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1. User Guide

1.1 About Automation Engine

Maximizing Productivity

Automation Engine doesn't only enable you to keep track of your files throughout your workflow, it
also optimizes and automates this workflow to increase your productivity.

Automation Engine:

• avoids double entry and possible operator errors,
• processes files faster (through digital standardization of production procedures, hot folders

automation, smart notifications...).
• frees operators from administrative tasks so they can concentrate on value-adding graphical

tasks,
• allows operators to share their expertise through tickets,
• keeps jobs, related files and related customer information organized to facilitate communication

and treatment of additional orders.

All this maximizes your efficiency and the quality of your deliverables, while lowering the cost of
prepress-related actions.

Integrating with your Existing Systems

Automation Engine can integrate seamlessly with your graphical editors, RIPs, file servers, business
systems...

It supports the industry standards (PDF, XML, XMP, SQL queries, Web Services, JDF...).

The Automation Engine client application (the “Pilot”) can be installed on any Mac or Windows
machine in your network, so all your operators can view files, get information or launch processing
tasks as needed.

Growing with You

Automation Engine is very modular and can be tailored to your needs, while always offering growth
possibilities.

From a background assistant to Adobe® Illustrator® to a central prepress server to a complete server
platform linking to your administrative systems, Automation Engine can grow with you to let you
handle larger accounts, accepting more jobs without increasing your costs.

Find more general product information on http://www.esko.com/AutomationEngine.

1.1.1 Copyright Notice

© Copyright 2015 Esko Software BVBA, Gent, Belgium

http://www.esko.com/AutomationEngine
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All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BVBA. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BVBA does not warrant, guarantee or make any representations
regarding the use, or the results of the use of the software or the information contained herein. Esko
Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising
out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published,
in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other
means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE
®
, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other

trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly
owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2014. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by BestTM Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.
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Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

1.1.2 Getting Help

You can also find the PDF version of this manual on the Automation Engine on http://help.esko.com/
products/Automation%20Engine .

To get an overview all of the keyboard shortcuts you can use in the Automation Engine Pilot, go to
Help > Keyboard Shortcuts...

1.2 What is Automation Engine

Automation Engine Architecture

Automation Engine is a client/server workflow software, running on Mac and Windows. This means
that one machine runs the Automation Engine server, to which you can connect from all Mac and
Windows machines in your network (using the Automation Engine Pilot).

Your Automation Engine server can connect to graphical editing software like ArtPro, PackEdge,
Adobe Illustrator (using the DeskPack plug-ins)...

It can also connect to your RIP software to ensure professional output.

You can store your files either on the Automation Engine server, on a dedicated file server, or on
different machines over the network.

http://help.esko.com/products/Automation%20Engine
http://help.esko.com/products/Automation%20Engine
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Automation Engine Processing

Automation Engine processes your files using single Tasks (for example a Trap or RIP task), or
Workflows ( more powerful and flexible series of tasks that can take complete care of the file from
arrival to final output).

Files and Jobs in Automation Engine

In Automation Engine, your files can be part of Jobs (customer orders that contain files and related
customer information), that are located in Containers (local or remote shared folders that Automation
Engine can access).

Depending on how you want to work with Automation Engine, you can link your jobs to customer
Products, focus on job Pages, Proofs, Plates...

Automation Engine Integration

Automation Engine can not only connect to editing and RIP software, but also to WebCenter (Esko’s
collaborative web platform) and other Esko workflow software (Nexus and Odystar). Automation
Engine can also be integrated with external systems.

1.2.1 The Automation Engine Pilot

The Automation Engine server software runs on a Windows server. Every Automation Engine action
is performed through the Automation Engine client, called the Pilot.

The Pilot can be installed on any Mac or Windows machine on your local network.

Depending on the user access rights you will set, operators can use the Pilot to:

• organize Jobs and files,
• create and modify tickets,
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• launch and monitor tasks,
• control workflows and devices,
• administrate users and perform general configuration,
• etc.

The Pilot's Main Window

1. These icons show different modes in the Pilot:

• Containers : This shows all the data that Automation Engine can access, in the different
Containers. Learn more in  Containers on page 24.

• Job Overview : This lists all jobs existing in the Automation Engine jobs database. Learn
more in Jobs on page 828.

• Last used Job : This shows the last job you worked on, and the job's data (files and folders).

2. The Views highlight different parts of the Automation Engine functionality. Certain views are only
accessible in defined workflows. Learn more in Views on page 22.

3. The Tools area contains tools useful to administrate Automation Engine. Learn more in The Tools
on page 616.

4. •
The Create Job  button allows you to create a job.
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•
The New Task  button creates a new Ticket from the pilot.

•

You can create a new workflow from the pilot using .

•
Using the  button, you can access the information regarding the files.

Note:  In the Job Overview mode, only Create Job  is available.

The contents of the central panes depend on the View you are in.

Tab support

In any Automation Engine view, a new tab can be created by using one of the following methods:

• Click  File > New Tab .

• Use the keyboard shortcut Control-T (Windows) or Command-T (Mac).

• If the tab bar is visible, you can also create a new tab by clicking the plus button in the tab bar .

• If the tab bar is visible, you can also create a new tab by right-clicking on the tab bar and choosing
New Tab.

Note:  The new tab will open with the same view that was active.

An opened tab can be closed by one of the following methods:

• Click on the close button in a tab (visible by hovering over the tab).

• Use the keyboard shortcut Control-W (Windows), or Command-W (Mac).

• Click on  File > Close Tab .

• Right-click on the desired tab and choose Close Tab.

Note:  To close all other tabs, safe the desired one, you can also choose Close Other Tabs from
this menu.

Full Screen Mode on Mac

When running the Automation Engine Pilot on Mac OSX or newer, you can enter and exit the Full
Screen Mode by using one of the following methods:

•
Click on the Full Screen button  in the top right corner of the main window

• Click on  Views > Enter Full Screen .

• Use the keyboard shortcut Command + Control + F.
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Views

The Pilot's Views highlight different parts of the Automation Engine functionality. You can use them
to work with your data in different ways (see Different Ways of Working with Automation Engine on
page 182).

Note:

• Depending on the Data View mode you are using (Containers, Job Overview or Last used job),
you will have access to different views. Only those that make sense are shown.

• Depending on your access rights, you may not be able to see some of the views.

Files

The Files view allows you to manage your jobs, files, favorite tickets, tasks... Learn more in The Files
View on page 152 for more information.

To Do List

The To Do List view lists all actions that need user intervention. Learn more in The To Do List View
on page 153 and To Do List on page 616.

Pages

The Pages view is only used in page workflows. It is extremely useful when working with page
impositions. For more information, see Working with Pages on page 182.

Products

The Products view shows the items you added to your Products database. This concept is useful
to customer who have re-prints. Products represent production data that you linked to a Job. It is
the Job order that has the specifications how to output the product this time, with or without many
other Product items.

Products are what you keep long term, until you are sure you will not have to produce them again.
Jobs however are Work In Progress, temporary by definition. A Job should be removed when it is
finished. Learn more in the dedicated chapter Products on page 876.

Proofs

The Proof view is only used in page workflows. It shows the proof sets and the proof details. Learn
more in Working with Proofs on page 189.

WebCenter

This view enables Pilot users to see what documents are inside a WebCenter project, without having
to use a browser. Read more in separate chapter Integrating with WebCenter on page 1346, in its
section The WebCenter View in Automation Engine Pilot on page 1349.

Plates

The Plates view is only used in page workflows. It shows details about all plates associated with
a job. It also includes advanced features for managing plates for jobs with multiple variants. Learn
more in Working with Plates on page 192.
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CDI

The CDI view shows all the files sent to the Digital Flexo Suite and used to image a flexo plate on a
Cyrel Digital Imager. See The CDI View on page 159.

Gang Run Printing

The Gang Run Printing view in the Pilot shows an overview of all graphics waiting to be nested and
printed on your available substrate sheets. It has two parts:

• The list of all substrates.
• The table of graphics waiting to be nested and printed on the selected substrate.

For more information, please see The Gang Run Printing View on page 1091 in the separate chapter
Working with Gang Run Printing on page 1081.

Tasks

The Tasks view shows the running tasks, the tasks waiting for execution and the finished tasks.
Learn more in The Tasks View on page 160. This list of tasks can be automatically cleaned up by
using Task Cleanup Rules on page 682.

Devices

The Devices view lists all output devices connected to your Automation Engine server. It allows you
to monitor, start and stop your devices and device queues.

Milestones

The Milestones view shows the milestones set for your job (in Last used job mode), or shows the
milestones set for all jobs (in Job Overview mode). Learn more in Milestones: Tracking Job Status
on page 854.

Tickets

The Tickets view shows a list of all tickets available on your server (both the default and your custom
tickets). Learn more in  Tickets on page 26.

Jobs

This view is only visible in Job Overview mode. It lists all or a filtered list of your jobs in the Automation
Engine job database. Learn more in The Job Views on page 830.

SmartNames

This view lists all SmartNames defined on the server. It is not visible in Job Overview mode. Learn
more in The SmartNames View on page 920.

1.2.2 Data Management in Automation Engine

Automation Engine works with  Containers on page 24, Jobs on page 828, Products on page
876, files and folders.

Customers with page (imposition) workflows can use the extra modes Pages, Proofs and Plates.
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 Containers

A Container is a network data share that contains the data that Automation Engine can work with.
You can make (part of) an existing network share a Container or you can have Automation Engine
create such network shares. These Containers can be located either on your Automation Engine
server or another computer in the same LAN.

By default, you have an empty ExampleJobContainer, on the disk drive that Automation Engine
was installed on.

You can have many Containers. You can see and browse though them in the Pilots’ Containers
mode.

To create a Container, see Creating a Container on page 691.

The Job Concept

What is an Automation Engine Job?

An Automation Engine Job represents an amount of work to be done for a certain order in your
business system. This can be a classic order management system but it could also come from a web
application that needs Automation Engine to execute some prepress tasks.

A Job is an entry in the Automation Engine Jobs database and has a unique name. In the Pilot, Jobs

are represented by this blue folder icon .

In Automation Engine, a Job consists of 2 things:

• data: files and folders, stored under the Job's Job Folder, in a Container.

• metadata: the parameters of that job order, usually how the order management system describes
this job. They can be general parameters like the job's name, order ID, customer and due date
but can also be parameters describing what to do with the input files to get to the targeted result.

Jobs can be created manually by an Automation Engine user or automatically via some integration
with an external system.

A Job represents Work In Progress (WIP). This means that you should remove Jobs that are 'done'.
Removing a Job from the Automation Engine Jobs database does not mean that you have to delete
the related data files.

Most Automation is based on Jobs
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A lot of the automation that Automation Engine brings comes from the fact that tasks can
automatically use parameters from their Job context. Job parameters automatically become
SmartNames and the (workflow) task tickets can use those SmartNames to pick up their values.

Note:  Customers that do not use Jobs at all find a similar level of automation by using Workflow
Parameters. Learn more in Using Workflow Parameters on page 1065.

Launching tasks on Jobs

Jobs can be managed manually in the Pilot, but several actions are also possible by launching tasks.

• The Create Job task on page 1280 task allows to create and modify Jobs.

• The The Check Job Parameters Task on page 874 task allows to check and correct barcode
and ink parameters used in designs.

• The Archive Job task and the Restore Job task allow to remove Jobs, store their data on a different
network place and, if needed later, restore them back, including their metadata.

• The Relocate Job task allows to move a Job's Job Folder to a different place. For example to
another Container that has more disk space.

Learn more about these tasks in Tasks you can Launch on Jobs on page 869.

Like all tasks, these tasks can also be triggered by an external system. Learn more in Integrating
with External Systems on page 1228.

1.2.3 File Processing in Automation Engine

In Automation Engine, you can process your files using single Tickets or Workflows (a sequence
of Tickets).

Launching those tickets or workflow results in (a series of) Tasks.

A Ticket contains all the parameters for that task.

Tasks

What is a Task?

A task is an action executed on a file, a folder or a Job on the Automation Engine server.

Types of Tasks

There are seven types of tasks:

1. Conversion tasks such as Export to PDF, Export to PostScript...
2. File Creation tasks such as Create Wrapper File, Create PAF / JPG / XML...
3. File Editing tasks such as Contourize & Clean, Trap...
4. Verification tasks such as Check Job Parameters, Check Print Rules, Preflight...
5. Administration tasks such as Prepare to Archive, Upload via FTP, Zip...
6. RIP tasks.
7. Device Output tasks.
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Task Settings

You can define settings for the tasks, and save these settings as Tickets to reuse them (see  Tickets
on page 26).

Task Progress

When a task is launched, you can monitor its progress in the Pilot. See Checking the Status of the
Task on page 37.

Workflows

You can build Workflows and launch them on your files using the Workflow Editor. Learn more in
Building Workflows using the Workflow Editor on page 987 .

You can also launch them from the Pilot, from Shuttle (see Using Shuttle to Upload and Process
Files on page 47) or from within most Esko Editors. They can also be launched automatically,
triggered by external signals (files arriving, commands from external systems, etc.).

Learn more in the dedicated chapter Workflows on page 986.

 Tickets

What is a Ticket?

The settings used when executing a task or workflow on a file can be saved as a ticket.

Default and Custom Tickets

The Pilot comes with a default ticket for each task type, but you can also create custom tickets. You
cannot overwrite or delete default tickets.

You can see all the available tickets (default and custom) in the Pilot's Tickets view.
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Global and Job Tickets

Global tickets (  ) can be used on any file you can access through the Pilot. Job tickets (  ) are
only available when you work in the Job that you saved them for.

Public Tickets

You can make tickets public if you want to submit files to them from Shuttle. There are several ways
to make a ticket public (see Making Your Ticket Public on page 49 in the User Guide).

Public tickets have a mark in the Public column.

Note:  Depending on your access rights, you may only see public tickets, and public parameters
inside the tickets.

1.3 Getting Started with Automation Engine

1.3.1 Starting Automation Engine

To start working with Automation Engine you need to:

• Start the Automation Engine server software, see Starting the server.

• Start the Automation Engine Pilot, see Starting the Pilot.

Starting the Automation Engine Server Software

Automation Engine features a new web tool for server administration. This means you can access the
server administration tool from any workstation via http://servername or http://servername:9999/.

On this web server administration tool you will also find the client application(s) such as the
Automation Engine Pilot, a diagnostics tool, a back-up tool, ...

To start the Automation Engine server:

1. Open your web browser and go to http://servername or http://servername:9999/.
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2. Log in with your user name and password.

3. In the Server administration > Start/Stop Server window, you have access to all admininstration
tasks for the Automation Engine server.

For more information on working with the server, see Server Administration.

Installing Client Applications

The Automation Engine Client applications like the Pilot, Shuttle and Diagnostics are available in the
Client Apps section of the Server Admin Web Tool. Access the Server Admin Web Tool via http://
servername or http://servername:9999/.
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Click the Download button next to Client Applications. This download includes the Pilot, Shuttle
and Diagnostics.

A shortcut for Pilot and Shuttle will be created during installation.

Installing Client Applications on Mac

1. Go to the Client Applications page of the Server Admin Web Tool. Click the Download button
next to Client Applications.

2. Open the downloaded installation file Automation Engine Client 12.1.dmg.

3. Follow the installation instructions.

Client applications will be available in the Applications folder.

Installing Client Applications on Windows

1. Go to the Client Applications page of the Server Admin Web Tool. Click the Download button
next to Client Applications.
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2. Open the downloaded installation file (Automation Engine Client 12.1.exe).

3. Follow the installation instructions.

Automation Engine Client applications will be available  Start > Esko > Automation Engine Client
12.1 .

Updating the Automation Engine Pilot

The Pilot and the Automation Engine Shuttle display automatic update alerts. This makes sure that
the latest version of these applications are available.

• While starting the Automation Engine Pilot for the first time, in the Logon Information window,
enter User name, Password and the Server name. Click OK.

• If the version of the Pilot matches that of the Automation Engine Server, the main Pilot window
will open.

• If there is a major version mismatch among the Pilot and the Automation Engine Server, you
cannot login to the Automation Engine Server. You will be alerted with a warning.

• If there is a build mismatch among the Pilot and the Server, the Software Update dialog will
pop up.

• Click Install Update. The Pilot will stop and the Updating Automation Engine Pilot dialog will
appear.

On Mac, you need to enter the credentials of an administrator use to update the Pilot application.
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The Updating Automation Engine Pilot dialog indicates the download progress.

• At the end of the download, this window displays Ready to install message. Click the Install
and Relaunch button to install the update.

After the update is installed, the Pilot application will be relaunched and you will be asked to enter
credentials in the Logon Information window again.

Note:  You can use the same procedure to update Automation Engine Shuttle.

Starting the Pilot

On your Automation Engine client machine:

1. Do one of the following:

•

double-click the Pilot desktop icon ,
• go to  Start > All Programs > Esko > Automation Engine Client 10.0 > Pilot.

2. In the Logon Information dialog that opens:

a) Enter a User name and Password valid for your Automation Engine server.
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Note:

Before you define any user, you can log in using admin as both user name and password.

Once you have created users (see Creating Users on page 32), you can log in with one of
your users’ credentials.

b) In Server, enter either your Automation Engine server’s name or its IP address.
c) Click OK.

Note:

If the build version of the Pilot is different from that of the Automation Engine Server or when an
update for the Automation Engine Pilot is available, the Software Update dialog will pop up. To
download and install the update of the Pilot, click Install Update. You can postpone it by clicking
the Remind Me Later button.

This opens the Pilot’s main window.

1.3.2 Performing Basic Configuration

Creating Users

1. In the Pilot, go to  Tools > Users .

2. In the Users window, do one of the following:

• go to  File > New User ,
• use the CTRL + N shortcut,
•

click the  icon.

The New User dialog opens.

3. Enter the user's Name, Full Name, Password, Description and valid E-mail address.

4. If you want the user to be able to administer Automation Engine, check the toggle.

This will give all user access rights to that user.

5. Click OK to add your new user to the Users list.
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Attention:

When creating a user, Automation Engine requests permission from the Windows OS.
Therefore, some changes (for example, changing the password) require the use of Windows
User Administration tools. These changes must also meet the existing domain policies (for
example, the length and complexity of the password).

Defining User Access Rights

Not all users have the same responsibilities, so you can assign them different access rights in
Automation Engine.

• To give access rights to a single user:

a) in the Users window, double the user you want to give access rights to,
b) in the Access Rights tab of the Properties window, check the access rights you want this

user to have.

Note:  Automation Engine Administrators automatically have all access rights. You cannot change
this.

• To give a particular access right to several users:

a) in the Users window, click the Access Rights button to switch to the Access Rights view,
b) select the access right you want to give to your users,
c) check the users you want to give this access right to.
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Configuring Output Devices

Automation Engine can output files to a variety of output devices (CDI, HP Indigo, Kodak Approval,
etc.).

Automation Engine uses Esko’s FlexRip engine to RIP the file in preparation for output.

To connect Automation Engine to an output device, you need to connect it to FlexRip.

1. In the Pilot, go to  Tools > Configure.

This opens the Configure dialog.

2. Select the option corresponding to your output device in the list at left (for example, select FlexRip
- Proofer Output to output to a proofer).
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3. Go to  File > New or use the Insert key (on Windows).

This shows tabs with parameters at right.

4. In the General tab:

a) To output to a RIP, enter the name or IP address of your RIP server in RIP Node.

For a FlexProof output, enter the name / IP address of your proof server in Proofer Node.
b) Enter the EskoLink port number used by the Dispatcher in EskoLink Portnr. (only for FlexRip

outputs).

Note:  You can find that port number by going to  Info > Ports in the Dispatcher.

c) Click the Synchronize with Rip / Synchronize with ProofNode button.

After a few seconds, your RIP/proof server is connected to Automation Engine, and you can see
its name in the Type field.

5. In the Queue tab:

a) Give your queue a name in the Queue field.
b) Choose a Queue Job Limit:

• choose 1 to have the RIP handle one file at a time (this ensures the files are ripped in the
order they enter the RIP),

• choose 2 to have the RIP handle two files at once (the files may not be ripped in the order
they enter the RIP if for example you send a big then a small file).

6. Go to  File > Save to save the configuration.

You can now see the devices you are connected to in the Pilot’s Devices view.

1.3.3 Uploading Files using the Pilot

In the Pilot, in the Container mode or in the Last used Job mode, select the folder in which you
want to upload your file(s).

Choose one of these methods:

• drag and drop files or folders from outside the Pilot onto a folder in the Pilot. Or use copy/paste
shortcuts.
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• go to  File > Upload... . In the browser dialog that opens, browse to your file and click Upload.

1.3.4 Launching a Task on a File

There are several ways to launch a task on a file (from the Pilot, from Shuttle, via Access Points or
via JDF/JMF). Here is how to launch a task from the Pilot's Files View.

1. In the Pilot, select the Files view from the Views bar (or use  Go > Files ).

2. In the Containers mode, browse to your chosen file.

3. Right-click it, select New Task then More Tickets...

Note:  If you have launched tasks previously, the most recent task tickets you used are listed
above More Tickets...

4. In the Select Ticket dialog that opens, select the task ticket you want to use.

Note:  This dialog contains all the tickets suitable for the file type you selected. You can choose
either a Default ticket, or a custom ticket (saved under a different name) if you have already
created one.

5. Click OK.

This opens the task’s ticket. An example:



1
Automation Engine

37

6. Fill in the settings you want to use in the ticket.

Note:  For a description of all of the ticket's settings for each task, see The Tasks and Workflow
Controls on page 239 in the Reference Guide.

7. Click the Launch button.

You can monitor the tasks progress in the Files View's Task pane or in the Tasks View. See Checking
the Status of the Task on page 37.

1.3.5 Checking the Status of the Task

After launching a task on one or several file(s), you can check its processing status in the Pilot’s
Tasks pane. You can see the Tasks pane in the Files, Product or Tasks views.

You can see the progress (in percentage) and the processing state. The state can be:

• : starting
• : success
• : warning
• : failure
• : processing cancelled
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You can also double-click the task entry in the Tasks pane to open your task ticket and check its
parameters.

Note:  Depending on your access rights, you may only see the public parameters.

1.3.6 Cancelling a Launched Task

You can cancel a launched task by richt-clicking on the task and choosing Cancel. When it was
successfully cancelled, the task will show the cancelled state with this icon: 

Note:  Tasks that are already too far in their processing or are no longer under control of Automation
Engine (for example FlexRip tasks) can no longer be cancelled

1.3.7 Relaunching the Task

• To relaunch the task without changing the settings:

a) Select the task to relaunch in the Tasks pane.
b) Go to  Tasks > Relaunch.

• To change the settings and relaunch the task:

a) Select the task to relaunch in the Tasks pane.
b) Go to  Tasks > Open.
c) Change the task settings as necessary.
d) Click the Launch button.

1.3.8 Generating Output

To output a file, use a task related to the output device you have configured (see Configuring Output
Devices on page 34).

For example, use the Proof (FlexProof) task if you have configured a proofing device using FlexRip
- Proofer Output.

Note:  The task related to your output device will only be available once you have correctly configured
your output device.

1.4 Server Administration

Automation Engine features a new web tool for server administration. This means that you
can access your server administration tool from any workstation via http://servername or http://
servername:9999/.

You can use this web tool to download the Automation Engine Client apps such as

• the Pilot
• the Script runner
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• the ArtPro Action List Editor
• the Automation Engine 10 Backup Tool

The Server Admin Web Tool also includes a Server Admin section which can be used to administer
the Automation Engine Server and its settings, create and restore backups and manage databases,
SQL Servers and the Application Server.

Server administration consists of :

• Status Overview of the Server

• Setting up the server

• Backing up the server

• Restoring the server

• Managing databases

• Managing SQL servers

Read detailed information in Automation Engine Reference Guide.

1.4.1 Status Overview of the server

The Status Overview shows an overview of the connected clients and the number of running tasks.
You also get an overview of the Server Version, Current role and Server databases. In the Status
Overview you can:

• Start and stop the Automation Engine server.
• Activate the server after install.
• Restart the web server.
• Download the server administration log files for support purposes.
• Start, stop or activate the local application server.
• Download Application Server log files for support purposes.
• Deploy components on the application server.
• Log in to another server.
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The Status Overview page contains more information from 12.1.1 onwards. Read the following.

For each Server database, the SQL Server Instance and the SQL Server location is indicated at
the Status Overview page. The Status column indicates the following statuses :

• Online : The SQL Server instance where the server database is located is running. This also
implies that the user name and password used to login to the SQL Server instance are correct.
The server database is online and available for access.

• Not Accessible: The SQL Server instance where the server database is located is running. Valid
credentials( user name and password) are used. But the server database on the SQL Server
instance is not accessible.

• Not Found : The SQL Server instance where the server database should be located is running
and the credentials used to login to the SQL Server instance are valid. But the server database
could not be found on the SQL Server instance.

• Login Failed:: The SQL Server instance where the server database should be located is running.
The server database is not available because the credentials used to login to the SQL Server
instance are invalid.

• Offline: The server database is not available because the SQL Server instance where it is located
is currently not running.

• Unknown: The status of the server database on the SQL Server instance is unknown.

Tip:  When you move your cursor over the status of a server database, a pop-over message will
indicate the detailed status information.
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1.4.2 Setting up the server

In the Server Setup window you can change the server role: master, assistant or idle. You can also:

• View and remove Assistant Servers.
• Change the system account and/or password.
• Change the processing capabilities.
• Redirect central resources to a central file server.

1.4.3 Backing up the server

In the Server Backup window you can manage the following backup settings:

• Specify a backup folder on the server.

• Specify the number of backups to be kept in Keep only last.

• Set a backup schedule or manage existing schedules.

• See the Backup history and details of each backup.

Tip:  Click on info to get more information about the selected backup. A Backup info window
will list the server, date, time, size and composition of the backup.

• Remove a backup.
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1.4.4 Restoring the server

In the Restore window you can view and restore backups. You can also:

• Restore, duplicate or migrate your server configuration
• Restore resources or databases only

Note:  Take into account that the server should be stopped before you can restore a backup.
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1.4.5 Managing databases

In the Databases window you can manage all databases that are on any accessible SQL server in
your network. Depending on the permissions on the selected SQL instance, you can:

• View the SQL server status
• Login and view the properties and status for each database
• Create or remove databases
• Back-up or restore databases
• Repair or move databases

Note:  Take into account that, even if you are logged in to the Server Administration, you also need
to log in to the SQL Server instance separately.
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In this page, you can manage the databases on any SQL Server in the network.

1.4.6 Managing SQL servers

In the SQL Server window you can manage any accessible SQL server in your network. You can:

• View the SQL server status
• Stop and restart an SQL server
• Login and change the properties: modify the maximum physical memory of the SQL server
• Look at the SQL server logs

Note:  Take into account that, even if you are logged in to the Server Administration, you also need
to log in to the SQL Server instance separately.
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1.5 Uploading Files to Automation Engine

You can work with files that are already stored in your Containers, or upload new files to Automation
Engine. You can upload files onto the Pilot, or by using the Shuttle application and plug-in. Access
Points can also upload data but they will also already trigger a workflow task.

1.5.1 Uploading Files using the Pilot

In the Pilot, in the Container mode or in the Last used Job mode, select the folder in which you
want to upload your file(s).

Choose one of these methods:

• drag and drop files or folders from outside the Pilot onto a folder in the Pilot. Or use copy/paste
shortcuts.

• go to  File > Upload... . In the browser dialog that opens, browse to your file and click Upload.

1.5.2 Uploading Files from a FTP Server

1. In Containers mode or when in a Job, right-click the folder in which you want to upload your file,
and select Upload from FTP Site...
This opens the Upload from FTP Site dialog, where you can enter the details necessary for the
FTP connection.

2. In Host, enter the name of the FTP server that hosts your files.

Tip:  To use a port other than the default port, add : and the port number after the host name.
For example: myftpserver:1085

3. Enter the User Name and Password you use to connect to the FTP server.
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Make sure you use a valid User Name and Password corresponding to an account that exists
on the FTP server.

4. In File Transfer, choose between Binary and ASCII.

Binary will always work, but if you have an ASCII file, the transfer will go a bit faster when selecting
ASCII.

5. By default, the transfer uses Active Connection Mode (where the FTP server opens the data
connection).

If your system is behind a firewall that blocks incoming FTP server connections, select Passive
to use Passive Connection Mode (where the client initiates the connection).

6. Select Secure FTP if you are connecting to a secure FTP server (over FTPS, not SSL or SSH).

Tip:  If you are experiencing problems using secure FTP, try connecting over regular FTP, and ask
your IT administrator to check the security settings of your FTP server.

7. If desired, you can delete the files from the FTP site once they are uploaded to the Pilot (select
Remove remote data after transfer).

If you do this, you can choose to Backup remote data before removal. Select the Backup
Folder in which to copy the files.

8. When you are done, click Connect.
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1.5.3 Using Access Points to Upload Files

Access Points are documented in the dedicated chapter Integrating with External Systems on
page 1228.

1.5.4 Using Shuttle to Upload and Process Files

You can upload and process files from any Mac or Windows client computer using the Shuttle
application.

 The Automation Engine Shuttle

The Automation Engine Shuttle is a client tool for easy submission of files to Automation Engine
workflows. Shuttle also allows monitoring of the workflows.
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Download Shuttle from the Main section of the Server Admin Web Tool. You can access it by browsing
to http://<name of your server>  or  http://<name of   your server>:9999. Read
more in Installing Client Applications on page 28

If the Shuttle application is installed on your computer, the system will check if you have the
appropriate version and download updates if necessary.

As explained in Shuttle on page 681, you first need to configure your Shuttle in  Tools > Configure
> Shuttle .

What is Shuttle?

Shuttle is a small stand-alone application that enables you to submit files to Automation Engine tasks
or workflows, Odystar canvases, and Nexus workflows, and monitor their progress. You can use
Shuttle to connect to several servers.

The Shuttle functionality is also integrated in ArtPro, Neo, PackEdge, Plato, FastImpose and in Adobe
Illustrator as a DeskPack plug-in.

Shuttle Setup

Automation Engine Setup for Shuttle

1. In the Pilot, go to  Tools > Configure.

2. Select Shuttle in the left pane.

3. Enter the Port to use for communication between your Automation Engine server and the Shuttle
clients.
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Note:  By default this is port 5182, but if this port is already used by other processes, you should
enter the next available port.

4. Choose an Upload Folder using the Browse... button.

This is where Shuttle clients will upload files that are not located in a container (except the Shuttle
plug-in, that will always upload files to the DeskPackContainer).

Note:  The Upload Folder must be located on a container.

5. Select Start Shuttle server automatically when Automation Engine is started if you plan to
make frequent use of the Shuttle technology.

6. Click the Start button to start Shuttle server.

Shuttle server makes Automation Engine’s workflows, tasks and files accessible to the Shuttle
clients.

7. Save your settings.

Note:  If you need to make changes to this Setup, you must Stop the Shuttle server first.

Making Your Ticket Public

Important:  Only Public tickets or workflows can be launched from the client applications mentioned
here.

Note:  Default tickets can not be made Public.

To make a ticket Public, you can either:

• Select the Public option when creating the ticket.

•
Select your ticket in the Ticket view, click  and select Public.
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• Right-click your ticket in the Tickets view and select Make Public.

Note:  Public tickets have a mark in the Public column.

Shuttle Clients Connecting to Any Server

The Automation Engine Shuttle, the Shuttle plug-in, and the Shuttle clients in ArtPro, Neo and
FastImpose Standalone can connect to a number of Odystar, Nexus and Automation Engine servers.

1. Launch your application.

2. Open the Preferences.

In... go to...

Illustrator • Illustrator > Preferences > Esko > Shuttle
Preferences...  on Mac

• Edit > Preferences > Esko > Shuttle
Preferences...  on Windows

ArtPro ArtPro > Preferences...  or use Command +
K

Neo Neo > Preferences...  or use Command + ,
(comma)

FastImpose Standalone Tools > Shuttle Preferences...

3.
In the Servers tab (Advanced tab for Neo), click the  button at the bottom of the Servers list.
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The following dialog will prompt.

4. Enter your User Name and Password.

• When connecting to an Automation Engine server, enter the User Name and Password you
use to log in to the Pilot (the password can be blank if your server is configured to accept this).

You will have the same access rights (for example, the right to set processing priorities or not)
in Shuttle as you have in the Pilot.

Note:  If you don’t know which User Name and Password to use, contact your system
administrator.

5. To connect to a server not broadcasting over the Bonjour network (Automation Engine servers or
non-Bonjour-enabled Nexus servers):

a) Select Manual in the Browse Method list
b) Enter your server’s name or IP address in Server Address
c) Fill in the Server Port used by your server

Note:

When connecting to an Automation Engine server, enter the port you defined in Configure (see
Automation Engine Setup for Shuttle on page 48).

6. Click the Add button.
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This adds a connection to your server in the Servers list.

•
To remove the connection to a server, select it in the Servers list and click the  button.

• To check or edit a server’s settings, double-click it in the Servers list.

Note:

If you are using the Shuttle plug-in with other Deskpack plug-ins, and you have set up a server
connection with the Server Connection Assistant, you will see this connection in bold in the Shuttle
plug-in’s Servers list (after restarting Illustrator).

You will be able to change the user name and password if necessary, but you will not be able to
remove this connection from the Shuttle plug-in.

See the Adobe Illustrator Client documentation for more information on the Server Connection
Assistant.

Shuttle Clients Connecting only to Automation Engine

The Shuttle clients in PackEdge, Plato and FastImpose Server can only connect to one Automation
Engine server.

1. Launch your application.

2. Open the Preferences.

• In PackEdge or Plato, go to  Edit > Preferences or use Ctrl+Alt+Shift+P.
• In FastImpose Server, go to  Tools > Options...

3. In the Server&Resources tab (the Server tab for FastImpose Server):

a) Select Connect to Automation Engine Server.
b) Enter the Automation Engine Server Name and click Check.

You should see a message saying the server is up and running.
c) Select Login with the following user account settings, and fill in the User Name and

Password you use to login to the Pilot.
If the connection is successful, you will see a green dot and the message Connected as
user ...
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Tip:

If you are running an Automation Engine Pilot on the same computer, or another Shuttle
client connecting to it (either PackEdge, Plato or FastImpose Server), you can select Login
automatically with user name and password from other application connected to the server.

This way, if you are already logged in to the Pilot or the other client application, you won't need
to log in when starting PackEdge / Plato / FastImpose Server.

4. Restart your application.

Launching the Automation Engine Shuttle

When you launch the Shuttle application from your installed programs, a pop up window with the
Shuttle Launch panel and a Task Monitor will appear.
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• To open a new window, go to  File  >  New Window . You can use dedicated Shuttle windows
for each of your Workflows.

• Shuttle saves the settings of the open windows while closing. These settings are restored during
the next launch.

• You can use View menu to hide or show the The Task Monitor, Shuttle Launch panel and the
Status Bar.

• View > Tasks  hides/shows the Task monitor.

• View > Launch Panel  hides/shows the Launch Panel.

• View > Status Bar  hides/shows the Status Bar indicating the progress.

Working with the Automation Engine Shuttle

You must login to the Automation Engine Server to use the Shuttle.

Note:  You have access to Shuttle if you have access to Pilot. But your access to Pilot may be
restricted even when you are allowed to use Shuttle. This requires a user access right (Pilot: start
the Pilot (in addition to Shuttle)). Read more in Access Rights on page 702.

The following menus are available in the Shuttle application on Mac and Windows:

• File menu: Submit one or more files and launch the selected Workflow, open new Shuttle windows
and close Shuttle windows.

• Edit menu: cut, copy, paste, delete a Task or Workflow, select all Tasks and Workflows in the
Task Monitor.

• View menu: show or hide the Task Monitor, the Shuttle Launch panel and the Status Bar.

• Task menu: open or show the output file of the selected Task or Workflow, release or cancel the
Task or Workflow, add annotations and show detailed information.

• Window menu: minimize, zoom and switch between Shuttle windows.

• Help menu: See the About window or open the Online Help (Esko Help Center).

Setting the Preferences for Shuttle

• On Mac, select Preferences... in the Application menu.

• On Windows, go to  Edit > Preferences...

In the Preferences window, set the units for Dimension, Resolution, Ruling and the number of
Decimals to use.

You can also select the Always show launch dialog option. This will show the Public Parameter
dialog upon starting a new task, even if there aren't any public parameters. This allows you to alter
these types of tasks before they launch.
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The Task Monitor

When you are logged in, The Task Monitor displays your Automation Engine Workflows launched
from both the Shuttle and the Pilot.

To filter the displayed Workflows, you can choose a job context filter.

• Go to the drop-down list in the toolbar and select the desired job. All recently used jobs are listed
in this list.

• If the desired job is not present in the list, choose Other.... The Open dialog will prompt where
you can choose the desired job.

• Choose the menu item "All Jobs" to clear the current filter.

Note:  You cannot view, open or edit the Tickets of the Tasks or the Workflows in the Task Monitor.
This is only possible in the Automation Engine Pilot.

Intervening in a workflow

You can intervene when a workflow is halted for user intervention provided the Workflow user
intervention settings designate you for intervention. To intervene,

• Click on User intervention needed link of a workflow.

• In the resulting To Do window, choose to Forward or Release.
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Tip:  You cannot hide the columns displayed in the Task Monitor. However, you can change the order
and the width of the columns.

Context menu options

Right-click on a workflow/task to access the context menu with the following options:

• Open Output File opens the output file of the Task or Workflow with the appropriate application.

• Show Output File in Finder/Explorer shows the folder that contains the output file in Mac Finder
or in Windows Explorer.

• Release allows you to release the Task or Workflow if it is on Hold.

• Cancel allows you to cancel the Task or Workflow.

• Delete allows you to delete the Workflow from the list of Workflows the Task Monitor.

• Annotation... shows a dialog that allows you to add or modify an annotation.

• Details shows the Details dialog with detailed information about the Task or Workflow.

Alternatively, these options are also available via the Task menu of the Shuttle application.
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The Shuttle Launch Panel

You can drop one or more files as input files for the selected Workflow/Task through the Shuttle
Launch Panel.

• Browse to the desired workflow using the Workflow drop-down list. This will be updated when
new workflow tickets are created. Shuttle launches the selected workflow when files are placed
in the Shuttle Launch panel.

Attention:  The drop-down list only shows the Workflow Tickets that are public.

• The selected workflows are saved when you quit Shuttle. Shuttle restores the selection of
workflows during the next launch.

Launching a Workflow from the Automation Engine Shuttle

1. If the Launch Panel is not visible in the Shuttle window, go to  View > Launch Panel .
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2. Select the desired Workflow with the drop-down menu. Shuttle will launch this Workflow when
files arrive at the launch panel.

3. Submit one or more files in one of the following ways.

• Drag and drop the desired file(s) into Drop Files Here area.

• Go to  File  > Launch...  and select the files.

• Use the keyboard shortcut Command-L on Mac or Ctrl-L on Windows and select the file(s).

Note:

• The selected file(s) will be uploaded to the root folder of the job.
• If a file was previously launched on the chosen workflow, a dialog will prompt to give you the

option to reuse the public parameter values from the previous launch. If you choose to reuse
these public parameter values, they will be used as default parameter values. You can still edit
these values if necessary.

• If a file with the same name is already present in the root folder of the job, a dialog is prompted
warning you of overwriting the file. You can then choose to either Replace the existing file, or
Cancel the launch to rename the file.

4. If your workflow has Public Parameters, you can fill them in the New Task window which will
prompt. Learn more in Using Public Parameters in Workflows on page 1051. It also possible to
set the Task Options in this window.

a) You can set Task OptionsIn the New Task window, click the Task Options button.

In the resulting window, you can:

• set the Priority of the Task or Workflow as Low, Normal, High or Immediate by selecting
from the drop-down.
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• select Hold if you want to hold the launch of the Workflow. The Workflow will not be
launched until you Release via the right-click menu in the Task Monitor or via the Task
menu.

Alternatively, hold the workflow until a set period of time after which it will be automatically
released. To do this, select Release at and specify the period or date and time.

Note:  You can bypass the automatic release setting by selecting Release via the right-
click menu in the Task Monitor or via the Task menu.

• Select Launch a separate Task per input file for launching a separate Task or Workflow
for each input file.

• You can also set an Annotation for the Task or Workflow in this window.

5. Click the Launch button to launch the workflow.

The task will immediately appear in the Task Monitor.
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Note:

You can upload multiple files for multiple workflows. Click on the Plus button  to add extra
drop zone slots.

To remove these slots, proceed as follows:

•
Click on the Minus button . This will place the user interface in Editing mode

• Click on the desired Delete button on the top left corner of the drop zone.

• To leave the Editing mode, click on the Minus button, or press Escape.

User Intervention from the Shuttle

If you have setup a Wait for Action step in the workflow, the process halts for user intervention (for
a To Do action). User intervention needed link will appear in the Task monitor when the workflow
is halted.

1. Click on the User intervention needed link.
The To Do dialog will prompt.

2. You can select I am currently handling this to do item to mark that you are handling this To Do.

3. You can choose to Forward, Release or Delete the To Do.
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• You can let the workflow continue by clicking Release. Select the output state that you require
in the release. The To Do window will close and the Workflow will continue processing.

• You can forward the To Do to another user. Click Forward and the workflow will not continue
until the other user handles the To Do.

• You can also delete the To Do by clicking on Delete. This will end the processing of the
workflow.

Launching Files from ArtPro

1. To launch your current file to Shuttle, go to  File > Launch Workflow...

This opens the Launch Workflow window.

2. Choose what file type you want to launch your file as.
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If your workflow is... you can launch the file
as...

with...

an Automation Engine
workflow accepting
Normalized PDF files as
input

Normalized PDF either Normalized PDF
or Normalized PDF
(embedded)

an Automation Engine
workflow accepting PDF
files as input

PDF any of the available PDF
flavors

an Automation Engine
workflow accepting ArtPro
files as input

ArtPro with the included images
(TIFF, EPS...) or without
(only the ArtPro and the
ArtPro CT file)

3. If you want to add your file to an Automation Engine job, select it in the Job list or fill in the Job
ID and/or Job Part ID.

Note:  Use the Search... button to see a list of your server's jobs, with job information and a filter.

4. If you want to add your file to an Automation Engine product, select it in the Product list or fill
in the Job ID and/or Job Part ID.
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Note:  Use the Search... button to see a list of your server's products.

5. Select the workflow you want to launch your file to.

6. If your workflow has public parameters, you can fill them in in the same window.

7. Click the Launch button.

Launching Files from PackEdge or Plato

Attention:  You must save your file on an Automation Engine container before you can launch
it into a workflow from PackEdge or Plato.

1. Go to  File > Launch Workflow...

This opens the Launch Workflow window.

2. Select the workflow you want to launch on your file in the workflow list.

3. If your workflow has public parameters, you can fill them in in the same window.

Note:  For more information on public parameters, see Using Public Parameters  on page 68.

4. Click Launch to launch the workflow on your file.
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Tip:

To access Shuttle easily in the future (without using the menus):

1.

Go to  Window > Toolbars > Shuttle to open the Shuttle palette. 
2. Drag it into your application's toolbar.
3.

Click  to open the Launch Workflow window, or  to open the Shuttle window.

Launching Files from FastImpose

When working with FastImpose Server, you must save your file on an Automation Engine container
before you can launch it.

1. Go to  File > Launch Workflow...

This opens the Launch Workflow window.

2. Choose what file type you want to launch your file as.

• When working with FastImpose Server, you can only launch your file as an IMP file.
• When working with FastImpose Standalone, you can launch your file either as a JDF or a PDF

file.



1
Automation Engine

65

Click the Settings... button to set JDF or PDF Export Preferences (see the FastImpose
manual for more information).

3. Select the workflow you want to launch on your file in the workflow list.

4. If your workflow has public parameters, you can fill them in in the same window.

5. Click Launch to launch the workflow on your file.

Launching Files from Neo

1. Go to  File > Launch Workflow...

This opens the Launch Workflow window.

2. Select the workflow you want to launch on your file in the workflow list.

3. If your workflow has public parameters, you can fill them in the same window.

For more information on public parameters, see:

• Using Public Parameters  on page 68,

Note:  If you want to go back to the default parameters values after changing them, use the Reset
To Defaults button.

4. Click Launch to launch the workflow on your file.

Launching Files from the Shuttle Plug-in (Adobe Illustrator)

To launch a file into a workflow through the Shuttle plug-in, it needs to be the current file in Adobe
Illustrator (open and at the front).

1. Go to  File > Launch Workflow... or use Option + Command + Z.

This opens the Launch window.
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2. When launching to Automation Engine, choose Normalized PDF in Launch As.

This copies the Normalized PDF version of your file onto the DeskPack Container.

Note:  This uses the PDF Export plug-in to convert your Illustrator file to Normalized PDF. To refine
the conversion, click Settings... and edit the PDF Export Preferences.

3. If you want to link your file to an existing Automation Engine job, fill in the Job ID and/or Job
Sub ID.

Note:

• You must enter a Job ID / Job Sub ID that already exists on your Automation Engine server.
The Shuttle plug-in cannot create jobs.

• The Normalized PDF that you launch with a Job ID / Job Sub ID will be linked to that job, so
that tasks and workflows processing that file can use the job parameters.

• If you are launching a file that was already in an Automation Engine job, the Job ID and/or
Job Sub ID will be filled automatically.

4. Select the workflow you want to launch your file to in Launch To Workflow.

5. If your workflow has public parameters, you can fill them in, in the same window.

6. Click Launch to launch your file.
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1.6 Launching Tasks on Files

1.6.1 Creating a Task Ticket

Creating a Custom Ticket from the Tickets View

To create a ticket with your own parameters, that you will be able to reuse:

1. Open the Default ticket of your chosen task.

Note:  To create a custom workflow ticket, see Workflows on page 986.

2. Fill in your parameters.

3. Go to  File > Save As...  or use Ctrl + Shift + S (Windows) / Shift + Command + S (Mac).

4. In the Save As pop-up:

a) Enter the name to give your custom ticket
b) Add the ticket to your Favorites if you like
c) Make the ticket Public if you want to be able to use it from Shuttle (send files to that task

using your ticket's parameters)

Note:  The Scope is always Global when creating a custom ticket from the Tickets view.

Creating a Custom Ticket when Working with Files

You can create a custom ticket when launching a task on a file too:

1. Right-click your file, select New Task then More Tickets...

2. In the Select Ticket dialog that opens, select the Default ticket for the task you want to use.

3. Fill in the settings you want to use in the ticket.

4. Go to  File > Save As...  or use Ctrl + Shift + S (Windows) / Shift + Command + S (Mac).

5. In the Save As pop-up:
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a) Enter the name to give your custom ticket
b) Add the ticket to your favorites if you like
c) Make the ticket public if you want to be able to use it from Shuttle (send files to that task using

your ticket's parameters)

Note:

• If you are not in a job context, the Scope is always Global.

• If you are in a job context, you can choose between Job and Global Scope.

When choosing the job scope (called after your job), you cannot make the ticket public.

Using Public Parameters

Public Parameters are Ticket parameters that users can define when launching files from these client
applications connected with the Automation Engine server:

• Automation Engine Shuttle
• Automation Engine Pilot
• ArtPro, Neo
• PackEdge, Plato, FastImpose
• DeskPack (Adobe Illustrator)
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Note:  Only Public Tickets can be launched from these client applications.

For each public parameter, you can either:

• enter a list of predefined values that the user must choose from,
• let the user enter a value himself.

Making a Parameter Public

Note:  You need to define which parameters are public before files are submitted to your workflow.

Note:  Not all parameters of all tickets can be made public.

In the ticket containing the parameter to make public:

1. Right-click the parameter and select Make Parameter Public.

2. Right-click it again and select Modify Public Parameter...

3. In the Modify Public Parameter dialog that opens:

a) If necessary, change the way the parameter will be called in the client application in Prompt as.
b) Choose either:

• Allow the user to set the value if you want client application users to be able to freely
enter a value for that parameter.

• Let the user select a predefined value if you want client application users to choose from
a list of values that you define.
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If that parameter already offers a list of values to choose from in the ticket, they will be
displayed here. You can Add or Remove values.

Note:  client application users will see (and choose from) the Predefined Settings. They
will not see the associated Values.

c) If you have chosen Let the user select a predefined value: in Default Predefined Setting,
choose the setting that will be selected by default. If the user doesn’t select another setting,
this one will be used for processing.

4. Save your ticket to also save all settings related to public parameters.

This is how your public parameter will look like when it prompts to the users of the client application:

If you chose Allow the user to set the value If you chose Let the user select a predefined
value

 

 

 

 

Managing Public Parameters in Your Ticket

Once you have made parameters public in your ticket, you can have an overview of your public
parameters and edit them at the ticket level.

1. In your ticket, go to  Advanced > Manage Public Parameters...

The Manage Public Parameters dialog that opens contains all of your ticket’s public parameters.
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The left pane shows all parameters that can be made public for that ticket (the ones you have
made public are greyed out).

The right pane shows the parameters you have made public, with their settings (predefined values,
etc.).

2. You can:

• drag parameters from left to right to make them public;
• click a public parameter’s cross  if you don’t want it to be public anymore;
• rearrange the order of your public parameters (drag them up or down);
• change public parameters’ settings (Prompt as, Predefined Settings, etc.);
• group public parameters under a custom header (click Add Group, click  to edit the header,

and drag parameters from the left);
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• use presets to simplify users’ choices (see Making Presets to Simplify the Users’ Choices on
page 72).

Making Presets to Simplify the Users’ Choices

Presets are custom combinations of parameters. They simplify the choice users have to make. They
limit the amount of decisions that users have to make.

Example

For example, you want users to use different trapping settings when printing offset versus dry offset.
You can define those trapping settings in a preset, so that users will only have to choose between
'offset' and 'dry offset'.

We start from a Manage Public Parameters dialog where the trapping step has 3 public parameters:

1. Click on  to remove the (default) Group named "Trap with PowerTrapper"
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2. Press the Add Group button.

A new "Untitled Group" is created. Click on  to change the name.

3. Press the Add Preset button.

A new "Preset" is created. Click on  to change the name.

By default, two example values will appear. the preset was renamed to 'Choosing Process
to Decide Traps'.

4. Define what the users will see:

a) in Prompt as, enter the text that users will see in the client application (replacing 'Type the
name of the preset here (e.g. “Paper Size”)').

b) enter the values that the users will choose from (replacing 'Type a value here (e.g.
A4)'). We here added 'Offset' and 'Dry Offset'.

Click Add if you want to add extra values (not the case in our example).

5. Drag the parameters from the dialog’s middle pane onto one preset item. This will make them
automatically appear under each preset item (here both under Offset and Dry Offset).
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6. Define the parameters values for each preset item.

See the above screenshot for a good example.

7. Click OK to confirm and close the dialog.

8. Save your ticket.
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Result: this is how the resulting dialog will look like to the users of the client applications:

Making Your Ticket Public

Important:  Only Public tickets or workflows can be launched from the client applications mentioned
here.

Note:  Default tickets can not be made Public.

To make a ticket Public, you can either:

• Select the Public option when creating the ticket.

•
Select your ticket in the Ticket view, click  and select Public.

• Right-click your ticket in the Tickets view and select Make Public.
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Note:  Public tickets have a mark in the Public column.

SmartNames

SmartNames are documented as a separate chapter in the "Complete Manual". Find it here:
SmartNames on page 916.

1.6.2 Launching a Task on a File

There are several ways to launch a task on a file (from the Pilot, from Shuttle, via Access Points or
via JDF/JMF). Here is how to launch a task from the Pilot's Files View.

1. In the Pilot, select the Files view from the Views bar (or use  Go > Files).

2. In the Containers mode, browse to your chosen file.

3. Right-click it, and select either:

• New Task to fill in the ticket's settings before launching the task.
• Launch with to launch the task without changing the ticket's settings.

Note:

If you don't have the Tickets: Show All Tickets and their Parameters (Public and other) access
right (see Access Rights on page 702 in the Reference Guide), you will only see Launch with.

In this case, you can only select public tickets, and only fill in public parameters in the ticket.

4. Select the ticket to use.

• If you have launched tasks previously, the most recent task tickets you used are listed.

• If you didn't, or if you need a different ticket, select More Tickets...

In the Select Ticket dialog that opens, select the task ticket you want to use and click OK.
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Note:  This dialog contains all the tickets suitable for the file type you selected. You can choose
either a Default ticket, or a custom ticket (saved under a different name) if you have already
created one.

5.
• If you chose New Task, the task ticket opens. Fill in the settings you want to use in the ticket

and click the Launch button.
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• If you chose Launch with and you have the Tickets: Show All Tickets and their Parameters
(Public and other) access right, the task is launched on the file as soon as you selected the
ticket. You don't need to fill in any settings.

• If you chose Launch with and you don't have the Tickets: Show All Tickets and their
Parameters (Public and other) access right, the task is launched on the file as soon as you
selected the ticket if there are no public parameters.

If the ticket contains public parameters, it will open for you to fill them in (you will only see the
public parameters). Click Launch when you are done.

Note:  For a description of all of the ticket's settings for each task, see The Tasks and Workflow
Controls on page 239 in the Reference Guide.

You can monitor the task's progress in the Files View's Task pane or in the Tasks View. See Check
the Status of the Task.

1.6.3 Checking the Status of the Task

After launching a task on one or several file(s), you can check its processing status in the Pilot’s
Tasks pane. You can see the Tasks pane in the Files, Product or Tasks views.
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You can see the progress (in percentage) and the processing state. The state can be:

• : starting
• : success
• : warning
• : failure
• : processing cancelled

You can also double-click the task entry in the Tasks pane to open your task ticket and check its
parameters.

Note:  Depending on your access rights, you may only see the public parameters.

1.6.4 Relaunching the Task

• To relaunch the task without changing the settings:

a) Select the task to relaunch in the Tasks pane.
b) Go to  Tasks > Relaunch.

• To change the settings and relaunch the task:

a) Select the task to relaunch in the Tasks pane.
b) Go to  Tasks > Open.
c) Change the task settings as necessary.
d) Click the Launch button.

1.7 Launching Workflows on Files

Workflows are documented in a separate dedicated chapter Workflows on page 986.

1.8 Viewing Files in the Automation Engine Viewer

1.8.1 Introduction

What is the Automation Engine Viewer?

The Automation Engine Viewer is a comprehensive, powerful and integrated Viewer and QA tool. It
can easily be integrated in your Automation Engine workflow, to view, check and compare graphic
production data. It can be launched directly from within the Automation Engine Pilot, on any Mac or
Windows computer in your network. Anywhere you can install and log on to an Automation Engine
Pilot you can start the Automation Engine Viewer (DTP, prepress, QA department, CSR desk...).

You can use as many Automation Engine Viewers as you have Pilot connections. Opening the
Automation Engine Viewer does not allocate an extra Pilot connection. It is even possible to have two
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or more Automation Engine Viewers on one workstation by opening a second Automation Engine
Pilot (Pilot - File menu - New window) and opening a file in the Automation Engine Viewer from there.
If you also use the Esko Bitmap Viewer, you will notice that the interface and shortcuts are nearly
identical.

The Viewer offers you

• Reliability: Showing the data in a correct way. At best in the same way the RIP / Proofer will see
them.

• Detail: Unlimited zoom, high detail measuring, measuring traps and exact distances (die objects).
• Speed: Opening files swiftly, even when it concerns large files. Fast zooming.

Supporting many file formats, Comparing and more

The Viewer supports many different file types: PDF, AI, ArtPro, images and even bitmap RIP data.
For a full list, see Supported File Types on page 580.

You can even compare with other files, even when they are a different file type and even when they
have a different size! Learn more in Comparing Files on page 81.

Basic use

To open files in the Viewer,

• click the word View next to your file.

• right-click your file and select View...

• select your file and go to  File > View .

Here 's a first look at the Viewer:
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You can zoom in on the file, measure distances and densities, view separations individually or
together, etc.

Note:  The Viewer has its own local On Line Help. Start it from the question mark icon in the top bar.

The concept of Prepared View Data

Reliability is a must. Detail can also not be compromised, it is always offered. The challenge lies in
opening very large files quickly. That is why the Automation Engine Viewer offers 2 view modes: with
or without Prepared View Data.

• In case you do not prepare View Data, the server will stream the data to the Automation Engine
Viewer. When a large file has to be opened or compared or when the server is very busy, a delay
can be noticed. Deep zoom detail mode is immediately available.

• In case you do opt to prepare View Data in advance, then the Viewer will show you the prepared
View Data instantly. Zooming in will of course require object data streaming from the server, but
then for a smaller area. For more information about creating View Data, see the task Prepare for
Viewer on page 415 in the Reference Guide.

Attention:  If the User Access Right for deep zoom is not enabled (read more in Defining
User Access Rights on page 33), then

• you can only view 'prepared' files.
• your zoom is restricted.

1.8.2 Comparing Files

The Viewer is also a powerful compare tool. It allows to compare two files and have a close look at the
differences, if needed per separation, including changes in images (internal or referenced images).
Various tools help you analyse those differences.
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1: The names of the two files that you are comparing

2: Enable difference view - to activate the Compare tool

3: View both - highlight the difference: the differences between the two files is highlighted in red.
Right-click this button to see the other options for compare that are available.

While comparing you can also use other tools like for example "view separations in separate
windows", measure, (de)select, rotate, etc...
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1: Show channels (Automatic tiling) - Right-click this button to see the other options that are available
to see the different channels.

1.9 Integration with Other Esko Applications

Note:  Integrating Automation Engine with WebCenter is documented in Integrating with WebCenter
on page 1346, a dedicated chapter in the Complete documentation of Automation Engine.

1.9.1 Review and Approval of Page Impositions using WebCenter

This chapter is specific on publishing page impositions to WebCenter. For all other generic
documentation on integrating Automation Engine and WebCenter, we refer to Integrating with
WebCenter on page 1346.

WebCenter Setup

In WebCenter, you need to set up a Project Template with Approvers.

You will use this template in Automation Engine when sending impositions: it will allow you to create
new WebCenter Projects (already containing your Approvers) as needed, directly from Automation
Engine.



1
Automation Engine

84

Note:  Alternatively, you can set up a WebCenter Project with Approvers in WebCenter, and send
your impositions to it from Automation Engine. But then you will only be able to create new Projects
from WebCenter and not from Automation Engine.

1. Create a new Project.

2. Add Members to the project.

3. Choose Approvers from within the Project’s members.

4. Save the Project as a Template.

Creating a New Project

1. Log in to WebCenter as a user who is a Project Manager.

2. Click Projects.

The Favorite Projects page is shown.

3. Click Create New Project at the top right of the page.

4. Choose Start from a Blank Project and click Continue.

5. Enter the name for the Project in the Project Name field.

• To make another user or user group the Project Manager for this project, select his or her
name, or the group name, from the Project Manager list.

• If desired, enter a description in the Description field.
• To make the Project active, set the Status as Active.
• To specify an optional due date, click the calendar control at the end of the Due On field and

select the desired due date. To set the due time, click the drop-down list box to the right of
the calendar control.

Note:  This is not the Approval Due Date. You will set the Approval Due Date when setting
the Approval Cycle.

• To use a custom thumbnail, click Change and enter the complete path and filename in the
associated field or Browse for it. To use the default thumbnail, leave that choice selected.
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6. Click Create Project.

The Project is created.

Adding Members to a Project

1. Once the project is created, click  Members  > Add Members .

This shows a list of the current WebCenter members.

2. Select the users or groups to add as members and click Continue.
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3. Set the members’ permissions as desired. For Approval tasks, members need at least View
permissions (selected by default).

Note:  The permissions you set here apply to all members you have just added.

4. Click Finish.

5. Once the members are added, click Go back to the project.

Adding Approvers to the Project

Approvers can be either regular users or they can be user groups.
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When you add a group as an approver, you must indicate whether:

• all the members of the group (select the group entry labeled as whole group) must approve
the document before it gets the approved status, or

• whether the approval of a single group member (select the group entry labeled as one of
group) will set the document to approved status.

Note:  You can only change (add or remove) Approvers when the Approval Cycle is stopped.

1. In the Project Page, click Approval.

2. Click Setup Approval.

3. Open the Add approver list, and select the individual users or the groups you want to add.

Tip:  Use Ctrl+Click to select multiple members.

Note:  The Project Manager is not automatically made an Approval User and must be explicitly
added to the list of Approvers.
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Saving a Project as a Template

Note:  To save a Project as a Template, you need have Administrator permissions.

1. If the user you are logged in with is not an Administrator:

a) Log out.
b) Log back in with an Administrator user.
c) Go back to your Project page.

2. In the More actions menu on the left, click Save as Template.

3. Enter the Template Name (different from your Project Name) and a Description.

To use a custom thumbnail, click Specify New Thumbnail and enter the complete path and
filename in the associated field or Browse for it. To use the default thumbnail, leave that choice
selected.
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4. Click Finish.

The Template is created.

Configure Workflow Approval Clients

When  and Automation Engine are not on the same LAN, you can use the workflow approval client to
establish a bi-directional communication. The Automation Engine Pilot needs to have the workflow
approval client credentials to send messages to .

This is configured through  Admin > Configuration > Workflow Approval Clients  in , and, in the
case of Automation Engine, in  Tools > Configuration > Web Sites  in the Automation Engine Pilot.

Attention:

Configure the  account first so that it can be tested from within the workflow approval server.

and the workflow approval server must use the same user name and password!

This is completely separate from a normal  user. Workflow approval clients may not log in to .

Two manual configuration steps must also be performed outside of  to ensure proper communication
between the workflow approval client and  systems that are not on the same LAN.

Create a Workflow Approval Client

1. Click  Admin > Configuration > Workflow Approval Clients.

2. Click New Workflow Approval Client.

3. Enter the User Name and Password for the workflow approval client user.

4. Click Create.

Note:  If you have several Automation Engine, Nexus, or Odystar sites communicating with , you
need to create a separate Workflow Approval Client for each site.
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WebCenter Sites

To configure links from Automation Engine to WebCenter sites, go to the item WebCenter sites in
the Configure  tool ( Pilot > Tools > Configure ).

Website:

Specify the web address of the WebCenter site. After you entered the WebCenter address, click
Open... to check if the WebCenter site is up and running. If you are redirected to the login page, it
means that the address is correct and that the site is up and running.

Tip:  Be aware that this address is also the address that will be included in the notification e-mails
when adding links to documents (approval cycle start e-mail). You should therefore make sure that
the address can be accessed from the outside. Make sure to not use an internal address, but one
that you want your users to use when they use WebCenter.

WebCenter and Automation Engine are in the same LAN

Check this toggle if this is true. This will most likely be the case. Un-check this toggle if WebCenter
and Automation Engine are remote.

Note:  How can you verify that WebCenter and Automation Engine are in the same LAN? WebCenter
and Automation Engine are in the same LAN when you can connect from WebCenter’s application
server, this is the system where JBOSS is installed, to an Automation Engine Job Folder with the
credentials of the user ‘BGSystem’.
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WebCenter's Approval Client:

If WebCenter and Automation Engine are not in the same LAN, you first need to create an Automation
Engine Approval Client in WebCenter. This is necessary to give Automation Engine permissions to
listen to the approval messages that are stored in WebCenter.

Tip:  If the Approval Client does not exist yet, follow these steps:

1. In WebCenter, log in as Administrator.
2. Go to the Admin section. In Configurations, select Workflow Approval Clients.
3. Click the link “New Workflow Approval Client".
4. Enter a User name and a Password for the Automation Engine client. Mind that this is also

the user name and password that have to be entered when configuring the WebCenter site in
Automation Engine.

Fill out the client Name and Password and click the 'Check Connection' button. This will check
if that user can log on successfully.

The Info button displays the following information: ”In case Automation Engine and WebCenter are
not in the same local area network (LAN), the retrieval of the approval results is secured by a name
and password. The name and password specified in Automation Engine must match the name and
password specified in WebCenter by the WebCenter administrator. When clicking the 'Check' button,
the WebCenter version will be checked and the name and password will be validated by WebCenter.”

Check Connection

When you click this button, you should, after a few seconds, get a window saying “Check OK". The
software version of that WebCenter will also be mentioned.

Note:  The button will check the validity of the user name or password to connect to that WebCenter
but not of your WebCenter’s Approval Client.

Note:  When you connect to a secured WebCenter site (for example one that uses HTTPS://), then
you have to export its security certificate and import it on the Automation Engine server. If this is
not done, publishing from Automation Engine to WebCenter will result in an error. Read more on
how to do this in the chapter Install SSL Certificates on the Workflow Production Server of the
WebCenter documentation.

Tip:  After configuring a new WebCenter site, it is recommended to close your Pilot and start it again
in order to see the updated list of WebCenter sites in your tickets.

Sending an Imposition from Automation Engine to WebCenter

Preparing the Imposition

1. In the Files view, browse to the FastImpose imposition file (*.imp) you want to upload.

Note:  The imposition file must be part of a job.

2. Right-click it and select Add to Imposition Gallery from the context menu.
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When you switch to the Pages view, you can see your file in the Imposition Gallery.

3. If the imposition doesn't show the pages preview (as in the previous example), add them as
follows:

a) Click on the first page's file name in the Page Gallery. This shows the page's preview in the
Details area at right.

b) Drag this preview onto the first page of the imposition in the Page list area.
c) Repeat this for the other pages of your imposition.

Sending the Imposition to WebCenter

If your imposition contains several books, you must send the books one by one to WebCenter. Each
book will be shown as a Page List in WebCenter.

1. In the Imposition Gallery, right-click the imposition (or the book) and select  New Task > Prepare
Imposition for WebCenter Workflow.
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If the Prepare Imposition for WebCenter Workflow task does not appear in the context menu,
choose More Tickets and select the task in the Select Ticket dialog.

2. Modify the settings of the Prepare Imposition for WebCenter step (the first step in the workflow)
if needed.

3. In the Send Imposition to WebCenter step, modify the settings of the Destination tab (you can
use SmartNames where indicated by the SmartNames button):

a) Select your WebCenter Site from the list.
b) Enter the name to give to your Project. Automation Engine will create this project in

WebCenter, from the Project Template you specify below.

Note:  You can also send your imposition to a Project already existing in WebCenter. In that
case, you don’t need to enter a Project Template. Note that this Project must have Approvers
defined in WebCenter.

c) If you want to send your imposition to a subfolder in the project, enter that Folder’s name. If
this folder doesn’t exist in the template (or project), Automation Engine will create it.

d) Enter the name to give to your imposition Document. This is the name that will be shown in
WebCenter. For example you can use [ImpositionName]_[BookName]_[LayerName].

e) Enter the Project Template to use to create your WebCenter project.

Important:  This Project Template must be defined in WebCenter. See WebCenter Setup on
page 83.

f) Enter the User Name and Password used to connect to your WebCenter site. You can use
an Encrypted password or SmartNames.

4. Modify the settings of the Approval tab:

a) Enable Start the Approval Cycle.
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b) Select a Due date and time.

5. Click the Launch button in the top left corner to upload the imposition to WebCenter.

Note:

If you don't start the Approval Cycle from Automation Engine, you will still be able to start it from
WebCenter, and view the approval results in Automation Engine.

For more information, see the WebCenter manual.

Approving the Imposition in WebCenter

In WebCenter 7.1, you can:

• Approve / reject documents sent from Odystar, Nexus or Automation Engine as regular
documents (see Approving a Document on page 95).

• Approve / reject documents FastImpose impositions added to the Pages View in Automation
Engine as regular documents or Page Lists (see About Page Lists on page 95 and Approving
a Page List on page 96).

When approving a Page List, you can:

• Approve / reject not only the whole multipage imposition but each individual page.

• Update and have version control not only on the whole multipage imposition but on each individual
page.

Note:  Only FastImpose impositions that have been added to the Pages View in Automation Engine
are recognized as Page Lists in WebCenter. Multipage files uploaded from within WebCenter, or from
Odystar, Nexus, or even other Automation Engine documents will never be treated as Page Lists.
Instead, they are considered regular multipage PDF documents.

When approving a Document, you can:

• If you are an Approval User: Approve the document, Reject it, or leave it Pending to approve /
reject it in the future.

• If you are a Project Manager: Approve or Reject the document, leave it Pending, or Force
Approve / Force Reject it if you need to overrule the approval status granted by the approval
users.

Note:

For more information about Forced Approval or Rejection, see the WebCenter manual.
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Approving a Document

Documents waiting for your approval are shown on My To Do List under My Work. If you are an
Approval User, do the following to Approve or Reject a document:

Note:

You can also approve or reject documents in the Viewer.

1. Click Approve/Reject at the end of the Approval field in the document header.

2. Choose the desired Approval Status from the drop-down list: Approved indicates approval;
Pending indicates future Approval or Rejection, and Rejected indicates disapproval.

3. Once you choose Approved or Rejected, you may not change the status later; a view-only version
of the page will be shown showing the choice you picked. Only a Pending status allows future
changes.

If desired, you can add a comment in the Comment field. Submitted approvals and comments
are shown on the Action History page.

4. Click Finish to change the status of the document.

To cancel the changes, navigate to another page without clicking Finish.

About Page Lists

What is a Page List document?

Page Lists are a special type of multipage PDF documents in WebCenter that represent imposed
books or magazines. As such they are an important tool for commercial printers.

Page Lists are uploaded from a Automation Engine production server using the Pages View in the
Automation Engine Pilot.

Note:  Only FastImpose impositions that have been added to the Pages View in Automation Engine
are recognized as Page Lists in WebCenter. Multipage files uploaded from within WebCenter, or from
Odystar, Nexus, or even other Automation Engine documents will never be treated as Page Lists.
Instead, they are considered regular multipage PDF documents.

Page List documents have two major advantages over other multipage PDF files:

• You can upload either the complete document, or specific pages only (for example, pages
6-12);

• individual pages can be approved or rejected in WebCenter (for example, you can approve
pages 3, 5 and 7-16 of a 16-page Page List).
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Note:  A multipage PDF file can only be approved or rejected as a whole.

Working with Page Lists

Page List documents are displayed as a single document in document lists. Click the Page List
name to view its pages and details in the dedicated Page List views.

Note:  Page Lists cannot be downloaded.

Approving a Page List

In order to approve your imposition as a Page List in WebCenter, you need to first login to WebCenter
as an approver, then navigate to the document (Page List) to approve, in the project created from
Automation Engine.

You can also access this Page List from the link in the approval notification email, if you received one.

Make sure you have the correct permissions to approve documents in WebCenter. For more
information, please see your WebCenter manual.

You can choose from a number of different methods to approve the pages in a Page List:

• Use the WebCenter Viewer:

a) In the Project, click on the Page List's thumbnail image. The Viewer opens, displaying the
Page List.

b) In the Approval area in the sidebar on the right of the Viewer window, select the appropriate
approval state (Approved, Rejected, Pending) from the list.

The Approval dialog opens in which you can add approval comments.

c) Enter your comments, provide your password if required and click Commit.

Note:  You can approve / reject one page at a time, or all of the document’s pages (using
Apply to all pages).
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• Use the Page Gallery view:

a) In the Project, click on the Page List's name.

The Document Details page appears.
b) Select Page Gallery from the menu.
c) Select the pages you want to approve and then click Approve/Reject. You can also use

Approve/Reject all Pages.

d) Enter your comments, provide your password if required and click Commit.
• Use the Page List view:

a) In the Project, click on the Page List's name.

The Document Details page appears.
b) Select Page List from the menu.
c) Select the pages you want to approve and then select Approve/Reject from the gearbox

menu. You can also use Approve/Reject all Pages.

d) Enter your comments, provide your password if required and click Commit.
• Use the Approve/Reject link on the Document properties page to approve all the pages at

once.

a) Enter your comments, provide your password if required and click Commit.
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Sending a RunList / PageList to WebCenter

You can send a RunList from Automation Engine to WebCenter without having to create an
Imposition. The resulting PageList will have pages in the right order. These pages are sent to
Automation Engine after approval.

In PageLists, information such as Sheet info is not available.

Use this workflow if you want to send pages to WebCenter in the right order to get them approved.

Note:  Unlike sending impositions, you still need to position them afterwards.

The uploaded PageList in WebCenter takes the Sheet Name NoImposition. The Sheet Name and
the Sheet Side will always be 0.

Preparing a RunList

Context for the current task

Run the Create RunList task on a multipage PDF file. Remember to enter a name for your RunList.
If the Name field is left blank, the task uses the file name.

Read more about the task settine in Create RunList from PDF on page 300.

A RunList is created and shown in the Imposition Gallery. Switch to the Pages view to see the
RunList and its pages.

Sending A RunList to WebCenter

1. In the Pages View, right-click the RunList and select  New Task > Publish Imposition on
WebCenter  .

2. Modify the settings of the Publish Imposition on WebCenter chain task.

Read more in Publish Imposition on WebCenter Chain on page 445

3. Click the Launch button in the top left corner to upload the RunList to WebCenter.

Note:

If you don’t start the Approval Cycle from Automation Engine, you will still be able to start it from
WebCenter, and view the approval results in Automation Engine.

For more information, see the WebCenter manual.

The RunList will be uploaded to WebCenter. If approval is required the approval feedback is visible
in page and proofs views.

Note:  In the pages view, the approval status is indicated in a color on top of the page. When
you hoover over the page, the details of the approval becomes visible.

Checking the Approval Results in Automation Engine

• To view the status of documents in a WebCenter Approval Cycle in Automation Engine, you can
use either:
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• the Pages View,
• the Proofs View,
• the WebCenter View.

In the Pages and Proofs Views

• Go to the Pages or Proofs View to view the approval status of each page of the imposition.

• In the Pages View:

• In the Proofs View:

Note:

When you try to expose a sheet that contains a rejected page, you will get an error in the
Expose task and an error status in the Plates View.

If you really need to expose the sheet anyway, you can overrule the WebCenter approval status
from Automation Engine (see Overruling the WebCenter Approval on page 102).

In the WebCenter View

In the WebCenter View, you can view the approval status of the whole imposition.
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Important:  You need to first set up the WebCenter View before you can view all the approved /
rejected documents in the WebCenter project you created.

1. Right click the WebCenter View’s background and choose Configure.

2. Enter the URL of your WebCenter site.

3. Enter the User name and Password used to connect to your WebCenter site.

4. In Project Name, enter the name of the WebCenter project you sent your imposition to. You can
use SmartNames.

Important:  Make sure this matches the Project Name of the project you created (or used) when
sending your imposition from Automation Engine to WebCenter. See Sending the Imposition to
WebCenter on page 92.

5. To check that the information you entered is correct and that the WebCenter server is running,
click the Retry Connection button at the bottom of the view.

You can also use the link at the top of the view to open the web page of the WebCenter project.

6. Once you have checked that your configuration is correct, use the Save to Configuration button
to save it.

Once it is saved, you will be able to return to this configuration using the Load from Configuration
button after any unwanted change.

7. Click the Show Documents button to view the documents in your WebCenter project.
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Note:  If at least one page of the imposition is rejected, the status of the whole imposition is Rejected.

Possible Document Statuses

This icon... means that...

the page and the original imposition layout have been approved by all
approvers.

Note:  The imposition layout can be approved even if some of its pages are
rejected.

the page has been approved by all approvers, but it may have changed the
imposition layout, which needs to be checked (for example for a new page
replacing a rejected one).

the page or the whole imposition has been rejected by at least one approver.

the page or the whole imposition has yet to be approved or rejected by at
least one approver.

When you hover on the top of a page in the Pages or Proofs View, you can see:

• the approval status,
• any comment entered,
• the date and time of the approval,
• the WebCenter user who approved/rejected the page.
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Overruling the WebCenter Approval

After your imposition has been approved or rejected in WebCenter, you can still overrule the approval
status of some of the pages in Automation Engine, if necessary.

1. In Automation Engine Pilot, go to either the Pages or the Proofs View and locate your imposition
document.

2. You can either:

•

Select a page of your document and use the  and  buttons in the View’s toolbar to
approve/reject the document without entering a comment.

• Right-click on a page of your document and choose Approve/Reject... to open the Approve/
Reject dialog where you can enter a comment.

3. In the Approve/Reject dialog, select Manual as Approval Type.

4. Choose to either:

• Approve,
• Approve with warning,
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• Reject the document.

5. Enter a Comment if you wish and click OK.

Note:  You can hover on the top of a page to view approval information, whether it has been approved/
rejected automatically in WebCenter, or manually in Automation Engine.

1.9.2 Integration with Nexus

Why run Nexus workflows from the Automation Engine Pilot?

You can use all the power of Nexus workflows from within a Automation Engine Job. This allows
you to bring both Automation Engine and Nexus workflows in line, running them from within a single
controlling environment: the Automation Engine Pilot.

How does it work?

The Send to Nexus ticket gives you access to the workflows that are available on a specific Nexus
server.

Any public parameters that have been defined in the Nexus workflow (NeXML) will show up on the
Send to Nexus ticket in Automation Engine. In addition, these public parameters are SmartName-
enabled, so you can use Job metadata to drive the Nexus workflows.

On the Nexus side the Copy to BackStage activity allows you to set up workflows that send their
resulting files back to Automation Engine.

Behind the scenes, Automation Engine and Nexus communicate via the SOAP protocol, exchanging
files and notifying each of other of their progress.

NeXML

Setting up public parameters in Nexus requires knowledge of NeXML. Please refer to the NeXML
Manual for more information.

Setup on the Nexus Side

To enable the Automation Engine Pilot to launch Nexus workflows, you must perform a number of
setup tasks on the Nexus server.

Mounting Your Containers on the Nexus Server

The Automation Engine containers have to be mounted on the Nexus server.

• If the Nexus server runs on a Windows OS, the container should be mapped to a drive letter on
the operating system.

• If the Nexus server runs on a Mac OS, the container has to be mounted over the SMB protocol.

Setting up the Nexus SOAP Server and Workflows

1. In the Modules list, double-click the NexusSoapServer module.

2. Enter a port number in the Listening Port field of the NexusSoapServer Module Defaults dialog,
and click OK.
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The Nexus SOAP server is now active.

Note:

The option User Management, which determines the workflows that a particular user can
access, is ignored by the Automation Engine Pilot. As a result, Automation Engine Pilot operators
automatically have access to all Nexus workflows.

3. Create valid Nexus workflows with the Input Type: Hot Folder.

4. Configure the Hot Folder queues for the workflows. Make sure the option Show in Shuttle is
selected.

Only Hot Folders that have Show in Shuttle enabled are published to the Nexus SOAP server
and become accessible to the Automation Engine Pilot.

5. Create the workflows with the Nexus Workflow Editor.

6. Make sure you add the Copy to BackStage activity at the end of the workflow.

Your Nexus workflow is now available for use with the Automation Engine Pilot.

Setup on the Automation Engine Side

1. In the Pilot, go to  Tools > Configure  and select the Nexus category.

2. Click  File > New .

3. Enter the name of the Nexus server in the Host field.

4. Enter the Port on which the Nexus server is accessible.

5. Click Test Connection to verify the settings you entered.

Note:  You can also test whether the Nexus SoapServer is online by browsing to the following url in
your favorite web browser: http://NexusServerName:5182.

Running a Nexus Workflow from the Pilot

To run a Nexus workflow from within the Automation Engine Pilot, you can use the Send to Nexus
ticket.

Additional integration features allow you to check the progress of the workflow in the Automation
Engine Task Monitor, to jump to the workflow in Nexus Manager, and more.

Understanding the Send to Nexus Ticket

The Send to Nexus ticket consists of two parts:

• the top section of the ticket dialog is always the same, and allows you to:

• select a particular Nexus workflow from the Workflow list;

• indicate whether you want to launch a new, separate workflow in Nexus for every file you select
in the Pilot (Separate Tasks), or whether you want to send all the selected files to one Nexus
workflow (One Single Task).

• the bottom section of the ticket dialog contains fields for the public parameters for the workflow
you selected. These parameters can be different for every Nexus workflow (they are defined using
NeXML).
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Note:  You can also manage your Nexus workflow's public parameters (not one by one but as a
group) in your task ticket. See Managing Public Parameters in Your Ticket on page 70.

Launching a Nexus Workflow from the Pilot

1. In the Pilot, select the file(s) you want to process with your Nexus workflow.

2. Launch the Send to Nexus task.

3. Select the Workflow you want to run.

4. If you selected multiple files:

• select One Single Task to send all the files to a single workflow in Nexus.
• select Separate Tasks to launch a separate Nexus workflow for every selected file.

5. Provide the required public parameters for the different activities in the workflow.

Note:  You can use SmartNames in all the public parameter fields.

6. Click Launch to send the files to the Nexus workflow.

The Send to Nexus task appears in the Task List, where you can see the progress of the Nexus
workflow. Note that progress is not displayed in real time.

The processed files from Nexus are returned to Automation Engine as the output of the Send to
Nexus task. In other words, you can include Send to Nexus as a step into a more complete workflow.

Switching Between Automation Engine and Nexus

• In the Automation Engine Pilot: in the Task List, right-click on the Send to Nexus task and choose
Go To Job in Nexus Manager to view the job in Nexus Manager (this command is only available
on Mac OS).

• In Nexus Manager, double-click the Copy to BackStage activity to view the job in the
Automation Engine Pilot.
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Note:  In order to jump from the Nexus Manager 9.0 to the Automation Engine Pilot, you must
connect to Nexus Manager with a blank user name and the password awsnexus.

1.9.3 Integration with Odystar

Why Run Odystar Workflows from the Automation Engine Pilot?

You can use all the power of Odystar workflows from within a Automation Engine Job. This allows
you to bring both Automation Engine and Odystar workflows in line, running them from within a single
controlling environment: the Automation Engine Pilot.

How Does it Work?

The Send to Odystar ticket gives you access to the workflows that are available on a specific Odystar
server. You can use the Send to Odystar ticket as a single task or as part of a more complete
Automation Engine workflow.

Any public parameters that have been defined in the Odystar workflow will show up in the Send to
Odystar ticket in Automation Engine. In addition, these public parameters are SmartName-enabled,
so you can use Job metadata to drive the Odystar workflows.

On the Odystar side the Copy File gateway allows you to set up workflows that send their resulting
files back to Automation Engine.

Behind the scenes, Automation Engine and Odystar exchange files and notify each of other of their
progress.

Example

• The Automation Engine workflow (top) sends the files to Odystar for additional processing before
outputting them to a proofer.

• The Odystar workflow (bottom) applies PrePress changes to the files before copying them back
to Automation Engine, where they go through the rest of the workflow (Proof step).
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Note:

Odystar accepts Normalized PDF files as input, but its changes may render the files non-Normalized.
We suggest that you do either (or both) of the following:

• send regular (not Normalized) PDFs to Odystar (add an Export to PDF File step before Send
to Odystar),

• re-normalize the files you get back from Odystar (add a Normalize PostScript / PDF / Illustrator
8.0 File step after Send to Odystar).

Setup on the Odystar Side

To enable the Automation Engine Pilot to launch Odystar workflows, you must perform a number of
setup tasks on the Odystar server.

Mounting Your Containers on the Odystar Server

• Mount the Automation Engine containers on your Odystar server using the SMB protocol.

Note:  Make sure you have Read and Write permissions for those mounted volumes from your
Odystar server machine.

Setting up the Hub and Your Odystar Canvases

1. On your Odystar server, launch the Hub application. You can find it in Odystar’s Server Software
folder.

2. Go to  Hub > Preferences.

You can also use the shortcut Command + , (comma).

3. In the Shuttle tab, enter the IP Address of the server running your Hub, and the port to use for
communication between Automation Engine and the Hub (in Shuttle Port).

Note:  By default this is port 5182, but if this port is already used by other processes, you should
enter the next available port.

4. Create your Odystar workflow using the Inspector.

5. Double-click the Receive Process Folder of your Odystar workflow to open its parameters.

6. In the Shuttle tab, click Enable Shuttle Queue.
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7. Make sure you add a Copy File gateway, with the Copy Back To Automation Engine mode
selected, at the end of your workflow.

Your Odystar workflow is now available for use from the Automation Engine Pilot.

Setup on the Automation Engine Side

1. In the Pilot, go to  Tools > Configure and select the Odystar category.
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2. Click  File > New.

3. Enter the name or IP address of the Odystar server in the Host field.

4. Enter the Port on which the Odystar server is accessible.

5. Click Test Connection to verify the settings you entered.

Note:  You can also test whether the Odystar Hub is online by browsing to the following url in your
favorite web browser: http://OdystarServerNameorAddress:5182.

Running an Odystar Workflow from the Pilot

To run an Odystar workflow from within the Automation Engine Pilot, you can use the Send to
Odystar ticket. You can use it as a single task or as part of a more complete Automation Engine
workflow.

You can also check the progress of the Odystar workflow in the Automation Engine Task Monitor.

Understanding the Send to Odystar Ticket

The Send to Odystar ticket consists of two parts:

• the top section of the ticket dialog is always the same, and allows you to:

• select a particular Odystar workflow from the Workflow list;

Tip:  If you can’t see the workflow you are looking for, use the refresh button .

• indicate whether you want to launch a new, separate workflow in Odystar for every file you
select in the Pilot (Separate Tasks), or whether you want to send all the selected files to one
Odystar workflow (One Single Task).

• the bottom section of the ticket dialog contains fields for the public parameters for the workflow
you selected. These parameters can be different for every Odystar workflow (they are defined in
the Inspector).

Note:  You can also manage your Odystar workflow’s public parameters (not one by one but as
a group) in your task ticket. See Managing Public Parameters in Your Ticket on page 70.
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Launching an Odystar Workflow with the Send to Odystar Task

1. In the Pilot, select the file(s) you want to process with your Odystar workflow.

2. Launch the Send to Odystar task.

3. Select the Workflow you want to run.

4. If you selected multiple files:

• select One Single Task to send all the files to a single workflow in Odystar.
• select Separate Tasks to launch a separate Odystar workflow for every selected file.

5. Provide the required public parameters for the different gateways in the workflow.

Note:  You can use SmartNames in all the public parameter fields.

6. Click Launch to send the files to the Odystar workflow.

The Send to Odystar task appears in the Task List, where you can see the progress of the Odystar
workflow. Note that progress is not displayed in real time.
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Note:  The files processed by Odystar are returned to Automation Engine as the output of the Send
to Odystar task (or as the output of the Send to Odystar workflow step when including the Send
to Odystar ticket in an Automation Engine workflow - see the workflow example).

1.9.4 Integration with Enfocus PitStop

You can integrate a separate install of Enfocus PitStop with Automation Engine, to be able to preflight
PDF files from the Pilot using the task Preflight via External Application.

Caution:  Depending on your licenses, check if your Automation Engine already has the
PitStop software built in. This then enables the Preflight with PitStop task.

To preflight a file using a separate software install of Enfocus PitStop:

1. Go to Tools > Configure and set up the connection to PitStop (see Preflight Tools in the
Reference Guide for more details).

2. Launch the Preflight via External Application task on your file. Learn more in Preflight via
External Application on page 405.

1.9.5 Integration with Third Party Applications using Hot Folders

The Integrate via External Hot Folder task allows you to integrate external prepress applications
into your workflow tickets. The only requirement is that the external system works with hot folders.

1. In the Integrate via External Hot Folder ticket, you define the location of the hot folder used by
the external application, as well as the Result subfolders in which the external application will
output processed jobs (the OK Folder), failed jobs (Error Folder) or jobs that produced warnings
(Warnings Folder).

2. When you process a job with this ticket, Automation Engine copies the files to the external hot
folder.

3. The external application picks up the files in its hot folder and processes them. The processed
files are saved in the subfolder that matches the processing result: OK, Warning or Error.

4. Automation Engine monitors the OK, Warning and Error folders for any files that have been
processed.

5. If it detects a file in the OK folder, Automation Engine copies it to the Output folder defined in the
Integrate via External Hot Folder ticket, and continues its workflow. Depending on your settings,
Error or Warning files might also be copied into the Output folder, or they might be deleted.
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Note:  In the Error area of the ticket, you can define an amount of time after which the external
processing should be considered as failed. To do this, enable the option Error when no result after ...
and define a time period (for example, you could enter one hour, a number of days, or even a specific
date).

1.10 Integrating with Third Party Imposition Systems

Automation Engine enables working with non-Esko imposition systems. These tasks import or export
industry standard file types to or from the Impositions in the Pages and Plates views.

You can check or change (approval) statuses, assign pages and select elements for further
processing or output in the Pages and Plates views in Automation Engine.

1.10.1 Workflows: The bigger picture

You can find a schematic overview of how impositions can be created, processed and exported
below. The tasks highlighted in green are new in Automation Engine 12.
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You can import populated or unpopulated impositions from applications that produces JDF layout
file as its output. Some of the applications that can write a JDF Layout file are Kodak Preps, Litho
Technics Metrix, Ultimate ImpoStrip , Dynagram Inpo2 , Dynagram Dynastrip, Plato and Pandora.

1.10.2 Importing and Creating Impositions

You can import the JDF Layout and use the Create Imposition from JDF Layout task to bring the
Imposition to the Pages and Plates views in Automation Engine.

If you start with a PDF file or a JDF Runlist, you can use the  Create RunList task to create a Runlist in
Automation Engine. Subsequently, you can use the Create Imposition from RunList task to create
Imposition from this RunList.

It is possible to separate the creation of a RunList and the creation of an Imposition from that Runlist
in time. In some cases printers prefer to let the RunList be approved and corrected before they select
the layout and create the Imposition.

You can achieve this by using two workflows.

1. Assemble the RunList and send it for approval.

2. Create the Imposition from the RunList and export it:

Read more about the new importing and creating tasks in the Reference Guide:

Create Imposition from JDF Layout on page 282

Create RunList from PDF on page 300

Create Imposition from RunList on page 283
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General Remarks

Note:  File Compatibility

• JDF layout files: tests have been done with Preps, Metrix, ImpoStrip, InpO2, DynaStrip, Plato and
Pandora.

• PDF files: Normalized as well as non Normalized files can be used in the Imposition workflows.
However, third party rips and workflows do not support external images.

Note:  Thumbnails in the Pages and Plates views are only shown when the pages in the files contain
thumbnails. If you have no thumbnails in your PDF files, you can speed up the system.You can also
save some screen space by hiding the details pane and by switching to  list mode.

1.10.3 Exporting Impositions

You can use Export Imposition to JDF Layout task to send an Imposition or part of an Imposition
to another workflow system or to a Rip that is compatible with JDF layout.

• The output is JDF layout containing a JDF runlist.
• You can create a runlist for the Join Pages task using this output. This allows you to create a

multipage PDF file to send to your customer for approval.

• It can be used to drive the FlexRip when followed by the Import JDF Layout task.

You can send an Imposition or part of an Imposition to a PDF Rip (for example Nexus Rip) using
Export Imposition to PDF task. The output will be a PDF file containing the Imposition.

More info regarding these exporting tasks in:

Export Imposition to JDF Layout on page 321

Export Imposition to PDF File on page 322

1.10.4 Workflows with Selection and the Convert Selection tasks

Page, RunList, Layer, PageSlot, Imposition and Plate are abstract file types that do not correspond
directly to a file. They can be used as entities in a workflow to route the elements you want to process
through the workflow. For example, you can import an Imposition and preflight all the PDF files
referred from that Imposition. The workflow below accepts a JDF Layout as its input, selects the
PDF files referred in the JDF file and waits until all of them pass the preflight check before producing
outputs as sheets to a PDF file. You need to convert the Selection to a PDF before Preflight.
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Read more about Convert Selection task in Convert Selection on page 270 the Reference Guide.

1.11 PDF Processing in Automation Engine

1.11.1 PDF Normalization in Automation Engine

Normalization in Automation Engine 10 and older

In Automation Engine 10 and older versions, PDF files had to be normalized at the start of a workflow
before any further processing could take place.

With the release of Automation Engine, 10.1 new PDF processing tasks were introduced that can
handle incoming PDF files without the need for normalization. However, these tasks could not
process normalized PDF files. On top of this the PDFs produced by these tasks needed to be
normalized before they can be handled by other tasks. As a consequence, it was not straightforward
to build workflows that used a combination of these tasks.

Improvements from Automation Engine 12 onwards

From Automation Engine 12 onwards, the collection of PDF processing tasks that do not require
normalization was extended. To avoid that the user needs to carefully consider which tasks require
normalized PDF as input when building workflows 2 features were introduced in Automation Engine
12:

• Tasks that do not require normalized PDF (the new ones added in Automation Engine 12 and
the ones that were added in Automation Engine 10.1) can now also handle normalized PDF, and
keep the files normalized.

• Tasks that require PDF files to be normalized will now do this automatically without the need
to introduce explicit normalization tasks in a workflow.

What Makes a Normalized PDF Special?

Overview

Normalized PDF differs from regular PDF 1.6 in the following areas:

• External references
• Color space
• Document level metadata
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• Object level metadata

External references

A Normalized PDF is not always self-contained. It can refer to images or other PDFs that are not
embedded in the PDF itself. Making use of references instead of embedding images and/or graphics
can have several advantages in the workflow. The main advantage is that it allows for “late binding”
for example an image can be color corrected. After the color correction all PDFs that refer to this
image will automatically contain the corrected version of the image without the need to open and
rewrite all those PDFs. Working with Normalized PDFs with external referenced can also lead to faster
processing especially when the Normalized PDF refers to large amounts of external image data.

Although referring to external files is a standard PDF feature (for example used in the PDF/X-5),
most PDF applications do not support this. To guarantee that a PDF can be processed correctly by
PDF application (like Adobe Acrobat) it has to be made self-contained (embedding all the referred
components like images). A self-contained Normalized PDF is 100% PDF compatible.

Color space

A Normalized PDF can only contain objects in the final printing color space. This final printing color
space can have any number of separations but in most cases this will be CMYK and some spot
colors. The PDF object model allows objects to be defined in RGB and CIE based color spaces. This
is not possible in Normalized PDF. During normalization such objects are color converted to CMYK.

The fact that Normalized PDF can’t contain objects in RGB or CIE based color spaces its biggest
limitation. On the positive side it makes the workflow more predictable. It avoids late and often
somewhat hidden color conversions for example in the RIP that can lead to problems in printing.

Document level metadata

A Normalized PDF contains XMP metadata. The schema of the XMP data is Esko specific, but the
specification is public. The XMP metadata serves 2 purposes. It contains info about the file that can
be extracted by 3th party applications and used for example for quality control or asset management.
The XMP metadata are also used by Esko applications like Automation Engine to retrieve information
from a PDF in an efficient way (for example the number of separations).

Object level metadata

A Normalized PDF contains metadata for specific objects like barcodes. Object level metadata are
added to allow modification of those objects using an Esko application. Object level metadata are
stored using a proprietary mechanism and format.

Which Tasks Require PDF Normalization?

The table below lists the Automation Engine tasks...

• that require normalization and will normalize regular PDFs automatically (Normalized PDF Tasks),
• that do not require normalization and work natively with regular PDFs (PDF tasks).

Note:  The exact list of tasks available on your Automation Engine Server depends on the licenses
you have, so some tasks in the list below may not be visible in your Pilot.

Normalized PDF Tasks PDF Tasks

Add Ink Eaters Adjust PDF Screening
Check Job Parameters Compare PDF
Check Print Rules (PRC) Create PDF File from RunList
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Normalized PDF Tasks PDF Tasks

Convert CMYK Colors Extract Inks
Convert Colors with Equinox Optimize PDF Document
Create Design (DesignWizard) Optimize PDF Separations
Create PAF/JPG/XML (LinkEdge) Preflight with PitStop
Create Report (ReportMaker) Process PDF Spreads
Enrich Black Resize PDF for Output
Export to 3D Resolve OPI
Export to ArtPro File Split Pages
Export to EPS/DCS File Version PDF
Export to PDF File  
Export to PostScript File  
Export to VRML File  
FastVariants (all tasks)  
Manage Colors
Optimize and Clean (PSFix)  
Outline Fonts  
PowerTrapper  
Prepare Station  
RIP (all tasks)  
Step & Repeat (all tasks)  
Trap (all tasks)  

How do PDF Tasks Work with Normalized PDF Files?

Task Task Type Description

Optimize PDF
Separations

PDF task The task checks whether the Normalized PDF input
file contains any external references to images or other
Normalized PDFs:

• if there are external references, the Optimize PDF
Separations task checks if the modifications it is
instructed to make will affect the external references. If
any of the external references are affected, the task will
first make the Normalized PDF input file self-contained
(by embedding all the external references).
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Task Task Type Description

• if there are no external references, or if the external
references are not affected by the Optimize PDF
Separations task will process the Normalized PDF
directly.

The task also updates the XMP document metadata.

Trap - Prepare
Trap Layer

Normalized PDF
task

The task traps the Normalized PDF file.

How Do Normalized PDF Tasks Work With Regular PDF Files?

Task Task Type Description

Optimize PDF
Separations

PDF task The PDF is processed directly, because Optimize PDF
Separations is a PDF task.

Trap - Prepare
Trap Layer

Normalized PDF
task

The task detects that the input file is a regular PDF
document, and automatically normalizes it. After that, the
file is trapped and a self-contained Normalized PDF is
produced.

The ticket used for Automatic Normalization can be configured using the Configure window in the
Automation Engine Pilot (choose  Tools > Configure  and navigate to  Processing Preferences >
Automatic Normalization ).

Automation Engine is pre-configured to use the “Normalize PostScript/PDF/Illustrator 8.0 File” ticket
called “OnDemand”. From this ticket only the settings in the “Color Management” tab are taken into
account. All other settings of the auto normalization are forced to fixed default settings. For example,
automatic normalization will always embed all images.
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PDF Normalization and Step and Repeat

Output formats

Depending on your choice in the Output Format list of the Step & Repeat ticket, the format of the
resulting document can be:

• PDFPLA
• a self-contained Normalized PDF
• a regular PDF



1
Automation Engine

120

PDFPLA

When you choose this option, the output of the step and repeat task will be a PDFPLA file.  A PDFPLA
is a Normalized PDF with external references to the 1-ups. It can be loaded and modified in Plato.
It can be RIP'ed directly by FlexRip. To send it to a non-Esko system, the PDFPLA needs to be
exported to a PDF using the Export PDF task.

Note:

PDFPLA output can only be generated if all the inputs are Normalized PDFs. The task will fail if a 1-
up at the input is not normalized on beforehand.

This format is the recommended output format when the primary purpose of the step and repeat
file is to send it to FlexRip.

Normalized PDF (embed all)

When you choose this option, the output of the step and repeat task is a self-contained Normalized
PDF. The 1-ups are embedded in the PDF using PDF forms so that the file size remains compact.
The file can not be modified in Plato. It can be RIP'ed directly by the FlexRip. It can also be sent
to a non-Esko system.

Normalized PDF inputs will be embedded in the output. PDF inputs will be auto normalized and then
embedded in the output.

This format is recommended when further processing is needed on the output, for example by
the Optimize PDF Separations task before sending it to FlexRip.
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PDF

When you choose this option, the output of the step and repeat task is   a PDF. The 1-ups are
embedded in the PDF using PDF forms so that the file size remains compact. The file can not be
modified in Plato. FlexRip can not RIP this file directly: it will first automatically normalize the step
and repeat file. The file can be sent to a non Esko system.

Normalized PDF inputs will be embedded in the output. PDF inputs will be embedded in the PDF
“as is”.

This format is recommended when the primary purpose of the step and repeat file is to send it
to a third-party, non-Esko RIP.

1.11.2 Retaining XMP data in PDF tasks.

It is possible to retain XMP metadata from third party software while processing native and normalized
PDF files in the following tasks (with PDF as input or output):

• Optimize PDF Separations
• Optimize PDF Document
• Adjust PDF Screening
• Resize PDF for Output
• Process PDF Spreads
• Resolve OPI
• Extract Inks
• Prepare Graphics for Nesting
• Preflight with PitStop (changes to XMP metadata are possible through specific PitStop Actions)
• Normalize PDF File
• Normalize PostScript / PDF / Illustrator 8.0 File
• Export to PDF File
• Trap with PowerTrapper
• Prepare Station
• Check Job Parameters
• Convert CMYK Colors
• Convert Colors
• Create PAF / JPG / XML (LinkEdge)
• Enrich Black
• Export to Normalized PDF (Embed All)
• Trap - Prepare and Create Trap Layer
• Outline Fonts
• Check Print Rules (PRC)
• FastVariants - Split (Deprecated)
• FastVariants - Remove White Boxes (Deprecated)

Following tasks can retain XMP data when specific settings are enabled.

• Split Pages: when the option Keep XMP Data is switched on, all XMP metadata is copied to
each and every output file.

• Version PDF: when the "Combine Base with Version Files" action is chosen, only the XMP
metadata of the base file is kept.
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1.12 Scripting

You can write Scripts (small programs) to automate the execution of certain tasks during a workflow.
Writing and using such scripts is called scripting. You need the Script Runner application to link
scripting with your Automation Engine workflows. You can automate actions from Adobe applications
(e.g. Illustrator, Photoshop, InDesign) and third party tools (for example Alwan) using Scripts.

Some of the instances where scripting is useful are given below:

• to ensure file format integrity (standardization) for workflow inputs.
• to use standardized PDF as input during the Preflight process.
• to automate Adobe Illustrator, Photoshop, InDesign and InDesign Server via ExtendScript on Mac

Os and Windows.

Supported Script Types

• AppleScript (on Mac OS)
• ShellScript (on Mac OS)
• Batch files (on Windows)
• Windows Script (VBScript, JScript) (on Windows)
• ExtendScript (on Mac OS and Windows)

More info on Scripting :Getting Started with Scripting on page 123

More info on Scripting in workflows: Use case: Scripting on page 125

1.12.1 Automation Engine Script Runner

The Automation Engine(AE) Script Runner is a standalone AE server component which runs scripts
on behalf of AE. You can add customization to your workflow by adding a Run Script task. This
task will run on the Automation Engine server while the execution of the script will be done on the
Script Runner application which can be installed on Windows or Macintosh. When you launch the
workflow, the following will take place:
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1. The Run Script task sends a request to run the specified script.
2. The Script Runner processes the request accordingly and runs the script.
3. The Script Runner sends the results back to the server.
4. The workflow will continue with the outputs from this task.

1.12.2 Getting Started with Scripting

Scripting helps you customize some steps in your work flows. You can achieve this by adding a Run
Script  task to the work flow where you want customization. The Automation Engine will use Script
Runner to run scripts which are stored either locally or on a server. When you launch the workflow in
Automation Engine, the Script Runner runs the script which contains the main function incorporating
the inputs from the Run Script task, output folder and some optional script parameters from the Run
Script ticket. The workflow in Automation Engine continues with the contents of the output folder
which contains the outputs from the script. To achieve this, you need to do the following steps :

1. Download Automation Engine Script runner. You can download it via the web access to the
Automation Engine Server. Client Apps > Tools .
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• On Mac OS, open the ‘dmg’ file after downloading the Script Runner which contains the
installer package. Double-click to start the installation.

• On Windows, double-click the downloaded installer to start the installation.

2. Install the Script Runner by following the instructions in the Installshield Wizard/Assistant and
make sure it is running in your computer.

• On Windows, open  Start > All Programs > Esko > Automation Engine Script Runner >
Preferences .

• On Mac OS, open  Applications > Automation Engine Script Runner > Esko > Automation
Engine Script Runner > Script Runner Preferences .

In the Script Runner Preferences window, you can:

• check if the Script Runner is actually running
• start / stop the Script Runner
• enable(disable) Start at login
• view and change the port the Script Runner is communicating with
• view and change the default folders for scripts

3. Configure the Script Runner on your computer. Read more in Scripts  on page 681.
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4. Write and save scripts. You can find sample scripts in the subfolders of /Library/Scripts/Esko on
Mac OS and C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts on Windows.

• You can store the scripts on your computer on a default folder(specific for script type). This is
ideal when you are developing and testing a script or when you do not intend to give access
to other Script Runners on the network.

Note:  The default location :

on Mac OS : /Library/Scripts/Esko.

on Windows : C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts.

Automation Engine does not back up these scripts.

• Alternatively, you can store your scripts in the Automation Engine data folder. This option is
suitable when you want to make your scripts available to all configured Script Runners.

Note:  The default location :

C:\Esko\bg_data_fastserver_v100\Scripts.

Automation Engine backs up these scripts.

5. Run the Script using Run Script task in a workflow. Read more about this in Run Script.

Note:  Refer to the Reference Guide for more on Scripting

1.12.3 Use case: Scripting

Note:

Sample scripts are solely intended to demonstrate techniques for accomplishing common tasks.
Additional script logic and error-handling may need to be added to achieve the desired results in
your specific environment.

It is up to the user to verify that his intended use of the offered automation functionality is compliant
with any third party license agreement and/or other restrictions applicable to any non-Esko products.

Please read Getting Started with Scripting on page 123 before conducting the steps below.

In this example, we are demonstrating a script which will perform a Photoshop action
and produce a JPEG output. The script 'EskoPSDoActionAndSaveasJPG.jsx' is available
from the sample scripts subfolder (ExtendScript) in /Library/Scripts/Esko on Mac or C:\Esko
\bg_data_fastserverscrrunnt_v100\Scripts on Windows.

1. You have to save the Set and Action in Photoshop . In this example we are using Default Actions
as Set and Molten Lead as Action.

2. You can open the script with ExtendScript Toolkit to edit the script if required. However, in this
sample, we do not need to edit the script.
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3. Edit the settings of the Run Script task as follows:

a) Run on: is the name of the computer where your Automation Engine ScriptRunner is
installed. The name in this example is ShaletMac. You can read more about configuring and
naming Script Runner in Scripts on page 681

b) Script Type: choose ExtendScript.
c) Script File: choose EskoPSDoActionAndSaveasJPG.jsx.
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d) Script Parameters: Add the name of your Photoshop Action name followed by your Set . In
this example, Molten Lead; Default Actions

e) Save the task.

4. Launch the task:

a) Select the Photoshop file.
b) Right-click the file and browse for the ticket.
c) Click Launch.

You will see that while the script starts to run on the Automation Engine Server, PhotoShop opens,
performs the actions, closes and continues the script. The result of this sample script is finally
an adjusted jpeg.

1.13 Example of Building and Using a Packaging
Workflow

1.13.1 Build a Workflow

Note:  Working with Workflows is documented in this dedicated chapter Workflows on page 986.

You can build workflows from zero or by using custom tickets and you create nested workflows.

You can use SmartNames on page 916 to use predefined values. You can also choose to have the
prepress manager build workflows that daily users will use, or let the daily users build workflows on
the fly while processing files. See Workflows on page 986.

The following steps will help you build this example workflow:

Preflight your file
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Preflight via External Application

The Preflight via External Application step allows you to preflight a PDF file by integrating external
(non- Automation Engine) preflight software into Automation Engine.

Attention:  To define the preflight settings for Automation Engine go to  Tools > Configure
and select Preflight Tools

1. From Start connect to the Preflight via External Application workflow step.

2. Double-click on the workflow step to edit its parameters. For more information go to Preflight via
External Application.

When Preflighting in a workflow, the Preflight via External Application workflow step has four
output pins:
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Note:

• Preflight OK: your files will go through this pin if the preflight gave an OK status.

• Preflight with Warnings: your files will go through this pin if the preflight gave a warning.

• Preflight with Errors: your files will go through this pin if the preflight gave an error.

• Error: your files will go through this pin in case of a processing error unrelated to the preflight
status.

3. Connect each pin to the appropriate workflow step (for example, files which are “OK” or “Warning”
can be normalized depending on your preflight setup, while files with “Error” need to be checked
by an operator).

Wait for Action (Checkpoint)

Use the Wait for Action (Checkpoint) task to make your workflow stop at certain predefined points
so that you have time to check and possibly correct something. See Wait for Action.

This Workflow is built so that you can route files based on your expertise. You will get a notification

(To Do List ), when the Preflight detects an error. The processing will be paused until you decide
whether to approve the file or not, based on the preflight error report.

1. Add the Wait for Action (Checkpoint) step to your workflow.

2. Double-click the step to open its settings.

3. Create the notification that will be sent:

a) choose which user you want to send it to,
b) enter a Subject,
c) add a Message if desired.
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4. Choose a Due date. Either:

• choose one of the predefined due dates (from Immediate to Next Sunday),
• choose Other... in the Due date list and pick the due date yourself.

5. In Output states, define the output possibilities you want for your checkpoint.

By default, this step has two outputs: Completed and Aborted.

To add an output:

a) click Add,
b) enter the output’s name.

Add as many outputs as you like.

6. If necessary, use the Move Up and Move Down buttons to display your outputs in a different
order.

Note:  You can Remove the default outputs if you don’t need them.

7. Click OK to apply your settings.
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Tip:  After connecting the Output states you can:

• Add an extra Output state to the checkpoint and connect it to the“Preflight via External
Application”step, to preflight your file again.

• Relaunch the file from the Task pane or directly in the canvas. Right click and choose Relaunch

Copy or Move File

This task copies or moves the input file or the marked files to a new location. To mark a file, please
insert the Mark file task in your workflow chain. If you don't want to evaluate an existing file, select
the "Fail" task when the file that is to be copied or moved already exists in the output folder. See
Copy Move File

Normalize your File

The Normalize PostScript / PDF / Illustrator 8.0 File generates a Normalized PDF file based on
the preflighted file. See Normalize PostScript / PDF / Illustrator 8.0 File

• Transparencies and Layers check the box to import PDF files as in Scope 3 (and lower). All
transparencies and layers will be flattened. If not checked, a normalized PDF file will be created
that contains all typical PDF features (like transparencies and layers).

Workflow overview

Trap your file

Note:  This example still used the older trapping technology that pre-dated the more recent task
Trap with PowerTrapper.
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Trap - Prepare and Create Trap Layer

The trapping process is a safeguard against possible (even likely) fluctuations in the printing process.
Minor discrepancies in registration, slight paper shifting can cause inks to mis-register. See What
is Trapping?

There are three different Trap tasks;

Trap – Create Trap Layer: This task traps the input file according to the settings specified in the Trap
Color Pairs file associated with the input file. The output of this task is a trapped Normalized PDF file.
This task contains only the output options of the Trap task. All other trapping parameters are stored
in the TCP file located in the same folder as the input file.

Trap – Prepare and Create Trap Layer: this step selects candidate trap color pairs and executes the
trapping. The trapping areas are added in a separate layer on top of the original job.

Trap – Prepare Trap Pairs: This scans through the job and suggests a list of candidate trap color pairs.

Export Trapped File to PDF

Export your Normalized PDF to generic PDF for storage or approval. See Export to PDF File

Tip:

• To define the name and location of the output file that will be generated, use SmartNames.
• You can send the output file via mail.
• You can use PDF as SoftProof.

Workflow Overview

View your file

Prepare for Viewer

The Prepare for Viewer task prepares view data for the Automation Engine Viewer. This view data
will help the Viewer to quickly open the file (the Viewer will use the prepared View Data instead of
asking the server to make or stream it). See Prepare for Viewer.
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Hold for Viewing

Choose a decision maker with experience to approve the trapped file. See Wait for Action. The
Automation Engine Viewer is a powerful integrated Viewer and QA tool. The Automation Engine
Viewer offers:

• Reliability: Showing the data in a correct way. At best in the same way the RIP/ Proofer will see
them.

• Detail: Unlimited zoom, high detail measuring, measuring traps and exact distances (die objects).
• Speed: Opening files swiftly, even when it concerns large files. Fast zooming.
• See Automation Engine Viewer.

Workflow Overview

Tip:  You could add an extra Output state, ”Send to Proof” to the checkpoint, connecting to
Proof(FlexProof) to print HardProof.

Generate Step & Repeat

Mark

 Use this to tag files that you will need to select later in the workflow (with the Select workflow
control). The file will be tagged as "Label" and after approved in Hold for Viewing, the Select will
pickup the original file.

• Give the tag a name.



1
Automation Engine

134

Select

 Use this ticket to select files that you have tagged earlier in the workflow (with the Mark
workflow control).

• Enter the tag of the file.

For an example see Mark and Select.

Step & Repeat Tabular

This Workflow Step executes all Step and Repeat parameters (number of one-ups vertically and
horizontally, gap between one-ups, alignment, SmartMarks...) after which the server will output the
sheet layout. The ticket's input fields also accept SQL queries, so that information stored in a
database can be used to drive the sheet layout creation. See Step & Repeat Tabular.
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Workflow Overview

Create Report

Create Report (ReportMaker)

The ReportMaker task is used to automate the creation of design print cards (in French: fiche
technique, in German: Drueck Karten).

The idea is that you generate reports containing all kind of information: file name, used inks, name of
the operator, an image of the file. All this information is defined in a report template, then this template
is used to generate a specific report. For more information about templates, see ReportMaker
Templates.

Note:  You need PackEdge 3.0 or higher to make a ReportMaker template.

Export Report to PDF

Export to PDF makes it possible to specify different settings, for example PDF version, Color
Management…

Tip:  You can define the File Name and the, Output location, of the report file that will be generated,
by using SmartNames.

Upload via FTP

Upload via FTP is an administration task which allows you to send files to a server. You need an FTP
account on that server. For details or how to connect to an FTP server, see Upload via FTP.

Tip:  To interact with customers you can also use steps like Publish on Web and Create WebCenter
Project.

Workflow Overview



1
Automation Engine

136

1.13.2 Use Shuttle in the Workflow

What is Shuttle

Shuttle is a small stand-alone application that enables you to submit files to Automation Engine tasks
or workflows, and monitor their progress. You can use Shuttle to connect to several servers. The
Shuttle functionality is also integrated in ArtPro, Neo, PackEdge, Plato, FastImpose and in Adobe
Illustrator as a DeskPack plug-in. You can download Shuttle from Esko's Download Center (https://
mysoftware.esko.com/). For more information about Shuttle see the Shuttle User Guide.

Set up Shuttle for Automation Engine

To use Shuttle and submit files to your Automation Engine workflow, you need to set up your server,
your Shuttle client, and make sure they can exchange files via a shared folder.

Workflow Server Setup

Automation Engine’s Configure tool. See Automation Engine Setup for Shuttle, Automation
Engine User Guide.

Shuttle Client Setup

Set up your Shuttle client in the applications you use. See Shuttle Clients Setup, Automation
Engine User Guide.

Shared Folder Setup

You also need to make sure that the relevant servers shared folders are mounted on the Shuttle
clients machines, with the appropriate Read and Write permissions. For Automation Engine, the
shared folder is either an Automation Engine Container, or an Upload Folder you set up in Configure.
See Automation Engine Setup for Shuttle, Automation Engine User Guide.

https://mysoftware.esko.com/
https://mysoftware.esko.com/
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What are Public Parameters

Learn more about Public Parameters in Using Public Parameters in Workflows on page 1051.

Making Your Tickets Public

With Shuttle, you can submit files to any Automation Engine task, task chain or workflow that has a
custom ticket. To do this, you need to make the ticket public. You can either:

• Select the Public option when creating the ticket.

• In the Ticket view, right-click your ticket and select Public Ticket.

Note:  Public Tickets have a mark in the Public column.

Using Public Parameters

Public Parameters are ticket parameters that users can define when they launch tasks using Shuttle
(applications).

For each public parameter, you can either:

• enter a list of predefined values that the user needs to choose from,

• let the user enter a value himself.

Making a Parameter Public

Attention:  You need to define which parameters are public before files are submitted to your
workflow.

In the ticket containing the parameter to make public:
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1. Right-click the parameter and select Make Parameter Public.

2. Right-click it again and select Modify Public Parameter...

3. In the Modify Public Parameter dialog that opens:

a) If necessary, change the way the parameter will be called in Shuttle in Prompt as.
b) Choose either:

• Allow the user to set the value if you want Shuttle users to be able to freely enter a value
for that parameter.

• Let the user select a predefined value if you want Shuttle users to choose from a list of
values that you define.

If that parameter already has a list of values to choose from in the Ticket, they will be
displayed here. You can Add or Remove values.

Note:  Shuttle operators will see (and choose from) the Predefined Settings but not the
associated Values.

c) If you have chosen Let the user select a predefined value: in Default Predefined Setting,
choose the setting that will be selected by default when submitting files from Shuttle (if the
operator doesn’t select another setting, this one will be used for processing).

4. Don’t forget to save your ticket.

This is how your public parameter will look to Shuttle operators:
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If you chose Allow the user to set the value If you chose Let the user select a predefined
value

 

 

 

 

Managing Public Parameters in Your Ticket

Once you have made parameters public in your ticket, you can have an overview of your public
parameters and edit them at the ticket level.

1. In your ticket, go to  Advanced > Manage Public Parameters...

The Manage Public Parameters dialog that opens contains all of your ticket’s public parameters.

The left pane shows all parameters that can be made public for that ticket (the ones you have
made public are greyed out).

The right pane shows the parameters you have made public, with their settings (predefined values,
etc.).

2. You can:

• drag parameters from left to right to make them public;
• click a public parameter’s cross  if you don’t want it to be public anymore;
• rearrange the order of your public parameters (drag them up or down);
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• change public parameters’ settings (Prompt as, Predefined Settings, etc.);
• group public parameters under a header (click Add Group, click  to edit the header, and

drag parameters from the left);

Using Presets to Simplify Operators’ Choices

You can use presets to minimize the amount of public parameters your operators have to choose
from, and make it simpler for them.

For example, you want operators to use different trapping settings for printing with offset or dry
offset. You can define those trapping settings in a preset, so that operators will only have to choose
between offset and dry offset.

In the Manage Public Parameters dialog:

1. Click the Add Preset button.

2. Enter what your operators will see:

a) in Prompt as, enter the name to give the preset parameter in Shuttle,
b) enter the values that operators will choose from (replacing Type a value here).

Click Add if you need to add extra values.
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3. Drag parameters from the dialog’s left pane into the preset.

You can drag as many parameters as you want. They will appear under each value (here both
under Offset and Dry Offset).

4. Define the parameters values for each preset value.

For example, define normal trapping, 50% opacity and object dependant end caps for Offset,
and reverse trapping, 100% opacity and round end caps for Dry Offset.

5. Don’t forget to save your ticket.

This is how your preset will look to Shuttle operators:
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Public Parameters in Sample Workflow: Packaging

When choosing which parameters to make public you can keep have in mind end production,
different customers, workflow capability etc. Define the parameters so that you can change the
production file without having to change the workflow ticket.

Launching Files into a Workflow

Launching Files from Shuttle Standalone

1. To assign a Job ID and / or Job Part ID to the files to process in your workflow, go to  Window
> Context  and fill in the Job ID and / or Job Part ID.
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Do this when:

• you want to add your file(s) to an Automation Engine job,

Note:  If the file you are launching is already located in an Automation Engine job, it will
automatically be processed within that job’s context (you don’t need to enter the Job ID).

2. Open the Launch window using:

• File > New Launch Window... ,
• Option + Command + N (Mac) or Alt + Control + N (Windows).

3. Select the Workflow you want to launch on your file.

• For Automation Engine workflows, you will see public tickets.

Note:

You can open several Launch windows, and select a different workflow in each.

If you quit and restart Shuttle, your Launch windows will be remembered.

4. Launch your file in one of the following ways:

• Drag and drop your file on the Drop Files Here arrow.
• Click the Launch... button and browse to the file you want to launch.
• Go to  File > Launch...  and browse to the file you want to launch.
• Use Command + S (Mac).

5. If your workflow has public parameters, you will see a pop-up where you can fill them in.
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Note:

For more information on public parameters, see:

• Using Public Parameters  on page 68,

Launching Files from PackEdge

Attention:  You must save your file on an Automation Engine Container before you can launch
it into a workflow from PackEdge.

1. Go to  File > Launch Workflow...

This opens the Launch Workflow window.
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2. Select the workflow you want to launch on your file in the workflow list.

3. If your workflow has public parameters, you can fill them in in the same window.

Note:  For more information on public parameters, see Using Public Parameters  on page 68.

4. Click Launch to launch the workflow on your file.

Tip:

To access Shuttle easily in the future (without using the menus):

1. Go to  Window > Toolbars > Shuttle to open the Shuttle palette.

2. Drag it into your application’s toolbar.
3.

Click  to open the Launch Workflow window, or to open the Shuttle window.
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2. Reference Guide

2.1 Copyright Notice

© Copyright 2015 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BVBA. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BVBA does not warrant, guarantee or make any representations
regarding the use, or the results of the use of the software or the information contained herein. Esko
Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising
out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published,
in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other
means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE
®
, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other

trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly
owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2014. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.
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Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by BestTM Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

2.2 What is Automation Engine

Automation Engine Architecture

Automation Engine is a client/server workflow software, running on Mac and Windows. This means
that one machine runs the Automation Engine server, to which you can connect from all Mac and
Windows machines in your network (using the Automation Engine Pilot).

Your Automation Engine server can connect to graphical editing software like ArtPro, PackEdge,
Adobe Illustrator (using the DeskPack plug-ins)...

It can also connect to your RIP software to ensure professional output.

You can store your files either on the Automation Engine server, on a dedicated file server, or on
different machines over the network.
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Automation Engine Processing

Automation Engine processes your files using single Tasks (for example a Trap or RIP task), or
Workflows ( more powerful and flexible series of tasks that can take complete care of the file from
arrival to final output).

Files and Jobs in Automation Engine

In Automation Engine, your files can be part of Jobs (customer orders that contain files and related
customer information), that are located in Containers (local or remote shared folders that Automation
Engine can access).

Depending on how you want to work with Automation Engine, you can link your jobs to customer
Products, focus on job Pages, Proofs, Plates...

Automation Engine Integration

Automation Engine can not only connect to editing and RIP software, but also to WebCenter (Esko’s
collaborative web platform) and other Esko workflow software (Nexus and Odystar). Automation
Engine can also be integrated with external systems.

2.2.1 The Automation Engine Pilot

The Automation Engine server software runs on a Windows server. Every Automation Engine action
is performed through the Automation Engine client, called the Pilot.

The Pilot can be installed on any Mac or Windows machine on your local network.

Depending on the user access rights you will set, operators can use the Pilot to:

• organize Jobs and files,
• create and modify tickets,
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• launch and monitor tasks,
• control workflows and devices,
• administrate users and perform general configuration,
• etc.

The Pilot's Main Window

1. These icons show different modes in the Pilot:

• Containers : This shows all the data that Automation Engine can access, in the different
Containers. Learn more in  Containers on page 24.

• Job Overview : This lists all jobs existing in the Automation Engine jobs database. Learn
more in Jobs on page 828.

• Last used Job : This shows the last job you worked on, and the job's data (files and folders).

2. The Views highlight different parts of the Automation Engine functionality. Certain views are only
accessible in defined workflows. Learn more in Views on page 22.

3. The Tools area contains tools useful to administrate Automation Engine. Learn more in The Tools
on page 616.

4. •
The Create Job  button allows you to create a job.
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•
The New Task  button creates a new Ticket from the pilot.

•

You can create a new workflow from the pilot using .

•
Using the  button, you can access the information regarding the files.

Note:  In the Job Overview mode, only Create Job  is available.

The contents of the central panes depend on the View you are in.

Tab support

In any Automation Engine view, a new tab can be created by using one of the following methods:

• Click  File > New Tab .

• Use the keyboard shortcut Control-T (Windows) or Command-T (Mac).

• If the tab bar is visible, you can also create a new tab by clicking the plus button in the tab bar .

• If the tab bar is visible, you can also create a new tab by right-clicking on the tab bar and choosing
New Tab.

Note:  The new tab will open with the same view that was active.

An opened tab can be closed by one of the following methods:

• Click on the close button in a tab (visible by hovering over the tab).

• Use the keyboard shortcut Control-W (Windows), or Command-W (Mac).

• Click on  File > Close Tab .

• Right-click on the desired tab and choose Close Tab.

Note:  To close all other tabs, safe the desired one, you can also choose Close Other Tabs from
this menu.

Full Screen Mode on Mac

When running the Automation Engine Pilot on Mac OSX or newer, you can enter and exit the Full
Screen Mode by using one of the following methods:

•
Click on the Full Screen button  in the top right corner of the main window

• Click on  Views > Enter Full Screen .

• Use the keyboard shortcut Command + Control + F.
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Views

The Pilot's Views highlight different parts of the Automation Engine functionality. You can use them
to work with your data in different ways (see Different Ways of Working with Automation Engine on
page 182).

Note:

• Depending on the Data View mode you are using (Containers, Job Overview or Last used job),
you will have access to different views. Only those that make sense are shown.

• Depending on your access rights, you may not be able to see some of the views.

Files

The Files view allows you to manage your jobs, files, favorite tickets, tasks... Learn more in The Files
View on page 152 for more information.

To Do List

The To Do List view lists all actions that need user intervention. Learn more in The To Do List View
on page 153 and To Do List on page 616.

Pages

The Pages view is only used in page workflows. It is extremely useful when working with page
impositions. For more information, see Working with Pages on page 182.

Products

The Products view shows the items you added to your Products database. This concept is useful
to customer who have re-prints. Products represent production data that you linked to a Job. It is
the Job order that has the specifications how to output the product this time, with or without many
other Product items.

Products are what you keep long term, until you are sure you will not have to produce them again.
Jobs however are Work In Progress, temporary by definition. A Job should be removed when it is
finished. Learn more in the dedicated chapter Products on page 876.

Proofs

The Proof view is only used in page workflows. It shows the proof sets and the proof details. Learn
more in Working with Proofs on page 189.

WebCenter

This view enables Pilot users to see what documents are inside a WebCenter project, without having
to use a browser. Read more in separate chapter Integrating with WebCenter on page 1346, in its
section The WebCenter View in Automation Engine Pilot on page 1349.

Plates

The Plates view is only used in page workflows. It shows details about all plates associated with
a job. It also includes advanced features for managing plates for jobs with multiple variants. Learn
more in Working with Plates on page 192.
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CDI

The CDI view shows all the files sent to the Digital Flexo Suite and used to image a flexo plate on a
Cyrel Digital Imager. See The CDI View on page 159.

Gang Run Printing

The Gang Run Printing view in the Pilot shows an overview of all graphics waiting to be nested and
printed on your available substrate sheets. It has two parts:

• The list of all substrates.
• The table of graphics waiting to be nested and printed on the selected substrate.

For more information, please see The Gang Run Printing View on page 1091 in the separate chapter
Working with Gang Run Printing on page 1081.

Tasks

The Tasks view shows the running tasks, the tasks waiting for execution and the finished tasks.
Learn more in The Tasks View on page 160. This list of tasks can be automatically cleaned up by
using Task Cleanup Rules on page 682.

Devices

The Devices view lists all output devices connected to your Automation Engine server. It allows you
to monitor, start and stop your devices and device queues.

Milestones

The Milestones view shows the milestones set for your job (in Last used job mode), or shows the
milestones set for all jobs (in Job Overview mode). Learn more in Milestones: Tracking Job Status
on page 854.

Tickets

The Tickets view shows a list of all tickets available on your server (both the default and your custom
tickets). Learn more in  Tickets on page 26.

Jobs

This view is only visible in Job Overview mode. It lists all or a filtered list of your jobs in the Automation
Engine job database. Learn more in The Job Views on page 830.

SmartNames

This view lists all SmartNames defined on the server. It is not visible in Job Overview mode. Learn
more in The SmartNames View on page 920.

The Files View

This view is available in Containers and Job modes.
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1. The Folders pane shows your containers, folders and job folders (in Containers mode) or a job
folder and its subfolders (in Job mode).

2. The Contents pane shows the contents of the folder you selected in the Folders pane. It only
shows the contents of a job folder in Job mode.

3. The Launch Favorites pane allows you to add tickets to your favorites and find them again quickly
to launch them. For more information, see Favorite Tickets on page 179.

4. The Tasks pane shows all the tasks launched for a job (if a job is selected), or all tasks launched
on your server.

The To Do List View

This view is available in Containers and Job modes.

The To Do List view lists all actions that need user intervention. Among these actions are Messages,
Checkpoints, Red Alerts, Milestone Actions.

Use this view to view, modify, forward and delete these actions, and all related files.

Note:  The To Do List view is job context dependent:

• in container mode you can see all To Dos,
• in a job context you only see the To Dos of that job.
•

you can release the jobs from this view by clicking on  .
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Tip:

• Initially, the entries in the To Do List are not sorted. You can sort them by clicking the appropriate
column heading.

You can also show / hide or reorganise columns by going to  View > Select Columns in 'To Do
List'...

• You can refresh the list using Ctrl + R or  Edit > Refresh .

For more information, see To Do List on page 616.

The Pages View

This view is only available in Job mode. It is only used in page workflows.

The Pages View is divided into several panes. The top part of the view (the Page Gallery and
the Details pane) displays both assigned and unassigned pages, the bottom part displays the
impositions, layers and assigned pages.
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1. The Page Gallery pane lists all incoming files, indicates the number of pages and the assignment
status.

2. The Details pane displays thumbnails of the individual pages of the selected file.
3. The Imposition Gallery pane shows the imposition structure with its different books. It also allows

you to create books that later will be used in an imposition.
4. The Layers pane shows the different layers of the selected imposition. You can rename layers,

approve them, and set them empty or blank.

Note:  The Layers pane is only visible when the selected imposition or book contains more than
one layer.

5. The Page List shows you which pages are assigned and which are not. For each page status
information can be asked.

6. Click the Page List button to switch between thumbnail view or list view.

You can view both the task status and the page status information. Simply right-click the columns
Page Gallery and / or Imposition Gallery pane(s) and select both Task Status and Page Status.
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See Working with Pages on page 182 for more information.

The Products View

This view is available in Containers and Job modes.

The Products view is a user-friendly, searchable view on the Products database. You can use it to
create new Products, search them and link them to Jobs.

You can see the Products in a thumbnail view  or a list view .

Working with Products is documented in a separate chapter Products on page 876.

The Proofs View

This view is only available in Job mode. It is only used in page workflows.

The Proof View consists of two panes that give a different view on the proof:

1. The Proof Sets pane, where the proof sets are listed.
2. The Details pane is a visual presentation of all proofs of the set.

The Proof Sets pane shows you the names of the proof sets, both hardcopy proofs and softproofs, as
well as the number of flats, pages, status, the date on which they were last modified and information
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about the kind of proof that has been made (Content proof if a file is proofed, or Imposition proof
if an imp file is proofed).

Thumbnails of the proofs can be viewed with the corresponding application, for example Acrobat
for PDF proofs.

The Info button will open a properties file of that page (proof).

See Working with Proofs on page 189 for more information.

The WebCenter View

This view is only available in Job mode.

Attention:  You need to have configured the connection to your WebCenter site before you
can use this view. See WebCenter Sites - OLD.

Jobs that have been published on WebCenter (with the Publish on Web task or the Publish
imposition on WebCenter Chain) will appear in the WebCenter View.

Those jobs can have different statuses:

• When a job arrives on the WebCenter site and approval is required, its status will pending.

• Files which do not require approval are marked with approval is not required.

• After a file is approved or rejected in WebCenter, you can see its approved or rejected status
in the WebCenter view.
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The status will be updated in Automation Engine as soon as the job is approved or rejected in
WebCenter.

Tip:

• Press F5 to update the WebCenter view to the latest information.
• Click the link in the top-left corner to open WebCenter in a browser window.

See Review and Approval of Page Impositions using WebCenter on page 83 in the User Guide for
more information.

The Plates View

This view is only available in Job mode. It is only used in page workflows.

Note:  In a page workflow, the job's inks are also used for creating "expected" separations (and
corresponding plates) in the Plates View. This means that an expected separation will be created
for each ink and for each sheet. If the assigned pages contain inks that are not listed in the inks list,
"unexpected" separations will be created.

• The Plates View makes it easier to manage the most important deliverables that prepress provides
to the press room, plates.



2
Automation Engine

159

• It gives an overview of the total number of plates that have to be output.
• It allows you to track the progress of a job at a very detailed level.
• It allows you to detect discrepancies between the expected plate output and the supplied data

very easily.

For example, when a sheet side is supposed to have only a black plate, but one of the supplied
pages for that sheet side contains CMYK, this can be easily seen in the Plates overview.

The same is true for the inverse situation (for example when an expected Pantone plate is not
being realized).

See Working with Plates on page 192 for more information.

The CDI View

This view is available in Job Overview and Job modes.

The CDI view shows all the files sent to the Digital Flexo Suite (using the Make Plate on CDI task)
and used to image a flexo plate on a Cyrel Digital Imager.

You can view the flexo plates created for all jobs (in Job Overview mode) or for a particular job (in
Job mode).

You can double-click an entry in Job Overview mode to see all the plates and len files corresponding
to that job in Job mode.

You can also select an entry to view its Details at the bottom of the window.
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See Make Plate on CDI on page 364 for more information.

The Tasks View

This view is available in Containers and Job modes.

• In Containers mode, it shows all tasks and workflows.

• In Job mode, it shows all tasks and workflows run for that job.
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Tasks

For each entry in the Tasks list, you can see the Job Name, the File Name, the Task Type...

You can show / hide or reorganise columns by going to  View > Select Columns in 'Tasks'...

Details

Select an entry in the Tasks list to show its Details below. They include extra information, like when
processing was Started and Finished, and some processing details.

Note:  For more information on how to run tasks and workflows on files, see Launching Tasks on
Files on page 67 and Workflows on page 986 .

Display Related Tasks

If you want to filter all tasks in this view to only the ones you are interested in, you can select a few
desired tasks and choose to Display the Related Tasks. This way it's easier for you to follow up
your tasks, spot user interactions and possible errors in your workflows.

To display all tasks that are related to one or more workflows, proceed as follows:

• Select one or more tasks, belonging to the desired workflows.
• Right-click on one of the chosen tasks.
• Choose Display Related Tasks.

A filter on the Tasks list will occur, focusing on the chosen workflows. In this filter, only tasks belonging
to the chosen workflows are shown. This is indicated in the scope bar as Focused on X workflows.
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To reveal all tasks once more, click on Done in the right-hand side of the Tasks view.

The Milestones View

The Milestone Views are documented in the dedicated chapter on Jobs on page 828.

The Tickets View

This view is available in Containers and Job modes.

You can see all the available tickets in the Pilot's Tickets view.

You can see:

• default and custom tickets,
• global and job tickets,
• public tickets.

See  Tickets on page 26 for more information about tickets.

The Jobs View

The Job Views on page 830 are documented in the dedicated chapter on Jobs on page 828.

The SmartNames View

The The SmartNames View on page 920 is documented in the dedicated chapter on SmartNames
on page 916.
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The Gang Run Printing View

The The Gang Run Printing View on page 1091 is documented in the chapter dedicated to Working
with Gang Run Printing on page 1081.

Smart Views

Smart Views allow to save a filter as a custom view.

You can do this for all filters for the items available under Views. You can create Smart Views for
all View types: lists of Tickets, Tasks or Jobs, Products, Milestones etc. Smart Views also makes it
easier to and to navigate between views.

How to create a Smart View is explained below.

You can modify a Smart View's filter setting by double clicking the Smart View name.

You can remove a Smart View by right-clicking it and choosing Remove from Views Bar.

Creating Smart Views

As an example, follow these steps to create a Smart View that will filter all tasks based on these
criteria:

• Belong to a chosen operator/administrator
• Launched during the past two days
• Failed

1. In the Automation Engine Pilot, go to the Containers view and then click Tasks to see an overview
of all tasks.

2. Press Ctrl + F to open the Search bar and see the extra filter options that can help you to limit
your search results.
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3. Set these filters:

• Set the first filter to Operator + is + <the operator whose task you want to see>. You can
browse for the operator/administrator of your choice by clicking the Browse button in the
Search field (1).

• Open a second filter line by clicking the +-button (2) in the first filter line.
• Set the following parameters for this second filter: Launched date + is + within last + 2 + days

4. Click the +-sign in the second filter line while holding down the Alt-key.
It changes into a ... - sign and allows you to further specify that second filter line by adding one
or more criteria to it.

5. Add these filters:

• All of the following are true
• State is 'cancelled'

6. Click Save to save these filter settings in a Smart View and give it an appropriate name.

• Select the option All users to make this Smart View accessible for other users all well.
• Select the option Add to my views bar to add this smart view to the Views bar.
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The Smart View 'Admin tasks - failed - 2 days' is now part of the Smart Views list.

Pilot Preferences

Go to  Edit > Preferences  to open the Pilot's Preferences.

Tickets

• Show default tickets: select/deselect this option to show/hide the default tickets.

• Use bold ticket names in task launching menu: select this if you want to see the ticket names
in bold when doing New Task or Launch with on a file.

• Show only Public Parameters in Tickets: this preference is only available if you have the
Tickets: Show All Tickets and their Parameters (Public and other) access right (see Access
Rights on page 702).

It is selected by default. Deselect it to only see public tickets and public parameters in the Pilot
(you will see the Pilot as if you didn't have the Tickets: Show All Tickets and their Parameters
(Public and other) access right). You can select that preference again at any time to go back
to the full Pilot.

This is useful for administrators who want to check how users without the full Pilot access right
will see the tickets and their parameters.

• Units: select the units you want to work with for Dimension (mm, cm, mil, inch, point), Resolution
(ppi, ppmm, ppcm) and Ruling (lpi, lpmm, lpcm).

• Enter the number of Decimals you want the system to display.

Files

The Preview Size allows you to define the size of the preview in the Info dialog for example (in pixels).

Open Normalized PDF files with

Indicate which application should become the default application when opening Normalized PDF
files from within the Pilot.

Normalized PDF files have a .PDF extension, which implies that the OS will not make a distinction
between Normalized PDF files and regular PDF files.

By default PDF files will be opened by the OS with Adobe Acrobat Reader if it is installed. However,
when working with the Pilot, you probably will want to see Normalized PDF files opened in an Esko



2
Automation Engine

166

editor. As making this distinction is not possible on OS level, you will have to specify here which
application you prefer to use.

So, if a PDF file is double-clicked in the Pilot, and it happens to be a Normalized PDF file, the
application selected in the Files tab will be used.

On OS level (for example in Windows Explorer or Macintosh Finder), Adobe Acrobat Reader will be
the application that is started up when you double-click a Normalized PDF file.

This preference will be taken into account:

• In the Files View, when double-clicking the file or selecting Open from the pop-up menu.

• In the Task View, when selecting Open Output File from the pop-up menu.

• In the To Do List, when clicking a URL link to a PDF.

Tip:  Still, the Pilot also offers Open with which allows you to indicate the non-default choice.

Pilot

You can indicate the Number of recently used jobs in the job selector. By default this is set to 10.
Changes will be applied when you log back into your Pilot.

Jobs

Multi-Job Removal

Select your preferences when you remove multiple jobs at once:

• Remove Jobs even when they are in use by other users.

• Remove Jobs even when they contain unfinished tasks.

2.2.2 Data Management in Automation Engine

Automation Engine works with  Containers on page 24, Jobs on page 828, Products on page
876, files and folders.

Customers with page (imposition) workflows can use the extra modes Pages, Proofs and Plates.

 Containers

A Container is a network data share that contains the data that Automation Engine can work with.
You can make (part of) an existing network share a Container or you can have Automation Engine
create such network shares. These Containers can be located either on your Automation Engine
server or another computer in the same LAN.

By default, you have an empty ExampleJobContainer, on the disk drive that Automation Engine
was installed on.

You can have many Containers. You can see and browse though them in the Pilots’ Containers
mode.
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To create a Container, see Creating a Container on page 691.

 Jobs

What is a Job?

A Job represents a to do for Automation Engine. A Job contains all the files and information related
to a specific job-order. A Job has a unique name. A Job represents a job order and is also WIP: Work
In Progress. This means that in Automation Engine you should remove Jobs that are finished. Still,
the Jobs database can hold up to 100.000 Jobs.

It has a blue icon  and is stored in the Automation Engine Job Database.

In the Containers mode, you can see your Job in its Container.

In the Last used Job mode, you can see your Job’s subfolders and files.

Job Metadata (Job Setup Parameters)

You can attach an extended set of metadata to every Job: customer information, inks to use, bar
codes, impositions, categorizations or any other custom parameter...). This metadata is stored in
the Automation Engine database, and can be used when launching tasks on the Job. Ideally, these
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parameters are not set here manually but came in automatically when the Job was created by your
business system.

Job Automation

Automation Engine is very Job-centric. Workflows can take their settings from the Job setup. They
can even be launched automatically when the Job reaches a certain status (for example: a new page
has been delivered, the sheet is complete, the Milestone changed to 'Approved' etc...).

Note:  When you choose not to work with this Jobs concept, you can still get a similar level of
automation by using alternative tools like Workflow Parameters.

Learn more in the dedicated chapter Jobs on page 828.

2.2.3 File Processing in Automation Engine

In Automation Engine, you can process your files using single Tickets or Workflows (a sequence
of Tickets).

Launching those tickets or workflow results in (a series of) Tasks.

A Ticket contains all the parameters for that task.

Tasks

What is a Task?

A task is an action executed on a file, a folder or a Job on the Automation Engine server.

Types of Tasks

There are seven types of tasks:

1. Conversion tasks such as Export to PDF, Export to PostScript...
2. File Creation tasks such as Create Wrapper File, Create PAF / JPG / XML...
3. File Editing tasks such as Contourize & Clean, Trap...
4. Verification tasks such as Check Job Parameters, Check Print Rules, Preflight...
5. Administration tasks such as Prepare to Archive, Upload via FTP, Zip...
6. RIP tasks.
7. Device Output tasks.

Task Settings

You can define settings for the tasks, and save these settings as Tickets to reuse them (see  Tickets
on page 26).

Task Progress

When a task is launched, you can monitor its progress in the Pilot. See Checking the Status of the
Task on page 37.

Task Menu

The Task Menu contains the following items:
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• Open Task [CTRL + O]: opens the selected task(s), allowing you to relaunch them (with the same,
or with modified settings).

• Relaunch [CTRL + L]: relaunches the selected task(s) without opening them first.

• Open Output File [CTRL + Shift + O]: opens the output file that was generated by the task with
the associated application.

• Right-click a file to select 'Open Output File with...'. If no application has been registered, the
default application for the selected file type will be used.

To register and select an application:

1. Click 'Register'

2. Browse to the location on the hard disk to select the application's .exe file.

3. Click 'OK'. The path and the official name of the application appear in the Register dialog box.
4. Click 'OK'. You can now select this application to open a file.

• Go to Input / Output File: selects the input or output files of the selected task. The Automation
Engine Pilot will automatically switch to the Files View and select the file in the appropriate folder.

It is possible that the folder containing that file is no longer available in the current containers,
because it has been deleted or because the container is no longer available. In this case, an error
message will appear:

If the file is found, the container and path are opened in the folder selector, and the file is selected
if it is still available. If the file is located inside another Job than the current Job, a message is
shown asking you if the Job should be opened or not:
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• Hold[CTRL + K]: holds a task until it is 'released' manually.

• Hold Until... [CTRL + Shift + K]: holds a task until a predefined point in time.

• Release [CTRL + G]: releases a task that's 'On Hold'.

• Cancel [CTRL + Y]: cancels the launch of a task.

• Priority... [CTRL + U]: allows you to change the task's priority.

• Move to History [CTRL + M]: moves the selected task(s) to the Task History.

• Annotation... adds or modifies an annotation. When the annotation pops up, click 'Save' to save
modifications.

• Log Info... offers you several possible ways to handle the log file. The log file contains all
information that the system displayed in the 'Details panel' during the execution of the task.

• Open opens the log file in the Pilot's log window [Ctrl + Shift + L].

• Open with allows you to open the log file with your favorite text editor. This will only work if
the Automation Engine client has access to the share AutomationEngineLogging on the
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Automation Engine Server. Once the file is opened in your favorite editor you can save it locally
for future reference.

• Mail allows you to compose a mail message with the log file, the ticket and the input and
output files attached.

Tip:  Click ‘Open with’ to open the log file with your favorite text editor. Keep in mind that this
is only possible if the client machine has access to the share on the Automation Engine Server
that contains those log files (in the share AutomationEngineLogging).

• Group workflows [CTRL + B]: workflows will be grouped in the Task list.

• Related Workflow Tasks...: the system displays a dialog in which all related tasks are listed. A
specific task can be selected from the list.

• Show/Hide Details: shows or hides the Details pane.

Workflows
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You can build Workflows and launch them on your files using the Workflow Editor. Learn more in
Building Workflows using the Workflow Editor on page 987 .

You can also launch them from the Pilot, from Shuttle (see Using Shuttle to Upload and Process Files
on page 47) or from within most Esko Editors. They can also be launched automatically, triggered by
external signals (files arriving, commands from external systems, etc.).

Learn more in the dedicated chapter Workflows on page 986.

Task Chains (old workflows)

Task Chains are old BackStage workflows. They are still supported in Automation Engine but will
need to be migrated.

A Task Chain is a succession of tasks, linked together in a Task Chain Ticket.

You can build new workflows from these old Task Chains, while keeping all your tickets settings (see
Migrating Old Task Chains on page 1078).

 Tickets

What is a Ticket?

The settings used when executing a task or workflow on a file can be saved as a ticket.

Default and Custom Tickets

The Pilot comes with a default ticket for each task type, but you can also create custom tickets. You
cannot overwrite or delete default tickets.

You can see all the available tickets (default and custom) in the Pilot's Tickets view.
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Global and Job Tickets

Global tickets (  ) can be used on any file you can access through the Pilot. Job tickets (  ) are
only available when you work in the Job that you saved them for.

Public Tickets

You can make tickets public if you want to submit files to them from Shuttle. There are several ways
to make a ticket public (see Making Your Ticket Public on page 49 in the User Guide).

Public tickets have a mark in the Public column.

Note:  Depending on your access rights, you may only see public tickets, and public parameters
inside the tickets.

Inside a Ticket
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1. The menus:

• Use the File menu to create a New ticket, Save the ticket, save it under another name (Save
As), or Close it.

• Use the View menu to Show different kind of tickets (when creating a workflow): All, Public,
Global or Job Tickets.

• Use the Advanced menu to Manage Public Parameters.
2. Use the Save and Close button when you are done editing the current ticket.

Note:  If you were editing a default ticket, the system will ask you to save the ticket under another
name.

3. Steps: The above screenshot is outdated. Learn more about workflows in Workflows on page
986.

4. Most of the tickets offer the possibility to define an Output path and a File Name.

Use the Browse button to browse to the output path.

Use the SmartNames icon  to add SmartNames to the output path and / or file name.

For more information, see this separate chapter in the Complete Manual: SmartNames on page
916.

5. You can add a Notification to the task by clicking .

For more information, see Notifications on page 175.
6. The ticket's settings differ for all tasks.

For detailed documentation of all tasks and tickets, please see The Tasks and Workflow Controls
on page 239.
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Notifications

Each task ticket can trigger a Notification. The system will so notify a user by sending an E-mail
when a task finishes, or notify an external system by feeding it an XML or a TXT file with the same
kind of content.

Note:  In workflows, when your goal is to send an E-mail, consider using the separate task Send E-
mail on page 471 instead.

To add a notification:

1. Click the notification button  in a ticket.

The 'Notification' dialog pops up.

2. Click Add.

The Notification Rule Editor pops up.
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3. Define the Notification.

Define the condition for the notification and the action.

A notification may consist of an E-mail sent to the task owner (or to any other valid address), it
may also be an entry in a XML/text file, or an XML/text file in a certain folder.

Note:  When selecting Send an e-mail, you can add more than 1 E-mail address in the 'To' field
(including SmartNames) by using ' ; ' as a separator.

You can add the input files, the output files, the task's log file and or the ticket to the notification.

The notification can be based on a template. Hit the Edit templates ... button to create and modify
templates. Learn more in Edit Notification Templates.

Note:  The Template list and Edit templates button will only be visible if templates have been
created before.

Note that SmartNames can be used in the To field, for example to refer to E-mail addresses of
the Job’s CSR or up to 3 customer contacts.

4. Click OK. The notification rule is now added to the Notification dialog.

E-mail notifications of tasks that end in a warning or error will contain the basic problem description
(the messages that appear in the task's details pane). This avoids having to analyze more complex
log files.
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Customizing the Contents

It is possible to save XML notifications on Smart enabled paths. For example saving XML notifications
inside the job folder or on a dedicated central folder:

Early Notification

The condition Task Step is finished makes it possible to receive a notification message at the end
of the step on which it was set, before the rest of the workflow has finished.

Tip:  Use the Configure tool to configure general notification rules for tasks and devices, and to
define the places where the XML or text files will be saved. This will save you from having to do this
inside the task ticket(s).

Working with Tickets

From the Tickets view, you can:

• Create a new task ticket: double-click an existing task ticket (for example a default one), fill the
settings in as desired, and save it under a new name.

•
Create a new workflow ticket: click  and build your workflow (Learn more in Workflows on
page 986).

•
Copy a ticket: select the ticket to copy, click  and enter a name for the new ticket.

•
Delete a ticket:select the ticket to delete and click .

• Make a ticket public: right-click it and select Public Ticket.
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• Export a ticket: right-click the desired ticket and choose Export Ticket. For more info, see
Exporting Tickets on page 178.

• Import a ticket from an other Automation Engine. Go to  Tickets > Import Tickets . For more
info, see Importing Tickets on page 179.

•
Enter information about a ticket:select the ticket, click  and enter a Description.

The Description you enter here will be visible in the Description column of the Tickets view.

You can also make the ticket Public from here.
• Filter tickets: you can either filter by file type (to only show tickets valid for that file type), or by

entering text in the search field.

Note:  Depending on your access rights, you may not be able to create, edit or delete tickets. Setting
priority may also be limited.

Exporting Tickets

Follow these steps to exchange (workflow) tickets with an other Automation Engine:

1. In the Pilot, go to the Tickets view.

2. Select one or more tickets.

3. In the menu, go to  Tickets > Export Ticket .

Alternatively, you can right-click the (workflow) ticket and choose Export Ticket.

4. Choose the location and file name to save the exported data (as a ZIP file).

5. Press Export to start the Export action.

The resulting zip file contains the selected ticket(s) and the following dependent resources, if used
in the ticket(s):

• SmartNames
• Referred Tickets
• ArtPro Action lists
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• PitStop Profiles and Action Lists
• SmartMark sets (as .paf files)
• ppd files
• ReportMaker templates (as .paf files)
• Rule sets for the Check Print Rule task

• Tiling templates for the Create Tiles task

• Step&Repeat Templates for the Step & Repeat Template based task

• CAD file for the Prepare Station task

• Template for the Create Imposition from RunList task

• Compare with file for the Compare PDF task

• Script for the Run Script task

• .xml file for the Create Design (DesignWizard) task

Exporting tickets has the following limitations:

• Certain resource information is not included, such as the DGC files and CMS related files like
Color Strategies.

• Workflows that include (blue) Job Tickets by reference, can not be exported. An error message
will appear.

• Plate templates for the Import JDF Stripping task are not included.

• Template for the Create IMP File task is not included.

• In the Expand Variable Data to PPML File task, .xml or .csv database files per grid are not
included.

Importing Tickets

To import Tickets that were made on an other Automation Engine, proceed as follows:

1. In the Pilot, go to the Tickets view.

2. In the menu, go to  Tickets > Import Tickets .

3. Select the desired ZIP file that contains the Ticket(s) and their dependant files and click Import.

If certain resources would be overwritten by importing the chosen ZIP file, a dialog will ask you
whether those resources should overwrite the existing resources. Click OK to accept the new files.

After the import is completed, the newly imported tickets will be selected in the Tickets view (when
no filters are set up).

Note:  Tickets are imported as Global Tickets, while retaining their original name.

Favorite Tickets

You can add tickets of single tasks or workflows to your favorites, to be able to launch them quicker
in the future.

Favorite tickets are linked to:
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• the Pilot user account (so every user can have his/her own favorites),

• the file type selected in the Pilot (so the favorite tickets you can add or see always match the
file type you selected).

Adding a Ticket to your Favorites from the Files View

1. In the Containers or Last used job mode, select a file (remember that you make favorites per
file type)

2. Right-click in the Launch Favorites pane and choose Add Favorite... .

3. In the Add Favorite dialog that opens, select the ticket you want to add as a favorite and click OK.

Note:  This dialog contains all (single and workflow) tickets suitable for the file type selected in
the Pilot.

Adding a Ticket to your Favorites from the Tickets View

You can either:

• Right-click your chosen ticket and select Add to Favorites.



2
Automation Engine

181

• When creating a ticket, select the Add to Favorites option in the Save As dialog.

This adds the ticket as a favorite for all file types that can be processed with this ticket.

For example a ticket for the Copy or Move File  task will be added as a favorite for all file types.

Using a Favorite Ticket

1. Select the file to process in the Containers or Last used job mode.

The Launch Favorites pane shows all the favorite tickets for this file type.

2. Click the favorite ticket you want to use.

Note:  If you want to use another ticket of the same task type (for example another Export to
ArtPro File ticket), click the arrow beside the favorite ticket and choose your desired ticket.

3. The ticket opens. If necessary, review or edit the ticket's parameters.

4. Click Launch.

Tip:  To launch the ticket's on the file without opening the ticket or workflow, press Alt when clicking
the ticket.
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2.3 Different Ways of Working with Automation Engine

Note:  The concepts of Pages, Plates and Proofs only serve in page workflows (commercial printing).

2.3.1 Working with Jobs

The Jobs concept and how to work with it is explained in a dedicated chapter Jobs on page 828.

2.3.2 Working with Products

The Products concept and how to work with it is explained in a dedicated chapter Products on
page 876.

2.3.3 Working with Pages

Note:  The concepts of Pages, Plates and Proofs only serve in page workflows (commercial printing).

About Pages

The Pages View is extremely useful when working with impositions. The Pages View allows you to:

1. View, check and (re-)assign pages to imposition or books.

• If the Imposition file contains all pages, the Pages View can be used to simply check the
presence and correct order of the pages.

• If there are pages missing, you can assign them by either selecting the (multi-page) file in the
Page Gallery or individual pages in the Details pane, and drag them to the correct location
in the Page List.

2. Generate proofs and follow up approval states.

Both PDF and IMP files can be exported, exposed, proofed, etc. from the Pages View. The same
tasks as in the Files View can be executed on both file types.

3. Upload and normalize PDF files.
4. Create impositions after templates.
5. Create books for later use in a new imposition.

The Pages View

This view is only available in Job mode. It is only used in page workflows.
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The Pages View is divided into several panes. The top part of the view (the Page Gallery and
the Details pane) displays both assigned and unassigned pages, the bottom part displays the
impositions, layers and assigned pages.

1. The Page Gallery pane lists all incoming files, indicates the number of pages and the assignment
status.

2. The Details pane displays thumbnails of the individual pages of the selected file.
3. The Imposition Gallery pane shows the imposition structure with its different books. It also allows

you to create books that later will be used in an imposition.
4. The Layers pane shows the different layers of the selected imposition. You can rename layers,

approve them, and set them empty or blank.

Note:  The Layers pane is only visible when the selected imposition or book contains more than
one layer.

5. The Page List shows you which pages are assigned and which are not. For each page status
information can be asked.

6. Click the Page List button to switch between thumbnail view or list view.

You can view both the task status and the page status information. Simply right-click the columns
Page Gallery and / or Imposition Gallery pane(s) and select both Task Status and Page Status.
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See Working with Pages on page 182 for more information.

Adding Imposition Files to the Pages View

When you go to the Pages View for the first time, you will see that all panes are empty.

To send an imposition file from the Files View to the Pages View:

• Select the IMP file and launch the Add to Imposition Gallery task on it.

The imposition file will appear in the Pages View.

If the imposition contains pages, the corresponding files will appear in the Page Gallery.

Tip:

When an IMP file is already present in the Imposition Gallery of the Pages View, launching the Add
to Imposition Gallery task resynchronizes the IMP file.

This can be useful when problems with non-matching SmartIDs occur.

Creating an Imposition

To create a new imposition:

1.
Right click the Imposition Gallery and select New Imposition, or click the New Imposition 
button.

This opens the New Imposition dialog.
2. Enter the Imposition Name.
3. Select the appropriate Imposition Template from the list, or browse to the correct location.
4. By default, Use Layer Name(s), Book Name(s) and Finished Page Sizes from Template is

selected, which makes the Width and Height parameters unavailable.

Deselect this option if you want to overrule the template sizes.

Additional information on the number of books and pages of the selected template is displayed.
5. If you want to automate the Page Assignment, insert the regular expression to use. You can

include SmartNames.
6. By giving a particular Page Offset, the pages will be assigned to the correct page slots.
7. Select the correct Use case and Variant separation if necessary.
8. Click Create.

The imposition will appear in the Imposition Gallery.
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Creating a Book

To create a new book:

1.
Right click the Imposition Gallery and select New Book, or click the New Book  button.

This opens the New Book dialog.
2. Enter the Book Name.
3. Indicate the Number of Pages the new book should contain.
4. Set the correct Finished Page Size.
5. If you want to automate the Page Assignment, insert the regular expression to use. You can

include SmartNames.
6. By giving a particular Page Offset, the pages will be assigned to the correct page slots.
7. Indicate the correct Folio numbering, if necessary.
8. Select the correct Use case and Variant separation if necessary.
9. Click Create.

The book will appear in the Imposition Gallery.

The properties of the book can be consulted or changed at any time by right-clicking the book and
selecting Book Setup...

Tip:  Use the Create Imposition task to turn your book into an imposition.

Adding (PDF) Content Files to the Pages View

When you go to the Pages View for the first time, you will see that all panes are empty.

To add a PDF file to the Pages View:

• Select a PDF in the Files View and choose Add to Page Gallery from the pop-up menu. The PDF
will appear in the Page Gallery, unnormalized.

Note:  The Add to Page Gallery option is only available if the selected file is not yet present in
the Page Gallery of the Pages View.

• Right-click the Page Gallery and select Get Data and Normalize to browse to the correct PDF
file.

The PDF file will be copied to the root of the Job. After normalization your pages will automatically
be added to the Page Gallery.

Note:  You can upload files that are already present in the job folder. In this case, the files will be
left in their current location and will not be copied to the root folder of the Job.
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Note:

You will only be able to create a limited number of workflows that work in combination with the Add
to Page Gallery:

When a PDF file is selected you can use:

• Copy or Move File > Normalize PostScript / PDF / Illustrator 8.0 File > Add to Page Gallery

• Normalize PostScript / PDF / Illustrator 8.0 File > Add to Page Gallery

• Add to Page Gallery

When a Normalized PDF File is selected you can use:

• Copy or Move File > Add to Page Gallery

• Add to Page Gallery

Page Assignment

Pages can be assigned to the Page List in different ways:

• Drag a (multi-page) file from the Page Gallery and drop it on the correct page in the Page List.
Reader's spreads are automatically recognized and assigned correctly.

• Select one or multiple pages in the Details Gallery and drop them on the correct page(s) in the
Page List.

• Selecting Replace Pages in the context menu of the Page List allows you to upload and
normalize a PDF file which will be assigned automatically when the Normalize task finishes.

• If you don't want to replace the pages that have already been assigned, you can use Insert Pages.
In this case, the new pages will be assigned, moving the 'old' pages to the next pages slots.

• Pages can also be assigned automatically, via a naming convention.

Note:  Within one Page List, pages can also be dragged to another location.

Page Assignment via Naming Convention

In case the page number in the page list is encoded in the name of the incoming PDF files, Automation
Engine can automate the assigning of these pages by using a regular expression. This regular
expression can be composed from ordinary characters, SmartNames, wildcard characters and
placeholder(s) for the page index.

In case a regular expression for a certain book is defined, each incoming file that is added to the
job containing this book is checked against this regular expression. If the file name conforms to this
expression, it is assigned to the corresponding page slot(s).

The regular expression can be specified on Job, imposition and book level.

If automatic page assignment is enabled, it is indicated in the Page List of the Pages View.
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The specified regular expression is automatically matched to an incoming file when its pages are
created.

• The pages are assigned on the condition that the regular expression fully matches the *file name.
Moreover,

• when the regular expression develops into just one page, all pages of the file will be assigned
from this desired page onwards.

• if there are several situations in which the regular expression matches the file name, the first
successful one (which leads to a page assignment) will be taken.

• if the imposition has more than one book or layer and the regular expression does not specify
any, the first book or layer will automatically be selected.

Note:  Pages can only be assigned when the desired page slots are empty, not when they are blank.
Previously assigned pages will not be unassigned / reassigned during page assignment via naming
conventions.

You can also specify a Page Offset. By default, the page offset is 0, which means that the first page
will be assigned to the first empty page slot.

These are the available wildcard characters:

• ? stands for any character
• * stands for any sequence of characters (even empty)

The are the available SmartNames that can be used to create the rule:

• [BookIndex]: index of the book inside imposition (going from 1)
• [BookName]: name of the book
• [Folios]: folio number
• [ImpositionName]: name of the imposition
• [JobName]: name of the job
• [LayerIndex]: index of the layer inside book (going from 1)
• [LayerName]: name of the layer
• [PageNames] .. A range of page names (folios, for example A,C-E,G)
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• The same rules as for [PageNumbers] are applicable, but now with folios.
• No prefix like in page numbers is assumed (for example, p12 means page with folio "p12", 01

means a page with folio "01").

• [PageNumbers]: a range of page numbers (numbers are going from 1, for example 1-5,7,9-11)

• A page number can be just a number or a number preceded by "p". For example P23 stands
for the 23rd page of the imposition.

• Page numbers can be separated by one or more commas (",") or ("-") to indicate a range. For
example 10,p23-p37  .

• Page ranges can be separated by one dash ("-"). For example 10-12 indicates pages
10,11,12.

• If just one page is specified and the file has more than one page, the pages are assigned from
the desired page onwards.

• If two pages are specified (for example p10_p13) but the file has the number of pages equal
to the number of pages in a range between the given page numbers (for example, 4 pages for
page numbers p10_p13), the given page numbers are assumed as a page range.

• [PageSlotId]: page slot id (product id)

Approving and Rejecting Pages

You can approve or reject pages or files in different ways:

•
select the file or page and click the approve  or reject  button in the tool bar.

• select the file or page, click right and select Approve/Reject.... Then select the appropriate status
in the pop-up dialog.
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If you select Automatic as approval type, the approval state will automatically show the result of
the approval task (Publish on Web).

• Choose Manual if you want to set the approval status yourself.

•
Approve  approves the selected object.

•
Approve with warning  makes it possible to add a comment in which you can
indicate what modifications should be made or what should be kept in mind. The comment
can be seen in the tool tip when moving the cursor over the warning icon in the Page List.

•
Reject  rejects the selected object.

Note:  Pages can be proofed as such (content proofs) or in their imposition context. Content proofs
are more flexible, imposition proofs are more reliable.

2.3.4 Working with Proofs

Note:  The concepts of Pages, Plates and Proofs only serve in page workflows (commercial printing).

About Proofs

Proofs are preferably made with the ImposeProof! functionality.
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The Proofs View

This view is only available in Job mode. It is only used in page workflows.

The Proof View consists of two panes that give a different view on the proof:

1. The Proof Sets pane, where the proof sets are listed.
2. The Details pane is a visual presentation of all proofs of the set.

The Proof Sets pane shows you the names of the proof sets, both hardcopy proofs and softproofs, as
well as the number of flats, pages, status, the date on which they were last modified and information
about the kind of proof that has been made (Content proof if a file is proofed, or Imposition proof
if an imp file is proofed).

Thumbnails of the proofs can be viewed with the corresponding application, for example Acrobat
for PDF proofs.

The Info button will open a properties file of that page (proof).

See Working with Proofs on page 189 for more information.

Marking Files As Proofs

Proof sets appear in the Proofs View after being 'marked as proof'. The Mark as Proof ticket has to
be connected to an export ticket, for example the Export to PDF File ticket.

Perform the following steps to make proofs appear in the Proofs View:
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1. Select an imposition in the Pages (or Files) View.
2. Click right and select the Export Imposition to PDF File Chain ticket via New Task.
3. Specify the appropriate settings.

Approving Proofs

Setting the approval status of the proof also sets the page state of the corresponding page. This is
visible in the Pages View.

Approval statuses can be set manually by an operator or via JDF. Please refer to the presentation
on JDF for more information.

Pages can be proofed as such (content proofs) or in their imposition context. Content proofs are
more flexible, imposition proofs are more reliable.

The main properties of content proofs:

• Once a page has been proofed it can be moved or copied to any location in the imposition without
loosing its proofing and approval status.

• The order of the pages in the imposition is not checked.
• The placing (offset and scaling) of the page in its “window” is not checked.

The main properties of imposition proofs:

• Imposition proofs can only be made after the pages have been assigned to the imposition.
• Sheet Imposition proofs require large output devices and are harder to check since the pages

are not in reading order.
• ImposeProof imposition proofs put the pages in reading order. This makes it easier to check the

order and does not require large output devices.
• The safety of imposition proofs can sometimes hinder flexibility since the signature of the

imposition is also stored and checked. Many times impositions are changed without a
consequence for the pages.

• Reassigning a page degrades the existing imposition proofs to content proofs.
• Changing the impositions degrades the existing imposition proofs to content proofs.
• Approval on an imposition proof on a page slot, implies content approval on the page assigned

to that slot and thus on all page slots to which this page is assigned.
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Note:

The validity of the proofs is being maintained (based on Smart IDs).

When a page is changed, for example renormalized, the related proofs are rejected and get a note
"Proof is outdated”.

The link between the page and the proof is broken, which means that the proof is no longer valid
for that page.

2.3.5 Working with Plates

Note:  The concepts of Pages, Plates and Proofs only serve in page workflows (commercial printing).

About Plates

The Plates View is a view that shows a whole range of details about all plates that are associated
with a job. It includes advanced features for managing plates for jobs with multiple versions.

• It visualizes the corresponding flat for a selected plate along with all relevant sheet layout
information (plate size, paper size, etc.).

• It makes it possible to expose or proof a set of plates with an ink & sheet selection preset according
to the chosen plates.

• It shows progress and status information about each plate.
• It shows both the expected and the realized plates, so differences between planning and

production can be detected.
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The Plates View

This view is only available in Job mode. It is only used in page workflows.

Note:  In a page workflow, the job's inks are also used for creating "expected" separations (and
corresponding plates) in the Plates View. This means that an expected separation will be created
for each ink and for each sheet. If the assigned pages contain inks that are not listed in the inks list,
"unexpected" separations will be created.

• The Plates View makes it easier to manage the most important deliverables that prepress provides
to the press room, plates.

• It gives an overview of the total number of plates that have to be output.
• It allows you to track the progress of a job at a very detailed level.
• It allows you to detect discrepancies between the expected plate output and the supplied data

very easily.

For example, when a sheet side is supposed to have only a black plate, but one of the supplied
pages for that sheet side contains CMYK, this can be easily seen in the Plates overview.

The same is true for the inverse situation (for example when an expected Pantone plate is not
being realized).

See Working with Plates on page 192 for more information.

Task Status information

The Status column is used for progress tracking. It indicates the status of the plate and offers a wide
variety of statuses going from Waiting for pages till Plate approved.

Every time an action takes place the status column will provide you with the latest information.

Delivering:
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 Waiting for pages appears when no pages have been
assigned to this sheet side or when the separation has not yet been delivered.

 Delivered appears if all pages of a flat are delivered. This
status only appears when the output prerequisite in the Imposition tab of the Job Setup dialog is set
to When all pages are approved.

 Delivering gives an indication of how many pages have
already been assigned to the sheet, and how many are still missing.

 Not delivered appears if a separation was expected, but is not
present in this particular sheet and if there are no empty pages remaining for this sheet. Expected
separations are those that are defined in the Inks tab of the Job Setup dialog. By default, this is
CMYK. This status only appears when all pages of a flat have been delivered.

Approving:

 Approving Pages can only appear as a status if the output
prerequisite in the Imposition tab of the Job Setup dialog is set to When all pages are approved.
When the option is set to 'When no page is rejected', the status automatically switches from
'Delivering' to 'Ready for ripping'.

 Ready for ripping will appear if all pages of the sheet have been
approved.

In case not all pages have been approved, but ripping has been started, the following status icon

will be shown: 

Ripping:

 Ripping

 Ripped implies that the rip task ended well.

 Ripped with warning

 Ripping failed

Plate approval:

 Plate approved

 Plate approved with warning

 Plate rejected:In case new pages have been assigned to a
rejected plate and the plate is ripped again, the following status icon will be shown:
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Adding Plates

An imposition cannot be added to the Plates View only. The Plates View is always linked to the Pages
View.When an imposition is added to the Imposition Gallery of the Pages View, it is automatically
added to the Plates View. Likewise, it is removed from the Plates View when the imposition is removed
from the Pages View.

Modifications in the Pages View (like adding and removing pages, approving or rejecting pages...)
will usually have an effect on the Plates View. Modifications in the Plates View will not affect the
Pages View.

In a JDF workflow the Pages and Plates Views can be populated at the time of job creation if the
JDF file contains the relevant information.

Inks and Plates

Adding an imposition to the Imposition Gallery of the Pages View will also create the entries for the
Plates View.

How the imposition was made is not important in this respect. It can be made interactively in
FastImpose, by executing the Create Imposition task or by creating a New Imposition in the
Imposition Gallery of the Pages View.

All the columns of the Plates View will automatically be filled in.

When no pages have been assigned to a sheet side yet the Pages View will show a list of plates that
are expected. This list is based on the inks defined in the Job Setup of that job. When no inks are
defined in the Job Setup, CMYK is assumed.

When all the pages of a sheet side have been delivered, the list of plates for that sheet side will
represent the inks of the pages on that sheet side.
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Variant Setup

Decisions on which separations are created, which unplanned plates will be created and how the
separations are mapped to plates depend on "use case rules". Use case rules are applied when an
imposition is synchronized for the first time and again when the user explicitly applies the selected
use case to the job. A use case is selected on job level but can be overwritten on imposition level.

This section contains the following topics:

• Variant setup on Job level

• Variant setup on Imposition or Book level

• Reapplying use cases

You can select one of these "Use Case"s:

USE CASE 1 : No plate reuse between print runs (no background layer)

In this case, there is a separation for every job ink, layer and side of a sheet. Each such separation
creates a plate. All layers contain full-colored variants.

The English and French versions share the same imposition characteristics but they are printed
separately without the reuse of common plates. The files are supplied separately in CMYK.

Result: the imposition has 2 layers for 2 variants. The number of plates created is 32: 4 flats x 4 inks
x 2 layers. This is the default setting.

USE CASE 2 : Background layer contains variant (n variants = n layers)

In the example below, the variant ink is black. This means that C, M, Y (or all inks other than the
variant ink) are taken from the background. The variant ink is taken only from variant layers.

The bottom layer acts as a background layer and contains the common elements of all variants.
Plates will be created for the non-variant inks of this layer and can be reused. For every other
(foreground) layer, a plate will be created for the variant ink.

Files are supplied as full CMYK.

Result: there are 2 layers for 2 variants. The number of plates created is 20.
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Tip:

You can opt for this use case if you don't have a FastVariant licence. In this case there's no need to
split the incoming files. The English and French PDF file can be assigned to the corresponding layers
of the imposition file, and as background layer one of the language files can be reused.

USE CASE 3 : Background layer is merged with variant layers (n variants = n+1
layers)

The English and French versions are printed with the same CMY plates. When the run length of the
first variant is reached, only the black plate is changed. The files are supplied as one file with the
common CMYK elements (images, logos...) This file goes into the background layer. Per variant there
is one file that contains only the changing black variants (usually just text). These file will be assigned
to the language layers that lay on top of the background layer.

Result: there are 3 layers for 2 variants. The number of plates created is 20: (4 inks + 1 ink) x 4 flats

USE CASE 4 : Background layer is printed separately (n variants = n+1 layers)

This case will be used when working with variants on a 5–color press. A complete preprint is done
for the images and the black of the text is printed separately for both languages.

The bottom layer acts as background layer and contains the common elements of all variants. For
all inks of this layer plates will be created, which can be reused. For every other (foreground) layer,
a plate will be created for the variant ink.

Files are supplied as full CMYK, plus an additional ink for the text. However, this additional ink needs
to be combined with the black ink.

Result: there are 2 layers for 2 variants. The number of plates created is 20 and not 24 as would have
been the case when 5 inks were used.
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The default selection of use cases is ”No plate reuse between print runs”, which is defined on Job
level (Job Setup ⇒ Imposition tab). The same use case is selected when there is no definition on Job
level. The list of variant separations is actually the list of job inks, which corresponds with the Ink
Settings parameter of a job. In case a job contains no ink settings, Process CMYK inks are present.

Note:  When creating multilayer jobs in FastImpose, please make sure that the background layer
is always the bottom layer in order to avoid incorrect output when handling variants in Automation
Engine.

Variant Setup on Job level

The Variant Setup option on Job level is available in:

New Job
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Check the “Apply to Existing Impositions” if you want to apply the use case to all impositions in
the job.

Note:  The option "Apply to Existing Impositions” is only available if there is an applicable imposition
in the job.

Job Setup
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Check the “Apply to Existing Impositions” if you want to apply the use case to all impositions in
the job.

Note:  The option "Apply to Existing Impositions” is only available if there is an applicable imposition
in the job.
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Variant Setup on Imposition or Book level

When creating an imposition or book in the Pages View, one of the following dialogs will pop up:

Note:  Selecting a use case in the Book or Imposition Setup dialog overrules the selection on Job
level (not just for a separation or variant, but for the whole imposition). This way, you can have two
impositions following different use cases in one job.
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Reapplying Use Cases

Use cases can be reapplied in two ways. Settings can be changed on book or on imposition level.

Note:  Selecting a use case in the Book or Imposition Setup dialog overrules the selection on Job
level (not just for a separation or variant, but for the whole imposition). This way, you can have two
impositions following different use cases in one job.
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1. On Book level

A use case can be reapplied on book level if the page list has not yet been turned into an imposition
file. In this case the imposition level is not present in the Pages View. The Variant Setup option can
be found in the Book Setup dialog.
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Note:  If the imposition has an IMP file associated with it, the Variant Setup is not present in the Book
Setup dialog. As the use case has to be common for all books in the imposition, the use case is to
be defined on the imposition level.

2. On Imposition level

If the imposition level is present in the Pages View, the Variant Setup option can be found in the
Imposition Setup dialog.
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Manipulating Plates

1. Separations need to be exposed together
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It is not uncommon that two separations need to be exposed together, because the supplied file is
not correct. The file can be corrected interactively, but when it is simply a matter of combining two
separations on the same plate, it can also be done here.

Example: a file contains a designer ink “Text” which has to be exposed together with “Black”. This
can be done by selecting one of the plates and selecting “Add Separation...” from the pop-up menu.

2. There are superfluous separations

Sometimes a file contains inks for a special purpose that do not need to be exposed onto a plate
for example a designer ink called “dieshape”. Such a plate can be hidden by selecting “Hide” from
the pop-up menu. In the top right corner of the Plates View there is a toggle with which hidden
separations can be shown.

This operation can be reversed. When the “Hidden separations” toggle is on, select the hidden plate
(separation?), right click and select “Create Plate...” from the pop-up menu to turn the separation
into a plate.

3. Separations are named incorrectly

Some MIS systems do not name spot colors (correctly). In the JDF file, a spot color could be named
“Spot1”, but in reality a designer ink is required. The pages, however, do contain the correct designer
ink. This leads to a situation in which there is an ordered plate which is not realized (Spot01) and a
plate/separation which is there, but not ordered (Designer Xbed).

2.4 Server Administration Web Tool

A Server Admin Web Tool is installed with every Automation Engine Server from Automation Engine 12
onwards. You can open the Server Admin Web Tool by entering http://<name of your server>
 or http://<name of your server>:9999 in the address field of your browser.
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You can download and launch Client Apps and conduct Server Administration via this tool.

System Requirements

Windows :

• Internet Explorer (8.0 or higher required), Firefox, Chrome or Safari.
• Windows XP or Windows Server 2003 or higher and Java JRE 1.7 or higher 

Mac

• Safari, Chrome or Firefox.
• Mac OS X 10.5 or higher and Java JRE 1.6 or higher

2.4.1 Main

The default start page of the Server Admin Web Tool is the  Client Apps > Main  page. You can
access it by browsing to http://<name of your server>  or  http://<name of   your
server>:9999.

Main
You can download the main applications (the Pilot, the Shuttle and the Diagnostics tool) from this
page.

• Automation Engine Pilot : The Pilot is the primary client tool for your prepress workflow
automation. Read more in The Automation Engine Pilot on page 19.

• Automation Engine Shuttle : The Automation Engine Shuttle is a client tool for easy submission
of files to Automation Engine workflows. Shuttle also allows monitoring of the workflows. Read
more in the Automation Engine User Guide.

• Automation Engine Diagnostics : You can use this app to monitor the status and activity of the
Automation Engine Server. It can be launched and used both on Mac and Windows.

You can click on Tools to access the other Client Apps.

Note:  The Client Apps are only available on Automation Engine Servers that are configured as Master
server.

2.4.2 Downloading A Client App

The Client Apps section is the place to launch or download the Automation Engine Client Apps.
These apps work both on Mac and Windows. The Server Admin Web Tool will automatically detect
the OS from which you access it and provide the correct versions of the Client Apps that can be
launched or downloaded.

To download Click the Download  button next to the Client App you want to download. The Server
Admin Web Tool will detect the Operating System and will download the appropriate installers.

Automation Engine Script Runner
You can automate tasks in applications like Illustrator, Photoshop and InDesign using Script Runner.
Read more in the Automation Engine User Guide Automation Engine Script Runner on page 122 and
in The Script Runner on page 794.



2
Automation Engine

209

Automation Engine ArtPro Action List Editor
Create and edit ArtPro Action List files to automate tasks in ArtPro. This tool is available for download
on both Mac and Windows. Read more in The ArtPro Action List Editor on page 708

Automation Engine RunList Editor
This tool helps in creating and editing RunLists to collect several files into one job folder, or to make
one final PDF out of several smaller PDFs (for example for imposition). This tool is available for
download on both Mac and Windows. Read more in The RunList Editor on page 786

Automation Engine PitStop Profile Editor
This tool helps in creating and managing PitStop PDF  Profiles and Action Lists. This tool is available
for download on both Mac and Windows. Read more in The PitStop Profile Editor on page 782

2.4.3 Server Administration

Automation Engine features a new web tool for server administration. This means that you
can access your server administration tool from any workstation via http://servername or http://
servername:9999/.

You can use this web tool to download the Automation Engine Client apps such as

• the Pilot
• the Script runner
• the ArtPro Action List Editor
• the Automation Engine 10 Backup Tool

The Server Admin Web Tool also includes a Server Admin section which can be used to administer
the Automation Engine Server and its settings, create and restore backups and manage databases,
SQL Servers and the Application Server.

Server administration consists of :

• Status Overview of the Server

• Setting up the server

• Backing up the server

• Restoring the server

• Managing databases

• Managing SQL servers

Read detailed information in Automation Engine Reference Guide.

Status Overview of the server

The Status Overview shows an overview of the connected clients and the number of running tasks.
You also get an overview of the Server Version, Current role and Server databases. In the Status
Overview you can:

• Start and stop the Automation Engine server.
• Activate the server after install.
• Restart the web server.
• Download the server administration log files for support purposes.
• Start, stop or activate the local application server.



2
Automation Engine

210

• Download Application Server log files for support purposes.
• Deploy components on the application server.
• Log in to another server.

The Status Overview page contains more information from 12.1.1 onwards. Read the following.

For each Server database, the SQL Server Instance and the SQL Server location is indicated at
the Status Overview page. The Status column indicates the following statuses :

• Online : The SQL Server instance where the server database is located is running. This also
implies that the user name and password used to login to the SQL Server instance are correct.
The server database is online and available for access.

• Not Accessible: The SQL Server instance where the server database is located is running. Valid
credentials( user name and password) are used. But the server database on the SQL Server
instance is not accessible.

• Not Found : The SQL Server instance where the server database should be located is running
and the credentials used to login to the SQL Server instance are valid. But the server database
could not be found on the SQL Server instance.

• Login Failed:: The SQL Server instance where the server database should be located is running.
The server database is not available because the credentials used to login to the SQL Server
instance are invalid.

• Offline: The server database is not available because the SQL Server instance where it is located
is currently not running.

• Unknown: The status of the server database on the SQL Server instance is unknown.

Tip:  When you move your cursor over the status of a server database, a pop-over message will
indicate the detailed status information.
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FAQ on Starting the Server

How to start or stop the server?

Click on either the Start server  or the Stop server  button. Starting or stopping the Automation
Engine Server can take up to one minute.  The Server Admin Web Tool will indicate the status during
this process.

You can refresh manually or visit other pages while it is processing.

How to activate the server?

Click on the Activate server  button. When activating the server, a log window will indicate the server
activation progress.

How to stop or activate a server that still has connected clients?

If you try stopping or activating a Master or Assistant server with connected clients and/or executing
tasks, you will be asked to close all the Automation Engine applications. If you fail to do so, the open
applications will be interrupted and the server will be automatically stopped or activated within five
minutes.

Note:  Stopping/ Activating process will make it impossible to login via a new client or start a new
Task on this Automation Engine Server

How to Cancel the Stop and Activate Processes?

You can cancel the Stop or Activate process by clicking on Cancel . You will be able to login again
with a Client and start new Tasks.

You can also Force stop or Force activate while waiting for the open applications to close. The
server will then break the connection with clients and will cancel all the executing Tasks.

How to download the Automation Engine Server log files?
When you click the Log Files button, a ZIP file containing the Automation Engine Viewer log files
and the Application Server log files will be downloaded. The ZIP file contains a folder named
egappsrvlogs with Viewer log files (ImageList*.log) and a folder jbosslogs with Application
Server log files.

How to restart the Web Server?

You can restart the Tomcat Web Server using Restart Web Server button from the Web Server
section. The Start/Stop Server page will be automatically refreshed when the Tomcat Web Server is
restarted. You can also refresh manually to see if the Tomcat Web Server is restarted.
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How to download the Web Server log files?

For Tomcat Web Server log files, click the Log Files button in the Web Server section. A ZIP file
will be downloaded to your computer containing the log files of the Tomcat Web Server and the log
files of the Server Admin Web Tool.

Log files for Client Apps are not found in the Server Admin Web Tool, because they are executed
on the computer itself.

Gang Run Database

You can see the Gang Run Printing database in the Status Overview page when it is a separate
database (separated from the Jobs database). The Gang Run database will be listed under Server
databases section.

When the Gang Run Printing database is a separate database, you can restore it independently. Use
the Restore page of the Server Admin Web Tool.
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Read more about restoring databases in Restoring Database on page 228.

Setting up the server

In the Server Setup window you can change the server role: master, assistant or idle. You can also:

• View and remove Assistant Servers.
• Change the system account and/or password.
• Change the processing capabilities.
• Redirect central resources to a central file server.

Server Roles

You can configure an Automation Engine server installation as

• Automation Engine Master
• Automation Engine Assistant
• Data Server (Idle).

These act as a set of cooperating servers to distribute the workload and provide recovery when a
system goes down.



2
Automation Engine

214

Automation Engine Server Standalone Setup

The simplest configuration is a stand-alone Automation Engine server Setup. You can configure more
than one such setups. In this setup,

• each system has its own set of resources (such as CMS data, DGC data, font data, custom
data, marks data, ink planner data, task history database). Therefore, they function independently
without sharing the workload.

• each system has separate local license management
• you can create containers on shares of other systems.

Automation Engine Server setup with Assistant system(s)

This consists of Automation Engine Master server system and one or more Automation Engine
Assistant systems. In this setup,

• the Assistants use Master resources for performing tasks.
• Automation Engine Clients connect to the Master computer (but not to the Assistants).
• the workload on the different Automation Engine systems is allocated to the system with the

smallest load. If one of the Assistant systems goes down, it is automatically removed from the
configuration and the other systems take over the workload.

If the Master system goes down, the complete system shuts down. 
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Note:

• The Assistants take a copy of the complete configuration of the Master system. This helps in
taking over the Master role.

• The Assistants should have an Application Server and database engine installed locally for taking
up the Master role.

Automation Engine Server setup with Assistant system(s) and Data Server

You can configure an Automation Engine Data Server (Idle) which can be accessed when the Master
goes down along with the Assistants. A Data Server system can be set up for all the resources
required to facilitate the take over of the Master role by one of the Assistant systems. 
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Note:  You need to save regular backups of the Application Server database on the Data server
system. These can be imported into the Assistant system's database when the Master goes down.

Tip:  You can install the Application server software on another system instead of the Master. 

For more information on how to schedule backups read Creating a Back-Up Schedule on page 219

General Remarks

• You should define and configure the PostScript printers on all the systems (Automation Engine
Master and Assistant) if the Print Task is used for outputting on PostScript printers.

We recommend installing the PostScript printers locally on the:

• Master system (in Automation Engine Master- Assistant Setups)
• or on the Data Server (Automation Engine Data Server- Assistant server setups)
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Configure them on the network so that you can access them on all other systems as network
printer.

• Automation Engine Viewer and Automation Engine Server for CP applications require the
Application Server software. We recommend the Application Server Software to be installed on:

• the stand-alone systems ( they use own local installation of Application Server software and
local database engine)

• the Master Server (in Automation Engine Master- Assistant Setups).

Note:  The tasks running on the Assistants always connect to the Application Server on the
Master.

• the Data Server (Automation Engine Data Server- Assistant server setups)

Licensing Requirements for Different Server Setups

You require specific licenses for installing or converting systems to Automation Engine Assistant and/
or Master server systems. These limit the number of Automation Engine Assistants and/or Master
systems.

These licenses are installed on the Automation Engine Master (in Master- Assistant Server setups)
and in the Automation Engine Data Server (in Assistant- Data Server Setups). These systems act as
remote license manager systems for the Automation Engine Assistant or Master systems.

System Account

The Automation Engine Server service (BGMD), the Automation Engine Web Service (egwebsrv) and
the Application Server service (EG Application Server) run on service account (user: BGSYSTEM -
ask the default password to Esko).  You can change the username and password of this account.

Changing the System Account

• You can change the username to an existing Windows user. This user should be a member of the
Windows Administrators group of the Master computer.

• Modifying the system account will modify the service account of the:

• Automation Engine Server service (BGMD)
• Automation Engine Web Service (egwebsrv)
• Application Server service (EG Application Service) of the Master, Assistants and Data Server

in one operation.

You can use either local or domain username. However, the Application Server only supports the
local BGSystem user.  If you specify another local user or a domain user as system account, the
service account of the Application Server will NOT be modified automatically. 

Tip:  You can use Windows tools (i.e. Service Manager) to modify the service account of the
Application Server.

• When the Application Server is not installed on the Master, Assistant or Data Server, the
modification of the system account is to be performed manually.

• If you have configured a Container or Resource a computer other than the Master, Assistant or
Data Server, you have to modify the system account manually.
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Processing Capabilities

Can Run Tasks

You can select this setting to allocate the Task workload to this Server. If you have a Master Server
with many Assistants where the Master is heavily loaded, you can use this setting to allocate Task
workload to the Assistants. Do not enable this setting to run only File Streaming Sessions.

Can Run File Streaming Sessions

Select this option to set the Server to run File Streaming Sessions. This setting determines
Automation Engine Viewer's deep zoom abilities via File Streaming (implemented by a process called
sdbserver.exe) which is started when you view a file which has no prepared view data or when you
zoom deeper than the resolution of the prepared view data.

The maximum sessions setting is the maximum number of simultaneous File Streaming sessions on
the Server.

Important:  We recommend that only experienced system administrators or Esko Customer Service
engineers modify the maximum number of File Streaming sessions. Erroneous modification of the
maximum File Streaming sessions can seriously endanger the proper functioning of the setup. 

Can Run Gang Run Printing Sessions

Select this option to set the Server to run Gang Run Printing Sessions.

A Gang Run Printing Session is the  background process which calculates the optimal nested
layouts (PDFPLA) of Gang Run Jobs for one particular substrate at the time. Since this background
process can be time consuming, you can configure the Automation Engine server to run multiple of
these background processes simultaneously for separate substrates.

When this option is selected, enter the maximum number of Gang Run Printing Sessions the server
can run in the Max. sessions field.

Attention:  Automation Engine's default maximum number of Gang Run Printing Sessions is
1. Increasing this number may lead to the Automation Engine Server slowing down.

See the Gang Run Printing documentation for more information about Gang Run Printing.

Redirect Central Resources

The Master uses the locally installed resources (fonts, CMS database, DGC curves etc) by default .
You can use Redirect Central Resources  task (only on Master) to redirect this to a Data server
system.

You can redirect:

• bg_data_cms_v010 – the Color Engine database
• bg_data_custom_v010 - a resource containing various data like ArtPro action lists, Print Rule

Checker profiles, etc..
• bg_data_dgc_v010 - the Curve Pilot database contain dot gain curves
• bg_data_fonts_v040 – the Central fonts repository
• bg_data_ipldata_v010 – the Ink planner data
• bg_data_marks_v010 – the SmartMarks repository
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Note:  You cannot redirect individual resources.

Backing up the server

In the Server Backup window you can manage the following backup settings:

• Specify a backup folder on the server.

• Specify the number of backups to be kept in Keep only last.

• Set a backup schedule or manage existing schedules.

• See the Backup history and details of each backup.

Tip:  Click on info to get more information about the selected backup. A Backup info window
will list the server, date, time, size and composition of the backup.

• Remove a backup.

Creating a Back-Up Schedule

You can create a schedule to Back-Up the server configurations.

1. Go to the ServerAdmin pages. Task step.

2. Click on Back-Up in the left column.

3.
Click the lock  to make changes. You can specify where the Back-Up folder should be stored.

4. Click on the Add Back-Up Schedule button. A pop-up window will open asking for details.
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You can also choose Make Back-Up Now to immediately start backing up.

5. Define when and what to back up and how many backups should be stored in the given fields.
Fill in the Frequency, Start time, Back-Up What and Keep only last fields.

FAQ on Backing-Up the Server

Is the configuration of the Automation Engine backed up automatically?

No. You need to set up a Back-Up schedule to achieve that. Read more about it in Creating a Back-
Up Schedule on page 219

Can an Automation Engine Back-Up be made while the system is running ?

Yes. It can also be made when Automation Engine system is not running.

What is included in the Automation Engine Back-Up ?

The Back-Up always includes the basic configuration like tickets, workflows, SmartNames,
configuration settings etc.. Additionally, you can include DGC-files, Marks, CMS data, Fonts and the
data stored in the Databases in the Back-Up. This is called a Restore point which you can restore
later.

Where are the backups stored ?

In the Server Back-Up window you can specify a Back-Up folder on the server. By default, the location
of this folder is a path local to the Automation Engine server.

Tip:  A UNC path is accepted as the location. You need to make sure that the corresponding share
is accessible.

Tip:

You can keep a local path as destination Back-Up folder and save a copy on a DVD,/USB stick. The
Back-Up consists of a subfolder named like [Full]Backup__yyyy-MM-dd-HHMM.

Will I eventually run out of disk space when I schedule a regular Back-Up ?

You can configure this by setting how many backups you want to retain. Read more in Creating a
Back-Up Schedule on page 219.

Note:  The restore points (Back-Up including basic configuration, resources and databases) are never
deleted. Therefore, you need to save restore point backups on DVD/USB and delete them from the
hard disk.

Restoring the server

In the Restore window you can view and restore backups. You can also:

• Restore, duplicate or migrate your server configuration
• Restore resources or databases only

Note:  Take into account that the server should be stopped before you can restore a backup.
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How to Restore the Server

You can use Restore when you want to:

• reverse to a previous backup in order to correct some mistakes by going back in time.

You can use Restore Configuration to restore the Automation Engine backup that was made
previously.

• build a testing scenario (alpha, beta or shadow production). You can take the production
configuration settings from the production computer by creating and copying a backup.

After installing full Automation Engine on testing computer, you can restore the configuration in
the testing computer using Duplicate Configuration setting. You can therefore have production
and testing systems run in parallel.

• move to another computer. For example, upgrading from Automation Engine 10.1 on a separate
computer or to have a new computer where the Automation Engine will run henceforth.

Note:  You can create an Automation Engine 12 backup from an AE10.1 system. Read more in

You can choose Migrate Configuration after the full installation on the new computer. This will
restore the old production settings on the new computer.

• give the Master's configuration to an Assistant when the Master goes down.

You can restore the Master backup on the Assistant using Migrate Configuration restore action.

Note:  The Master backup can be found on the Assistant disk (C:\Esko\AEBackup.

1. Go to the ServerAdmin pages and click on Start/Stop Server  in the left column.

2. Click on Restore in the left column.

3.
Click the lock  to make changes.

4. Click Restore after selecting the corresponding entry in the Backup History list. For all other
cases, click the Select Backup Folder button and browse to the folder that contains the backup
to be restored.

5. Finally, choose OK to start the restore action.
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FAQ on Restoring the Server

Can I use a backup of one system to transfer its Workflow tickets to another
Automation Engine system ?

Yes, You need a dedicated Restore action. Consult Esko for this.

Can I use a backup of one system to just transfer its SmartNames to another AE
system ?

Yes, You need a dedicated Restore action. Consult Esko for this.

Do I need to restore backup when upgrading from Automation Engine 10 to
Automation Engine 12 ?

No. When the same computer is used to run Automation Engine 12 , it will use the same configuration
data and databases.

Can I upgrade my BackStage 7Rx directly to Automation Engine 12 ?

No. You need to upgrade BackStage 7Rx to Automation Engine 10.1. You can upgrade this to
Automation Engine 12.

Can I restore data from a backup of BS7Rx or AE 10 into an AE 12 ?

No. The format of BS 7Rx and Automation Egine 10.x backups is different from the format of the
Automation Engine 12 backup.

How do I make Automation Engine 12 based backup of my Automation Engine
10.1 system ?

In the Client Apps view, click on Tools in the left column. Click on the Launch button next to
Automation Engine 10 Backup.

In the window that pops up, fill in the destination folder, decide whether to include the databases
and click on Backup Now.

Managing databases

In the Databases window you can manage all databases that are on any accessible SQL server in
your network. Depending on the permissions on the selected SQL instance, you can:

• View the SQL server status
• Login and view the properties and status for each database
• Create or remove databases
• Back-up or restore databases
• Repair or move databases

Note:  Take into account that, even if you are logged in to the Server Administration, you also need
to log in to the SQL Server instance separately.
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In this page, you can manage the databases on any SQL Server in the network.

Managing SQL servers

In the SQL Server window you can manage any accessible SQL server in your network. You can:

• View the SQL server status
• Stop and restart an SQL server
• Login and change the properties: modify the maximum physical memory of the SQL server
• Look at the SQL server logs

Note:  Take into account that, even if you are logged in to the Server Administration, you also need
to log in to the SQL Server instance separately.
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How to Select and Log-In to SQL Server Instances

• You can select a SQL Server from the list of all SQL Servers that could be detected in your local
network.

The local SQL Server will be selected as default if there is one.
• To choose one not in the list, you can click Select another SQL Server, enter the name of the

SQL Server and click OK.

You can see the list of SQL Server Instances and their statuses beneath the SQL Server list. You
can select the Server Instance on which you want to manage the databases.

Note:  If the SQL Server Browser service is not running or your access is blocked to the Server
Service, the status of the Instance will be unknown.

Note:  If the list of SQL Server Instances is not available, you can select a SQL Server Instance
by entering its port number. The port number of the default SQL Server Instance will already be
filled in.

•
After selecting the SQL Server Instance, click the lock  at the bottom of the page. Enter your
credentials to login.

You should login to the SQL Server Instance to be able to manage the databases of a SQL Server
Instance.

Note:  All SQL instances configured with Automation Engine has two users by default: sa and
admin. The sa  user has all permissions for managing databases.

The admin user has a limited set of permissions. Therefore, if you are logged in as admin, you
may get warnings while performing certain database actions.

•
You can log out from the SQL Server Instance by clicking on the lock .

• You can view the databases installed on an SQL Server Instance by selecting it and logging in.
The list of databases will load after logging in.

Detailed database information will be available to the right of the selected database.
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FAQ on SQL Server Instances

How to start or stop a SQL Server Instance?

Select the SQL Server Instance you want to start or stop and click on Start the server or Stop the
server.

You are not required to login to the SQL Server Instance to Start or Stop the Server.

How to view the properties of a SQL Server Instance ?

You should select a SQL Server Instance and login to it. The properties will be loaded automatically
after you successfully logged in. Read more in How to Select and Log-In to SQL Server Instances
on page 224

How to modify the maximum physical memory of a SQL Server Instance?

Click on the Modify  link next to the current value of the maximum physical memory. The Change
max. physical memory dialog will open. Enter a value and click OK.

How to view SQL Server logs?

Click on the Show  link next to SQL Server logs. You can see the SQL Server logs in the following
dialog.

Note:  You will get a warning when you attempt to view the SQL Server logs if you have limited
permissions.
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Creating an Empty Data base

1. Click on + button. The Create database dialog will follow.

2. Fill in Database name  with a name that is not currently used.

3. If you want to create a new empty database, leave the Use data setting to No (empty database).

4. Enter the location and the file name for the Master database file  and the Transaction log file.
Alternatively, use the Browse to a specific location for these files.

Note:  The file names can be either a local or UNC path. If the selected SQL Server is not the
local SQL Server, the Browse  will be disabled. In such cases, fill in the UNC path.

5. Click OK to create an empty database.

Creating A Database from Back-Up

1. Click on + button. The Create database dialog will follow.
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2. Change the Use data setting to From backup .

3. Enter the location and the file name of the Backup file or use the Browse  button to select it.

Note:  The file names can be either a local or UNC path. If the selected SQL Server is not the
local SQL Server, the Browse  will be disabled. In such cases, fill in the UNC path.

4. The information from the backup file will be loaded and the Database name, Master database
file  and Transaction log file textfields will be filled in. If not, fill them in manually. Check the fields
to ensure that the database will be re-created correctly.

5. Click OK  to create a database from the backup file.

Creating a Database from Existing Database Files

1. Click on + button. The Create database dialog will follow.

2. Change the Use data setting to  From existing database files .

3. Enter the location and the file name of the Master database file and Transaction log file or use
Browse .

Note:  The file names can be either a local or UNC path. If the selected SQL Server is not the
local SQL Server, the Browse  will be disabled. In such cases, fill in the UNC path.

4. Click OK  to create a database from the backup file.

Deleting a Database

You can delete a database if that is not used by Automation Engine and the Automation Engine
Server. If it is running, trying to delete will prompt a warning.

1. Select a database from the list and click the - button.

2. Choose either or both of the options.
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• delete database files from disk
• close existing connections

3. Click OK to confirm.

Database Back Up

Context for the current task

• Select a database and click on Backup . The Backup database  dialog will open.
• Enter the location and the file name for the Backup file. use Browse  to choose a back-up file.

Note:  The file names can be either a local or UNC path. If the selected SQL Server is not the
local SQL Server, the Browse  will be disabled. In such cases, fill in the UNC path.

• Click OK.

If the selected SQL Server does not have access to the UNC path you entered, the Server Admin
Web Tool will show a warning: "Backup file for database X could not be created. Please make
sure the path for the backup file is correct.".

You can ensure access to the UNC path share by following the procedure outlined below:

1. In Windows Explorer, right-click the shared folder and then click Properties.
2. Select the Security  tab.
3. Click on Advanced . The Advanced Security Settings dialog will open.
4. Click on Change Permissions  under the Permissons tab.
5. Click on Add .
6. Click on Object Types button and make sure the Computers checkbox is checked. Click OK.
7.   In the textfield, give the SQL Server computer name for which you want to add permissions.

Click on Check Names . Click OK. The Permission Entry dialog will open.
8. Make sure the Allow checkbox next to Create files / write data  is checked. Click OK.
9.   Click OK  and close the open dialogs.

Restoring Database

You can restore a database by using Restore  function. You can will the location and file name in the
Restore database  dialog. Click OK to restore the backup.

You can restore a database that does not exist (anymore) on the selected SQL Server Instance
databases list. Click on +  to create a database from a backup file or from existing database files.
Read more in Creating A Database from Back-Up on page 226 and in Creating a Database from
Existing Database Files on page 227

Note:

If the database you are trying to restore is used by Automation Engine and the Automation Engine
Server is running, it will not be possible to restore the database and you will get a warning.

Moving or Renaming a Database

Context for the current task

1. Select a database from the list and click on Move . The Move database  dialog will open. .
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2. Enter the new location and the new file name for the Master database file and the Transaction
log file or use the Browse  button to select it.

Note:  The file names can be either a local or UNC path. If the selected SQL Server is not the
local SQL Server, the Browse  will be disabled. In such cases, fill in the UNC path.

3. Click OK  to move/rename a database.

Application Server

You can manage the local Application Server which is installed on the same computer as the
Automation Engine via the Server Admin Web Tool. Go to Home/Server Admin/Application
Server. In the Application Server window you can view the status of any accessible application
server in your network. You can:

• Start, stop or activate the local application server
• Download log files for support purposes
• Deploy components on the application server
• Log on to another application server

Among the actions available at this page. Deploy is only available when the server is configured as
Master Server. All the other actions are available when Application Server is installed.

Managing Application Server

Activating the Application Server

You can Activate the Application Server for repairing a serious malfunction of the Application Server
and when executing Deploy does not solve the malfunctioning of the Application Server.

Retrieving the Automation Engine Viewer Log Files
When you click the Log Files button, a ZIP file containing the Automation Engine Viewer log files
and the Application Server log files will be downloaded. The ZIP file contains a folder named
egappsrvlogs with Viewer log files (ImageList*.log) and a folder jbosslogs with Application
Server log files.
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Tip:  The log files of the Pages and Proofs View are contained in the log files of the Application
Server.

Deploy

When you click Deploy, Automation Engine Components are copied into the EG_APPSRV_DEPLOY
and EG_APPSRV_BINDEPLOY share of the computer indicated in the Deploy dialog.  When you
start the deploying, you indicate which computer Automation Engine will use for connecting to the
Application Server.

Note:  Deploy can only be performed when the Master Server is running.

When to use Deploy?

You can use Deploy when:

• you want to use another computer as Application Server.
• the Application Server installationreinstalled, repaired or updated.
• fixing incomplete or failed deployments.

The Automation Engine components are deployed on the Application Server during the installation
of Automation Engine.   If the deployment failed or was not executed, you can use Deploy to
complete the procedure.

Note:  Incomplete deployments can cause the following issues :

• The Viewer window fails to open when clicking on View in the Pilot.

• The Pages and Proofs View fails to function.

Troubleshooting

If you get an error message “Failed to connect server: host:8080” while clicking View in the
Automation Engine Pilot:

•
Verify that the Application Server is started.  Check the status and click the refresh icon 
next to the status.  Restart the Application Server and open the View again.

• It is possible that the deployment is incomplete.   Click the Deploy button and verify that the
deployment succeeds.

2.5 The Automation Engine Shuttle

The Automation Engine Shuttle is a client tool for easy submission of files to Automation Engine
workflows. Shuttle also allows monitoring of the workflows.

Download Shuttle from the Main section of the Server Admin Web Tool. You can access it by browsing
to http://<name of your server>  or  http://<name of   your server>:9999. Read
more in Installing Client Applications on page 28

If the Shuttle application is installed on your computer, the system will check if you have the
appropriate version and download updates if necessary.
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As explained in Shuttle on page 681, you first need to configure your Shuttle in  Tools > Configure
> Shuttle .

2.5.1 Launching the Automation Engine Shuttle

When you launch the Shuttle application from your installed programs, a pop up window with the
Shuttle Launch panel and a Task Monitor will appear.

• To open a new window, go to  File  >  New Window . You can use dedicated Shuttle windows
for each of your Workflows.

• Shuttle saves the settings of the open windows while closing. These settings are restored during
the next launch.

• You can use View menu to hide or show the The Task Monitor, Shuttle Launch panel and the
Status Bar.

• View > Tasks  hides/shows the Task monitor.
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• View > Launch Panel  hides/shows the Launch Panel.

• View > Status Bar  hides/shows the Status Bar indicating the progress.

2.5.2 Working with the Automation Engine Shuttle

You must login to the Automation Engine Server to use the Shuttle.

Note:  You have access to Shuttle if you have access to Pilot. But your access to Pilot may be
restricted even when you are allowed to use Shuttle. This requires a user access right (Pilot: start
the Pilot (in addition to Shuttle)). Read more in Access Rights on page 702.

The following menus are available in the Shuttle application on Mac and Windows:

• File menu: Submit one or more files and launch the selected Workflow, open new Shuttle windows
and close Shuttle windows.

• Edit menu: cut, copy, paste, delete a Task or Workflow, select all Tasks and Workflows in the
Task Monitor.

• View menu: show or hide the Task Monitor, the Shuttle Launch panel and the Status Bar.

• Task menu: open or show the output file of the selected Task or Workflow, release or cancel the
Task or Workflow, add annotations and show detailed information.

• Window menu: minimize, zoom and switch between Shuttle windows.

• Help menu: See the About window or open the Online Help (Esko Help Center).

Setting the Preferences for Shuttle

• On Mac, select Preferences... in the Application menu.

• On Windows, go to  Edit > Preferences...

In the Preferences window, set the units for Dimension, Resolution, Ruling and the number of
Decimals to use.

You can also select the Always show launch dialog option. This will show the Public Parameter
dialog upon starting a new task, even if there aren't any public parameters. This allows you to alter
these types of tasks before they launch.
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The Task Monitor

When you are logged in, The Task Monitor displays your Automation Engine Workflows launched
from both the Shuttle and the Pilot.

To filter the displayed Workflows, you can choose a job context filter.

• Go to the drop-down list in the toolbar and select the desired job. All recently used jobs are listed
in this list.

• If the desired job is not present in the list, choose Other.... The Open dialog will prompt where
you can choose the desired job.

• Choose the menu item "All Jobs" to clear the current filter.

Note:  You cannot view, open or edit the Tickets of the Tasks or the Workflows in the Task Monitor.
This is only possible in the Automation Engine Pilot.

Intervening in a workflow

You can intervene when a workflow is halted for user intervention provided the Workflow user
intervention settings designate you for intervention. To intervene,

• Click on User intervention needed link of a workflow.
• In the resulting To Do window, choose to Forward or Release.

Tip:  You cannot hide the columns displayed in the Task Monitor. However, you can change the order
and the width of the columns.

Context menu options

Right-click on a workflow/task to access the context menu with the following options:

• Open Output File opens the output file of the Task or Workflow with the appropriate application.
• Show Output File in Finder/Explorer shows the folder that contains the output file in Mac Finder

or in Windows Explorer.
• Release allows you to release the Task or Workflow if it is on Hold.
• Cancel allows you to cancel the Task or Workflow.
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• Delete allows you to delete the Workflow from the list of Workflows the Task Monitor.

• Annotation... shows a dialog that allows you to add or modify an annotation.

• Details shows the Details dialog with detailed information about the Task or Workflow.

Alternatively, these options are also available via the Task menu of the Shuttle application.

The Shuttle Launch Panel

You can drop one or more files as input files for the selected Workflow/Task through the Shuttle
Launch Panel.

• Browse to the desired workflow using the Workflow drop-down list. This will be updated when
new workflow tickets are created. Shuttle launches the selected workflow when files are placed
in the Shuttle Launch panel.

Attention:  The drop-down list only shows the Workflow Tickets that are public.

• The selected workflows are saved when you quit Shuttle. Shuttle restores the selection of
workflows during the next launch.
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Launching a Workflow from the Automation Engine Shuttle

1. If the Launch Panel is not visible in the Shuttle window, go to  View > Launch Panel .

2. Select the desired Workflow with the drop-down menu. Shuttle will launch this Workflow when
files arrive at the launch panel.

3. Submit one or more files in one of the following ways.

• Drag and drop the desired file(s) into Drop Files Here area.

• Go to  File  > Launch...  and select the files.

• Use the keyboard shortcut Command-L on Mac or Ctrl-L on Windows and select the file(s).

Note:

• The selected file(s) will be uploaded to the root folder of the job.
• If a file was previously launched on the chosen workflow, a dialog will prompt to give you the

option to reuse the public parameter values from the previous launch. If you choose to reuse
these public parameter values, they will be used as default parameter values. You can still edit
these values if necessary.

• If a file with the same name is already present in the root folder of the job, a dialog is prompted
warning you of overwriting the file. You can then choose to either Replace the existing file, or
Cancel the launch to rename the file.

4. If your workflow has Public Parameters, you can fill them in the New Task window which will
prompt. Learn more in Using Public Parameters in Workflows on page 1051. It also possible to
set the Task Options in this window.
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a) You can set Task OptionsIn the New Task window, click the Task Options button.

In the resulting window, you can:

• set the Priority of the Task or Workflow as Low, Normal, High or Immediate by selecting
from the drop-down.

• select Hold if you want to hold the launch of the Workflow. The Workflow will not be
launched until you Release via the right-click menu in the Task Monitor or via the Task
menu.

Alternatively, hold the workflow until a set period of time after which it will be automatically
released. To do this, select Release at and specify the period or date and time.

Note:  You can bypass the automatic release setting by selecting Release via the right-
click menu in the Task Monitor or via the Task menu.

• Select Launch a separate Task per input file for launching a separate Task or Workflow
for each input file.

• You can also set an Annotation for the Task or Workflow in this window.
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5. Click the Launch button to launch the workflow.

The task will immediately appear in the Task Monitor.
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Note:

You can upload multiple files for multiple workflows. Click on the Plus button  to add extra
drop zone slots.

To remove these slots, proceed as follows:

•
Click on the Minus button . This will place the user interface in Editing mode

• Click on the desired Delete button on the top left corner of the drop zone.

• To leave the Editing mode, click on the Minus button, or press Escape.

User Intervention from the Shuttle

If you have setup a Wait for Action step in the workflow, the process halts for user intervention (for
a To Do action). User intervention needed link will appear in the Task monitor when the workflow
is halted.

1. Click on the User intervention needed link.
The To Do dialog will prompt.

2. You can select I am currently handling this to do item to mark that you are handling this To Do.

3. You can choose to Forward, Release or Delete the To Do.
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• You can let the workflow continue by clicking Release. Select the output state that you require
in the release. The To Do window will close and the Workflow will continue processing.

• You can forward the To Do to another user. Click Forward and the workflow will not continue
until the other user handles the To Do.

• You can also delete the To Do by clicking on Delete. This will end the processing of the
workflow.

2.6 The Workflow Editor

The Workflow Editor is documented in the separate chapter on Workflows on page 986.

2.7 The Tasks and Workflow Controls

This chapter is a full (alphabetical) list of all available Tasks and Workflow Controls and their
description. Some of the tasks and tools mentioned are optional.

Some of the items refer to another page where they are documented as part of a dedicated chapter
related to that technology.

At the end of this complete list, we mention the deprecated and obsolete tasks.

2.7.1 Add Dynamic Marks

Use this task to apply marks from a pre-defined mark set to the input PDF file. The mark sets are
created using the Dynamic Marks plug-in for Adobe Illustrator.

This task produces a non-normalized PDF. This PDF does contains all the information from the input
file (for example object based screening).

Note:  In situations where a normalized PDF is required in steps of the workflow after the Add
Dynamic Marks task, you can add the Normalize PostScript/ PDF/ Illustrator file task to the
workflow. If you use this extra task, ensure the Use rulings, angles and dot gain compensation
from file  option is enabled on the Inks tab to preserve the screening parameters.

Task Settings
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Replace existing marks: Select this option to remove existing marks from the input file while adding
the new mark set. If left unchecked, the old marks will be preserved.

Mark Set: This table lists the mark sets added to the task and the pages those mark sets apply to.
To add or remove marks from the table, or edit the existing marks, see the following section: Mark
Set Control for more info.

Processing: The time this task will take to process the marks. Choose from the following options:

• Calculate once and copy (faster): When choosing this method, the mark content is calculated
only once for the first and second page. After that, this information is copied to all other pages.
The content from the first page is copied to the odd pages, the content from the second page is
copied to all even pages. This method is also called "caching".

Note:  Some marks cannot be cached because the content depends on the page number (for
example text mark with a sheet number variable). In this case, the task will fail to avoid a wrong
output. If this happens a message will be displayed in the task details.

Note:  Do not combine caching together with text marks that contain current time. If so, the time
stamp from the first page will be copied to all odd pages and the time stamp from the second
page will be copied to all even pages.

• Calculate for each page (more accurate): Use this option when mark content calculation for
each page is necessary. This option will slow down the progress of the task, but it will generate
more accurate results.

Mark Set Control

You can use the following options to control the Mark Set table:

• Add: Click this button underneath the table to add a new Mark Set. The Add Mark Set dialog
will prompts:
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• Mark Set: specify the name of the Mark Set, using one of the following methods:

• Select the name from the existing Mark Set names, available via the selector on the right
side.

• You can type a name manually.

• You can use SmartNames.

• Add to: specify on what page(s) the mark set should be applied. Choose one of the following
options :

• All pages: The mark set will be applied on all pages.

• Even pages : The mark set will be applied on all even pages.

• Odd pages: The mark set will be applied on all odd pages.

• First page: The mark set will be applied on the first page only.

• Last page: The mark set will be applied on the last page only.

• Remove: To remove a mark list, select the desired mark list and click the Remove button
underneath the Mark Set table.

• Edit: To edit a mark set, double-click the desired mark set in the table. The Add Mark Set dialog
will prompt, allowing you to edit the details.

2.7.2 Add Ink Eaters

Ink Eater areas are the non-printed areas that are not part of the printing jobs. These can be left-
overs that will be cut off or the white spaces next to and in between one-ups. Ink Eater areas help
to achieve a constant ink consumption over the width of the plate. This makes it easier for press
operators to set the ink keys, and results in a faster setup time for the press.

Ink Eater areas helps to avoid excess ink buildup by stabilizing "peaks" and "lows" in the ink key
histogram. This prevents spilling of excess ink onto the printed zones of the printing jobs. You can
flatten the ink key histogram by filling non-printed zones with a gradient. A gradient(resolution) is
used to avoid hard edges in the compensation object. You can adjust the settings for minimum ink
density and minimum ink key value. You can get warnings when the maximum total area coverage
(TAC) is too high depending on the settings of this task. These areas are then compensated(filled
with ink) depending on the strategy settings you give in the task.
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Using this task you can :

• create Ink Eater areas or choose a predetermined Ink Eater area
• fill Ink Eater areas with predefined settings.

Select the Ink Eater tab to create ink eater area and to define settings for filling Ink Eater zones.

Ink Eater tab



2
Automation Engine

243

Ink Eaters Areas

You can choose predefined and named objects as Ink Eater by choosing Fill Named objects. This
is useful when you have defined the Ink Eater areas in another software such as Plato.

Create Ink Eater Areas

You can choose from four options in the Start from Station's field to create Ink Eater areas:

• Die Shape: when the Die Shape is pre-defined(for example in Plato) and when it can be used as
edge for the Ink Eater object.

• Trim Box: when the edge of the Ink Eater object is defined by the Trim Box of the one-up on
the plate.

• Media Box: when the edge of the Ink Eater object is defined by the Media Box of the one-up on
the plate. Media Box is larger and it contains the Trim Box.

• Die Annotation: You can mark an object as a die in a software such as Plato. When you choose
this option, these objects will be used to define the edge of Ink Eater area.
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You can restrict the creation of Ink Eater areas by choosing the shape as above. The selected shapes
will be saved as Ink Eater areas. To set the offset for the Ink Eater object in relation to the Die Shape
or Trim Box, you can fill in the distance in the Keep Away field . You can exclude SmartMarks in the
Ink Eater object by enabling Exclude SmartMarks option.

Scan Ink Coverage

When you have selected a contour object or a group of contour objects for ink coverage, you can
use the options under Scan Ink Coverage for filling the Ink Eaters

• Scan: You can specify the area the scan has to cover by selecting either of the two choices. All
Inside Sheet (Sheet View) will scan within the sheet and will exclude objects that are outside the
sheet. All Inside Plate (Sheet View) option will scan all objects on the sheet and plate. If you have
objects that extend or are outside the plate, they are not included.

• Direction:You can specify the direction for ink coverage. Horizontal means that the ink zones
are vertical on the plate and the ink histogram is on the horizontal base of the document. The
direction of the compensation gradient in the ink eater area is horizontal.

• Resolution: This indicates the number of intermediate steps of the gradient to be used as
compensation.

Note:

You can achieve global compensation by giving a low resolution value (for example 5 gradient
steps). This gives a very smooth compensation gradient along the length of the press. The ink
histogram zones are very wide with this setting.

You can achievevery local compensation by setting up a high resolution value (for example 60
gradient steps). This results in a gradient with more banding.

Use Very Low for 5 steps, Low for 15 steps, Medium for 30 steps, High for 45 steps and Very
High for 60 steps.

Compensation

You can choose the ink use strategy for filling the Ink Eater zones from the options given below.

• Economic : you can minimize the ink use by choosing this strategy to fill Ink Eater areas.

• Best performance: you can have the best performance in print by using the maximum ink to fill
the Ink Eater zones.

• Intermediate: you can optimize the ink use and to get medium performance, you can use this
strategy.

You can specify the Ink key settings for filling the Ink Eater areas by defining the following settings.

• Minimum Ink DensityYou can set the minimum ink density of the ink separation in the ink eater
area by enabling this option and specifying the percentage.

• Minimum Ink key Value: This indicates the minimum ink key value for the ink eater area. The ink
density of the gradient is adjusted to make sure the ink key value is higher than this settings.

• Maximum Total Area Coverage: You can enable the option and enter a maximum total area
coverage (for example, 270%) to display warnings in those areas of the histogram where the total
ink coverage exceeds your limits.

Inks tab

You can exclude inks such as Non-process, Opaque and Varnish inks by enabling these options in
the Inks tab. You can keep the original separations by enabling Keep similar inks in their original
separations
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2.7.3 Add Marks To Imposition

Use this task to add mark definitions to impositions, plates or pages. This task can add marks at
all these levels:

• page

• sheet

• section

For example, you can add sluglines to include text at sheet level or page level and collating marks
for the entire section.

The added marks will be included while exporting the output using the Export Imposition to PDF
file task or the Export Imposition to JDF file task .

Check Replace existing marks to remove the existing marks before adding the new marks.

Note:  Existing marks here include the marks defined in the JDF template.

Use Add to compose the list of marks.

You can choose from the following mark definitions:

• Trim Mark: Info about adding a Trim mark in Adding Trim Marks on page 246,

• Rectangle: Read about adding a rectangle mark in Adding Rectangle Marks on page 247

• Text: Read about adding text marks such as collating marks in Adding Text Marks on page 247

• Image: Info about adding an image mark in Topic title

• Bar Code

When you have selected the type of smart mark, a Properties dialog will open where you can define
appropriate settings.
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Adding Trim Marks

1. In Add marks to imposition task, click on Add.

Check Replace existing marks to remove the existing marks before adding the new marks.

Note:  Existing marks here include the marks defined in the JDF template.

The Add mark dialog will open up.

2. Click on the Trim Mark icon.
The Trim Mark window will open up.
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3.
Click the trim marks button  located adjacent to the four courners around the page image to
activate/deactivate the individual marks.

Note:  This right hand side of the page image is pointing outwards.

4. Give a Namewhich will be displayed in the Add marks to Imposition task panel.

5. Enter Lengthand Weight of the individual trim mark.

6. Set  Offset which is the distance between the trim box of the page and the trim mark.

7. Choose Color for the marks. You can choose from:

• None : This is useful when enabling or disabling the trim marks using SmartNames.

• Registration: to choose all inks

• Darkest: choose this when you want a Color darker than Process Black.

• Black or Darkest

• Knockout

Note:  When creep is applied, set trim marks will move depending on the creep settings of the
individual pages.

Adding Rectangle Marks

You can create Rectangle Marks at:

• page level

• sheet level

• section level.

Most of the settings of adding a rectangle mark is similiar as in Adding Text Marks on page 247.

In the rectangle smart option, you can specify the intensity for the chosen color of the mark and its
background. This is useful when building control strips using rectangles.

1. In Add marks to imposition task, click on Add.

Check Replace existing marks to remove the existing marks before adding the new marks.

Note:  Existing marks here include the marks defined in the JDF template.

The Add mark dialog will open up.

2. Click on Rectangle icon.
Rectangle Mark Properties window will open where you can specify the mark settings.

3. Specify the settings as in Adding Text Marks on page 247.

4. Specify an intensity for the Color and Background.

Adding Text Marks

You can create a text mark at:
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• page level

• sheet level

• section level.

1. In Add marks to imposition task, click on Add.

Check Replace existing marks to remove the existing marks before adding the new marks.

Note:  Existing marks here include the marks defined in the JDF template.

The Text Mark Properties dialog will open up.

2. Give a Namewhich will be displayed in the Add marks to Imposition task panel.

3. Give the specific content by:

• typing it in
• using SmartNames
• by browsing to the file with the intended text.

Use the InkNames SmartName in the content to identify the individual printing plates. The text
mark will be set for each plate and the SmartName will be replaced with the indiviual Ink name.

4. Select the level of the smart Mark. In the Attach to field, select from Sheet, Page or Section.

5. Select the Reference to your desired level. You can choose from

• Paper
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• Plate
• Trim Box
• Bleed Box

The reference is the rectangle you will use as a reference to position your mark.

6. Set the Position tool to the precise location of the reference.

The Position tool allows you to snap the blue rectangle (your mark) relative to the inner gray
rectangle ( your reference rectangle).

7. Click on Size and Margins to define the size and margins of the text mark.

You can specify the final dimensions of the mark in this window. The resulting mark will be
positioned and rotated using the parameters from the Text Mark Properties dialog.

a) Specify a height and width for the text mark. You can either choose Fixed and specify the
dimenstions or choose Fit to text.

b) Set the Clip on level to limit the boundaries of your mark. You can choose to clip the mark
at Plate, Paper or Mark levels.

c) Select the Margins. These are extra margins on top of the text box height and width.

Note:  These margins are taken into account for positioning the mark and are included when
creating background color.

d) Set Alignment to position the text within text box. relative positioning when the SmartName
[InkName] is used and multiple text lines are set on top of each other.
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The Size and Margins window will open up.

8. Choose the Orientation of the text and set the dimensions. Use the orientation mark to rotate
your mark.

Specify a vertical and horizontal offset after positioning the mark relative to the reference
rectangle.

9. If you have chosen Section in Step 4, you can use the text mark as a collating mark. Enable Use
as collating mark.

a) Click on Collating Properties.
The Collating Properties window will open.

b) Select the Pattern and Direction of the collating mark from the symbols given. Alternatively,
use SmartNames.

c) Specify the Offset which is the distance between two collating marks.
d) Specify the Step which is the height of the collating mark.

Note:  You can pick any mark except a trim mark to be used as collating mark.

Use the following settings for a standard collation mark.
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• Position: Place the top center of the mark attached to the top left of the Reference trim box.

• Set -back as horizontal offset. Enter a hyphen (- and use SmartName Back from the
SmartName category Mark Information.

• Set aFixed height and width for your mark in the S

• ize and margins window.

• In the Collating Properties, use markheight" as the collating step.

• Use SmartName Markheight from the Mark Information category as Step

• Choose the saw tooth pattern.

• Select down as stepping direction

• Use vertical text Orientation.

• Select Registration as background color.

• Select Knockout as the mark color.

10.Select the Color which is the selection of the color for the text in the mark.

Note:  This value is ignored if you use the SmartName [InkName] in the Content field.

11.Select a Background Color which is the color of the rectangle within which the text mark is
placed.

Background color is the color of the rectangle surrounding your slug line, you can influence the
dimensions of this rectangle using the Size and Margins dialog.

Adding Image Marks

You can create image marks at:

• page level

• sheet level
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• section level.

Most of the settings of adding a image mark are the same as in Adding Rectangle Marks on page
247.

1. In Add marks to imposition task, click on Add.

Check Replace existing marks to remove the existing marks before adding the new marks.

Note:  Existing marks here include the marks defined in the JDF template.

The Add mark dialog will open up.

2. Click on Image icon.
Image Marks Properties dialog will open up.

3. Specify the settings as in Adding Text Marks on page 247.

In the Image Marks Properties window, you can choose Mapped as a Color.

4. Specify an intensity for the Color and Background Color.

Adding Bar Code Marks

You can create Bar Code marks at:

• page level

• sheet level

• section level.

1. In Add marks to imposition task, click on Add.

Check Replace existing marks to remove the existing marks before adding the new marks.

Note:  Existing marks here include the marks defined in the JDF template.

The Add mark dialog will open up.

2. Click on Bar code icon.
Bar Code Marks Properties dialog will open up.

3. Specify most of the settings as in Adding Text Marks on page 247.

Note:  If you use Registration as the Color, the mark will appear in all the plates you have defined
in the plates viePlates View.

4. Click on Select Bar code. This will result in Select Bar Code window.
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5. Specify Bar Code Parameters.

• Bar Width Reduction: Use this option to compensate for the ink spreading on the press..

• Narrow Bar: Fill this in to change the default size of the bars.

• Magnification: Use this to make your barcode bigger or smaller than its default size.

• Add Bar Code Text: Select No to remove the text located below the bar code.

Note:  You cannot choose the Bar Code type. The default is Code-128

2.7.4 Add SmartMarks

Add SmartMarks

With the Add SmartMarks task you can apply a SmartMarks set to a PDF file. A SmartMark set is a
group of marks that can be created in PackEdge, Plato or i-cut Layout. Consult the PackEdge, Plato
or i-cut Layout documentation to learn how to create SmartMarks sets.

Applying a SmartMark set can be done in 2 ways:

• Add to current set: will merge the SmartMark set with any existing SmartMarks in the file.

• Replace current set: will replace any existing SmartMark sets
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Note:

• Since only a normalized PDF file can contain SmartMarks, Replace current set is not relevant
for native PDF files.

• When applying a SmartMark set on a native PDF file, the resulting file of the task will be native PDF
too. Any applied SmartMark set will be converted into normal PDF objects. For more information
on normalized versus native PDF you can refer to the User Guide.

Load on all Pages: Selecting this option loads the selected SmartMark set on all pages of a multi
page input file.

Load different set on even pages: Selecting this allows you to apply a different SmartMark set on
the even pages of a multi-page input file. For example: load a different marks set on the backside
of a layout.

Load Mark Set in bottom layer: This option allows you to choose if the marks set should be applied
on top of the graphics or if the graphics should be on top of the marks.

Fit Margins: Depending on the setup of your SmartMark set, it can happen that the marks generated
are (partially) positioned outside the PDF’s media box. Selecting this option will extend the media
box to all the visible content outside the trim box.

2.7.5 Add to Pages View

The Add to Imposition Gallery task brings IMP files from the Files View into the Pages View. This
task will especially be used in workflows or when working with Folder Access Points.

The following workflows work in combination with the Add to Pages View ticket.

On a PDF file:

• Copy or Move > Normalize PDF File > Add to Pages View
• Normalize PDF File > Add to Pages View
• Right-click the file in the Files View and select 'Add to Page Gallery' from the context menu.

On a PDFSC file:

• Copy or Move > Add to Pages View
• Right-click the file in the Files View and select 'Add to Page Gallery' from the context menu.

Note:

This task is only used in page workflows.

2.7.6 Add To Products

This task is documented in the chapter Products on page 876. Find a direct link here.

2.7.7 Adjust PDF Screening

You can apply rule-based modifications of screening parameters using this task. This helps to limit
the changes to specific requirements. For example, you can set just one rule. However the task is

http://help.esko.com/docs/en-us/automationengine/12.1/userguide/home.html?q=en-us/common/ae/concept/PDFnormalisationinAE.html
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flexible enough to let you make a complex set of rules for changing the screening parameters. See
the following example screenshot which has criteria defined to change the screening parameters of
a CMYK document (of corresponding separations).

You can preview the Separation Details when a file is selected. This will display the results for the
specified set of rules in the current file.

This task:

• limits the changes to what is needed. For example, when you only want to change the ruling for
all separations.

• can use the criteria like inkbook, printing method or ink type. For example, you can set rule such
as : when printing method is flexo; set DotShape to "F".

• can use SmartNames. You can set SmartNames for screening parameter values and specify the
condition accordingly. For example, if the name is "Cyan" or "Magenta" or "Yellow" or "Black";
set DotShape to [mydotshape] .

• add complex and elaborate set of rules. For example, in the case of Object Based Screening,
use a rule such as : when name is "Cyan" and angle is between "0" and "45" ; set angle to 30
and DotShape to "R"

Note:

The screening parameter DotShape does not exist in native PDF. Instead there is a SpotFunction
Name, which can have a limited number of values like SimpleDot, Ellipse, Square which are mapped
to the Esko DotShapes "C", "E", "S" respectively. Other SpotFunctionName values are mapped
to "C".

The task Normalize AI/Illustrator/PDF File does not take account of the DotShapes (SpotFunction
Name Values) specified in Native PDF fIles. You need to adjust the PDF Screening parameters during
or after normalization.

1. In the task settings, click on Add. This will start a dialog where you can enter the rules for screening
parameters.

2. Enter a Name  for the rule. For example, you can type in the same name as the ink name.
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3. Select Apply rule to all separations if the rule applies to all separations.

4. Select the condition for the criterion under If separation matches. You can choose from Ink
name, Ink book, Ink type, Printing method, Ruling, Angle and Dot shape. Set the condition
specific and give related text in the field. If needed, add more criteria by clicking on +.

5. Select and specify the Apply Separation settings as per the requirement. You can specify
Rulingand /or Angle and /or DotShape.

6. Click OK.

7. Repeat steps 1-6 to add more rules.

For each of the separations the rules are accounted for in the set order. In the current example
(see the previous screenshot), when a separation (Cyan, Ruling of 135 lpi, Angle of 60 degrees, no
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dot shape) is present in the document, the first rule is considered. Since it complies with the set
conditions, a new angle is set (45 deg). In the remaining set of rules, only the last one is relevant.
According to the last rule, the task sets the dot shape and the ruling. but does not modify the
already set angle.

If a file is selected, you can preview the applied rules under Separation Details. To be able to
do this, enable Preview.

8. Click OK  to save the task.

2.7.8 Apply ArtPro Action List

In Automation Engine the Apply ArtPro Action List task automates tasks in ArtPro and converts
Nexus workflows into one or more Automation Engine workflows.

The Processor uses an ArtPro Action List to define the list of actions which are to be executed. This
file can be created and edited by using the ArtPro Action List Editor. An Edit button in the Apply
ArtPro Action List task panel launches the ArtPro Action List Editor with the selected Action List.

Complicated NexusProcessor workflows with file dependencies and "Select File" activities are
broken into a set of processor tasks with relatively small Action Lists. These tasks are combined in
workflows using Router, Select File etc. All Action Lists are placed in a custom folder on the server.

The Processor window consists of a section in which users can choose ArtPro Action List items.

Click Using SmartNames radio button to define ArtPro Action List items using SmartNames (please
see Using SmartNames for more information about SmartNames).

Or click the Selecting Below and Customizing Parameters radio button and pick one from the list.
Click the Edit button to open the selected action list in the ArtPro Action List Editor.

Click the Refresh button to update the panel. This not only updates the list of Action List items but
also updates the parameters of the selected item. However, it does not change any parameter values.
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Click the Refresh button while holding the Shift key to revert the parameter values in the panel to
the values that were saved in the Action List.

Using SmartNames in Apply Artpro Action List Task

This task has access to Automation Engine SmartNames linking to Artlink parameters in ArtPro files.
Use SmartNames from the following categories:

• File Information
• Global ( custom created SmartNames )
• Job Information
• Job barcodes
• Job parameters
• Miscellaneous
• Path information
• Product information
• Product Parameters
• Product Part Parameters

Note:

• The SmartNames are resolved when you open the ArtPro file.
• You cannot use SmartNames for which a task is required to resolve the values ( for eg. TaskID ).

Use SmartNames based on the file location or file name.
• You cannot use a Workflow Parameter directly as an Artlink parameter.

Tip:  You can create a Global SmartName based on the Workflow parameter and link this as Artlink
Parameter Value. Read more in ArtPro User Guide.

• When an ArtPro file is saved in a Job and linked to a Job Parameter, the information is only kept
within that Job. When the same file is saved outside that Job, this Job Parameter info is lost.

• When a Global Product is linked to multiple Jobs and Job SmartNames are used, any of these
values can be stored in the file. The ArtPro Processor does not update the parameter to the
current Job.

2.7.9 Apply Creep

Use this task to define compensation for 'creep'. When a publication is folded, the bulk of the paper
causes the inner pages to extend beyond the outer pages. Creep defines by how much the edges
of each inserted spread or signature extend beyond the edges of the one enclosing it.

When used correctly Apply creep task will ensure that the pages are correctly aligned after folding.
This task works for Perfect Bound as well as Saddle Stitched impositions.

• Set creep for each new Sheet in the case of Perfect Bound impositions.
• Apply creep across all sheets in the case of Saddle Stitched impositions.

You can apply either outer creep or inner creep depending on the bleed.

• Use outer creep when there is enough bleed in the back of your pages. This will add bleed to
the back of outer pages.

• Use inner creep when there is not enough bleed in the back of your pages. This removes small
strips from the back of inner pages for proper alignment.
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Creep is applied when exporting an Imposition or Plate to PDF or JDF using the Export Imposition
to PDF file or Export Imposition to JDF file

tasks.You can inspect the results of your Creep settings by using the "Open in Browser" function on
an Imposition in the pages view or a Plate in the plates view.

Using the Task

1. Go to Plates View and select the Imposition. If you are selecting Pages, go to Pages View and
select Page Slots.

2. Specify a Creep Type. Choose from:

•
None 

•
Inner 

•
Outer 

Alternatively, choose the relevant SmartName.

Note:  You need to create SmartNames with values None, Inner and Outer .

You can create exceptions to the top level Creep Type for particular Sheets or Pages (like no
creep) . To do that:

• Select the Page where you want exception to the general Creep Type.
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• Right-click and start a new Apply Creep task.

Attention:  If you apply higher level creep after setting lower level creep settings made
earlier will be overruled. Therefore, first create the higher level creep and then apply
exceptions to lower levels.

3. Set the Distance per page depending on the expected shift.

Note:  You can calculate it as Pi/2 times the thickness of the paper.

Note:  The distance values gets converted to mm. For example: '0.01 in' the ticket will be returned
as '0.254 mm'.

2.7.10 Archive Job

This task is documented in the separate chapter on Jobs. Find a direct link here.

2.7.11 Assign Pages To RunList

Use this task to assign individual pages (for example revised pages, new pages) to an existing
Imposition or RunList. You can add pages to a designated slot in a folio or index.

The task uses :

• PDF files
• Pages

Tip:  Define SmartNames for Impositions, RunLists, PageSlots and Layers to be used in the Assign
Pages to RunList task. This task is best suited in a workflow setting to update specific pages. For
example, you can assign pages to an existing pagelist in WebCenter. Use this to automate the re-
assigning of corrected pages and the corresponding WebCenter approval workflow.

You can either assign a single Page or all the pages using this task.

This task has two output pins for assigned and unassigned page slots when used in a workflow.
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Page Slot

• Define the designated slot where the pages should be placed

• Folio

• Index

• Fill in the input field. Use a SmartName to indicate the page to be mapped. When you select a
single page, it will be mapped to the corresponding page in the existing RunList.

• When left blank, the page index or folio of the pdf file is mapped onto the corresponding page
slot in the runlist.

Imposition: Give the name of the Imposition where you want the specific page or all pages to be
reassigned.

If you leave this on Auto, all Impositions for the current job or workflow (when you work without job
context) will be considered for assigning the page/all pages.

RunList: Give the name of the RunList in this field in which you want the specific page or all pages
to be reassigned.

If you leave this on Auto, all RunLists for the current job or workflow (when you work without job
context) will be considered.

Layers: If you have Layers, give the name of the Layer in this field in which you want the specific
page or all pages to be reassigned.

If you leave this on Auto, all Layers for the current job or workflow (when you work without job context)
will be considered.

Allow page Reassignment: Check this to allow to replacement of existing pages and blanks. The
task assigns only empty page slots when this toggle is unchecked.

Reassign: Use this control to protect pages against unwanted replacement. Choose from the drop-
down options:

• Always, even when approved.
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• Always, except when approved

• When rejected or approved with warning.

• When rejected.

• Never.

Note:

• You cannot assign pages to a locked Imposition.
• Split your spreads before using this task.

2.7.12 Calculate Ink Key Settings (InkPlanner)

The InkPlanner ticket is used to create CIP3 files (mainly PPF), which contain all necessary data for
the printing and further processing of a job.

Note:  The InkPlanner ticket cannot be launched separately. It always needs to be connected to an
Expose to FlexRip ticket. It cannot be connected to Proof or Approval tickets.

Global settings

Select the Plate Setting File (*.ini), which contains specific information for the CIP3 generation, like
image position, rotation, compensation, etc.

Select the Press Configuration File (*.dat), which contains data about the press and the InkPlanner
output.

Note:  You need to have created the Plates Setting and Press Configuration files with the CIPress
Setup tool before using this ticket.

The name entered in the Output File Name will be used for making files created by InkPlanner. This
InkPlanner output will be stored in the 'output directory' specified in 'Press Configuration File' (*.dat).

Page Side: select Automatic, Front, or Back from the list.

Note:  The option selected here has priority over the page side option selected in the Plate Settings
file.

Tip:  If an imposition file is processed, the page side option should be set as Automatic. The page
side settings typical of the imposition file will then be processed.

CIP3

Use the input fields provided to enter administrative data in the output file. This information will be
useful when further processing CIP3 files.

• Job Name: (required) If nothing is specified, the default job name will be used.

• Sheet Name: (optional)

• JobCode: (optional) is the code used for the job identification.

• Make: (optional) refers to the make of expose device.

• Artist: (optional) refers to the person who created the sheet.
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• Customer: (optional) refers to the target customer.

• Software: (optional) refers to the software used to create the sheet.

• Paper Weight: (optional) the weight of the paper to be used.

• Paper Thickness: (optional) the thickness of the paper to be used.

Note:

If you do not enter anything in the input fields, the corresponding input fields in the CIP3 tab of the
Plate Settings tab in the CIPress Setup tool will be checked.

Anything that is entered in there will be taken into account.

2.7.13 Check Dynamic VDP Database

The Check Dynamic VDP Database task validates a VDP database before running the Expand
Dynamic VDP Data task. Although, the same checks are conducted as in the Expand Dynamic
VDP task, the Check Dynamic VDP Database runs faster because it does not generate any output.

This task analyzes all entries from the database using rules stored in Variable Data Template (VDT file).

Note:

When used in a workflow and the check succeeds, the task will produce a database CSV file which
can be sent to the next workflow step.

If the check fails, the task delivers a report file listing the detected issues.

This task requires the following

• a CSV database as input,
• a VDT template as mandatory parameter.

Task Settings

• CSV File Encoding: Specify the desired character encoding.

Note:  The default encoding is UTF-8. This is also the recommended encoding.

• Field Separator: specify the separator or let the task identify automatically via Detect
Automatically. The following separators can be used:

• , (Comma)

• ; (Semicolon)

• Space

• Tab

• Field Names: Field names map data chunks from the database entry to its corresponding VDP
template items. You can choose from:

• From CSV file: If this is selected, the task will extract Field Names from the first record of
CSV file by default.
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Attention:  The Field Names can only contain the following characters:

• lower-case ASCII letters ("a-z")
• upper-case ASCII letters ("A-Z")
• digits ("0-9")
• underscore ("_")

• From Header file: When selected, provide a Header File containing Field Names.
• Header File: You can browse to the CSV Header File or use a SmartName to access the file.

The Header File:

• should contain a single line specifying the Field Names.
• should have Field Names corresponding to each column present in the CSV file.
• and the CSV file must use the same delimiter and encoding.

• Template: browse to the Variable Data Template file containing rules to check database validity.
The template is created and exported using the Dynamic VDP DeskPack Plug-in for Adobe
Illustrator.

2.7.14 Check Job Parameters

This task is documented in the chapter dedicated to Jobs on page 828. Find a direct link here.

2.7.15 Check Print Rules (PRC)

Print Rule Checker inspects jobs, completely or partially, for potential printing problems and violations
of standard printing conventions. Insufficient line thickness, wrong halftone densities, the use of
too many inks, and various other production-related issues are brought up instantly. The PRC task
will add the results of the checking pass to the Normalized PDF file. The Normalized PDF file can
be inspected in detail using the graphic editor. In the editor the user will see a full report of the
checking pass and has tools to quickly navigate to the parts of the job where rules have been violated.
Additionally, a report file with a list of all the errors that were found in the job can be generated.
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The Print Rule Checker consists of one tab.

Select the PRC Ruleset from the drop down list. You can choose a standard Ruleset, or you can
use a customized one. You can customize the PRC rules in the graphic editor.

PRC Report. Select the toggle to make sure the system generates a PRC report. Enter a name for
the report and select the place where you want the report to be stored. You can use SmartNames,
learn more on SmartNames on page 916).

Decide what the state of the task will be when the rules are violated.

• The task ends with a warning .

• The task fails .

2.7.16 Check Product Parameters

This task is documented in the chapter Products on page 876. Find a direct link here.

2.7.17 Check Technical Inks

The Check Technical Inks task checks whether the input file (Normalized PDF, Plato File or PDF
File) contains technical objects in knockout.

When technical objects are in knockout, the task will fail or end with a warning according to the
task settings.

Read more in Esko white paper Working with Technical Inks in Suite 12 assembly 3.

2.7.18 Compare PDF

Use this task to make a comparison between two PDF files. You can define what you want to compare
and how you want the comparison results to be viewed and saved.

Note:  You can use SmartNames in most fields of this dialog. For information on SmartNames, see
SmartNames on page 916.

1. In the Compare with field, browse for the reference file with which you want to compare your
PDF file.

2. Select the Compare Region or media box within which you want to make the comparison. This
allows you to restrict the comparison to the contents of one of the media boxes.

3. Set the Compare Resolution. This is the resolution you want to RIP the files to before comparing
them (TIFF files are created per separation and those are compared).

This value should be between 50 and 300 ppi

4. Set the Noise Tolerance. The Compare Resolution defines in what detail you compare the files.
This Noise Tolerance however defines how strict you want to compare. What do you consider
as a difference? If you do not want the most strict form, you can here define a different Noise
Tolerance. The distance you set here is the maximum (horizontal or vertical) distance between
isolated pixels for them to be ignored. An isolated pixel is a pixel that is different in both files but
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that has all surrounding pixels equal in both files. The higher you put the value, the more tolerant
you are against noise: the more you allow noise, the less strict the comparison will be. The default
is '0 mm', no differences allowed (most strict).
For example: The comparison shows 2 isolated pixels that are 10 mm apart and also 2 isolated
pixels that are only 2 mm apart. If you now set the Noise Tolerance to '5 mm', then the set of
isolated pixels that are 10 mm apart will be ignored in the comparison.

5. If necessary, add the separation(s) that should be ignored. For example for multilingual magazines
you may want to ignore the separation(s) that contain(s) text.

6. In the Output in field browse for the folder where you want to save the file containing the
differences between the two PDF files.

7. Select the Create Differences layer option to save the differences between the two files in a
separate layer. Then browse for a Layer file or make one automatically using SmartNames.

Note:  If page boxes are different and/or separations do not match, the task will report a mismatch
but it will not create a difference layer.

8. Select the Report differences to file option to save the differences in a separate XML report.
When files don’t match, this report contains the coordinates of the mismatched pixels for each
separation. Then browse for a report file or make one automatically using SmartNames.

2.7.19 Convert CMYK Colors

This task allows you to convert your file from one CMYK Profile to another.

Use Link Profile Link profiles describe a transformation from 1 device dependent color space to
another. This is actually a concatenation of a forward transformation of 1 profile and a backward
transformation of another profile. This means that all other options will be grayed out as the Link
Profile takes complete care of the color management.

Source CMYK Profile Select the source CMYK Profile.
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Destination CMYK Profile Select the source CMYK Profile

Render intent

• No Background: Use this option if you do not want any background simulation. The white point
of the source will be mapped on the white point of the destination process. This rendering intent
takes into account the ability of the human eye to adapt to the surrounding white.

• Perceptual: This will result in no background simulation (white of reference colorspace is mapped
on white of destination colorspace). Use this option if you don't care too much about an exact
color match but you want the pictures at least to look nice on your proofer. It will give a visually
pleasing result. If the gamut of the source is wider than the proofer, the entire gamut is shrunk so
that it fits inside the gamut of the proofer.

• Absolute (Background): Use this option if you want background simulation and you want an exact
color match, including the paper simulation.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent will
map saturated colors on saturated colors.

Use the document profile as source profile if available If a document profile is defined, then that
one will be used as a source profile. The one chosen from the Source Profile dropdown list will be
overruled. If no document profile is present while processing, the default source profile will be used.

Convert CMYK Objects. Choose what objects need to be converted.

• Images and Linework (everything)
• Images only
• Linework only

Black

• Map black on black: All colors will be converted, but the conversion will treat the black separation
separately. As a result, the black separation will only slightly change (to compensate for possible
differences in dot gain). Colors that contain only black, will remain black-only. Use this setting if
you want to convert a file from one color profile to another, but you do not want to change the
UCR/GCR level of the file.

• Keep Gray: Gray colors (colors that only have a certain percentage of black and no cyan, magenta
or yellow) will be kept unchanged. All colors that contain some cyan, magenta or yellow are
converted according to the profile. Use this setting if you want to use the UCR/GCR settings from
the destination profile, but you would like to keep black text and other gray objects untouched.

• Convert: black: All CMYK colors will be converted according to the destination profile. The output
file will have the black-generation and UCR/GCR settings from the destination profile. Because of
this, the black separation can possibly change a lot. Use this setting if you are using this task to
change the UCR/GCR level of a file. Note that black text might get converted into a rich composite
black, depending on the destination profile.

Keep Registration Color In case you use marks in your file, and if you do not want them to be
converted, then check this toggle.

Flatten document Select to flatten the entire document. Objects may be flattened that should not
have been resolved, and in some occasions new CTs are generated during resolving. However,
flattening may eliminate some unexpected results in color conversions.

2.7.20 Convert Colors with Equinox

The Convert Colors with Equinox task enables you to convert your PDF files’ colors using Equinox.



2
Automation Engine

268

Equinox is Esko's award winning extended gamut printing solution. Extended gamut printing is
using a standardized set of 5, 6 or 7 inks for printing, instead of CMYK plus different spot colors
for each job.

Equinox functionality is available in Automation Engine, ArtPro, PackEdge, the Color Engine Pilot
and as a plug-in for Adobe Photoshop.

For more information about Equinox, please see the the Equinox product page and the Equinox
documentation.

Use this task to convert jobs' colors for extended gamut printing in the following cases:

• You don't have ArtPro or PackEdge and work with regular PDF files.

With this task, you don't need to convert your file to an ArtPro file or a Normalized PDF file before
conversion, but you can get the same results as if you did.

• You do have ArtPro or PackEdge, but you want to automate the conversion.

For example, you can:

1. First experiment with Equinox conversion in ArtPro or PackEdge, and make small adjustments
to the conversion until it is exactly the way you want it.

2. Then use the resulting color strategy in the Convert Colors with Equinox task to automate
the conversion of all your job's variants, or "SKUs" (Stock Keeping Units), for example different
languages and sizes.

This task takes PDF and Normalized PDF files as input. When working with regular PDFs, it will
automatically normalize them using the Normalize ticket set in the Configure tool (see Processing
Preferences on page 674).

For more information about Normalized PDFs and automatic normalization, see PDF Normalization
in Automation Engine on page 115.

Note:

This task:

• flattens all the complex blend modes in your file, to make sure the colors are converted accurately.
• keeps your file's metadata (for example CAD information) intact.

Parameters

Tip:  You can make all of this task's parameters public if desired.

1. Select the Color Strategy you want to use for the conversion (you can use SmartNames).

This must be an Equinox Color Strategy that you have created in the Color Engine Pilot.
2. Select Hide Technical Inks if you want to keep technical inks out of the conversion.
3. Select which types of objects you want to Convert:

• Images and Linework,

• Linework only,

http://www.esko.com/en/products/overview/artpro/overview/
http://www.esko.com/en/products/overview/packedge/overview/
http://www.esko.com/en/products/overview/color-engine/overview/
http://www.esko.com/en/products/overview/equinox/overview/
http://help.esko.com/products/Equinox
http://help.esko.com/products/Equinox
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• Images only.

2.7.21 Convert IMP File to Normalized PDF

Use this task to convert your GRS impositions to Normalized PDF impositions.

This convert the GRS imposition’s template, marks and content to Normalized PDF, and adapts the
imposition around it.

Overwrite existing files

This option determines what the task will do if it finds some of the imposition’s files (mark files for
example) already converted to Normalized PDF.

• Select the option to overwrite the existing Normalized PDF files with the new ones generated by
the task.

• Leave it deselected to keep the existing Normalized PDF files.
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Note:  The remaining options are similar to those of the Export to Normalized PDF File task (see
Export to Normalized PDF File on page 329).

2.7.22 Convert Selection

You can use this task in a workflow to automate file conversion. For example, you can convert some
of the layers from an Imposition from the Pages view to a PDF format for proofing before proceeding
with the next task.

You can convert formats such as

• PDF
• Page
• Runlist
• Layer
• PageSlot
• Imposition
• Plate

into any of these output formats

• PDF
• Page
• Runlist
• Layer
• PageSlot
• Imposition
• Plate

This task is useful in a workflow when you need a certain file format to continue the flow.

You can choose the output format of the task in the Output Format field.

2.7.23 Copy or Move File

This task copies or moves the input file or marked files to a new location.

To mark a file, please insert the Mark File workflow control in your workflow. Learn more in Mark File
and Select Marked File on page 1029.

Check the box if you want the task to fail when the file to be copied or moved already exists in
the output folder.

You can also choose to not take over the Extension of the Input file in the Output file.
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Tip:  The Copy or Move File task can also be launched on folders.

2.7.24 Create CAD Sheet

The Create CAD Sheet task allows you to fully automate your Step and Repeat process based
on information from the business system (MIS, ERP). No more manual intervention is then required
to produce the plates or sheets. The Create CAD Sheet task places graphic files on the stations
defined in an MFG, DXF or CFF2 CAD file. For the graphic files, the task can use an XML file, or
one or more PDF files.

If the input file is an XML file, this XML file contains all information on what file(s) to use, the quantity,
bleed, etc. to build the Plate / Sheet.

If the input file is a PDF file, this PDF is placed on all stations. If the input is multiple PDF files, the
files will be distributed equally.

See also Distributing the one up graphics on the stations on page 275 and Positioning a one up
graphic onto a station on page 275

XML input

The task looks for a <JOB> element in the XML file.

It's also possible to combine multiple graphics in the XML file. In that case, multiple <JOB> elements
are gathered in one <JOBS> element

A <JOBS> element can contain the following sub elements:

XML Element Description
Filename (mandatory) URL of the graphics
Quantity (mandatory) Number of times the graphics in FileName needs

to be placed. Set the value to 'Maximum' to fill
the CAD file with as many graphics as possible.

DieShape Ink name of the die line of the graphics.
Bleed Setting the bleed mask in mm to be applied

starting from the die line.
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XML Element Description
Page@number When no page number is defined, the first

page of a multipage PDF is used. Set the page
number if you want to use a different page.

Ticket settings

General

The Output Format can be PDFPLA, Normalized PDF or PDF.

The Screen Registration parameter allows to choose if the RIP should reset the screening origin for
every one-up or keep the same screening origin for the complete document

Use the Backing Up when working with a back and front. You can choose to Turn (rotate over a
vertical axis) or Tumble (rotate over a horizontal axis)

Note:  In order to make a CAD sheet with a Front and a Back, multi page PDF files are needed, the
first page to be placed on the front, the second on the back.

Add SmartMarks by selecting a SmartMark set from the drop down list. You can also use
SmartNames.

Check the 'Load Mark Set in bottom layer' box if you want to make sure the marks are positioned
in the bottom layer, to make them appear 'behind' the graphics.

Use Pull back Marks to keep marks away from the graphics. You create a marks free zone starting
from the die line over the given distance. This is only available if Load Mark Set in bottom layer is
enabled.

The Limit Bleed toggle: the bleed can be limited to a specific distance. The bleed mask is created
by spreading the die shape.
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CAD

Both Mapping and CAD Style are options you can define in the Editors.

Mapping allows you to select a set of Mapping rules. Mapping rules allow to map DXF layer names,
DXF line styles and DXF color numbers onto line types (ArtiosCAD style). Use the mapping rules to
indicate which DXF elements will be imported as cut, crease or bleed lines. The mapping rules are
scanned from top to bottom, as soon as a DXF element matches a rule, the action corresponding
with this rule (ignore or import as cut, crease, bleed) will become effective.

A CAD Style changes the appearance of the imported CAD lines.

By default, the filling order as defined in the CAD file is used. However, by setting Set custom filling
order, you can specify a custom filling order.

The filling order is defined by selecting a start position, direction and filling order. For each of those,
you can also use a SmartName.

The sequence of the designs is determined by taking the center points of the designs and sorting
these in rows and columns. Keep in mind that designs with different sizes or layouts with staggered
designs can result in more rows or columns than expected.
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Plate

The sheet size can be automatically extracted from the CAD template but neither Artios MFG nor
CFF2 have a notion of plate. As a result the plate size and position of the sheet on the plate have
to be specified in the Plate tab.

Plate Size: enter -if necessary- the plate's horizontal and vertical dimensions.

Position the sheet on the plate by dragging and dropping the blue square (the sheet) to the right
position on the grey square (the plate).

Define horizontal and vertical Sheet Offset

Tip:  All edit fields are SmartName-enabled. Make sure the SmartName returns a value according to
the field, for example a SmartName in the Plate Size field should return a number

Sheet
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If you want to use a custom sheet size instead of the sheet size defined in the CAD file, enable Set
custom sheet size and enter the dimensions for the sheet.

You can also specify a custom Blank Position instead of using the position defined in the CAD file
by enabling Set custom position. Using the Blank position, you can position the bounding box of
all cut lines on the sheet.

Position the Blank on the sheet by dragging and dropping the blue square (the sheet) to the right
position on the grey square (the sheet).

Define horizontal and vertical Blank Offset

Positioning a one up graphic onto a station

To decide how to position a PDF onto the CAD file, the task will try the following options (in order):

1. Check if the input PDF contains a die cut object, i.e. a linked ARD file. If the name of this ARD file
matches the name of the design in the MFG file, the graphics will be placed

Note:  This option is only available for Normalized PDF files.

2. Position the trim box of the PDF on the bounding box of the cut and crease lines. If the trim box
and bounding box match, the graphic can be placed.

3. Position the die line of the PDF defined in the XML file, on the bounding box of the cut and crease
lines. If it matches, the graphic can be placed

Note:  This option is only available for XML input.

If the PDF trim box or die line bounding box does not match any of the bounding boxes of the design
in the CAD file, then the file will not be processed and an error will be given.

Distributing the one up graphics on the stations

Distributing the one up graphics on the stations defines what PDF goes on what position in the CAD
file.

If the input file of the task is XML, the task will look for an element Quantity, defining the amount of
stations to be filled with the specified graphic, for example <Quantity>10</quantity>.

Note:  If the total number of quantities doesn't match the number of stations, the task will stop with
an error.

When using the element <quantity>Maximum</quantity>, the task will place the referred PDF
file as many times as possible.

If more than one PDF file has the quantity element set to Maximum, the task will equally distribute
the referred PDF files. You can also make a combination of files with a fixed quantity, and one or
more files set to Maximum.

If the input for the task is PDF, the task will consider all PDFs to be set to "Maximum" quantity, so
the provided input files will be distributed evenly onto the provided CAD file.

If the number of available stations cannot be divided by the number of input files (for example 9
stations and 2 PDF files), the task will automatically distribute the remaining stations.
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Note:  When the CAD file contains different designs (for example different type of boxes), the graphics
will only be distributed on the corresponding (fitting) designs (see Positioning a one up graphic onto
a station on page 275)

Bleed and overlap

When the one up contains bleed, this bleed will be used around the diecut, limited by the Limit
Bleed value.

Note:  Everything outside the dieline is considered to be bleed. Bleed zones without content will
knockout when overlapping. Overlaps can only work well if a correct bleed limit is applied.

If the bleed of two stations would overlap, you can have the following situations:

• There is a gap between the panels of the two stations. In this case, centerline overlapping is
applied, so the bleeds from both neighboring stations touch on the center-line of the gap.

• The station panels are touching:

• the biggest panel will overlap the smaller panel (situation A in the example below)
• if the panels are the same size, center-line overlapping will apply (example B in the example

below)
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Note:  When deciding if a station is touching another station, minor tolerances are taken into account
to cope with small inaccuracies in the diecut file.

2.7.25 Create Design (DesignWizard)

Note:  This Task requires a PackEdge editor

This task is intended for the automatic generation of template-based designs with different content.
The template is made in PackEdge.

The objects that vary between the different versions are generated by SmartMarks.

DesignWizard will simply regenerate the SmartMarks using different data sets. These data sets can
come as field in a database (accessible from the Automation Engine server through ODBC) OR as
fields in XML files.

Tip:  SmartName support for path to XML file makes it possible to create more generic tickets.
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These labels vary in color, text and bar code. External references an also vary (images, logos). The
task gets the correct input from an XML file:
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Using SmartNames in a DesignWizard template

DesignWizard assumes the texts are available as either:

• fields in a database (accessible for the Automation Engine server through ODBC)
• fields in XML file(s)

In the case of a live connection to a database, you need to define a set of SmartNames through the
Automation Engine Configure panel.

In the case of XML files, the XML file is expected to have a similar format as when saving a database
query into an XML file. This means the data can either be split over 1 file per instance (i.e. each XML
file contains all the data for 1 flavor) or there can be multiple sets in 1 XML file.

Taking such an XML file, you can easily convert all the tags from this XML file into job parameters.
This is done via the  Load button in the Parameters tab of the Job Setup dialog:

Once this is done, all these job parameters are also available as SmartNames (inside this job).

As a result, building the templates is in this case similar to using global SmartNames (defined in the
Automation Engine Configure panel).

2.7.26 Create IMP File

The Create Imposition ticket makes it possible to create an imposition file simply by selecting an
imposition template.

The pages selected in the Files View will be automatically assigned to the template.

In the Pages View, the input will be a book to which you attach an imposition template.
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Settings

• Select an Imposition Template you previously created in FastImpose. The pages will
automatically be assigned to that template.

An imposition file can also be used as a template. The pages assigned to that imposition will then
be overwritten.

• Paper: you can either use the width / height from the template you selected, or specify an adapted
paper size.

• Trim: you can either use the width / height from the pages, from the template, or specify an
adapted trim size.

• Fill remaining pages with blanks: In case not enough pages have been selected to fill all pages
of the template, the empty pages at the end will be filled with blank pages if this option has been
selected. The task will not shrink the template.

• Extend Automatically: select this option to automatically generate extra sheets in the template
if it doesn’t have enough sheets for your imposition.
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Note:

To do this, your template must have at least one master sheet, and no more than one exception
sheet.

The task will generate the number of extra master sheets needed, and use the template’s
exception sheet if it fits the last sheet of your imposition better.

Possible Workflows

What follows is an overview of all possible situations that can occur when creating impositions.

Note:  You can start by selecting either a number of files, or an entire folder. In both cases, situations
1 to 3 can occur. As far as the incremental workflow is concerned (see below), only situation 1 can
occur when selecting a folder.

Possible situations (and their message in the log window):

1. If the number of pages selected equals the number of pages in the selected template, the task
will be processed correctly.

2. If fewer pages are selected than there are pages in the template, we call that a page 'underflow'.

• The task will end with a warning.

Log message: Page x in page list remains empty.Page underflow in AutoImpose: the template
contains x pages, x pages remain empty.

• The task will be processed correctly if the Fill remaining pages with blanks toggle is selected.

Log message: Page x in page list is made blank.Page underflow in AutoImpose: the template
contains x pages, x blanks are added.

3. If more pages are selected than there are pages in the template, we call that a page 'overflow'.
Since the excess pages are not clipped, the task will end with an warning.

Log message: Page overflow in AutoImpose: x excess pages, the template contains only x pages.

You can also opt to assign your pages in different steps. Do not forget to check the 'Fill page list
incrementally' toggle.

1. Select for example pages 1 & 4. The pages will be assigned to pages 1 & 4 of the template (and
not to 1 & 2).

• The task will end with a warning if the 'Fill remaining pages with blanks' toggle has not been
selected.

Log message: Page underflow in AutoImpose: the template contains 4 pages, 2 pages remain
empty. Page 2 in pagelist remains empty. Page 3 in pagelist remains empty.

• The task will be processed correctly if the 'Fill remaining pages with blanks' toggle has been
selected.

Log message: Page underflow in AutoImpose: the template contains 4 pages, 2 blanks are
added. Page 2 in the pagelist is made blank. Page 3 in the pagelist is made blank.

2. Suppose you want to overwrite page 1 of an imposition called 1234. Select page 1 again in Pilot
and launch with the 1234.imp file as template.
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Log message: Adding file x to the page list. Page number 1 not free in template, overwritten by
page (path), placed on page 1.

2.7.27 Create Imposition from JDF Layout

You can import a complete imposition including layout and page assignments into the Pages and
Plates view using this task. This creates an IMP file from a JDF Layout file.

• Imposition Name: Here you can assign a name to the Imposition which will be visible in the
Imposition Gallery.

• Page Root Path: You can specify the path to the pages referred in the JDF layout here.

• Mark Root Path: This path will be used as root to look for the marks reffered from the JDF Layout
File.

• Apply Color Mappings: Enable this option when you want to use the same ink mapping scheme
which is defined in the JDF file.  This mapping can be viewed in Plates View.

Note:

• This option works only when the input JDF file contains a color mapping.
• The mapped inks will be visible in the Plates View after applying color mapping . However, the

inks in the referenced input PDF files will remain the same as before.

• When you enable Apply Color Mapping in the Export Imposition to PDF file ticket, the color
mapping from the Plates View will be exported to the output PDF file.
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2.7.28 Create Imposition from RunList

You can use this ticket in a workflow to create an Imposition from a RunList. This creates an IMP
file from a RunList file.

Settings

• Imposition Name: You can use this name to identify the Imposition in the Imposition Gallery

• Template: You can browse to your JDF layout file here.

Note:  You can use SmartNames like nPages, pageHeight and pageWidth to make the
selection of the Layout Template dependent on the RunList.

• Mark Root Path: You have to enter the path to the file with marks referred from the JDF layout.
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• Fill remaining pages with blanks:You can enable this if you want to add blank pages when the
layout contains more pages than the RunList.

• Remove RunList: You can enable this if you want to remove the RunList after it is included in
the Imposition.

• Extend Automatically: Enable this to expand the number of sheets in the template to
accommodate for all pages in the runlist.

• Assembly: Choose from : Saddle Stitch, Perfect Bound, Cut & Stack  and Automatic. You
can use SmartNames to select an Assembly provided your SmartNames are prepared using
the localized assembly name.

Attention:

• All sheets in the template should contain equal number of pages.
• If Assembly is set to Automatic , the template should contain a minimum of 2

sheets to establish the numbering scheme. Numbering should be consistent across
the template when there are more sheets than 2.

• If the imposition contains printgroups of multiple sheets, the renumbering will be at
the printgroup level as that is the logical foldable unit.

• If the runlist has layers, individual layers will be handled independantly while
renumbering. Similiarly, independant flats will be added.

• Optimize Sheet: When Extend Automatically  is enabled, you can select and optimize sheets.
When this option is set, the task removes the back side of the selected sheet and uses the
front side for printing (Work & Turn or Work & Tumble printing depending on your template
numbering).

• Select from : First Sheet, Second Sheet, One but last Sheet and Last Sheet.

Note:  The works only when the assembly is Perfect Bound or Saddle stitched.

Note:  Use Optimize Sheetonly when the sheets are filled up to 50 percent or less.

You can view the results of this task in the Imposition Gallery.
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2.7.29 Create Job task

This task is documented in the chapter Integrating with External Systems on page 1228. Find a
direct link here.

2.7.30 Create or Modify WebCenter Project

This task is documented in the chapter Integrating with WebCenter on page 1346. Find a direct
link here.

2.7.31 Create PAF / JPG / XML (LinkEdge)

LinkEdge started as an interactive tool to link 2 sites both using PackEdge. This tool packed the Esko
native data (with all its references) and allowed to unpack it again at the receiving site. However, this
is more than just 'Esko-Zip'. The (un)Packing also communicates with the Esko editing kernel and
resource folders like central or local font folders. Automation Engine then started a background server
version of this historical tool. It was logic to also add extra file representation data like thumbnails
and metadata (XMP-XML).

Pack/UnPack

Select Create Packed File to create a PAF file (a packed file) from a Normalized PDF or Plato PLA
file (and legacy file formats GRS and GRQ).
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Set the Pack/Unpack Options:

Select an action:

• Pack File, this creates a .PAF or a .PDFSC file
• Unpack File

• You can include the Fonts

• Tick the Unpack in Local Directory toggle if you want to be sure that all elements of your packed
file will be unpacked in the same directory. Be it the default directory or the one you defined as
output directory. If you deselect this option, LinkEdge will try to restore the original file structure.

Suppose you have packed a Normalized PDF (D:/Jobs/2345 banana/2345_50ml.pdfsc) and it has
one referenced image (residing in a different folder: D:/Jobs/2345 banana/images/banana.eps ).
If you were to unpack using the Unpack in Local Directory option, the LinkEdge task would drop
all files in the same directory. If you were to Unpack without the option, then the LinkEdge task
would put the CT in a CT folder.

• Use the Password toggle to protect the Packed file. You will be prompted to enter the password
when you want to unpack.

XML

The system is also able to generate an XML Report, which contains information about the file: CTs,
inks, angles, LPI, ...

XML Structure: choose between standard XMP and the old BackStage 1.2 version (also based on
XMP, but contains less information), and define the units.
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Note:  Detailed information on Esko XMP tags can be found on the technology pages on
www.esko.com.

JPEG

Tick the Extract JPEG Preview toggle if you want a preview file. This is useful for archive systems
that work with thumbnails.

Set the various Image settings:

• Horizontal and Vertical resolution in dpi
• Set the width and height in pixels
• Choose a compression from the dropdown list
• Select the anti aliasing toggle (use the dropdown list to define the quality of the anti aliasing)
• Decide if you want the JPEG to contain data from outside your borders. Check 'Account for

margins' to select the margins of the job as the true boundary. Normally the borders of the job
are taken as the true boundary of the job. Sometimes however you may also want to convert
everything that is situated within the margins too.

• Check the option 'Use varnish inks in output' if you want the inks which have the attribute 'varnish'
in the input file to be included in the JPEG file.

• Page range: choose between 'All pages' or enter a page number / range.
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Note:  Detailed information on Esko XMP tags can be found on the technology pages on
www.esko.com.

2.7.32 Create PDF File from JDF RunList

This task uses JDF RunLists to combine individual PDF (one-up) files into one multipage PDF file.
You send the JDF RunList to the task, and define where to find the individual PDFs.

You can create JDF RunLists using the Split Pages on page 475 task, or The RunList Editor on
page 786.

The RunList contains the file names of the files to be joined, their joining order and their original
location.

One Up Location: Define the location of the one-up PDFs. Choose one of the following options:

• Select Defined in JDF if you want to use the location defined in the JDF RunList,

• Select Custom Location if you want to specify the one-ups' location yourself.

Note:  When you choose Custom Location, fill in the location of the Custom Folder. You can
browse to it, enter a path or/and use SmartNames.

Replace * in File Names By: If you created your RunList manually using the RunList Editor, you may
have wildcards (*) in the file names of the PDFs to be joined. For example, the file names in your
RunList may look like this: *_01.pdf, *_02.pdf, etc.

By filling in the option Replace * in File Names By, you can define the part of the file name that
the * matches.
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Note:

The output PDF will not be normalized if:

• at least one input file is not normalized,
• at least two input files have different media or trim boxes.

The XMP information of the individual PDFs will be merged into the multipage PDF.

2.7.33 Create PDF File from RunList

The Create PDF File from RunList task can be used to create a multipage PDF file containing (a
selection of) the pages of a RunList. This is typically done for content proofing purposes.

You have the following options in this task:

• Number of Pages per File: This defines the maximum number of pages after which a new output
file will be created. This number is a maximum. When multiple layers are selected, each layer will
start with a new file.

• Apply Color Mapping: This will add and/or remove inks to/from the RunList pages to ensure that
your proof will look the same as your sheet output.

Note:  This option will typically be used in combination with the Apply Color Mapping option in
the Export Imposition to PDF File or the Export Imposition to JDF Layout tasks.

• If your RunList contains marks on page level (like trim marks, page numbers, etc), you can include
these marks by selecting the Include page marks option.

• Add to proofs view: You can optionally add your proof to the Proofs view after it's created. This
will allow you to keep an overview of your proofs and ensure that the content of your proofs is
consistent with the content of the pages in your Imposition.

Note:

In case an imposition was defined for the RunList, the trim box from the PageSlots in the imposition
will be used. If no imposition was defined, the trim box of the RunList will be used instead.

In case a media box was defined for the RunList, this media box will be used. In all other cases, the
media box from the included pages will be used.
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Input and output formats

Possible inputs for this task can be one of the following:

• An IMP file
• An imposition
• A RunList
• A PageSlot
• A layer
• A plate

The output for this task will be a PDF file.

2.7.34 Create Report (ReportMaker)

Note:  This Task requires a PackEdge license.

The ReportMaker task is used to automate the creation of design print cards (in French: fiche
technique, in German: Drueck Karten).

The idea is that you generate reports containing all kinds of information: job name, used inks, name
of the operator, an image of the job...

All this information is defined in a report template, then this template is used to generate a specific
job. For more information about templates, see ReportMaker Templates on page 291.

Settings

Select a Report Template (you can browse to it or use SmartNames to define the path).

If you want your report to be a regular PDF instead of a Normalized PDF, select Export to PDF, and
choose a Ticket for the PDF export. For example, use this to make a report containing a 3D object
(see Creating a Report Containing a 3D Object on page 297).

Example

This is an example of how a report may look when viewing it in Acrobat. The format anc content is
decided by the Report Template, also the amount of pages.
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ReportMaker Templates

You need PackEdge 3.0 or higher to make a ReportMaker template.

The ReportMaker Template - how the resulting print card will look - is a Normalized PDF which you
can design yourself.

You are placing an image of your input file before you even know what your input file will be (since
it's a template and should be generic), but PackEdge offers a solution.

Let's make a template that will give us this result:
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1. The name of the Job
2. The date/time of the report
3. The operator who made the report
4. An image of the job (possibly scaled to fit the report)

The name of the job, the date and time, the operator are all Text Marks that are placed in the file and
they are resolved when the ReportMaker task is executed.

In fact, you can place as many SmartMarks as you see fit.

Note:

SmartMarks used in a ReportMaker template can give you useful information:

• If you use ink-related SmartMarks, they will reflect the inks of the input job, not of the generated
report.

• Ink coverage will give you the ink coverage of the unscaled version of the input job (the report
may contain a scaled version of the input job).
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The image of the input file is a special kind of ImageMark.

1. Select a new Image Mark
2. Use Smart Text [taskinputfile] to define the name of your Image Mark.

taskinputfile is the one smart text that's able to define the Image Mark in such a way that it will
place the input file in the Report at the time of outputting.

3. The Linework Editor will place the Image Mark, it will look like a square because at that time the
editor has no idea how big the input file will be.
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4. You can use Named Objects to further define the behavior of the Image Mark during output. You
can make any object a placeholder, in this example we'll make the white contour a placeholder

Select the object you want to make a contour, select 'Placeholders...' from the Production Menu,
add a new one and give it a name (in this example: Job Window).
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5. Now you can define the Image Mark according to the Placeholder. Choose On Placeholder from
the Position dropdown list. Choose the correct placeholder from the Placeholder dropdown list.

You'll see that the editor places the Image Mark in the Placeholder.

6. Bear in mind that the task inputfile Image Mark has the same functionality of any other SmartMark,
it behaves the same, it can defined in the same way, it can be scaled, the inks can be defined...

Viewports in ReportMaker

A ReportMaker report can show you several ‘viewports’ of a file. This is ideal to zoom in on smaller
objects (ingredient copy, small logos, bar codes...). It also proves to be very useful if the design
contains only few graphic objects, as could be the case for example on corrugated boxes.
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When creating ReportMaker templates in PackEdge, you can specify a named object to attach the
task input file to. This task input file will make sure that the file will be pasted in the named object,
which will act as a ‘window’.

1. Select an object or draw a box and give it a name.
2. Select the named object and open the SmartMarks dialog box. Make sure that you add the new

mark to the named object.
3. Select the SmartMark type ‘Image Mark’ which allows to indicate that you want to place only a

detail of the [taskinputfile] (under ‘reportmaker’).

You can zoom in by taking the bounding box of the named object and applying the specified scale
factor on this bounding box. For example 'Scale to Fit' will calculate the scale factor without taking
into account the size of the input file but the size of the named object in the input file.

If the named object is a contour object, the contour object will be used as a clip mask on the input
file. If the named object is a different object (CT, group of objects…) a rectangular clip mask (with
size equal to the bounding box of the named object) will be applied.
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Creating a Report Containing a 3D Object

To create a report containing a 3D object, you need:

• a report template with image marks allowing 3D objects,
• a Normalized PDF file with a link to a CAD (.ard, .dae or .zae) file.

1. In PackEdge:

a) create a template,
b) add an image mark where you want your 3D object to be,
c) use the SmartNames button to use Smart Text for your image mark name,
d) in the Smart Text pop-up, choose ReportMaker then task inputfile in 3D,
e) save your template.
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2. In Automation Engine:

a) launch the Create Report (ReportMaker) task on your Normalized PDF with a linked CAD file,
b) in Report Template, browse to the 3D-enabled report you created in PackEdge,
c) select Export to PDF,
d) choose a Ticket for the PDF export.
e) click Launch.

You will get a report containing a 3D object corresponding to your CAD file.

You can open this report and view the 3D object on all computers running Adobe Reader 8.0.1 or later.

2.7.35 Create RunList

With the Create RunList task, you can create a new RunList from one or more uploaded file(s).

When you use this task in a job context, the created RunList will be added to the imposition gallery
in the pages view for this job.

When this task is used in a workflow context, the created Runlist can be used as long as the workflow
is running. After the workflow has completed, the created RunList will be removed.
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Note:

By default, the source files are not visible in the task window. To see these files, click  View > Show
Files > .

If you want to add more source files, click:  File > Select File .

1. Specify the Runlist Name. This name will be visible in the Pages view of the job when the task
successfully finishes. If no name is specified, the name of the first source file will be used for this.

Caution:  If a RunList with this name already exists for this job, it will be overwritten.

2. Specify the Number of Pages in your RunList.

If you want to specify the number of pages by specifying the number of pages in the folio ranges
(see below) , then leave this field blank.

3. If you want to use certain folios for the pages in your RunList, you can build these by clicking
on the Folio Names button.
The Folio Names dialog will prompt.
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4. You can add a new folio range as follows:

a) Click on the default Folio Range and click Remove.
b) Click on the Add button to add a new Folio Range.

The Folio Name dialog will prompt.
c) Choose the desired Number Format for your folio.
d) Choose the Number of Pages the folio will run.
e) Choose the number of the first folio in the field Start at.
f) Determine the Prefix and Suffix of the Folio.
g) Click Add to add the new folio to the Folio Names dialog list.

5. If all desired Folio ranges have been added, click OK.

6. Specify the vertical and horizontal Finished Page Size (the trim size) of you RunList.

7. You can choose to (de)select one or more of the following checkboxes:

• Unfinished Page Size: This option allows you to set the unfinished page size to be used by
proofing and impositioning later on in your workflow.

• Bleed Box: This option allows you to set the page bleed box  to be used by proofing and
impositioning later on in your workflow.

• Art Box: This option allows you to set the art box to be used for page positioning later on
in your workflow.

For each of these options, you can click on Options... to select the offset values.

8. If you're using single sided printing, deselect the Mirror Page Boxes checkbox.

9. You can  specify  the  Layer Names if  you want to  create your  RunList in multiple layers. For
example, to handle language variants with plate reuse.

For each comma-separated name, a new layer will be added to the RunList.

2.7.36 Create RunList from PDF

Using this task, you can create a RunList from one or more selected PDF files. A RunList collects
the pages from one or more PDF files sequentially to make one final JDF RunList (for example for
an imposition). It contains the names of the files to be collected or joined, their collecting / joining
order and their original location.

Note:

The source file(s) can be both normalized and non-normalized PDFs.
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Using the Create RunList from PDF task will copy each page into the RunList. However, if you want
to add Folio Names to the pages, change the Finished Page Size or change the Page Boxes, use
the Create RunList task instead.

Note:

By default, the source files are not visible in the task window. To see these files, click  View > Show
Files > .

If you want to add more source files, click:  File > Select File .

1. Give a suitable name in the RunList Name field. You can use SmartNames for this. If this task is
completed, the result can be seen in the Pages view when working in a job context.

2. If you have language variants, enable Plate reuse between runs. This enables the reuse of the
image plates among the language variants. This option will consider each input file as a separate
variant, if the number of pages in these files are equal.
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You should use this in combination with the Variant Separation settings in Job Setup.

This will produce a RunList (with multiple layers, if plate reuse has been enabled). Plates will be
reused for common images in these language variants.

When you create an Imposition from a multilayer RunList, the system will take this into account
when creating the plates in the Plates view.

2.7.37 Create Sheet Report from IMP File

Use this task to output your imposition report as a PDF.

Note:  The report is created in FastImpose, when you make the imposition (you choose a report
template).

Report Units: You can choose to show the imposition’s dimensions in either millimeters or inches
in the report.

Decimal Places: Choose how many decimal places you want in the dimensions.

The report below uses millimeters and 3 decimal places.
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2.7.38 Create Tiles

For detailed information about the Create Tiles task, please see Create Tiles on page 1104 in the
Gang Run Printing chapter.

2.7.39 Create Wrapper File

The Create Wrapper File task creates a Normalized PDF that encapsulate a given image, for example
a screened TIFF copydot file. The Normalized PDF encapsulating the image can then be processed
further via tasks that can handle Normalized PDF data such as FlexRip tasks.
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You can bind a set of stand-alone files containing bitmap or copydot data that contains ink
separations of one image using the the Separations  tab. The output file will be a normalized PDF
document.
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The Create Wrapper File task supports the following file types:

• TIFF
• TIFF_IT
• PSD
• JPG
• BG_CT
• BG_LP
• BG_JS
• EPS
• DCS
• Copydot

Page Size tab
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Page size

The default page size is Job size. When Job size is selected, the page size found in the selected
file will be taken into account when importing. The Custom option allows you to enter page size
values manually. The dropdown list displays all possible options (for example Custom, A5, A3, Letter,
Tabloid, Scanner Trim Size...). Click the arrow in the dropdown list to switch between millimeters
and inches.

Note:

All the Eskoscan scanners have a feature to indicate the trim size of the page when making a scan.
Scanners equipped with software release JPS9.0 build 99 or higher will write that information into
the master DCS file.

When choosing the option 'Scanner Trim Size' in the 'Job Size' list, the borders of the resulting
file will be automatically positioned where intended. The placement of that Normalized PDF file in
FastImpose or Plato will not require any manual correction.

Offset: Enter the appropriate values to give the page a horizontal and/or vertical offset. When no
offset is given, the center of the image will be positioned on the center of the page. If the page
is smaller than the image (width, height, or both), then margins will be set that enclose the image
completely.The size of the margins will not be fixed. Margins indicate the differences between the
image size and the user-defined page size.

Margins: Tick the margins toggle and define the margins' dimensions if you want to give the margins
of the page a fixed size (for example 3 mm for bleed). Click the arrow in the dropdown list to switch
between millimeters and inches.

Reader's Spread None of the file formats that can be wrapped into a Normalized PDF file have
the notion of reader's spread. It can be useful, for example when using the Normalized PDF files in
FastImpose, to give an indication of whether the file is a single page or a reader's spread.

• Single Page forces the file as single page output.

• Reader's Spread forces the file into a reader's spread format. The file will be set as double pages.

• Auto checks the size of the image and when the image width equals or exceeds two times the
selected page width, the reader's spread option is set. Otherwise it is treated as a single page.

Page number: Select the correct page number from the Normalized PDF that you want to output.
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Display images: This option allows you to change the Normalized PDF preview settings. Select
None, Thumbnail or Image from the dropdown list.

Inks tab

The Inks tab contains a fixed list of inks (default, cyan, magenta, yellow, and black) to which you
can add other inks manually.

Tip:

Choose the ink book you use most frequently in the Preferred Ink Book list. Doing so ensures that
when you type an ink name in the table, Automation Engine searches for the ink in your preferred ink
book first. For example, if you type the ink name "154" and your preferred ink book is set to Pantone
Colors Uncoated, Automation Engine will automatically suggest the ink PANTONE 154 Uncoated.

If an image contains definitions for its inks (for example a CMYK Tiff or a PhotoShop DCS2) and an
ink of the image matches an ink selected in the inks tab, then the angles, screen ruling, etc... in the
Normalized PDF file will be the ones from the inks tab. All inks in the image that do not match the
selected ink in the inks tab will be processed according to the values for angle, screen ruling and
dotshape in the Default options.

For images that contain no ink definition:

• If only one ink is selected in the inks tab, the Normalized PDF file generated will contain that
specific ink with angles, lpi and dotshape as specified in the inks tab.

• If multiple inks are selected and K is part of that selection, the Normalized PDF file generated will
contain K with angles, lpi and dotshape as defined in the inks tab.

• If multiple inks are selected and K is not part of that selection, then the Normalized PDF file
generated will contain the first ink from the list with angles, lpi and dotshape as defined in the
inks tab.

• If no ink, or the wrong ink (which cannot be found in the Pantone or Designer book) is selected,
then a Normalized PDF file will be generated which contains K with default parameters.

• If the wrong ink is selected, together with the default ink, then a Normalized PDF file will be
generated with parameters from the default ink.
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Overprint: Select the appropriate overprint from the dropdown list. Choose between Opaque and
Darken.

2.7.40 Create XML File

This task is documented in the chapter Integrating with External Systems. Find a direct link here.

2.7.41 Data Collector

This Workflow Control is documented in the chapter "Workflows". See Data Collector on page 1029.

2.7.42 Data Splitter

This Workflow Control is documented in the chapter "Workflows". See Data Splitter on page 1030.

2.7.43 Delete File

This task is mostly used at the end of a workflow ticket, where the original input may be deleted
since the workflow has created other data that are more worth keeping..

Tip:  This task can also be combined with the Wait task. For example: first wait 2 hours, then delete
the marked file.

Tip:  To delete marked files, you can perform the following actions: Mark File + any other action +
Select Marked File  + Delete File.

2.7.44 Download WebCenter Document

This task is documented in the chapter Integrating with WebCenter. Find a direct link here.

2.7.45 Enrich Black

This task automatically creates rich black (super-black) objects. A darker, deeper color is obtained
by adding a layer of overprinting objects covering all the pure black areas in a color of your choice.
The task can also be used to enrich other inks than process black.

In the example below 80% Cyan is added (as separate layer of overprinting objects) to all areas
containing pure black, resulting in an enriched black:
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Two tabs:

• General
• Scan (identical to the Scan tab in the Trap - Prepare and Create Trap layer task).

General Tab

Add Inks

A color containing up to four inks can be added to all colors containing an ink of your choice.
Typically 80%C or a more neutral combination of CMY such as 60%C 40%M 40%Y are used for
rich black generation. Alternatively PANTONE ink names may be entered in these input fields. When
the percentage next to an ink name is set to 0%, the ink will not be used.

Choke Distance

Defines the distance between the edge of the area in the defined color and the edge of the original
(black) object. If this distance is not zero, the generated area in the defined color will be smaller than
the original (black) area to prevent registration errors on the press.

Corners

This option allows you to change the way sharp corners in the trap areas will be handled.
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• Mitered:  If the distance from the base of the trap to the corner point is larger than the miter
ratio multiplied by the trap distance then the corner will be beveled, otherwise it will remain sharp.
See also miter ratio option. (default)

• Round:  A round cap will be placed at all corners.

• Beveled: 

Miter Ratio

Determines when a sharp corner is beveled. If the Distance from the base of the trap to the corner
point is larger than the miter ratio multiplied by the trap distance then the corner will be beveled,
otherwise it will remain sharp. This option is only available when mitered corners are selected (default
value 2).

To Ink

Specifies the ink to which the selected color will be added. This ink is typically Process Black.
An alternative process or PANTONE ink name may be entered in this input field, to enrich colors
containing that specific ink.

Minimal Density

Specifies the minimum percentage of 'To Ink' needed in an area before the specified color will be
added to that area. The default percentage is 100%, which means that the selected color will be
added to areas containing 100% of the 'To Ink'.

2.7.46 Expand Dynamic VDP data

The Expand Dynamic VDP Data task creates PDF/VT files from a database containing variable data,
using a VDP template (VDT file).

This task requires the following:

• a CSV database as input, and
• a VDT template as mandatory parameter.

Task Settings
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Database File:

• Database File Encoding: Specify the character encoding here. Select the correct encoding to
ensure accurate interpretation of database entries.

Note:  The default encoding is UTF-8. This is also the recommended encoding.

• Field Separator: specify the separator or let the task identify automatically via Detect
Automatically. The following separators can be used:

• , (Comma)

• ; (Semicolon)

• Space

• Tab

• Field Names: Field names map data chunks from the database entry to its corresponding VDP
template items. You can choose from:

• From CSV file: If this is selected, the task will extract Field Names from the first record of
CSV file by default.

Attention:  The Field Names can only contain the following characters:

• lower-case ASCII letters ("a-z")
• upper-case ASCII letters ("A-Z")
• digits ("0-9")
• underscore ("_")

• From Header file: When selected, provide a Header File containing Field Names.

• Header File: You can browse to the CSV Header File or use a SmartName to access the file.
The Header File:
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• should contain a single line specifying the Field Names.

• should have Field Names corresponding to each column present in the CSV file.

• and the CSV file must use the same delimiter and encoding.

Dynamic VDP:

• Template: Here, browse to the VDP Template file containing artwork and the placeholders
necessary to generate the task output.

Note:  The VDP template can be created and exported using Dynamic VDP DeskPack Plug-in
for Adobe Illustrator.

• Image Path: If the database file has image references, provide the Image path.

2.7.47 Export ArtPro to Normalized PDF File

The Export ArtPro to Normalized PDF File can generate a Normalized PDF file based on an ArtPro file.

Preferred Ink Book Select the ink book to look in first when processing inks that are not in the
predefined ink books, or for inks that may be in several ink books.

For each ink in the ArtPro file, the task will:
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• first look in the predefined ink books (such as the process and PANTONE ink books),
• then in the Preferred Ink Book you define here,

• if it still doesn't find the ink, it will check other ink books you created,

• if the ink is not present anywhere in the color database, it will be saved as an unregistered ink.

Search for missing images in: If the ArtPro file references some images that the task can't access,
you can copy those images to a folder on one of your Automation Engine containers, and browse
to that folder here.

Embed all images Embeds all images referenced in the ArtPro document into the PDF file.

Add non-printable layers

If switched on, layers set to non printing are exported into the PDF file. With this option off, these
layers are not output, so the PDF file contains only layers with the Print option on.

Add fully transparent objects

If this option is off, objects that are completely transparent will not be included in the PDF file. If it
is on, they are included.

Folder Mapping:

When the ArtPro file contains links to images that reside on a Mac OS-based file server, you can
mount the drive of the Mac OS server on the Automation Engine server and use this Folder Mapping
table to keep the references to the images working in the Normalized PDF.

To map folders from the ArtPro file to the Normalized PDF file:

1. Click Add.
2. In the Client column, type the drive name on the Mac OS system.
3. In the Server column, type the drive letter that is used to mount the Mac OS drive on the

Automation Engine server.

For example, in our ArtPro file, the path to an externally linked image is:
Intel_Mac:images:image1.

We mount the Intel_Mac drive of the Mac OS file server on our Windows-based Automation Engine
system, using the G:\ drive letter.

To allow Automation Engine to automatically locate the images on the Mac OS file server when
exporting the ArtPro file, we use the Folder Mapping feature to map Intel_Mac to G:\.

2.7.48 Export IMP File to GRI File

In the unlikely event that some editing is required, the Export Imposition to GRI File task can generate
a .gri file that can be opened in PackEdge.

Sheets
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Print Mode

• Select the Press Sheet button to create a .gri file and select the appropriate radio button in the
Output Area field to specify the output format.

• Select One Up to create output of a user-definable size, containing one page per output page.

• Select Spread to create output of a user-definable size, containing a printer's spread per output
page.

Front/Back

This is only available when Press Sheet is selected. Select the appropriate option to indicate which
side of the sheets you want to expose: Front, Back, Both or Both, but reversed.

Output Files

You can choose how many output files to generate.

When Press Sheet is selected, you can generate:

• One (output file) per Press Sheet Side,

• One per Press Sheet,

• All Press Sheets in one file.

You can also choose to Reverse Sheet order to generate the sheets in reverse order.

When either One Up or Spread is selected, you can generate:

• One (output file) per Proof Sheet Side,

• One per Proof Sheet,

• One per Section,

• One per Booklet,

• One per Book.
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Sheets

This is only available when Press sheet is selected. Select the sheets you want to expose by checking
the appropriate boxes. If you want to select all sheets, check the file.

Layers

• Check the trim boxes box to expose the trim boxes layer, so that you will be able to see where
the sheets will be trimmed.

• Check the Marks box to expose the layer containing all marks.
• Check the Pages box to expose the layer containing the pages.

Output Area

• All outputs all elements, even those that are situated outside the plate.
• Plate outputs all elements within the plate format.
• Paper outputs all elements within the paper format.
• Zones outputs all elements within the signature format.

Area growth: enter a positive or negative value in the input box to enlarge or reduce the output area
formats mentioned above. Select the appropriate unit from the dropdown list.

Pages

This is only available when One Up or Spread is selected.

• Check the All toggle to select all pages.
• Enter the correct Range of pages.

• All pages in range prints only the pages indicated.
• Include front and back prints the selected pages and the corresponding front and back sides.

Paper

This is only available when One Up or Spread is selected.

Specify the appropriate paper width and height. When nothing is entered, the size of the file is used
when sent to an output device.

Other Settings

When a one-up is selected, you can enter a BackBleed value to be able to check the bleed in the
spine of the book for one-up proofs.

Checking the Show ImposeProof numbers box puts a page number on the recto side of the page.

Check the Skip administrative cover box if you do not want to have a cover printed, containing
administrative information about the job.

Checking the Optimize for OutRight toggle makes sure that all pages are incorporated in the file.

Note:  All data that is outside the clipping masks will be clipped before being processed. This results
in better performance and smaller files.

Mockup

Check the elements you want to be visible on output and select the appropriate mockup color from
the dropdown list to enhance visibility.
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Tiling

If the job is too big to fit the selected paper/plate size, it may be interesting to opt for a tiled output.
The job will then be exported to a series of smaller pages/plates (tiles).

Select No tiling if no tiled output is required.

Deselect all toggles to obtain a tiled output, omitting tiles that contain only marks. To include these
kind of tiles, select Allow mark-only tiles. Enter width and height of the tiles, and a certain amount
of overlap.

2.7.49 Export IMP File to JDF Layout

The JDF Export task converts IMP files to JDF files, referring to PDF pages.
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This task combines elements of the Export to PDF File tasks and the Export Imposition to GRI File
task.

JDF version: JDF 1.2 or JDF 1.3

Pages format: PDF or Normalized File. If you select 'Normalized File' all PDF related tabs will be
greyed out.

This task consists of six tabs:

• The Output tab is identical to the Output tab of the Export to PDF File task.

• The Rasterize tab is identical to the Rasterize tab of the Export to PDF File task.

• The Compression tab is identical to the Compression tab of the Export to PDF File task.

• The Advanced tab is identical to the Advanced tab of the Export to PostScript task.

• The Sheets tab is identical to the Sheets tab of the Export Imposition to GRI task.

• The Mockup tab is identical to the Mockup tab of the Export Imposition to GRI task.

2.7.50 Export IMP File to JDF Post-Press

The Export to JDF PostPress task creates JDF for cutting and saddlestitching, starting from an
imposition file. The resulting JDF file will be interpreted directly by cutting machines (like for
example Wohlenberg or POLAR-Mohr) and binding machines (like for example the Muller Martini
Amrys SaddleStitcher or Heidelberg StitchMaster).The JDF capabilities of finishing equipment vary
significantly depending on the supplier and the machine model. Contact your supplier for more
information.
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The aim is to output in JDF all information that can be extracted from prepress and that serves to
optimize the production workflow downstream.

JDF Version: Select whether you want to generate a JDF version 1.2 or 1.3 file.

Export JDF: Indicate what data should be included in the JDF file: cutting, saddlestitching or both.

Maximum Trim: If the distance between the edge of the paper and the cut line is smaller than or
equals the trim indicated then no cutting will take place.

Cutting

The JDF file generated by the task contains a set of Cut Blocks that the cutting machine needs to
cut out of a sheet of paper.

Sheets: allows you to indicate which sheets must be exported.

Sheet Lay: determines how the paper is placed in the feeder.You should indicate the reference edge
of the paper relative to the front side of the sheet as seen in FastImpose.

• Automatic: determines the Sheet Lay by looking at the location of the Side Guide mark. If there
is exactly one side guide mark found its location is used. When there is no Side Guide or more
than one Side Guide, the Sheet Lay cannot automatically be determined, and consequently an
error will be generated.
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• Not Automatic: allows the user to select one of the four corners of the paper as Sheet Lay.

Cut Blocks: indicate where the cutting machine will have to cut, on the finished page size of each
cell of the signature or on the unfinished signature.Cutting on the finished page size of each signature
cell is useful when individual elements are combined as flat work, for example postcards or posters.

Print: indicate which side will be printed first, front or back.

Saddlestitching

The JDF file generated by the task contains the number of signatures that need to be bound, their
size, overfold and number of pages. It also contains information for stitching and trimming.

Saddlestitch

• Staple Shape: Crown, Overlap, Butted, ClinchOut, Eyelet

• Stitch Width

• Wire Gauge

• Wire Brand

• The Position boxes allow you to indicate the positions of the stiches.Positions are measured
starting from the trimmed side of the Registered Jog Edge. Stitches will be centered on these
positions.
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Registered Jog Edge

The Jog Edge is the reference edge of the folded signatures. This is the side that is used to align
the different signatures to.

• Automatic: the smallest of the FastImpose Head and Foot is used as Jog Edge.

When the head and foot trims are equal, the FastImpose head is used as Jog Edge.
• FastImpose Head
• FastImpose Foot

2.7.51 Export IMP File to PDF File

This task combines elements of the Export to PDF File task and the Export Imposition to GRI File task.

See Export to PDF File on page 331 and Export IMP File to GRI File on page 313.

2.7.52 Export IMP File to PDF File Chain

This task chain ticket consists of the Export IMP File to PDF File on page 320 ticket, linked to the
Mark as Proof on page 376 ticket. The result of the action is a PDF file that can be checked in
the Proofs View.

Note:  This task is used only in page workflows.

Depending on where the output file name is specified, in the PDF step or in the Proof step, a different
naming mechanism for the Proof Sets is triggered.

PDF step

When a task is launched from the Pages or Plates View, the default proof file name is proof_[File].
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Mark as Proof step

The default proof set name is: Output file name. extension.

Use SmartMarks to build up the name or enter it manually.

In the Details pane you'll see the original name of the file, including extra information on trim boxes,
side, etc.

2.7.53 Export IMP File to PostScript File

This task combines elements of the Export to PostScript File task and the Export Imposition to GRI
File task.

2.7.54 Export Imposition to JDF Layout

Using this task, you can export Imposition, RunList, Layer, Plate and Page to JDF Layout and JDF
Runlist format. This task will send an Imposition or a part of an Imposition to a workflow that requires
JDF Layout as input. The JDF Layout contains a JDF RunList which you can use in the Join Pages
task to produce a multipage PDF book for getting approval.

Apply Color Mapping: You can enable this to export the layout file with the same color mapping
as defined in the Plates view.
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Check page status: You can use this option to check if the approval status of the pages is compliant
with the Job setup settings. The task will fail if it is not compliant.

2.7.55 Export Imposition to PDF File

This task exports Imposition, RunList, Layer, Plate and Page formats to PDF format.

Number of Flats per File: You can use this option to specify how you want to split the output file.
One sheet side of an Imposition is considered as a Flat.

• If you enter 0 , the output will be one multipage file.

• If you enter 1 , the output will be two PDF files containing front(recto) and back(verso) sides
separately. For each sheet in the Imposition, there will be two PDF files like this.

• If you enter 2 , the output will contain front(recto) and back(verso) side together in one PDF file
with two pages. This will bethe outcome for each sheet in the Imposition .

Page Label: The page labels as they will appear in the output file(s).

Note:  You can make use of SmartNames from the categories Page Information and Plate
Information here.

Apply Color Mapping: You can enable this to export the layout file with the same color mapping
as defined in the Plates view.

Check page status: You can use this option to check if the approval status of the pages is compliant
with the Job setup settings. The task will fail if it is not compliant.

2.7.56 Export Nested Layouts

For detailed information about the Export Nested Layouts task, please see Export Nested Layouts
on page 1116 in the Gang Run Printing chapter.

2.7.57 Export Step and Repeat to JDF Layout

This task makes it possible to export a JDF Layout file. Stations, masks and marks are exported
to PDF 1.5 files. A JDF file containing references to all these files will be generated. You can select
whether you want to generate a JDF version 1.2 or 1.3 file.
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When selecting the 'Create MIME file' toggle, the JDF and the referenced PDF files are put together
in a MIME packed file.

2.7.58 Export to 3D

This task produces 3D output files which you can view in 3D viewers. 3D viewing helps in

• Quality control
• Better viewing of directions, positioning and visibility of the elements

With this task, you can export a Normalized PDF or PDFSTA (Station file) with a linked structural
design (CAD) file into a 3D file. The task accepts multiple input files with support to define one scene .
For example, you can give multiple input files belonging to one Scene which you can load in the
task separately.

• two input PDFs containting the same structural design
• one input PDF with three pages referring to one part of a scene
• three input single page PDFs referring to one part of a scene

This task can create output in the following formats:

• 3D Collada file : this can be uploaded to WebCenter and viewed in the integrated 3D Viewer.
• Tiff image
• PDF with 3D Design: view this as 3D in Adobe Reader or Acrobat Professional (version 8.0.1 or

later).
• U3D : it is a common exchange format for 3D objects. In Acrobat Professional 8.0.1 or higher you

can place U3D files in PDF files.

Attention:  Your input file must have a linked CAD file or the task will fail.

About Structural Design Files

A structural design file (2D and 3D) contains all the cut and crease lines for a specific type of package.
A structural design file may also contain folding angles that define how the package is to be folded
into its final shape. The structural design file does not contain the graphics, only the structural lines.

To bring the structural design and the graphic design together, a structural design file can be placed
or opened in either:
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• Adobe Illustrator using the Esko Data Exchange plug-ins,

Note:  You can get the Data Exchange plug-ins for free at http://www.esko.com/.

• ArtPro,

• PackEdge.

Supported structural design file formats:

• ArtiosCAD or Studio Toolkit for Boxes (.ard files) for boxes
• Score! (.vlm or .scb files) for boxes
• Studio Toolkit for Flexibles (.bag files)
• Collada files with a printable part (.dae or .zae files)

A printable part is an Esko extension to the Collada format. Collada files with one or more printable
parts can be created in Studio Designer, Studio Toolkit for Shrink Sleeves, Studio Toolkit for Labels
and ArtiosCAD.

Export to 3D Settings

http://www.esko.com/
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This task will work of multiple file belonging to a Scene.

Note:  You can create a Scene using Esko ArtiosCAD. The Scene will contain links to multiple .ARD
files which contains Structural Designs. For example

Exporting to Collada

Choose Collada File to export the 3D design to a Collada file.

Specify the Resolution of the image.

Define the View Angle from which the package should be rendered. You can either inherit the angle
from the file (using the view angle the file was saved with in Illustrator, Studio or PackEdge), or specify
it manually by entering the angles numerically.

Adapt the Perspective. A high value has the effect of a camera with a wide angle lens, close to the
object. A low value has the effect of a camera with a zoom lens, further away from the object. The
default perspective is 45 degrees.

Note:  The object will always fit completely inside the exported image.

Choose a Background Color: White, Black or Transparent. For example, choose a transparent
background if you want to use the file for a product placement.
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Exporting to TIFF

Choose Tiff Image to export the 3D design to an RGB TIFF image.

You can define the Width / Height of the image that you want to export. The TIFF image will always
be square and will contain the whole package.

You can also specify the Resolution of the image.

You also need to specify the View Angle from which the package should be rendered. You can either
inherit the angle from the file (using the view angle the file was saved with in Illustrator, Studio or
PackEdge), or specify it manually by entering the angles numerically.

You can also change the Perspective. A high value has the effect of a camera with a wide angle
lens, close to the object. A low value has the effect of a camera with a zoom lens, further away from
the object. The default perspective is 45 degrees.

Note:  The object will always fit completely inside the exported image.

Choose a Background Color: White, Black or Transparent. For example, choose a transparent
background if you want to use the file for a product placement.

Exporting to PDF with 3D Design

Choose PDF File with 3D Design as File Type.

You can define the Width, Height and Resolution of the PDF file.

The Show Footer toggle allows you to switch the Footer Text on or off. Instead of the default Esko
text you can personalize the footer text to include your own message. You can also use SmartNames.

As when exporting to TIFF, you can use the View Angle saved in the file or enter it manually, and
change the Perspective.

You can choose a White or Black Background Color.

Exporting to U3D File

Choose U3D File as File Type.

You can set the U3D file’s Resolution, View Angle and Perspective.

You can choose a White or Black Background Color.
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Using Prepare Station with Export to 3D

In a workflow, you can connect the Prepare Station and the Export to 3D tasks to get both a one-
up file for your Step and Repeat, and a 3D preview of the final result (box, bag, can or bottle).

• As input, you need your design in Normalized PDF format (you can export Normalized PDF from
Illustrator using the DeskPack plug-ins), with a link to your CAD file (see Export to 3D on page
323 for a list of supported CAD files).

• As output, you will get a PDFSTA one-up, collada (ZAE) and a 3D file in TIFF, PDF or U3D format.

For more information, see Prepare Station on page 417 and Export to 3D Settings on page 324.

2.7.59 Export to ArtPro File

This task allows you to export a Normalized PDF file to the ArtPro file format.

Version: you can export your file as:

• an ArtPro 10.x/9.x/8.x file,

• an ArtPro 7.5/7.0 file.

ArtPro 7.5/7.0 files do not contain version-specific information or blend modes (the file will be
flattened).

Copy linked files next to output file: select this to copy the linked images next to the ArtPro file
created.

2.7.60 Export to EPS / DCS File

The EPS Export ticket has five tabs:
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• Output
• Color Management is the same as the Color Management tab of the PostScript Export task.
• Rasterize is the same as the Rasterize tab of the PostScript Export task.
• Compression is the same as the Compression tab of the PostScript Export task.
• Advanced is the same as the Advanced tab of the PostScript Export task.

Note:  The names of multiple DCS files consist of the name of the original EPS DCS file followed by
_C, _M, _Y, _K (for process ink plates) or _1, _2, _3, ... (for all other kinds of inks). The files have .x
as extension.

Output

PostScript version: choose between PostScript 3 or PostScript level 2.

Output type: choose between an EPS, a Single DCS and a Multiple DCS file.

EPS: This will create an EPS file with an RGB preview. When the selected PostScript version is
PostScript 3 and the color management toggle in the Processing Tab is switched off, this will be a
deviceN EPS, in all other cases a CMYK composite EPS will be created.

Single DCS file: This will create one EPS DCS file containing multiple separations. The DCS file
always contains an RGB preview used when placing the EPS DCS file. In addition a composite
grayscale or color CMYK preview may be added used for composite printing.

Multiple DCS file: This will create a master EPS DCS file referring to multiple separations (one file
per ink). The names of these files consist of the output filename followed by the name of the ink. The
master DCS file always contains an RGB preview used when placing the EPS DCS file. In addition a
composite grayscale or color CMYK preview may be added used for composite printing.

• EPS
• Single DCS file, no composite
• Single DCS file, grayscale composite
• Single DCS file, color composite
• Multiple DCS file, no composite
• Multiple DCS file, grayscale composite
• Multiple DCS file, color composite
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Preview Resolution

The default resolution is set on 72 ppi. This option can change the resolution of the RGB preview
used when placing the EPS DCS file. A higher value will produce a finer, more detailed preview but
will also increase the files size of the EPS DCS. The minimum value is 72 ppi.

Resolution

The default resolution is set to 4.000 ppi. If you do not know where the EPS will be placed, you might
want to make a high resolution file. Mind, however, that the higher the resolution, the bigger the file
size of the EPS will become.

Page Number: To select the page of the job you want to export.

Scale: allows you to scale using percentages.

Add SmartMarks sets by selecting one from the drop-down list.

Account for job margins: selects the margins of the job as the true boundary. Normally the borders
of the job are taken as the true boundary of the job. Sometimes, however, you may want to convert
everything that is situated within the margins too.

Hide Trap Layer in output: allows you to export your file with or without the trap layer.

2.7.61 Export to Normalized PDF File

This task converts a GRS file to a Normalized PDF file. A GRS is an old Esko file format.

Note:  This task is only available when you are working in a Normalized PDF job folder.

External References
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External references have to be converted, you can define what the system needs to do.

• 'Write local external references to the output folder and other external references to their original
folder'.

Upon exporting, external references in subfolders or neighboring folder will be written to the
output folder. External references in for example central folders will be written in their original
folder.

• Write all external references to the output folder.

• Write all external references to their original folder.

When converting again, you can opt to:

• Reconvert if recently updated: only updated references will be reconverted, all other conversions
will be used as they were.

• Use previous conversions: the existing conversions will be used, potential updates will not be
considered.

• Always reconvert: all external references will be converted at all times.

Embed External Images

Referenced external files in GRS format can be converted to referenced files in Normalized PDF file
format. Indicate which images you want to have converted.

1. All images
2. Images with uncompressed data size smaller than 640 kB (as specified via Configure > Processing

Preferences > Embedded Images). This option is identical to the option in the Inks tab of the
Normalize PostScript / PDF / Illustrator 8.0 File task.

3. None

Indicate what should happen with the external images. You can have them copied to the output
folder, or you can opt to leave them in their original folder.

Fail when fonts are not found

When the fonts used in the file are not found the task will fail, when the toggle is not selected, the
task will end with a warning.

Fail when external references are not found

The task will fail when not all external files were found.

2.7.62 Export to Normalized PDF File (Embed All)

This task embeds all the external references, images and fonts to a Normalized PDF file. You
can use this task to include external references and links in a PDFPLA or Normalized PDF file.

You can specify the output file name and location in the ticket settings.



2
Automation Engine

331

The output will be one Normalized PDF file with all the external references, fonts and images
embedded.

Note:  In the Export to Normalized PDF task you can embed the images, but the external references
in a normalized PDF file is exported together to the specified location. Read more in Export to
Normalized PDF File on page 329

2.7.63 Export to PDF File

We advise to use one of the following factory settings. Using a factory setting does not mean that
you cannot modify the settings:

These settings are a quick way to define your ticket. There are seven settings, select one from the
drop down list:

• PDF for data interchange (PDF 1.3): High compatibility but slow and less editable.

• Acrobat 4 and lower
• Ripping

• PDF for data interchange (PDF 1.4): Interchange with modern applications, well editable. For
example Acrobat 5 and more recent.

• PDF for data interchange (PDF 1.5): Interchange with modern applications, well editable for
example Acrobat 6 (and higher).

• PDF for data interchange (PDF 1.6): Interchange with modern applications, well editable for
example Acrobat 7 (and higher).

• PDF for data interchange (PDF/X-1a:2001 (ISO 15930-1)): PDF/X-1a is a standardized subset
of PDF designed specifically for reliable prepress data interchange. PDF/X-1a ensures complete
exchange using CMYK and spot color data. Uses: ripping and imposition

• PDF for data interchange (PDF/X-3:2003 (ISO 15930-3)): PDF/X-3 is a standardized subset
of PDF designed specifically for reliable prepress data interchange. PDF/X-3 ensures complete
exchange suitable for coloured managed workflows. Uses: ripping and imposition
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• PDF for Illustrator CS2 or higher: PDF file meant for editing in Adobe Illustrator CS2 (or higher).
Note that this mode improves the editability in Adobe Illustrator, but does not guarantee full
editability.

• PDF for viewing / proofing (CMYK Composite): Useful when using hard copy proofers, or when
the result doesn't have to be editable or when the result is used for softproofing. It is not useful
to serve as final output.

• PDF for viewing / proofing (RGB): Useful for softproofing (smaller file, and it's faster to generate).

• PDF for viewing/proofing DeviceN: Interchange file for proofing/viewing. Adobe Acrobat Reader
7.0 or later is required to view overprint settings correctly.

If you change the predefined settings, the user interface will indicate that the Factory Settings are
modified.

Note:

If you define a ticket using the Factory Settings, and you save it, the Factory Settings option
disappears.

If you overwrite a Default ticket, the Factory Settings will be gone as well.

Note:

Even though Acrobat 7 Professional now offers the possibility to define an ink as Opaque ("Ink
Manager") for Trapping reasons it has no influence on the preview.

The PDF Export ticket has seven tabs:

• Output,

• Device,

• Color Management,

• Inks (similar to the Inks tab in the Export to PostScript File task, see Inks / Separations on page
346),

• Rasterize (similar to the Rasterize tab in the Export to PostScript File task, see Rasterize on page
347),

• Compression,

• Advanced.

Output
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PDF Version

Select a PDF version from the list.

• PDF for Illustrator: Select this version if you want to open the generated PDF 1.4 file in Adobe
Illustrator CS2 or higher. Because Adobe Illustrator only supports a (undocumented) subset of
PDF 1.4 features some objects and/or colorspaces must be split up, transformed and/or pre
ripped in order to correctly represent them in Illustrator.

• PDF/X-1a:2001 (ISO 15930-1)

• PDF/X-3:2003 (ISO 15930-3)

• PDF 1.6: the Acrobat 7 file format

• PDF 1.5: the Acrobat 6 file format

• PDF 1.4: the Acrobat 5 file format

• PDF 1.3: the Acrobat 4 file format

Password security

Allows you to make your file password protected. For more information, please see Password
Security on page 334.

Output type

• Composite: Generates a composite file, which if no color management is used produces a
deviceN pdf for data interchange. DeviceN means colors can be combinations of the standard
CMYK process colors and/or spot colors, guaranteeing perfectly separable PDF files which can
also be proofed on a composite PostScript 3 device. The generated PDF file will proof correctly
and separate correctly. Color management for spot color objects must be handled by the device.

• Separated: Activate this option to generate separations. Multiple pages will be generated,
corresponding to the inks in the job.

Scale

Define the scale in percentages. You might want to scale your job to make it easier to softproof via
e-mail.

Select SmartMarks from the dropdown list.

Put marks with ink coverage on a hardcopy proof (or view it in Acrobat).

Account for job margins
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To select the margins of the job as the true boundary. Normally, the borders of the job are taken
as the true boundary of the job. Sometimes, however, you may want to convert everything that is
situated within the margins too.

Hide trap layers in output

Toggle this option on if you do not want the trap layers included in your output.

Page Range

• Output All pages.

• Output a number of Pages. Enter page numbers or page ranges separated by commas, for
example 1,3,5-8.

Password Security

The options in the Password Security window depend on the PDF version you chose in the Output
tab.

Click the Password Security button in the Output tab (Export to PDF task), the Password Security
window opens:

Compatibility: the compatibilities offered here depend on the PDF version you chose in the Output
Tab.

Encryption level: Low (40–bit RC4)

Require a password to open the document: enter a password.
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Use a password to restrict permissions: enter a password.

Printing Allowed

• Select 'None' to prevent users from printing the file.
• Select 'low resolution (150 dpi)' to give users permission to print the file at a resolution of 150

dpi only.(Acrobat 5.0 and later)
• Select 'High resolution' to give users permission to print the file at high resolution only.

Changes allowed

• Select 'None' to prevent users from doing anything with the file, including filling in signature and
form fields.

• Select 'Inserting, deleting and rotating', lets users insert, delete, and rotate pages, as well as
create bookmarks and thumbnail pages. This option is available only if a high encryption level is
selected. (Acrobat 5.0 and later)

• Select 'Any except extracting pages' to let users do anything to the document except extract
contents.

Enable copying of content: Lets the user select and copy the contents of the PDF document. This
option is available only if the Compatibility option is set to Acrobat 5.0 and later.

Enable Text Access: (Acrobat 5.0 and later) Enables visually impaired users to read the document
with screen readers. This option does not allow users to copy or extract the document's contents.
This option is available only if the Compatibility option is set to Acrobat 5.0 and later.

Device

Make your export PDF device specific by adding a description of the dot gain compensation curves
inside that PDF.

Note:  These are not calculated, but they are stored as PDF standard transfer curves. Opening the
PDF in Acrobat will not show any difference.

Dot Gain Compensation

You can select Dot Gain Compensation (DGC) curves made with IntelliCurve or IntelliCurvePro.

• Single curve: Allows you to select one DGC curve (.dgc file) that will be applied to all your data.

• Automatic: Allows you to select a Screen-Based DGC table (.scrdgc file) or a DGC Strategy (.icpro
file). The former allows you to apply dot gain compensation selectively depending on the dot
shape, screen ruling, angles and even Contone or Linework properties. The latter does the same
but also offers ink-based dot gain compensation.
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Note:

You can also apply both single curve and automatic DGC simultaneously, resulting in a cumulation
of both effects.

Color Management

Convert to

• CMYK: all inks are converted to CMYK values.
• RGB: all inks are converted to RGB values.
• Gray: all inks are converted to Gray values.

Use link profile: Link profiles describe a transformation from 1 device-dependent color space to
another. This is actually a concatenation of a forward transformation of 1 profile and a backward
transformation of another profile. This means that all other options will be grayed out as the Link
Profile takes complete care of the color management.

Source profile: If any CMYK objects are to be converted, choose a source profile. The list shows all
CMYK print profiles in the color database. The source profile defines the target that the destination
profile is supposed to match.

Destination profile: Choose a color profile for your destination color space. The list shows all print
profiles in the color database. These profiles are either measured in Color Engine Pilot or imported
ICC-profiles.

Rendering intent

• Relative (No Background): Use this option if you do not want any background simulation. The
white point of the source will be mapped on the white point of the destination process. This
rendering intent takes into account the ability of the human eye to adapt to the surrounding white.

• Perceptual: This will result in no background simulation (white of reference colorspace is mapped
on white of destination colorspace). Use this option if you don't care too much about an exact
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color match but you want the pictures at least to look nice on your proofer. It will give a visually
pleasing result. If the gamut of the source is wider than the proofer, the entire gamut is shrunk so
that it fits inside the gamut of the proofer.

• Absolute (Background): Use this option if you want background simulation and you want an exact
color match, including the paper simulation.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent will
map saturated colors on saturated colors.

Black Mapping: When toggled on, the CMY-part of the composite colors are converted separately
from the black component. As a result, the type of black separation (Skeleton, UCR, GCR...) is
preserved by the conversion. (It is still possible that the black percentage changes slightly due to
different dot gain in the color profiles.) When toggled off, the converted CMYK colors are completely
re-separated into the black behavior that is built into the destination profile.

Use the document profile as source profile if available: If a document profile is defined, then that
one will be used as a source profile. The one chosen from the Source Profile dropdown list will be
overruled.

Embed the Destination profile as an intermediate color space

If this toggle is off, the colors in the PDF file will not be tagged with an ICC color profile. The document
is device dependent and its colors will only be reproduced accurately if the PDF file is output on the
device that is specified in the Destination Profile. This choice is preferable if we are sure the PDF file
will be sent to the device specified in the Destination Profile.

If this toggle is on, the color in the PDF file will be tagged with an ICC color profile. The document
then becomes device independent, and its colors will be reproduced accurately even on devices with
a color space different from the one specified in the Destination Profile. In this case, the Destination
Profile is an intermediate colorspace between the Source Profile and the color profile of the device
that will eventually process the PDF file.This method is preferable when the PDF file will be sent to
an unknown device.

Embed the document profile as PDF Output intent: The output intent is an ICC profile that specifies
the intended output device. If this option is toggled on, the document profile will be saved as the
PDF output intent. For certain PDF flavors (PDF-X/3) an output intent is mandatory and this option
is always on. If no document profile was set explicitly, the default document profile (crom_offs) is
used instead. If the document profile is a Color Engine Pilot profile, it will first be converted to an
ICC profile.

Compression

General
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Optimized lossless image compression

Selecting an overall lossless image compression method seldom results in the smallest overall file
size. This option will use the smallest lossless compression method for every image seperately
(JPEG2000, Flate, FlateDiff, LZW, LZWDiff, CCITT3, CCITT4 or RLE) depending on the image type
and the allowed lossless compression methods for the chosen PDF version. When activating this
option the compression methods for Contones and Bitmaps are disabled and the encoding is set to
Binary. Please do not overrule this option unless you have good reasons to choose another encoding
method, otherwise the resulting file will become larger.

Attention:  Activating this option will slow down PDF export considerably, so use it only for
file size critical jobs.

Check Crop images on clip mask to crop the image(s) on the clip mask. All information located
outside the clip mask will be lost.

Encoding

• Binary: The image data is represented as binary data. This results in compact files that however
are not editable in a common ASCII editor. Nor can these files be sent over a communication line
using a communication protocol that relies on control characters in the data stream itself.

• Hex: In this way, the PostScript file remains editable with an ASCII editor at all times. They also
can be sent over a communication line using whatever communication protocol is available. The
drawback, however, is that hexadecimal image data may take up to twice as much size as binary
data.

• Ascii 85: Encodes binary data in an ASCII base-85 representation. This encoding uses nearly all
of the printable ASCII character set. The resulting expansion factor is 4:5, making this encoding
more efficient than hexadecimal.

Bitmaps

Downsample The images referenced in your design are subsampled approximately to the specified
value. Activating this option, allows you to reduce the size of the generated PDF file. Select the unit
for subsampling from the dropdown list: lpmm or ppi. Please be aware that 1–bit copydot Images
cannot be downsampled.

Compression

• None
• CCITT group 3 and CCITT group 4
• Run Length
• LZW
• LZW Diff
• Flate (ZIP)
• Flate (ZIP) Diff

Contones

Downsample The images referenced in your design are subsampled approximately to the specified
value. Activating this option, allows you to reduce the size of the generated PDF file. Select the unit
for subsampling from the dropdown list: lpmm or ppi.

Compression

• None
• LZW
• LZW Diff
• JPEG Compressions



2
Automation Engine

339

• JPEG2000
• Flate (ZIP)
• Flate (ZIP) Diff

When selecting JPEG, an extra dropdown list becomes activated. It allows you to select the quality of
the JPEG compression that needs to be used: from Limited over Standard to Extreme.When selecting
JPEG2000, the dropdown list offers the following compression types: lossless, limited, low, standard,
high or extreme compression.

Text and Lineart

Compression

• None
• LZW
• Flate (ZIP)

Advanced

Fonts

• Contourize fonts

Note:  Protected CID fonts will be referenced by name.

• Embed BG and Type1 and CID fonts: Allows you to include the used BG and Type 1 fonts of
your design in your PostScript file.

Split Complex Paths

Note:  These are workarounds for typical PostScript level 1 path limitations. Only use these when
absolutely necessary.
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• Filled and stroked paths at X points Use this option to split linework with more than x points into
several smaller linework parts. This option decreases the complexity of the linework. A suitable
value for the selected device type is calculated for this option.

• Clip paths at X points Use this option to split linework masks for images with more than x points
into several smaller linework parts. This option decreases the complexity of the masks.

Workaround

• Limit filename to 31 characters Use this toggle if you want to make sure your imported files can
be seen/read from/by all Apple operating systems.

• Ignore varnish inks Varnish inks will not be included while outputting.

• Resolve pure black overprint. Overprints are normally resolved, but by default, pure black is
left untouched. If you want Rich Black to be resolved too, select this option. This option is only
available when Color Management in the Processing tab is activated.

• Resolve once identical external files Instead of resolving the complete file and all its external
references, identical external files will be resolved only once.

• Resolve once identical one-ups in Step & repeat file Instead of resolving the complete Step &
Repeat file, identical one-ups will be resolved only once.

• Suffix for PANTONE ink names Enter a suffix for PANTONE ink names. The default is C.

• Split multi-page jobs into multiple files Every page of a multi-page job will be output as a
separate PDF file.

• Add ruling, angle and dotshape information in PDF Data section

• Add Ink Coverage data in XMP

Uncheck this to not save the ink coverage data in the XMP section of the exported PDF file
(calculating the ink coverage might be time consuming and slow the PDF export down).

2.7.64 Export to PDF File Chain

Note:  This task is used only in page workflows.

This task chain ticket consists of the Export to PDF File on page 331, linked to the Mark as Proof
ticket. The result of the action is a PDF file that can be checked in the Proofs View.

Depending on where the output file name is specified, in the PDF step or in the Proof step, a different
naming mechanism for the Proof Sets is triggered.
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PDF Step

When a task is launched from the Pages or Plates View, the default proof file name is proof_[File].

Mark as Proof Step

The default proof set name is: Output file name. extension.

Use SmartMarks to build up the name or enter it manually.

In the Details pane you'll see the original name of the file, including extra information on trim boxes,
side, etc.

2.7.65 Export to PostScript File

The Factory settings supplied are a quick way to define your ticket.

We advise you use one of these settings (but you can modify them if needed).

• PostScript for press (separated)
• PostScript for press (DeviceN composite): This output mode (only supported by PostScript 3

devices) uses the PostScript DeviceN colorspace to produce high-fidelity colors.

These colors are combinations of the standard CMYK process colorants and/or spot colors,
guaranteeing perfectly separable PostScript code that can be proofed on a composite PostScript
3 device.

• PostScript for viewing / proofing (CMYK composite)

If you change the predefined settings, the user interface will indicate that the Factory Settings are
modified.
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Note:  If you define a ticket using the Factory Settings, and you save it, the Factory Settings option
disappears. If you overwrite a Default ticket the Factory Settings will also be gone.

Output

Device type: To select the output device you want your design to be exported to or printed to, the
corresponding PPD is chosen and will be used.

Output type: To export or print your design as CMYK Composite, Separated or Composite.

• CMYK Composite: Activate this option to generate a composite PostScript file for proofing.

Note:  Remark that a CMYK composite PostScript file will proof correctly but separations will not
be correct since all spot color are converted to CMYK.

• Separated: Activate this option to generate separations. Multiple pages will be generated,
corresponding to the inks in the job.

• Composite: this output type can only be selected for PostScript 3 devices since they support
deviceN colorspace to produce high-fidelity colors.

These colors are combinations of the standard CMYK process colorants and/or spot colorants,
guaranteeing perfectly separable PostScript code which can also be proofed on a composite
PostScript 3 device.

The generated PostScript file will proof correctly and separate correctly. Color management for
spot color objects must be handled by the device.

Emulsion Up: To obtain Right Reading (= emulsion up) or Wrong Reading (=emulsion down).

Image: To specify Positive or Negative print mode.

Note:  Image and Emulsion up becomes unavailable (appears dimmed) when CMYK Composite
Output was chosen.

Enter the Vertical and/or Horizontal distortion in percentages.
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Select SmartMarks from the dropdown list.

Account for job margins: To select the margins of the job as the true boundary.

If you deselect this toggle, the borders of the job are taken as the true boundary.

When you want to output everything that is placed within the margins too, leave the option activated.

Hide trap layer(s) in output: Trap layers will not be included in the output.

Page range

• Output All pages.
• Output a number of pages. Enter pagenumbers or page ranges separated by commas. For

example 1,3,5–8.

Scale & Tile

• Enter a Scale factor (percentage).

• Fit job on page scales the job so it fits the selected paper size.

• Shrink oversized jobs to paper size.

• Select 'Tile Job' to obtain a tiled output if the job is too big to fit on the selected paper size.

The tiling option which can be used to export a large job to a series of smaller pages (tiles) allows
the user to cycle through the tiles which will be produced and see just how many tiles there are.

Overlap X mm/inches: To specify a tiling overlap. The value you enter here, is the amount of
overlap in all four directions between adjacent tiles. It defaults to 5 mm.

Page Setup

• Select a paper size from the drop-down list. The list that appears here is based on the page sizes
supported by the selected ppd.

• Orientation: Auto, None, 90° cw, 90°ccw, 180°. The orientation options are disabled when 'Tile
job' is selected.

• Alignment: Bottom left, Top left, Top right, Bottom right, Centered. The alignment options are
disabled when 'Tile job' is selected.

• Enter the number of copies.

Device
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The Resolution depends on your output device and on the purpose of the PostScript file. For
proofing for example, a lower resolution might be sufficient.

Select the Dot shape.

Halftoning: If you select CMYK Composite or Composite as Output type, you can choose to include
screen information when outputting (lpi and angle).

• Use Printer Defaults: the output device's default screen information will be used.

• Take over from job

• Some devices offer other dotshapes if they are available in the PPD.

Dot Gain Compensation: You can select Dot Gain Compensation (DGC) curves made with
IntelliCurve or IntelliCurvePro to be added as transfer curve.

Note:  A screen-based DGC file was the format written by the two DGC Editors (DGC Editor and
Screen-based DGC Editor). These two editors have been replaced by IntelliCurve, which writes DGC
Strategies. However, a screen-based DGC file can still be applied.

• Single curve: Allows you to select one DGC curve (.dgc file) that will be applied to all your data.

• Automatic: Allows you to select a Screen-Based DGC table (.scrdgc file) or a DGC Strategy (.icpro
file). The former allows you to apply dot gain compensation selectively depending on the dot
shape, screen ruling, angles and even Contone or Linework properties. The latter does the same
but also offers ink based dot gain compensation.

Note:  You can also apply both single curve and automatic DGC simultaneously, resulting in a
cumulation of both effects.

Note:  When a DGC curve is selected, the job will be flattened to ensure the correct Dot Gain
Compensation is applied to transparent objects. This may result in a larger file.

Roll Fed Devices: Account for Media Width allows the conversion program to find the best printing
orientation. For roll-fed devices, mostly imagesetters, a Media Width (film width) can be specified.

The conversion program finds the best printing orientation in order not to waste paper or file if
Rotation is set to Auto.
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The Media Width value is expressed in mm.

The option 'Extra Gap' allows you to specify extra width for the film or paper feed. The Extra Gap
value is expressed in mm. By default, no Extra Gap is set.

For Device specific options please refer to the manual of your output device.

Color Management

Convert to

• CMYK: all inks are converted to CMYK values
• Gray: all inks are converted to Gray values.

Use link profile: Link profiles describe a transformation from 1 device dependent color space to
another. This is actually a concatenation of a forward transformation of 1 profile and a backward
transformation of another profile. This means that all other options will be grayed out as the Link
Profile takes complete care of the color management.

Source profile: If any CMYK objects are to be converted, choose a source profile. The list shows all
CMYK print profiles in the color database. The source profile defines the target that the destination
profile is supposed to match.

Destination profile: Choose a color profile for your destination color space. The list shows all print
profiles in the color database. These profiles are either measured in Color Engine Pilot or imported
ICC-profiles.

Rendering intent

• Relative (No Background): Use this option if you do not want any background simulation. The
white point of the source will be mapped on the white point of the destination process. This
rendering intent takes into account the ability of the human eye to adapt to the surrounding white.

• Absolute (Background): Use this option if you want background simulation and you want an exact
color match, including the paper simulation.

Map black on black: When toggled on, the CMY-part of the composite colors is converted separately
from the black component. As a result, the type of black separation (Skeleton, UCR, GCR...) is
preserved by the conversion. (It is still possible that the black percentage changes slightly due to
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different dot gain in the color profiles.) When toggled off, the converted CMYK colors are completely
re-separated into the black behavior that is built into the destination profile.

Use the document profile as source profile if available: If a document profile is defined, then that
one will be used as a source profile. The one chosen from the Source Profile dropdown list will be
overruled.

Inks / Separations

The Inks/Separations tab depends on the output type you selected in the Output tab.

• If you choose CMYK Composite or Composite, the Inks tab will be visible.

• If you choose separated output, the Separations tab will be visible.

All Inks: The standard behavior of the default ticket is to offer all inks in the job to be exposed.
Deactivating All Inks opens an ink-list panel where you can select specific inks. The list contains ink
names, ruling, angle, dot shape and ink type.

Note:  The Inks panel only shows the inks that are present in the input file(s) for the first task in your
workflow. When no files are selected (for example, when building workflows in the Tickets view, you
will not be able to “preselect” inks.

Use technical inks in output: Normally technical inks are hidden when you save a job in an Esko
editor. Check the box to output the visible (non hidden) technical inks.

Convert all inks to CMYK: inks will be converted to CMYK.
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Use Merge with to output inks on top of each other in the same output file. This is common when
you use different rulings for 1 ink.

For example, let's assume that the job contains two Cyans, and that they have a different ruling. You
might want to put them on the same separation.

You can do so by clicking in the Merge with column and selecting the ink it has to be merged with.

Rasterize

Rasterizing resolution: Enter the resolution for the objects that will be resolved.

Output as image: When this toggle is activated an image is made of the job. The resolution entered
above will be taken into account.

Anti-aliasing: is relevant for the line-art objects in your design, that need pre-processing and for
which images are generated. Anti-aliasing smoothens the staircase effect you get in the generated
images of lineart objects that need pre-processing.

Tip:  This option increases the readability of small text that is pre-processed to image.

Convert vignettes to image: To avoid banding in the vignettes when exporting. Exporting vignettes
to a PostScript Format, may result in blends and banding due to restrictions in PostScript. However,
to obtain a nice result in your export file, activate Convert Vignettes to CT. All the vignettes present
in your design will be converted to images.

Vignette noise: When exporting to PostScript, some vignettes or parts of vignettes will be converted
to images. This happens when the vignettes overlap other objects with translucency or overprint
between the vignette and the other objects.

When the option 'Convert Vignettes to Image' is activated all vignettes are converted to images
regardless of overlap with other objects. Vignettes that are converted to images may have tone jumps
in the final result. To reduce this banding effect, noise is applied on the image. The amount of noise
can be specified in the field Vignette Noise.

Compression
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Encoding:

• Binary: The image data is represented as binary data. This results in compact files that however
are not editable in a common ASCII editor. Nor can these files be sent over a communication line
using a communication protocol that relies on control characters in the data stream itself.

• Hex: In this way, the PostScript file remains editable with an ASCII editor at all times. They also
can be sent over a communication line using whatever communication protocol is available. The
drawback, however, is that hexadecimal image data may take up to twice as much size as binary
data.

• Ascii 85: Encodes binary data in an ASCII base-85 representation. This encoding uses nearly all
of the printable ASCII character set. The resulting expansion factor is 4:5, making this encoding
more efficient than hexadecimal.

Compression: None, LZW or Flate (PostScript3 devices).

Downsampling The images referenced in your design are subsampled approximately to the
specified value. Activating this option allows you not only to reduce the size of the generated
PostScript file, but also a quicker generation of the PostScript file.

Select the unit for subsampling from the dropdown list: lpmm or ppi. You can subsample both
bitmaps and contones.

Please be aware that 1–bit copydot Images cannot be downsampled.

Advanced

Fonts

• Contourize fonts

Note:  Protected CID fonts will be referenced by name.

• Embed BG and Type1 fonts: Allows you to include the used BG and Type 1 fonts of your design
in your PostScript file.

Split Complex Paths

Note:  These are workarounds for typical PostScript level 1 path limitations. Only use these when
really necessary.

• Filled and stroked paths at X points: Use this option to split linework with more than x points into
several smaller linework parts. This option decreases the complexity of the linework. A suitable
value for the selected device type is calculated for this option.
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• Clip paths at X points: Use this option to split linework masks for images with more than x points
into several smaller linework parts. This option decreases the complexity of the masks.

Workaround

• Limit filename to 31 characters: Use this to make sure your imported files can be seen/read
from/by old Apple operating systems.

• Ignore varnish inks : Varnish inks will not be included when outputting to PostScript.

• Resolve pure black overprint: Overprints are normally resolved, but by default, pure black is left
alone. If you want Rich Black to be resolved too, select this toggle.

This toggle is only available when the Color Management in the Processing tab is activated.

• Resolve once identical external files: Instead of resolving the complete file and all its external
references, identical external files will be resolved only once.

• Resolve once identical one-ups in Step & Repeat files: Instead of resolving the complete Step
& Repeat file, identical one-ups will be resolved only once.

• Suffix for PANTONE ink names: Enter a suffix, the default is C.

• Suppress hairlines at clips : Due to the PostScript limitation of the maximum number of points
allowed for a path, complex paths will be cut into smaller pieces.

When the PostScript file is printed/exposed on some older PostScript RIPs, hairlines can become
visible. To avoid this problem, activate Suppress hairlines at clips.

• Split multi page job into multiple files: Every page will be output as a separate file.

• Image to paper edge: This moves the origin of the converted job to the lower left corner of the
paper or film. Activate this option to align your job to the edge of the paper or film to use the
full area.

Note:  Exporting to a paper PostScript device: For most of these devices, there is always a border
on the output page on which nothing can be imaged. Parts of your design that are located in that
border area will be lost.

• Avoid tabular number problem: When digits are written as tabular numbers, exporting to some
PostScript RIPs may result in bad positioning of the numbers. The tabular numbers are not
correctly placed at the text base line.

To avoid this problem, activate Avoid tabular number problem.

• Disable path clipping: By default, paths are clipped by the borders of the job, but if there are
instances where you do not want the paths to be clipped, check this box.

• Map spot color separations to CMYK: This option is intended to export a job containing
spot colors to pre-separated PostScript for systems which are limited to handling process color
separations only (for example a Scitex Brisque Workflow).

This option is available when Pre-Separated is selected.

Spot color separations can only be handled on such systems by remapping them to a specific
process separation. When this box is checked, spot colors will be exported as a C, M, Y or K
separation according to a simple rotating name principle (C->M->Y->K->C->...).

Spot colors which are named exactly after process colors remain unchanged.

• Omit “Process” For CMYK in %% PlateColor comment: This option is intended to export a
job to a device that does not understand "Process".

If your different separations all have the K (Black separation) Angle and Rulings when output to
your Image Setter, you must activate this option.
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• Split separated output into multiple files: Instead of writing one file containing all separations,
the system will write one file per separation.

• Force Black Overprint: Select this if you want all 100% black objects to overprint in your
PostScript file.

2.7.66 Extract Inks

You can keep ink separations according to the Printing Methods present in the PDF file. The output
PDF contains only those inks which are corresponding to the printing methods specified in this task.

Note:  This task extracts inks(keeps inks) in a file according to the printing method/criteria you specify.
Therefore, it is essential that it contains the information on the printing methods.

Note:

You can set the printing methods in a PDF file via Automation Engine Job setup or in Plato/PackEdge.
In the Inks panel of the Job Setup dialog in Automation Engine, the printing method can be set for
each separation. Read more in How Can the Printing Method of a Separation Be Defined?

You can use Extract Inks task while setting up separate processing workflows for individual
separations with specific printing methods. This is especially useful in hybrid press industry where
press- specific inks can be kept in the output PDF. Another instance where this task is useful is
when you want to generate separate reports corresponding to inks. Read more on tasks relating
to hybrid press industry in How Can You Differentiate the Processing of Separations for Different
Printing Methods?

You can specify Printing method in the field about which the information is pre-defined in the file.
You can have multiple printing methods specified by adding fields using +. If you use a combination
of Alt and ... , you can exclude printing methods.
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2.7.67 Fork

This Workflow Control is documented in the chapter "Workflows". See Fork and Join on page 1032.

2.7.68 Image to MJM File

The Image to MJM File task will pack the JDF that describes the ImageSetting process together with
the data files (ripped data) into one .mjm file.

This file can then be easily transported to another site for exposing or archiving purposes.

At the remote site, the exposure can be started by sending this .mjm file to a JDF/JMF enabled device
controller using the task as described in Make Plate on CDI on page 364.

If an .mjm file is selected as input file, the task panel will be empty. This is normal as all crucial
information is stored in the .mjm file itself.
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2.7.69 Image to Screened Separations

Use this task if you need screened output to send to a platesetter or filmsetter (for offset or flexo
for example).

Task Output

The Image to Screened Separations task generates one file per separation, in either PDF, TIFF or
LEN format.

For example, you can send screened LEN separations to the CDI.

In the example below, processing a file containing the lime green Esko star generates screened files
for the Cyan, Yellow and Black separations.

Task Parameters

In the Device field, select the imaging device that you configured.

Then use the selector pane at left to show more settings to fill in. See:

• General on page 1157,

• Transformations on page 1159,

• PDF Objects on page 1160,

• Document Inks on page 1161,
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• Output on page 1161,

• Separations on page 1168,

• Summary on page 1175.

2.7.70 Image to Unscreened Separations

Use this task if you need unscreened output to send to a device that will take care of the screening,
or a device that doesn't need screened input (for gravure for example).

Task Output

The Image to Unscreened Separations task generates one file per separation, in either PDF or
TIFF format.

In the example below, processing a file containing the lime green Esko star generates unscreened
files for the Cyan, Yellow and Black separations.

Task Parameters

In the Device field, select the imaging device that you configured.

Then use the selector pane at left to show more settings to fill in. See:

• General on page 1176,

• Transformations on page 1177,

• PDF Objects on page 1178,

• Document Inks on page 1179,

• Output on page 1179,

• Separations on page 1187,

• Summary on page 1193.

2.7.71 Import Image

The Image Import task is able to convert pixel images to native CT or LP file format. This task can
optionally convert RGB images to CMYK for easier processing in workflow. You can also convert
CMYK CTs with Inkswitch or BlackSmith.
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Mask/Path Settings

Use these toggles to control the conversion of pixel masks and clipping paths. They can be removed
or kept during conversion.

• Select the Keep Pixel Masks toggle to keep the original pixel mask.

• Keep the original Clipping Path, the resulting file will contain the original clipping path.

Preview Settings

• Create a Thumbnail image
• Create a Preview

Keep Indexed

If the colors in the image are reduced (indexed) and you want to keep it like that, use this toggle.

RGB Conversion Method

You may want to convert the image you want to import to a CMYK colorspace. There are two ways
to convert to CMYK.

• Device Link Profile

This allows you to select a Process Link, made in Color Engine Pilot. This option will give you
the best result.

Link profiles describe a transformation from 1 device dependent color space to another.

This is actually a concatenation of a forward transformation of 1 profile and a backward
transformation of another profile.

This means that all other options will be grayed out as the Link Profile takes complete care of
the color management.

• Device Profile

This enables you to select a source and a destination (proofer) process.

Use this option if you did not make a Process Link in Color Engine Pilot but you still want a better
color result. The process links will be made for you.

RGB Profile: Source profile used for conversion.

CMYK Profile: Destination profile used for conversion.

Rendering intent: Possibilities are:

• Perceptual: This will result in no background simulation (white of reference colorspace is
mapped on white of destination colorspace). Use this option if you don't care too much about
an exact color match but you want the pictures at least to look nice on your proofer. It will give
a visually pleasing result. If the gamut of the source is wider than the proofer, the entire gamut
is shrunk so that it fits inside the gamut of the proofer.

• Relative Colorimetric: Use this option if you do not want any background simulation. The
white point of the source will be mapped on the white point of the destination process. This
rendering intent takes into account the ability of the human eye to adapt to the surrounding
white.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent
will map saturated colors on saturated colors.
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• Absolute Colorimetric: Use this option if you want background simulation and you want an
exact color match, including the paper simulation.

Note:  For BGCMS profiles Perceptual, Relative Colorimetric and Saturation are in fact identical.

2.7.72 Import JDF Layout

The JDF Imposition task handles JDF files generated by JDF compliant imposition programs. It
imports the JDF layout into Esko native files.

The JDF file is a low level JDF file, which means that the delivered imposition is a flat imposition and
thus no longer editable. Automation Engine will handle this kind of JDF file as a GRx file.

The JDF file contains two parts:

1. A page list, referring to PDF or PostScript files.
2. Geometrical layout info.

The JDF Imposition task converts all PDF and PostScript files and creates 1 GRO file per sheet side.

This tickets’s tabs are identical to the Normalize PostScript/PDF/Illustrator 8.0 File ticket’s tab, and
the Sheets tab differs a little from the Sheets tab of the Export Imposition to GRI File task, but has
the same functionality.

Sheets

Indicate of which pages you want to import the JDF layout. For the front as well as the back sheets,
you can either select all pages or choose for a range of pages.

2.7.73 Import JDF Step & Repeat

With this task, you can generate a Step & Repeat (PDFPLA) file from a JDF file you received, probably
from a business (planning) system.

You can launch this task on:
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• a JDF file containing a link to a CAD file and PDF station files, to perform CAD-based Step &
Repeat,

• a JDF file containing a link to PDF station files, to perform tabular Step & Repeat.

Note:  The JDF ticket you use should always contain a list of the input files.

General

SmartMarks

Select your desired SmartMark (created in PackEdge) in the list, or enter a SmartMark name. You
can use SmartNames to define your SmartMark name.

Load Mark Set in Bottom Layer

Select this if you want to make sure the marks are positioned in the bottom layer, "behind" the
graphics.

Limit Bleed to

Use this option to limit the bleed to a specific distance.

Note:  The bleed mask is created by spreading the die shape.

Plate Setup

Use Sheet Size from JDF

You can either use the sheet size defined in your JDF ticket, or define a Sheet Size yourself.

When defining a sheet (or a plate) size, choose the Unit to use: either mm or inch.

Use Plate Size from JDF

You can either use the plate size defined in your JDF ticket, or define a Plate Size yourself.

When defining a plate size manually, you also need to define the Sheet Offset and the Sheet Position
on Plate.

Sheet Offset

Define by how much the sheet should be offset from the plate corner, horizontally and vertically.

Sheet Position on Plate

Position the sheet on the plate by dragging and dropping the small red rectangle (the sheet) to the
right position on the big blue rectangle (the plate).

Note:  Take into account the point of Origin from which the repetition will be built. This is defined
in the JDF and is always bottom left.

Shrink

Enter horizontal and vertical shrink values to compensate for printing distortion (especially in Flexo).
The default value is 100 both horizontally and vertically (no distortion compensation).
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Screen Registration

Select this option to restart the screening for each unit (use this when you need each unit of the Step
& Repeat to have the exact same screening, for example in a workflow aimed at printing stamps).

Attention:  This setting is only supported by FlexRIP / Imaging Engine. It will be lost if you
use another PDF RIP on your file.

Tip:  You can use SmartNames in all the input fields of this tab. Just click in a field then click the
Insert SmartNames button.

CAD Options

Mapping

If you are working with DFX, you can map your DFX layers, line styles and color numbers to ArtiosCAD
line styles (for example cut lines, crease lines...). You need to create a mapping in Plato or PackEdge,
then select it here.

Fore more information, please see the Plato / PackEdge documentation.

CAD Style

Use this to map the ArtiosCAD line styles of your CAD file (cut lines, crease lines...) to Plato /
PackEdge inks. You need to create a CAD style in Plato or PackEdge, then select it here.

Fore more information, please see the Plato / PackEdge documentation.

Include CAD info for Digital Flexo Suite

If you are using the Digital Flexo Suite, select this option to write technical cutting and creasing
information into the header of the output file.

This information will be embedded in the LEN files output by the FlexRIP, and used in the Digital
Flexo Suite to help visualizing the output.

Use Blank Position from JDF

You can either use the blank position defined in your JDF ticket, or position the blank on the sheet
yourself.

Note:  The blank is a representation of the single design that will be stepped & repeated. It is
equivalent to the one-up without the artwork (or the bounding box of the one-up).

Position Blank on Sheet

Position the blank on the sheet by dragging and dropping the small red rectangle (the blank) to the
right position on the big blue rectangle (the sheet).

Note:  Take into account the point of Origin from which the repetition will be built. This is defined
in the JDF and is always bottom left.

Blank to Sheet Offset

Define by how much the blank should be offset from the sheet corner, horizontally and vertically.
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Note:  When defining the blank to sheet offset, choose the Unit to use: either mm or inch.

2.7.74 Import JDF Stripping

One of the typical components of a business system (MIS-ERP) is production planning. This is where
it is determined how an order (a job) will be produced.

Taking into account for example the presses available, folding and cutting machines, a production
plan will be worked out.

This may not necessarily be the cheapest way, but it will certainly be the most efficient way at that
particular moment (for example because a certain press is in maintenance, another - less economical
press - will be used.)

The JDF file that is sent to the prepress department contains a lot more information than only
imposition information.

This valuable imposition information, like for example sheet and signature information will be retrieved
from the JDF file, in other words, the file will be stripped.

A JDF file can contain several parts, for example cover, pages, insert... Each part has to be stripped
separately. You can also choose to strip all parts in one go. Select 'All parts from the list'.

The result of the stripping task is an empty imposition (IMP) file.

All signatures and positioning are decided upon, as well as a number of other valuable imposition
settings that are not visible in the Stripping task, like for example finished and unfinished page
properties.

Note that these parameters are fixed in the JDF file and can therefore not be modified interactively.

The JDF Stripping task retrieves all relevant imposition information from the JDF file.
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Sheets

• Name indicates the name of the sheet.

• WorkStyle indicates the work style for the particular sheets: Sheetwise, Work&Turn,
Work&Tumble, etc.

• Paper shows the dimensions of the paper on which will be printed.

• Press indicates the type of press on which the sheet will be printed.

All of the above settings are retrieved from the business system (JDF file from an MIS / ERP).

• Plate settings have to be determined by the operator.

If no specific plate is selected, the values for the Master are taken into account, which is Auto
in the example above.

Auto refers to the value specified for Auto in the Other tab.

Master indicates that the same plate as the one indicated on Master level will be used.

In the example below, the plate SM72x102 V_tumble will be used for both sheets.
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Assembly

• Type: is determined by the business system (MIS / ERP).

• Template: The operator has to map the correct template to the assembly type.

Other

Auto Rules

Here you can indicate which plate or assembly template should be used when 'Auto' is selected in
the Sheets tab.

Clicking the SmartNames icon  opens the list of available SmartNames.Click the SmartNames
category to see the SmartNames that have already been created. For each SmartName, a description
is given in the description area at the bottom of the dialog.
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Positioning of signatures

Indicate how the signature should be positioned on the paper.

• Vertical

• Expert: positions the signature so that the bleed margin coincides with the gripper in a turn
workflow. In case of a tumble workflow, the signature will be positioned in the center of the
paper.

• Center in paper
• Use bottom of paper as origin

• Horizontal

• Expert: In case of a horizontal positioning, the Expert option is identical to the Center in paper
option.

• Center in paper

• Use left side of paper as origin
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Search for productID of plates: check this toggle if you want to have the JDF file searched for Plate
Product IDs. You can then use this Plate Product ID as a text or barcode mark on the plate.

2.7.75 Integrate via External Hot Folder

The Integrate via External Hot Folder task allows you to integrate external prepress applications
into your workflow tickets. The only requirement is that the external system works with hot folders.

1. In the Integrate via External Hot Folder ticket, you define the location of the hot folder used by
the external application, as well as the Result sub-folders in which the external application will
output processed jobs (the OK Folder), failed jobs (Error Folder) or jobs that produced warnings
(Warnings Folder).

2. When you process a job with this ticket, Automation Engine copies the files to the external hot
folder.

3. The external application picks up the files in its hot folder and processes them. The processed
files are saved in the sub-folder that matches the processing result: OK, Warning or Error.

4. Automation Engine monitors the OK, Warning and Error folders for any files that have been
processed.

5. If it detects a file in the OK folder, Automation Engine copies it to the Output folder defined in the
Integrate via External Hot Folder ticket, and continues its workflow. Depending on your settings,
Error or Warning files might also be copied into the Output folder, or they might be deleted.



2
Automation Engine

363



2
Automation Engine

364

Note:

In the Error area of the ticket, you can define an amount of time after which the external processing
should be considered as failed. To do this, enable the option Error when no result after ... and define
a time period (for example, you could enter one hour, a number of days, or even a specific date).

2.7.76 Integrate with WebCenter

This task is documented in the chapter Integrating with WebCenter. Find a direct link here.

2.7.77 Interact with Database

This task is documented in the chapter Integrating with External Systems. Find a direct link here.

2.7.78 Interact with Web Service

This task is documented in the chapter Integrating with External Systems. Find a direct link here.

2.7.79 Join

This Workflow Control is documented in the chapter "Workflows". See Fork and Join on page 1032.

2.7.80 Join XML Files

This task is documented in the chapter Integrating with External Systems. Find a direct link here.

2.7.81 Link Product To Job

This task is documented in the chapter Products on page 876. Find a direct link here.

2.7.82 Make Plate on CDI

The Make Plate on CDI task can send ripped data (.LEN, .tiff files) directly to the Digital Flexo Suite
(DFS) (version 10.1 and later).

The Digital Flexo Suite drives a Cyrel Digital Imager that will image a flexo plate using the ripped data
from the Make Plate on CDI task.

Note:  the integration between Automation Engine and the DFS uses JDF. This does not require you
to buy any JDF-license from an optional integration module!
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Advantages of Using the Make Plate on CDI Task

• You can enforce the plate type through job parameters (that can be filled in from a business
system) to reduce errors.

• It automates your plate-making workflow: ripped files are automatically pushed to the Digital Flexo
Suite operator (no need to FTP those files, or browse through a file server to get them).

• You can get feedback about the waste per plate.

• It builds up a Flexo Plate History, which makes it easier to remake a plate if necessary.

Settings

Destination

Enter the Address of the computer on which the Digital Flexo Suite software is installed.

It will typically take the following shape: http://<computer name>:4410/JDFP/JMF.

Priority

Choose the Priority you want to give to the task: Low, Normal or High.

Choose a Due Date: either choose Job Due Date, or choose Other... and pick the due date yourself.
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Plate

Tip:  You can use job parameter SmartNames to retrieve the plate information from the job.

Enter the plate Manufacturer and Type.

Select the Media Type you want to use (Plate or Sleeve).

• If you want to expose a Plate, enter its Thickness.

• If you want to expose a Sleeve, enter its Width and its Circumference.

Enter the Relief Thickness.

XML Notifications

You can use the standard Automation Engine notification mechanism to create an XML file containing:

• a history of your Job's different statuses in the Digital Flexo Suite and on the CDI,
• information useful for billing (total area used on the plate, waste...).

Once the task is finished, this XML file will be saved in the location you defined. Your MIS or ERP
system can pick it up and use that information.

Note:  Depending on the capabilities of that external system, other techniques might be preferred.
Learn more in Integrating with External Systems on page 1228.

Defining an XML Notification

1. Click  in the Make Plate on CDI ticket.
2. Click Add in the Notification dialog.
3. In the Notification Rule Editor, define your notification as follows:

Note:  Using [Job URL]/Notification/[ShortID].xml as Location saves your XML file:

• in a subfolder of the Job Folder called Notification,

• with the run ID of the task ([ShortID], visible in the Tasks pane) as name.

See Notifications on page 175 for the basics of defining notifications.
4. Click OK in the Notification Rule Editor and the Notification dialog.
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See Feedback in the XML Notification File for an example of a file generated by an XML notification.

The Make Plate on CDI Task in a Workflow

The Make Plate on CDI task is commonly used in combination with a RIP ticket (for example RIP
to CDI LEN File) in a workflow.

1. The workflow is launched on the one-up.
2. The one-up is stepped and repeated.
3. The Step and Repeat file is ripped.
4. View Data is created for the ripped file.
5. The operator gets a To Do asking him to view the ripped file and check if it's OK.
6. If the file is OK, the Make Plate on CDI task sends the ripped file to the Digital Flexo Suite.

After this the Digital Flexo Suite operator:

1. gets the file automatically in the Digital Flexo Suite,
2. places it on a virtual plate using the Merger application,
3. exposes the flexo plate when it is full enough.

The Automation Engine operator gets feedback from the Digital Flexo Suite at each point. See
Feedback on page 367 for details.

Feedback

When using the Make Plate on CDI task, you can receive feedback in two ways:

• XML notifications that can be used by your MIS - ERP system.
• Live status feedback in the Pilot's Tasks and CDI views.

In the XML Notification File

In the XML file generated by the Make Plate on CDI task notification, you can see:

• A description of how a separation was processed by the Digital Flexo Suite.

For example:

<MESSAGES>
<COMMENT Type="INFO">Fetching (XMP) bitmap info for strawberry_123.len</
COMMENT>
<COMMENT Type="INFO">Initializing ImageSetting Process for
 strawberry_123.len.</COMMENT>
<COMMENT Type="INFO">Logging JDF file: file://begeloppem/
AutomationEngineTmpFolder/14951_temp_21782062_imagesetting.jdf</
COMMENT>
<COMMENT Type="INFO">Doing SubmitQueueEntry towards http://
begeloppem:4410/JDFP/JMF.</COMMENT>
<COMMENT Type="INFO">03:18:38 Remote QueueEntry ID:
 CDI1_@_20110620151838_@_171</COMMENT>
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<COMMENT Type="INFO">03:18:39 CDI state change(NEW): NEW job in Merger
 JDF list</COMMENT>
<COMMENT Type="INFO">03:24:26 CDI state change(MERGE): Job in Merge
 editor</COMMENT>
<COMMENT Type="INFO">03:24:58 CDI state change(CDI): Job Sent to the CDI
 Queue</COMMENT>
<COMMENT Type="INFO">03:25:10 CDI state change(RUN): Job Running on the
 CDI</COMMENT>
<COMMENT Type="INFO">03:25:29 CDI state change(DONE): Job Completed on
 CDI</COMMENT>
<COMMENT Type="REPORT">&lt;HTML&gt;03:25:52 Received the
 processed JDF File: &lt;A href="file://begeloppem/
AutomationEngineTmpFolder/14951_temp_21782135_imagesetting.jdf"&gt;c:
\fastlane\data_v100\Tmp\14951_temp_21782135_imagesetting.jdf&lt;/A&gt;
 &lt;/HTML&gt;</COMMENT>
</MESSAGES>

with time stamps that your MIS / ERP system can use:

<StateInfo>
<CDI.NEW>2011-06-20T13:18:39.50Z</CDI.NEW>
<CDI.MERGE>2011-06-20T13:24:26.44Z</CDI.MERGE>
<CDI.CDI>2011-06-20T13:24:58.70Z</CDI.CDI>
<CDI.RUN>2011-06-20T13:25:10.39Z</CDI.RUN>
<CDI.DONE>2011-06-20T13:25:29.63Z</CDI.DONE>
</StateInfo>

• Statistics and valuable accounting information.

For example:

<PlateInfo>
<Plate.PlateJobId>20jun15_24_49_stry_Kstr945str1@76298443584</
Plate.PlateJobId>
<Plate.MediaType>Plate</Plate.MediaType>
<Plate.TotalArea>263537.4</Plate.TotalArea>
<Plate.UsedArea>26356.48514455161</Plate.UsedArea>
<Plate.TotalUsedArea>79069.45543365483</Plate.TotalUsedArea>
<Plate.Manufacturer>Flint</Plate.Manufacturer>
<Plate.Brand>ACE_114</Plate.Brand>
</PlateInfo>

Monitoring the Waste per Plate

Waste per plate can be monitored using the PlateJobId (unique to each plate).

You can calculate the total amount of waste per plate as follows: TotalArea - TotalUsedArea

Monitoring the Cost per Separation

To calculate the plate cost per separation, multiply the UsedArea value by the cost per square unit.

To take into account the plate waste, you can use this: (UsedArea/TotalUsedArea) x Plate Waste.

In the Tasks View

After running the Make Plate on CDI Task, you will get detailed feedback in the Tasks view (and
the Tasks pane of the CDI view in Job mode).

You will see the following statuses:

• NEW job in Merger JDF list,
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• Job in Merge editor (while the Digital Flexo Suite operator is placing the job files on the virtual
plate),

• Job Sent to the CDI Queue,

• Job Running on the CDI,

• Job Completed on CDI.

Once the plate is made, you will see a green check  (or a red cross  if there was an error).

In the CDI View

The CDI view shows all the files sent to the Digital Flexo Suite and used to image a flexo plate on
a Cyrel Digital Imager.

You can view the flexo plates created for all jobs (in Job Overview mode) or for a particular job (in Job

mode). You can also use the filters to only view certain plates (or click  to define your own filters).

You can double-click an entry in Job Overview mode to see all the plates and LEN files
corresponding to that job in Job mode.

You can also select an entry to view its Details (in Job Overview mode), or the related task (in Job
mode) at the bottom of the window.

For each plate, you can see valuable:

• administrative information (Order ID, Customer Name...),

• technical information (plate Manufacturer, Type and Thickness, imaging Device),

• production information (Launched date, Due Date, Priority...),

• accounting information (UsedArea and Waste).

Tip:  Go to  View > Select Columns in 'FlexoPlates'...  to pick the information to show or hide.
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You can also see the plates' status in real time.

Statuses

In Job Overview mode, you will see the following statuses:

• Queued on CDI,

• Done or Done, with errors, or Done, with cancellations.

You can also see the number of plates that are ready in the Done column. The status will be Queued
on CDI until all plates are ready.

In Job mode, you will see:

• NEW job in Merger JDF list,

• Job in Merge editor (while the Digital Flexo Suite operator is placing the job files on the virtual
plate),

• Job Sent to the CDI Queue,

• Job Running on the CDI,

• Job Completed on CDI,

• Exposed,

• Error or Cancelled if applicable.

Checking the Files

In the CDI view, you can:

• Open the LEN file(s) in the Viewer: right-click the entry (in Job or Job Overview mode) and select
View.

You can then show / hide separations using the Viewer's Channels panel.
• Go to the LEN file(s) in the Files view:

• in Job Overview mode, right-click the entry and select Go To Folder.

This opens the job folder and the subfolder containing the LEN files.
• in Job mode, right-click the entry and select Go To File.

This opens the job folder and the subfolder containing the LEN files, and selects the LEN file.

Re-exposing the Plate

If one or several of the plates need(s) to be re-exposed (it turned out wrong, or broke coming out of
the CDI or after a number of print runs), it can easily be sent to the Digital Flexo Suite again.

1. Use the filters to find the right (set of) plate(s).

2. Right-click the desired plate entry and select Go To Workflow to open the workflow used to
process the file in the workflow editor.

3. Right-click the workflow step where you want to relaunch processing from, and select Relaunch.

For example,

• if the resolution of the LEN files is wrong, relaunch from the RIP.

• if the plate broke, relaunch from Make Plate on CDI.
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Attention:

Make sure you have kept the LEN files if you are relaunching the workflow after the RIP
step!

We recommend you either:

• Save them somewhere consistent and easy to find in your job folder structure, for
example using:

• Save them in an external location if you have the habit of quickly deleting jobs (but if
you delete the job without deleting its folder and files, you can still store them in your
job folder).

2.7.83 Manage Color

With this task, you can:

• convert a CMYK file to another CMYK profile,
• reseparate a CMYK file so that it contains less CMY and more K, while keeping the image looking

the same,
• both convert and reseparate your CMYK file.

This task takes PDF and Normalized PDF files as input. When working with regular PDFs, it will
automatically normalize them using the Normalize ticket set in the Configure tool (see Processing
Preferences on page 674).

For more information about Normalized PDFs and automatic normalization, see PDF Normalization
in Automation Engine on page 115.

Converting to another CMYK Profile

You can convert a file to another CMYK profile if for example you want to print it on a different
substrate, on a different press, or even with a different printing process (offset, digital printing...).

In Actions, select Convert color space to convert your input file to another CMYK profile. This
displays extra parameters below it.

1. Choose what to use as a source profile when converting your input file:

a) In Source CMYK Profile, select the source profile to use for the conversion in case you are
not using your input file's profile.

This can be an Esko or an ICC profile and you can use a SmartName (resolving to the full
profile name) to set it. By default this is ISOcoated_v2_eci.icc.

b) If your input file has a CMYK profile and you want to use it for the conversion, select Use
document profile if available.
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When processing a file without a profile, the task will use the Source CMYK Profile you
selected.

2. Choose what Destination CMYK Profile to convert your file to.

This can be an Esko or an ICC profile and you can use a SmartName (resolving to the full profile
name) to set it. By default this is ISOcoated_v2_eci.icc.

3. Choose the Rendering Intent to use when converting the colors.

This can be:

• Perceptual: This rendering intent shrinks the image's gamut into the destination gamut. It
modifies all the colors, but relatively to each other, so it keeps an overall harmony.

It does not perform any background simulation: it maps the source profile's white point to the
destination paper’s white (so no ink is used when printing white).

Use this option if you don't care too much about an exact color match but want a visually
pleasing result.

• Relative Colorimetric: this converts the colors that fall inside the destination gamut to the
destination profile, and converts each color falling outside the destination gamut to the closest
in-gamut color.

It does not perform any background simulation: it maps the source profile's white point to the
destination paper’s white (so no ink is used when printing white).

Relative Colorimetric is a good choice for photographic imagery, because it preserves color
relationships without sacrificing color accuracy.

It generally gives less good results when converting images with gradations or blend modes.

• Saturation: This rendering intent saturates the in-gamut colors, and converts each out-of-
gamut color individually to the closest in-gamut color.

This means that close out-of-gamut colors may be converted to the same in-gamut color (the
image will then lose several shades).

Use this option if you care more about saturated colors than color accuracy, for example if you
are working with cartoons / comics, business graphics, or you want to improve weak images.

• Absolute Colorimetric: this converts the colors that fall inside the destination gamut to the
destination profile, and converts each color falling outside the destination gamut to the closest
in-gamut color.

This rendering intent simulates the source white within the image (background simulation), so
that if for example the source profile is designed for a newspaper, its white will be slightly grey,
and the whole image will have a slight grey undertone.

This rendering intent is mostly used for proofing (on-screen or on a proofing device), to
reproduce what the image's appearance will be on the final paper.

If accidentally printed on the final paper with this rendering intent, the image will look dull and
darker!

Absolute Colorimetric is the most accurate rendering intent if the image's color profile contains
correct white point information: it can then give an exact color match (for in-gamut colors).
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However, it maintains color accuracy at the expense of preserving relationships between
colors: when converting to a smaller gamut, two colors that are different in the source gamut
may be converted to the same color in the destination gamut.

Note:

• When converting to an ICC destination profile, you can choose from the four rendering intents
listed here.

• When converting to an Esko destination profile, you can choose either Relative Colorimetric
or Absolute Colorimetric.

You can also set the rendering intent with a SmartName, resolving to 2 (for Perceptual), 3 (for
Relative Colorimetric), 4 (for Saturation) or 5 (for Absolute Colorimetric).

4. Select what objects in your file you want to convert in Apply on. This can be either:

• Images and Linework,
• Linework only,
• Images only.

You can also set this with a SmartName, resolving to images_and_linework, linework_only
or images_only (SmartNames are case insensitive).

5. Select Keep registration color if you use marks in your file and if you don't want them to be
converted to the new profile (you want them to stay 100% of each CMYK color).

6. Select Flatten document if you are experiencing unexpected results in color conversions (if after
conversion the color of some blend modes or other objects on top of each other looks different).

Note:  We recommend you only use this in case of conversion problems, as it will remove any
transparencies in your file.

Reseparating your CMYK File

Reseparating a file is replacing some amount of Cyan, Magenta and Yellow in the file (that would give
grey) by a certain amount of Black, giving the same grey color.

Objects that are only Cyan, Magenta or Yellow (or only two of these colors) are kept as they are.

This can help you save on CMY inks, have a more stable output (less risks of color casts in neutral
areas) or have more detail in the shadow areas.

In Actions, select Reseparate to reseparate a CMYK file so that it contains less CMY and more K,
while keeping the image looking the same.

This displays extra parameters below it.

1. Choose the profile to use when reseparating your input file:

a) In CMYK Profile, select the profile to use in case you are not using your input file's profile.

This can be an Esko or an ICC profile and you can use a SmartName (resolving to the full
profile name) to set it. By default this is ISOcoated_v2_eci.icc.

b) If your input file has a CMYK profile and you want to use it for reseparating, select Use
document profile if available.

When processing a file without a profile, the task will use the CMYK Profile you selected.
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2. Select what type of reseparation you want to do in Purpose:

• Ink Saving replaces as much CMY as possible by Black.

This is a good choice if you want to save on CMY inks.
• GCR replaces CMY by Black in the grey and chromatic areas.

This is a good choice if you want to avoid color casts in the grey areas, and to have more
detail in the shadow areas.

This is selected by default.
• UCR only replaces CMY by Black in the neutral areas.

This is a good choice if you want to avoid color casts in the grey areas.

You can also set this with a SmartName, resolving to ink_saving, GCR or UCR (SmartNames
are case insensitive).

3. In Range, choose how much of the CMY inks that can be replaced by Black you want to actually
replace.

This depends on the Purpose you chose:

• For Ink Saving, this is how much CMY inks in all areas of the file you want to replace.

• For GCR, this is how much CMY inks in the grey and chromatic areas of the file you want
to replace.

• For UCR, this is how much CMY inks in the grey areas of the file you want to replace.

Note:  You can set all percentage values in this task with SmartNames.

4. In Total Ink, select the maximum amount of ink (CMYK) that you want to print.

If you don't limit the amount of ink, you can get a maximum of 400% (100% Cyan + 100% Magenta
+ 100% Yellow + 100% Black), which tends to cause problems on most substrates (slow drying,
web growth, or even a risk of tearing).

Additionally, limiting the maximum amount of ink used can make printing jobs less expensive.

The maximum percentage of ink you should use depends on your printing process and substrate.
For example for newsprint, you may only want to have a maximum of 240%, while you may be
able to use 280 to 320% on a glossy substrate.

The default Total Ink percentage set in the task is 310%.

5. Define the minimum and maximum amount of Black that you want to have in your output file:

a) In Start K, define from which (minimum) final Black value you want to start reseparating.

If replacing CMY by Black in a certain color gives a Black percentage lower than this, the CMY
won't be replaced.

This is to avoid having really small Black dots, which can be prone to high dot gain, making
them less stable than the equivalent CMY dots.

b) In Max K, define until which (maximum) final Black value you want to start reseparating.

If replacing CMY by Black in a certain color gives a Black percentage higher than this, the
CMY won't be replaced.

This is to avoid having too dark shadows and losing detail.
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6. Select what objects in your file you want to reseparate in Apply on. This can be either:

• Images and Linework,
• Linework only,
• Images only.

You can also set this with a SmartName, resolving to images_and_linework, linework_only
or images_only (SmartNames are case insensitive).

7. Select Keep registration color if you use marks in your file and if you don't want them to be
reseparated (you want them to stay 100% of each CMYK color).

8. Select Flatten document if you are experiencing unexpected results after reseparating a file (if
after reseparation the color of some blend modes or other objects on top of each other looks
different).

Note:  We recommend you only use this in case of reseparation problems, as it will remove any
transparencies in your file.

Converting and Reseparating your File

When converting and reseparating your file(s) at the same time, you need to:

1. Select the Source profile, Destination profile and Rendering Intent for the conversion.

2. Select what type of reseparation you want to do and set the appropriate options.

3. Select on which objects to perform both the conversion and the reseparation, whether to keep
objects in registration color untouched, and whether to Flatten your file.

Note:

• When using one Manage Color task to both convert and reseparate, the conversion will try to
keep the black channel unchanged, so as not to affect the reseparation.

• When using two Manage Color tasks after each other, one for conversion and one for
reseparation, this will not be the case, so the output will be different.

If you want to perform both conversion and reseparation on your file(s), we recommend you use one
Manage Color task for both instead of a task for each in your workflow.

2.7.84 Manage Milestone

The Manage Milestone task is documented here in the chapter on Jobs on page 828.

2.7.85 Manage Product Status

This task is documented in the chapter on Products on page 876. Find a direct link here.

2.7.86 Map Data

This task is documented in the chapter Integrating with External Systems. Find a direct link here.
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2.7.87 Mark as Proof

Note:  This task is used only in page workflows.

The Mark as Proof ticket can only be used in a workflow, for example in combination with the Proof
(Imposition) to PDF File ticket. It is used to make the proofs appear in the Proofs View. Automation
Engine offers a ready-made Export Imposition to PDF File workflow ticket, which contains the export
ticket, linked to the Mark as Proof ticket.

The Proof Set Name will by default be indicated as [File].[File Type], but can be adapted with
SmartNames or hard text.

2.7.88 Mark File (link)

This Workflow Control is documented in the chapter "Workflows". See Mark File and Select Marked
File on page 1029.

2.7.89 Merge PDF Files

The task Merge PDF Files can be used to combine multiple PDF files into one single PDF.

The task can accept multiple native PDF files to produce a single native PDF file, or a multiple
normalized PDF Files to produce a normalized PDF File.

Take the following notes into account when using this task:
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Note:

• Normalized and native PDF files cannot be mixed together.
• The page sizes of the normalized PDF files must be the same.
• The output PDF will only be normalized if all the input files are normalized files and have the same

media and trim boxes. In case there is a mismatch in size, the task will fail.
• For normalized PDF files, the XMP information of the first file will copied into the resulting PDF

file. Then it will be updated with information from the other normalized PDF files.
• In workflow context, all pages of all incoming PDF files are added in the same order as the inputs

of the task in job context. To control the order of the files, use the Sort Workflow Control.

2.7.90 Modify Workflow Parameter Values

This Workflow Control is documented in the chapter "Workflows". See Modify Workflow Parameter
Values on page 1015.

2.7.91 Normalize PDF File

Colors

Use the Colors tab to define the conversion settings needed when converting the document's (non-
process) colors during Normalization.

Note:  The conversion is done by Esko's Color Engine.

Objects With Profile Tags: In this parameter, choose how to convert non process color images that
have an embedded ICC profile. Choose either:

• Ignore Tag to use the Default RGB Profile or Default Gray Profile set in this tab to convert the
RGB or gray images. This disregards the images' own profiles, and is the default option.

• Convert Using Profile Tag to use the images' own profiles to convert them to CMYK.

Rendering Intent

• Relative (No Background): Use this option if you do not want any background simulation. The
white point of the source will be mapped on the white point of the destination process. This
rendering intent takes into account the ability of the human eye to adapt to the surrounding white.

• Perceptual: This will result in no background simulation (white of reference colorspace is mapped
on white of destination colorspace). Use this option if you don't care too much about an exact
color match but you want the pictures at least to look nice on your proofer. It will give a visually
pleasing result. If the gamut of the source is wider than the proofer, the entire gamut is shrunk so
that it fits inside the gamut of the proofer.

• Absolute (Background): Use this option if you want background simulation and you want an
exact color match, including the paper simulation.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent
will map saturated colors on saturated colors.

Default CMYK Profile: Select the default profile to use for CMYK objects without an embedded
color profile. It will be used as a source profile for colorspace conversions.
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You can choose any CMYK profile in the Color Engine database.

Default RGB Profile: Select the default profile to use for RGB objects without an embedded color
profile. It will be used as a source profile for colorspace conversions.

You can choose any RGB profile in the Color Engine database.

Default Gray Profile: Select the default profile to use for gray objects without an embedded color
profile. It will be used as a source profile for colorspace conversions.

You can choose:

• any gray profile in the Color Engine database,
• Convert to Black Channel, if you want your grayscale object to only have a value in the Black

separation when outputting it to CMYK.

Output Color Profile: Enter the colorspace of the output device (for example proofer or press) in
this parameter.

You can choose any CMYK profile in the Color Engine database.

Separations

Use the Separations tab to define ink specifications for the input file. These ink specifications will
be used when you edit that file with an Esko editor.

Note:  The settings in this tab only affect Normalized PDF output. They are ignored if the file is output
as a regular PDF.

1. Choose your Preferred Ink Book.

When you type an ink name in the table, Automation Engine will first look up its color information
(CMYK, RGB, or LAB values), or ink type (Technical, Varnish, Opaque...) directly in the PDF.

If it cannot find it there, it will look it up the Preferred Ink Book you define here.

For example, if you type 154 as ink name, and your preferred ink book is Pantone Colors
Uncoated, Automation Engine will automatically suggest the PANTONE 154 Uncoated ink.

2. Enter the name of the first ink to define in the Ink Name column.
3. The Ink Book column shows the first ink book containing this ink (or your Preferred Ink Book if

it contains the ink). To select another ink book, click the ink book name.
4. If the Ruling, Angle and Dot Shape information are defined for this ink, they will be shown

automatically.

If they aren't, you can enter them manually.

Note:  You can also specify Default Values to use when a ruling, angle or dotshape is not
specified.

5. If the Ink Type shown is not correct, you can click it to change it.
6. Do the same for the remaining inks you want to define.
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7. If desired, you can change the ink order using the Move Up and Move Down buttons.

2.7.92 Normalize PostScript / PDF / Illustrator 8.0 File

Note:

• The PostScript / PDF interpreter extracts fonts embedded in PostScript, Illustrator and PDF files.
Only Type 1 fonts embedded in a PostScript / PDF file will be extracted.

The extracted fonts will be installed locally automatically.

• For copyright reasons extracted fonts can only be used to view and output the particular
PostScript, PDF or Illustrator job containing the font.

Any other use of that font (for example editing the text) requires a license of that font.

Tip:  When using an XMP XPath SmartName in the Output field of a Normalize PostScript / PDF /
Illustrator 8.0 File ticket, and the XMP XPath cannot be resolved (because there is an error in the
SmartName or, for some reason, the queried data cannot be found), the output file is saved in a /
xmp_unresolved subfolder.

Pages

Select All Pages or specify a Range of pages.

Split up a multi-page file

Check the box to divide the original multi-page PostScript file into smaller parts. You define the
amount of pages to open (of the specified pages or range). What you need to know:

• Each part is stored as a separate Normalized PDF file. It is either stored locally or stored in the
Output Directory.
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• Each part is stored with the name of the imported PostScript file followed by _001, _002,
_0001_001... or it gets the Output Name.

Compose a Group of CT Images into 1 CT Image

Some ArtPro files have tiled CTs, those are CTs which are actually divided into a number of little CTs
(tiles). Some jobs are so large that there are thousands of these little CTs.

Select this toggle to merge the tiles into one CT to improve the editability of the Normalized PDF
and to optimize further processing.

This option is selected by default, it doesn't matter if you import a file with no tiled CTs.

Note:  When errors occur when a PostScript file is imported (for example a font is not found), the
Merge Tiled CTs to one CT will not be performed.

Merge Separated file to Composite

Merges separated single-page and multi-page PostScript or PDF files to a composite file.

Optimize Merged File

This option optimizes the merged file. This is useful when you need to edit the imported file. This
option becomes available when 'Merge Separate File to Composite Page' is activated.

Note:  When errors occur when a PostScript file is imported (for example a font is not found), the
Optimize Merged PostScript File will not be performed.

Password: You can enter a password for protected PDF files.

Color Management
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Destination Color Space

Here you define what colorspace the opened/imported document will have.

Colorspace:

• CMYK
• Grayscale

Destination Profile: choose a color profile from the list. Currently only CMYK and Grayscale profiles
are supported, you can choose between standard ICC profiles and Esko profiles made in Color
Engine Pilot.

Use PDF Output intent if available: in some PDF files, the PDF Output intent is defined (for example
PDF/X-3). (The output intent is the intended output color space.)

If you want to use the color space as defined in the output intent, select this option. If you selected
it for a file without PDF Output intent, the chosen Destination Profile will be used.

Rendering intent

• Relative (No Background): Use this option if you do not want any background simulation. The
white point of the source will be mapped on the white point of the destination process. This
rendering intent takes into account the ability of the human eye to adapt to the surrounding white.

• Perceptual: This will result in no background simulation (white of reference colorspace is mapped
on white of destination colorspace). Use this option if you don't care too much about an exact
color match but you want the pictures at least to look nice on your proofer. It will give a visually
pleasing result. If the gamut of the source is wider than the proofer, the entire gamut is shrunk so
that it fits inside the gamut of the proofer.

• Absolute (Background): Use this option if you want background simulation and you want an
exact color match, including the paper simulation.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent
will map saturated colors on saturated colors.

Set Document Profile

A Document Profile is the color space of the process inks used in the document.

• Always: you can 'tag' a Normalized PDF file with its Document Profile. This means that the file
'knows' what its Document Profile is, which may make further color conversion throughout a
workflow more correct.

If you selected the Use PDF Output intent if available option, the Document Profile will be the
same as the PDF Output intent (if the imported file had one).

• From PDF File: the Document Profile is taken from the PDF file, if there is an output intent defined
in the PDF file (this option is only available when the Use PDF Output Intent option is selected).
If there is no Output Intent defined in the PDF file, then the Document Profile is not set (untagged).

• Never: the Document Profile is not set.

Spot Colors

PANTONE inks

• Keep All: No PANTONE inks will be converted to process inks.
• Convert All: All PANTONE inks will be converted to process inks.
• Keep list: All PANTONE inks will be converted except for those listed in the Inks tab.

Method



2
Automation Engine

382

• Use Destination Profile: PANTONE and Designer inks will be converted using the selected
Destination Profile. This gives the most accurate color reproduction.

• PANTONE Solids to Process (Euroscale). PANTONE inks will be converted to process inks
according to a fixed conversion table provided by PANTONE. The result is independent of the
selected Destination Profile. This assumes the Euroscale print conditions.

• PANTONE Solids to Process (SWOP). PANTONE inks will be converted to process inks according
to a fixed conversion table provided by PANTONE. The result is independent of the selected
Destination Profile. This assumes the American SWOP print conditions.

Designer Inks:

• Keep All: No Designer inks will be converted to process inks.
• Convert All: All Designer inks will be converted to process inks.
• Keep list: All Designer inks will be converted except those listed in the Inks tab.

Note:

If the 'Flatten PDF transparencies and layers' box is checked and you select 'Convert all' or 'Keep
list', the color conversion may give unexpected results when overprint is involved.

RGB

RGB will always be converted to process inks during import.

RGB Method:Select one from the list

• Source to destination profile: the user needs to specify both the Source Profile (RGB) and the
Destination Profile (CMYK or Grayscale).

• With Link profile: the user specifies a Color Engine Pilot Device Link Profile. this Link Profile
implicitly determines the Source and Destination profiles.

Source Profile / Link Profile: Select one from the list.

Objects with RGB Profile tags: The RGB objects in a PostScript or PDF file may be tagged with
a Color Profile.

• Convert using the RGB Profile tags: The user may choose to use that Color Profile as a Source
Profile (overruling the Source / Link Profile selected above).

Tip:  In strictly controlled workflows, the embedded tags are probably accurate, so this option
may be preferable.

• Ignore tags: the embedded Color Profile will be ignored, the Source / Link Profile defined above
will be used during conversion of RGB objects.

CMYK and Gray

The CMYK objects in a PostScript or PDF file may be tagged with a Color Profile. The color
percentages of untagged objects will always be preserved. For tagged objects, users have a choice:

• Ignore tags, preserve percentages: the Color Profile tag will be ignored, the percentages will
be those of the object's color.

• Convert, preserve appearance: the objects' color profile will be taken into account; this means
that their color values will change.

The Gray objects in a PostScript or PDF file may be tagged with a Color Profile. The color percentages
of untagged objects will always be preserved. For tagged objects, users have a choice:
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• Ignore tags, preserve percentages: the Color Profile tag will be ignored, the percentages will
be those of the object's color.

• Convert, preserve appearance: the objects' color profile will be taken into account; this means
that their color values will change.

Inks

Use rulings, angles and dot gain compensation from PostScript file if available: If the PostScript
file contains rulings, angles and dot gain compensation, these will be used when this toggle is
selected. Other settings in this tab will be overruled.

Force ink settings from Job setup: If inks were defined in your job setup, you can use this toggle
to make sure that this task uses these parameters.

For more information, please refer to the section on the Inks tab in Job Setup Parameters.

Apply Screen Swap Table: Select a screen swap table from the list.

Map PANTONE Inks to: Enable this option to map all Pantone inks found in the source file to the
Pantone ink book of your choice.

For example, if you enable this option and select the Uncoated ink book, any Matte or Coated
Pantone inks will be automatically mapped to the nearest equivalent Pantone Uncoated ink.

Search Custom Ink Names: Determines how Automation Engine searches for inks in its ink books
when you type in an ink name in the Inks table.

Choose Only in the ink book 'designer' to search for ink names from the "designer" ink book only;
or choose First in <your ink book> and then in designer to search in another ink book of your
choice first, and only use the designer ink book if no match is found there.

Inks table: double-click the fields to edit them. Select one or more inks to limit the effect of the task
to those separations.
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Default values, used when a ruling, angle or dotshape is not specified: Enter the default values for
ruling angle and dot shape, the system will take these values when they are not specified elsewhere
(i.e. in the PostScript file, or in job ink parameters...).

Overprint

Strict overprint behavior

CertIn (the Esko input module) will honor the overprint parameter 100% according to the rules
mentioned in the "PostScript Language Reference" (in case of PostScript / EPS /AI import) and "PDF
Reference Manual" (in case of PDF).

This option must be set when the user wants to process test files like the Altona test suite or other
test suites which verify overprint behavior correctness.

This option controls how zero percentage inks are handled when reading composite files.

When Strict overprint behavior is switched on all zero percentage inks of a color are kept and
correspondingly affect the overprint behavior.

When Never strict overprint behavior is selected, all zero percentage inks are removed.

• Never strict overprint behavior: all zero percentage inks are removed

• Always strict overprint behavior: CertIn will honor the overprint parameter 100% according to
the rules mentioned in the "PostScript Language Reference" (in case of PostScript / EPS /AI
import) and "PDF Reference Manual" (in case of PDF import).

• Only strict overprint behavior for PDF: CertIn will honor the overprint parameter 100%
according to the rules mentioned in the "PDF Reference Manual" (in case of PDF).

Overprinting default is non-zero overprinting

Prevents overprinted objects with zero CMYK values from knocking out CMYK objects beneath them.

Default: To set the overprint mode that the conversion needs to apply when importing the file.

• Opaque: Ignores any overprint of your job.

• BG Overprint: Converts all overprint present in your PostScript job to BG Overprint.

• PS Overprint: All PS overprint present in the job is imported correctly. (This is the default setting.)

Pure Black: To set the overprint mode for objects containing 100% black only. Possible Pure Black
overprint modes in the list:
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• Default: As it is defined in the job.
• Force Opaque: Forces Opaque for objects in 100% black and knocking out all underlying inks.
• Force PS Overprint: Forces PS overprint for objects in 100% black.
• Force BG Overprint: Forces BG overprint for ALL objects in 100% black. The black color is

printed on top of other colors, instead of erasing the color underneath.

Note:

There are two problems:

• Sometimes ink saturation can occur.

100% black text on a 100% red (this is, 100% magenta and 100% yellow) background, results
in three inks printed at 100%.

• Black is best handled as knockout for flexo, since it is better to add a small trapping region
than to make the complete black region overprint.

Rich Black

Set the paint mode for objects containing 100% black and at least one other ink.

• Default: As it is defined in the job.
• Force Opaque (masking): Sets the overprint mode to opaque for all objects containing 100%

black and at least one other ink.
• Force PS Overprint: Keeps the PS overprint for objects in 100% black and at least one other ink

(overprint objects stay in overprint and opaque objects stay opaque).
• Force BG Overprint: Sets BG Overprint for all objects in 100% black and at least one other ink.

White

Possible white paint modes to select from the list:

• Opaque: Forces all objects in white to opaque.
• Keep PS Overprint: Keeps the PS overprint for objects in white (overprint objects stay in

overprint, opaque objects stay opaque).

Images
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Embed all images Toggle this on if you want to embed all 1–bit, 8–bit and native images. If the
box is not checked, then only images with uncompressed image data smaller than 640 kB will be
embedded.

Optimize DCS LineWork Without linework DCS optimization, the result after conversion of linework
DCS files can be difficult to edit afterwards. However it will be correct when viewed in extended
preview or RIPped. 'Optimize DCS Linework' will do an additional operation to combine the elements
on each DCS plate to a composite and a more editable result.

Search Preconverted Files This option forces the system to look for the GRx, CT or LP equivalent
for the original EPS file. If this equivalent is not found, it will use the EPS instead.

Link External Images (OPI, DCS, Helios, ...) Force the system to look for referenced images.

Fail if not Found Activate this option if you do NOT want the system to continue importing /
normalizing your PostScript file when it cannot find an image. When this option is not activated the
imported (E)PS file will appear on screen but without the missing images.

Images Determines how images are treated when the task is run:

• Use Most Recent: forces the system to use the existing images of a previous conversion of the
same job.

• Reconvert: forces the system to regenerate the images on-the fly.

Use Masks Available in the list are:

• PS Mask: Forces the system to take the PS mask present in the EPF file. The mask available in
the external image is discarded. If no PS mask is present in the file, no mask will be taken.

• External Mask: if any, PS Mask otherwise: Forces the system to take the mask present in the
external image. The PS mask is discarded. If the external image has no mask, but there is a PS
mask available in the EPF file, this PS mask will be taken.

• External Mask: if any, no mask otherwise: Forces the system to take the mask present in the
external image. The PS mask is discarded. If the external image has no mask, no mask will be
taken.

• No Masks: The PS mask and the mask of the external image are discarded.

• Joined External and PS Mask: Forces the system to join the available PostScript mask in the
EPF file and the available mask in the external image.

Search directories. To specify a list of directories to look for referenced images.

Use the 'Add'  and 'Remove'  buttons to optimize the Search Directories list.

Clicking  opens the directory selector.

You can browse to the correct directory and click OK to add the directory to the Search Directory list.

Note:  You can also use SmartNames in the Search directories.

Path Translation To define an understandable link for paths from a platform to another platform. The
Path Translation dialog opens, it has three columns:

• From platform: Use the list to select a platform from which the files are to be retrieved: NT,
Macintosh, Unix or VMS.

• From path: specify the syntax of the path(s) of the platform you want to retrieve files from. For
example Mywork:PostScript:job1

• To Path: define the syntax of the paths so that the destination platform understands. For example
Mywork/PostScript/job1
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For example, when going from Macintosh to Windows NT, the path translation would look like this:

You can do the same for files: File Translation.

Page Size

The default page size is PS Page Size. PS Page Size is the page size found in the selected PostScript
file for import. The list displays all possible options (Custom, A5...).

Reader's Spread: To determine how the PostScript file, which has reader's spread format, must
be opened.

• Single Page: Forces the reader's spread in the PostScript file into single page output.
• Double Page: Forces PS File into reader's spread format. When the PostScript file contains no

reader's spread info, the single pages will be set as double pages.
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Scale vertical  : To enter the vertical scale percentage. 100 % is the original size of the PostScript
file.

Scale horizontal  : To enter the horizontal scale percentage. 100 % is the original size of the
PostScript file.

Rotate  : Forces the system to rotate the PostScript File with the specified angle. The origin for
rotation is bottom left.

Possible angles in the list:

• 0: No rotation is to be performed.
• 90: Forces to rotate over 90 degrees counterclockwise
• 180: Forces to rotate over 180 degrees.
• 270: Forces to rotate over 270 degrees counterclockwise.

Offset   : The original offset is Bottom Left.

Specifying a positive vertical/horizontal offset moves your PostScript file upwards/to the right in
relation to the bottom/right border.

Specifying a negative vertical/horizontal offset moves your PostScript file downwards/left in relation
to the bottom/left border.

Other

Substitute Missing Fonts

Roman Fonts by: Choose a default replacement font for the missing fonts for this job on your system.

Japanese Fonts by: Choose a default replacement font for the missing fonts for this job on your
system.

Fail if Font Not Found: The task will fail if the font is not found.

Images
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Import 1-bit images as:

• Intern: Images become internal black and white bitmaps.
• Extern: Images are imported as external referenced LP files.
• Contours: Images are contourized during import of the (E)PS file.

CT display images: Choose Yes to create a display image for the generated CT files on-the-fly.

Output file display images: Select the type of display from the list: None, Thumbnail or Image
and Thumbnail.

Miscellaneous

Device resolution: The resolution used internally by CertIn during the normalization.

Normally the produced output is not dependent of this internal resolution but in some rare cases like
when converting RIP test strips or device specific tests it is important that this value is the same
resolution of the final RIP device which will be used to print output.

Virtual Memory limit: The default value for the virtual memory is 50MB. The limit is set on 1 gigabyte.

Convert text to contours

Note:  Conversion might increase the file size.

Workaround Options

Skip Images: To open the (E)PS file without linking to external images or converting embedded
images.

Preserve Quark trapping: Forces the system to keep the trap strokes made by QuarkXpress.

Disable optimizations: Vignettes recognition and optimization for Photoshop Multitone images are
performed (whenever possible) when this option is not activated.

Sometimes after updating your DTP applications, Esko can no longer perform the optimization and
the conversion of the (E)PS file might fail. Switching this option ON will allow you to import the (E)PS
file.

Show PS comments: All PS comments present in the (E)PS file are displayed on screen.

Disable OPI: This option is valuable when you are importing (E)PS files of QuarkXpress containing
high resolution Tiffs files for which the option 'Include tiff, omit ...' or 'Include all' was activated.

In this case, when importing such a file and if Link External Images is activated, the matching for
the TIFF files will surely fail. It fails because at the time the (E)PS file was generated OPI commands
were also inserted for the TIFF files.

Therefore the system will try to link to images for the Tiff files. To overcome this, activate Disable OPI.

Show external images searches: Displays the path(s) in which the system has found and linked
to external images.

Optimize Illustrator Patterns: Illustrator writes patterns in a different way than PostScript does,
default behavior is that Illustrator patterns will be optimized.

Normally this speeds up the further processing (less linework in your file) sometimes, though, the
optimization itself may take some time.

Use PostScript rules for color conversion: This toggle makes sure that all color management will
happen using PostScript rules, instead of BGCMS. Most options in the Color Management tab will
be grayed out.

Recognize ArtScreen (lpi-angle): Check this box and the application will try to recognize screens
that are created in ArtPro applications and swap them to Esko screens.
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If a (E)PS or PDF file with an unknown ArtScreen is imported, an error will be generated.

For more information, please refer to the ScreenFilter user manual.

Object Based Color Conversion: Object by object color conversion does not take overprint and
transparency interaction between objects into account, and may therefore produce undesirable
results. However, it may greatly improve editability.

Output

As a CT folder is no longer automatically created in every new job folder, you can specify your own
favorite local images folder here.

Image Creation Path

Browse to a location or define one with SmartNames.

If, during normalization, extra image data is created, you can indicate here where these images should
be written.

If no output directory is specified, then CT images generated during the conversion will be saved in
the current working directory.

Limit Filename Length to Maximum 31 characters

Use this toggle if you want to make sure your imported files can be seen/read from/by all Apple
operating systems (CTs that are kept on a Windows share but might be edited on a Mac for example).

Keep Layers

Keeps the Illustrator layer information. This will only work for Illustrator 8 files. It will not work for
native Illustrator 9 files (or higher).

When normalizing PDF 1.5 files (or higher), the 'Keep Layer' option will also preserve the PDF layers.

Fit Media Box (margins)

Allows you to automatically fit the margins.

2.7.93 Optimize and Clean (PSFix)

PSFix is a type of technology that will optimize and clean up ex-PS/PDF data: removing redundant
objects is a typical action. The optimization and clean-up will speed up further processing. PSFix is
typically executed right after a conversion to Normalized PDF.
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General

Delete

• Spurious Contours are:

• Single points that only have a fill attribute.
• Single points that have a stroke attribute with but or square caps.
• Contours that contain two points, that have a mask attribute, but do not mask out any object.

These contours can be created by accident or generated by PostScript printer drivers.
• Double Contours: removes double contours by recombining the fill and stroke attribute of two

identical objects into one object again. Double contours are created when importing PostScript
files, in which case an object with a fill and a stroke attribute is split into two objects with each
one attribute.

• Gross Clipping: selects and deletes the objects whose bounding boxes fall completely outside
the bounding box of the clipping path. Gross Clipping can also be applied on composed text and
externally referenced objects.

• Useless Clips: Selects and deletes useless clipping paths, objects that are totally clipped away
or objects that are totally covered by other objects.

• Hidden Objects: Selects and deletes objects that are covered completely with another object,
because the designer did not want to delete them or could not delete them on a certain page,
as they were components of a master page.

• Contours outside margins: Selects and deletes contours outside the margins.
• Clean up unused inks: Automatically removes all unused inks.

Strokes

• Regenerate Strokes: searches and selects simple objects that contain 20 points or less and
converts them to the equivalent strokes. Select the Select Complex Objects too option if you
want the system to search all objects that might be degenerated strokes, instead of limiting the
search to objects of less than 20 points.

• Minimal Line width defines the minimal width for strokes.

Correct

• Blend to CT converts all recognized blends in the job to externally referenced CT objects.
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In PostScript files, blends are constructed by a large amount of contours that lie close to each
other and that have slightly different colors. The more accurate the blend, the more contours and
colors. This leads to very large jobs and decreases the processing speed.

For each detected blend, Blend to image creates 1 image.

Note:  After conversion to different images, the display of the blend can change. However, the
conversion does not affect the printed result.

Resolution defines the resolution of the blend that was converted into a CT.

• Simplify Linked Mask Objects will try to reduce the number of linked contours for complex
mask objects. This option is only useful for linked mask objects with a huge number of contours
(>50). When used with a lower number, PSFix will become less powerful and it will have no effect
whatsoever on the complexity of the mask object.

• Fix bleed: It is a common occurrence for pages to be supplied without any bleed. This means
that either a new page has to be sent or the page has to be manually corrected in PackEdge.
Especially the latter can be a time-consuming process. Optimize and Clean (PSFix) now has
the capability of fixing this problem automatically, by adding bleed where there is none, or not
enough. There are three parameters to control the process:

• Bleed Distance is the amount of bleed that is required. For any object that does not have this
amount of bleed the correct bleed will be created.

• Gap: any object that is inside the borders, and that is closer than this distance to the borders
will be considered to require bleed. Typically, this value will be small. It makes sure that objects
which do not really touch the borders because of inaccuracies in the design, are taken into
account for bleed creation anyhow.

• Maximum Image Scale: in the case of linework objects all the bleeds that are created are
added to an additional layer called "Bleedlayer". This layer can be removed at all times to
return to the original file. This is not possible with images, however. Images are modified in
their original location. There are two possible ways in which images can be handled. When an
image is larger than its clip mask, it is possible to create bleed by extending the clip mask of
the image; hidden pixels will become visible and the missing bleed problem is fixed. When the
image is not larger than its clip mask, the only way in which bleed can be created is by scaling
the image. When doing so, the position of the image inside the page does not change, but it is
disproportionately scaled to create the correct bleed. To avoid an unacceptable distortion of
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the image this parameter determines how much scaling of an image is allowed. If no scaling
is desired, then the value can be set to 0.

In order for the bleed-fixing to work properly it is imperative that the borders of the file are set correctly.
Optimize and Clean (PSFix) also has functions to correct borders and it now also has a new function
to set the borders of a file automatically to the trim marks.

When no bleeds have been corrected the exit status of the Automation Engine task will be OK (green).
When bleeds have been corrected, the exit status will be a warning (orange), and when the maximum
scale factor was not enough to create bleed for an image an error will be generated (red).

Adjust Borders

Select the Adjust Borders to make the options available.

To move any of the four borders numerically, to measure manipulations applied to borders and to
save the borders manipulation to an option file. This can be done separately for odd and even pages.

Fit borders to : select from the dropdown list:

• All inks
• Any ink in your file

'Auto fit borders on trim marks' tries to detect the presence of trim marks. When valid trim marks
are recognized the borders will be set accordingly. When not, the borders will remain unaffected.
This feature is useful when the trim size of the supplied files is unknown and unreliable (for example
missing or wrongly defined trim box in a PDF file) and the user wants to determine it automatically.
Even when the desired trim size is known to the user, it can still be interesting to see if the
automatically determined border size corresponds to the desired one: a difference between the two
is likely to point to an error. Users very often neglect to work with accurately set borders, because the
intelligent placement of files in FastImpose and Plato does not require them to do so. However, if you
want to use the function to fix wrong bleeds it is a requirement to have the borders defined correctly.
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You can define the borders:choose Even and/or Odd and fill out the specifications for Top, Bottom,
Left and Right.

You can load a Borders Adjust file (.psbaf file), you can create such a file in the interactive editor.

Set Margins: enter a value for the margins.

2.7.94 Optimize PDF Document

The Optimize PDF Document task enables you to make some prepress-specific changes to a PDF
document.

If you want to output the files in a different location, you can define that location in Output in. You
can enter a path manually, browse to a location, or use Smart Names.

If you want to give the output file a different name, enter it in File Name field. You can enter a name
manually, browse to an existing file to replace it, or use Smart Names.

Document

Select Preserve fonts if you want to make sure external systems receiving the PDF file can print or
display the fonts correctly. You can choose:

• Embed Fonts: this embeds all used fonts.

• Embed & Rename: this embeds Base 14 Fonts fonts under a different name (their name in the
Esko PDF Library), and all other fonts under their existing name. This prevents Acrobat from
replacing the document font with a local font of the same name when using live text.

Note:  Base 14 fonts are: Courier, Courier Bold, Courier Oblique, Courier Bold-Oblique, Helvetica,
Helvetica Bold, Helvetica Oblique, Helvetica Bold-Oblique, Times Roman, Times Bold, Times
Italic, Times Bold-Italic, Symbol and Zapf Dingbats.

• Vectorize: this converts all text to outlines.

Apply document's rotation flags: A rotation flag is a property of a PDF page that specifies by what
angle the contents should be rotated when previewing or printing the file.

Some older applications/output devices ignore or mishandle the rotation flag. If you are sending your
file to such an application/device, select this option to execute the rotation specified in the rotation
flag (that is, actually rotate the file's contents).

Select Outline strokes if you want to convert the document's strokes to outlines. You can choose
either:

• All: this converts all strokes to regular outlines.

• Dash Only: this converts dashed strokes (only) into individual outline objects. This can
significantly improve trapping.

If you want to change the strokes’ width in your document, select Increase line width and enter the
Minimum Line Width to use. All strokes widths below this value will be enlarged to it.

Rotate Job: Use this parameter to change the rotation of the contents of your file by 0º, 90º, 180º
or 270º.

• If Apply document's rotation flags is off, this changes the rotation flag's value but doesn't rotate
the file's contents.

• If Apply document's rotation flags is on, this rotates the file's contents.
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Adjust Page Box: This option allows to change some or all of the document's page boxes, or add
page boxes in your document. See Adjust Page Box on page 395 for details.

Outline Page Box: This option allows to outline some or all of the document's page boxes. Use this
if you want to show the page boxes on proof (for example, you can outline the trim box to show
where the artwork will be).

See Outline Page Box on page 397 for details.

Adjust Page Box

To add or change a page box:

1. Click the Add button. This opens the Adjust Page Box pop-up.

2. Select the Page Box to add or change.

3. Choose what you want the new page box size to be Based on:

• Choose Absolute if you want to define the page box size independently of the document's
contents or existing page boxes.

• Choose Content if you want to base the page box size on the document's contents. This takes
clipping paths and masks into account.

• Choose Media Box, Crop Box, Trim Box, Bleed Box, or Art Box if you want to base the page
box size on another one of the document's page boxes.

4. Determine the new Width and Height.

• If you have chosen to use an Absolute size, enter the page box's Width and Height.
• If you have chosen to base the page box size on the document's Content or on another page

box, you can adjust the width and height in Increase Width and Increase Height.
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Note:

• Use a negative value to reduce the page box size instead of extending it.
• You can use Smart Names.

5. If desired, enter an Horizontal Offset and / or a Vertical Offset.

• A positive horizontal offset will move the page box to the right, a negative one to the left.
• A positive vertical offset will move the page box to the top, a negative one to the bottom.

You can use Smart Names.

Note:  This is applied after the Alignment!

6. Choose the page box's Alignment (relatively to the old page box):

7. Apply your changes to either:

• All Pages,
• Odd Pages Only,
• Even Pages Only.

8. Click the Add button.

Note:  You can Remove a page box you have added.
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Outline Page Box

To outline a page box:

1. Click the Add button. This opens the Outline Page Box pop-up.

2. Select the Page Box to outline.

3. Select the Ink to use.

You can type in the Ink Name, use Smart Names, or click the color patch to open a color picker.

4. Enter the ink Density to use.

You can use Smart Names.

5. Specify the Stroke Width to use.

You can use Smart Names.

6. Click the Add button.

Note:  You can Remove a page box outline you have added.

Layers

Use the Layers tab to rename, remove, or add layers, as well as handle the PDF's layer printability.

Note:

• The layer functionality is executed in the order shown in the user interface (Action 1, Action 2...).

• You can use wild cards (*) in the layer names.

Action 1: Rename Layers

Use this parameter to rename layers.

Click Add to open the Rename Layer pop-up, then enter the Old Layer Name and the New Layer
Name. You can use Smart Names and / or wild cards (to replace part of the layer name).
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Tip:

You can also merge layers by renaming a layer to an existing layer's name, or by renaming several
layers to the same name.

The layers to merge have to be directly on top of each other in the file.

Action 2: Remove Layers

Use this to remove layers from the file.

Click Add and enter the names of the layer you want to remove. You can use Smart Names and /
or wild cards.

Except for: When using a wild card to remove layers, use this parameter to keep certain layers, even
if they match the name entered in Remove Layers.

Action 3: Add Layers

Use this to add empty layers to all pages of your PDF.

Click Add and enter the name of the layer to add. Repeat as necessary.

Update Layer Printability: Select how to handle layers’ printability in your document. You can
choose either:

• Don't Change Layer Printability,
• Make All Layers Printable,
• Remove Non Printable Layers.
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Images

Downsample Images

Select this parameter if you want to downsample images’ resolution. This makes the parameters
underneath it available.

• Choose what resolution you want to Downsample bitmap (black & white or one-bit) images to,
if their resolution is above a certain resolution.

• Choose what resolution you want to Downsample contone (grayscale or color) images to, if
their resolution is above a certain resolution.

You can use Smart Names.

Crop Images

Select this parameter to crop images clipped by a clipping path to the rectangular bounding box of
the clipping path. This makes the Split images area... parameter available.

Split images area when at least ... % of the images is clipped away: This parameter defines how
the task will crop the image, depending on how much of it is clipped away (for example, for images
that have multiple clipping paths on them).

• If the part of the images clipped away is less than what you enter here, the images will stay
together and be cropped to the bounding box of the combined clipping paths.

• If the part of the images clipped away is greater than what you enter here, the images will be split
into multiple clipped images, each cropped to the rectangular bounding box of its clipping path.

The default percentage is 50%.

Recompress Image Data

This option allows you to re-compress images in the PDF file. Selecting it makes the parameters
underneath available.

• For Color, Gray Scale and Soft Mask Images, you can choose between the JPEG and ZIP
compressions.

For JPEG compression, you can choose between Minimum, Low, Medium or High Quality.

• For Bitmap Images, you can choose between the CCITT Group 3, CCITT Group 4, ZIP, and
Run Length compressions.

Note:  DeviceN images will always be compressed to ZIP files when Recompress Image Data is
selected.

2.7.95 Optimize PDF Separations

The Optimize PDF Separations task enables you to make changes to a PDF document's
separations.

If you want to output the files in a different location, you can define that location in Output in. You
can enter a path manually, browse to a location, or use SmartNames.

If you want to give the output file a different name, enter it in File Name. You can enter a name
manually, browse to an existing file to replace it, or use SmartNames.
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In File Type, choose if you want to output a PDF or a Normalized PDF file.

Colors

Use the Colors tab to define the conversion settings needed to convert the document's (non-
process) colors.

Note:  The conversion is done by Esko's Color Engine.

Embed Profiles Mode: This parameter handles color profiles embedding. You can select:

• Do not change: This doesn't make any changes to color profiles embedding.

• Embed: This embeds all color profiles.

• Embed & Overwrite: This re-embeds all color profiles, overwriting profiles already embedded.

• Remove All Embedded: This removes all embedded profiles.

Note:  The task uses the embedded profile(s) as source profiles for conversions.

Convert RGB, LAB, Gray To CMYK: Enable this parameter to convert all non-process color spaces
(except spot colors) to CMYK.

Note:  This will generate errors and/or warnings when trying to convert non-separable blend modes.

Fail When Converting Color Spaces: Color converting objects that have transparency effects (like
blend modes) can generate visually unexpected results. You can:

• leave this option selected if you want the task to stop with an error when this problem occurs.
• deselected this option if you want the task to only generate a warning for this problem.

Default CMYK Profile: Select the default profile to use for CMYK objects without an embedded
color profile. It will be used as a source profile for Color Space conversions.

Note:  You can choose any CMYK profile in the Color Engine database.

Default RGB Profile: Select the default profile to use for RGB objects without an embedded color
profile. It will be used as a source profile for Color Space conversions.

Note:  You can choose any RGB profile in the Color Engine database.

Default Gray Profile: Select the default profile to use for gray objects without an embedded color
profile. It will be used as a source profile for Color Space conversions. You can choose one of the
following:

• Any gray profile in the Color Engine database.
• Convert to Black Channel, if you want your gray-scale object to only have a value in the Black

separation when outputting it to CMYK.

Output Color Profile: Enter the Color Space of the output device (e.g. proofer or press) in this
parameter.

Note:  You can choose any CMYK profile in the Color Engine database.

Update spot color equivalents: This option handles CMYK values for spot color inks. You can:

• enable this option to overwrite the CMYK values found in the file with the CMYK values stored
in the ink book.

• leave this option deselected to use the CMYK values found in the file for spot color inks.
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Spot Color Lookup: Use this parameter to select where to look for the spot colors' information.
Choose one of the following methods:

• Look in Ink Books First: the task first looks in the ink book you defined in the Preferred Ink
Book option (see Optimize PDF Separations  on page 399) .

If it doesn't find the spot colors' information in that ink book, it then looks for it in the job.

• Look in Ink Books Only: the task only looks in the ink book you defined in the Preferred Ink
Book option.

If it doesn't find the spot colors’ information in that ink book, it ends in error.

• Use Colors in File: the task looks for the spot colors’ alternate color values (generally in the
CMYK color space) in the file, and uses those values.

Preferred Ink Book: Choose the desired Ink Book that will be used in this task.

PANTONE Color Lookup: Choose the settings for the PANTONE colors conversion. This can be
one of the following:

• Use destination profile: Use the color profile defined in the Output Color Profile to determine
CMYK equivalents of the PANTONE Color.

• HP Indigo CMYK 1.1: Use CMYK equivalents for the HP Indigo Press.

• Pantone Color Bridge Coated: Use the CMYK equivalents defined in the Pantone Color Bridge
Coated guide.

Inks

Use the Inks tab to define how to handle inks. Use the following parameters to rename, convert or
remove inks.

Note:  The functionality is executed in the order shown in the user interface (Action 1, Action 2...).

Caution:  All ink-related parameters are case-sensitive.

Action 1: Rename Inks

Use this parameter to rename inks.

Click Add to open the Remap Ink pop-up, then enter the Old Ink Name and the New Ink Name.

Tip:  You can also merge inks by remapping an ink to an existing ink's name, or by remapping several
inks to the same name.

Note:  If your original ink has a PANTONE Suffix, add it to the Old Ink Name, even if you are changing
this suffix. The reason for this is that when you use both the Remap Inks and Pantone Suffix
parameters, the task renames the inks first.
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Pantone Suffix: With this parameter, you can change the suffix (for example CV, CVC, CU...) of
PANTONE colors.

• Do not change: This keeps the suffix as it is.

• Convert: This changes the suffix to the one you select in the To list, for all PANTONE colors.

• Convert If Found In Ink Books: this changes the suffix to the one you select in the To list, for
PANTONE colors found in the ink books you defined (see Optimize PDF Separations  on page
399).

Note:  This can also merge inks (for example if you have PANTONE 484 U and PANTONE 484 C,
and you changing all the suffixes to C).

Action 2: Convert Inks

Use this parameter to convert spot colors to CMYK. You can use wild card characters (*) in the ink's
name.

Action 3: Remove Inks

Use this to remove inks from the file.

Click Add and enter the names of the ink you want to remove. You can use SmartNames and/or
wild card characters.

Except for: When using a wild card character to remove inks, use this parameter to keep certain
inks, even if they match the name entered in Remove Inks.

For example, you can remove all the inks except the die cut ink, to send your file to the die-cutter.

Preserve Separation Interaction: Use this parameter to define what to do when the separations
you remove contain objects knocking out other separations.

• None: this only deletes knockout objects that are only defined in the removed separation(s).

Use this when removing separations that don't influence the final result (for example die cut
separations).

• Standalone: this converts knock-out objects that are only defined in the removed separation(s) to
white knock-out objects defined in one of the remaining separations. The remaining separations
keep looking the same.

This method is recommended for most use cases.

• For Versioning: this converts knock-out objects that are only defined in the removed separations
to white overprinting objects.

Those are defined in a color space made from the remaining separations of the file, and
overprinting on all other separations.

This ensures that when re-adding separation layers for versioning, the final result looks the same
as the original file.
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Note:  This may create objects in DeviceN color spaces, that some applications can't handle.
Only use this method if you want to do versioning on your file.

Remove unused separations: Enable this to remove unused separations (separations containing
no objects) from the file.

Ink Properties

The Ink Properties tab allows to apply ink types and printing methods to the inks in native and
normalized PDF files. These properties can be used to steer behavior of tasks later on in the workflow,
for example the Extract Inks task for printing methods.

Apply Ink Type : You can define the Ink Type for each Ink Name. The task will accept Ink Names
containing wild cards (asterisks).

Use Add to add an entry to the Apply Ink Type. You can type in the Ink name and Ink type or use
corresponding SmartNames.

Note:

• The Ink Name may contain wild cards (asterisks). In such instances, the inks matching the pattern
of the Ink Name will have the specified properties set. If one ink matches more than one pattern,
the first one is taken.

• When matching, the letter case is ignored.

Ink Type can be:

• Normal, Opaque, Varnish, Technical. Limitations for opaque can be imposed by CMS.

Note:  process colors (CMYK) can only be normal

Use Add to add an entry to the Apply Ink Type. You can type in the Ink name and Ink type or use
corresponding SmartNames.
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Apply Printing Method : Set the Printing Method corresponding to Ink name here. Choose from
predefined printing methods:

• Offset, Gravure, Flexo, Letterpress, Screen, Inkjet, Toner, Thermal Transfer, Other,
Unknown.

Note:  You can use SmartNames to specify Printing Method.

Overprints

To Knockout

Use this tab to change the Overprint versus Knockout behaviour of inks in a PDF file.

All overprint objects: Select this to disable all overprints in your file.

Attention:  This can change the file's appearance.

White text: Use this to set white text to knockout.

White vector: Use this to set white line art to knockout.

Technical objects: Use this to set technical objects to knockout.

Varnish objects: Use this to set varnish objects to knockout.

Opaque ink vector: Use this to set line art in opaque ink to knockout. Opaque inks are defined in
the ink book, using the Color Engine Pilot.

Opaque ink text: Use this to set text in opaque ink to knockout. Opaque inks are defined in the
ink book.

Caution:  When an ink is explicitly defined as "opaque" in the ink book, you cannot make it
"normal" with this task. You will get a warning if you try.

To Overprint

All knockout objects: This parameter changes all knockout objects to overprinting objects, and
modifies their color space(s), so that the file keeps the same appearance.

Attention:

• Only use this parameter in versioning situations.
• This parameter affects how you can place the file afterwards. If you place this overprinting

file on top of another file, all the bottom file's channels not present in the top file will be
visible.

Black text: Use this to set black text to overprint. You can choose to make:

• All black text overprint, or

• black text Smaller Than a defined value overprint.

Black vector: Use this to set black line art to overprint.

Technical objects: Use this to set technical objects to overprint.

Varnish objects: Use this to set varnish objects to overprint.
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Opaque ink vector: Use this to set line art in opaque ink to overprint. Opaque inks are defined in
the ink book.

Opaque ink text: Use this to set text in opaque ink to overprint. Opaque inks are defined in the
ink book.

2.7.96 Outline Fonts

This task will contourize ALL fonts in a file (and in all files it refers to). All live and composed text will
be contourized. ‘Internal’ text (executed SmartMarks for example) is already contourized.

The task will save the output as a copy of the original job, and will add the suffix _c, this behavior
can be overruled by using SmartNames.

Tip:

When you processed a file that did not contain any fonts, the details pane of the Tasks View will
tell you so.

2.7.97 Preflight via External Application

The Preflight via External Application task allows you to preflight a PDF file by integrating external
(non-Automation Engine) preflight software into Automation Engine.

Using the Task in a Workflow

Note:  When preflighting in a workflow, the Preflight via External Application workflow step has
four output pins:

• Preflight OK: your files will go through this pin if the preflight gave an OK status, or if you chose
Task ends OK for When warnings appear in the ticket (and the preflight gave warnings). See
Task Parameters on page 406.

• Preflight with Warnings: your files will go through this pin if the preflight gave an error or a
warning (depending on what you chose in the ticket).

• Preflight with Errors: your files will go through this pin if the preflight gave an error or a warning
(depending on what you chose in the ticket).

• Error: your files will go through this pin in case of a processing error unrelated to the preflight
status.

Supported Preflight Software

Third party preflight products that Automation Engine can link up to are:

• Callas PDFInspektor (batch version): versions 2, 3 and 4
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• Enfocus PitStop Server: versions 3, 4, 8, 9 and 10

Note:  The preflight software should be able to run in the background.

Task Parameters

Tool: select a supported preflight tool from the list.

Note:

Changes made in the Enfocus PitStop Server application's preferences will not affect the Automation
Engine Preflight task.

To change the Report Language, Profiles and Action Lists folders, use Configure (go to Tools >
Configure > Preflight Tools).

Executable File: indicate the path to the preflight engine executable or dll (PDF Inspektor only).

Profile: browse to, or select a preflight profile from the list. Note that a profile can also contain action
lists.

Tip:  You can also create these preflight profiles with Adobe Acrobat Professional.

Action: use the buttons at right to Add or Remove actions from the list (only from PitStop Server 4).
You can also reorganize the list using Move up and Move down.

Attention:  Tickets created with versions of BackStage prior to BackStage 70R5 will be loaded
with one single action in the list.

Report: define the name and location of the preflight report file that will be generated. You can use
SmartNames.

When rules are violated: choose what status you want the task to have when preflighting gives
errors:

• Task ends with a warning

• Task fails

When warnings appear: choose what status you want the task to have when preflighting gives
warnings:

• Task ends OK

• Task ends with a warning

• Task fails

Preflight Report

The Preflight Report file generated by the task contains the Errors and Warnings found by the
preflight, and any Fixes it implemented.
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If you generated a PDF report, you can open it in the Viewer (or the application associated with this
file type).

2.7.98 Preflight with PitStop

The Preflight with PitStop task allows you to preflight a PDF file in Automation Engine, without
needing external preflight software.

This task uses the latest PitStop preflight technology.

Using the Task in a Workflow

When preflighting in a workflow, the Preflight with PitStop workflow step has four output pins:

• Finished OK: your files will go through this pin if the preflight gave an OK status (with no warnings
or errors).

• Finished with Warnings: your files will go through this pin if the preflight gave warnings (but no
errors).

• Finished with Errors: your files will go through this pin if the preflight gave errors.
• Error: your files will go through this pin in case of a processing error unrelated to the preflight

status.

To customize what to do when you get warnings from the preflight:

1. Right-click the workflow step and select Configure Outputs...
2. In the pop-up that opens, select what to do under Warning handling:

• select OK on Warning to send the files that have preflight warnings through the Finished OK
output pin,

• select Error on Warning to send them through the Finished with Errors output pin,
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• select Dedicated handling of Warning to send them through the Finished with Warnings
output pin.

3. Click OK.

Tip:

You can also use the Configure Outputs... pop-up to:

• Send the successfully preflighted files further in the workflow (select Add an extra output pin
where the task's inputs will be when no errors occur and connect that pin to the workflow
step of your choice).

• Use the preflight reports in your workflow (select Add an extra output pin where the task's
reports will be put and connect that pin to the workflow step of your choice).

Settings

Preflight Tab

Action Lists: Define which Enfocus action list(s) you want to use on your file. Use the Add or Remove
buttons to add/remove Action Lists. You can reorganize the list using Move up and Move down.

Attention:  Tickets created with versions of BackStage prior to BackStage 7R5 will be loaded
with one single action in the list.
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Profile: You can browse to, or select a preflight profile from the list. Note that a profile can also
contain action lists.

Tip:  You can create these preflight profiles with Adobe Acrobat Professional.

Define how you want the task to behave depending on the preflight results:

• In When rules are violated, choose what happens when you get preflighting errors:

• Task ends with a warning
• Task fails

• In When warnings appear, choose what happens when preflighting gives warnings:

• Task ends OK
• Task ends with a warning
• Task fails

Certified Tab

You can certify a PDF file in this task (for example, when a Pre-Media company wants certified files
to be sent to the Converter). This certification can be verified using Verify Certification task, for
example in a converter's workflow (Read more in Verify Certification on page 521).

• Set Certify to:

• Make Certified: to certify the file.

• Keep Certified: to preserve the existing certified/uncertified status of the file.

• Make Uncertified: to remove all the certified information from the PDF file.

If your choice is Make Certifiedor Keep Certified, you need to set the following items:

• User: fill in the user name to be added to the certified PDF.

• E-Mail: fill in the E-mail that needs to be added to the certified PDF.

• Session Comment: use this space for comments.

• Allow to Roll Back: Enable (default) this, if you want the users to be able to roll back to previous
sessions of the file (for example to compare versions). If you disable it, users cannot roll back to
previous versions. But the Certified history will be in the file.
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Report Tab

• Generate a Report : Enable this (default) if you want to generate a report of the preflighting
session.

• Settings for the generated report :

Choose the settings according to your report requirements:

• Units : select from mm, cm, Pointand Pica.

• Language : choose from the list of eight major languages.

• Type : Set your preferred file type. Choose from PDF, PDF + XML and XML.

Read more in Preflight Report on page 410

Color Tab

You can correct color space errors (for example convert RGB colors to CMYK) in this tab. Select
Enable Color Management and choose the Grayscale, RGB, CMYK and Lab ICC profiles for color
conversions.

Preflight Report

The Preflight Report file generated by the task contains the Errors and Warnings found by the
preflight, and any Fixes it implemented.

Report: define the name and location of the preflight report file that will be generated. You can use
SmartNames.
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If you generated a PDF report, you can open it in the Viewer (or the application associated with this
file type).

2.7.99 Prepare for Inspection

You can set measurement points in from the design which can be later monitored through an
automated /sem-automated inspection system. This will take a JDF-Layout file to create a JDF-
Inspection file.

The JDF-Inspection file contains the layout of the sheet/sheets and for each one-up information on
the following:

• the contour of the retained area (ClipPath)

• the location of the barcodes (IdentificationField)

• the location of the text areas (IdentificationField)

• the location and values of Spectrometer measurements (CIELabMeasurement)

The Prepare for Inspection task generates a preview of the one-up PDF files in RGB TIFF format,
and a rendering of the ClipPath as a monochrome mask in TIFF format. The task packs the results
as a MIME file which can be delivered to the inspection system as a single self-contained file. Read
more about the task settings in Settings on page 413

Sample Workflow using Prepare for Inspection

This sample workflow starts with a PDFPLA Step and Repeat file. As a first step, you can export the
file as a JDF Layout file. This creates a JDF file and self-contained PDF files for each one-up.



2
Automation Engine

412

Prepare JDF for Inspection task uses this JDF layout to create the MIME file containing the JDF
file and the TIFF previews. Next task publishes this MIME file to a hotfolder to be picked up by the
designated inspection system.

You can use the Router tasks to select the correct file as input file.

Preview and Cut Mask Samples

Speed Label One-Up:

Preview Sample: Note that the cut contours are not visible in the Preview.
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Cut Mask Sample:

Settings

Document Tab

Specify the output requirements here. You can output at each step of the processing separately as
a Preview, Cut Mask and or the entire results as MIME pack. You can enable/disable Create MIME
pack, Render Preview and the Render cut mask options.

Configure the rendering resolution via setting the Preview Resolution manually or via SmartNames.
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Add extra SmartName/ free text parameters such as a a "profile" dictating the settings for
the inspection system (for example, "commercial labels").Specify these free-text parameters for
inspection system under Inspection Parameters. Use Add or Remove to add or delete these
parameters.

Separations Tab

Use this tab to indicate the selection of colors to be extracted (the “Die Cut” separations) and to
specify the non-printable (the technical ink separations) areas to be excluded.
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Specify the Separations to exclude from the preview under Exclude Separations. Enter the
separations to be rendered as cut mask under Cut Path Separations.

2.7.100 Prepare for Viewer

About View Data

The Prepare for Viewer task prepares View Data for the Automation Engine Viewer.

This View Data will help the Viewer to quickly open the file (the Viewer will use the prepared View
Data instead of asking the server to make or stream it).

Note:  When you start zooming in, there will be a point where the View Data is no longer sufficient
and when the server will be asked to stream ‘new’ data anyway. This point depends on the size of
your file and the zoom-in that you request.

How to Prepare View Data

You can prepare View Data manually, or in a (semi-)automatic way.

• Select a file and launch this task manually.
• Include this task in a workflow ticket (semi-automatic).
• Create View Data by activating 'Speed up for Viewing' on a folder.

When should I prepare View Data?

Only create View Data when it is certain that the file reached its final state, preferably before the QA
operator opens the file. What you could do is add a checkpoint to indicate when the View Data is
ready to your QA operator.
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Using the Task

The Prepare for Viewer ticket, which allows you to generate View Data semi-automatically, has the
following options:

• Resolution for non-images: Optimal allows Automation Engine to use its own logic to generate
the optimal speed/quality compromise, Custom allows you to indicate a desired resolution
manually.

• Anti-aliasing

• Automatic grouping of input files into digital film sets: will group digital film separations into
sets that can be combined for viewing a composite image.

For example, when the input files are 123_C.len, 123_M.len, 123_Y.len, 123_K.len, then
these will be grouped into one digital film set and rendered in a composite view.

If you disable this option, all input digital films are grouped and displayed in a composite view,
regardless of the file names.

Fully Automatic View Data Generation

If you decide to use the Prepared View Data mode, you will want the data to be prepared as
automatically as possible.

This can be done by setting an attribute to a specific folder of choice: Speed Up for Viewing. The

folder will get a specific icon .

When Speed Up for Viewing is activated, Automation Engine will automatically launch the Prepare
for Viewer task on all Esko PDF and Esko PLA files in the folder which are new or have been changed
(indicated by a changed SmartID). You can Configure to indicate other file types.

The Speed Up for Viewing attribute of the folder can be inherited from other Jobs and it can simply
be removed again. It will be removed automatically when the Job is removed from the Automation
Engine database, manually, via the Archive task or via JDF.
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Note:  Extra smart integration with Esko editors is guaranteed. When a file is being edited in PackEdge
or Plato, you definitely do not want to have View Data re-created every time you click Save. Of
course, the ‘Prepare View Data’ task only starts and updates your View Data when you indicate that
you have finished the editing session.

2.7.101 Prepare Graphics for Nesting

For detailed information about the Prepare Graphics for Nesting task, please see Prepare Graphics
for Nesting on page 1100 in the Gang Run Printing chapter.

2.7.102 Prepare Station

This task is used to prepare one ups for use in Step and Repeat. The task's input is a Normalized
PDF file.

If the orientation of the PDF does not match the orientation used in the one-up CAD, the automatic
repetition will fail. This is why a one-up ARD/CFF2 file is loaded on top of the PDF.

The position of the one-up CAD will use the die shape (defined by an ink) as a reference. The die
shape and the one-up CAD will be compared in order to derive the rotation angle. If the rotation angle
is not identical, the one-up CAD will be placed rotated on top of the PDF file.

The Prepare Station task can create either Station files or Normalized PDF files. The kind of output
that will be generated depends on whether or not the Create Station File toggle is activated.

Check the 'Create Station File' box to create a Station File (STA or PDFSTA file).
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• The input file is always placed externally.
• Check the option 'Extract Die using Ink' to create a die by extracting all contours in a specific

separation.If the box is not checked then the trim box of the station will be used as die shape.
This is the default situation.

• ‘Load CAD’ is only active when the option ‘Create Station File’ is selected. It allows you to place
a CAD file. Supported CAD files include ARD files and 1-up CFF2 files.

Note:  In case a layout CFF2 file is selected, the task will generate an error.

You can browse to the appropriate CAD file or use SmartNames.If needed, you can select a CAD
mapping file which will determine how the CFF2 line attributes are mapped to the ArtiosCAD line
types. This will happen only when a CFF2 file was selected.S elect the appropriate CAD style file
to determine in which separations the different CAD lines will appear.

• The bleed can be limited to a specific distance. The bleed mask is created by spreading the die
shape.

• Graphics on the backside of the station can be loaded (also through an external reference).
• To load a SmartMark set, select a set from the dropdown list or enter the set via SmartNames.

Note that only one set will be loaded for both front and back.

Note:

Keep the following in mind when positioning graphics on the back side:

• If the image PDF contains objects in the ‘die ink’, the graphics for the back side are positioned
so that these object (in the die ink) are centered on the die of the front side.

• In the other case, the graphics on the back are positioned centered on the original borders (i.e.
unfitted) of the front side graphics.

When placing a CAD file, the following sequence of operations takes place:

• The graphics file is placed in a station.
• If the option ‘Extract die ink’ is selected, the die shape is extracted from the graphics. If not, die

shape is set to trim box.
• The CAD file is loaded and the outline of the CAD file is compared to the outline of the die shape

generated in the above mentioned step. The graphics is rotated in such a way to create a maximal
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intersection of the CAD outline and the outline of the die shape. If a rotation is applied, the log
file will contain a message.

• The CAD is taken as the die shape for the station.

If the 'Create Station File' box is not checked, a Normalized PDF file will be created:

• The input file is opened (so it is not placed externally).
• Borders can be fitted to objects in a specific ink.
• Margins can be limited to a specific value.
• SmartMarks can be placed around the graphics.

2.7.103 Print

Select a device from the drop down list. The devices that appear in the list are the ones that are
configured on the server.

Note:

The devices should be configured on the server using the user BGSYSTEM. The Print Task will not
be available for devices configured by other users.

The configured devices must be PostScript printers.

Factory settings: These settings are a quick way to define your ticket.

There are two settings, select one from the drop down list and don't forget to click Apply:

• PostScript for press (Separated)
• PostScript for Press (DeviceN Composite), only available with PostScript 3 devices.
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• PostScript for viewing/proofing (CMYK Composite)

If you change the predefined settings, the user interface will indicate that the Factory Settings are
modified.

Note:

If you define a ticket using the Factory Settings, and you save it, the Factory Settings option
disappears. If you overwrite a Default ticket the Factory Settings will be gone as well.

Please refer to Export to PostScript File on page 341.

2.7.104 Print IMP File

This task is a combination of the Print task and the Export Imposition to GRI File task.

2.7.105 Print on Digital Press

Working with a Digital Front End Server

Automation Engine can create print jobs on an Esko Digital Front End Server (DFE) using the files
in your Automation Engine containers. It will monitor those print jobs until they are printed on the
digital press.

In Automation Engine:

• use the Print on Digital Press task to create print jobs on the DFE server. If Automation Engine
is connected to a DFE server lower than version 4.0, the Print on Digital Press Task can only
create static print jobs.  When connected to a DFE server of version 4.0 or higher, this task can
create both static and variable print jobs. Learn more below in Print on Digital Press Task Settings
on page 421.

• use the Print on Digital Press (PPML) task to create variable print jobs on the DFE server from
Automation Engine from Esko PPML input file (see Print on Digital Press (PPML)  on page 431),

• the Print on Digital Press (Track) task is started automatically to track DFE print jobs created
from within the DFE server. This means you can monitor print jobs created from sources other than
Automation Engine. Because this is an automatic task, you don't need to fill in any task settings.

Each of those tasks shows detailed feedback (for each step of the DFE printing process) in
Automation Engine's Tasks pane.

Setup

Before using those tasks, you must connect your Automation Engine server to your DFE server in
Configure.

If your DFE server drives several digital presses, you also need to select the press to connect to
from Automation Engine.

See Digital Press on page 635 for details.
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Supported File Types

You can send the following file types to a digital press:

For static print jobs: For variable print jobs:

Either:

• Normalized PDF
• PDF
• Plato PDF

An Esko PPML file, with links to several
Normalized PDF files (for the fixed background
and the variable data).

An Esko PPML is a PPML file generated by
DeskPack, PackEdge or Plato.

Note:  Make sure that the files referenced by
the PPML file (the fixed PDF and the variable
PDFs and images) are in an Automation Engine
container, so the Digital Front End server can
access them.

PDF/VT (for example generated by Adobe
Illustrator, while using the Dynamic VDP Plug-in).

Note:

• If you are using an MIS - ERP system to store print job parameters, you can add the JDF ticket
created by your MIS system to the input of the Print on Digital Press task.

• If you want to send other file types to the digital press, you should convert them to Normalized
PDF first.

Using the Print on Digital Press Ticket in a Workflow

Unlike most workflow steps, the Print on Digital Press or Print on Digital Press (PPML)) step does
not create output files to be transferred to another Automation Engine workflow step, but sends data
to the Esko DFE server.

This means it is always the final task in a workflow.

In the workflow editor, you can see the number of files it has successfully processed on the pin called
Inputs at the end of the step.

Print on Digital Press Task Settings

The Print on Digital Press task allows you to create a VDP Print Job from a One-Up  Variable
Data Template (.VDT) file. The Variable Data Database parameters (expansions of the variable data)
will happen on the DFE. This is typically used when running the Expansion in Adobe Illustrator or
Automation Engine takes too much processing resources.
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Note:

• A VDT file (.vdt) is a variable data template file that contains VDP objects (placeholders for the
variable data) and must be expanded to a PDF/VT file on the L&P Print Server.

• A VDP file can be created in the Dynamic VDP DeskPack plug-in.

• A VDT file must be self-contained: For example, it must NOT contain external references to other
resources than Variable Images.

Settings

Device: This list contains all the digital press devices that you connected to in Configure. Choose
the digital press you want to send your file to.

Print Job Ticket: Choose the print job ticket you have created on the DFE server to process and
print static print jobs.

General settings: see General Tab on page 423.

Files settings: see Files tab on page 424.

Step and Repeat settings: see Step and Repeat Tab on page 425.

Transformation settings: see Transformation Tab on page 430.

Color Management settings: see Color Management Tab on page 430.
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Note:

When using the Print on Digital Press task, make sure the DFE server is running.

If your task is stuck, check if the Digital Press connection is still OK in Configure.

You can send the following file types to the Print on Digital Press task:

General Tab

Note:

For all parameters, you can choose [From Print Job Ticket] to use the parameter value defined in
the DFE Print Job Ticket you selected.

The value defined in the Print Job Ticket is then shown beside the parameter.

If you added a JDF ticket to the task input, you can choose [From JDF Ticket] to use the parameter
value defined in your JDF ticket.

Print Job Name: You can specify a name. You can type in a name or select a SmartName / Public
Parameter / Workflow Parameter.

Substrate: Contains a list of substrates available at the press. The substrate specified in the ticket
is selected by default.

Copies: Enter the number of copies to be printed by the press.

Finishing Marks: Choose if finishing marks have to be applied (you have more options if Step and
Repeat is enabled).

Lead-in Sheets: Enter the number of lead-in sheets that needs to be printed at the start of the Print
Run, or enter <None> in case you don't want to use Lead-in.

Lead-out Sheets: Enter the number of lead-out Sheets that needs to be printed at the end of the
Print Run, or enter <None> in case you don't want to use Lead-out.

Die Cut Layout Input Ink: Specify the ink of the input file of the task that will be used as contents
of the Lead-in/Lead-out Sheet. This is typically a Technical Separation (for example Cutter)

Die Cut Layout Output Ink: Specify the ink that will be used to print the Lead-in/Lead-out Sheets.
This must be one of the inks of the selected Ink Set in the Color Management tab.

Comments: Choose Custom to enter print job related comments here. They will be included into
the file sent to the press, and be visible on the press (if your press model supports it).
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Files tab

Duplex Print Job

To create a duplex Print Job, select Duplex print in the Files Tab.

Backing Up:

• Select Tumble if you want the roll to be re-inserted into the Digital Press with rewinding.

• Select Turn if you want the roll to be re-inserted into the Digital Press without rewinding.

The One-Up Settings list allows you to Custom specify an input file for both the Front and the Back
side of the Print Job.

Note:

For all the above parameters goes the following: if you added a JDF ticket to the task input, you can
choose [From JDF Ticket] to use the parameter value defined in your JDF ticket.

VDP Print Job

Also in the Files Tab, you can specify the Variable Data Database parameters.  To make a job variable,
a source of variable information is needed. To do this, proceed as follows

1. Choose Custom in the One-Up Settings.
2. On the bottom of this tab, click Add.

This is set in the Select Database File dialog. You can either use a CSV File or a Simple Database.
   A CSV  file is used in case the job should contain complex information such as   names, serial
numbers or links to images.  When using a Simple Database, you only use Simple Counters, and
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don't need a  CSV file. This is suited for jobs that only require a simple sequence of numbers.  You
can define how many records need to be generated in the Number of records field.

For more information, see the DFE User Documentation.

Note:  Creating a VDP Print Job from a VDT file is supported on the HP L&P Print Server 4.0 and
later for  Dynamic Workflows.

Step and Repeat Tab

1. To make the Step and Repeat options available, Select Custom in the Step and Repeat Settings
and select Step and Repeat at the top of the dialog.

Note:  When using the PowerLayout DeskPack plug-in to send jobs to the DFE, you have already
defined your Step and Repeat grid, so you don't need to set Step and Repeat options here.

2. Choose to either define a tabular Step and Repeat, or to Step and Repeat using a template.

• If you want to do a tabular Step and Repeat, select None in the Template Field. Then fill in
the parameters in the Grid Details tab (for more info, see Grid Details ).

• If you want to Step and Repeat from a template, select one in the Template field.

Note:

• If you are working with multiple input files, you need to use a Step and Repeat template.
You cannot define a tabular Step and Repeat.

• Step and Repeat using a template is only supported when using a Dynamic job ticket.

• The Step and Repeat template and marks can be created in DeskPack (Powerlayout
Standalone & Dynamic Marks). For more information how to create these templates, see
the Deskpack documentation.

If your template has multiple grids and you have selected multiple one-ups at print job creation,
the application will automatically assign the first grid to the first one-up, etc. You can change
this by:

1. Selecting a grid by either clicking it in the Sheet Preview or selecting it using the arrows
in the Grid parameter,

2. Selecting the one-up to go with this grid in the One-up parameter,
3. Repeating this for each grid and one-up you want to associate.

Note:  If the number of one-ups doesn't match the number of grids in the template, or if the
size of a one-up doesn't match the size defined in the template's grid, you will see a warning.

The Grid Details tab will automatically be filled with the data of the selected grid from the
template.

3. In Sheet Preview, you will see a preview of the Step and Repeat after creation of the print job,
based on the parameters you filled in at right.

4. If you are working with a variable job, fill in the parameters in the Variable Data tab (for more
info, see Variable Data).

5. Click on Marks and Margins to set the marks and the margins for your Step and Repeat.

Note:  You can set marks and margins even if you are not using Step and Repeat in your print job
(if the Step and Repeat option at the top of the dialog is deselected).
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a. Choose if you want to add Finishing Marks to your print job. Finishing marks are used to align
the substrate for cutting.

You can choose marks you made in Dynamic Marks or the default marks (1 x LabelRow, 1
x Sheet or 2 x LabelRow). These marks are all visible when Step & Repeat is active, or from
within PowerLayout. When Step & Repeat is inactive, only "1 x Sheet" is shown.

Note:  If you are using a template, you cannot add finishing marks here. The marks from the
template will be applied.

b. If you are working on a duplex print job, you can also add Second Pass Marks (also called
"reinsertion marks"). These marks are used to align the substrate when reinserting it back into
the machine for printing its back.

The default marks available are: Reinsertion Marks (Bottom Right) 10x5, Reinsertion Marks
(Bottom Right), Reinsertion Marks (Upper Left) 10x5 and Reinsertion Marks (Upper Left).

Note:  If you are using second pass marks in combination with finishing marks, make sure that
your margins are big enough to accommodate both sets of marks.

c. Set Margins: you can define each gap (1, 2, 3 and 4) using the following:

• Gap (Length or Width): the size of a gap between one-ups.

• Gap (Length or Width) / 2: half the size of a gap between one-ups. This is typically used
for top and bottom margins, as the bottom margin of one sheet plus the top margin of the
next sheet will be equal to one gap.

• Custom: a custom number (formulas are not allowed).
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Note:

If you selected a mark whose size you defined in the Configuration tool, the corresponding
margin will show Defined by Mark. This means that the margin is automatically large enough
to provide space for this finishing mark.

For example, if you selected the default mark 1 x LabelRow, which is set in the Configuration
tool to need 8mm of right margin, the right margin (4) will be set to Defined by Mark and
be 8mm wide.

6. At the bottom of the dialog, you will see the Grid Size if you defined a tabular Step and Repeat,
or the Template Size if you used a template. This is the includes the margins you defined in the
Marks and Margins dialog.

7. After creation of the print job, the Actual Repeat Area shows the area actually used by the
repetition (not including the margins). The width and length values are calculated based on the
Step and Repeat parameters, including gaps. You cannot edit them.

Grid Details

You can define parameters here if you are building a tabular Step and Repeat from a single one-up
(you have selected one input file at print job creation).

If you are using a template, this tab will automatically be filled with the data from the template (which
is then non-editable).

Repeat one-up using its: Choose whether to use the dimensions of the one-up's Trim Box or Media
Box to calculate the repetition grid.

You can see the One-up Size at right.

Clip on Trim box with bleed of: If the Trim Box / Media Box of the one-up is too large for the desired
repetition, you can clip it to the desired value to avoid overlapping between one-ups.

Note:  This value should not be larger than half of the gap defined in the corresponding direction.

Orientation: Choose how to orientate the one-up.

Available Repeat Area: Define the width  and length  of the repeat.

• The width can be set to Substrate Width (the width of the substrate you chose in the Printing
Properties) or to a Custom value.

• The length can be set to the Maximum Repeat Length or to a Custom value.

Repetition: This defines the number of horizontal  and vertical  steps in the repetition grid.
You can choose either:

• Maximum: The server will calculate the maximum amount of repetition steps possible within the
Available Repeat Area.

• Custom: Enter the repetition amount of your choice.

Gaps: The values you enter here (for a horizontal  and a vertical  gap) will be used as a
distance between the one-ups' borders in the repetition grid.
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Note:

• The amount of gaps is equal to the number of repetition steps, in order to provide seamless
printing.

• The length of the sheet is equal to the length of the vertical repetition, plus the length of the vertical
gaps, plus the top and bottom margins.

Variable Data

This tab is only available when you are working on a variable print job (for this you need to have

selected either the Default ticket  or a custom ticket created from the Default ticket when creating
the print job).

Use this tab to define how to distribute your variable data over the grid of one-ups you built in the
Grid details tab, or over the one-ups repeated according to the Template you chose.

Start: Choose where to start printing your variable data (where to print the first record):

•
 top left,

•
 top right,

•
 bottom left,

•
 bottom right.

On the preview at right, you can see a black dot where the first record is.

For example this distribution starts on the top left:

while the distribution below starts on the top right:
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Choose also if the flow of variable data should run horizontally  or vertically .

The preview at right reflects your choice.

Horizontal flow:

Vertical flow:

Note:  The Printing direction marked with an arrow shows the direction the paper flows through
the press.

Fill over: choose if you want to distribute the variable data over the Complete Job or over Blocks.

If you choose Blocks, the variable data flow will run over Blocks of a certain size, then run over the
next Block when the previous one is complete.

You can see an example of Blocks in the preview at right when selecting Blocks.

Block Size: select the size of the Blocks you want to use. You can express the size in Grid Rows,
Sheets, Feet or Meters.

If you have chosen to Fill over the Complete Job, then the Block Size will be 1.00 Job by default.
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You can set it to another unit if you still want to print in Blocks, but without having the variable data
flow respect the Block. This is useful if you want to add gaps (see below).

Add gap between blocks: this is available if you have chosen to Fill over Blocks, or to fill over the
Complete Job but still have Blocks (as explained above).

It adds white space in between the Blocks.

Gap size: this is available when you have selected Add gap between blocks. Define the gap size
in Grid Rows, Sheets, Feet or Meters.

Transformation Tab

Note:

For all parameters, you can choose [From Print Job Ticket] to use the parameter value defined in
the DFE Print Job Ticket you selected.

The value defined in the Print Job Ticket is then shown beside the parameter.

If you added a JDF ticket to the task input, you can choose [From JDF Ticket] to use the parameter
value defined in your JDF ticket.

Vertical Scale: Use this to scale the print job vertically (in the length).

Horizontal Scale: Use this to scale the print job horizontally (in the width).

Rotation: Choose the rotation of the print job (None, 90˚ CW, 180˚ or 90˚ CCW).

Note:  The Rotation option is disabled when Step and Repeat is enabled.

Mirror: Choose whether to mirror the contents of the print job or not.

Color Management Tab

Note:

For all parameters, you can choose [From Print Job Ticket] to use the parameter value defined in
the DFE Print Job Ticket you selected.

The value defined in the Print Job Ticket is then shown beside the parameter.

If you added a JDF ticket to the task input, you can choose [From JDF Ticket] to use the parameter
value defined in your JDF ticket.

Ink Set: Choose the set of process inks that will be generated by the RIP (this depends on the model
of the press used).
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Use: Define if you want to use color management when ripping the print job (to convert the file
separations to the press ink set), and what kind of color management.

• Choose <None> if you don't want to use any color management settings for the conversion.

• Choose Color Strategy to select a Color Strategy to use for the conversion.

When you select Color Strategy in the Use list, you can choose the Color Strategy to use for color
conversion of the print job.

2.7.106 Print on Digital Press (PPML)

Use the Print on Digital Press (PPML) task to create variable print jobs on the DFE server from
Automation Engine.

Caution:  From version 4.1.1 onwards, the DFE will no longer support PPML as an input
format. Therefore this task can only be used with DFEs prior to version 4.1.1.

Settings

Device: This list contains all the digital press devices that you connected to in Configure. Choose
the digital press you want to send your file to.

Variable Print Job Ticket: Choose the print job ticket you have created on the DFE server to process
and print variable print jobs.

General settings: see General Tab on page 423.

Transformation settings: see Transformation Tab on page 430.

Color Management settings: see Color Management Tab on page 430.

Note:

When using the Print on Digital Press (PPML) task, make sure the DFE server is running.

If your task is stuck, check if the Digital Press connection is still OK in Configure.

2.7.107 Process PDF Spreads

PDF Spread options: process modes

There are three process modes:

• Split Reader Spread: to create single pages from an incoming spread

• Make Reader Spread: to create spread pages from incoming single pages.

• Make Printer Spread: to create spread pages that can be used to create an imposition mock-
up from incoming single pages

The settings for each process mode are described in the following sections.

Settings for Split Reader Spread

Spread position:
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• Reference Box: Select a page box to choose how much of the page to include in, or retrieve
from a spread. For example select Crop box to crop everything outside that box. Reference boxes
include the Media Box, Crop Box, Bleed Box, Trim Box, and Art Box.

• Reference Box Offset: Enter an exact offset distance from the reference box specified in
Reference Box field. The offset distance will extend beyond the box boundaries. This parameter
is commonly used when creating spreads of asymmetric files.

• Bleed Mode: Control the placement and size of bleeds. There are three options:

   
   

Remove Bleed Only the content of the reference
box will be retained, any bleeds
present in the incoming job will be
removed.

   

Bleed from Bleed Box The bleed will be the Bleed Box
but only if the reference box is the
Trim Box.

Bleed from Bleed Distance This option will add the specified
bleed distance to the chosen
reference box. Enter the bleed
distance in millimeters. A bleed
distance will extend beyond the
borders of the Trim Box and
therefore will set the boundaries
of the Media Box when output.

Spread structure:

• Flow Direction: Determine whether pages are arranged in numerical order from either left to right
or right to left. When set at left to right direction, page one will be on the left hand side of a two-
page spread, with the second page on the right. If the flow direction is right to left, page one will
be on the right hand side of the spread, with page two on the left hand side.

• First Spread Contains Control how pages will be organized in the output job:

   
   

Page 1 and 2 To divide a spread into single
pages. If you use this mode in
conjunction with the “Mixed
Spreads” option, you can split
spread pages in a job while
leaving single pages intact.

Note:  Note: The reference page
for a splitting job using Mixed
Spreads should be a spread
page, not one of the single pages.

   

First page only If you place the first page of the
job on the right-hand side of the
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first spread page; the left-hand
side remains blank.

For jobs with an even number
of pages, the last page will be
also be placed on a spread page,
on the left-hand side, with an
accompanying blank page.

The left / right positioning of
pages on spreads is determined
by the selection made in the Flow
Direction field. The description
above assumes a left to right flow
direction.

Last and first page When making a spread in Last
and First Page mode, the last and
first pages of the input job are
placed side by side on the first
spread page.

In a left to right flow direction
setting, the last page will be on
the left and page one on the right
of the first spread page output.

In “Split Reader Spread” mode
the task will simply reverse the
make mode. A job with spread
pages will have the spread pages
split but the page on the left side
of the first spread will be output
as the last single page of the
output job.

Even number of pages To prevent incoming jobs with an
even number of pages from losing
any pages while being split.

The parameter produces different
results depending on which of
these spread types it is combined
with.

• Select the Even Number of
Pages option together with the
First Page Only spread type
to split the output job. The left
side of the first spread and the
right side of the last spread will
not be output.

• A combination of the Last
and First Page spread type
and the Even number of
Pages parameter will split a
job successfully.
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Note:  This option is active only in
the Split Reader Spread process
mode and with the First Page
Only and the Last and First Page
spread types.

Mixed spreads:

Use this option for incoming jobs with a variety of paper sizes for which you need to define the
Reference page.

For example, if a job contains both an A4 page as page one and a two-page spread as page two,
enter page two as the reference page and indicate that this page has two pages on it. All the spread
pages are correctly detected and split correctly while leaving the single pages intact.

• Auto Detect Spread Reference: to take the most frequently featured page size as the Reference
page

• Reference Page Number: to specify an exact page as the Reference Page. Use the actual page
number in the series of pages, not the page’s number label

• Reference Page contains X One-Ups: enter the number of single pages to be positioned on
the Reference Page.

Settings for Make Reader Spread

Select this process mode to create spread pages from incoming single pages.

The Spread position and Spread Structure options are the same as for the process mode Split Reader
Spread.

Settings for Make Printer Spread

Select this process mode to create spread pages that can be used to make an imposition mock-
up from incoming single pages.

The Spread position and Spread Structure options are largely the same as for the process mode
Split Reader Spread.

Processing PDF Spreads

Use this task to manage PDF Spreads. You can create spread files, split spread files, specify bleed
distances and control the order and positioning of the pages in spreads. This task can handle jobs
that contain a combination of single pages and spread pages.

1. Use the Output in field to define where to place the PDF spreads.

This can be the job's original location, or another location.

2. Define the Job Name to use.

By default, this field contains the [JobName] SmartName, meaning that the original job name
will be used for the PDF spreads.

3. Choose one of the following Actions:

• Split Reader Spread
• Make Reader Spread
• Make Printer Spread
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4. ChoosingSplit Reader Spreadallows you to create single pages from an incoming spread. Set
the following parameters:

• the Reference Box: Media, Crop, Trim, Bleed or Art box
• the Reference Box Offset
• The Bleed Mode and Bleed distance, when relevant
• The Spread Structure: the flow direction and the contents of the First Spread
• If you have mixed page sizes in the PDF spread, choose your Reference page and specify the

number of one-ups on that Reference page.

5. Choosing Make Reader Spread allows you to create spread pages from incoming single pages.
Set the following parameters:

• the Reference Box: Media, Crop, Trim, Bleed or Art box
• the Reference Box Offset
• The Bleed Mode and Bleed distance, when relevant
• The Spread Structure: the flow direction and the contents of the First Spread

6. ChoosingMake Printer Spread allows you to create spread pages that can be used to create an
imposition mock-up from incoming single pages. Set the following parameters:

• the Reference Box: Media, Crop, Trim, Bleed or Art box
• the Reference Box Offset
• The Bleed Mode and Bleed distance, when relevant
• The Spread Flow Direction

7. Click OK to save your settings for this task.

2.7.108 Proof (FlexProof)

In the Device list, select the FlexRip Proofer Output you added in Configure.

General

Transformations

Enter a percentage in Scale V and/or Scale H to scale the design vertically or horizontally. The scaling
direction is always applied ‘as the file is’ (so the vertical and horizontal dimensions are as you see
them in the editor).

Rotate: Choose the requested rotation from the list. The rotation is counter clockwise.

You can also select Fit On Paper to fit the design on the paper of your proofing device. This makes
the Scale and Rotate options unavailable.

Positive-negative : Define whether you want a positive or negative output file.

Mirroring : choose whether you want mirroring or not.

Original Size (incl. Margins)

The system provides the original Job size, margins included.
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Output Size (incl. Margins)

The size shown here is the real output size, that is the original job size influenced by the scaling
factors (and/or distortions) and the chosen rotation.

Marks

If desired, you can add SmartMarks to your file. SmartMarks are created in an Esko editor.

Dot Gain Compensation

Single Curve: Select the preferred Dot Gain Compensation Curve.

Automatic: Select the preferred screen based Dot Gain Curve.

Inks

All Inks. The standard behavior of the default ticket is to offer all inks in the job to be exposed.
Deactivating ‘All Inks’ opens the ink list where you can select specific inks.The list contains ink names,
ruling, angle, dot shape and ink type.

Use technical inks in output. Normally technical inks are hidden when you save a job in an Esko
editor. Check the box to output the visible (non hidden) technical inks.

Keep similar inks in their original separations. Check the box if you want to keep similar inks in
their original separations.

Keep inks separated. Do not merge the inks.

Use Merge with to output inks on top of each other in the same output file. This is common when
you use different rulings for 1 ink.

Let's assume that the job contains two Cyans, and that they have a different ruling. You might want to
put them on the same separation. You can do so by clicking in the 'Merge with' column and selecting
the ink it has to be merged with.

Click Merge Similar Inks to prompt the system to look for the same inks with a different ruling or
angle. The image shows how two Cyans (with a different ruling) were detected and put together. You
can reset any modifications by clicking Reset.

Advanced

Hold In Rip Queue This options offers to hold the task in the rip-queue until someone manually
releases this task. For more information, please see the Tasks View.
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Choose between:

• Don't change Y ruling: this is the default, the Y ruling is not adapted.
• Change Y ruling: change the Y ruling, possibilities are: -15%, -7%, 0% (changes nothing), + 7%

and +15%.
• Change Y ruling stochastic: same as the 'Change Y ruling' settings, but the dotshapes is

adapted to the Monet dot.

Pre - Rip

The Pre-Rip tab contains options that are only relevant when the job really needs pre-ripping. The
Pre-ripping mentioned here is the ‘simplification’ that can be necessary before the job-objects can
be offered to the Rip. The decision to do this is taken automatically. And even when this is done, the
options are best left to their default settings. Special objects (in Normalized PDF format) that require
the need for this ‘simplification for rip’ pre-ripping are:

• ‘Edge vignettes ’ (vignettes with alpha channels effect on the edge of the object)
• Barco Blends (=non contourized GRO-blends)
• Warped CTs (warping done on Placed CTs)

Pre-ripping results in making a CT of these special objects that the rip can handle them. The resolution
of such a CT and the anti-aliasing can be set here.

Specify the output resolution for the generated CT(s). Default output resolution is 12 lpmm or 304
ppi.

Anti-aliasing is relevant for the lineart objects in your design, that need pre-processing and for which
CTs are generated. Anti-Aliasing smoothens the staircase effect you get in the generated CTs of
lineart objects that need pre-processing.

Vignette Noise When exporting to some EPS vignettes or parts of vignettes will be converted to
CTs. This happens when the vignettes overlap other objects with translucency or overprint between
the vignette and the other objects. When the option Convert Vignettes to CT is activated all vignettes
are converted to CT regardless of overlap with other objects. Vignettes that are converted to CT can
result in tone jumps in the final result. To reduce this banding effect, noise is applied on the CT. The
amount of noise can be specified in the field Vignette Noise.

The  Blend to CT toggle converts the Barco Graphics blend objects into a CT when exporting your
job.

Use the Smooth Blend toggle to set the steps of the blend objects to 255 steps when exporting
your job. As long as Convert Blend Objects to CT is not activated, Smooth Blend appears dimmed.
When Convert Blend Objects to CT is activated and Smooth Blend also, the generated CT will ignore
the original steps of the blends of your Barco Graphics design. The amount of steps is set at the
maximum which is 255. The goal is to obtain a fluid blend effect.

Output

Configuration Set

Indicates the name of the selected configuration file. These configuration files represent specific
behavior of the output device. The list of configurations is filtered according to the CMS license
that the selected dispatcher holds. For example if it has a 4 channel license, no multi channel
configurations will be visible.

Output Folder

Leave this empty to use the output path as defined in the Dispatcher (EskoLink queue – Output tab).
If your EskoLink queue has no value for the output place; then you can define output folders here.
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Output File

Leave this blank to get an output file name based on the input file. Edit this to overrule this standard
behavior. Only plain letters and numbers will be allowed. Other, unsupported characters (symbols)
will be replaced by an _.

Output Type

Choose between Composite and Separate and select the appropriate Output Color.

Output Color

In case of Composite output, you can choose between Colored and Greyscale. In case of Separate
output, you can choose between Colored and Black & White.

• Colored: all inks are converted to CMYK values
• Greyscale: all inks are converted to grey values.
• Black and White: if you want a Black & White proof.

Anti-Aliasing is relevant for the lineart objects in your design, that need pre-processing and for which
CTs are generated. Anti-Aliasing smoothens the staircase effect you get in the generated CTs of
lineart objects that need pre-processing.

Enter the Number of Copies you need.

Check Keep job files for relaunch purposes to be able to proof jobs a second time without having
to rip them again.

Note:

When using this option, the files created for the proof (and the proof job on the Esko Proof Client)
will not be automatically cleaned up.

You will have to delete them manually.

White Coloring

Attention:  You will only have this option if one of your Configuration Sets connects to an
Epson Stylus Pro WT7900 proofer.

When you use an extra white ink to print on foil (transparent or metallic), this option allows you to
customize your white ink (for example, to get a cooler or warmer white).

You can choose between:

• No Coloring: this uses the proofer's white ink to print objects in the white separation, without
applying coloring to this ink.

• Custom values: this allows you to color the proofer's white ink manually. Enter the CMYK values
to add to the white inks.

• Values from Color Management: this uses a Color Strategy to color the proofer's white ink.

This Color Strategy must have a white Extra Output Ink (called white) and map the white
separation used in the file to this white output ink.

Color Managing White Ink for an Epson WT7900 Proof

For example, you want to print a file with a cool white ink on your Epson Stylus Pro WT7900
proofer.

1. In Color Engine Pilot’s Designer book:

a) add your file’s white ink (here, cool white),
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b) add a generic white ink. Call it white.

2. Create a Color Strategy that will color manage your file’s white ink:

a) add your generic white ink as an Extra Output Ink,

b) map your file’s white ink (cool white) to your white output ink,

c) make sure Extra Output Ink and Ink Mapping are selected in your Color Strategy.
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3. In Automation Engine’s Proof (FlexProof) ticket, go to the Output tab and:

a) select the Configuration Set corresponding to your Epson Stylus Pro WT7900 proofer,
b) in White Coloring, select Values from Color Management.

4. In the ticket’s Color tab:

a) select Manage Color,
b) select Color Strategy,
c) choose the Color Strategy with white ink mapping you created in Color Engine Pilot.

Color

Simple Color Workflow

Check Manage Color to apply color management to your job.

If you choose to apply color management for Normal Proof the settings of the requested color
management are, by default, chosen by a Color Strategy which can be selected from the list.

If the color strategy toggle is disabled, the color management settings are entered with profile
settings.

Then, Use the Document Profile as Source Profile if Availabe is set but as this document profile
may not be available, a backup of the source profile must still be chosen.

Choose the Process you want to simulate on the proof here. This process can be a registered ICC
profile or an Esko Profile.

There are some default Esko Profiles on the system, for example crom_offs (Cromalin Offset). If you
have measured an Esko Profile yourself, for example for your own Flexo press, you will be able to
select it here.

Destination Profile

This is the profile for the proofer. Choose the proofer profile that describes the colors of your proofer
here (for example the characteristics of your proofer).

Both Esko Proofer profiles and ICC profiles of proofers are available in this list.
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Also defaults are listed, for example ddcw_glossy, a description for a Digital Cromalin/WaterProof
on glossy paper.

If you profiled your proofer using Color Engine Pilot, you will be able to select your Proofer profiles
here as well.

Note:

The list of color strategies and destination profiles is filtered according to the CMS license that the
dispatcher holds.

If the Dispatcher has no CMS license, only “preview” and “linear” can be selected as color strategies,
whereas additional strategies are available with a 4-channel or multi-channel license.

Rendering intent

Rendering intent decides how you will visualize the simulated profile on your proofer. Since there are
many differences between the simulated process (for example a gravure press) and the proofer, the
CMS software gives some options to give you the best result for your purpose. Possibilities are:

• Relative (No Background): Use this option if you do not want any background simulation. The
white point of the source will be mapped on the white point of the destination process. This
rendering intent takes into account the ability of the human eye to adapt to the surrounding white.

• Perceptual: This will result in no background simulation (white of reference colorspace is mapped
on white of destination colorspace). Use this option if you don't care too much about an exact
color match but you want the pictures at least to look nice on your proofer. It will give a visually
pleasing result. If the gamut of the source is wider than the proofer, the entire gamut is shrunk so
that it fits inside the gamut of the proofer.

• Absolute (Background): Use this option if you want background simulation and you want an exact
color match, including the paper simulation.

• Saturation: Use this option if you care especially about saturated colors. This rendering intent will
map saturated colors on saturated colors.

Note:

For Esko profiles Perceptual, Relative and Saturation are in fact identical.

Black Mapping

This option is only available if you choose an Esko destination profile (not if your destination profile
is an ICC profile). Black will be mapped onto black or, in other words, the black separation will only
be printed with black ink.

In case you want to simulate a very dark black, which is darker than the black of your proofer, you
might want to switch this option off. In this case all 4 proofer inks will be used to simulate the high
density of the black.

Generate an error if the job contains unregistered inks

This toggle is by default unchecked. You can enable this option when Manage Color is on.

When this toggle is checked, the task will indicate an error if unregistered job inks are being color
managed. The resulting Error will indicate a message:

• The job contains unregistered inks
when launched as a stand-alone task.

• Proofing aborted because the file contains unregistered inks
in the Log window when launched as a workflow task.

.
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This helps to avoid inaccurate results from unregistered inks. When unregistered inks are not present
in the job or the unregistered inks are deselected in the inks-tab, the task will launch without indicating
an error.

Note:  When you select an Equinox source profile ( or use a Color strategy with Equinox source
profile) with Manage color toggle on, this task will perform a default check. This check verifies if all
the selected job inks are specified in the Equinox source profile. If they are not specified, the task
will end in error with a message such as :
Proofing aborted because the following input inks are not found in the source profile: cut glue

Color (Emulation Proof)

You need an extra license to see the Manage Color for Emulation Proof option. If unchecked,
then the workflow remains as described in the simple color workflow. Otherwise, extra options are
available:

Here, CMS options can be set twice:

• In the topmost section of the tab, you set the color management options for emulating the
conventional press on a digital press (conversion from the source profile to the emulation
profile).

• In the second section, you set the color management options for the output proofing device
(conversion from emulation profile to destination profile).

The preferred option is to use a Color Strategy for both conversions. Select the emulation Color
Strategy first, so that the list of color strategies for the output settings can be filtered to have the
same source profile as the emulation profile selected in the emulation step.

Alternatively, you can manually select the source profile, emulation profile and destination profiles
with their respective rendering intents.
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Tip:

If you select a multichannel printing profile in the Emulation Profile list (such as the seven-channel
IndiChrome Plus profile), you can use the Output Inks... button to enable or disable the additional
inks (for example, indiChr Orange, indiChr Green, and indiChr Violet).

This allows you to use a profile like IndiChrome Plus to generate output without one or more of the
additional inks (for example, without the IndiChrome Orange ink).

Generate an error if the job contains unregistered inks

This toggle is by default unchecked. You can enable this option when Manage Color is on.

When this toggle is checked, the task will indicate an error if unregistered job inks are being color
managed. The resulting Error will indicate a message:

• The job contains unregistered inks
when launched as a stand-alone task.

• Proofing aborted because the file contains unregistered inks
in the Log window when launched as a workflow task.

.

This helps to avoid inaccurate results from unregistered inks. When unregistered inks are not present
in the job or the unregistered inks are deselected in the inks-tab, the task will launch without indicating
an error.

Note:  When you select an Equinox source profile ( or use a Color strategy with Equinox source
profile) with Manage color toggle on, this task will perform a default check. This check verifies if all
the selected job inks are specified in the Equinox source profile. If they are not specified, the task
will end in error with a message such as :
Proofing aborted because the following input inks are not found in the source profile: cut glue

Verification

Note:  You can only set Verification options if you have chosen an Esko Proof Configuration Set
in the Output tab.

Print Verification Strip: To print a verification strip, select this option and fill in the options below
(that become available once Print Verification Strip is selected).

Strip Preset: a certain number of presets come with your color database. They contain information
about the strip and the measurement device to use, the tolerances in color difference, etc.

You can select a preset here, that will fill in the options below, or select Custom and fill the options in
yourself. You can also start from a preset and change the other options as desired (the Strip Preset
field will then show Custom).

For more information about the strip presets available, see XXX.

In Strip Type, choose the strip to print with your job: this can be EskoStrip or Esko + Solid Color
Strip. The Esko + Solid Color Strips contain the same patches as the EskoStrips, plus a 100% patch
for every spot color present in the job. When printing a color managed strip, you should use an Esko
+ Solid Color Strip.

For more details about the available strips, see the FlexProof/E documentation.

Apply Color Management to Strip: If you selected Manage Color in the Color tab, the Apply Color
Management to Strip option is available. Select it if you want to color manage your strip.
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Verify strip (with Verification tool): If you have a Verification license and you are color managing
your job, this option is available. To verify your strip, select this option and choose what to use as
a Reference.

You can choose either:

• Manually load reference values if you want to verify the color managed strip against a standard
(for example Ugra/Fogra) or a previous measurement.

You will need to load this standard manually in Esko Verification.
• Automatically load reference values from source profile if you want to verify the color managed

strip against the source ICC profile (set in the Color Strategy used or defined in the Color tab).

dE Formula: choose the Delta E formula to use when verifying your strip.

You can select between dE CIE76, dE CMC, dE 94 and dE 2000. If your company is already using
one of those standards, we recommend that you choose the same one. If not, you should choose
the most recent one, dE 2000.

Click Edit Tolerances... to set custom tolerances for the measurements.

You can fill in:

• General dE Limits: the Delta E values that the color patches and paper should not exceed.
• Primary color dE Limits: the maximum Delta E values allowed for CMYK colors.
• Hue difference Tolerance Limits: the maximum Delta H values for CMYK, CMYKRGB and

grayscale colors.

Delta H is the difference in Hue between the expected color and the printed color. XXX
• Tone Value Tolerance Limits

• Chromaticness Tolerance Limits

If you selected a Strip Preset, the tolerances may be automatically defined.

The verification will pass if the Delta E values are within the tolerances, or fail if they are bigger.

Strip Layout

2.7.109 Proof IMP File (FlexProof)

This task is a combination of the Proof (FlexProof) task and the Export Imposition to GRI File task.

2.7.110 Proof to File - Unscreened

Use this task if you need unscreened but color managed output, in a file that you can send to a
proofer.

Task Output

The Proof to File - Unscreened task can generate composite PDF or TIFF files (one file with all the
separations).

In the example below, processing a file containing the lime green Esko star generates one multi-
channel unscreened file containing the Cyan, Yellow, Magenta and Black channels, where the
Magenta channel is empty.
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Task Parameters

In the Device field, select the imaging device that you configured.

Then use the selector pane at left to show more settings to fill in. See:

• General on page 1204,
• Proofer on page 1206,
• Transformations on page 1207,
• PDF Objects on page 1208,
• Document Inks on page 1208,
• Color Management on page 1209,
• Output on page 1209,
• Summary on page 1218.

2.7.111 Publish Imposition on WebCenter Chain

You can publish your Imposition to WebCenter using this task chain. You can then approve/reject
pages in WebCenter. The input of this task can be an Imposition or a RunList. If you want to approve
the RunList before adding a layout you can use this task to publish a Runlist on WebCenter.
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Your approval in the WebCenter is registered in the Automation Engine Proofs  view. You can proceed
with these proofs in the Automation Engine workflows.

This ticket has two subtasks(steps):

• Publish imposition on WebCenter. Read more in Publish Imposition on WebCenter on page 446

• Send RunList to WebCenter. Read more in Send RunList to WebCenter on page 448

Publish Imposition on WebCenter

Mockup

In this tab, you can check the elements you want to be visible on output and select the appropriate
mockup color from the drop down list to enhance visibility.
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Publish

Allow Viewing and Annotating in WebCenter

The files will be processed by Automation Engine and uploaded to WebCenter according to the
settings for resolution and image processing.

Resolution for non-images for linework and text etc.. can be set to either Optimal or Custom.

• Optimal: If you select this, Automation Engine will calculate the best resolution based on the size
of the file.

• Custom: You can specify the required resolution.

For images, the maximum resolution available will be used.
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Anti-aliasing: You can enable this image correction option to relevant objects. Anti-Aliasing
smoothes the staircase effect you get in the generated CTs of line art objects that need pre-
processing.

Allow Downloading in WebCenter

You can select which kind of files you want to make available for downloading in WebCenter here:

• Input files
• PDF files for proofing. You have to choose which Ticket should be used to generate the PDF

files.

Note:  If you select PDF files for proofing the viewing quality will be limited to the resolution of the
PDF files for viewing.

Send RunList to WebCenter

Destination

You can select the WebCenter settings.

• Site: You can indicate to which site you want to upload the documents. The sites available are
the ones defined in Configure.

• Project:You can indicate the name of the WebCenter project to which the imposition will be
published.

Tip:  Use [JobName] as project name to map the jobs in Automation Engine to the projects in
WebCenter.

Note:  The project does not have to exist in WebCenter at upload time. If the project does not exist,
it will be created in WebCenter. The person that does the upload needs to be Project Manager in
WebCenter to be able to create a project in WebCenter over the upload.

• Folder: You can indicate in which folder the documents should be stored.
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• Document Name: You can set the name of the published document and this setting allows to
have documents published with a name which is different from the name of the published file.

• Document Description: You can enter a description about the document which will be available
in WebCenter.

• Project Template: Here you can enter the Webcenter Project Template. You should have created
this project template in WebCenter prior to using this ticket.

• User Name: Enter your WebCenter user name to gain access to the site. User name and password
are used by WebCenter to check if the Automation Engine operator has the right to publish in
the specified project.

• Password: Enter your WebCenter password to gain access to the site.

Note:  You can use SmartName in most of the fields.

Approval

The Approval tab allows you to select if and when the approval cycle should be started on WebCenter.

Note:  Make sure you have an approval cycle set up in WebCenter!You can do this by setting up an
approval cycle in a project template, and creating your the project from this template.

Select the Start the Approval Cycle option if you want the approval cycle to start automatically as
soon as the file is uploaded to WebCenter.

If the user you logged in with in the Destination tab has the Change Approval Setup permission in
WebCenter, you can also set the approval Due date. You can choose:

• today,

• tomorrow,

• today + x days (then define the number of days in the x = field that appears),

• job due date,

• other... (then enter the due date or select it in the calendar).

You can also select the hour at which the cycle should be completed (except when using job due
date).

2.7.112 Publish On WebCenter

This task is documented in the chapter Integrating with WebCenter. Find a direct link here.

2.7.113 Relocate Job

This task is documented in the separate chapter on Jobs. Find a direct link here.
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2.7.114 Resize PDF for Output

This task allows to resize PDF pages and/or their contents for output to a proofer or a RIP.

Note:  The task uses the Dimension unit defined in the Preferences. You can use SmartNames for
the values.

Resize to a specific page size: Select this parameter to adjust the PDF markup for a given paper
size.

Leave it deselected if you only want to adjust the page contents (page boxes, etc.).

Selecting or deselecting this parameter affects which parameters you see in the Page Content and
Page Size areas. See Resizing PDF Pages on page 450 and Resizing PDF Contents on page 451
for details.

Resizing PDF Pages

When Resize to a specific page size is selected, you can resize the PDF pages and their contents
using the following parameters:

1. In the Page Content area, select the Page Box to Use for positioning, scaling, etc.

2. Select how to Position this page box and its contents on the page:

• Don’t Fit (default): the file will be placed “as is”.
• Center on Page: the task will center the job in the selected page box.
• Scale to Fit (Reduce Only): the task will scale the job down if necessary, so it fits in the

selected page box.
• Scale to Fit (Reduce & Enlarge): the task will scale the job up or down if necessary, so it fits

in the selected page box.
• Use Tiling: the task will keep the original file size, and tile it over several pages as necessary.
• Use Proportional Tiling: the task will tile the file over several pages as necessary, but make

all tiles the same size.
• Gripper on Top: the task will leave space for the gripper at the top of the page.
• Gripper at the Bottom: the task will leave space for the gripper at the bottom of the page.

When selecting Use Tiling or Use Proportional Tiling, you can enter the size of the Tile Overlap
(where two tiles are partly on top of each other).

When selecting Gripper on Top or Gripper at the Bottom, you can enter the amount of space
needed for the gripper in Gripper Size.

3. Select Mirror page if you want to mirror the page contents and the page boxes horizontally.

4. If desired, use the Scale parameter to define a scaling to apply to the artwork before placing it
on the page.

Note:  The Scale, Horizontal Distortion and Vertical Distortion parameters are not available
when selecting Scale to Fit (Reduce Only) or Scale to Fit (Reduce & Enlarge) in the Position
parameter.

5. If desired, enter a Horizontal Distortion and/or a Vertical Distortion to apply to the artwork
before placing it on the page.
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Distortion is a stretch of the jobs’ original dimensions. It is specifically important for Flexo jobs.

When mounting a Flexo plate on the press, it is stretched out in one direction. By making the
output slightly smaller than needed, we compensate for this distortion. The dimensions of the
original file remain unchanged.

You can either enter the distorted output values (for example 97% or 103%), or the positive/
negative distortion values (for example -3% or +3%). Leave the values at 100% (default) to apply
no distortion.

6. Select Clip on selected page box if you want to clip away all artwork outside the page box you
selected in Page Box to Use.

Note:  The artwork outside the selected page box is not deleted, just clipped away by a clipping
path (it is invisible but still present in the file).

7. Select Crop to fit if you want to crop your Page Box to the content of your original file.

8. In the Page Size area, select the page size you intend to print to in New Page Size.

This page size is used by the Scale and Position parameters.

• If you select a predefined page size, you will see an Orientation parameter, where you can
select the orientation of the paper you intend to use. Choose either Portrait or Landscape.

• If you select Custom as a page size, you will see a Page Width and a Page Height fields
where you can enter the dimensions of the custom paper you intend to use.

9. Enter the Page Margins required by the output device.

The Page Margins value you enter will be used for the four sides of the page. These margins
cannot be used for exposing.

Resizing PDF Contents

If you don't select Resize to a specific page size, you can resize/reposition the PDF contents using
the following parameters:

1. In the Page Content area, select the Page Box to Use for positioning, scaling, etc.

2. Select Center content on page if you want to center the page contents on the page.

3. Select Mirror page if you want to mirror the page contents horizontally.

4. If desired, use the Scale parameter to define a scaling to apply to the artwork before placing it
on the page.
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Note:  The Scale, Horizontal Distortion and Vertical Distortion parameters are not available
when selecting Scale to Fit (Reduce Only) or Scale to Fit (Reduce & Enlarge) in the Position
parameter.

5. If desired, enter a Horizontal Distortion and/or a Vertical Distortion to apply to the artwork
before placing it on the page.

Distortion is a stretch of the jobs’ original dimensions. It is specifically important for Flexo jobs.

When mounting a Flexo plate on the press, it is stretched out in one direction. By making the
output slightly smaller than needed, we compensate for this distortion. The dimensions of the
original file remain unchanged.

You can either enter the distorted output values (for example 97% or 103%), or the positive/
negative distortion values (for example -3% or +3%). Leave the values at 100% (default) to apply
no distortion.

6. In the Page Size area, use the Set Orientation parameter to alter the orientation of every page
without resizing it. You can choose either:

• Keep,

• Portrait,

• Landscape.

7. Use the Rescale page boxes and Rescale page size parameters to define what happens when
you scale the page contents:

a) Select Rescale page boxes to scale the page boxes together with the contents.

Deselect it to only scale the page contents and not the page boxes.
b) Select Rescale page size to scale the page size together with the contents.

Deselect it to only scale the page contents and not the page size.

2.7.115 Resolve OPI

Use this task to resolve the OPI-links (links to external high-resolution images) in incoming PDF files
that contain the low-resolution images and links to the corresponding high-resolution images.

Note:  You can use SmartNames in most fields of this dialog. For information on SmartNames, see
SmartNames on page 916.

Repository tab

• Add the location(s) of the external folder(s) that contain(s) the OPI-files.
• If necessary, add the location(s) of the excluded folders. These folders will not not be searched.

Note:  Use this option if all images can be found on the same volume and you want to exclude
all folders containing low-resolution files.

• Select the option Update OPI links only to only update the links to the high-resolution images
and not to replace the links by embeddeding the high-resolution images.

Mapping tab

Add the extensions that need to be replaced while resolving the OPI-links:
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• In the From field enter the original extension. If left blank, the extension in the To field will be
applied to all linked files.

• In the To field, enter the new extension to give the linked files, or a comma-separated list of
extensions to use as replacement for the original extension.

Note:  If you enter multiple extensions, Automation Engine will search for a file matching one of them.
Use the backslash ( \ ) to preserve a character (for example to use a comma as part of an extension
and not as a separator).

2.7.116 Restore Job

This task is documented in the separate chapter on Jobs. Find a direct link here.

2.7.117 Rip IMP File to Screened and Unscreened Tiff File

This task is a combination of the Rip to Screened Tiff File task and the Export Imposition to GRI
File task.

2.7.118 Rip to CDI LEN File

This task has a lot of settings in common with the Rip to Screened Tiff File task.

Select the device on which you want to expose.

This task has five tabs:

• General (see the Rip to Screened Tiff File ticket.)

• Inks (see the Inks tab in a Rip to Screened Tiff File ticket.)

• Advanced (see the Advanced tab in a Rip to Screened Tiff File ticket.)

• Pre-Rip (see the Advanced tab in a Rip to Screened Tiff File ticket.)

• Output

Output

Note:

Output settings that have been specified in the Dispatcher Queue Settings, are preceded by a blue

icon .
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Configuration Set

Name of the selected configuration file. These configuration files represent specific behavior of the
output device.

Output File

Path: leave this empty to use the output path as defined in the Dispatcher (EskoLink queue - Output
tab). If your EskoLink queue has no value for the output place; then you can define output folders
here.

Name: leave this blank to get an output file name based on the input file. The output name of a
multipage file will look as follows: <file >_<page>_<sink>. Non-multipage file will loose the <page>
indication. Edit this to overrule this standard behavior. Only plain letters and numbers will be allowed.
Other, unsupported characters (symbols) will be replaced by an _.

Resolution

Define the resolution of the output file.

• Perimeter: When a predefined configuration set is chosen, this perimeter field will be grayed out
and will show the perimeter as it was set in the device queue (see Configure tool). When no ‘conf’
was selected. You will be able to edit this field

• Pixelclock: Choose here the appropriate Pixelclock of your CDI. This field will most probably
be fixed as it does read what CDI type your device queue was based on (in the Configure tool).
‘VariablePLL ’ CDIs will not show the Pixelclock field nor the Perimeter field.

• Actual resolution: This informational field shows the result of the desired resolution and the effect
of the perimeter on that desired resolution. It is the combination of these two, the so called ‘actual
resolution’ that will be requested to the Rip. The FlexRip will then (see the log file) round off any
non-integer number.

Compression

Indicates the compression method that will be used.

2.7.119 Rip to Screened and Unscreened DCS File

This task has a lot of settings in common with the Rip to Screened Tiff File task.
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Select the device on which you want to expose.

This task has five tabs

• General (see the Rip to Screened Tiff File ticket.) There's the obvious distinction between the
Screened and unscreened DCS file. The unscreened ticket will not show the screening options.

• Inks
• Advanced (see the Rip to Screened Tiff File ticket.)
• Pre-Rip (see the Rip to Screened Tiff File ticket.)
• Output

Note:

The fields in gray are the presets that are defined in the Dispatcher Queue settings.

Output

Note:

Output settings that have been specified in the Dispatcher Queue Settings, are preceded by a blue

icon .

Configuration Set

Name of the selected configuration file. These configuration files represent specific behavior of the
output device.

Output File

Path: is defined in the Dispatcher (EskoLink queue - Output tab). If your EskoLink queue has no value
for the output place; then you can define output folders here.

Name: leave this blank to get an output file name based on the input file. The output name of a
multipage file will look as follows: <file >_<page>_<sink>. Non-multipage file will loose the <page>
indication. Edit this to overrule this standard behavior. Only plain letters and numbers will be allowed.
Other, unsupported characters (symbols) will be replaced by an _.

Select a Resolution.



2
Automation Engine

456

Single File DCS: when this toggle, all separations will be ripped to separate files first. Afterwards,
they will all be included in the final DCS file. This means that in the end only one file is created. If you
don't select this toggle a Master file will be created, referring to plate files. The number of plate files
to which is referred equals the number of separations.

Compression

Choose the compression for the output TIFF file: Flate, LZW or CCITT Group.

The LZW compression is most commonly used.

CCITT group compressions are more effective but take longer to generate (and to decompress on
the receiving side).

The compression to use in your workflow depends on the TIFF downloader on the device you are
creating the TIFFs for.

Define the Preview resolution.

• For placement only (in a DTP application)
• Proofable Preview (composite printing from a DTP application)

Inks

All Inks. The standard behavior of the default ticket is to offer all inks in the job to be exposed.
Deactivating ‘All Inks’ opens the ink list where you can select specific inks.The list contains ink names,
ruling, angle, dot shape and ink type.

Use technical inks in output. Normally technical inks are hidden when you save a job in an Esko
editor. Check the box to output the visible (non hidden) technical inks.

Keep similar inks in their original separations

Keep inks separated
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Use Merge with to output inks on top of each other in the same output file. This is common when
you use different rulings for 1 ink.

For example, Let's assume that the job contains two Cyans, and that they have a different ruling.
You might want to put them on the same separation. You can do so by clicking in the 'Merge with'
column and selecting the ink it has to be merged with.

Click Merge Similar Inks to prompt the system to look for the same inks with a different ruling or
angle. The image shows how two Cyans (with a different ruling) were detected and put together. You
can reset any modifications by clicking Reset.

Check the box Highlight modified values to have all modified values highlighted and preceded or
followed by an asterisk.

2.7.120 Rip to Screened and Unscreened PDF File

This task has a lot of settings in common with the Rip to Screened Tiff File task.

Select the device on which you want to expose.

This task has five tabs

• General (see the Rip to Screened Tiff File ticket.) There's the obvious distinction between the
screened and unscreened PDF file. The unscreened ticket will not show the screening options.

• Inks (see the Rip to Screened Tiff File ticket..)
• Advanced (see the Rip to Screened Tiff File ticket.)
• Pre-Rip (see the Rip to Screened Tiff File ticket.)
• Output

Note:  The fields in gray are the presets that are defined in the Dispatcher Queue settings.
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Output

Note:

Output settings that have been specified in the Dispatcher Queue Settings, are preceded by a blue

icon .

Configuration Set

Name of the selected configuration file. These configuration files represent specific behavior of the
output device.

Plate Size

This shows the plate size of the configuration file you selected.

Output File

Path: leave this empty to use the output path as defined in the Dispatcher (EskoLink queue – Output
tab). If your EskoLink queue has no value for the output place; then you can define output folders
here.

Name: leave this blank to get an output file name based on the input file. The output name of a
multipage file will look as follows: <file >_<page>_<sink>. Non-multipage file will loose the <page>
indication. Edit this to overrule this standard behavior. Only plain letters and numbers will be allowed.
Other, unsupported characters (symbols) will be replaced by an _.

Select a Resolution.

Anti-aliasing When ripping to Unscreened PDF files the output tab offers the option to use Anti-
Aliasing.Anti-aliasing is relevant for the line-art objects in your design, that need pre-processing and
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for which CTs are generated. Anti-Aliasing smoothens the staircase effect you get in the generated
CTs of line-art objects that need pre-processing.

PDF Version

Select a PDF version from the list.

• PDF for Illustrator: Select this version if you want to open the generated PDF 1.4 file in Adobe
Illustrator CS2 or higher. Because Adobe Illustrator only supports a (undocumented) subset of
PDF 1.4 features, some objects and/or colorspaces must be split up, transformed and/or pre
ripped in order to correctly represent them in Illustrator.

• PDF/X-1 a:2001 (ISO 15930-1)
• PDF/X-3 (ISO 15930-2)
• PDF 1.4: the Acrobat 5 file format

Single / Multi file

When selecting 'single' file output, all separations will be ripped to separate files first. Afterwards,
they will all be included in the final PDF or PostScript file. This means that in the end only one file is
created. Selecting 'multiple' file output creates a Master file, referring to plate files. The number of
plate files to which is referred equals the number of separations.

Softproofing

When soft proofing is enabled FlexRip/P writes a composite PDF file that combines the different
separations in a single PDF page. This PDF file can be used for colored viewing in Acrobat.

The combination of 'Single file' with 'Softproofing', can lead to four situations:

• All separations are written in a different page, and all pages are written in a separate output file.
(no soft proofing, multi file)

• All separations are written in a different page, and all pages are concatenated in a single file. (no
soft proofing, single file)

• Separations are kept together per page, and all pages are written in a separate output file. (soft
proofing, multi file)

• Separations are kept together per page, and all pages are concatenated in a single file. (soft
proofing, single file)

Compression: choose between CCITT (group 3 and group 4), Flate, RLE, LZW, JPEG and 'No
compression'.

Encoding

• Ascii 85: Encodes binary data in an ASCII base-85 representation. This encoding uses nearly all
of the printable ASCII character set. The resulting expansion factor is 4:5, making this encoding
more efficient than hexadecimal.

• Binary: The image data is represented as binary data. This results in compact files that however
are not editable in a common ASCII editor. Nor can these files be sent over a communication line
using a communication protocol that relies on control characters in the data stream itself.

• Hex: In this way, the PostScript file remains editable with an ASCII editor at all times. They also
can be sent over a communication line using whatever communication protocol is available. The
drawback, however, is that hexadecimal image data may take up to twice as much size as binary
data.

2.7.121 Rip to Screened and Unscreened PostScript File

This task has a lot of settings in common with the Rip to Screened Tiff File task.
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Select the device on which you want to expose.

This task has five tabs

• General (see the Rip to Screened Tiff File ticket.) There's the obvious distinction between the
screened and unscreened PS file. The unscreened ticket will not show the screening options.

• Inks (see the Rip to Screened Tiff File ticket..)

• Advanced (see the Rip to Screened Tiff File ticket.)

• Pre-Rip (see the Rip to Screened Tiff File ticket.)

• Output

Note:

The fields in gray are the presets that are defined in the Dispatcher Queue settings.

Output

Note:

Output settings that have been specified in the Dispatcher Queue Settings, are preceded by a blue

icon .

Configuration Set

Name of the selected configuration file. These configuration files represent specific behavior of the
output device.

Plate Size

The plate size of the above selected configuration file is shown.

Output File

Path: leave this empty to use the output path as defined in the Dispatcher (EskoLink queue – Output
tab). If your EskoLink queue has no value for the output place; then you can define output folders
here.
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Name: leave this blank to get an output file name based on the input file. The output name of a
multipage file will look as follows: <file >_<page>_<sink>. Non-multipage file will loose the <page>
indication. Edit this to overrule this standard behavior. Only plain letters and numbers will be allowed.
Other, unsupported characters (symbols) will be replaced by an _.

Select a Resolution.

Anti-aliasing When ripping to Unscreened PostScript files the output tab offers the option to
use Anti-Aliasing. Anti-aliasing is relevant for the line-art objects in your design, that need pre-
processing and for which CTs are generated. Anti-Aliasing smoothens the staircase effect you get in
the generated CTs of line-art objects that need pre-processing.

Single / Multi file When selecting 'single' file output, all separations will be ripped to separate files
first. Afterwards, they will all be included in the final PDF or PostScript file. This means that in the end
only one file is created. Selecting 'multiple' file output creates a Master file, referring to plate files.
The number of plate files to which is referred equals the number of separations.

Compression Choose between CCITT (group 3 and group 4), Flate, RLE, LZW, JPEG and 'No
compression'.

Encoding

• Ascii 85: Encodes binary data in an ASCII base-85 representation. This encoding uses nearly all
of the printable ASCII character set. The resulting expansion factor is 4:5, making this encoding
more efficient than hexadecimal.

• Binary: The image data is represented as binary data. This results in compact files that however
are not editable in a common ASCII editor. Nor can these files be sent over a communication line
using a communication protocol that relies on control characters in the data stream itself.

• Hex: In this way, the PostScript file remains editable with an ASCII editor at all times. They also
can be sent over a communication line using whatever communication protocol is available. The
drawback, however, is that hexadecimal image data may take up to twice as much size as binary
data.

2.7.122 Rip to Screened and Unscreened Tiff File

Select the device on which you want to expose.

Note:  The fields in gray are the presets that are defined in the Dispatcher Queue settings.

General
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Transformations

Scale V and Scale H: Define here in % the requested vertical or horizontal scaling. Scaling direction
is always applied ‘as the file is ’ (so the V and H are the V and H as you see them in the editor).

Rotate: Choose the requested rotation from the list. Rotation is counter clockwise.

Shrink values from File: GRQ (QuickStep) jobs that have shrink values defined inside the GRQ file
will show these values here. You can choose to deactivate the toggle and still edit (overrule) the
values.

Attention:

If you use both scaling and distortion (shrink) options, then both these scaling values will be
executed!

For example: if you have distortion V 98% set here and in the above options Scale V 95%,
then the output-size for V will be 98% of 95% (which is 93.1 %).

So the job will be scaled first and then distorted.

Positive-negative  : Define whether you want a positive or negative output file.

Mirroring  : Choose whether you want mirroring or not.

Original Size (incl. Margins):The system provides the original Job size, margins included.

Output Size (incl. Margins): The real output size. The size shown here is the original job size
influenced by the scaling factors (and/or distortions) and the chosen rotation.

Select a Mark Set from the dropdown list. These marks were created (in a central database) by the
SmartMarks tool in the LineWork editor (from the Production menu ).

Screening
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Note:  The Screening options will not be shown in the Rip to Unscreened Tiff File ticket.

• Type: choose between Esko Classic (Precalculated), DynaCell, DynaCell HighlineXM,
HighlineXM and Seamless.

• Dotshape: The selection of JOB (Dotshape(s) from job)’ will show in orange when the job does
not have the predefined dots (in its ink menu).

Attention:  You can expose with an 'orange' dot shape, but the Rip's default dotshape will
be used then.

Press Dot Gain Compensation

• Single Curve: Select the preferred DotGain Compensation Curve.

• Automatic: Select the preferred Screen based Dot Gain Curve.

• Platemaking DGC: displays the platemaking DGC defined (if any) in the FlexRip Configurator.

Tip:  The Dot Gain Compensation will be applied to Smart Marks as well. The Curve will be applied
and compensated for smart marks. To prevent this, rip smart marks separately as copy-dot files.

Inks

Inks on separate TIFF files This toggle appears when you're outputting to a merging device. Toggle
it on to make sure that different inks end up on different films.

All Inks The standard behavior of the default ticket is to offer all inks in the job to be exposed.
Deactivating ‘All Inks’ opens the ink list where you can select specific inks. The list contains ink
names, ruling, angle, dot shape and ink type.

If you are granted the Ink remapping in inks panel access right (see Access Rights on page 702),
you can edit the inks.

Double-clicking the color swatch opens the Edit Ink dialog:
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You can edit Lpi, Angle and Dotshape. Click 'OK' to apply the changes, 'Cancel' to close the dialog
without applying the changes and 'Reset' to reset all values to default ones.

Use technical inks in outputNormally technical inks are hidden when you save a job in an Esko
editor. Check the box to output the visible (non hidden) technical inks.

Keep similar inks in their original separations

Keep inks separated

Use Merge with to output inks on top of each other in the same output file. This is common when
you use different rulings for 1 ink.

For example, let's assume that the job contains two Cyans, and that they have a different ruling.
You might want to put them on the same separation. You can do so by clicking in the 'Merge with'
column and selecting the ink it has to be merged with.

Click Merge Similar Inks to prompt the system to look for the same inks with a different ruling or
angle. The image shows how two Cyans (with a different ruling) were detected and put together. You
can reset any modifications by clicking Reset.

Check the box Highlight modified values to have all modified values highlighted and preceded or
followed by an asterisk.
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Advanced

Hold In Rip Queue This option offers to hold the task in the rip-queue until someone manually
releases this task. For more information, please see the Tasks View.

Yellow Ruling choose between:

• Don't change Y ruling: this is the default, the Y ruling is not adapted.
• Change Y ruling: change the Y ruling, possibilities are: -15%, -7%, 0% (changes nothing), + 7%

and +15%.
• Change Y ruling stochastic: same as the 'Change Y ruling' settings, but the dotshapes is adapted

to the Monet dot.

CT Resampling: choose between:

• Don’t resample: this is the default. No resampling is done. This avoids most image pixel shift.

• Resample to highest CT resolution from job: this choice fixes the remaining image shift
problems, with the least upscaling possible without data loss.

• Resample to automatic chosen resolution: this option reduces broken dot problems, by
interpolating images to at least 1000 ppi

• Resample to output resolution: this is the slowest option, resampling all CT's to the output
resolution

Merge Queue
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If the device queue of a FlexRip/T4 Dispatcher allows the use of the Handlers’s background Merger
software (see setting in the Configure tool), you will get this extra ‘Merge ’ options tab.

Merge with other jobs Choose here if you want that merger program to merge these separations
with separations from other jobs or not. 'Merge with other Jobs' is deactivated by default.

When activating the ‘Merge with other jobs’, the other merge options will be offered.

Hold in Merge Queue This will ‘hold’ the separations in the merger database. This means they are
‘not to be considered for merging’. Use the Merger Monitor to see this database and to release the
entries that were put on ‘hold in merger’.

Force after… Use this toggle to have the separations be forced out of the merger database after a
chosen time. This prevents having to wait too long before the ‘minimum fill %’ has been reached.

Priority decides on the priority that entries will have in the merger database. Entries with a high
priority will be chosen sooner for merging with other entries.

Restriction The separations will only merge with other separations of jobs that have received the
same restriction value from the operator.This value can be anything, whatever makes sense for your
workflow. Some examples:

• fruit This word 'fruit' could be the restriction: these separations will only be merged with other
separations that were also sent with the same restriction : the word 'fruit'. Practical reason could
be that you wish to bundle the 'banana', 'cherry' and 'apple' job all on the same film.

• Bob. The word 'Bob' could be operator Bob's restriction to only get films with separations of
'his own jobs'.

Pre - Rip
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The Pre-Rip tab contains options that are only relevant when the job really needs pre-ripping. The
Pre-ripping mentioned here is the ‘simplification’ that can be necessary before the job-objects can
be offered to the Rip. The decision to do this is taken automatically. And even when this is done, the
options are best left to their default settings. Special objects (in Normalized PDF format) that require
the need for this ‘simplification for rip' pre-ripping are:

• ‘Edge vignettes’ (vignettes with alpha channels effect on the edge of the object)
• Barco Blends (=non contourized GRO-blends)
• Warped CTs (warping done on Placed CTs)

Pre-ripping results in making a plain CT of these special objects that the rip can handle them. The
resolution of such a CT and the anti-aliasing can be set here.

CT Resolution

• Custom: The CTs created during pre-ripping will be at the resolution given by the user. This
is the default choice (with a value of 304.8 ppi) and guarantees the behavior of previous Esko
Software Suite versions. This option allows for maximum flexibility in CT resolution setting but is
independent of output resolution.

• Output: The CTs created during pre-ripping will be at the same resolution as the output resolution
of the rip, with a maximum of 1000ppi. When selecting 'Output', the text field containing the CT
resolution shows what that resolution will be, but remains un-editable. This option allows for the
rip output to be optimal, but may slow down pre-ripping and may require more disk space.

• Automatic: The CTs created during pre-ripping will be at a resolution as close as possible to
300 ppi, depending on the output resolution. This CT resolution is calculated in such a way that
the output resolution of the rip is an integer amount of times this CT resolution. When selecting
'Automatic', the text field containing the CT resolution shows what that resolution will be, but
remains un-editable. This option is a compromise between optimal rip output and fast pre-ripping
using minimal disk space. Examples: If the output resolution of the rip is set to 609.6 ppi, then
the CT resolution will be set to 304.8 ppi. If the output resolution is 600 ppi or 1200 ppi, then the
CT resolution will be set to 300 ppi.

Specify the output resolution for the generated CT(s). Default output resolution is 12 lpmm or 304
ppi.

Anti-aliasing is relevant for the line-art objects in your design, that need pre-processing and for
which CTs are generated. Anti-Aliasing smoothens the staircase effect you get in the generated CTs
of line-art objects that need pre-processing.
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Vignette NoiseSmoothens the tone jumps or banding effect in vignettes by adding noise/grain (in
%). The amount of noise can be specified in the noise field. The higher the value, the more noise
(grain) is added.

The Blend to CT toggle converts the Barco Graphics blend objects into a CT when exposing your job.

Use the Smooth Blend toggle to set the steps of the blend objects to 255 steps when exposing
your job. As long as Convert Blend Objects to CT is not activated, Smooth Blend appears dimmed.
When Convert Blend Objects to CT is activated and Smooth Blend also, the generated CT will ignore
the original steps of the blends of your Barco Graphics design. The amount of steps is set at the
maximum which is 255. The goal is to obtain a fluid blend effect.

Ripping jobs with lots of transparency can be rather slow. By using the Resolve Transparency toggle
you can resolve transparencies up-front.

Using the Convert Strokes toggle, strokes in the job will be converted to regular objects. By doing so,
the Miter limit calculation will be done in exact the same way as it is done in for example PackEdge.

Output

Note:

Output settings that have been specified in the Dispatcher Queue Settings, are preceded by a blue

icon .

Configuration Set

Name of the selected configuration file. These configuration files represent specific behavior of the
output device.

Plate Size

The plate size of the above selected configuration file is shown.

Output File
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Path: leave this empty to use the output path as defined in the Dispatcher (EskoLink queue – Output
tab). If your EskoLink queue has no value for the output place; then you can define output folders
here.

Name: leave this blank to get an output file name based on the input file. The output name of a
multipage file will look as follows: <file >_<page>_<sink>. Non-multipage file will loose the <page>
indication. Edit this to overrule this standard behavior. Only plain letters and numbers will be allowed.
Other, unsupported characters (symbols) will be replaced by an _.

Select a Resolution.

Anti-aliasing When ripping to Unscreened PostScript files the output tab offers the option to
use Anti-Aliasing. Anti-aliasing is relevant for the line-art objects in your design, that need pre-
processing and for which CTs are generated. Anti-Aliasing smoothens the staircase effect you get in
the generated CTs of line-art objects that need pre-processing.

Compression Choose the compression for the output TIFF file. The LZW compression is most
commonly used. CCIT group compressions are more effective but take longer to generate (and to
decompress on the receiving side). Which compression to use in your workflow depends on the TIFF-
downloader of the device you are creating the TIFFs for.

2.7.123 Router

This Workflow Control is documented in the chapter "Workflows". See Router on page 1024.

2.7.124 Run Script

You can use this task to run a script on the input file. You can run AppleScript, Shell Script in Mac
while you can Batch File and Windows Script in Windows . You can use scripting to automate Adobe
Illustrator, Photoshop, InDesign and InDesign Server via ExtendScript in Mac and Windows.
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1. Run on: is the name of the computer where your Automation Engine ScriptRunner is installed.
You can read more about configuring and naming Script Runner here Scripts on page 681

See Scripts  on page 681 for details on how to configure a Script Runner to your Automation
Engine server.

2. Select the Script Type. The script types are different, depending on your OS:

a) For Mac OS: You can choose from AppleScript, Shell Script and ExtendScript.
b) For Windows OS: You can choose from Batch File, ExtendScript, Windows Script and

Windows Script (32-bit).

The type Windows Script will run your script using a 64-bit Scripting Host on a 64-bit Windows
OS and a 32-bit Scripting Host on a 32-bit Windows OS.

3. Select the Script File. You can select one from the drop-down list, enter a path or/and use
SmartNames.

4. If the script you want to run needs one or more parameter(s), enter them in Script Parameters:
click Add and type the parameters.

2.7.125 Select File

The Select File workflow control allows you to select one or a group of files on which you launch
the next workflow step

Learn more about workflows and see some examples in the chapter Workflows on page 986
(specifically in Workflow Controls on page 1014).

Note:  You can use SmartNames, and * as wild card character in all input fields.
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Note:  In fields that end with "name matches", you can also use regular expressions. Learn more in
Using Regular Expressions  on page 978.

1. Define what file types you want to select in the File Type list. You can:

• choose to select Any file type,

• pick one of the default file types,

• choose Select File Types and pick them in the Select File Types dialog.
2. Select which files you want to select:

• Select task's input files will select all input files (of the selected File Type if you specified one).

Use the Only select when name matches option if you want to filter the input files to select
based on their name.

• Select Product Parts linked to a Job with name will select Product Parts linked to a job of
your choice. Specify the job name in this option.

Use the Only select when File name matches option if you want to filter the Product Parts
based on the name of the file they contain.

See the chapter Products on page 876 more information about Products and Product Parts.

• Select other will select other files or folders (that have not been processed by the workflow).

1. Choose to select Files or Folders.
2. Use the Name Matches option to select those files or folders based on their name. This

is not case sensitive.
3. Define where the files or folders to select are located in Look in Folder. Choose to Look

in sub folders or not.
3. If desired, you can choose to make the Task end in Error when no files were selected.

2.7.126 Select Mark File

This Workflow Control is documented in the chapter "Workflows". See Mark File and Select Marked
File on page 1029.

2.7.127 Select Referenced File

This Workflow Control is documented in the chapter "Workflows". See Select Referenced File on
page 1018.

2.7.128 Send E-mail

You can use this task to have Automation Engine send an E-mail automatically at a certain point in
your workflow.

This E-mail can contain:

• custom text,
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• job information (you can use SmartNames in all of the ticket's fields),
• the task input files.

Note:  The mail server settings must be correctly set in Configure for this task to work. See E-Mail
Configuration on page 636.

1. Enter the E-mail address(es) you want the E-mail to be sent To. If you want to send the E-mail
to the customer, add the SmartName (E-mail address) from SmartName category Customer E-
mail address You can use SmartNames to add the E-mail address of the Task owner from Task
information category in the SmartName field.

Note:  If you use SmartNames, make sure they resolve to a valid E-mail address.

2. If desired, add extra E-mail address(es) in Cc. The recipients' mail address will be displayed to
the receiver.

3. If desired, add extra E-mail address(es) in Bcc. The recipients' mail address will not be displayed
to the receiver.

Similar to the To field, you can also use SmartNames (that are valid E-mail addresses) in Cc an
Bcc.

4. Enter the desired E-mail Subject.

5. If desired, you can change the sender of the mail in From. By default the E-mail address of the
Task Owner will be used.

The Send E-Mail task's ability to send E-mails on behalf of the task owner (or any other user
address that's filled in as From) is subject to the mail server configuration. When in doubt, please
consult your IT administrator.

6. Enter your Message.

7. By default, the Send E-mail task uses the system's local encoding.

If you notice unreadable characters when reading an Automation Engine E-mail in your E-mail
program (for example for Asian characters), you can change the encoding to UTF-8.

Add this to the Message field: to...

#set ($SubjectCharSet="utf-8") set the encoding of the Subject to UTF-8.

#set ($ContentType="text/
plain;charset=utf-8")

set the encoding of the Message to UTF-8 and
use plain text.

#set ($ContentType="text/
html;charset=utf-8")

set the encoding of the Message to UTF-8 and
use HTML.

#set ($AttachmentsCharSet="utf-8") set the encoding of the file name of the
attachments to UTF-8.

8. If you want to include the task input files, select Attach input files.

9. You can set public parameters if you want to be able to fill in E-mail settings when submitting
files to your workflow from Shuttle.

Learn more in Using Public Parameters in Workflows on page 1051.

10.Save your ticket if you want to use it as an E-mail template later.
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Note:

Self-closing tags are not supported (example <br/> or <address/>). When setting up HTML E-mails,
you have to use a separate opening tag and closing tag (example <address></address>), or the
empty variant (example: <br>).

2.7.129 Send PostScript File to Device

This task outputs a PostScript file to a PostScript device.

Use the drop down list to select the PostScript device you want to output to. The devices are
PostScript devices defined on the server.

2.7.130 Send to Nexus

The Send to Nexus ticket consists of two parts:

• the top section of the ticket dialog is always the same, and allows you to:

• select a particular Nexus workflow from the Workflow list;

• indicate whether you want to launch a new, separate workflow in Nexus for every file you select
in the Pilot (Separate Tasks), or whether you want to send all the selected files to one Nexus
workflow (One Single Task).

• the bottom section of the ticket dialog contains fields for the public parameters for the workflow
you selected. These parameters can be different for every Nexus workflow (they are defined using
NeXML).
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For more information, please see Integration with Nexus on page 103 in the User Guide.

2.7.131 Send to Odystar

The Send to Odystar ticket consists of two parts:

• the top section of the ticket dialog is always the same, and allows you to:

• select a particular Odystar workflow from the Workflow list;

Tip:  If you can’t see the workflow you are looking for, use the refresh button .

• indicate whether you want to launch a new, separate workflow in Odystar for every file you
select in the Pilot (Separate Tasks), or whether you want to send all the selected files to one
Odystar workflow (One Single Task).

• the bottom section of the ticket dialog contains fields for the public parameters for the workflow
you selected. These parameters can be different for every Odystar workflow (they are defined in
the Inspector).

Note:  You can also manage your Odystar workflow’s public parameters (not one by one but as
a group) in your task ticket. See Managing Public Parameters in Your Ticket on page 70.
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2.7.132 Set Priority

This Workflow Control is documented in the chapter "Workflows". See Set Priority on page 1021.

2.7.133 Sort

This Workflow Control is documented in the chapter "Workflows". See Sort on page 1021.

2.7.134 Split Pages

The Split Pages task can split a multi-page PDF into single page PDFs, or smaller multi-page PDFs,
and generate a RunList that contains references to all output PDFs.

Output in: select where you want to output the generated PDFs and the RunList. By default, this is
the location of the original file ([File URL]).

File Name: Enter the name of the generated RunList. By default, this is [File]_RunList.jdf.

Split Mode: Choose how you want to split the pages of the input file:

• Split Pages: the task will split the job into individual 1-page files, and generate a RunList.
• Split in Groups: the task will split the job into several files having the same number of pages, and

generate a RunList. You can enter this number of pages in the Group Size parameter.
• Extract Pages: the task will extract the pages you specify in the Page Ranges parameter, and

generate a RunList.

Note:  Depending on the Split Mode you choose, you will see different parameters.

Group Size: This parameter is available when you choose the Split in Groups Split Mode.

Enter the number of pages you want each output file to have.

Note:  If the task cannot output files having the same number of pages (for example if you send a 5
pages PDF to be split into files of 2 pages), the last output file will have less pages.

Pages File Name: Use this parameter to set the name of the output files.

You can use SmartNames in this field, including two extra SmartNames: [Page Label] and [Page
Number] (the page label and page number included in the PDF).

Page Ranges: This parameter is available when you select Extract Pages in the Split Mode
parameter.

Enter the page ranges to extract: either single pages or page ranges with a hyphen (for example 1-3
for pages 1 to 3). Separate the page ranges by commas.

Output as one multi page document: This parameter is available when you select Extract Pages
in the Split Mode parameter.

Select it if you want to output all of the page ranges you entered as one single document.

Output remaining pages: This parameter is available when you select Extract Pages in the Split
Mode parameter.
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Select it if you want to output all the pages you didn't include in the Page Ranges parameter as
one multi-page PDF.

Remaining Pages File Name: This parameter is available when you select the Output remaining
pages parameter.

It allows you to set the name of the multi-page PDF containing all the pages you didn't include in
the Page Ranges parameter.

You can use SmartNames in this field (including the [Page Label] and [Page Number] SmartNames).

Copy XMP data: Select this parameter if you want to copy the XMP data of the original file to the
output files.

2.7.135 Split XML

This task is documented in the chapter Integrating with External Systems. Find a direct link here.

2.7.136 Step & Repeat CAD based

This batch step and repeat task is based on a die-layout, it places graphic files on the different
designs in the CAD layout.

This task supports MFG files (Artios Manufacturing files) and CFF2 files.

General

Location Stations Define the folder where the task can find the stations.

When the task is unable to find the correct files, set the task's status to:
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• Provide Info
• Generate a warning, the task will continue.
• Generate an error, the task will stop.

Add SmartMarks by selecting a SmartMark set from the drop down list. You can also use
SmartNames.

Check the 'Load Mark Set in bottom layer' box if you want to make sure the marks are positioned
in the bottom layer, to make them appear 'behind' the graphics.

The Limit Bleed toggle: the bleed can be limited to a specific distance. The bleed mask is created
by spreading the die shape.

Plate Setup

The sheet size is automatically extracted from the CAD template but neither Artios MFG nor CFF2
have a notion of plate. As a result the plate size and position of the sheet on the plate have to be
specified in the Plate Setup tab.

Plate Size: enter -if necessary- the plate's horizontal and vertical dimensions.

The Fit Plate to Sheet toggle makes sure that the plate has the same size as the sheet. Deselecting
this option enables you to manually define the plate size and the sheet offset.

Define horizontal and vertical Sheet Offset

Position the sheet on the plate by dragging and dropping the red square (the sheet) to the right
position on the blue square (the plate).

Enter horizontal and vertical shrink values.

Tip:  All edit fields are SmartName-enabled.

CAD Options



2
Automation Engine

478

Both Mapping and CAD Style are options you can define in the Esko Editors.

Mapping allows you to select a set of Mapping rules. Mapping rules allow to map DXF layer names,
DXF line styles and DXF color numbers onto line types (ArtiosCAD style). Use the mapping rules to
indicate which DXF elements will be imported as cut, crease or bleed lines. The mapping rules are
scanned from top to bottom, as soon as a DXF element matches a rule, the action corresponding
with this rule (ignore or import as cut, crease, bleed) will become effective.

A CAD Style changes the appearance of the imported CAD lines.

2.7.137 Step & Repeat Tabular

This task will execute all step and repeat parameters (number of one-ups vertically and horizontally,
gap between one-ups, alignment, SmartMarks...), and output the sheet layout.

The ticket’s input fields also accept SQL queries, so that information stored in a database can be
used to drive the sheet layout creation.

The main benefit of this process is the single entry point for data: the typical production-critical data
required for step & repeat is usually known upfront and stored in a project or workflow management
system.

The operator does not have to enter these values from a printed sheet, which results in serious
performance increases and reduction of human errors.

Tabular typically means 'next to each other'. In this task, data can be entered in three different ways:

• Manually entered numeric values,
• Esko formulas like [VPLATE] (the Esko legacy QuickStep formulas),

• User - defined SQL queries that retrieve the values from external (DIE) databases.

General
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Origin: define the point of origin from which the repetition is to be built. Choose from four possible
origins.

 (top left),  (top right),  (bottom left),  (bottom right).

Unit: select a unit (mm or inch).

SmartMarks: Select SmartMarks from the dropdown list if needed.

Insert SmartNames button   Click this button to open the SmartNames dialog. The button is
only enabled if the selected input field accepts SmartNames.

Tip:  Double clicking or right-clicking a field also opens the 'Insert SmartNames dialog'.

Check the 'Load Mark Set in bottom layer' box if you want to make sure the marks are positioned
in the bottom layer, to make them appear 'behind' the graphics.

Plate

Size: enter the horizontal and vertical plate formula, value or SmartName(s). Shrink: if necessary,
enter a shrink value, formula or SmartName.

Sheet

Size: enter the horizontal and vertical sheet formula, value or SmartName(s) (see Formulas on page
487 for details).

Offset: enter an offset value.

Sheet Position on Plate: position the sheet on plate by moving the red rectangle (the sheet) on the
blue square (the plate).

Screen registration: relevant only to Esko FlexRip users.

When activated, the origin of the screening will be reset for each one-up on the layout. This
guarantees that the exact same screening will be applied for each one-up.
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When deactivated, screening will be done continuously throughout the complete job.

Tip:

Right-click a field to open an extra dialog:

• Cut
• Copy
• Paste
• Clear Contents
• Insert Formula (choose between a global or a grid formula). See Formulas on page 487.

• Insert SmartNames

Note:  Some fields only accept SmartNames defined with 'Step and Repeat' where as others also
allow global SmartNames. See SmartNames for more information.

Grids

A repetition chart may be composed of several grids. If a repetition chart is composed of two jobs,
there will be two grids. Each grid has its own number.

Grid Tab Columns

1. Grid number You can click it to select the corresponding grid.
2. File Name This shows the name of the one-up assigned to this grid.
3. Grid Mask  To define the mask area around a job.

Depending on where the repetition is positioned in the layout, a mask may or may not be required.
Use the dropdown list to choose between 'none' or 'borders'. The dropdown list appears when
you click the field.

4. Grid Mask Bleed   To extend a selected grid mask with a bleed.

Specify the spread distance in the Grid Mask Bleed input box.

Mask is spread but masks will not overlap.
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5. Vertical offset to sheet  To define the top or bottom shift of the grid in relation to the sheet,
depending on the setup of the origin.

6. Horizontal offset to sheet  To define the left or right shift of the grid in relation to the sheet,
depending on the setup of the origin.

7. Vertical step  To define the vertical distance between two steps of the grid. The distance is
calculated from center point to center point of the job.

8. Horizontal step  To define the horizontal distance between two steps of the grid. The distance
is calculated from center point to center point of the job.

9. Vertical count  To define the number of times you want to repeat your job vertically.
10.Horizontal count  To define the number of times you want to repeat your job horizontally.
11.Angle  To define the angle to rotate your job when repeated.
12.Head Turn / Stagger This column indicates if you have defined a head turn or staggering for your

grid (for example,  for vertical stagger, or  for column-based head turn). See Grid Settings
on page 481 for details on staggering and head turns.

Managing Your Grids

Add Grid: Use this button to add an extra grid.

Note:  When you select multiple files in the pilot, the system adds enough grids to accommodate all
the jobs you selected (the ticket is automatically updated).

Remove Grid: To remove a grid, select it and click this button.

Edit Grid: Select a grid and use this button to define advanced grid settings (staggering, head
turns...). See Grid Settings on page 481.

Other Options

Insert SmartNames...  opens the 'Insert SmartNames' dialog, which allows you to insert
'Formulas' in the selected field.

Note:  Some fields (Grid Mask and Grid Mask Bleed) cannot contain formulas.

Allow Multiple Inputs

This option determines what the task will do when you launch it on multiple files.

• Select it to generate one Step and Repeat file for all of the input files. Each input file will be
assigned a different grid in the Step and Repeat.

• Deselect it to treat each input file separately, and generate a different Step and Repeat file for
each input file.

Attention:

This option is only available when you open the Step & Repeat Tabular ticket from the
Tickets view.

To use this option on your files, save your Step & Repeat ticket as a custom ticket first.

Grid Settings
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In the Settings Grid x dialog, you can change settings defined in the ticket (File Name, Die Shape,
Bleed, and Geometry options), but also define advanced settings (Head Turn/Stagger).

Head Turn

Use this parameter to rotate certain stations in the grid by 180 degrees.

•
Use the first button ( ) to keep all stations as they are, without rotating them (default).
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•
Use the second button ( ) to rotate objects in alternating rows by 180°.

•
Use the third button ( ) to rotate objects in alternating columns by 180°.



2
Automation Engine

484

•
Use the fourth button ( ) to rotate objects both in alternating columns and in alternating rows
by 180°.

Stagger

Use the Stagger option to stagger (move) certain stations of your grid horizontally or vertically.

•
Use the first button ( ) to keep all stations as they are, without staggering them (default).

•
Use the second button ( ) to define a vertical stagger for your grid.

•
Use the third button ( ) to define an horizontal stagger for your grid.

To define a horizontal or a vertical stagger:

1. Click the horizontal or the vertical stagger button.
2. Enter a stagger value and choose a unit in the fields below the stagger buttons (mm, cm, mil, inch

or percentage of the width or height).

The example below shows a 4 x 6 Step & Repeat with a 50% vertical stagger.



2
Automation Engine

485

3. Adjust your staggering with the Restart after, Continuous or Up & Down options if you wish.

Restart after

You can choose to restart the staggering after a certain number of rows or columns. This means that:

• for vertical staggering: the top station of that column is positioned at the same height as the top
station of the first column (it has the same vertical offset from the top of the sheet).

For example, the staggering below restarts after 3 columns.

• for horizontal staggering: the first (leftmost) station of that row is positioned at the same horizontal
offset as the first station of the first row.

Continuous

Select Continuous if you want to add extra stations to fill the blank space.

The example below is a 4 x 6 Step and Repeat (with staggering restarting after 3 columns), but the
Continuous option added some stations vertically.
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Up & Down

Use Up & Down together with Restart after to go back in the other direction gradually instead of
at once.

The example below restarts after 3 columns, with the Up & Down option selected.

Rules
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You can modify the task's behavior by defining rules. Click 'Add' to open the 'Add Rule' dialog:

Define the 'Condition' and the 'Action'.

For example, we want to define a rule that states that all jobs with more than 8 inks shouldn't be
output.

First you define the condition, then you define what happens if the condition is not met.

1. Enter the parameter you want to use as check.
2. Choose an 'expression' from the dropdown list.
3. Enter the value for the parameter.
4. Choose the Action for when the conditions is not met from the dropdown list: OR the task finishes

with a warning OR the task finishes with a warning (there's no output).

Formulas

Some of the fields work with formulas, which act as parameters and may represent different things.

There are two different kinds of formulas: Global formulas (that define the whole repetition) and Grid
formulas (that define individual grids).

Note:  A repetition chart may be composed of several grids. If a repetition chart is composed of two
jobs, there will be two grids. Each grid has its own number.
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1. Global formulas:

• VPLATEFIT: vertical plate size that fits around a repetition sheet and SmartMarks.
• HPLATEFIT: horizontal plate size that fits around a repetition sheet and SmartMarks.
• VPLATE: vertical plate size.
• HPLATE: horizontal plate size.
• VSHEETOFFSET: vertical offset of the sheet relative to the Plate.
• HSHEETOFFSET: horizontal offset of the sheet relative to the Plate.
• VSHEETFIT: vertical sheet size that fits around the repetition.
• HSHEETFIT: horizontal sheet size that fits around the repetition.
• VSHEET: vertical sheet size.
• HSHEET: horizontal sheet size.
• SHEETTOP: top position of the sheet relative to the Plate.
• SHEETLEFT: left position of the sheet relative to the Plate.
• SHEETBOTTOM: bottom position of the sheet relative to the Plate.
• SHEETRIGHT: right position of the sheet relative to the Plate.
• NROFINKS: number of non-technical inks (Technical inks will not be printed).
• NROFGRIDS: number of grids

2. Grid Formulas:

x = the grid number.

• VLABELx: vertical size of non-rotated job.
• HLABELx: horizontal size of non-rotated job.
• VSTEPx: vertical step size, from center point to center point.
• HSTEPx: horizontal step size, from center point to center point.
• VSIZEx: vertical size of bounding box of rotated job.
• HSIZEx: horizontal size of bounding box of rotated job.
• VCOUNTx: number of vertical repetitions in grid x.
• HCOUNTx: number of horizontal repetitions in gridx.
• ANGLE: the angle of the rotation.
• GRIDVSIZEx: vertical size of the grid (top-bottom).
• GRIDHSIZEx: horizontal size of the grid (left-right).
• TOPx: top position of the grid relative to the sheet.
• LEFTx: left position of the grid relative to the sheet.
• BOTTOMx: bottom position of the grid relative to the sheet.
• RIGHTx: right position of the grid relative to the sheet.
• BLEEDx: distance to spread the grid mask with.

This example illustrates how one could use formulas to define an auto fill repetition: a defined sheet
will be automatically filled.
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The formulas break down like this:

1. First you define the vertical (and horizontal ) count of the grid: the vertical count is the vertical
size of the sheet divided by vertical size of the job, hence: VSHEET / VLABEL1. (The horizontal
count: HSHEET / HLABEL1.)

2. Then you are able to define the vertical  (and horizontal ) step: vertical gap is the vertical
sheet size divided by the vertical count, hence: VSHEET / VCOUNT1. (The horizontal step:
HSHEET / HCOUNT1).

3. Now for the vertical  (and horizontal ) offset: you want to center the repetition on the sheet.
You can do that by defining the vertical offset as half the vertical step minus the vertical size of
the job, hence: (VSTEP1-VLABEL1)/2. (For the horizontal offset: (HSTEP1-HLABEL1)/2 )
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Database Query: an Example

Let's say you have a database in which you keep data about the Die you use:

You might want to use this data to set up a Tabular Step and Repeat Ticket.

It's possible to define SmartNames in such a way that they query a database, and the Tabular Step
and Repeat Task is able to use SmartNames.

Note:

Use the Configure tool to define SmartNames (see SmartNames on page 916).

You can define SmartNames that query all the values of your database, using SQL commands, in
this example, we defined the following:

• DB_DrumH: Retrieves the value for the horizontal size of the drum.
• DB_DrumV: Retrieves the value for the vertical size of the drum.
• DB_GapH: Retrieves the value of the gap's horizontal size.
• DB_GapV: Retrieves the value of the gap's vertical size.
• DB_Teeth: Retrieves the number of teeth.
• DB_StepH: Retrieves the value of the die's horizontal step.
• DB_StepV: Retrieves the value of the die's vertical step.
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You can use the SmartMarks in the Step and Repeat Ticket: Use the Insert SmartNames... button,
or use the right mouse button shortcut.

The General tab:

The Grids tab:
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The ticket is now defined by using nothing but values queried from the database. Your database
controls the output.

2.7.138 Step & Repeat Tabular (Dynamic)

This dynamic version of the Step & Repeat Tabular task allows you full interactive control over the
grids and positioning, much as if you were doing this in an interactive application (like for example
PowerLayout, the stand-alone plug-in for Adobe Illustrator).

Use this Step & Repeat Tabular (Dynamic) task when you do not have a template that was created
with PowerLayout (if you do have such a template, then see the Step & Repeat Template based
(Dynamic) on page 499).

Clicking on one of the Task Options will show you their available settings. Almost all of these are
identical to those in the PowerLayout tool: See also documentation of PowerLayout standalone. As
usual , many of these options can be set by using SmartNames.

On Job level, you decide the Sheet and Plate options, the Filling Order of the items and you set
the Marks. On Grid level, you decide the amount of grids and their own specific filling order.

• Sheet and Plate options: See: Sheet and Plate Options on page 493.
• Filling Order options: See: Filling Order on page 493.
• Marks options: See: Marks on page 496.
• Grid x options: See Setting specific Grid Options  on page 496.
•

Grid selection : Use these buttons  to Add or Remove Grids, .

Note:  Grids are numbered sequentially. When three Grids are present, and you delete grid 2,
then grid 3 will automatically be renamed to grid 2.

Note:  Preview: The  Preview  displays the position of all grids. The currently active grid will be
highlighted in orange. The others will be displayed in blue.

Input

This task needs a group of input files for each grid placed in the template. The group of input files
defines a pool of PDF pages. Pages will be pulled from the pool sequentially to populate the cells of
a grid. The way the pages from this pool are positioned in the grid is defined by the filling order.

http://help.esko.com/docs/en-us/powerlayout-standalone/12.1.1/userguide/home.html
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There are 3 ways to define such a group:

• a single PDF file.

Note:  Grid Filling: If a group consists of a single PDF file with only a single page, then a special
behavior is triggered, called Grid Filling. This means that every cell of the grid will be filled with
the specified static one-up print item.

• multiple PDF files, if they follow the naming convention "filename-number". When a number is
appended behind the file name using a hyphen, the files with the same base name are grouped
together.

For example, banana-001.pdf, banana-002.pdf , banana-003.pdf will be grouped together.
• one XML file for each grid. See the dedicated page describing the Dynamic Step & Repeat RunList

XML Specification.

Sheet and Plate Options

Use this tab to specify the Sheet and Plate settings of your output file. The sheet size will be the
area where your one-up grids will be positioned within the Plate.

You can define the following:

• Plate Size: Define the horizontal and vertical size.

Note:  The plate size will correspond to the Media Box of the generated step and repeat PDF.

Caution:  Take the printer's size limits into account when defining these values.

• Shrink: Set the size options for additional page transformation. Shrink is used to compensate for
plate distortion, later in the output process.

• Sheet Size: The inner printable area on your plate.

Note:  The sheet size will correspond to the Trim Box of the generated step and repeat PDF.

• Position on Plate: The blue square in the image represents the position of the sheet on the plate.
You can click or drag this blue square in the desired alignment.

• You can adjust by using Offset values to fine-tune the position. The values are calculated versus
the light grey lines.

Filling Order

Note:  This task is also used to manage the layout of variable data.

Note:  We here name the one-up print items as 'items'.

Use the Filling Order options to specify how the items should be distributed over the grid. You can
specify the following:

• a starting point
• whether the grid should be filled in row/column order
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• gaps (empty grid stations).

This tab has the following options:

• Scope settings: Choose:

• Same Settings for all Grids to apply these settings on this tab to all grids present in the
template. Choosing this option will automatically disable setting filling order on grid-level.

• Individual Settings for Each Grid for specifying different settings individually for each grid.
Choosing this option will automatically disable further settings here. You now have to set the
filling order on grid-level.

• Start Content filling: Choose where the first print item is printed. The next options decide how
the other items will follow.

•
: Top Left. SmartName text version: TL

•
: Top Right. SmartName text version: TR

•
: Bottom left. SmartName text version: BL

•
: Bottom right. SmartName text version: BR

•
Also specify whether the grid is to be filled by rows  or by columns .

Note:  See the preview of your selected options on the right hand side. The Printing direction
marked with an arrow shows the direction that the paper/substrate flows through the press.
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Note:  in that preview, a black dot shows the first record. For example:

• The following distribution starts on the Top left with vertical flow:

• The following distribution below starts on the top right with vertical flow:

• The following distribution starts on the top left with horizontal flow:

• Fill over: choose if you want to distribute the print items over the Complete Job or over Blocks.
Blocks can be used to subdivide a long print job in such a way that rolls of a specified number of
items (for example labels) can be delivered to the end customer.

• If you choose Blocks, the variable data flow (one-ups flow) will run over blocks of a certain
size, then run over the next block when the previous one is complete.

You can see an example of blocks in the preview at right when selecting Blocks.
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Block Size: Define the size of these blocks. You can express the size in Job, Sheets, Rows
or set a SmartName.

• If you have chosen to Fill over the Complete Job, then the Block Size will be 1 Job by default.

You can set it to another unit if you still want to print in blocks, but without having the items
(variable data) flow respect the block. This is useful if you want to add gaps (see below).

• Gap between blocks: this option is available if you have chosen to Fill over Blocks, or to fill over
the Complete Job but still have blocks (as explained above).

This option adds white space in between the blocks.

Gap size: this is available when you have selected yes for Gap Between Blocks.

Marks

Use this tab to add Dynamic Marks.

Read more about adding/removing/editing Dynamic Marks in the description of this dedicated task:
Add Dynamic Marks on page 239.

Setting specific Grid Options

• Specify the Cell Height and Cell Width for the one-up print item (cell).

Tip:  Instead of manually entering data, you can use SmartNames to fill this and many other the
Grid Options.

• Set the grid Orientation and Clip Bleed.

The Initial Orientation of the one-up can be set using the buttons .
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The orientation of the one-up within the Repetition can be changed further by the Head Turn
settings.

The Clip Bleed at allows to create a clipping mask around the one-up, to clip bleed to the desired
distance.

Read more about bleed in the manual of PowerLayout Standalone, in Working with bleed.

Note:  When Clip Bleed is deselected, no clipping will occur. This can cause overlapping of one-
ups. This can be useful in some special layouts.

• Specify the Stagger direction and Stagger Options options :

Staggering allows to shift the 2nd, 3rd, ... row or column down or to the right.

:

Select the Direction in which you want to stagger the one-ups. From left to right, the choices are:
No Stagger, Stagger Columns, and Stagger Rows.

Next to the Stagger Distance button  , you can define the distance for staggering. By clicking
the Stagger Distance button you can switch between entering the distance as a fixed value in the
current units, or as a percentage of the one-up size.

The stagger will be repeated for a number of rows or columns as defined in Restart after n
columns/rows. After that, the next one-up will be at the begin position again.

If Add partial labels  is enabled, the gaps created by staggering will be filled with partial labels
(print items) .

See some examples of staggering in the manual of PowerLayout Standalone, in Staggering
Examples.

• Specify the Position of the layout grid using the Positioning tool and Offset distances.

You can choose to Attach to a Sheet or Plate as the reference.

The way the Repetition is attached, can be chosen by clicking and dragging the blue square
(representing the Repetition) to the desired position on the grey square (representing the Attach
To reference). Each square has 9 reference points (top left center and right, middle left center and
right, and bottom left center and right), so you have 81 different ways of positioning the Repetition.

In the example underneath, the top center of the (bounding box of the) Repetition will be placed
on the left bottom corner of the (bounding box) of the reference defined in the 'Attach to' field.

In the offset fields, you can move the Repetition based on the defined position. The direction of
the offset (up, down, left or right) depends on the positioning, and is shown by the arrows.

2.7.139 Step & Repeat Template based

This task will make a layout based on an indicated template layout.
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The layout will be exactly the same as the template as new design files are typically 'same size'
variants of the ones in the layout template.

It can be used for all print segments: labels, boxes, flexibles etc..

The template that is indicated in the ticket can be:

• a layout file: PDFPLA, even legacy layout files like PLA or GRQ.
• a Normalized PDF one-up file (that contains external references) - even legacy GRS.
• depending on the version, also specific JDF can be used (containing right 'stripping' info).

The output file will be a PDFPLA file. If you do not specify a name, it will simply receive the name
of the file you selected in the Pilot, with a '_rep' attached to it. So if you want to step and repeat
2345banana.pdf and you do not define an output name, it will be output as 2345banana_rep.pdfpla.

1. Select a normalized PDF file in the Pilot.
2. Open the 'Step and Repeat - Template based' ticket.
3. Select a Template. Enter a path or click the Browse button.
4. The ticket will present a list of stations (externally referenced files), according to the template you

selected.

The Template in the example contained two stations, job A and job B. Job B will be replaced by
the file you selected in the Pilot (in this case Test1.grs). The other Station has not been substituted
yet. You can do that by clicking the browse button and defining a Normalized PDF file.

Obviously, you cannot step and repeat more Esko native files than there are dummy stations
in the Template. But you don't have to substitute all dummy stations. There is an option that
automatically deletes the unsubstituted dummy stations in a template.

5. You can add SmartMarks. Use the list to select a Mark.
6. When the borders of a station file and substituted file do not fit, you can define the status of the

task.

• Provide info.
• Generate a warning. The task will continue.
• Generate an error. The task will stop.
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Attention:  If you use a Template which contains legacy QuickStep macros, these macros
will be lost. You need to replace these macros with SmartMarks.

2.7.140 Step & Repeat Template based (Dynamic)

Use the Step & Repeat Template based (Dynamic) task to place specified one-ups (print items)
into grids based on a PDF template.

The template containing the grids is created and exported from Adobe Illustrator using the
PowerLayout Standalone plug-in. For more info, see the manual of PowerLayout standalone.

Selecting the template

In Task Options, in the Job tab, select the desired Template file that contains the information about
the grids.

Once the template is selected, all other information in this task will be automatically filled in with
information from the template. You will be unable to change any of the information in the task, but
you can click on any of the Option tabs to see how it has been filled in. For more information on
these options, see Step & Repeat Tabular (Dynamic) on page 492.

Attention:  Filling order is not applied globally. Therefore, if you specify the filling order for
each grid separately, ensure that your number of grids in this ticket match the number of
grids in the template file.

Input

This task needs a group of input files for each grid placed in the template. The group of input files
defines a pool of PDF pages. Pages will be pulled from the pool sequentially to populate the cells of
a grid. The way the pages from this pool are positioned in the grid is defined by the filling order.

There are 3 ways to define such a group:

• a single PDF file.

Note:  Grid Filling: If a group consists of a single PDF file with only a single page, then a special
behavior is triggered, called Grid Filling. This means that every cell of the grid will be filled with
the specified static one-up print item.

• multiple PDF files, if they follow the naming convention "filename-number". When a number is
appended behind the file name using a hyphen, the files with the same base name are grouped
together.

For example, banana-001.pdf, banana-002.pdf , banana-003.pdf will be grouped together.

http://help.esko.com/docs/en-us/powerlayout-standalone/12/userguide/home.html
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• one XML file for each grid. See the dedicated page describing the Dynamic Step & Repeat RunList
XML Specification.

2.7.141 Submit to Gang Run

For detailed information about the Submit to Gang Run task, please see Submit to Gang Run on
page 1109 in the Gang Run Printing chapter.

2.7.142 Submit XML to Gang Run

The Submit XML to Gang Run task allows to submit a batch of jobs, described in an XML file, to a
Gang Run Printing queue. Such an XML is usually exported by the MIS (the business system).

The ticket itself has no interface options. Everything needs to be defined in the input XML file.

Technical summary

The input XML that describes the 'nesting request' needs to be very specific. Read more in
Specification of the XML and using the task on page 500

This task also outputs a 'return XML'. This is specified by the ReturnURL= element in the input XML.
Once the nesting request has been processed fully, it will then write a NestingResponse_[date].xml
file on the folder specified by the ReturnURL. This response can always be linked to the original
request via the id= attribute. This file can be picked up directly by the original submitter/the MIS by
monitoring that ReturnURL folder. In this way, the MIS gets a response to its request.

When adding the attribute production="TRUE" to the input XML, the return XML will also include
references to the actual production files.

The Return XML allows these extra use cases

• Feedback to the business system to help Cost Calculation and Accounting. When all jobs for a
given batch have been nested, Automation Engine can write an XML file back that can be used for
cost accounting. Read more in Feedback XML for Cost Calculation or Accounting on page 502.

• Using the return XML to inform Production systems/devices. The XML file generated by
Automation Engine can be enriched with references to the actual production files. The XML can
then also be used for organizing production. Read more in Information to Production via XML with
File References on page 505.

• The return XML with those references to the production files allows many workflow extensions.
Those referenced files can be used as input to many other tasks. For example to feed that data
to WebCenter or other (web)systems. Read more in Workflow Extensions on page 506.

Specification of the XML and using the task

Specification of the XML

The Production Order:

Let's take the example where your company needs to do a cost calculation for customer 123456 to
produce the following items, before noon at 5th of June of 2014:

• 10 items of AmericanCars_7 on Dibond-4mm, 1100x2400 mm
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• 12 items of AmericanCars_2 on Dibond-4mm, 600x1100 mm
• 12 items of AmericanCars_1 on Forex-3mm, any size

The Nesting Request in form of XML:

Your MIS could generate this XML file:

Launching the task

Select the generated XML file and launch the Submit XML to Gang Run task. As usual, this task can
also be triggered by for example a Folder Access Point.

The task has no options. Everything must be specified in the XML file itself.

As a result of running the task, the corresponding jobs enter into the Gang Run Queues.

Nesting calculations are started, with or without taking possible other jobs in the queues into account,
all depending on the specified possible grouping keys.

When all jobs for a certain NestingRequest have been placed, a NestingResponse output XML file
will be written on the requested location. This corresponds to the ReturnURL element, as specified
in the XML file.

Only a file based url is supported at this time.

The NestingResponse output XML file can be picked up as soon it becomes available.

The MIS could monitor the folder (SnDResponses) on the share(Data1) on the computer (aeserver01),
waiting for a NestingResponse file with the valid id (2014-84103).

Remarks on the Specification of the XML

• NestingRequest element: of course, such an element is required.

• Id Attribute: required. It will come back in the NestingResponse output XML file.
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• ReturnURL element: optional. Specifies the folder via a file:-based URL where the
NestingResponse output XML file will be written once all jobs have been nested.

• DueDate element: optional (ISO 8601 format).

• JOBS element: required. Contains a list of JOB elements.

• JOB element: at least 1 JOB must be present.

• FileName: required. A file:-based URL indicating the 1 up item involved.

• Substrate, SubstrateSize, Quantity elements: these can be specified under the NestingRequest
element. However, if these elements occur under the JOB element, they overrule the values
appearing under the NestingRequest element.

• As can be seen in above example, 1 NestingRequest can hold multiple jobs, possibly on multiple
substrates, possibly on any, 1 specified or multiple substrate sizes. This allows to keep an order,
which can consist of multiple components, as 1 NestingRequest.

Some more examples

Using the same graphic on the back but flipped:

Using a specific graphic for the back and filling the sheet:

Feedback XML for Cost Calculation or Accounting

How to get a return XML

The NestingResponse output XML file is placed in the folder that was specified in the ReturnURL in
the NestingRequest. The id of the NestingRequest is taken over in the NestingResponse. It becomes
available as soon as all jobs of the NestingRequest have been placed.

Example of a Return XML
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Feedback to Production via Folder Organisation

Concept

The NestingResponse example as shown in Feedback XML for Cost Calculation or Accounting on
page 502 holds 2 parts: Sheets and Jobs.

• The Sheets element describes which (part of) sheets were used to nest the given files. It refers
to the files by a <Job id=""> element.

• The Jobs element lists all jobs that had to be nested.

In that example, you see that 3 sheets were generated:

• the first sheet holds 2 items of the AmericanCars_1, and must be produced 6 times (Forex-3mm
900x900)

• the second sheet holds 1 item of the AmericanCars2, and must be produced 12 times.
(Dibond-4mm 600x1100)

• the third sheet holds 5 items of the AmericanCars_7, and must be produced twice. (Dibond-4mm
1100x2400)

Contrary to the next chapter Information to Production via XML with File References on page 505,
the actual files for production (print/cut/...) are not mentioned in this NestingResponse output XML
file. In fact, at the moment this NestingResponse report XML file is written, these files must still be
generated, by the workflow that is linked to the substrate in the Gang Run Queues.

Of course, there are ways to link this NestingRequest to the actual production files. To achieve this,
it is useful to know that certain workflow parameters are set in the workflow that is launched on
the generated Nested Layout files: substrate, substrate.size, substrate.quantity, CustomerId and all
the GroupingKey's that are set up as grouping key.

Example

• In Pilot-Configure, set up GroupingKey4 as grouping key, under the name OrderId.

• For the workflow that the Gang Run launches on the generated nested layouts, set up the Output
Folder in the Production Files tab of the Export Nested Layouts ticket as follows:

As a result, the production files are organized in the following folder structure, in which it is easy to
find the appropriate files relatied to the initial NestingRequest:
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Information to Production via XML with File References

How much material is needed to produce the order?

This information is part of the NestingResponse output XML file. In our example:

• 6 sheets of Forex-3mm 900x900 (AmericanCars_1), waste 0,54 m2 (11%)
• 12 sheets of Dibond-4mm 600x1100 (AmericanCars_2), waste 2,56 m2 (32%)
• 2 sheets of Dibond-4mm 1100x2400 (AmericanCars_7), waste 0,82 m2 (16%)

Extending the XML with references to the production files

The NestingResponse output XML can also be extended to contain references to the actual
production files. To do this, add the attribute production="TRUE" to the ReturnURL element. See
an example:

As a result, each /NestingResponse/Sheets/Sheet element will be extended with a FileList element.

For each production file, there will be a File element attached to the FileList element.

Note:  What is considered to be a 'production file'? Production files are the output files of the workflow
that is launched/configured per Substrate in the Gang Run Printing View.

Example

A NestingResponse Output XML with references to production files:
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Workflow Extensions

Concept

The production files in the NestingResponse output XML can be picked up in an Automation Engine
Workflow via the workflow control Select Referenced File.



2
Automation Engine

507

Read more about this workflow control in Select Referenced File on page 1018.

Example workflow

This enables a lot of extensions to the workflow. The selected files can for example be ZIP'ed and
sent out to external systems or partners. Some users then also continue by deleting these files locally.

2.7.143 Track Edit Session

Automation Engine can track and log interactive editing actions. Decide in Configure if and for which
editors you want automatic tracking to happen.



2
Automation Engine

508

When you open a file that resides in an active Job (folder) in an Esko editor, the Track Edit Session
task will automatically start logging the interactive editing actions. This tracking will stop when the
file is closed.

As this tracking is actually an Automation Engine task, this also enables:

• Notifications (for example XML for reporting to other systems).
• Automatic storage in the Task History.

Note:  This task cannot be launched interactively. The Track Edit Session task will appear in the Task
View if the task has been configured in the Configure Track Edit Session panel. Keep in mind that the
editor needs to be restarted to activate the settings.

Note:  Track Edit Session also works when editing your file with ArtPro, but in this case it will only
record session times, not editing details.

Viewing the Edit Session Information in the Pilot

In the Pilot, the Tasks View offers more information about the Track Edit Task.

The logging of the editing actions will appear:

• In the Pilot’s message window of that task.
• In the task’s log files.
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• In notifications (TXT or XML or E-mail format).This can happen by setting up a general notification
rule for all Track Edit Session tasks.

• It is possible to save all notifications locally in a job folder or centrally in one or several files.
• It is possible to name TXT / XML logs via SmartNames. Typically this is the name of edited file.

How to Store the Editing Information System-Wide?

Many users want to store all this editing information in a system-wide way. This can be done easily
through the standard Notifications tool (see Defining a Notification Rule on page 667).

The Track Edit session task starts automatically, so unlike other task types, you will not create your
own Track Edit Session ticket to add the notification in there. In this case, all you need to do is setting
a general notification rule for this task type. This is done in the Configure panel.

How can this edit log be stored automatically?

• Either you save all edit logs inside the job folder. You will then have to indicate a path for the XML/
TXT under the [JOB URL] and decide if you want 1 (XML/TXT) log per file or per date or if you
want all logs in 1 file.

• Or you save all edit logs per customer or even system-wide. You will then have indicate a general
path to a higher level 'above' all Jobs.

1. Go to  Configure > Notification > Rules > .
2. Select the Track Edit Session task in the Tasks tab.
3. Click Add. The Notification Rule Editor opens.
4. For an XML file, select the Create XML File in folder as Action.
5. Define the folder's Location and click OK.

Which Edit Actions are Logged?

Among the items logged are:

• Which user opens which file from which workstation?
• Start and stop timings of this editing session
• Was the file saved? When and with what name?
• Loading, saving, placing, exporting functions
• All changes to inks
• All changes to (Esko) bar codes objects: creating, modifying, type change
• All changes to layers
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• All changes to pages
• Starting, stopping a session. Loading, saving, placing, exporting files
• Changes of page size, of margins, of reader's spread
• Losing the connection
• HIFI conversions
• Ink mapping
• Trap edits
• External references: creating, replacing
• Layers edits: creating, renaming
• PSFix: Process, Remove Spurious Contours, Remove Double Contours, ...
• InkWizard: destination profile, CMYK profile, ...
• Die object edits: adding, turning, flipping, rotating

This is an example of what information can be available in a Track Edit Session log.

*** Start interactive PackEdge 7.0 ***
        Time 13/01/06 17:19  
        User wde@backstage1  
        Automation Engine server BACKSTAGE1  
        Loading file file://backstage1/wdedata/52355/
Scope/52355_Leffe_back.pdf  
        Remove layer OMBRE  
        Trap with local ticket Default  
        "Modified ink angle for C from 22 to 7 degrees" 
        "Created ink PANTONE 123 C (100 lpi, 7 degrees, dot ?, type Normal)"  
        "Created ink C (170 lpi, 75 degrees, dot ?, type Normal)" 
        "Created ink M (170 lpi, 15 degrees, dot ?, type Normal)"  
        "Created ink Y (170 lpi, 90 degrees, dot ?, type Normal)"  
        "Created ink ROUGE (170 lpi, 45 degrees, dot ?, type Normal)"  
        "Created ink BISTRE (170 lpi, 45 degrees, dot ?, type Normal)"  
        "Created ink ILLOGLOSS (170 lpi, 45 degrees, dot ?, type Opaque)"  
        "Created ink K (170 lpi, 45 degrees, dot ?, type Normal)"  
        "Created ink EP (170 lpi, 45 degrees, dot ?, type Technical)"  
        "Created ink roc (170 lpi, 45 degrees, dot ?, type Technical)"  
        Placing file file://backstage1/wdedata/52355/
Scope/52355_Leffe_collar.pdf  
        Changed page margins to top 3.998701, bottom 9.998703, left 4.001198,
 right 66.0012 mm  
        Changed page size to width 110.0024 mm and height 73.99741 mm  
        PS-Fix: modified 2 contour(s)  
        Applied Job inkmapping  
        "Modified ink angle for C from 7 to 75 degrees"  
        "Modified ink angle for M from 37 to 15 degrees"  
        "Modified ink angle for Y from 82 to 90 degrees"  
        "Removed ink C (170 lpi, 75 degrees, dot ?, type Normal)"  
        "Removed ink M (170 lpi, 15 degrees, dot ?, type Normal)"  
        "Removed ink Y (170 lpi, 90 degrees, dot ?, type Normal)"  
        Changed page margins to top 7.25, bottom 7.25, left 7.25, right
 8.361092 mm
        Exporting file file://backstage1/wdedata/52355/
Scope/52355_Leffe_back.tif  
        Saving file file://backstage1/wdedata/52355/
Scope/52355_Leffe_back2.pdf  
        *** End interactive PackEdge 7.0 ***  
        Time 13/01/07 17:22  
        Notification:Wrote XML file:E:\wdedata\52355\Scope\EditSessions
\52355_Leffe_back.  
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2.7.144 Trap with PowerTrapper

The advantage of using a PowerTrapper is that you do not have to prepare the PDF file or create the
trap layer in advance. In addition, you can trap the input file without an intermediate file. The output
of this task is a Normalized PDF file.

You can choose your trapping settings in the Distance & Direction, Color & Shape, Processing,
Rules and Output tabs.

Distance & Direction
You can set the trapping distance and direction at the tab Distance & Directions.

1. Trapping

You can choose between two trapping modes:

• Normal Trapping: This selects adjoining color pairs, which are likely to cause registration
problems like ugly light gaps, and unwanted halo effects. Lighter colors are generally trapped
into darker colors to minimize the visual effect of the trap.

• Reverse Trapping: This prevents overprint of adjoining color areas by trapping these color
pairs with a white knockout (erasing) trap. The white knockout trap is put on top of the lighter of
the two colors. This is useful to prepare a job for Dry Offset printing (example: metal beverage
cans). This avoids overprinting of inks.

2. Trapping Distance
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Enter the width you want to give your traps. The unit used is the General unit defined in Illustrator's
Unit & Display Performance Preferences. The default trap width is 0.2 mm (or equivalent in your
chosen unit).

You can choose more trapping distance specifications such as: into black, into spot, into image
and into pullback further down in this tab.

3. Minimum Ink Difference

Trapping is applied to two adjoining colors when either:

• The two colors each consist of at least one ink but they have no common inks.
• The two colors have common inks but there is a difference of at least the Minimum Ink

Difference percentage for two or more inks making up these colors.

These differences in ink percentages must be in opposite directions.

For example, with the default minimum ink difference percentage of 10%, the following two colors
are trapped:

1st color: C 5% M 10% Y 50% K 15% (+10% K)

2nd color: C 5% M 10% Y 85% K 5% (+35% Y)

Increase the Minimum Ink Difference to trap colors that differ more, lower it to trap colors that
are similar.

4. Image Trapping

• Automatic (default): this determines the most suitable trap direction automatically, by
comparing the average lightness of the CT image with the lightness of the adjoining area, then
traps the lighter color into the darker one.

• Always Towards Images: this always traps line art under adjoining CT images.

• Always Towards Line Art: this always traps CT images under adjoining line art.

If you want images to be trapped with each other, enable Trap images to images.
5. Pull Back

You can use ink pull back to keep away all but the darkest ink of a color area composed of multiple
inks bordering to a very light background. It prevents individual inks from the composed color to
become visible on the background due to registration errors during the printing process.

• Automatic (default): this creates pull backs on rich black or rich spot colors, when the color
left in the pull back area is not very different from the composed color.

• Only Pull Back Rich Black: this only creates pull backs on rich black.

• Do Not Pull Back: this never creates any pull back.

There will be automatic pull back for the darkest color. You can enable Also pull back light inks
option to create pull backs even when the pullback ink (ink remaining in the pull back area) is
visibly different from the composed color. Enable Pull back images and gradients to create pull
backs on images and gradients.

6. Treat all spot colors as opaque inks

You can enable this option to set the trapping direction by ink sequence. PowerTrapper uses the
color luminance to define the trapping direction by default except for opaque inks. PowerTrapper
uses ink sequence to determine trapping direction in the case of opaque inks. If the Treat all spot
colors as opaque inks option is enabled, color luminance is used only for CMYK. For opaque
and spot inks, the trap direction is determined by the ink sequence.
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7. Overshoot Mode

You can choose between the following three overshoot modes:

• Automatic (default): The centerline behavior is according the rules determined in the color
pair list.

• Never on Dark Areas: The centerline is forced not to get beyond the center of dark areas.

• Never: The centerline is forced not to get beyond the center of any area.

Color & Shapes

1. Trap Color Intensity

By default, PowerTrapper uses the full color of the object to spread in the trap (100% trap color
intensity).

You can create a trap of a lighter color by reducing the trap color intensity percentage.
2. Image Trap Color

Choose how to trap your images:

• Use Original Image Data (default): When spreading an image, PowerTrapper uses the
underlying image data (when the image is clipped) to create the trap.

Note:  An empty trap is created, when there is no underlying image data (when the image is
not clipped).

• Extend Image Data: PowerTrapper automatically extrapolates the image along its top, right,
bottom and left edges to ensure that the trap looks as expected even if there is no clipped
image data outside the visible image.
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• Use an Approximate Flat Color: Instead of using existing or extrapolated image data in the
trap, PowerTrapper uses a solid color. A suitable color is determined by averaging the image's
colors along its boundary with the object to trap.

3. Truncate Traps

PowerTrapper can truncate the trap so that it does not stick out on another color. There are two
truncation modes:

• On Center (default): when a portion of a trap comes too close to the contour of another object,
PowerTrapper limits it to half the distance between the trapped object and the other object.

• On Edge: when a portion of a trap comes too close to the contour of another object, it is
truncated on the other object's edge.

4. End Caps

This option specifies how to shape the ends of an open trap.

• Square (default): this option ends the trap at right angle to the adjoining object.

• Round: this rounds the ends of the trap. This option is typically only used in combination with
white knockout (reverse trapping).

Note:  We recommend that you do not to use Round End Caps together with Truncate Traps
On Center, as this can generate some artefacts (the round caps are truncated).

• Object Dependent: with this option, the trap is a logical continuation of the contour of the
spread object.

5. Trap Corners

This option allows you to change how the traps’ sharp corners are handled.

• Round (default): a round cap will be placed at all corners.

• Beveled: this cuts sharp corners off.

• Mitered: this option works with a miter ratio.

The miter ratio serves to limit the length of the sharp corner (the distance from the base of
the trap to the corner point).

The default miter ratio value is 4. This means that if the length of the sharp corner is more than
4 times the Trapping Distance, then the corner are cut off (beveled). If it is less than 4 times
the Trapping Distance, the corner are left as it is.

6. Advanced Settings

Click the collapsible button to show the advanced settings.

Truncate Traps

If you want to truncate traps into black differently, select Into black and choose the truncation
mode (On Center or On Edge).
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Processing

1. Color pairs

PowerTrapper can trap all hits (occurrences) of a color pair the same way or recalculate the trap
direction for different hits.

• Each hit can have its own decision (default): this recalculates the trap direction for each hit
of a color pair.

• Use the same decision for all hits: this traps all hits of the same color pair in the same direction.
• Use the same decision for objects smaller than: this uses the same trap direction for hits of

a color pair belonging to small objects, and recalculates the trap direction for hits belonging
to bigger objects.

Use the field next to the option to determine the maximum size of small objects. The unit used is
the General unit defined in Illustrator's Unit & Display Performance Preferences.

The default size is 1 mm (or equivalent in your chosen unit).
2. Objects

In some cases PowerTrapper can safely ignore certain object types to speed up the trapping.

• Only selected objects

• Respect existing traps: if your document has already been trapped, select this option to keep
the existing trap layer out of the trapping process.

• Ignore bitmaps: this keeps bitmap pixel data from being trapped. Bitmap data is contourized
before trapping which may slow down trapping depending on the bitmap's contents. Bitmaps
with lots of small isolated islands typically take a longer time to trap.

Note:  When you indicate an object type to ignore, it is ignored completely as if it did not
exist in the job. Also, the ignored objects does not truncate trapping areas resulting from other
objects below them.
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3. Small Gaps

Some input jobs contain very small unintentional gaps between neighboring objects, preventing
the correct trapping of these objects. Although it is better to clean up such jobs before trapping,
PowerTrapper can ignore these gaps automatically.

To use this option, select Close when smaller than and enter the maximum size small gaps can
have.

The unit used is the General unit defined in Illustrator's Unit & Display Performance
Preferences.

The default size is 0.01 mm (or equivalent in your chosen unit).

Note:  If you set a big gap size, trapping may become slower and small parts of the job may be
ignored during trapping.

Rules
You can define custom trapping settings for specific trapping pairs using the Rules tab.

1. When to use rules?

In most cases the general trapping settings entered in the Distance &Direction gives you
excellent results. You can refine them using rules. If you add a rule that is not coherent with your
inputs in the other tabs, PowerTrapper will overwrite them with the rules

Note:  This is an advanced feature and we recommend it for experienced users.

You can specify exceptions to the general trapping settings for certain color pairs using Add Rule.
Some of the instances where you can use it are :

• to set a different trap distance for a specific spot ink. Sometimes you need a larger trap
distance for spot inks if there is no other ink to help cover leaks on the press.

• to prevent trapping or ink pull back in specific cases. Depending on the type of the adjoining
colors, trapping and / or pull back may be undesirable.

• to force a specific trap direction. PowerTrapper Standalone determines the trap direction
based on the relative lightness of the adjoining colors. If the colors have a similar lightness
level, it selects an arbitrary direction. You can use a rule to make it always use a particular
direction for a color pair.

• to specify a different shape and/ or truncation mode for certain color pairs. For example, you
can choose to use “On Center” truncation when trapping under a 100% black line and “On
Edge” truncation on all other color pairs.

2. Creating a rule
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• Click the Add Rule button at the bottom of the Rules tab.

• In the pop-up that opens, choose the trapping pair to apply the rule to using the From and To
lists. You can create a rule to trap from/to: any color, a particular ink (process, spot or opaque),
a particular object (image, gradient or empty background) or the registration color.

Note:  When trapping a particular ink, you can choose the ink name from which Minimum
Density the rule is applied and if the color must be pure (no other separation in the color
object) to apply the rule.

• Choose the contents of the rule.

Options Description
Trapping Direction

• Automatic lets PowerTrapper
Standalone calculate the trapping
direction.

• Force Trapping from ‘From’ to ‘To’
always spreads the “From” color/
object on the “To” color/object.

• Do Not Trap ‘From’ to ‘To’ never
traps the “From” and “To” colors/
objects together.
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Options Description
Trapping Distance Use this to define a special trapping

distance for the trapping pair.
Trap Color Intensity Use this to define a special trap color

intensity for the trapping pair.
Pull Back

• Automatic lets PowerTrapper
decide if there should be a pull back
on the trapping pair.

• Always Pull Back always creates
a pull back on the trapping pair.
The darkest ink of the pair is the
pullback ink (remaining ink in the
pull back area).

• Do Not Pull Back never creates a
pull back on the trapping pair.

Pull Back Distance Use this to define a special pull back
distance for the trapping pair.

Reverse
• Automatic lets PowerTrapper

Standalone decide if the trapping
pair should have a reversed trap.

• Always Trap Reversed always
generates a reversed trap for the
trapping pair.

• Do Not Trap Reversed never
generates a reversed trap for the
trapping pair.

Truncate Traps Choose if traps generated for the
trapping pair should be truncated on
center or on edge.

End Caps Choose how to shape the ends
of open traps for the trapping pair
(square, round or object dependent).

Trap Corners Choose how to shape the trapping
pair's trap corners (round, beveled or
mitered).

• If necessary, use the + button to add contents to your rule. You can use the - button to remove
contents.

• After defining the rules, click OK button. You can now see your rule at the Rules tab.

When trapping your document, PowerTrapper traps the trapping pairs that match rules according
to those rules and the rest of your document according to the main trapping settings. If necessary,
you can add another rule or remove a rule previously created. You can also edit a rule by double-
clicking it in the Rules tab.

Output

You can specify the output at Output tab. You can enable Trap layer only or Load trap color pairs
if present or enable both



2
Automation Engine

519

See also: What is trapping?

2.7.145 Unzip

You can use this task to extract files from a zipped archive. (Please refer to the Zip on page 525.)

You can select to one of these options if the files already exist in the destination folder:

• Fail

• Overwrite the files and give a warning

• Overwrite the files

You can also specify character set in the given field to overrule the default character set to avoid
problems due to special characters while unzipping.

2.7.146 Upload via FTP

Use the FTP task to send your files to a server. You need to have an FTP account on that server.

1. Click New to define a location. The Edit Ftp Location dialog pops up.
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2. Enter the Connection information:

• Host: the name of the server you want to send your files to.

Tip:  To use a port other than the default port, add : and the port number after the host name.
For example: myftpserver:1085

• Folder: if you do not specify a path, the files will be stored on the default directory. If you do
enter a directory, the files will end up in the directory you specified.

Tip:  Using SmartNames to define the destination folder may help you to organize the arriving
data.

• Connection Timeout: enter the connection timeout in milliseconds. You only need to change
this if you are working on a slow network and keep getting time out errors.

• Secure FTP: select this if you are connecting to a secure FTP server (over FTPS, not SSL
or SSH).
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Tip:  If you are experiencing problems using secure FTP, try connecting over regular FTP, and
ask your IT administrator to check the security settings of your FTP server.

3. Enter the User name and password you use to connect to the FTP server:

• User Name: enter a valid user name for the server.

• Password: a valid password for the account.

Tip:

SmartNames can be used to select user name and password.

This might be useful as user name and password are often centrally stored and can so be
SQL queried. And when user names and passwords change, your tickets do not have to be
changed.

4. Define settings for uploading your File on the FTP server:

• File Transfer: choose between Binary and ASCII.

Binary will always work, but if you have an ASCII file, the transfer will go a bit faster when
selecting ASCII.

• If File Exists:

• Overwrite and give warning: the file will be overwritten, but the tasks finishes in the state
Warning.

• Overwrite: this will just overwrite the file and the tasks finishes OK.

• Generate a unique filename: this will append the task ID to the file name, and store the
file at the destination under its unique name.

• Generate an error: the file will not be sent, the task will fail.

• Connection Mode: By default, the transfer uses Active Connection Mode (where the FTP
server opens the data connection).

If your system is behind a firewall that blocks incoming FTP server connections, select Passive
to use Passive Connection Mode (where the client initiates the connection).

2.7.147 Verify Certification

 A PDF file can be certified when it is being preflighted against a PDF profile (using Preflight with
PitStop task. The preflight information is stored in the certified PDF file. This include preflight profile,
the preflight report and the information on whether the PDF has subsequenlty been modified. If your
PDF is not re-certified after subsequent modification, it is no longer certified.

You can use Verify Certification task to verify if the PDF file is certified. Use this task to verify against
a Profile. It checks whether the PDF file was certified to comply with the selected profile settings.
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The task results in Verification OK if the profile that was used to certify the PDF is identical or stricter
than the selected profile in the task.

2.7.148 Version PDF

When working with various versions of a single PDF, such as multiple language versions or versions
containing minor differences, you can use this task to save on output material by:

• Combining a base file with multiple version files.
• Extracting separations or layers from the base file and replacing them by variants.
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Combine base file with version files

By combining a base file (or input file) with a number of version files you can create various flavours
for the same document and save on output material.

For example: your base file can contain graphics and the CMY-separations. Your version files contain
text in different languages in the K-separation. By combining the images in your base file with the
various language versions, you only need to make the plates containing the separations for the
graphics once.

Proceed as follows:

1. Under the Version Files dialog, click Add.
2. In the External File dialog, specify the following:

• The location of the Version Folder, which contains the version files.

• The name(s) of the Version File(s) including the file extension.

• The name of the Output File, which is a combination of the base file and a version file.
3. Choose what you want to do with the Version Input File (base file or input file):

• If you want it to remain in the same place, choose Leave.

• If you want it to be deleted, choose Delete.

• If you want it to be moved to another folder, choose Move to. If you choose this option,
determine the new location with the Browse button.

4. Select the desired Reference Page Box. Selecting the correct media box here can prevent errors,
such as double time stamps in the text of a page mark.

5. Determine the Order of the Base File and the Version file.
6. Choose if you want Separation Isolation. The value "Isolated" can be used to use the "Form

Isolation" PDF construct for combining the files, to reduce the interaction between the content
of the files. This is helpful when the files contain information for different separations, rather than
artwork to be placed on top.
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Note:  You can use SmartNames and wild cards to specify folder or file locations and names.

Note:  You cannot combine Normalized PDF files with other PDF files.

Extract separations from input file

Extract a separation from the input file and map it to another separation to limit the total number
of separations for output.

An example: Map a 'black' Pantone color that is used for text to 'Key color' (Black in CMYK).

Extract layers from input file

Extract layers from the input file and split the input file into a fixed master and a variant part based
on the graphical object database. Often black is the variable ink.

You can also work with layers to extract the language layer from the input file and replace it with the
corresponding translation(s).

Note:  Work with wild cards to optimize your workflow: for example to only extract the language
layer, use 'lang_*' if you know that all language versions follow this name rule. This will allow for the
lang_EN, lang_FR and lang_ES layers to be automatically extracted from the base file.

2.7.149 Wait

This task is documented in the chapter "Workflow", in the section Inserting Wait Points on page
1001.

2.7.150 Wait for Action (Checkpoint)

This task is documented in the chapter "Workflow", in the section Inserting Wait Points on page
1001.

2.7.151 Wait for Files

This task is documented in the chapter "Workflow", in the section Inserting Wait Points on page
1001.

2.7.152 Wait for Files (via JDF)

Use this task when you are working with a JDF RunList, but the files referenced in the RunList are
not ready yet.

Send the JDF RunList to this task, and it will check if the files are ready at a regular interval. When it
finds all the files, it ends in OK and passes them on to the next workflow task.

You can set where to look for the files, and what to do if the files aren't found after a certain time.
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Example Workflow

You can use this task when working an MIS system:

1. The MIS system creates jobs via JDF, and sends the JDF RunList to your Automation Engine
workflow.

2. The Wait for Files (via JDF) task checks if all the files referenced in the RunList are where they
are supposed to be.

3. When the files are ready, the task finds them and passes them on to the next workflow task.
4. The rest of the workflow starts on the files.

Parameters

Look in Folder

By default, the tasks looks for the files at the location defined in the RunList. However, you can set
a custom location in this parameter.

You can use SmartNames here: for example, use [URL of Folder of Input] if you know the
files will be copied in the same folder as the RunList.

Stop waiting when time exceeds ...

Select this if you want the task to finish after a certain time if the files referenced in the RunList
haven't been found.

You can set the time in minutes, hours, days or weeks. To set a custom time, select other... then
select a date and time from the drop-down menus below.

If you don't select this parameter, the task will look indefinitely (or until it finds the files).

Task ends in error when not all files were found

This parameter is only available when using the Stop waiting when time exceeds ... parameter.

Select this if you want the task to finish with an Error state when:

• the time you set in the Stop waiting when time exceeds ... parameter has passed,

• the task hasn't found the files referenced in the RunList at that point.

2.7.153 Wait for Product Status

This task allows to hold a workflow until one or more Products have reached a certain status.

This task is documented in the chapter on Products on page 876. Find a direct link here.

2.7.154 Zip

This task creates a Zip file from the selected file(s) or folder.

Choose the task's behavior in case the zip file already exists:

• Generate an error.
• Replace the zip file.
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See also the Unzip Task.

2.7.155 Deprecated and Obsolete Tasks

Why Are Tasks Deprecated or Obsolete?

Several tasks have been declared “obsolete” or “deprecated” since Automation Engine 12. This
document explains what that means and why certain tasks should no longer be used..

Deprecated tasks are old types of Automation Engine tasks that are either no longer used or that
were replaced with newer tasks with similar functionality. By declaring tasks "deprecated" Esko also
warns its customers that it plans to take these tasks out of a next version of the Automation Engine.

This gives you the chance

• to replace these tasks by newer equivalents
• to contact Esko support with the request to keep a task in the software in case their workflow

relies on tasks that have no equivalent.

The next step is to declare a task "obsolete" - it is removed from the next version of the software.

Obsolete Tasks since Automation Engine 12.1

Task Reason for making this task obsolete

Add Parameters for Nesting Obsolete due to the changes in i-cut Automate
module. Use the Submit to Gang Run task as a
replacement.

Note:  The Submit to Gang Run does not
create an XML file (formerly typically dropped
into a hotfolder). This information is written
directly to the gang run database.

 Modify your workflows with the new task. Also
convert nesting mechanisms via a hotfolder into
a Substrate queue in the Gang Run Printing
view. See the Gang Run Printing documentation
for more information.

Create Nested Layouts This task has become obsolete since the i-
cut Automate module has been reworked.
The functions and settings of this task are
now divided over the Substrate settings in
the Gang Run Printing view and the Export
Nested Layouts task. In the substrate settings
you will find all the sheet specific settings and
the nesting parameters. The 'Export Nested
Layouts' task holds all the output settings.
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Note:  The nesting no longer happens in the
task, but as part of a background process
triggered by the nesting server.

Modify the workflows and convert nesting
mechanisms via a hotfolder into a Substrate
queue in the Gang Run Printing view. See the
Gang Run Printing documentation for more
information.

Create Preview This task was used to prepare a thumbnail
image for images. These display images were
used by editors in later steps of the workflow. 
Today editors make these display images when
needed without performance penalties, so there
is no longer any need to generate these display
images in advance.

Normalize EPF File EPF is an outdated data format written by
DeskPack Illustrator versions prior to DeskPack
7 R6. Since version DeskPack 7 R6 the
Normalized PDF format is used to send data to
other Esko applications, including Automation
Engine.

Note:  Adjust the workflows based on the obsolete tasks with new features or tasks.

Deprecated Tasks in Automation Engine 12.1
Figure 1: Deprecated tasks are marked in the Pilot by the suffix “(deprecated)”

in the Task Type. List of deprecated tasks in Automation Engine 12.1

“Deprecated” means that it is being considered to remove these tasks from a future version of the
software. The exact version has not been decided yet. Customers are recommended to start planning
how they can switch to newer tasks with equivalent functionality.
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These tasks are not available for new customers. Existing customers that had the tasks, will still have
access to them after upgrade to Automation Engine 12.

The reasons for deprecating these tasks are listed in the table below.

Task Reason for making this task deprecated

Adjust PDF screening The user interface as well as the algorithm of
this task have been totally reworked. The old
task has been kept so existing workflows will not
break after an upgrade.

Contourize and Clean This task was used to turn scanned bitmap
images in vector art. We believe there are better
tools available in desktop applications like
Adobe Illustrator.

Create Master DCS File This task was used to create a DCS wrapper for
a given set of images. The DCS could then be
placed in an application like PackEdge or Adobe
Illustrator. The replacement for this is to use the
Create Wrapper task. This task will create a
PDF. DCS is an old format. This PDF is a modern
equivalent that can be used in the same way as
the DCS.

Create Nested Layouts This task has become obsolete since the i-
cut Automate module has been reworked.
The functions and settings of this task are
now divided over the Substrate settings in
the Gang Run Printing view and the Export
Nested Layouts task. In the substrate settings
you will find all the sheet specific settings and
the nesting parameters. The 'Export Nested
Layouts' task holds all the output settings.
Note that the nesting itself no longer happens
in the task itself, but as part of a background
process triggered by the nesting server. It is
advised to rework workflows that are based on
the old tasks. That includes converting nesting
mechanisms via a hot folder into a Substrate
queue in the Gang Run Printing view. See the
Gang Run Printing documentation for more
information.

Export to GRS File The GRS format was the native format for Esko
applications. Many years ago the GRS format
was replaced by Normalized PDF as the native
format for Esko applications. The ability to
export a Normalized PDF to GRS was meant to
send files to older Esko applications.  We believe
this is no longer needed.

Export to VRML File The Export to VRML task was used to export 3D
files in the VRML format. This is replaced by 3D
PDF generated by the “Export 3D” task.
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FastVariants (3 tasks) These tasks are being replaced by “Version
PDF” and “Compare PDF”

Fork This task was used to connect task chains into
more complex workflows. This functionality
is replaced with the extended workflow
functionality introduced in Automation Engine
10. The since then available Fork workflow
control also works differently. Learn more in Fork
and Join on page 1032.

Normalize TIFF/IT This task was used to create a Normalized PDF
starting from a TIFF/IT. We believe TIFF/IT is no
longer used.

Trap – Create Trap Layer,  Trap – Prepare and
Create Trap Layer and Trap – Prepare Trap Pairs

All the functions of these tasks have been
integrated in the Trap with PowerTrapper
task.  Modify your workflows with Trap with
PowerTrapper task.

Attention:  Replace any deprecated tasks you might have in a workflow with the updated
tasks.

Normalize TIFF / IT File (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

The TIFF-IT import task is used in two situations: to edit linework, or to import a TIFF-IT file containing
copydot or blends.

A TIFF-IT job can consist of four data files:

• an FP file (final page) which has links to the data files with the graphic content. This file is optional.
• an LW file (linework). This is a palette high-resolution image that contains the linework part of the

job. This file is optional or required, depending on whether or not it is referred to in the FP file.
• an HC file (true-color high-resolution image), containing the linework part of the job. It is possible,

but unusual that both the LW and the HC are used at the same time. This file is optional or required,
depending on whether or not it is referred to in the FP file.

• a CT file (true-color CMYK contone). This file is optional or required, depending on whether or
not it is referred to in the FP file.

The TIFF-IT Import task converts a TIFF-IT job to a single PDF referring to an external CT, plus
optionally to a number of LPs with copydot and/or high-resolution CTs with blend areas.

The external CT may stay in TIFF format or can be normalized to the BG CT format. LPs with copydot
and CTs with blends will be always BG ones. The rest LW/HC part of the job (after removing copydot
and/or blends) gets contourized and is stored within the PDF.

When the job is launched, the topmost image is passed as the 'input' file and references to other
images are made by entries in the task ticket. The server part of the task recognizes a job as being
a set of free images and processes them accordingly.
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TIFF-IT

The options on this tab change according to the type of job selected:

1. For jobs with a Final Page it shows the image files and indicates their presence (see first screen
shot above).

2. For jobs without a Final Page, the TIFF/IT tab shows the name mode selector, one for each
possible dependent file (LW, HC and CT file) (see second screen shot above).

The different modes are:

• Select None if the dependent file is omitted (missing).
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• As LW with extension: Enable this toggle if you want the name of the dependent file to be
derived from the primary one (by changing the extension).

• Other: Use the Browse button to indicate the path of the dependent file.

The special notation ('?') allows unique handling of jobs having both the more frequent extension
ILW/IHC/ICT and the less frequent one LW/HC/CT.

 or  indicates whether or not the image file exists.

Keep native and verify Certain file types like copydot, tiff and eps files are already in a reliable format.
These files will be verified and left in their native format. On-the-fly preview files will be created.

Output File

The default page size is Job size. When Job size is selected, the page size found in the selected
file will be taken into account when importing. The Custom option allows you to enter page size
values manually. The dropdown list displays all possible options (Custom, A5, A3, Letter, Scanner
Trim Size, Tabloid...).

Reader's Spread

None of the file formats that can be wrapped into a GRS has the notion of reader's spread. It can
be useful, for example when using the GRS files in FastImpose, to give an indication of whether the
file is a single page or a reader's spread.

• Single Page forces the file as single page output.

• Reader's Spread forces the file into a reader's spread format. The file will be set as double pages.

• Auto checks the size of the image and when the image width equals or exceeds two times the
selected page width, the reader's spread option is set. Otherwise it is treated as a single page.

Offset

Enter the appropriate values to give the page a horizontal and/or vertical offset.When no offset is
given, the center of the image will be positioned on the center of the page. If the page is smaller
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than the image (width, height, or both), then margins will be set that enclose the image completely.
The size of the margins will not be fixed. Margins indicate the differences between the image size
and the user-defined page size.

Margins

Tick the margins toggle and define the margins' dimensions if you want to give the margins of the
page a fixed size (for example 3 mm for bleed). Click the arrow in the dropdown list to switch between
millimeters and inches.

Select the page number from the file that you want to output.

Display images

This option allows you to change the preview settings of the file. Select None, Thumbnail or Image
from the dropdown list.

Linework

Contours:

• match pixels exactly (robust mode): Contourization is done using an older, but proven algorithm.

• match pixels exactly (fast mode): Contourization is done using a faster algorithm.

Tip:

In the unlikely event that contourization fails, try again in the robust mode.

• are straightened: This option straightens borders of continuous single color areas (for example
the borders of black characters on white paper).

Overprint Settings:

• Pure Black: Set the paint mode for objects containing 100% black and at least one other ink.
Possible Rich Black paint modes are:

• Keep Opaque (masking) sets the overprint mode to opaque for all objects containing 100%
black and at least one other ink.

• Force BG Overprint sets BG Overprint for all objects in 100% black and at least one other ink.
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• White: Possible White paint modes:

• Keep Opaque forces all objects in white to Opaque.

• Make transparent will remove all white objects.

Copydot:

• Detect where the job contains copydot: the data will first be pre-read and analyzed for copydot
and/or blends. The areas found will be handled appropriate way.

• Job does not contain copydot: all data will be contourized.
• Job contains only copydot: all copydot-like data will be separated to LPs without detection.

Note:  The implementation includes storing the results of the copydot/blend detection as part of the
metadata of the HC/LW file. If the job will be re-processed, then re-reading won’t be necessary.

Minimum size (square units): Six square units is the default value.

Tip:  If your job terminates with an error, check the log message. It may be that the selected minimum
size is too small. Select a higher value and relaunch the job.Error message: “ERROR: Premature
end of data splitting. Exception of class ACQF_EDataSelectHCWithTransparency with message: "A
copydot or blend area was detected which is transparent. The result of splitting can therefore not be
guaranteed to be correct. Please try doubling or tripling the "Copydot Minimum size" option value."

Image Directory: all .lp files are by default stored in the ct directory of the job folder. Use the Browse
button to select a different directory to store .lp files.

Inks

The Inks tab contains a fixed list of inks (default, cyan, magenta, yellow, and black).

Note:  You cannot add or modify inks in the Normalize TIFF/IT File task.

If an image contains definitions for its inks (for example a CMYK Tiff or a PhotoShop DCS2) and an
ink of the image matches an ink selected in the inks tab, then the angles, lineature, etc... in the output
file will be the ones from the inks tab. All inks in the image that do not match the selected ink in the
inks tab will be processed according to the default values for angle, lineature, etc...
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If the image contains an ink that is not listed in the inks tab, its angles, lpi, etc... the default values
will be taken into account.

Values (angle, lpi, dotshape, ...) you define in the default line of the inks tab are used to define the
angle, lineature, etc... of new inks added to the inks tab. The default line has no effect on the output
file.

If the wrong ink is selected, together with the default ink, then the output file will be generated with
brix parameters from the default ink.

Add Parameters for Nesting (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

Use this task to specify nesting parameters for a particular graphic (cut path, quantity needed, due
date...).

If you want to combine several graphics onto a sheet, you should send them all to the same Add
Parameters for Nesting task.

You can send PDF (single page or multipage), TIFF, PSD or JPEG files to this task. Progressive JPEG
compression is not supported.

It outputs an XML file containing all of the nesting parameters for the graphic(s). You can then send
that XML file to the Create Nested Layouts task.

Note:  You can use SmartNames to retrieve the parameters needed from the job setup.

1. In the Front tab, specify the Quantity of that graphic that you want to print.

You can select Maximum Fill if you want to print as many copies as will fit in one sheet (if you
are not sure how many copies fit exactly and you don't want to waste paper).

2. If the input file is a downscaled version of your graphic, enter the Scale to use.

For example, enter 1000% to compensate a graphic that was downscaled to 10%.

3. If the graphics in your files have a bleed outside the cut path, you can clip it away by entering
the bleed distance into Bleed Clipping Mask.

4. Enter/choose the ink used for the cut path in the Cut path table (the drop-down list will contain
all inks used in the input file).

You can Add several inks (for example if you have customers from different countries using
different ink names like cut, découpe, taglio...) and Move them Up or Down the list. The order
is important as the task will use the first ink it finds in the list.

Note:  If you have specified a cut path ink name in the Prepare Graphics for Nesting task, you
only need to enter that one ink name.

You can use SmartNames to retrieve ink names from the job setup.

Select Create cut path from trim box if no ink is found if you want to use the trim box to create
a cut path when a file doesn't contain any of the inks you specified.

5. Specify a Due Date for the nesting (when the sheet with the nested graphics needs to be printed).

6. In the Back tab, you can specify what to print on the back of each repetition of the graphic:
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• No graphics.
• Even pages of multipage file: if you choose this, the odd pages of the file will be printed on

the front, and the even pages on the back (this only works with multipage PDFs).
• Graphics from front side: choose this if you want to print the same graphic on the front and

on the back.

If your graphic has an irregular shape, you can select Flip horizontally so both graphics face
the same direction and have the exact same contour for cutting.

If your graphic contains text, you shouldn't flip it as this will make the text unreadable.
• Other graphics: you can Browse to the graphic you would like to print on the back side.

Tip:  Give the graphics to print on the back a consistent name, and use SmartNames to retrieve
them (for example, [File]_back.[Extension of File]).

Adjust PDF Screening (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

Use this task to change the screening parameters in the input PDF. You can use it to define specific
screening parameters for some or all inks in your file, and/or assign default screening parameters to
inks with no screening parameters specified in the file.

Note:  This task doesn't change the ink order in the PDF.

1. In the Inks table, double-click the first row in the Ink Name column, enter the first ink for which
you want to define (new) screening parameters and press Enter.

2. The Ink Book column, you will see all the ink books containing this ink name in the CMS database.
Select the correct ink book for your file.

3. Enter the Ruling, Angle and Dot Shape to use for this ink.

This uses the Ruling unit defined in the Preferences.

4. Repeat for all inks needing (new) screening parameters.

Tip:

To define the same parameter value for all inks in the table, double click the header of the
parameter column, enter that value and press Enter.

For example, to give all inks a runling of 150 dpi, enter 150 in the Ruling column header and
press Enter.
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5. At the bottom of the task panel, enter the Default Ruling, Angle and Dot Shape values to use
for inks you entered in the Inks table without those values.

Note:  If you don't fill in default values, inks without a ruling defined will get a ruling of 120 lpi (or
equivalent in your ruling unit), and inks without an angle defined will get an angle of 45°.

Contourize & Clean (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

Contourizing is reading image pixel data and writing them as vector data. This reduces the amount
of image data and can straighten borders of continuous single color areas (for example the borders
of black characters on white paper).

Contourize

• Low Quality (fast speed): The fastest way of contourization with low data amount reduction ability;
the contours follows pixels as rectangles.

• Medium Quality (medium speed): Does not reduce the data very efficiently, but it is very fast; it
straightens the borders of continuous single colored areas.

• High Quality (slow speed): Is much slower than Medium Quality contourization, but it reduces
the amount of data a lot.You can define the margin the system has to take into account when it
contourizes (enter the number of pixels).
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When the Copydot data toggle is selected, the system will check for Copydot data. If the system
finds Copydot data the task will be terminated. If the toggle is not selected, the job will be processed
no matter what.

Note:

The Background color is not contourized.

If you want to clean your job, select the Clean toggle first.You can set the cleaning parameters, you
can also select the unit of those parameters (pixel, mm, inch and mil).

You define the contours you want to keep, a zero will be ignored.

• Minimal Horizontal and Minimal Vertical size. You fill in the minimal size of the contours you want
to keep, all the others (smaller ones) will be cleaned.

• Maximal Horizontal and Maximal Vertical size of the contours you want to keep, all the contours
that are larger will be cleaned. Contours with a vertical size larger than maxv and a horizontal
size larger than maxh will be removed. A value of 0 in one of the fields will disable the check on
maximum size. A scan can have a black border on the edges, just like an image scan will often
show the edge of the slide it was scanned from. That black border will be made up of two contours
with a large size, a size larger than the 'logical' size of the page. You can therefore remove it by
specifying the maximum sizes as equal to the page size.

Create Master DCS File (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

The Create Master DCS task is intended to bind a set of stand-alone files containing bitmap or
copydot data (particular ink separations of one image).

Output consists of a file in DCS 2.0 format with references to the separate plate files selected by
the user.

This task is useful when separation plate files have been delivered without a master DCS file or when
the master DCS file is no longer valid (due to wrong references or wrong preview).

The Create Master DCS task supports the TIFF, JPEG and EPS file types, and can also be applied
to a Folder.
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Separations

The Separations tab consists of three groups:

• Files
• Separations
• CopyDot



2
Automation Engine

539

Files

The Remove button is intended for removing files from the list. It is most useful if you select the
entire Folder first.

Separations

This option allows you to control how ink names will be parsed from the file name.

• From extension: Enable this toggle to indicate that the short ink name is an extension of the file
name. For example 6787.c

• From suffix: Enable this toggle to indicate that the short ink name is a part of the file name.

In the Separator field you can enter the character which is inserted between the basic name of
a file and the short ink name. For example '$' in 6787$c.tif'

CopyDot

• Yes: Enable this toggle to indicate that all separations are Bitmap or Colored. The CopyDot marker
is added.

• No: Enable this toggle to indicate that separations don't contain CopyDot data. The CopyDot
marker is not added.

• Detect: Enable this toggle to indicate that all separations are Bitmap or Colored and the
application detects CopyDot data in at least one of them. The CopyDot marker is added.

Tip:  Using the Detect option has an effect on the speed, while the real separations data is read
during detection.

Note:  Files containing CopyDot data must be marked in order to be processed correctly in the
workflow.

Tiff Preview
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Select whether or not you want to create a new preview or use an existing one. Depending on your
selection, different options will appear:

Use existing file(s)

When a file is selected, and you tick the Use File radio button, the Browse button will be activated.

When a folder is selected however, you will have to pick the correct extension from the list.

Create Tiff preview

Select the appropriate preview mode:

• CMYK
• RGB

Resolution

Set the resolution of the created preview image. Values are expressed in dots per inch (dpi).

• Screen: Enable this toggle to create a preview at a resolution of 72 ppi.

• Medium: Enable this toggle to create a preview at a resolution of 150 ppi.

• High: Enable this toggle to create a preview at a resolution of 300 ppi.

• Other: Enable this toggle to create a preview at the resolution you specified in the ppi input box.

Note:  The values mentioned about are only valid if you work in ppi. The value specified here depends
on the resolution preference settings.

EPS Preview

The EPS Preview tab displays the same options as the Tiff Preview tab.

Create Nested Layouts (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

Use this task to nest a set of graphics onto one or more sheets, and create production files (a PDF
print file and a cutting file) for digital printing and finishing.

Send the XML files generated by the Add Parameters for Nesting task to this task. You don't need to
send the graphics as each XML file contains a link to the related graphic.

You can also use (compatible) XML files produced by an MIS system.

Alternatively, you can send already stepped and repeated (PDFPLA) files to this task to generate
production files. This will then skip the nesting part and only output a print file and a cutting file.

Note:  You can use SmartNames to retrieve the parameters needed from the Job setup.
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Note:

In a workflow, this task has four output pins (Print Files, Cutting Files, Done Graphics and
Remaining Graphics), so you can send each type of file to the right place more easily.

If you select Create report, the task will have a 5th output pin for the report.

Sheet Setup Parameters

1. In the Sheet Setup tab, define the sheet size. You can either:

• Use a Sheet Template that you have defined in i-cut Layout.

Sheet templates contain height, width and substrate information.

Tip:

If you have several templates using the same substrate but in different sizes, you can also
select the substrate name as sheet template (shown in blue in the list).

In this case, the task will try nesting the graphics on the different substrate sizes, and will pick
the best size for the job (or a combination of sizes).

• Define a Sheet Height and a Sheet Width.
• Enter the Substrate that will be used for the sheet.

You can also Fit the sheet size to the size of the nesting (you can fit either the Sheet Height, the
Sheet Width or the Width & Height).

For example, for roll-fed printing, the sheet height will typically be the height of the roll, and the
width will be fitted to the size of the nesting.

2. Optionally, you can add Margins around the nesting (a Top, Bottom, Left and Right Margin).

The margins won't be used for printing/cutting, but may contain some bleed.

3. If desired, you can add SmartMarks (that you created in i-cut Layout or PackEdge) to your sheet.

4. If printing Front and Back, define how the sheet will be turned for back printing in Backing Up:
either Work-and-Turn or Work-and-Tumble.

Nesting Parameters

1. Select the Nesting Type to use for the layout:

• Minimal Waste tries to reduce the waste in material to a minimum,
• Minimum Layouts reduces the number of production files to a minimum (as for each new

layout, a new print file and cutting file are generated),
• Guillotine Cut prepares layouts to be cut on a Guillotine table, reducing the number of cuts,

and making sure all cuts are possible on a guillotine cutter.
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2. Select the Search Method to use for calculating the layout.

Depending on if you are running a test or processing graphics for production, you can set the
layout search from Very Fast to Slow (Very Accurate) (the faster the search, the less accurate
the result can be).

3. Optionally, select Respect the graphics order if you want to nest the graphics in the order in
which they are coming in.

Tip:

You can put a Sort workflow control in front of the Create Nested Layouts task to sort the files
in a particular order.

Alternatively, you can put a Sort in front of the Add Parameters for Nesting task to have that
order already reflected in the XML file (when using an XML file for several graphics).

4. If you have selected Minimal Waste or Minimum Layouts, you can set:

• the Fill Starting Point on Sheet (where the first graphic will be placed): at the Top Left, Top
Right, Bottom Left or Bottom Right,

• the Primary Fill Direction (in which direction the sheet will be filled): Horizontal or Vertical.

5. If you have selected Guillotine Cut, you can set:

• the direction of the First Cut: Horizontal, Vertical or Don't Care,
• a Maximum Overrun to get less different layouts: if you are printing different quantities of your

various graphics, some of the graphics with a lower quantity might get printed in excess to
keep the number of layouts to a minimum. Enter the maximum number of excess graphics
that can be printed in Maximum Overrun.

If you only want to print the exact quantity you specified for each graphic, keep the Maximum
Overrun to 0.

6. If desired, you can add a Gutter in between cut paths (specify the width).

7. In Rotation, specify if the task can rotate the layout in case a better fit is possible. You can choose:

• Allow any angle,
• Allow 90 degree,
• Allow 180 degree,
• No rotation.

8. Optionally, you can center the nested graphics on the sheet: in Align nesting center graphics
on sheet, select either:

• No if you don't want to center them,
• Vertical to center the graphics vertically,
• Horizontal to center the graphics horizontally,
• Vertical and Horizontal to center them in both directions.

9. Enter a Minimum Fill if you only want to output the sheet if it's filled to a certain level.

Note:

Do not put 100% here as only the graphics inside the cut path count as fill. The margins, gutters
etc. all count as waste.

By default, the minimum fill is set to 75%.
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10.If there is a due date linked to your graphics (see Add Parameters for Nesting (Deprecated) on
page 534), select what to do if the minimum fill hasn't been reached and the nesting hasn't
been output by that date in Action when Due Date Expires:

• Set Task Status to Error.
• Force Nesting and Save to PDFPLA to output the nesting as a PDFPLA instead of as

production files.

You can then edit the PDFPLA manually in i-cut Layout (for example to print it on an offcut), or
feed it back to the Create Nested Layouts task together with other graphics to fill the sheet
a little more.

• Force Nesting to output the sheet anyway.

Output Parameters

The task will output:

• PDF print files,
• cutting files (in your desired format),
• nesting reports (optionally),
• XML files containing references to any non-nested graphics and their quantity.

1. In Save Print Files, select how to output the PDF print files:

• as Single Files to have one single page PDF file per layout,
• as 1 Multipage File to have one multipage PDF file containing all the layouts.

Attention:  If the dimensions of the different layouts vary (for example when using
substrate-based nesting or the Fit option), the task cannot create a multipage output.

Note:

If multiple copies of the same layout need to be printed:

• For single page output, the number of copies will be part of the PDF file name.
• For multipage PDF output (and if the number of copies per page is less than 10), the same

page will be inserted multiple times, using forms to prevent the file size from growing.

2. In Save Cutting Files, choose the cutting file format you want to generate (i-cut, HPGL, PDF,
MFG or ACM).

Note:  When generating an ACM file (for a Kongsberg table), you can select Print Side Up, to
cut with the print side visible.

Tip:

• If you have several cutting tables and you don't know yet which one you will use to cut the
sheet, you can generate several file formats: choose Select File Types..., select all the file
types you want to generate and click OK.

• If you want to check your cutting files for quality control, you can also output a PDF file and
inspect it in Acrobat.
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3. If desired, you can Add Extra Structural Inks (for fold lines for example) that will be added to
the cutting file and excluded from the print file.

Tip:  Use commas to separate the list. You can use wildcards (*).

4. If you want, you can create a nesting report (for example to use as feedback for a MIS system).

Select Create layout report if you want a report detailing the different graphics used in each
layout.

Select Create report per graphic if you want a report detailing in which layout(s) each graphic
is nested.

5. In Output Name, enter the base name to use for the output files.

For example, if you enter Promotional_Coasters, the first layout will be called
Promotional_Coasters_1.pdf, the second Promotional_Coasters_2.pdf, etc.

If you don't enter anything, the name of the first input file will be used.

6. Define where to save the production files, the report(s) and the XML file(s) referencing any non-
nested graphics:

• If you want to save all output files in the same folder, select Save all files in the same folder,
and browse to that Output Folder.

• Otherwise, make sure Save all files in the same folder isn't selected, and browse to your
chosen folder for the Print Files, Cutting Files, Report Files and Remaining Files (XML file(s)
referencing any non-nested graphics).

Expand Variable Data to PPML File (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

The Expand Variable Data to PPML File task performs expansion of the specified database entries
into the corresponding graphical output and comes in two variations; one for the PackEdge workflow
and one for the DeskPack workflow.

The Expand Variable Data to PPML File is used for the PackEdge and Plato workflow. The input
file is a PDFPLA file. The ticket allows you to set all variable data parameters.

In the Expand Variable Data to PPML File (DeskPack only) ticket, only the output location and a
file name can be specified. This task is only used for expansion executed from within stepX.

All workflows will start with this task. In most cases, the expansion task is followed directly by the
RIP to WS4000 Series task, so creating a workflow ticket for both tasks is recommended.

However, independent use of the expansion task is also possible (in case you only care about the
expansion output, but do not want to run the RIP task afterwards).

It is compulsory to specify an output folder for the 'Expand Variable Data to PPML File (DeskPack
only)' task. Not doing so could generate a task error.

However, since you are allowed to use Smart Text in the specification, it is possible to create a path
similar to this: [joburl]/tmp_expansion/[date]_[time].

The contents of this folder must be maintained manually as the files are not deleted automatically.

The task takes the following input files:
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• a design file containing variable elements (Normalized PDF file)
• a repetition file generated by the stepX plug-in (PDFPLA file)
• a database file (XML or CSV)

It can generate the following output files:

• one file with constant (unchanging) graphic elements (Normalized PDF file)
• several files with variable graphic elements (Normalized PDF files)

All these files are linked together by a standard PPML file.

Grids

The VDP parameters must be specified for each grid individually. To specify the parameters for a
grid, select the grid on left. If the repetition layout contains more than one grid, use the + button to
add the required number of grids and specify parameters for every grid.

Grid Contents

The expansion task can handle two types of grid contents. ‘Identical One-ups’ does not include any
variable elements. It will fill the empty space on a substrate that is unused by variable data. ‘Variable
One-ups’ carries the design with variable data elements. These two types of grid contents have
different parameters. The main difference lies in the absence of a database for identical one-ups.
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Following enumeration gives you an overview of the differences:

Identical one-ups:

• Total number of one-ups for repetition
• Block size (optional)
• Gap size
• Gap at the beginning of the job (optional)
• Gap at the end of the job (optional)

Variable one-ups:

• XML database – file URL
• CSV database – one or two file URLs + other options (delimiter character…)
• Image Path URL – when Image Marks are used (optional)
• Block size: job, sheet or custom
• Gap at the beginning of the job (optional)
• Gap between blocks (optional)
• Gap at the end of the job (optional)
• Gap size
• Ordering
• Empty one-ups

Database

This parameter defines the database which will be used for expansion. The database is specified
either by an XML or a CSV file.

XML Database This type of database is a file in the eXtensible Markup Language format. Clicking
‘Open from XML...’ opens a file browser, which allows you to select the XML file. Please note that
the XML file must be stored within an Automation Engine container.

CSV Database A CSV is a Comma Separated Value file. The ‘Open from CSV...’ button opens a
dialog box, where the operator has to specify a URL to the database file, its Encoding and Field
Separator options.If field names are not stored in the first line of the database file, you can specify
a separate file with the required information by using the Field Names part of the dialog box. An
overview of the settings will be displayed in the expansion task window.

Image Path The location specified here is used to fill in the ‘vdp_image_path’ File SmartName, which
might be necessary if the job uses Image Marks. It must contain a valid path which will be used to
locate the images in the variable data.
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For a description of the Image Path parameter, please refer to Variable Data Printing workflow
document..

Content Filling

This part of the dialog box is used to specify how the database values will flow through the variable
job.

Block Size

Following options are available:

Complete Job This option defines that database will flow through the job without any interruptions.

One Frame The size of a frame is equal to size of the document defined in stepX or Plato.

Custom The size of a block is custom-defined. Units are grid rows, frame size, meters or feet.

Filling Order

Following options are available:

• Rows: The numbering is restarted when the end of a row is reached and continues from the left
cell of the next row. The starting position is the top left cell of each block.
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• Rows (ZigZag): The numbering is restarted when the end of a row is reached and continues from
the cell located below the last cell. The starting position is the top left cell of each block.

• Columns per Block: The numbering is restarted when the end of a column in a block is reached
and continues from the top cell of the next column. The starting position is the top left cell of each
block.Note: If the Block Size is set to ‘Complete Job’, then this filling order is equal to 'Columns
per Job'.

• Columns per Block (Reversed): The numbering is restarted when the end of a column in a block
is reached and continues from the bottom cell of the next column. The starting position is the
bottom right cell of each block. Note: If the Block Size is set to ‘Complete Job’, then this filling
order is equal to 'Columns per Job (Reversed)'.
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• Columns per Job: The numbering is restarted when the last cell of a column in the job is reached
and continues from the top cell of the next column. The starting position is the top left cell of
the job.

• Columns per Job (Reversed): The numbering is restarted when the last cell of a column in the
job is reached and continues from the bottom cell of the next column. The starting position is the
bottom right cell of the job.

Create Gaps

Some jobs need to be interrupted after a certain amount of labels (defined by Block Size) and continue
after this interruption to the next gap or to the end of the job.No one-ups are printed in the gap area,
so the press operator can easily identify the gap as a white area. However, all elements outside the
one-up area, such as die cut marks, are printed.

Here you can specify where you want to the gaps to be generated. Following options are available:

Starting gap: This gap will be printed first from the press point of view.
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Gap between blocks: These gaps will be generated in between Blocks.Note: When Block Size is
set to ‘Complete job’, this toggle is useless.

Ending gap: This gap will be printed last from press point of view.

The ‘Gap Size’ option specifies the size of the gaps in grid rows, frames, meters or feet.

Put Empty One-Ups

In general, the database size is not an exact multiple of the number of cells in a block. One of the
blocks cannot be filled completely with database entries. It will be padded with empty one ups. The
toggles ‘At the start’ or ‘At the end’ specify where to put the empty one-ups from Filling Order point
of view.

Export to GRS file (Deprecated)

Exports a Normalized PDF file to a GRS file.

External references External references have to be converted, you can define what the system
needs to do:

• Write external references which are close to the input file to the output folder. All other external
references will be written in their original folder.

• Write all external references to the output folder.
• Write all external references to their original folder.

When converting again, you can opt to:

• Reconvert if recently updated: only updated references will be reconverted, all other conversions
will be used as they were.
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• Use previous conversions: the existing conversions will be used, potential updates will not be
considered.

• Always reconvert: all external references will be converted at all times.

External images Referenced files in Normalized PDF job file format will be converted to referenced
external files in the GRS file. Indicate which images you want to have converted.:

1. Only images which are close to the input file.
2. All images
3. None

Fail when fonts are not found: when the fonts used in the file are not found the task will fail, when
the toggle is not selected, the task will end with a warning

Fail when external references are not found: the task will fail when not all external files were found.

Export to Normalized PDF File (DeskPack Only)(Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

This Task is only useful in a DeskPack workflow, please refer to the 'Adobe Illustrator Client' manual.

Export to VRML File (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

VRML stands for Virtual Reality Modeling Language. This task can make a 3D model of an Esko
native file that has a link to an ARD (Artios CAD) file. The result of the task is:

• A VRML file: a .wrl file. wrl stands for 'world' as in virtual world.
• One or more JPEG files, to build up the visualization of all the panels and all the sides of the 3D

simulation.

Note:

• The Esko native file must contain a link to an ARD file.
• The ARD file must contain folding information.

Tip:  You will need a VRML viewer to view the result of the task. There are three types of VRML
viewers: a plug in, a helper application or a stand-alone application. Several freeware VRML viewers
are available on the Internet.

Tip:  Supports recto/verso graphics. If the input file has 2 pages, the second page will be placed
on the inside of the CAD file.
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Note:

Linking a Normalized PDF file to an Artios CAD file can be done:

• using PackEdge,
• using Esko's ArtiosCAD plug-ins in Adobe Illustrator.

You can set resolution in ppi, ppmm or ppcm and define the JPEG compression. Options range
from: JPEG Limited, JPEG Low, JPEG Standard Low, JPEG Standard (default), JPEG Standard High,
JPEG High and JPEG Extreme.

Note:  There is a limit to the kind of resolution that the task will process, internally the output resolution
is restricted, so entering a higher resolution does not necessarily result in high resolution output.
Except for when the option high resolution images is selected.

JPEG Images:

• Separate Image on each face: creates a separate JPEG file for each face.
• High resolution images: use 'High Resolution Images when there is small text on the design, or

other graphics which require a high level of detail. A separate file is created for each face, but if
more detail is available, the files are larger.

• Single image: makes a single large JPEG file for each design instead of a single JPEG for each
face. Use this option when using the VRML file in other 3D graphics applications.

Creases:

• No creases
• Creases in board color: creases are included in the VRML, they have the same color as the board,

the lightning in the VRML rendition shows them as slightly contrasting.
• Creases in pink: turns the creases pink for easy visibility.
• Graphics on creases: wraps the graphics around the creases, this is the most sophisticated

option, but it increases the file size by 50 percent.

Animation:
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• No animation: creates an unmoving view of the design.
• Forward: runs the animation continuously.
• Forward and Back runs the animation forward, then backward, and repeats.
• With toolbar inserts a toolbar into the VRML file allowing you to manually step through the file,

as well as toggle design transparency.

Note:  This works only when the ARD file contains frames.

Output units: As there is no measurement ability in the browser window, the options in this group
control the granularity of the VRML plug-in's zoom tools. Selecting 'Meters' provide coarse zoom
while selecting 'millimeters' provides fine zoom. 'Centimeters' is the default, and should be selected
when choosing 'With toolbar' in the 'Animation' group.

Include graphics: this toggle controls the export of graphics. Toggle on for rich detail, toggle off for
the smallest VRML files with the most robust performance.

Include corrugations: this option draws corrugations on the edges of corrugated boards. This
depends on the ARD file's substrate definition.

Use compression: this option controls whether the VRML geometric information file is compressed
or not. A smaller file is faster to download, but some VRML browser plug-ins do not support
compression. The JPEG image files are already compressed according to the JPEG Compression
(at the top of the task).

View Zoom Factor: sets the initial field of vision in the VRML file. If you find that animations are
bigger than the browser window, try setting the value to a smaller number. You can enter zoom factors
between 40 and 250 percent.

Background color

• No background: no background will be defined, the preferences set in the VRML plug-in will be
used.

• Define values for Red, Green, Blue.

For example, this job (Lemon.pdf) contains a link to an ARD file which contains folding information.
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If we run this file through the VRML task, we get a wrl file that looks like this when we view it in a
VRML browser:
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FastVariants - Check (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

FastVariants is the perfect solution to avoid problems in a double-burn workflow, when one of the
plates on the press is replaced for a new run, and the other(s) are identical.

Two double-burn workflows are possible:

1. A neutral version + K variant for each language separately.
2. Different variants as full CMYK.

Use the FastVariants - Check task to compare the non-variable inks of two files (CMY in most cases).
It checks if there are differences, and shows you where they are situated. If the result of the Check
task is OK, the two files are double-burnable and you can use the FastVariants - Split task.

In case the FastVariants - Check task is run on impositions, it compares the page assigned in the
background (imposition) layer with the master page of the assigned page in the variant (imposition)
layer. By master page is meant the appropriate page from the master (or original if there is no master)
layer.

The FastVariant task can also be run from the Pages View. A few remarks:

• The variant ink selection follows the use case.
• The FastVariants task also works on page selection.
• When two incoming files or layers are selected, the Check task checks these (appropriately

normalized) files.
• Layers under incoming files are by default named as follows:

• 'original' stands for the originally normalized file.
• 'master' stands for the master file (result from the Split task).
• 'variant' stands for the variant file (result from the Split task).
• 'difference' stands for the difference file (result from the Check task).

Compare
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You can either compare files or folders. Depending on what you selected, the Compare option will
display 'Reference File' or 'Reference Folder'.In case a folder is selected, the FastVariants - Check
tool compares the folder file per file on the condition that both folders contain an equal number
of files and that the number of pages in the selected files matches the number of pages in their
reference files.

Use the Browse button to select the correct reference folder or reference file. This is the file or folder
you want to compare the selected file or folder with.

You can set the accuracy to normal, high, or very high. Depending on this setting, the checking will
take more or less time.

Enable the Ignore variant ink toggle and select the appropriate ink from the dropdown list.
FastVariants will now compare the selected files or folders and will report all changes, except for
those in the variant ink.If a folder is selected, it is possible that not all inks appear in the list. If this
is the case, enter the ink name manually.

Note:

This option is not relevant when comparing several versions of the same file.

In the Compare Area you can indicate what area should be taken into account when the file is being
checked. If you set the area to Job Size, the whole job will be compared, including margins. Custom
allows you to set the size and the offset of the area you want to have checked.Page size + bleed
checks everything that is within the borders of the file. You can specify an extra bleed distance.

Note:

Selecting the correct compare area is important to avoid irrelevant differences being reported, like
for example a time stamp in the text of a page mark.

Page Range allows you to indicate the range of pages that need to be checked. When multiple files
or layers are selected, the Checker task checks these files.
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Differences

Enable the Save differences toggle to activate this part. When differences are found, but not saved,
no separate layer will be created.

Note:  Specify an output path and file name if you do not want the original input to be overwritten.

Select a color from the dropdown list to mark the differences.

If the Add reference layer toggle is checked, a separate layer with an external reference will be
added to the job. When the reference layer is present you can toggle the differences in PackEdge
and check the differences visually.

Check the box 'Make FastVariants 'Check' layer printable' to be able to see the layers containing
differences when proofing. If the toggle is not selected, however, then layers containing differences
will still be visible in PackEdge, but as they have the 'non-printable' mark, they will not be on the proof.

Make original layers printable

Make original layers printable. Set this mark for the original image.

Note:  Make sure that one of the print options is set.

FastVariants - Remove White Boxes (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

It is common in double-burn workflows that the different versions are supplied as separated
PostScript files containing only the variant ink, usually K.

These files can be easily combined with the neutral version by superimposing the two, for example
by using layers in FastImpose.

It is usually the case, however, that these separated PostScript files contain white opaque boxes that
cause elements to disappear from the neutral file, when the two are put on top of each other.
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The FastVariants - Remove White boxes task is specially designed to remove these obtrusive white
opaque boxes.

White opaque text will never be removed. White opaque strokes can be kept when the toggle has
been enabled.

Enable the Keep strokes toggle to keep strokes with a maximum width of x mm or inches. All strokes
smaller than the selected width will be kept.

FastVariants - Split (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

Use the FastVariants Splitter task to split the input file into a fixed master and a variant part based on
the graphical object database. The splitting is being performed on the basis of the variant parameter
ink. In most cases, black will be the variable ink.

The term Master refers to the fixed part of the job, Variant to the variable part of the job.

When this task is run on impositions in the Pages View, it splits an (original) page assigned in a variant
(imposition) layer into a variant and a master page. It replaces the original page by the variant page
in the variant (imposition) layer and assigns the master page to the background (imposition) layer,
provided that this one is empty.

The FastVariant task can also be run from the Pages View. A few remarks:

• The variant ink selection follows the use case.
• The FastVariants task also works on page selection.
• When two incoming files or layers are selected, the FastVariants - Check task checks these

(appropriately normalized) files mutually.
• layers under incoming files are by default named as follows:

• original: original normalized file.
• master: master file (as a result of the Split task).
• variant: variant file (as a result from the Split task).
• difference: difference file (as a result from the Check task).
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Select the Variant Ink from the dropdown list.Enable the Extract Master toggle if you want to keep
the fixed (master) part of the job and have the variant part removed.Enable the Extract Variant toggle
if you want to keep the variant part of the job and have the fixed (master) part removed.Enable
both toggles if you want to split the (reference) file into a Master part and a Variable part.Enter an
appropriate file names for the both Master and Variant.

Page Range allows you to indicate the range of pages that need to be split.

Fork (Deprecated)

Note:  This task is deprecated from Automation Engine. You can use the advanced routing
functionality of the Workflow Editor instead. Learn more in Routing in Workflows on page 1006 in
the chapter "Workflows".

Note:  The currently available Fork Workflow Control is a different feature. Learn more in Fork and
Join on page 1032.

A workflow ticket consists of a number of sequential tasks. Each task is executed after the former
was finished, each task involves processing the output file resulting from the former process.

It is not possible to define a workflow ticket in such a way that more than one task involves
simultaneous processing of the output file of the former. However, by inserting a Fork task in the
workflow ticket these kinds of workflows can be built.

The Fork Task launches other tasks via the tickets as specified (based on SmartNames or on plain
ticket names).

When such a task cannot be launched because the name cannot be resolved or the ticket cannot
be found, then an internal warning flag is set. Only when this happens for a line that is flagged as
critical, the Fork task will end with an error.

The Fork task allows you to launch multiple tasks at once. This makes a few new types of workflows
possible.

• Workflows in which the order of the tasks is not important.

I want to create, from my normalized PDF, a small export PDF, a JPEG and a ReportMaker print
card PDF. I do not care which one is made first, I just need all 3 of them.
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• Workflows in which the required mix of file formats is not possible to combine in 1 single workflow
ticket.

My workflow ticket should include both PostScript output and output to FlexRip, but first the
PostScript output.

The ticket(s) that a Fork task will launch can now be 'Smart-selected’.

For example If the Export to PDF ticket contains a SmartName that indicates the customer name
(as filled in in the Job Setup), then the fork ticket can generate different output, depending on the
settings for that customer.

Even the task type can be 'Smart-selected' which enables Automation Engine to intelligently select
the correct ticket, based on the type of action that needs to be performed, for example:

• reach an HP or an Epson proof?
• reach a CDI Compact or a CDI Spark?
• create a PDF proof or launch a WebCenter approval cycle?

Defining a Fork Task

1. Select the Tickets View in the Views bar, or in the Go menu. Select the Fork task.

2. Click the task's 'Add' button:
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It is possible to add a definition of a ticket by using SmartNames. You can for example define the
task type or the ticket name as a SmartName. This can help you to limit the number of tickets
to choose from when launching a task.

3. The Add dialog pops up. Depending on which 'Add' button you clicked, different Add dialog boxes
will appear.If you do not want to use SmartNames, you can simply select a task type from the list.

If you do use SmartNames, you also select the task type from the list and indicate whether this
new fork ticket is a Job ticket or a global ticket.Enter a new ticket name.

Let us assume you have two customers and one needs PDF 1.5 files and the other PDF 1.6 files.
You can then create a fork ticket called [export_for_customer] like this:
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4. The selected ticket is added to the fork list.

When you have two tickets in your ticket list: export_for_LabelPrinter and
export_for_FoldingCarton and you launch the task “Export_for_[Job Customer Name]”
in a job where the customer name = FoldingCarton, then this task will select the
“Export_for_FoldingCarton” ticket.

When you launch the same fork task in a job where the customer name = LabelPrinter, it will use
the “Export_for_LabelPrinter” ticket.

This means that using SmartNames in a Fork ticket does not limit the number of tickets as you
still need both “Export_for_...” tickets (you even need an extra fork ticket).

It does offer the advantage that the operator can always launch the same task
“Export_for_customer”. So the risk of mistakes will be reduced.

5. Add as many tickets to the fork you want.

Hit the 'Remove' button to remove the selected ticket from the list.
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6. If you use the Fork task in a workflow ticket, you can choose whether the next step in the workflow
will use the fork's initial input files, or the fork's output files.

Mark File (Deprecated)

Note:  This task is deprecated since Automation Engine 10. You can use the Mark workflow control
in the Workflow Editor instead.

This task marks the input file. Use it in a chained task ticket, in combination with the Copy or Move
File and / or the Delete File task.

Process Remote Proofs (Deprecated)

This is a deprecated task. It allowed to proof the files you received on your local printer with the
right color management and linearisation etc.. Some customers receive such files via FTP or as e-
mail attachments.

Trap - Create Trap Layer (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

This task traps the input file according to the settings specified in the TCP file associated with the
input file.

The output of this task is a trapped Normalized PDF file.

This task contains only the output options of the Trap task. All other trapping parameters are stored
in the TCP file located in the same folder as the input file.

The Create Trap Layer task has only one tab, and it's the same of the Prepare and Create Trap Layer
task's output tab.

See also: What is trapping?
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Trap - Prepare and Create Trap Layer (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

This task offers you all the settings of the PowerTrapper: full automatic trapping.

It selects candidate trap color pairs and executes the trapping. The trapping areas are added in a
separate layer on top of the original job.

What is Trapping?

The trapping process is a safeguard against possible (even likely) fluctuations in the printing process.
Minor discrepancies in registration, slight paper shifting can cause inks to misregister.

When two abutting colored objects don’t meet exactly, you can end up with a printed result like the
one below:

The overlap creates a dark area and the gaps cause an undesirable light area. To prevent these
potential discrepancies, a trap can be implemented, causing the original colors to slightly overlap
each other:

In general trapping is necessary when there are two abutting color areas that don’t share a common
ink.

Placing a fine line where they join, made of a color that contains components of both abutting colors,
can effectively trap such areas.

Trap Expert
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Select the automatic trap expert that will examine the job and select candidate color pairs for
trapping. Depending on the expert and its associated parameters, different color pairs may be
selected for trapping.

Two Trapping Types:

• Normal Trapping: This trapping expert selects abutting color pairs, which are likely to cause
registration problems like ugly light gaps, and unwanted halo effects. The expert automatically
chooses the most appropriate trap direction based on the relative luminance of the adjoining
colors. Lighter colors are generally trapped into darker colors to minimize the visual effect of the
trap.

• Reverse Trapping: This trap expert prevents overprint of abutting color areas with different inks
by selecting these color pairs to be trapped with a white knockout (erasing) trap. The white
knockout trap is put on top of the lighter of the two colors. This expert is useful to prepare a job
for Dry Offset printing (for example metal beverage cans) where overprinting of inks is not allowed
as the inks would contaminate each other on the blanket.

Minimum Ink Difference: Trapping is applied to two adjoining colors when one of the following two
rules hold:

1. The two colors each consist of at least one ink but they have no common inks.
2. The two colors have common inks and there is a difference larger than the minimum ink difference

percentage for at least two different inks that make up these colors. These differences in ink
amount must be in opposite directions (see also example 3 below).

The minimum ink difference defined in the second rule can be altered by changing the value in
the 'Minimum ink Difference' input field. The default minimum ink difference percentage is 10%.

Image Trap Direction

• Automatic: Determine the most suitable trap direction automatically by comparing the average
lightness of the CT image with the lightness of the abutting area and trap the lighter color into
the darker one. (default).

• Trap Images into Linework: Always trap CT images under adjoining line work.
• Trap Linework into Images: Always trap line work under adjoining CT images.
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Image Trap Color Specifies the color of CT traps in those cases were the CT should be spread into
an adjoining color area.

• Original Image Data: Use the trap shape as a clipping mask on a copy of the original CT image
placed in overprint. This only works if there is additional image data outside the original CT mask
(default).

• Extended Image: Same as above but the CT image is automatically extended (extrapolated) along
its top, right, and bottom and left edges to ensure the trap gets the expected color even if there
is no image data outside the original CT mask.

• Solid Color: Use a solid color as trap color instead of a (variable) CT. A suitable solid color is
computed by averaging the CT color along the boundary between the abutting color areas.

Image Trap Detail

This option is only used in a DeskPack workflow: image traps are rendered to linework.

• Coarse: is faster to process but will generate coarser results.
• Default: is a trade off between speed and detail.
• Fine: nice results, but larger files and slower to process.

Optimized for: The “Optimized for” option has three possible values that each correspond to a
different way to represent the traps in this particular case.

• Scope 2 and lower When this option is selected, the trap will be created as a stack of objects.
There will be as many objects in the stack as there are colors/objects contributing to the
transparency blend. Each object in the stack will have the shape of the trap and the color of one
of the transparent objects involved and will be put in blend mode Darken. Note that this does not
result in the correct trap color in all cases. The reason is that a stack of trap objects each with
blend mode Darken does not accurately represent the result of the original blend of objects that
can each have a blend mode different than Darken. The only advantage of using this mode is that
it will not create any new CT images and that it is 100% compatible with GRS and older versions
of the trapping software (Scope 2 and lower).

• Scope 3 When this option is selected, the trap will be created as a new internal raster image that
is obtained by rasterizing the original stack of objects/colors that contribute to the transparency
blend. The raster image is put in blend mode Darken and the trap shape is used as a clip mask
on the image. The advantage is that (apart from resolution limitations) the trap color is always
correct. A disadvantage is that new images are created to represent the traps, and that increases
the document's filesize. Although these images are stored as internal (embedded) images, such
images will still become externally linked if the file is later exported to the legacy GRS format.
Therefore, if a GRS-based workflow is still used and/or needed, the use of this option is not
advised.

• Esko Software Suite 7 and higher When this option is selected, the trap will be created as a
transparency group containing a stack of trapping objects corresponding to the colors and blend
modes of the original objects taking part in the transparency blend. The group as a whole is
put in blend mode Darken. Note that this is different from option 1 “Scope 2 and lower”, where
each of the objects in the stack were put in blend mode Darken. This option uses the new group
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transparency feature. This always results in the correct trap color without the need to create any
new raster images. It is advised to always use this option unless there is a frequent need to export
documents to GRS or to share files with sites that use Scope 2 or 3 versions. In those cases
this option shouldn't be used since the transparency group construct will have to be flattened on
export to GRS or import in the older Scope system, which could result in performance issues.

Ink Pullbacks

• Also for vignettes and images: normally the system only takes solid colors in account when
it comes to ink pullbacks. If you want to, you can force the system to perform ink pullbacks on
everything, also on objects overlapping vignettes and images.

• Ignore luminance: the system takes certain aesthetic precautions while trapping. It takes
luminance into account when calculating what ink (if any) to pull back. You can disable this
behavior by selecting this toggle.

Scan

During the scan phase the trapping software looks for areas in the job where trapping could be
applied.

To do so, the objects to be examined will be converted to a flattened graph. In the flattened graph,
the areas are searched for places where two regions are approximating each other.

For each region, the accumulated color is taken into account. This accumulated color is the result of
applying all the paint and transparency settings of the objects contained in the given region.

The accumulated colors of the two regions are then checked for a chance to trap.

If there is a chance between the two colors to trap, a color pair is generated, and the place of proximity
of the two regions is stored as a 'color pair hit' with the given color pair.

There are two different kinds of color pair hits: direct hits and indirect hits.

• A direct hit of a color pair for a common edge between two regions occurs where one of the
regions has one color and the other region has the other color of the color pair.

In this case, there is a direct contact between the two colors of the region. In the picture below
there is a direct hit for the color pairs (C, M); (Y, C); (M, K) and (Y, K).
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• An indirect hit of a color pair occurs at places where the two regions are geometrically close to
each other, but not with a common edge.

This is the case at places where the regions touch each other just at one point, where four or
more regions touch each other.

In the picture above there is an indirect hit for the color pairs (C, K) and (Y, M) at the point where
the four boxes touch each other.

The scan tab contains options to fine-tune this scan action.

Objects:

• All: Scan all objects in the job when looking for trap color pairs (default).

• Green Selection: Only scan objects that have been selected in the LineWork editor (in the green
user selection). If this option is active but no green selection is found in the job, the entire job
will be trapped instead.

• Close Gaps smaller than x mm: Some input jobs contain very small unintentional gaps between
neighboring objects, preventing the correct trapping of these objects.

Although it is better to clean up such jobs before trapping, the trapping engine contains an
algorithm that tries to ignore these gaps automatically.

When you enter a value (in mm, cm or inches), the algorithm will try to ignore gaps having a
width smaller than the value you entered. However, this gives no guarantee that all small gaps
will be ignored.

The gap range is 0.0mm (meaning the algorithm is not used) to 0.1mm. The default value is
0.005mm.

Note:  If you set the distance too high, the scanning process will become slower, and small parts
of the job may be removed.

Restrictions: In some special cases the trapping software can safely ignore certain object types.
This knowledge can substantially speed up the trapping. The following object types can be ignored:

• Patterns: Ignores native fill and stroke patterns. Prior to trapping, fill patterns are converted to
contours. Fine patterns may result in a huge number of contours. In some cases this can cause
memory shortage and/or long trapping times.

• Bitmaps: Ignores bitmap pixel data. This type of data is contourized before trapping, which may
slow down the trapping action depending on the contents of the bitmap(s). Bitmaps (LPs) with
lots of small isolated islands will typically take a longer time to trap.
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• Overprinting Native Blends: This option is only used in a DeskPack workflow. Certain native
Adobe Illustrator blends cause performance issues, since they have little or no actual effect on
the trapping process you may ignore them.

• External Objects: Ignores references to external Normalized PDF, legacy GRS, LC, and LP files. If
this toggle is off then the external references are degraded to internal objects prior to trapping. By
default external references are not trapped because in some cases, when the input job contains
many references to external files, this can cause memory shortage and/or long trapping times.

• Existing Trap Layers: Ignores any existing trap layers contained in the job. This option is useful
to re-trap a job that was already trapped (with different trapping parameters).

Note:  When you indicate an object type to ignore, it will be ignored completely as if it did NOT exist
in the job. Also, the objects that are ignored will NOT truncate trapping areas resulting from other
objects. Use these options with care and only to speed up the trapping of specific types of jobs.

• Don't trap text smaller than x points

Small type must be kept as sharp as possible. Trapping may blur the sharp edges of small
characters making them harder to read.

The Trapping engine has an option to prevent trapping of text below a specific point size (1 point
equals 1/72 of an inch). Edges of text characters below the given point size will not be selected
for trapping.

This option only affects the trapping of native text objects not that of contourized text (the default
value 0 points, meaning trap all text).

Allow Different Settings for One Color Pair: The trap expert can generate a different trap action
for different hits of the same color pair.

Select Yes to allow different settings for the different hits of one color pair. This is the default value.

Select No to force the trap expert to apply one identical action to all the hits of the same color pair.

Select Only for objects bigger than to force the trap expert to apply one identical action to the hits
of one color pair belonging to small objects, and to allow different settings for the hits belonging to
the bigger objects.

Use the size parameter to select the size of small objects.

Rules Tab
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The rules tab allows users modify the default trap distance and shape settings and to specify one or
more custom trap color pair rules. Custom rules allow users to forbid specific types of trapping or
to specify a different set of trap settings (distance and shape) depending on the type of the abutting
colors of the trap pairs.

Note:  Custom trap color pair rules are an advanced feature that should only be used when trapping
with the general settings does not give you the desired result.

How do Trap Color Pair Rules Work?

While scanning the job, the selected trap expert builds an internal list of abutting color pairs that are
suitable candidates for trapping.

Each of these color pairs has an associated set of trap parameters like the trap distance (width of
the trap area) and other parameters controlling the shape of the trap.

By default a single set of default parameters ('General Settings') is associated with each of the color
pairs. If the general settings are not appropriate for a specific type of color pair (for example CT to line
work trapping), a rule can be added to specify a different set of parameters for this type of color pair.

For example a rule can be created to trap spot colors into spot colors with a specific distance different
from the default.

In that case only the pairs of colors containing PANTONE inks will be trapped with that distance. All
other color pairs will be trapped with the default distance specified in the default settings.

Modifying General Settings

Select the default settings in the rule list by clicking on 'General Settings' and press the modify
button. The modify panel will appear:
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Action Group

This panel allows you to specify the actions that will be performed for each color pair (trap and/or
pullback) and the settings that will be used to create the trap area (distance, color and shape).

The radio buttons in this group specify the action performed on each candidate trap color pair. Two
actions are possible: Trap and Ink Pullback:

• A thin trap area will be created between the abutting colors where the colors will overprint each
other. Traps are also known as Frames or Grips.

Options:

• Force: Force a trap area for each color pair.
• No: Forbid creation of trap areas for each color pair.
• Trap Expert: The selected trap expert automatically decides for each of the color pairs if they

are to be trapped or not. (default).

• Ink Pullback is an action that keeps away all but the darkest inks of a color area composed of
multiple inks that borders to a very light background. This action prevents that individual inks from
the composed color will become visible on the background due to registration errors during the
printing process. Ink pullback is also known as Cutbacks or Keepaways.

Object with 100%C,100%K on an empty background. 100%C is pulled back, a fine line of 100%K
remains:
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Options:

• Force: Force a pullback area for each color pair where this is possible. At least one of the two
colors should be composed of multiple inks.

• No: Forbid creation of pullback areas for each color pair.
• Trap Expert: The selected trap expert automatically decides for each of the color pairs they

are to be pulled back or not. (default).
• Reverse prevents overprint of abutting color areas with different inks by selecting these color

pairs to be trapped with a white knockout (erasing) trap.

Options:

• Force: Force a Reverse area for each color pair where this is possible.
• No
• Trap Expert: The selected trap expert automatically decides for each of the color pairs (default).

Settings Group

• Trap Distance: Specifies the width of the trap area in millimeters or inch.
• Pullback Distance: Specifies the width of the pullback area in millimeters or inch. If a color pair is

both trapped and pulled-back, this distance will be used.
• Trap Color Opacity: Instead of spreading the full color, the trap color can be reduced to a

percentage of the original color. This options can be used to create a lighter trap color. (default
100%, spread full color)

Shape
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• TruncateThe trap area is truncated to avoid that it exceeds the edge(s) of the color area under
which is trapped. There are two different truncation modes:

• On Edge:  The trapping area is truncated on the object edge, even if a larger distance
has been defined. This is to avoid that the trapping area of an object exceeds the edge of the
object under which is trapped. This is the default truncation mode. (default)

• On Center:  The system recalculates the trapping distance for the areas where a trapping
area comes too close to the contour of an object. In that case, the trapping area stops halfway
the object. In all the other areas, the complete trapping distance is applied.

• End Caps This option specifies how the ends of an open trap area are constructed.

• Perpendicular:  When this mode is selected, the trapping areas are placed at right angles
relative to the boundaries of the abutting color areas.

• Object Dependent:  When this mode is selected the trapping areas are a logical
continuation of the contour of the object that is spread. (default)

• Round:  When this mode is selected the trapping areas are ended with circular arcs. This
mode is typically used in combination with white knockout or ink pullback.

Corners This option allows you to change the way sharp corners in the trap areas will be handled.
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• Mitered:  If the distance from the base of the trap to the corner point is larger than the miter
ratio multiplied by the trap distance then the corner will be beveled otherwise it will remain sharp.
See also miter ratio option. (default)

• Round:  A round cap will be placed at all corners.

• Beveled: 

Miter Ratio  Determines when a sharp corner is beveled. If the Distance from the base of the
trap to the corner point is larger than the miter ratio multiplied by the trap distance then the corner
will be beveled otherwise it will remain sharp. This option is only available when mitered corners are
selected (default value 4).

Adding a New Rule

To add a new rule, press the 'New' button on the 'Rules' tab. The 'New Rule' panel will appear:
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The top section of this panel defines the type of color pair for which this rule applies. A rule will only
'match' with color pairs that have the same type of trap and boundary color as specified in this color
pair template. The bottom section specifies the trapping actions associated with this type of color
pair and the parameters of the trap area.

Color Pair Group Contains a description (template) of the color pair. On the left is the description of
the trap color and on the right is the description of the color that is being trapped into (the boundary
color).

Both color templates are composed of the same fields:

Color Type

• Any Color: Matches to any color (wildcard).
• Process Ink: Any color containing at least one process ink (CMYK).
• Spot Ink: Any color containing at least one PANTONE ink or at least one designer ink.
• Image: Any contone Image.
• Vignette: Matches to any vignette color
• Empty Background: The empty background. Can be used on the left side to match with color

pairs for which ink pullback will be performed.
• Registration Color: The color that is composed of all inks used in the job used at 100%.
• Opaque Ink: Any color containing at least one opaque (metallic) ink.

Ink Name When the color type is Process or Spot, an optional ink name may be specified. In that
case the color template will only match with colors containing the ink with that specific name (default
'Any').

Densities When the color type is Process, PANTONE, Designer or Opaque, additional constraints
on the densities of the specified ink (type) may be imposed.
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Minimum Density: the color template will only match with colors that contain at least the given
percentage of the specified ink.

Density of other inks must be 0%: If this toggle is on, the color template will only match with colors
that do not contain any other (type of) inks than the one specified. If the toggle is off, the template
will also match to colors containing other inks. (default off)

The Action and Settings groups are the same as those in the 'Modify Rule' panel. Here you can
specify which actions to take for the specified type of trap color pair and what parameters to use
to create the trap areas.

Finally press OK to add the new rule to the list of rules in the rules tab. Under the rules list a textual
summary is give of the settings associated with the selected rule. Differences with the default settings
are indicated with blue text.

Rule Priority

Rules have a priority associated with their position in the rules list. The system always evaluates the
list of rules in a bottom-up fashion. The system first tries to match each color pair to the last rule
in the list. If this rule’s color pair template matches the color pair, then the evaluation stops and the
settings associated with the rule are used for the color pair. If the rule does not match then the next
rule (the one above the last one in the list) is tested.

This process continues until a match is found or the top of the list is reached. If no matching rule
was found, the default settings are applied to the color pair. The “Default Settings” are always at
the top of the list and contain the parameters associated with all color pairs that do not match to
a more specific rule.

For the list above the color pairs will first be tested for a match with the rule 'Process Ink >PANTONE
reflex blue CVC', then with the broader rule 'Process Ink >PANTONE Ink' then with 'Any Color
>Image', until a match is found. If no match is found the default settings are applied to the color pair.

• Move Up / Down buttons:These buttons can be used to change the position and the associated
priority of the selected rule in the list. The 'General Settings' cannot be moved. They always
remain at the top of the list.

• Remove button: This button removes (deletes) the selected rule from the list of rules. The 'General
Settings' cannot be removed. They always remain at the top of the list.
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When to Use Rules?

Trap color pair rules are an advanced feature of the Trapping technology, intended for experienced
users. The Trapping engine will deliver high quality trapping results for most jobs without any
customized rules if suitable default settings are selected.

There are cases, however, in which the automatic algorithm based on the relative darkness of
the colors to be trapped is not perfect. In other cases a single set of trap parameters (distance,
shape, color) independent of the type of trap colors may be too restrictive. Customized rules offer
a mechanism to specify exceptions.

Below a number of typical examples (use cases) are given to demonstrate the use of color pair rules.

1. Different widths for different types of traps. Depending on the type of the abutting colors a different
trap distance may be required. Sometimes larger trap distances are used for spot inks since there
are usually no other inks to help cover leaks on the press. Process tints typically only need a
very small trap. A larger distance may be required when trapping into a dark color (for example
containing 100% black).

To set a specific distance when trapping a CT into another color, add a new rule: 'CT' > 'Any
Color' with the required trap distance. If colors trapping into a CT should also be of this distance
then a second rule 'Any Color' > 'CT' should be added.

2. Prevent Trapping or Ink Pullback in specific cases. Depending on the type of the abutting colors,
trapping and/or pullback of ink may be undesirable. In such cases a rule may be created with the
'Trap' and/or 'Pullback' action set to 'No'.

To allow ink pullback only on colors containing 100%K: Set 'Pullback' to 'No' in the 'General
Settings' and add a rule 'Empty Background' > '100% Process Black' with 'Pullback' set to 'Trap
Expert'. This rule will allow ink pullback on composite colors containing 100% process black but
forbid pullback on any other composite color.

3. Force a specific Trap direction.The trapping engine determines the trap direction based on the
relative lightness of the abutting colors. If the colors are of (almost) equal lightness, then the
algorithm selects an arbitrary direction. In some cases this direction can be selected with a rule.

By default the color 100%C is trapped into the color 100%M. To change the trap direction, add a
new rule '100%M' ® '100%C' and set the trapping action to 'Yes'. This will force the pair to trap
in the specified direction. Activate the toggles: 'Other Inks must be 0%' to prevent other color
pairs containing cyan and magenta from being affected by this rule.

4. Specify a different Shape and/or Truncation mode for certain color pairs.

Only apply 'On Center' truncation when trapping under a 100% black key line and 'On Edge'
truncation on all other color pairs. Use round corners on some types of traps and mitered corners
on others.

Output
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Include Original File

By default the trapping engine generates a copy of the original GRS job containing one additional
layer which contains all the trapping areas. When this option is off, the resulting GRS will only contain
the new layer with trapping areas. This layer can later be placed on top of the original job later using
the Place option in the LineWork editor. This allows you to add objects that don’t need trapping (for
example bar codes and registration marks) in the original job and add the trapping layer as a final
step. (default: On)

Only Use PostScript Compatible Features to Create Trap Areas

By default the trapping engine uses proprietary paint operators (BG Overprint and in some cases
Reverse Overprint) to obtain the correct colors in the trap areas. Use of these special overprint
operators gives the best results in an Esko workflow (for example output using an Esko RIP). However,
this default output model is less suited when the trapped job should finally be output on a PostScript
device or as a PDF file. In that case it is best to activate this option to prevent long conversion times
when exporting the trapped file to PostScript or PDF.

Note:  Trapping times may be longer when this option is active. In some areas where multiple traps
overlap each other, the resulting color may be undesirable. Therefore it is advised to use this option
in combination with Centerline truncation (as it prevents overlap of trap areas).

Trap - Prepare Trap Pairs (Deprecated)

Note:

This task is deprecated. Read more in Deprecated Tasks in Automation Engine 12.1 on page 527

This task scans the file and suggests a list of candidate trap color pairs.

The 'suggest' task has the same options as the Trap task except that it has no output options. The
output of this task is a trap color pair information file. This file contains all information gathered by the
automatic trap expert during the scan phase. This file has the same name as the input job and has the
extension '.tcp'. It is placed in the same folder as the input file. The settings associated with the color
pairs in the TCP file can be edited in the LineWork editor. Jobs that have been scanned by this task
(and as a consequence have an associated TCP file) can be submitted to the 'Create trap layer' task.

2.8 The Automation Engine Viewer

2.8.1 Introduction

What is the Automation Engine Viewer?

The Automation Engine Viewer is a comprehensive, powerful and integrated Viewer and QA tool. It
can easily be integrated in your Automation Engine workflow, to view, check and compare graphic
production data. It can be launched directly from within the Automation Engine Pilot, on any Mac or
Windows computer in your network. Anywhere you can install and log on to an Automation Engine
Pilot you can start the Automation Engine Viewer (DTP, prepress, QA department, CSR desk...).
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You can use as many Automation Engine Viewers as you have Pilot connections. Opening the
Automation Engine Viewer does not allocate an extra Pilot connection. It is even possible to have two
or more Automation Engine Viewers on one workstation by opening a second Automation Engine
Pilot (Pilot - File menu - New window) and opening a file in the Automation Engine Viewer from there.
If you also use the Esko Bitmap Viewer, you will notice that the interface and shortcuts are nearly
identical.

The Viewer offers you

• Reliability: Showing the data in a correct way. At best in the same way the RIP / Proofer will see
them.

• Detail: Unlimited zoom, high detail measuring, measuring traps and exact distances (die objects).
• Speed: Opening files swiftly, even when it concerns large files. Fast zooming.

Supporting many file formats, Comparing and more

The Viewer supports many different file types: PDF, AI, ArtPro, images and even bitmap RIP data.
For a full list, see Supported File Types on page 580.

You can even compare with other files, even when they are a different file type and even when they
have a different size! Learn more in Comparing Files on page 81.

Basic use

To open files in the Viewer,

• click the word View next to your file.

• right-click your file and select View...

• select your file and go to  File > View .

Here 's a first look at the Viewer:
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You can zoom in on the file, measure distances and densities, view separations individually or
together, etc.

Note:  The Viewer has its own local On Line Help. Start it from the question mark icon in the top bar.

The concept of Prepared View Data

Reliability is a must. Detail can also not be compromised, it is always offered. The challenge lies in
opening very large files quickly. That is why the Automation Engine Viewer offers 2 view modes: with
or without Prepared View Data.

• In case you do not prepare View Data, the server will stream the data to the Automation Engine
Viewer. When a large file has to be opened or compared or when the server is very busy, a delay
can be noticed. Deep zoom detail mode is immediately available.

• In case you do opt to prepare View Data in advance, then the Viewer will show you the prepared
View Data instantly. Zooming in will of course require object data streaming from the server, but
then for a smaller area. For more information about creating View Data, see the task Prepare for
Viewer on page 415 in the Reference Guide.

Attention:  If the User Access Right for deep zoom is not enabled (read more in Defining
User Access Rights on page 33), then

• you can only view 'prepared' files.
• your zoom is restricted.

2.8.2 Supported File Types

The Automation Engine Viewer supports the following file types:

Graphic files, both with and without prepared View Data
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Esko normalized data:

• Esko PDF

• Esko PDFPLA

• Legacy Esko GRS

• PLA

• Legacy Esko STA

• EPF (DeskPack)

Non-normalized graphic files:

• PDF
• PostScript
• EPS
• ArtPro
• AI (Adobe Illustrator)
• For Adobe Illustrator ‘EPS’ file types, the

same restrictions are valid as in PackEdge.

Images, both with and without prepared View Data

• Esko CT

• Image EPS

• DCS/EPS
• PSD
• TIF (< 600 ppi)
• JFIF
• LP

Post-RIP data only with prepared View Data

• LEN
• TIF (> 600 ppi)
• DCS 2.0 (> 600 ppi)

Note:

When opening files that are not yet normalized, the Viewer needs to read in the data. This is equal
to a normalization step.

The Viewer Settings in Configure make it possible to indicate which Normalization ticket is preferred
to execute this hidden normalization (see Viewer on page 685).

If you use View Data, the Prepare for Automation Engine Viewer task will include a normalization step.

If you do not use View Data, the file will be normalized right after choosing ‘Open’.

Tip:  If you want to compare an Esko normalized file with its original non-normalized design, you can
set up a workflow where you always keep the first file version after the normalization - before starting
to edit - and compare that file with the resulting edited version.

2.8.3 Viewer Statuses in the Files View

The View column can display a number of different statuses. Select a file to find out its status.
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1. A dash (-) indicates that the file is not viewable, for example text, Word documents, paf files... File
extensions are taken into account to decide whether or not a file is viewable.

2.  'View' indicates that the file could be viewable. It is possible based on the file extension, but
no view files have been generated as the calculation could provoke a performance slowdown.

3.  'View (Prepared)' indicates that the file can be viewed as prepared view data has
been generated, either by launching a file with the Prepare for Viewer task (see Prepare for
Viewer on page 415), or by copying or moving files in a folder that is marked as Speed up for
Viewing. Up-to-date view files are available.

4.  'View' indicates that the file can be viewed. However, there are no view files available, and
they will be calculated on the fly if you want to view.

5.  'View (Prepared)' indicates that the file could be viewed, but viewing is disabled
because the view files are out of sync with the original file.

Digital Film Files

For digital film files, the situation is slightly different.

A) For .len files, it is mandatory that view files are prepared so as to be able to view.

1.  'View (Prepared)' indicates that the files have up-to-date view files and can be
viewed.

2. - (Need View Data) indicates that for the selected .len file no view data has been generated and
it cannot be viewed.

3.  indicates that the .len files have view data, but that the view data is not in sync with
the original file and can therefore not be viewed.

B) For .tif files, behavior depends on the resolution of the file.

A TIFF with low resolution (<600 ppi) can be viewed without having view files.

A TIFF file with a high resolution (>600 ppi) must have up-to-date view files to be able to view it.

2.8.4 The Viewer Window

The Viewer comes with a number of powerful tools that make it easy to navigate, view and compare
files.
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1. The View Selector on page 587
2. The Toolbar on page 591
3. The Top Tools Panel on page 591
4. The Navigator Panel on page 596
5. The View Panel on page 596
6. The Channels Panel on page 606
7. The Info Panel on page 607

Note:  Some tools have an arrow in their lower-right corner. Right-click those tools to show more
options.

Customizing the Viewer Window

You can hide some of the Viewer’s tools to get a bigger viewing area, and show them again when
you need them.
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•
Click  in the toolbar to hide or show The Top Tools Panel on page 591.

•
Click  on the right to hide or show the side panels (Tools, Navigator, View, Channels...).

Viewing Differences in the Separations

In case you compare files that have different separations, then all differences will be shown in both
common and unique separations.

When the compare tool is activated, the Channels group will display an additional number of icons.

Move over the icon with the cursor and the tool tip will indicate what it stands for.

Right-click the following icons   to get additional options that allow you to change view modes,
highlight colors and difference levels.

In the example below, only the difference is shown.
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Comparing Files of Different Sizes

Comparing files with different sizes may seem like a challenge as they are not aligned in the Viewer,
but the Viewer has some tools that make it very easy.

You can align both files by:

• Rotating one file (by 90 degrees)
• Mirroring one file
• Inverting one file
• Aligning both files on one corner
• Aligning with the help of a ruler (see Align from Ruler on page 586, Auto Align from Ruler on

page 587 and Auto Align on page 587)

Note:  You can find the ruler tools under the alignment button.
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• Indicating the offset manually (typing in the fields)

Align from Ruler

The ruler tool works by defining two points (one in each file) that have to be aligned.

Tip:  Click the Align from Ruler tool to show additional information.

1.
Select the reference version of the file by clicking the  icon.

2.
Click the alignment icon  and select Align From Ruler in the list.

3. Indicate the ruler anchor point.

4.
Switch to the other version by clicking the  icon (or use Ctrl + S).

The anchor point, here in the red circle, will be in a different location in the second file version.

5. Indicate the point that should be positioned on the ruler anchor point (here in the blue circle).
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6. Click the Align From Ruler tool again. The files are now aligned.

Note:  Depending on how precisely you defined the second ruler point, you may have to zoom in
and repeat the alignment procedure to align your files with more precision.

Auto Align from Ruler

Auto Align from Ruler is used the same way as the Align from Ruler tool, but is more accurate at
high resolution.

If the details of the alignment points match, the viewer will be able to increase the alignment precision
(and have a good alignment with fewer iterations).

Auto Align

Auto Align does not use the ruler, but rather the currently visible view of the two compared images
to attempt an automatic alignment.

Using this tool repeatedly with one or more zoom-ins can be a very convenient and quick way to
align two images.

For convenience, a separate tool button  is available to perform an Auto Align operation without
having to open the Alignment pop-up menu. Clicking this button will perform an Auto Align from
Ruler if a ruler selection is active, otherwise an Auto Align (from view).

The View Selector

The View Selector allows you to go through both:

• the recently viewed files,
• the pages of a (recently or currently viewed) multi page file.
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Select the file or page you want to view in the list, or use the arrows.

Page Lists

When opening a multi-page document, the Viewer offers a special preview and navigation panel
called the Page list panel. The Page list panel occupies the left part of the Viewer window.

The Page list panel can be shown (or hidden) by clicking the  button in the top right part of the
file selection bar. This button is not visible if only single page documents are opened in the viewer.

The major part of the Page list panel is occupied by the page list thumbnail view. This view shows
thumbnails of the all the pages in the current multi-page document paired two and two according
to the file’s binding definition.

The size of the thumbnails can be changed by right-clicking the Page list view button in the file
selection bar.

You can switch the main view to a specific page by clicking the corresponding page thumbnail.

Below the thumbnail view is a navigation bar that applies only to the currently selected multi-page
document.
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Reader Spreads

You can use the Reader spread button  in the file selection bar, to show your file in reader spread
view (pages side-by-side). The reader spread view shows pairs of pages as they will appear in the
final document.

The pages are assembled by stitching two pages together on the pages' trim-boxes. If one of the
two pages is missing (if the active page is the first or the last), the active page will be shown with
an empty (white) area next to it.

Note:  In reader spread view, clicking  displays the previous / next reader spread (set of
two pages).

There is a single active page in reader spread view. You can see which of the two pages is active in

the Page list panel, or by turning on the page margins  in the View panel.

You can choose to show the trim boxes of the two page margins in different colors, or to only show
the trim box of the active page.

You can also clip the reader spread on its trim box.
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Note:  The document comparison is disabled while reader spread view is active. If document
comparison is turned on, reader spread view is automatically turned off and visa versa.

Comparing Mutipage Documents

When comparing two multi-page documents, the view will present an option panel where you decide
which pages to compare to which.

Printing Multipage Documents

When viewing a multipage document, you can also choose to print all pages.
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The Toolbar

The toolbar contains:

• a progress bar,
• multi page options (when viewing a multi page file). See Viewing Multipage Files on page 611.

• a Compare tool that allows you to compare two files. See Comparing Files using the Viewer on
page 608.

• an Information button that opens the Info dialog box (containing XMP metadata). See File
Information (XMP metadata).

• a Print button that opens the Print options dialog box. See Print.

• a Help button that opens the Viewer online help.

• a Close button that closes the file being viewed (but not the Viewer).

Note:  The Viewer documentation included in Automation Engine only highlights the most important
tools and options. Please refer to the online Viewer documentation for more elaborate information.

The Top Tools Panel

The top tools panel contains some of the Viewer's most used tools. You can customize which tools
you see by right-clicking it and selecting or deselecting some tools.

You can show or hide it by clicking  (see Customizing the Viewer Window on page 583). Hiding
the top tools panel shows the Tools Panel on the right (containing the Inspect and Measure tools),
and vice-versa.

Note:  You can select a tool here even when it is not currently available in the Viewer (for example,
Page list when viewing a single page file). This tool will then automatically appear in the top tools
panel the next time it can be used (for example, when viewing a multi-page file).

The top tools panel can have the following tools:

Page List Tools

•
 Reader Spread view (only when viewing a multi-page file, see Viewing Multipage Files on

page 611).

•
  Arrows to navigate between pages or spreads (only when viewing a multi-page file).

•
 Mark tool to mark a certain page.

Inspect Tools

•
 Zoom tool
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•
 Zoom out tool

•
 Pan tool

See The Tools Panel on page 592 for more information.

Measure Tools

•
 Ruler tool

•
 Measure color percentages tool (densitometer)

See The Ruler on page 593 and The Densitometer on page 594 for more information.

Compare Tools

You can only see the Compare tools when you have two print jobs open to compare (see Comparing
Files in the Viewer).

•
 View current version

•
 View reference version

•
 View both - highlight difference

•
 View both - blinking

•
 View both

•
 View both - side by side

See Comparison Modes for more information.

View Tools

•
 Rotate view tool

•
 Mirror view tool

See The View Panel on page 596 for more information.

The Tools Panel

The Tools panel holds the most frequently used tools.

The Tools panel contains the following tools:

•
 the Zoom tool, that guarantees indefinite zoom.
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Click the tool or use Ctrl + to zoom in.

Use Ctrl - to zoom out.

•
: The Pan tool, that allows you to pan through your file,

•
: The Ruler tool (see The Ruler on page 593),

•
: The Densitometer tool (see The Densitometer on page 594),

•
: The Screen ruling and angle tool.

Note:  The Viewer documentation included in Automation Engine only highlights the most important
tools and options. Please refer to the online Viewer documentation for more elaborate information.

The Ruler

The Ruler tool calculates the distance between any two points in the work area.

When you measure from one point to another, a non-printing line is drawn and you can see the
following information (in a pop-up and in the Info panel):

• The starting location (X and Y).
• The horizontal (W) and vertical (H) distances traveled from the x- and y-axes.
• The angle measured relative to the axis (A).
• The total distance traveled (D).

To measure between two points:

1. Select the Ruler tool.
2. Drag from the starting point to the ending point.

Tip:  Hold down the Shift key to constrain the tool to multiples of 45°.

You can also:

• Right-click the measure icon to set some extra options, like, for example, showing or hiding units,
changing the ruler angle, or the display color...
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• Click the unit in the Size line of the Info panel to switch between points, millimeters, centimeters
and inches.

Tip:  The Ruler tool can be combined with different view tools. You can for example indicate a certain
point, then change the view by zooming out, navigating, or turning back to a previous view, and then
indicate the second measuring point.

The Densitometer

Click in your file with the densitometer tool to measure a certain point, or drag it to measure an area.

The densities are shown in the Channels panel, and the location measured in the Info panel.
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By default, the densities are also shown in a pop-up near the location you measured.

Right-click the densitometer tool to hide or show this pop-up.

Calculate Screen Ruling and Angle

Note:  You can only use this tool when working with digital film (RIP’ed files).

1. Select the screen ruling tool.

2. To select the area in which to measure the screen:

• click a point in the image,
• hold down your mouse and drag across an area (to make a more precise selection),
• make a selection and double-click the tool,
• double-click the tool to make a measurement based on the current view.

The Channels panel displays the screen rulings:



2
Automation Engine

596

3. To show a channel’s screen angle (in the measured area), click its screen ruling value in the
Channel panel.

4. To change the screen angle orientation, right-click the screen ruling tool button and choose either:

• Screen Orientation from XMP (used by default),
• Screen Orientation CW,
• Screen Orientation CCW.

The Navigator Panel

In the Navigator panel you can see the part of your file you zoomed in on, and reposition the zoom
if necessary.

The View Panel

The View panel contains the following tools, divided over three lines:
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First line:

•  Previous view: Go to the previous view. Hold the Shift key to go to the first view.

•  Next view: Go to the next view. Hold the Shift key to go to the last view.

•
 Rotate view: Rotates the current view by 90 degrees clockwise.

•
 Mirror view: Mirrors the current view.

•
 Invert view: Inverts the current view.

Note:  The Viewer documentation included in Automation Engine only highlights the most important
tools and options. Please refer to the online Viewer documentation for more elaborate information.

Second line:

•
 Background Color: Changes the image’s or the window’s background color (see Background

Color on page 597).

•
 Show margins (trim box): Displays your file’s trim box (see Show Margins on page 599).

•
 View from back: Mirrors the current view and the sequence of the channels will be reversed.

•
 Set overprint highlight color: Highlights the overprints in the color of your choice (see

Overprint Highlight on page 600).

•
 Seamless view: Allows you to see several one-ups of your file without any space in between

(see Seamless View on page 601).

Third line:

•
 Total Area Coverage: Shows the sum of all separation-densities at a certain point in your

document.

•
 Flexo Plate: Shows a single separation (by default the first in the list) as a simulated flexo

plate.

•
Flexo Print: Shows the effect of highlight dot gain on the image.

•
 Break Out: Shows an area where the percentage of a single separation is lower than the

First Visible Dot value. This can be used to track areas that won’t show up on print because the
values are too low.

•
Registration Error: Shows a simulation of a design printed with registration errors of a

specific press (as defined in the Press Settings).

Background Color

To change the window and/or image background color:

1. Either:

• Click the Background color tool then the appropriate icon in the Select Background Color
group that appears.
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• Right click the Background color tool then select one of the options from the context menu.

2. In the Select Background Color dialog that opens, select either a color swatch, or an HSB or
RGB value.

In the example below, the window color was set to black.

The image background was set to light grey, and whereas white is shown as light grey, all separation
measurements remain unchanged!
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Show Margins

When the trim box is set correctly, you can easily check the correct die settings and possibly predict
a problem in the later repeat layout.
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Overprint Highlight

Click the Set overprint highlight color button to get a clear indication of all areas with any form of
overprint of 2 or more separations.

Click the color patch to select the highlight color of your choice.
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Seamless View

• Click the Seamless view button to see a multi-up layout of the open file.

By default, the seamless repetition will be made around the trim-box.

If the trim-box is not defined (in the XMP metadata), it will be made around the image’s boundaries.
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• If necessary, you can adjust the seamless guides:

a)
click the seamless crop tool  to select the one-up’s trim box (or the image’s aboundary if
no trim box is defined),

b) drag the trim box sides or corners to resize the area that is repeated.

Seamless with Overlap

By default, the seamless repetition will be made by clipping the image at the trim-box, and repeat
the clipped part.

Sometimes however, the design to be checked is created to have a non-rectangular clipping.

To check such designs, the Overlap button  can often be helpful.

When turned on, the viewer will overlap the repeated areas rather than tiling them at the trim-box.
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Total Area Coverage

The Total Area Coverage (TAC) is the sum of all separation-densities at a certain point in your
document.

TAC Level Limit

The TAC Level limit is the maximal Total Area Coverage that your document may contain. This value
depends on the press and the substrate your design will be printed on. Your printer should provide
you with the TAC Limit value to use.

Defining the TAC Limit

The TAC limit is defined in the Press settings. By default the TAC Limit is set to 270%.

To quickly see the maximum TAC in your document, use the TAC Limit slider.

Move the slider to the right to use a TAC Limit value higher than that used by your current Press
Setting. The more you move the slider to the right, the less pixels will typically be over the TAC Limit.
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Flexo Plate

If you change the Viewer Preview mode to Flexo Plate, a single separation (by default the first in
the list) will be shown as a simulated flexo plate.

In this Preview mode, only one separation can be viewed at a time.

Note:

Viewer uses the same technology as the Esko Flexo Tools for Photoshop.

First Visible Dot

The Flexo Plate preview will use the First Visible Dot percentage from the press settings:

• Pixels with a percentage lower than the First Visible Dot percentage will be shown as areas without
dots.

• Pixels with a percentage equal or higher than the First Visible Dot percentage will be shown as
areas with dots.

Plate Color

This preview predicts how clean your flexo plates will be. Especially in very light or very dark areas,
you could end up with isolated dots or holes on the flexo plate, and those areas are difficult to hold
on the plate or the substrate.

You can choose the plate color (Cyrel Red, Blue, Green or Safran Yellow, or a High Contrast
Blue&White) to match the type of plate you are using.

Flexo Print

This Viewer preview mode shows the effect of highlight dot gain on the image.

This effect is equivalent to a curve adjustment. To determine this curve, the Flexo Print Preview will
use the First dot and the Dot gain in highlights settings from the Press Settings.
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Going from light to dark:

• The Print Preview layer will display percentages below the First visible dot percentage as 0%.

• The First visible dot percentage will be shown using the First Dot Prints as percentage.

• Percentages above the First visible dot percentage will be shown darker.

• Towards the midtones this darkening effect will fade out until the Range value.

• Percentages above than the Range value are displayed unchanged.

Break Out

A Breakout is an area where the percentage of a single separation is lower than the First Visible Dot
value. This can be used to track areas that won’t show up on print because the values are too low.

Your printer should provide you with the First visible Dot value. The First visible dot is set in the Press
Settings. When switching to Breakout mode, the preview will be dimmed and all areas where a single
separation has a value lower than the First Visible Dot value (but higher than 0%), will be displayed
in highlight color.

You can measure the actual percentages in that specific area using the densitometer.

Registration error

The Registration Error Preview is a simulation of a design printed with registration errors of a specific
press (defined in the Press Settings, see ). It can be very helpful to see if trapping is applied sufficiently
and correctly.
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The Registration Error value is taken from the Press Setting you selected. The separations are
randomly shifted. In fact, all separations are moved exactly the distance of the Registration Error,
but all under a random angle.

If you want to see another random registration error simulation, click the Simulate Again button.

In the example above, you can see a small area of a job in regular preview (left) and with registration
errors (right). In this case, you can clearly see no trapping was applied, so white lines appear at the
registration shifts.

The Channels Panel

The Channels panel shows the file’s channels and offers extensive separation viewing possibilities.

Click the View channels in separate windows button  to switch between a Composite view and
a tiled view of the individual separations. Right-click it to choose the kind of tiling to use (Automatic
tiling, Horizontal tiling or Vertical tiling).
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Click the separations' box to add or remove channels from the selection.

Tip:  Right-click a separation's box to see only this channel.

You can decide to show separations with the same ink name as one, or to split them. For example,
the K and K/1 Esko inks are shown as one by default.

Double-click a channel to show the Channel Colors dialog.

In this dialog, you can edit the channel’s display color definition: Select a new display color from the
list, or set new RGB values.

Tip:

This is useful, for example, if your print job will be printed on clear plastic and contains a white
separation. To see that separation better in the Viewer, you might want to display it as pink.

Note that this choice is not remembered the next time you open the Viewer.

Check the Opaque checkbox to make the selected separation opaque.

You can use the arrows at the bottom to change the order of separations that are shown in the list.

Note:  The Viewer documentation included in Automation Engine only highlights the most important
tools and options. Please refer to the online Viewer documentation for more elaborate information.

The Info Panel

The Info panel displays file information (dimensions, resolution), and viewing conditions
(magnification used, mouse position, readouts from the ruler selection when using the ruler...).

To change the current units, click on one of the small triangles and select the desired unit in the pop-
up window that opens. You can select units independently for sizes and resolutions.
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2.8.5 Working with the Viewer

Comparing Files using the Viewer

The Viewer is not only a powerful viewing tool, but also contains a strong comparison tool.

To compare two files, open one file in the Viewer, then click the Compare  button to open the
second file.

This enables you to have a close look at the differences between the two files. If needed, you can
see the differences per separation, including any changes in the images (internal or referenced).
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While comparing you can use other tools like for example View channels in separate windows, the
ruler, (de)select, rotate, etc...

Viewing Differences in the Separations

In case you compare files that have different separations, then all differences will be shown in both
common and unique separations.

When the compare tool is activated, the Channels group will display an additional number of icons.

Move over the icon with the cursor and the tool tip will indicate what it stands for.

Right-click the following icons   to get additional options that allow you to change view modes,
highlight colors and difference levels.
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In the example below, only the difference is shown.

Comparing Files of Different Sizes

Comparing files with different sizes may seem like a challenge as they are not aligned in the Viewer,
but the Viewer has some tools that make it very easy.

You can align both files by:
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• Rotating one file (by 90 degrees)
• Mirroring one file
• Inverting one file
• Aligning both files on one corner
• Aligning with the help of a ruler (see Align from Ruler on page 586, Auto Align from Ruler on

page 587 and Auto Align on page 587)

Note:  You can find the ruler tools under the alignment button.

• Indicating the offset manually (typing in the fields)

Viewing Multipage Files

Page Lists

When opening a multi-page document, the Viewer offers a special preview and navigation panel
called the Page list panel. The Page list panel occupies the left part of the Viewer window.
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The Page list panel can be shown (or hidden) by clicking the  button in the top right part of the
file selection bar. This button is not visible if only single page documents are opened in the viewer.

The major part of the Page list panel is occupied by the page list thumbnail view. This view shows
thumbnails of the all the pages in the current multi-page document paired two and two according
to the file’s binding definition.

The size of the thumbnails can be changed by right-clicking the Page list view button in the file
selection bar.

You can switch the main view to a specific page by clicking the corresponding page thumbnail.

Below the thumbnail view is a navigation bar that applies only to the currently selected multi-page
document.

Reader Spreads

You can use the Reader spread button  in the file selection bar, to show your file in reader spread
view (pages side-by-side). The reader spread view shows pairs of pages as they will appear in the
final document.
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The pages are assembled by stitching two pages together on the pages' trim-boxes. If one of the
two pages is missing (if the active page is the first or the last), the active page will be shown with
an empty (white) area next to it.

Note:  In reader spread view, clicking  displays the previous / next reader spread (set of
two pages).

There is a single active page in reader spread view. You can see which of the two pages is active in

the Page list panel, or by turning on the page margins  in the View panel.

You can choose to show the trim boxes of the two page margins in different colors, or to only show
the trim box of the active page.

You can also clip the reader spread on its trim box.

Note:  The document comparison is disabled while reader spread view is active. If document
comparison is turned on, reader spread view is automatically turned off and visa versa.
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Comparing Mutipage Documents

When comparing two multi-page documents, the view will present an option panel where you decide
which pages to compare to which.

Printing Multipage Documents

When viewing a multipage document, you can also choose to print all pages.

Compensating Distortion

What is Distortion?

Distortion is a technique used to pre-compensate graphics that are to be printed with a non-uniform
printing technology. Distortion is typically done in the ripping process, the last step before printing.

The Viewer uses the file’s XMP metadata to detect if the files are distorted in the vertical and/or
horizontal directions, and by how much.

The Compensate Distortion Tool

To make comparison of files with and without distortion, or files with different distortion values easier,
the Viewer offers a simple distortion compensation tool.

Note:  You should compensate the distortion before aligning the files for comparison.

Use the Compensate Distortion button  to activate or deactivate the distortion compensation
(this button is only shown if one of the open files is distorted).
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The tool tip of the Compensate Distortion button will show what the distortion of the current file is.

When the distortion is compensated, the resolutions and the size will be adjusted in the Info panel.

Managing View Data

You can create View Data using the Prepare for Viewer task. See Prepare for Viewer on page 415
for more information.

Should you decide to work with prepared View Data, keep in mind that Automation Engine creates
this View Data in a (hidden) .view folder next to the opened file.

The size of this view data depends on the size of your designs. By default an automatic resolution
is chosen. But you need to balance these 2 factors:

• the time that the server spends on creating the View Data
• versus the speed improvement that you notice when initially opening a file that has prepared View

Data (instant).

Danger:  Manually manipulating this data will surely create Viewer errors and is therefore strongly
dis-advised.

A mechanism is provided to delete the View Data:

• You can manually delete the (hidden) view data, by:

• right-clicking a file and choosing ‘Delete View Data’. This will remove the View Data for the
selected file only.

• right-clicking a folder and choosing ‘Delete View Data’. This will remove the View Data for all
files in the folder.

• When you remove or demote a Job (or Export / Archive it), the View Data is automatically deleted.
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2.9 The Tools

The Tools menu contains tools useful to administrate Automation Engine.

You can also find the most important tools under the Views, in the left pane of the Pilot. But this list
of tools does not contain all of the tools. For example the Configure tool is not shown there.

2.9.1 To Do List

The To Do List lists all actions that need user intervention. Among these actions are Messages,
Checkpoints, Red Alerts, Milestone Actions.

You can open the To Do List using one of the following methods:

• Go to  Tools > To Do List .
• In the left window, click on the To Do List view.
• In the Status bar, click on the To Do Icon.
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Use the To Do List to view, modify, forward and delete these actions, and all related files.

Checking To Dos

Actions

You can see a list of To Dos in the Actions panel. For each To Do, you can see:

• what the To Do is about (its Subject),

• which user it is assigned To,

• it's current State,

• if it is linked to a Job and to which,

• the Type of the To Do (Message, Checkpoint, Milestone Action...),

• the To Do's Due Date.

Tip:

• Initially, the entries in the To Do List are not sorted. You can sort them by clicking the appropriate
column heading.

You can also show / hide or reorganise columns by going to  View > Select Columns in 'To Do
List'...

• You can refresh the list using Ctrl + R or  Edit > Refresh .

Filter

You can filter the list of actions using the drop-down menu. The default filters are My Actions, All
Actions, Checkpoint Actions, Messages and Milestone Actions.

You can define a custom filter. See Defining a Custom Filter on page 618.

You can also type text in the input field to search on the Subject text or the name of the file(s) linked
to the To Do.

Details

Select a To Do in the Actions panel to show its Details below. They include extra information, like
where the Files linked to the To Do are located, and if the To Do includes a Message...
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Defining a Custom Filter

1.
Select <custom> in the filter drop-down menu and click .

This opens the Modify Filter dialog.
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2. Use the Operator tab to choose whose To Dos you want to see.

Select Filter on Operator and select the desired operators (you can also Select All).

3. Use the Due Date tab to filter on the To Dos' due dates.

Select Filter on Due Date and select either a range of due dates, or a time span from the current
date and time.

4. Use the State tab to filter on the To Dos' states.
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Select Filter on State and select the states (either Pending, In Progress or both) to show with
this filter.

5. Use the Type tab to filter on the To Dos' types.

Select Filter on Type and choose from the list (Wait for Action, Milestone Action, Message).

6. When you are done, click Save As... and give your new filter a name.

You can also Apply the filter straightaway.

Handling a To Do

To handle a To Do, select it in the To Do List and:

• To mark that you are handling it, select the I am currently handling this to do item in the Details
pane.

• To open a To Do's file in the Viewer, click View next to the file path in the Details pane.

• To open a To Do's file in the associated application, double-click it in the Details pane.
• To open the folder containing the file(s), click the folder icon  next to the file path in the Details

pane.
• To go to the job in the Files View (if the To Do concerns a job), go to  File > Go to Job  or use

Ctrl + Alt + O.
• To release the files of a Wait for Action To Do to one of the output states of the Wait for Action

(Checkpoint) task / workflow step, click  then the output state you want to release
the file to (by default Completed or Aborted).

See The Wait for Action (Checkpoint) Task on page 1003 for more information about the Wait for
Action (Checkpoint) task / workflow step.

•
To forward a To Do to another user, click  and select the user to forward the To Do to.

Note:  You can also change the Subject, Due Date, State and Message at this point if desired.

•
To delete a To Do, click .

Creating a To Do

You can only create Message To Dos from the To Do List.
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1.
Click  in the To Do List tool bar.

2. In the New Action dialog that opens:

a) Enter a Subject.
b) Choose who to assign the To Do To.
c) Link this To Do to a Job if needed.
d) Choose a Due Date.
e) Choose the To Do State.
f) Enter a Message if desired.

3. Click OK when you are done.

2.9.2 SmartNames

SmartNames are documented as a separate chapter in the Complete Manual. Find it here.

2.9.3 Explore

For data that cannot be accessed via the Pilot, you can use this shortcut to see your data directly on
the file server, through the client's OS. This means that when you are using a Windows Pilot client,
this tool will open a Windows Explorer to show your data. When you are using a Mac OS Client, this
'Explore' tool will show the data though the Mac OS file system browser, provided that the file server
has the right share mapping to that Mac OS client.

2.9.4 Task History

To keep your Tasks view manageable, you might have to clean the task lists. If you do not want to
keep some tasks, you can delete them. If you want to keep certain tasks or tickets for later use,
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you can add them to Task History. After choosing a task, you can click on  in the Tasks View
to move it to task history.

To view the history Choose  Tools > Task History . You can only view the tasks in the history after
clicking Apply. Alternatively you can press Enter in your keyboard to view the tasks in the history.

The Task History has a lot in common with the Tasks View. It lists all 'moved' tasks which you can
relaunch, view and save.

You can archive entries in the Task History (more on that in the section on How To Archive? on page
625) which you can restore later. You can make XML reports of the tasks and use them to bill your
customers.

The Task History has three parts:

1. Task History XML Report
2. Task History Search options
3. Task History List
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Task History Menus

File Menu

• Open Task: opens the ticket used for the selected task.

• Export XML Report...  Writes a report of the current selection. This XML report contains task
name, ticket name (whether or not the ticket was modified), the Operator, when it started, when
the tasked ended, Status, Priority, job folder...

• Archive... It is possible to archive the data in the database to an XML file. This allows you to put
the file on CD or store it somewhere else.

• Import Archive... Restores the data in the selected XML file in the database. A browse window
pops up, browse to the archive.XML and click OK. The archive will be restored.

• Restart History Server This will shut down the History Server and reboot it.

• Close Window [Ctrl + W] Closes the window. If only one window is left, this is disabled (use Exit,
to close the last window).

Edit Menu

• Select All [Ctrl+ A] Selects all entries in the table.

View Menu

• Columns: define which columns you want to see, for more information, please refer to the section
on Columns.

• Customize Current Filter: Please see filtering.

•  Manage Views [Ctrl + Shift + F] Here you can save the View Settings or select a previously
created view.

• Related Workflow Tasks: Some tasks are part of a workflow, use this function to get a list of
related tasks.

• Stop [Escape] This cancels the current database query and lets you set up a different
specification.

• Refresh [F5] Perform another database query with the current settings.

Task History Toolbar

•  Open Task: opens the selected task.
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•  XML Report... Writes a report of the current selection. This XML report contains task name,
ticket name (whether or not the ticket was modified), the Operator, when it started, when the
tasked ended, Status, Priority, Job folder...

•  Opens the Filter Settings dialog. Please see filtering.
•  Views: use the dropdown list to select 'Manage Views...' or an already defined view.

Filter

Filter Settings allow specific modification of the way the Tasks View is filtered. There are five tabs.

• Operator Define the filter according to the Operator. Tick the ones you want to monitor.
• State Define the filter according to the Status of the task. Just tick the ones you'd like to view.
• Task Type By default, the Tasks View will show all tasks launched, but you can modify the filter

in such a way that the Tasks View shows nothing but the type of tasks you are interested in.
• Date Define the Filter according to date and time.

• in a given time window (between [date and time] and [date and time])
• during the previous X hour(s)
• during the previous X day(s)
• during the previous X month(s)

• Advanced

The Advanced Filter settings allow for precise queries.

Hit 'New' to define a rule. The set up is easy. You define a rule that shows X containing a certain
string.

Task History List

The Task History list looks a lot like the Tasks View task list.
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The list lists all tasks that have been moved from the Tasks View to Task History. You define what
you want to see. You can define the number of columns (see View Menu > Columns), you can click
the head of a column to get the list to sort the way you like it, and you can filter the entries (see
View Menu > Filter).

How To Archive?

Archiving serves two purposes:

• The Task History is used to make the Tasks View quicker, more user-friendly. All tasks stored in
the Task History can be relaunched, it is a so called 'living archive'. As time goes by, you will end
up with a Task History containing a lot of tasks that you may never want to relaunch. You can
delete these tasks, but if you think that's not a good idea, you can use the Archive function. so
archiving can be a part of the Task History database maintenance.

• Archiving can be used to make a backup of the Task History data for safety reasons. You archive
your data frequently, not because you need the space, but because you want to store your XML
archive safely elsewhere, so you can easily restore it when problems should arise.

Archiving will store all information of certain tasks in an XML file. This adds the possibility of restoring
those XML archives into the Task History. So your information will never be lost.

Note:

Archiving only works on selected tasks.

Archiving doesn't delete the archived tasks from the Task History.

1. Select the tasks you want to archive.
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If you want to archive all tasks, press CTRL + A. If you want to make a sub selection, the Task
History reacts to the known shortcuts such as CTRL + click and SHIFT + click.

If you want to make an intelligent selection, and you don't want to lose time, you'd better use the

Filter . You define what you want to see in the Task History (for example all tasks originating
from one particular job, or handled by one particular operator, ...), click CTRL + A and you're
ready to archive.

2. Click Archive (File Menu > Archive).
3. A dialog pops up, allowing you to browse to the place where you want the archive XML to be

stored. Make sure to give the archive XML a meaningful name in order to avoid confusion later
on. Confusion might arise if you bear in mind that the Task History also uses the XML language
to write an XML report.

Click OK.
4. A 'Confirm' dialog pops up and asks you whether or not you want to delete the archived items:

2.9.5 View Cleanup Rules

The Cleanup Rules dialog offers a view only mode of the task cleanup rules that have already been
defined in the Configure Tool, in Task Cleanup Rules on page 682.
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Click the 'Details...' button to inspect the settings (viewing only).

2.9.6 Merger Monitor

If you use an Expose On ticket to expose on a device that has been configured to work with merge
queues, you can monitor the merging activities.

Start the Merger Monitor by selecting 'Merger Monitor' from the Tools Menu.

The Merger Monitor consists of two panels. The left-hand panel lists all devices  on which jobs
have been merged or are currently waiting to be merged. In the example above there's one device
listed example_merge. Every device on which something has been merged stays listed until the
server is rebooted.

Select a device to see what is in the merge queue. Jobs that are to be merged are assembled in pools.

A pool is a group of jobs with the same characteristics (same plate size, negative or positive, ...).
These characteristics are defined by the so-called extract restrictions. For example: jobs with a
different Dot Gain Compensation setting will not be merged together. They will not belong to the
same pool.

Some of these restrictions depend on the setting in the General tab of the ticket you use.

1. VDistortion and HDistortion: Jobs must have the same vertical and horizontal distortion before
they can be in the same pool.

2.
Reverse : Jobs have to be reversed in the same way before they can be in the same pool.

3.
Mirror : Jobs have to be mirrored in the same way before they can be in the same pool.

4. Dot Gain Compensation: Only jobs with the same Dot Gain Compensation belong in the same
pool.

The other restrictions are defined in the Output tab of the ticket you use.

1. Conf: Jobs need to have the same plate size before they can be in the same pool.
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2. Output path and Output File Name: Jobs with different Output paths or Output File names will
end up in different merge pools.

3. Resolution: Jobs need to have the same resolution before they can be in the same pool.
4. Compression: Jobs need to have the same compression before they can be in the same pool.

Notice that example_merge has two pools : 20051128–1 and 20060215–1. When you select the
device, but not a pool, you get an overview of all jobs waiting to be merged. In order to visually
indicate that jobs belong to different pools they have a different background color. White and gray
are used consecutively.

The right hand panel provides detailed information on jobs in the merge queue.

• The taskID
• Priority: this is the priority you defined in the Expose On ticket, not the priority of the task.
• The name of the Job
• The inks you are exposing, you defined them in the Expose On ticket.

Note:  There are two ways in which the inks are listed. C&M&Y&K or C+M+Y+K. They can be
merged on separate films or on the same film.

• The Page

• The Size HV (mm)

Note:  The symbols used to indicate the size tell you whether or not the job can be rotated in the
merger. <> (154<>191) indicate that the job can be rotated, an x (154x191) indicates that it cannot.

Rotation is an option you can set in the Transformations part of General tab of the ticket you
use to launch the task.

• Fill %: Jobsize/Platesize

These percentages are relative, the overall fill depends on the margins and gap as they are
currently defined in your ticket. You cannot simply add the percentages to get a correct idea of
the overall fill. There are all kinds of reasons why jobs cannot be merged together and why the
fill percentage is -as a result- not yet reached.

• The State of the job in the Merger queue

A job can be on hold  (it's an option you can choose in the 'Expose On ticket'). A job can be

released , but that does not mean that it will be merged, it still has to wait till the fill percentage

is reached. You can Force a job out  of the Merger queue. The forced out job will take as many
jobs possible, if they have a 'release status', with it.

2.9.7 Configure

Use the Configure tool to connect to a variety of devices and applications, and define general
Automation Engine settings.

To start Configure, go to  Tools > Configure  in the Pilot.
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To Define Settings in Configure

1. Select the settings category, or the device / application you want to connect to, in the left pane.
2. Go to File > New.
3. Define your settings.
4. Go to File > Save.

Note:

Windows shortcuts:

• 'Insert': to add a device
• 'Delete': to delete the selected device
• 'F2': to rename the selected device.
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ArtiosCAD Servers

You can configure a new ArtiosCAD Server in Automation Engine via the pilot, by choosing  Tools >
Configure > Select ArtiosCAD Servers  and using Ctrl / Cmd + N

How to configure a Standard Edition ArtiosCAD Server

1. Set up the ArtiosCAD Database Settings

a) When using a Microsoft SQL Server:

1. Enter the Name of the ArtiosCAD database. Default is ArtiosCADdb
2. Enter the database host name and the name of the SQL Server Instance when ArtiosCAD

is not deployed in the default unnamed instance. (typically <ArtiosCAD Server>\Esko)
3. Enter the port when not using the default.

b) When using Oracle:

Important:  The Oracle Client Software (ODBC:  Additional libraries for enabling ODBC
applications) needs to be installed on the Automation Engine Master and its Assistants. When
not installed, the Create CAD Report from XML Task will not be able to connect to the Oracle
ArtiosCAD database.

1. Enter the name of the Oracle TNS Service name, for example Oracle XE
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2. Enter the name of the Oracle Database Driver

Note:  The name of the Oracle database Driver can be found in the Drivers tab of
the ODBC Control Panel (%systemdrive%\Windows\\SysWoW64\Odbcad32.exe) after
installation of the Oracle Client Software

3. Enter the database host name
4. Enter the port when not using the default.

2. Enter the location of the ArtiosCAD Defaults

This should be a file: URL, pointing to the ArtiosCAD Defaults., for example file://MyMachine/
ArtiosCAD.

The Automation Engine Server should be able to reach this folder, and the service account of the
BGMD Service (typically BGSystem) should have read access to the folder.

Note:  ArtiosCAD Defaults are version specific. The version of ArtiosCAD hosting the Defaults
must match with the version of CADX installed on the Automation Engine computer (Master and
its Assistants)

If no ArtiosCAD Defaults location is specified, the Create CAD Report from XML task will use
the ArtiosCAD Defaults in stalled on the Automation Engine computer (Master and its Assistants).

3. Test the connection by clicking the Test Connection button.

You will get a message stating "Connection to the database OK", or get an error message:

• if the Automation Engine Server can't connect to the database
• the Automation Engine Server can't get info about the Defaults location. Check if the location

exists, and can be reached from the server.
• the Defaults location is not a folder.

How to configure an Enterprise Edition ArtiosCAD Server

1. Select Enterprise Edition

2. Enter the WebCenter location, typically http://<WebCenterServer>/WebCenter_Inst

3. Click Open to open the specified location in your default browser.

4. Enter the User Name and Password

5. Test the connection by clicking the Test Connection button.

You will get a message stating "Connection to the database OK", or get an error message if the
Automation Engine can't connect to WebCenter.

Automation Engine Database

Here you can configure the following databases:

• The Task Monitor database,
• The FlexoPlates database,
• The JDF database,
• The Gang Run Printing database,
• The Task History database,
• The Jobs database,
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• The Application Server database.

FlexoPlates

This database stores all the information about LEN files sent to the Digital Flexo Suite using the Make
Plate on CDI task.

You can see this information in the CDI view (see CDI View).

By default, Automation Engine uses the Jobs on page 633 database as FlexoPlates database. To
use a custom database, do the following:

1. In Database, enter the name to give to your database. By default, this is FlexoPlateHistory.
2. In DBMS Type, choose the type of database you are using.
3. In Host, enter the name or IP address of your database server.
4. Enter the Port to use (or leave it blank to use the default port).
5. Enter the User name and Password used to connect to the database.
6. Click Synchronize to synchronize the information in the database with your Automation Engine

server.

Task History

Setup

These settings will be filled out correctly when the system is installed.

Note:  DBMS stands for DataBase Management System.

• Database: Enter the name of the database.
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• DBMS type: Select the correct driver type from the list. The screenshot shows the driver type for
an SGLdriven database.

• Host: Enter the name of the server.
• Port: Indicate which port the system uses to talk to the database.
• Enter the correct user name and password.

Use the Synchronize button to test the settings immediately. If you do not click Synchronize, the
changes will be effective the next time the system is rebooted.

Maintenance

This tab has a button to Delete all Task History data. This is only useful when you have major
problems with your database that cannot be fixed without deleting the database, or when you want
to alter your database (for example add columns and you don't want to run a conversion script on
the existing data, so you delete all Task History data and start with a fresh, altered database). The
system will ask for confirmation.

Jobs

Setup

These settings will be filled out correctly when the system is installed. However, you can change
these settings.
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Note:  DBMS stands for DataBase Management System.

• Database: Enter the name of the database.
• DBMS type: Select the correct driver type from the list. The screenshot shows the driver type for

an SGLdriven database.
• Host: Enter the name of the server.
• Port: Indicate which port the system uses to talk to the database.
• Enter the correct user name and password.

Use the Synchronize button to test the settings immediately. If you do not click Synchronize, the
changes will be effective the next time the system is rebooted.

Maintenance

Dangling Jobs are active Automation Engine Jobs that have a link to job folder that is not (or no
longer) there, probably because the folder was (re)moved, or renamed.

These Jobs can be removed from the Database via the Maintenance tab.

Ideally, each Job corresponds to one folder on disk. But... it may occur that a user or operator moves
or deletes a folder of a Job via Windows Explorer or Macintosh Finder. This way, discrepancies can
arise between the information of a job in the Automation Engine database and the actual situation
on disk.

Removing dangling jobs will bring the folders on disk and the Automation Engine database back
in sync.

Click Remove to make the database check for each folder whether or not the folder - as contained
in the database - still exists.
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If the folder does not exist, the job will be removed from the Automation Engine database. This implies
that instead of deleting jobs via the Pilot, you are able to delete jobs by deleting the corresponding
folder.

Create DCS Master

When you use the Create Master DCS task you might want to map short names used in plates (that
might not mean anything) to full ink names. This is handy for example for plates with international
ink definitions. Default, C,M,Y and K are mapped unto Cyan, Magenta, Yellow and Black.

To add an ink definition, double-click an input field and you can start typing. Use TAB to switch fields.

Digital Press

Use this to connect to a digital press through the DFE (Digital Front End) server that drives the press.

1. Select Digital Press and use File > New to create a new digital press connection.

2. Enter the name of your DFE Server and click Connect.
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Note:  Make sure the DFE server is running and reachable over the network.

If your connection is successful, you will see Connection OK! and details about the DFE server.

3. If your DFE server drives several digital presses, select the Press you want to connect to from
Automation Engine.

You will see details about the digital press.

4. Use File > Save to save your connection.

E-Mail Configuration

Mail Server Tab
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• PostMaster is the email address that will receive a warning mail when an email could not be
delivered.

• Check with your IT department for the correct settings of the SMTP Server and SMTP Port.

• Select the checkbox if you want to Use a secure connection instead of an unrestricted
connection.

• If the SMTP server requests authentication, fill out the User Name and Password fields.

• Click on the button to Send a Test E-mail.

The following authentication schemes are supported by the Automation Engine mail component:
PLAIN, LOGIN and DIGEST-MD5.

Send Test E-mail

• From: Indicates  the address you're using to send the test email. If no address is filled in, the
postmaster address is used. You can choose a different sender to test if the mail server allows
you to send emails on behalf of others. The Send E-Mail task relies on this behavior as it tries to
send emails on behalf of the user that launches the task.

• To: Fill in a valid email address that will receive the test mail.

• Message: You can enter a personal message or leave the default text.

• When finished, click Send to see whether the mail system is working properly.

External Databases

External Databases are databases from external systems (not part of Automation Engine).
Automation Engine uses links to such databases in

• a Database Query SmartName. Read more in Database Query SmartNames  on page 968.

• a Database Access Point. Read more in Database Access Point on page 1245.

• the Interact with Database task. Read more in Interact with Database task on page 1274.

Attention:  When integrating Automation Engine with an external database make sure you
are compliant with the license agreements of that database manufacturer.

Note:  Configuring these links requires knowledge about database setups. If necessary contact your
IT database administrator to figure out correct settings.
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Configuring External Databases

1. Go to  Tools > Configure > External Databases .

2. Click  File > New  to configure a new link to a database.

A new database name is created with the name db_number (the number is the chronological
number of the database).

3. In the left-hand window, click to select and then click again to rename on the name of that new
database link and enter the name you want. Press Enter to confirm.

4. Choose the appropriate DBMS Type.

These Database Management Systems (DBMS) are supported:

• Microsoft SQL Server

• ODBC Source

Note:  ODBC SmartNames created before version 14 remain unchanged but are deprecated
and renamed to the Type '32 Bit ODBC Query'.

• Oracle

• Other (when a JDBC driver is used).

Attention:

Esko provides the drivers for both SQL and Oracle DBMS types. Not all database drivers
can be freely distributed by Esko, and not all drivers have been tested. If you need to
connect to Other types you have 2 options:

• connect using an ODBC System DSN for the database
• connect using a JDBC driver.

When your database manufacturer allows both ways, we recommend to use JDBC as
a connection method. A JDBC connection is directly configured in Automation Engine,
whereas for ODBC you need to pass Window’s system DSN setup.

5. Enter the connection details. These are different per type of DBMS. See examples in Specifics
per DBMS on page 639.

6. If required for the DBMS, enter the name of the Host. This is the database server (computer) name.

7. If required for the DBMS, and if required, enter the Port number.

8. If required for the DBMS, enter the User name and Password that will be used to access the
database.

9. Click 'Test Connection' to test if your setup is valid. If it is not valid, the error message might
contain details about the problem.

10.Disclaimer: Be aware of the risks of direct database queries and of the fact that Esko takes no
liability for them. You need to agree before this link can be saved.

11.Click  File > Save  to save the configuration.

See the next section for some specifics per DBMS.
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Specifics per DBMS

Connecting to a Microsoft SQL Server

Connecting to a database server via ODBC

If the database manufacturer does not provide a JDBC driver, you can connect to the database using
an ODBC link.

When the name of your system data source is for example 'ProductionDetails', then enter it in
the Database name field as 'jdbc:odbc:ProductionDetails'.

Note:

32-bit versus 64-bit ODBC:

• On 32-bit hardware (for example Windows Server 2003), Automation Engine tools that use
these database links can only work with 32-bit Windows ODBC Data Sources. You need
to add the Data Source using the 32-bit ODBC Administrator tool (%systemdrive%\Windows\
\SysWoW64\Odbcad32.exe).

• On 64-bit hardware (for example Windows Server 2008 R2), Automation Engine tools that use
these database links can only work with 64-bit Windows ODBC Data Sources. You need
to add the Data Source using the 64-bit ODBC Administrator tool (%systemdrive%\Windows
\System32\Odbcad32.exe).

Note:  As of Automation Engine 14.1(2015), Esko will only support 64-bit systems for the Automation
Engine server(s).

Connecting to an Oracle Server
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Connecting an "Other" DBMS

Other DBMS can be accessed if you can get the necessary drivers and information on how to access
the DBMS via standard JDBC technology.

• Download the JDBC driver (a jar file) from the manufacturer’s website into a Container that is
accessible to the Automation Engine (Master) server..

• Enter the required configuration fields. See an example:

• Check your JDBC driver manual for more details.

External Web Services

Using the Interact with Web Service task, Automation Engine can communicate with web services
from external systems. Read more about this task in Interact with Web Service task on page 1276.
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To configure such a web service,

1. Go to  Tools > Configure .

2. In the Configure window, select External Web Services.

3. Press the Insert key or go to  File > New . Specify a name for the new External Web Service.

4. Specify URL.

You can use a secure connection via SSL (a URL starting with https:// ) with or without a valid
SSL certificate signed by a "Certificate Authority" (CA).

When using a secure connection without a valid certificate, import the certificate into the server
java KeyStore. Use the following command on the Automation Engine server:

keytool -import -alias mydomain -file myfile.crt -keystore C:\Esko
\bg_prog_fastserver_v40\jre\lib\security\cacerts

Check the Allow unverified SSL Certificate option to do this.

Warning:  This setting is not secure.

If you need to pass via a proxy, configure the proxy settings via  Tools > Configure > Web Proxy .

5. Select the Authentication mode from the drop-down options: None, Basic or WebCenter.

Caution:  About the "WebCenter" type authentication: if you try to connect to a
WebCenter 14 or more recent, you do not need to configure the WebCenter server, you
can indicate it in the task. If you try to connect to an older WebCenter server, you have to
configure the WebCenter server here and use the Interact with Web Service task instead
of the Interact with WebCenter task.

6. Provide User Name and Password.
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7. Click  File > Save .

FastImpose Site Preferences

The FastImpose site preferences are useful when you want to map certain names to customized
ones. For example if you want to map 'C' to the French 'bleu' on your plates.

Ink Names

Click Add and two values are added to the list: key and value, double click the words to edit them:

Tip:

A black rectangle around the field indicates that you can edit it.

If you want to 'C' to 'Bleu' you enter C in the Name column, and 'Bleu' in the Customized Name
column:

This will change nothing to your job, but if you used marks that would output 'C' on plate, now it
will read 'Bleu'.
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Surfaces

A number of values are defined (F/B, Front/Back, Back, F, Front, B) but sometimes these definitions
do not conform to your language or your way of working, so you can change them.Let's say you
want Front/Back to read Recto/Verso, you just edit the Customized Name by double clicking.

Tip:

A black rectangle around the field indicates that you can edit it.

FlexProof - Image Downloader

Select the Image Downloader folder icon, open the File Menu and choose New. Three tabs appear:

• General
• Queue
• Merge

Note:

When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Proofer Node Enter the FlexProof computer name.
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Fill out these fields before you click Synchronize with ProofNode.This may take a few seconds,
the system will fill out the ‘Type’ field.

Note:

The name of the Image Downloader ProofNode is case sensitive. This is not the case for the other
devices.

Tip:

You can retrieve your host name by typing host name in a command prompt.

Queue

Queue This field will have ImageDownloader1Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
commands at the same time, then set the job-limit of the Automation Engine queue on 2. Putting
this job-limit on 1 will result in each expose command to that EskoLink being handled one by
one: the second job will be ripped after the first one is completely finished. Also remember the
following rules:- having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge: Yes is the default setting.

Select a unit. Margin Set an extra margin around the separations.

Gap Extra added zone (of empty pixels) around each separation that will result in a ‘gap’ between
the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no
output is generated before the fill quota is reached.

FlexRip - Approval

Select the FlexRip - Approval folder icon, open the File Menu and choose New.Three tabs appear:

• General
• Queue
• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.
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Rip Node Enter the FlexRip or FlexProof computer name. Also enter the exact EskoLink Portnr.
that the specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Approval1 Queue in it initially. It will update automatically when you
rename the device.

Queue Job Limit A Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs
at the same time. If you want the Automation Engine Queue to allow sending 2 Expose commands
at the same time, then set the job-limit of the Automation Engine queue on 2.

Putting this job-limit on 1 will result in each expose command to that EskoLink being handled one
by one: the second job will be ripped after the first one is completely finished. Also remember
the following rules:- having jobs ripped earlier on the Rip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.

Margin Set an extra margin around the separations. If you decide to set it to Yes, other toggles
will appear.

Gap Extra added zone (of empty pixels) around each separation that will result in a ‘gap’ between
the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no
output is generated before the fill quota is reached.

FlexRip - B

Select the correct device folder icon, open the File Menu and choose New.

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

Three tabs appear:

• General
• Queue
• Merge

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip computer name. Also enter the exact EskoLink Portnr. that the
specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue
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Queue This field will initially read MegaSetter1Queue. This field will update automatically when
you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
commands at the same time, then set the job-limit of the Automation Engine queue on 2.

Putting this job-limit on 1 will result in each expose command to that EskoLink being handled one
by one: the second job will be ripped after the first one is completely finished. Also remember
the following rules: - having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Optimize Expose Sequence This toggle ensures 'faster' output (all separations will be ripped in
one pass). For some jobs, however, this way of working results in memory problems, when this
happens, you can deselect this toggle, all separations will be ripped separately (the rip will be
restarted after every separation).

Merge

Merge We advise to set this to No as merging will happen after this pass on the way to the
Imagesetter, in doing so you achieve high flexibility in merging (positive and negative can be
merged on one film).

Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.

Gap Extra added zone (of empty pixels) around each separation that will result in a ‘gap’ between
the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no
output is generated before the fill quota is reached.

FlexRip - BI (Barco Imagesetter)

Select the BI folder icon, open the File Menu and choose New. Three tabs appear:

• General
• Queue
• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip computer name. Also enter the exact EskoLink Portnr. that the
specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.
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Queue

Queue This field will have BiModel11 Queue in it initially. This field will update automatically when
you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
commands at the same time, then set the job-limit of the Automation Engine queue on 2.

Putting this job-limit on 1 will result in each expose command to that EskoLink being handled one
by one: the second job will be ripped after the first one is completely finished. Also remember
the following rules: - having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Optimize Expose Sequence: This toggle ensures 'faster' output (all separations will be ripped in
one pass). For some jobs, however, this way of working results in memory problems, when this
happens, you can deselect this toggle, all separations will be ripped separately (the rip will be
restarted after every separation).

Merge

Merge The dropdown list only offers 'No' as an option. That's because the BI cannot merge jobs.
Select a unit.

Margin Set an extra margin around the separations.

FlexRip CDI, CDI Spark and CDI Compact

These three can be configured in the same way.

Select the correct device folder icon, open the File Menu and choose New.

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

Four tabs appear:

• General
• Queue
• Merge
• JDF
• CDI

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip computer name. Also enter the exact EskoLink Portnr. that the
specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue
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Queue This field will initially read CDI1 Queue, CDI Compact1 Queue or CDI Spark1 Queue. This
field will update automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
commands at the same time, then set the job-limit of the Automation Engine queue on 2. Putting
this job-limit on 1 will result in each expose command to that EskoLink being handled one by
one: the second job will be ripped after the first one is completely finished. Also remember the
following rules: - having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Optimize Expose Sequence: This toggle ensures 'faster' output (all separations will be ripped in
one pass). For some jobs, however, this way of working results in memory problems, when this
happens, you can deselect this toggle, all separations will be ripped separately (the rip will be
restarted after every separation).

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.

GapExtra added zone (of empty pixels) around each separation that will result in a ‘gap’ between
the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no
output is generated before the fill quota is reached.

JDF

If your CDI is equipped with a JDF/JMF enabled Device Controller, you can specify on which URL
(http address) this JDF/JMF Device Controller can be reached. To this address an imagesetting
JDF file, together with the ripped data will be sent. The accompanying JMF file will indicate that
the data can be submitted in the queue.

A JDF/JMF Device Controller installs a tight link between the Automation Engine Server and the
Grapholas system. Advantages are:

• automatic transport of the ripped bitmap files towards the Grapholas system for access in the
PlatePrep application.

• closer followup of the real plate exposure process from within the Automation Engine Pilot.

CDI

Pixelclock is set to 360000

The Perimeter of the drum in mm, inches or mil.

The content of this tab depends on the Grapholas software. If you have recent Grapholas software
these settings will be 'automatic'. The CDI Spark for example does not have these settings any
more.
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FlexRip Indigo 4000 Series

Select the Indigo 4000 Series icon, open the File Menu and choose New.

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

Two tabs appear:

• General
• Queue

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip computer name. Also enter the exact EskoLink Portnr. that the
specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

QueueThis field will have HP Indigo 45000 Queue in it initially. This field will update automatically
when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
commands at the same time, then set the job-limit of the Automation Engine queue on 2.

Putting this job-limit on 1 will result in each expose command to that EskoLink being handled one
by one: the second job will be ripped after the first one is completely finished. Also remember
the following rules: - having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

FlexRip - Proofer Output

Select the Proofer Output icon, open the File Menu and choose New.

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

Three tabs appear:

• General
• Queue
• Proof

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip or FlexProof computer name. Also enter the exact EskoLink Portnr.
that the specific Dispatcher has for its EskoLink queue.
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Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Proofer Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
commands at the same time, then set the job-limit of the Automation Engine queue on 2. Putting
this job-limit on 1 will result in each expose command to that EskoLink being handled one by
one: the second job will be ripped after the first one is completely finished. Also remember the
following rules: - having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Proof

A workflow choice must be made: or you choose to let the FlexRip recombine the separations or
you choose to add a 'Proof (FlexProof)' task.

Recombine separations:

• On the FlexRip, you can add a margin (in mm/mil/inch), no merging is possible.

• By sequencing a 'Proof (Image Downloader)' Task: you have to specify the 'FlexProof -
Image Downloader' device from the dropdown list. (The list only shows those devices that are
configured for the same node (RIP and Proof node must be identical).

FlexRip - Screened Output

DCS

These are the settings of FlexRip devices.

Select Screened Output > select DCS > Select 'New' from the File Menu.

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

Three tabs appear:

• General

• Queue

• Merge

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip computer name. Also enter the exact EskoLink Portnr. that the
specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.
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Queue

QueueThis field will have Screened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job LimitA FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
commands at the same time, then set the job-limit of the Automation Engine queue on 2. Putting
this job-limit on 1 will result in each expose command to that EskoLink being handled one by
one: the second job will be ripped after the first one is completely finished. Also remember the
following rules:- having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels)
around each separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no
output is generated before the fill quota is reached.

TIFF

Select Screened Output > select TIFF >open the File Menu and choose New.

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

Three tabs appear:

• General

• Queue

• Merge

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip computer name. Also enter the exact EskoLink Portnr. that the
specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Screened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
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commands at the same time, then set the job-limit of the Automation Engine queue on 2. Putting
this job-limit on 1 will result in each expose command to that EskoLink being handled one by
one: the second job will be ripped after the first one is completely finished. Also remember the
following rules:- having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Optimize Expose Sequence This toggle ensures 'faster' output (all separations will be ripped in
one pass). For some jobs, however, this way of working results in memory problems, when this
happens, you can deselect this toggle, all separations will be ripped separately (the rip will be
restarted after every separation).

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels)
around each separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no
output is generated before the fill quota is reached.

Note:

Putting Merge on 'Yes' may result in a very large output file.

PDF

Select Screened Output > select PDF >open the File Menu and choose New.

Three tabs appear:

• General

• Queue

• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip computer name. Also enter the exact EskoLink Portnr. that the
specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

QueueThis field will have Screened Output1 Queue in it initially. This field will update
automatically when you rename the device.
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Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
commands at the same time, then set the job-limit of the Automation Engine queue on 2. Putting
this job-limit on 1 will result in each expose command to that EskoLink being handled one by
one: the second job will be ripped after the first one is completely finished. Also remember the
following rules:- having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels)
around each separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no
output is generated before the fill quota is reached.

Note:

Putting Merge on 'Yes' may result in a very large output file.

PS

Select Screened Output > select PS >open the File Menu and choose New.

Three tabs appear:

• General

• Queue

• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip computer name. Also enter the exact EskoLink Portnr. that the
specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Screened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
commands at the same time, then set the job-limit of the Automation Engine queue on 2. Putting
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this job-limit on 1 will result in each expose command to that EskoLink being handled one by
one: the second job will be ripped after the first one is completely finished. Also remember the
following rules:- having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels)
around each separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no
output is generated before the fill quota is reached.

Note:

Putting Merge on 'Yes' may result in a very large output file.

FlexRip - Unscreened Output

DCS

These are the settings of FlexRip devices.

Select Unscreened Output > Select DCS > open the File Menu and choose new.

Three tabs appear:

• General

• Queue

• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip computer name. Also enter the exact EskoLink Portnr. that the
specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Screened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
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commands at the same time, then set the job-limit of the Automation Engine queue on 2. Putting
this job-limit on 1 will result in each expose command to that EskoLink being handled one by
one: the second job will be ripped after the first one is completely finished. Also remember the
following rules: - having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels)
around each separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no
output is generated before the fill quota is reached.

Note:

Putting Merge on 'Yes' may result in a very large output file.

TIFF

Click the Screened Output icon, select TIFF from the list, open the File Menu and choose New.

Three tabs appear:

• General

• Queue

• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip computer name. Also enter the exact EskoLink Portnr. that the
specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip. This may take a few seconds.

Queue

QueueThis field will have Unscreened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
commands at the same time, then set the job-limit of the Automation Engine queue on 2. Putting
this job-limit on 1 will result in each expose command to that EskoLink being handled one by
one: the second job will be ripped after the first one is completely finished. Also remember the
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following rules:- having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Optimize Expose Sequence This toggle ensures 'faster' output (all separations will be ripped in
one pass). For some jobs, however, this way of working results in memory problems, when this
happens, you can deselect this toggle, all separations will be ripped separately (the rip will be
restarted after every separation).

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.

GapExtra added zone (of empty pixels) around each separation that will result in a ‘gap’ between
the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no
output is generated before the fill quota is reached.

PDF

Click the Screened Output icon, select PDF from the list, open the File Menu and choose New.

Three tabs appear:

• General
• Queue
• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip computer name. Also enter the exact EskoLink Portnr. that the
specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Unscreened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
commands at the same time, then set the job-limit of the Automation Engine queue on 2. Putting
this job-limit on 1 will result in each expose command to that EskoLink being handled one by
one: the second job will be ripped after the first one is completely finished. Also remember the
following rules:- having jobs ripped earlier on the FlexRip does not mean your output device
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can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.

Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels)
around each separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no
output is generated before the fill quota is reached.

PS

Click the Screened Output icon, select PS from the list, open the File Menu and choose New.

Three tabs appear:

• General
• Queue
• Merge

Note:  When you have defined settings, do not forget to save them. Click Save in the File Menu.

General

Type When you configure a new device, the system will tell you that the Type is Unknown.

Rip Node Enter the FlexRip computer name. Also enter the exact EskoLink Portnr. that the
specific Dispatcher has for its EskoLink queue.

Fill out these fields before you click Synchronize with Rip.This may take a few seconds.

Queue

Queue This field will have Unscreened Output1 Queue in it initially. This field will update
automatically when you rename the device.

Queue Job Limit A FlexRip's Dispatcher EskoLink queue can rip (= handle the expose-command
of) 2 jobs at the same time. If you want the Automation Engine Queue to allow sending 2 Expose
commands at the same time, then set the job-limit of the Automation Engine queue on 2. Putting
this job-limit on 1 will result in each expose command to that EskoLink being handled one by
one: the second job will be ripped after the first one is completely finished. Also remember the
following rules: - having jobs ripped earlier on the FlexRip does not mean your output device
can output them any earlier. - some people prefer the Automation Engine queue 'job limit' on
1 because that guarantees the 'first in first out' rule. Do consult your Esko workflow trainer or
customer service for more advice on these Queue 'job limits'.

Merge

Merge Select a unit.
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Margin Set an extra margin around the separations.

If you decide to set it to Yes, other toggles will appear.GapExtra added zone (of empty pixels)
around each separation that will result in a ‘gap’ between the merged separations.

Minimum Fill Enter a percentage. The minimum fill is an economic measure, it ensures that no
output is generated before the fill quota is reached.

Gang Run Printing

You can group compatible jobs in the Gang Run view. For this, define one or more custom fields and
specify their use as a grouping key. When jobs are submitted to the gang run for a certain substrate,
they are grouped automatically when they have the same grouping key values. Typical examples of
grouping keys are: Customer, Printing Method, Finishing Method, etc.

1. Go to  Tools > Configure .

2. In the Configure window, select Gang Run Printing.

3. Press Insert key or go to  File > New .

4. Specify names for each custom field under Name Custom Field.

5. Enable Use as grouping key to use Custom Field as grouping key.

6. You may select Use the Customer field as grouping key.

7. Click  File > Save .

Jobs

Job Setup

Six Custom Fields can be specified. When entering names in custom fields 3 to 6, an extra tab
Categorization will appear in the Job Setup dialog box.

Tip:  Examples: region - brand.
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Note:  Think about these carefully, changing this later will create confusing lists of values for these
fields.

JDF Setup

JDF Setup offers the possibility to define default settings in case you create (new) Jobs via JDF/JMF.

If you want to use the same Job structure each time a new Job is created via JDF, this can be done
by taking over the Job structure of a specified Job. Check Apply Job Setup and click Select if you
want to copy the setup from another Job. You can indicate what items should be copied. Traditionally
it will be Tickets, Parameters and sometimes Inks.
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On the Custom Fields tab, you can define how the data in the Comment elements from the JDF file
is used to populate the custom fields (Categories) that appear in the Job Setup dialog.

To do this, type an XPath expression into the field corresponding to the category that you want to
fill in automatically, or click Edit to open the XPath builder.

Note:

• The JDF that was loaded in the XPath builder is remembered while the Configure dialog is open.

• When editing the next XPath, the same JDF will be automatically used as the example XML in
the XPath builder.
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XPath Builder

When you click Edit in any field that allows XPath Expressions, the XPath Builder opens.

The XPath Builder supports alternative starting points:

• The XPath is not resolved relative to the root node of the XML document, but from another XML
element.

• When a proper JDF is used as the example XML, a list of possible starting points is generated.
• The first possible starting point is automatically used to configure the XPath builder.
• In this example, the XPath builder is used to create an XPath for a product part attribute:
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• The XPath builder automatically uses the first  PageData  node as starting point. This is
visualised by showing the content outside the PageData node in grey.

• It is still possible to select nodes outside the PageData node as result node or as predicate
node.

• When selecting nodes outside the PageData node, the XPath builder will create absolute
XPaths.

• When you want, you can modify these absolute paths by making them relative to the PageData
node using ../

• While the XPath builder automatically selects the appropriate starting point, it is still possible to
manually change the starting point by clicking on another node while holding down Command
(Mac) or CTRL (Windows).

Job Web Page

Define the Job Web Page's path here. Obviously, it needs to be a valid URL, so if you use
SmartNames, make sure they resolve correctly. This allows you to go to your WebCenter project from
within your Automation Engine Job!

Enter the name of your WebCenter site, and add “/projdetails.jsp?projectName=[JobName] at the
end.
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In the Pilot, you can right-click a job folder and select 'Go to Job Web Page' from the pop up menu.
A browser will start up and load the path defined here.

Attention:  This only works if you map the job on a project by name, but this will be the most
common case.

Smart Job Location

The Job’s job folder can be defined by a smart path named Smart Job Location. Its configuration
calculates the location of the job folder based on a set of rules as defined in Configure panel. This
avoids having to enter the path manually in the 'New Job' or 'Job Setup' dialogs.

There are three types of specifications that you can use to set up the Smart Job Location. You can
base the location on the Customer of that job, or on a custom Rule or you can specify (only) the
Container.

These 3 methods will be checked in their specific order: if no rule is found for the Customer, the set
of custom rules will be checked. If there is none that matches (that returns a valid path for the job
folder), then the Container setting will be checked.

In the 'New Job' or 'Job Setup' dialog boxes you will see an extra toggle Show Job Location. Check
this toggle to make Automation Engine use the Smart Job Location rules.

We now have a closer look at these types of rules:

• Customers: allows to set simple rule based on the customer name. It allows you to specify 1
smart place for all jobs of that specific customer.

• Rules: allows you to set extensive conditional rules.

• Container: allows you to set a fixed Container for all job folders to be created (from now on).
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Tip:  It is possible to use this Smart Job Location as a SmartName for the indication of the folder
for the Job in JDF. Use <SJL\>.

Customers

Set a rule here if you want to control the job location per customer. This so offers 1 smart place for
all jobs of that customer.

The rule that you set here will become part of the customer definition in  Tools >  Customers . See
this example:
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Rules

If no customer is selected for the new job, or no location is defined for the customer, the systems
checks your set of custom rules.

Click the New Rule button in the Rules tab to set up new rules. It enables extra conditions that you
can make as extensive as necessary.

In the Matches field, you can use Regular Expressions can be used. Click the Help button for an
overview of the characters that can be used to indicate your regular expressions.

This example shows how you can distribute many jobs automatically over subfolders, based on the
number in the job's Order ID:
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Container

If no rules apply to the new job, the default job location will be used.

In case the Checks on Customers and Rules did not return a valid path for a job folder, then this
rule will be taken: you here define a main choice for the Container.

This rule is particularly useful when you have a system where you have all jobs created on a Container
(a share on a hard disk) until that share runs full. In that case, you create a next Container and change
the general rule here to the new Container, again until that one fills up.

Nexus

1. Choose  Tools > Configure  and select the Nexus category.

2. Click  File > New

3. Enter the name of the Nexus server in the Host field.

4. Enter the Port on which the Nexus server is accessible.

5. Click Test Connection to verify the settings you entered.

Note:  You can also test whether the Nexus SoapServer is online by browsing to the following url in
your favorite web browser: http://NexusServerName:5182

Notification

The configuration of the notification consists of 3 parts:
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• Rules
• Via File
• Templates

Notification Rules

Instead of deciding on notifications per ticket, you can define general notification rules. You can set
a notification rule on a specific task or on a specific device (queue).

There are two tabs:Tasks and Devices. Both these tabs list either tasks or devices for which you
can define notification rules.

For example:

• Milestone task: send out an XML every time a Milestone task ends.
• CDI Compact device: send out XML on all actions on that CDI device. Have each notification

added to the main XML representing that CDI.

Note:  It is not possible to set up a notification rule for a device if a dedicated rule can be set up
for the corresponding task.

Defining a Notification Rule

1. Click 'Add'.

The Notification Rule Editor pops up.

2. Define the Notification.

Define the condition for the notification and the action.
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A notification may consist of an e-mail sent to the task owner (or to any other valid address), it
may also be an entry in a XML/text file, or an XML/text file in a certain folder.

The place where the Text and XML notifications end up is defined in the Notification via file part
of the Configure Tool.

Note:  When selecting “Send an e-mail”, you can add more than 1 e-mail address in the 'To'
field (including SmartNames) by using ' ; ' as a separator.

You can add the input files, the output files, the task's log file and or the ticket to the notification.

The notification can be based on a template. Hit the Edit templates ... button to create and
modify templates.

For more information, please see 'Edit Notification Templates'.

Note:  The Template list and Edit templates button will only be visible if templates have been
created before.

Note that SmartNames can be used in the To field, for example to refer to e-mail addresses of:

• the Job’s Customer Service Representative,
• up to 3 customer contacts.

3. Click OK.

The notification rule is added to the 'Notification' dialog.

Via File

There are two tabs: this allows you to determine the default location of the Text and XML report
(entries). You can enter a path for both Text and XML notifications. Use the Browse buttons to define
a different location.
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Text file notification: You can append the message in a log file (*.log). You can create a new file for
each message in the same folder.

XML notification: You can append the message in a log file (*.XML). You can create a new XML file
for each message in the same folder.

To set general rules, you need the Notification Rules part of the Configure tool.

Include task messages: the task messages and / or task parameters will be added to the notification.

Notification Templates

You can base your notification on a template. This means that you prepare a template with a default
structure.

You can also use the default template.

Click 'Edit Templates' in the Notification Rule Editor to add a new one, or to copy, modify, rename
or delete an existing template.

Please see Edit Notification Templates for an explanation of how to create a new template.

Edit Notification Templates

You can base notifications on a template. This means that the notification will be structured exactly
the way you want it to be structured.

You can either choose an existing template from the list, create a new one, or modify an existing
template.
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Creating a template

1. Click Add.

2. The Add dialog pops up. Enter a name for the template. Click OK.

3. The Edit Template dialog pops up. It has dedicated fields for:

• the E-mail subject line (SmartName enabled),
• the text of the E-mail message (SmartName enabled),
• code-based conditional information (SmartName enabled),
• attachments.
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Tip:  You can also Edit Notification Templates in the Configure tool, provided that you already have
templates available: go to  Configure >  Notification >  Rules > Select a task  > Add... .

Odystar

Enter the name or IP address of the Odystar server in the Host field.

Enter the Port on which the Odystar server is accessible.

Click Test Connection to verify the settings you entered.
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Note:  You can also test whether the Odystar Hub is online by browsing to the following url in your
favorite web browser: http://OdystarServerNameorAddress:5182.

Preflight Tools

Use the Preflight Tools category in the Configure tool to define the settings necessary for Automation
Engine to work with the supported preflight tools.

This is used in the Preflight via External Application on page 405 task.

Important:

• Your PitStop Server application has to run on your Automation Engine server.
• You must share your PitStop folder (located for example in C:\Program Files\Enfocus

\Enfocus PitStop Server 09) to be able to access it from the Preflight ticket.

Tool Name: select one of the supported preflight tools.

Report Language: select the appropriate language from the list. The report language selection for
Enfocus PitStop Server can be set in the PitStop Server preferences.

Report Units: select the unit to be used in the preflight report.
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Report Type: select the output type of the preflight report: PDF, XML or both.

Executable File: enter (or browse to) the path to the preflight tool executable file.

Profile Folder: enter (or browse to) the path to the folder where the default profiles for the selected
preflight tool are stored.

Action Folder: enter (or browse to) the path to the folder where the action lists for the selected
preflight tool are stored (only from PitStop Server 4). The Preflight task will allow you to select multiple
actions from this folder.

Note:  Tickets created prior to BackStage 7 Release 5 will be loaded with one single action in the list.

Printing Methods

Printing Methods are defined in the Configure tool. You get a list of standard names. You can add
custom ones.

You can set an ink to a specific printing method by using the Job setup's Inks tab on page 840
or by using a background task.

These tasks can set and/or use Printing Methods:

• Adjust PDF Screening on page 254
• Extract Inks on page 350
• Normalize PDF File on page 377
• Normalize PostScript / PDF / Illustrator 8.0 File on page 379
• Optimize PDF Separations on page 399
• Trap with PowerTrapper on page 511
• RIP'ing with Imaging Engine on page 1123

For example:
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These are typical examples of how to make use of a Printing Method:

• In your Imaging Engine (RIP) task for flexo, you select only the inks of printing method 'flexo'.

• You make a special ReportMaker PDF that focusses on the embossing 'ink'. In your workflow,
you use the Extract Inks on page 350 task to select the wanted ink type before you start the
ReportMaker task.

Processing Preferences

Embedded Images

Normalized PDF files have the ability to save all their images internally, but this may result in oversized
files. You can define the maximum size for internal images here.

Images exceeding the defined size will be saved externally.

Automatic Normalization

Tasks that require Normalized PDF files as input will automatically normalize any regular PDF you
launch them on using the Normalize ticket you select here.

By default, Automation Engine uses the Normalize PostScript/PDF/Illustrator 8.0 File ticket called
OnDemand.
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From this ticket only the settings in the Color Management tab are taken into account.

All other settings of the automatic normalization are forced to fixed default settings. For example,
automatic normalization will always embed all images.

Products

Product Setup

In the item Product Setup, you can name the custom fields that appear in the Product Setup and
in the Product Part Setup.

Above example configuration results in this:
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JDF Setup

Note:  JDF workflows are not documented in this user manual. Learn more about the basics of JDF
in the chapter Integrating with External Systems on page 1228. For more information, contact Esko
Solution Services.

Data Zone

Note:  The Data Zone concept is documented in Products Data Structure on page 881.

• Create Data Zone and File when a new Product Part is created from JDF:

• Data Zone: When the JDF references a non-existing product part, define here where to create
the data zone for that product part (the physical folder containing the part's file).

• File: When the JDF references a non-existing product part, define here where to create the
subfolder and/or file in the data zone.

• Apply Data Zone Structure: Use this option when you want to add a specific substructure to the
data zone. Browse to an example data zone (folder with subfolders).

Product (Part) Setup

In the Product Setup and Part Setup tabs, you can add rules to map values from the JDF onto the
attributes of the products that the JDF creates.
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To do this, type an XPath expression into the field for each attribute that should be overruled by the
system value, or click Edit to open the XPath builder.

Note:

• The JDF that was loaded in the XPath builder is remembered while the Configure dialog is open.
• When editing the next XPath, the same JDF will automatically be used as the example XML in

the XPath builder.

Learn more about using XPath in XPath Builder on page 661.

Updating

In the Updating tab, indicate what should happen when an existing product is updated over JDF.

Learn more about updating products in The Add to Products task on page 908.

XPath Builder

When you click Edit in any field that allows XPath Expressions, the XPath Builder opens.

The XPath Builder supports alternative starting points:

• The XPath is not resolved relative to the root node of the XML document, but from another XML
element.

• When a proper JDF is used as the example XML, a list of possible starting points is generated.
• The first possible starting point is automatically used to configure the XPath builder.
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• In this example, the XPath builder is used to create an XPath for a product part attribute:

• The XPath builder automatically uses the first  PageData  node as starting point. This is
visualised by showing the content outside the PageData node in grey.

• It is still possible to select nodes outside the PageData node as result node or as predicate
node.

• When selecting nodes outside the PageData node, the XPath builder will create absolute
XPaths.

• When you want, you can modify these absolute paths by making them relative to the PageData
node using ../

• While the XPath builder automatically selects the appropriate starting point, it is still possible to
manually change the starting point by clicking on another node while holding down Command
(Mac) or CTRL (Windows).

Smart Product Location

Smart Product Location allows to automatically decide the location for a new product based on a
set of rules defined in  Configure >  Products >  Smart Product Location .



2
Automation Engine

679

Learn more about creating products in Creating Products and about their file location settings in
Product (Part) Properties on page 893.

Important:  You do not need this tool when your file is already in the right place when you make it
a product part.

Three Ways to Decide the Location

You can use three kinds of specifications to set up the Smart Product Location: based on Customers,
on custom Rules and on a chosen Container.

These three ways are checked in a specific order: if the Customers check does not return an valid
path, then Rules will be checked. If this still does not return a valid path, then the Container rule
will be used.

• Customers: This rule allows to specify per customer a SmartName based path where all its
products will be created.

• Rules: This tab allows to set extensive conditional rules. For example you could create all the
products in a structure based on their [custom field 1]. You can create several rules and
they will be checked from top to bottom.

• Container: This tab allows to set a smart path in a fixed Container where all products will be
created (from now on). For example: All products are created in Container Data1 and when the
disk of that Container is full, you here configure that from now all new products will be created
in Container Data2.

Using the Smart Product Location

Smart Product Location is used in these cases:

• When choosing Uploading As a New Product on page 898. This feature is used for example
when your product data is still on a CD or on your desktop.

• When creating products via JDF or when placing products via JDF (a product part URL is already
decided but 'empty' and the JDF then delivers the file to the URL that expects the file).

When Uploading a File as a Product, the panel shows the extra Smart Product Location tool at the
bottom:
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Click Show Product Location to see a preview of where the uploaded file will be placed. An example:

Product Part Data Zone

Note:  Learn about the concept of Data Zone and see some examples in Products Data Structure
on page 881.

Every product part has a data zone. It contains the product part file itself and any additional related
files.

When you look at a product's data zone in the Pilot, the depth of the data zone indicates the number
of folders that you will see between the root of the data zone and the folder containing the actual
product part file.
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The Default Depth value that you enter here is used when you create or change the product part
properties.

Scripts

You can configure your Script Runner to your Automation Engine server. A Script Runner is a stand
alone Automation Engine Server component on which you can create scripts. These scripts can be
used in the Run Script task.

This computer must have Script Runner installed and running. For more information on installing a
Script Runner, refer to Getting Started with Scripting on page 123

1. Choose Scripts  from the categories on the left. Choose  File > New .

1.

2. Give a suitable name to the Script Runner by choosing  File > Rename

3. Enter the computer name or IP address of the local computer in Host field.

4. Enter the Port used to connect this computer to your Automation Engine server.

By default, this is 1983.

5. Click the Test Connection button. You will see all the scripts available on the Script Runner or
a message 'No scripts available'.

Shuttle
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Enter the Port to use for communication between your Automation Engine server and the Shuttle
clients.

Note:  By default this is port 5182, but if this port is already used by other processes, you should
enter the next available port.

Choose an Upload Folder using the Browse... button.

This is where Shuttle clients will upload files that are not located in a Container (except the Shuttle
DeskPack plug-in, that will always upload files to the DeskPackContainer).

Note:  The Upload Folder must be located on a Container.

Select Start Shuttle server automatically when Automation Engine is started if you plan to make
frequent use of the Shuttle technology.

Click the Start button to start Shuttle server. This is not required to use the Shuttle application.
However, starting the server is required to use Shuttle via applications like ArtPro, PackEdge and
Illustrator. Shuttle server makes Automation Engine’s workflows, tasks and files accessible to the
Shuttle clients.

Save the settings by clicking  File > Save .

Task Cleanup Rules

You can define Task Cleanup Rules to automate the cleaning up of the tasks pane.

These rules can be selected and applied in the Monitor.

1. Click New....

This opens the New Rule dialog box.
2. Enter a Rule Name of your choice.
3. Choose if this rule will Move entries to History, or Delete them.
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4. Choose what to apply the rule on: Single Tasks or Workflows.
5. Use the Operator tab to choose whose entries you want the rule to clean up.

Select Filter on Operator and select the desired operators (you can also Select All).
6. Use the Time tab to select the entries to clean up based on their date.

Select Filter on Date and choose to move / delete the tasks / workflows finished since a certain
number of minute(s), hour(s), day(s) or month(s).

7. If you are cleaning up Single Tasks, you can use the Task Type tab to only clean up certain task
types.

Select Filter on Task Type and select the desired task types.
8. Use the State tab to select the entries to clean up based on their state.

Select Filter on State and select the desired states (Successfully done, Done with warning,
Cancelled, Failed).

9. When you are done defining the rule, click OK.
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Attention:

The order of the Task Cleanup rules is very important. You have to define them in such a way
that a rule does not block the following rules.

For example, if your first rule moves all successful tasks after two days and the second
rule deletes all Proof tasks after 10 hours, the result will be that the first rule dominates and
successful Proof tasks will only be moved after 2 days (first rule) instead of being deleted
after 10 hours (second rule).

You can overcome this behavior by changing the order of the rules (use Move Up / Move
Down).

Track Edit Session

Automation Engine can be configured so that all sessions in the Esko editors are logged.

You can view this information in the Task View of the Pilot or as an XML file.

Select the application(s) for which you want to start the “Track Edit Session” task.

When you open a file that resides in an active Job (folder) in an Esko editor, the Track Edit Session
task will automatically start logging the interactive editing actions. This tracking will stop when the
file is closed.

Note:  Keep in mind that the editor needs to be restarted to activate the settings.
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Note:  For ArtPro, the Track Edit Session only records session times, not editing details.

Viewer

About the Viewer configuration settings

When a folder is marked as a Speed Up for Viewing folder, Automation Engine creates View Data
for any new files it finds there every time it accesses the folder (for example when a task writes or
reads files in this folder).

The 'Speed up for Viewing' settings in Configure allow you to select:

• which Prepare for Automation Engine Viewer ticket should be used and which types of files
should be taken into account;

• a file streaming session limit.

Note:  Files relating to Digital Film will be handled separation by separation.

How to configure the Viewer

Proceed as follows:

1. In the Preferences for automatic normalization area, select the Normalize ticket of your
choice.

Files that have not yet been normalized require a normalization step before Automation Engine
is able to create and show View Data.

2. Select the ArtPro to PDF ticket of your choice.

ArtPro files need to be converted to Normalized PDF before you can view them.
3. Select the Prepare for Viewer ticket you want to use for view data generation.
4. Configure how many Viewers can be used simultaneously to view files with no view data prepared

using the File Streaming Session Limit option in the Server Admin Wizard.

See more in Processing Capabilities on page 218
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You can also set your preferences for viewing by enabling the options :Anti-aliasing and /Or Merge
Similiar Inks.

WebCenter Sites

To configure links from Automation Engine to WebCenter sites, go to the item WebCenter sites in
the Configure  tool ( Pilot > Tools > Configure ).
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Website:

Specify the web address of the WebCenter site. After you entered the WebCenter address, click
Open... to check if the WebCenter site is up and running. If you are redirected to the login page, it
means that the address is correct and that the site is up and running.

Tip:  Be aware that this address is also the address that will be included in the notification e-mails
when adding links to documents (approval cycle start e-mail). You should therefore make sure that
the address can be accessed from the outside. Make sure to not use an internal address, but one
that you want your users to use when they use WebCenter.

WebCenter and Automation Engine are in the same LAN

Check this toggle if this is true. This will most likely be the case. Un-check this toggle if WebCenter
and Automation Engine are remote.

Note:  How can you verify that WebCenter and Automation Engine are in the same LAN? WebCenter
and Automation Engine are in the same LAN when you can connect from WebCenter’s application
server, this is the system where JBOSS is installed, to an Automation Engine Job Folder with the
credentials of the user ‘BGSystem’.

WebCenter's Approval Client:

If WebCenter and Automation Engine are not in the same LAN, you first need to create an Automation
Engine Approval Client in WebCenter. This is necessary to give Automation Engine permissions to
listen to the approval messages that are stored in WebCenter.
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Tip:  If the Approval Client does not exist yet, follow these steps:

1. In WebCenter, log in as Administrator.
2. Go to the Admin section. In Configurations, select Workflow Approval Clients.
3. Click the link “New Workflow Approval Client".
4. Enter a User name and a Password for the Automation Engine client. Mind that this is also

the user name and password that have to be entered when configuring the WebCenter site in
Automation Engine.

Fill out the client Name and Password and click the 'Check Connection' button. This will check
if that user can log on successfully.

The Info button displays the following information: ”In case Automation Engine and WebCenter are
not in the same local area network (LAN), the retrieval of the approval results is secured by a name
and password. The name and password specified in Automation Engine must match the name and
password specified in WebCenter by the WebCenter administrator. When clicking the 'Check' button,
the WebCenter version will be checked and the name and password will be validated by WebCenter.”

Check Connection

When you click this button, you should, after a few seconds, get a window saying “Check OK". The
software version of that WebCenter will also be mentioned.

Note:  The button will check the validity of the user name or password to connect to that WebCenter
but not of your WebCenter’s Approval Client.

Note:  When you connect to a secured WebCenter site (for example one that uses HTTPS://), then
you have to export its security certificate and import it on the Automation Engine server. If this is
not done, publishing from Automation Engine to WebCenter will result in an error. Read more on
how to do this in the chapter Install SSL Certificates on the Workflow Production Server of the
WebCenter documentation.

Tip:  After configuring a new WebCenter site, it is recommended to close your Pilot and start it again
in order to see the updated list of WebCenter sites in your tickets.

2.9.8 Queue Monitor
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1. Menus
2. Toolbar
3. Contents: lists all tasks in a selected queue. Right-clicking a task activates a context menu which

offers the same functionality as the Task menu.

Queue Monitor menus

File Menu

File Menu options:

• New Window: opens a new Queue Monitor window.
• Start / Stop queue  : These buttons allow you to start or stop the selected queue.

You can also do this by selecting Start / Stop Queue form the 'Advanced Menu' or by right-clicking
a device in the Device List. The devices' status is visible in the Queue State column.

• Schedule queue... allows you to schedule the activity of specific action queues. You can define
3 time intervals during which queues are kept on hold.

Set the FTP queue on hold till 2.30 PM. At that time your waiting FTP tasks will start processing

The scheduled status will be visualized in the Queue Monitor toolbar.

• Close window: closes the Queue Monitor.
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View

The View Menu offers 'Columns' from which you can select the columns you want to see or hide.
For more info, please refer to the part on 'Columns'.

Task

The Task Menu offers the same functionality as the Pilot's Task Menu. You can also right-click a task
in the queue. The context menu will offer you the following options:

• Open Task
• Log Info ...
• Hold
• Hold Until...
• Release
• Cancel
• Annotation...
• Priority...
• Relaunch

Toolbar

1. The Queue drop down list. Select the queue you want to monitor from the list.
2.  Opens the selected Tasks.
3.  Relaunches the selected task(s).
4. Status indicates the status of the selected queue.
5. The Start / Stop queues buttons . These buttons allow you to start or stop the selected

queue.
6. The Schedule Queue button  opens the Schedule Queue dialog box.

Contents of selected queue

Lists all tasks in the selected queue.

Right-clicking a task opens a pop up menu with the same functionality as the Task Menus.
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You can modify the look of the list by drag & dropping the heads of the columns, and by selecting
'Columns...' from the View Menu.

2.9.9 Containers

A Container is a network data share that contains the data that Automation Engine can work with.
You can make (part of) an existing network share a Container or you can have Automation Engine
create such network shares. These Containers can be located either on your Automation Engine
server or another computer in the same LAN.

By default, you have an empty ExampleJobContainer, on the disk drive that Automation Engine
was installed on.

You can have many Containers. You can see and browse though them in the Pilots’ Containers
mode.

To create a Container, see Creating a Container on page 691.

Creating a Container

To create a container, do the following:

1. Go to  Tools > Containers to open the Containers window.

2.
In that window, go to  File > New or click .

This opens the Create Container Wizard.
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3. Click Next in the wizard’s first screen.

4. Select either:

• Local Folder on the Server to create a container on your Automation Engine server,
• Existing Shared Folder

5. Click Next.

6. If you selected Local Folder on the Server:

a) Select in which drive you want your container to be.

Selecting a drive shows the containers already existing on that drive.
b) Click Next.
c) Enter the name to give your new container.
d) Enable Make this Job Container available for Macintosh if you want to be able to access

it from Pilots running on Macintosh machines.
e) Click Next.

Your container is created.
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f) Click Next to create another container, or Finish to leave the wizard.

7. If you selected Existing Shared Folder:

a) Enter the Computer Name of the machine where the share folder is located, or use the
Browse... button to select that machine in your network.

b) Click Next.
c) The wizard shows a list of all available shares on that machine. Select the share you want to

use as a container.

Attention:  The existing shared folders will not be displayed if the system does not
recognize the BGSYSTEM user (ask its default password to Esko).

d) Click Next.

Your container is created.
e) Click Next to create another container, or Finish to leave the wizard.
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Deleting a Container

You can delete a container from Automation Engine without losing the container’s contents. Deleting
a container simply makes its contents invisible to your Automation Engine server.

To delete a container:

1. Select the container to delete in the Containers window.

2.
Click  or use to  File > Remove.

Note:

If there are jobs in the container you want to delete, they will be listed in the confirmation dialog.

If you delete the container anyway, the job folders will become normal folders.

Relocating a Container

If one of your containers goes offline (for example the disk hosting it crashes) but you have a backup
of it, you can restore this container on another disk.

1. Select the offline container and go to  Edit > Relocate.

2. Enter the name of the computer you want to restore your container on, or browse to it.
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3. Select the share you want to restore your container on.

The Select the share dialog shows all shares available on the computer you have chosen.

4. Click OK in the Select the new location of this container dialog.

Your container is now restored on the share you selected (and has the name of the share).
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Refreshing the Containers’ List

The containers’ availability is automatically checked every 5 minutes. If you need to check it manually/
refresh the connection, you can:

• go to  Edit > Rescan,
• use CTRL + R,
• press F5 in the Pilot’s Files view when using the Container mode.

2.9.10 Access Points

Access Points are documented in the chapter Integrating with External Systems. Here is a direct
link.

2.9.11 Customers

This tool allows you to manage the customers list on your system. A customer has an ID, a name
and a description.
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Ideally, you do not type in these customer data but get it automatically via the integration with your
business system. Read more about such integrations in Integrating with External Systems on page
1228.

Customers menus

File

• New Customer [CTRL + N]: opens the 'New Customer' dialog. You can also click the new customer

icon in the toolbar 

• Modify Customer...: allows you to edit the selected customer data.

• Close Window [CTRL + W]: closes the Customer tool.

Edit

• Delete [Del]: removes the customer from the list. You can also use the delete button 

New Customer

The General tab contains three fields:

• ID
• Name
• Description

In the Contacts and Address tab, 3 contact names with e-mails and detailed addresses can be
specified.

The Additional Info tab provides 5 extra custom fields for even more information.

This data will be used in the customer tab of the Job Setup.
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To edit the data select Modify Customer from the File Menu or double-click a customer in the list.

2.9.12 Users

To manage users, go to  Tools > Users...  in the Pilot to open the Users window (or click Users
under Tools in the Pilot left pane).

From this window, you can:

• create a user (see Creating Users on page 32),

•
delete a user (select the user to delete and click the delete icon ),

• view which group a user belongs to,

• view which users are logged on,
• change users' propert
• go to Access Rights , Red Alerts, and Connections).

Menus in the Users window

File Menu

The File Menu consists of the following items:
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• New User... allows you to create a new user. For more information, see Creating Users on page 32.

• New Action... opens the New Action window, allows you to add a Milestone action to an user.

• Delete deletes the selected user(s).

• Properties... displays the selected user's properties. For more information, see Properties.

• Close Window closes the Users window.

When the tab Groups is selected, the File menu contains:

• New Group... allows you to create a new user group. For more information, see Creating Groups
on page 706.

• New Action..., Delete, Properties and Close Window.

Edit Menu

You can use the Edit menu to Copy and Paste a user's Favorites, Views and/or Red Alerts to
another user.

Note:

• Regular users can only copy Favorites from another user and paste them to their own user profile.

• Administrators can copy and paste Favorites, Views and/or Red Alerts as they wish.

They can also copy Favorites to multiple users.

View Menu

The Users window has two ways of presenting things:

1. Users: shows all defined users and lists their access rights,
2. Access Rights: displays all access rights and lists all known users.

You can also click the Users and Access Rights buttons.

Creating Users

1. In the Pilot, go to  Tools > Users .

2. In the Users window, do one of the following:

• go to  File > New User ,
• use the CTRL + N shortcut,
•

click the  icon.

The New User dialog opens.

3. Enter the user's Name, Full Name, Password, Description and valid E-mail address.

4. If you want the user to be able to administer Automation Engine, check the toggle.

This will give all user access rights to that user.

5. Click OK to add your new user to the Users list.
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Attention:

When creating a user, Automation Engine requests permission from the Windows OS.
Therefore, some changes (for example, changing the password) require the use of Windows
User Administration tools. These changes must also meet the existing domain policies (for
example, the length and complexity of the password).

Properties

Tip:  Double click a user to open the Properties window.

• The General tab lists information entered when creating the user.

Note:  The information cannot be edited in any way, except for the e-mail address (click the
Change button to make the field editable).

• The Views tab lists which Views the user has access to (see Views on page 703).

• The Access Rights tab lists the user's access rights (see Defining User Access Rights on page
33).

• The Red Alerts tab lists which Red Alerts are presented to a specific user (see Red Alerts on
page 705).

• The Connections tab lists from where and with what application the user is connected to the
server. Naturally, several connections are possible and the Connections tab will be empty when
the user is logged off.

Defining User Access Rights

Not all users have the same responsibilities, so you can assign them different access rights in
Automation Engine.

• To give access rights to a single user:

a) in the Users window, double the user you want to give access rights to,
b) in the Access Rights tab of the Properties window, check the access rights you want this

user to have.
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Note:  Automation Engine Administrators automatically have all access rights. You cannot change
this.

• To give a particular access right to several users:

a) in the Users window, click the Access Rights button to switch to the Access Rights view,
b) select the access right you want to give to your users,
c) check the users you want to give this access right to.
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Access Rights

This access right: affects...

Containers: create / delete Creation and deletion of containers.

Files: copy / move / delete files on
disk

what you can do with files in the Pilot interface. See the
Copy or Move File on page 270 and Delete File on page
308 tasks.

Hot Folders: create / modify / delete if you can manage Hot Folders or not. See Creating a Task
Hot Folder and Modifying Hot Folder Settings in the User
Guide.

Job Parameters: create / modify /
delete

what you can do with Job parameters. See Job
Parameters.

Jobs: create / modify / delete if you can manage Jobs or not. See Creating a Job on
page 835.

Monitor: move tasks to trash or
history

what you can do in the Tasks list. See Tasks list and Task
History on page 621.

Pilot : Start the Pilot (in addition to
Shuttle)

your access to Pilot

Queues: stop / start device queues what you can do with Queues. See Queue Monitor on
page 688.

Task launching: set priority
(immediate / high)

if you can set a higher priority to the tasks you launch.

Tasks: ink remapping in inks panel if you can edit inks when ripping to a TIFF file or proofing
to Kodak Approval.

Tickets: create / modify / delete
(Global and Job tickets)

if you can manage Global and Job tickets. See  Tickets on
page 26 and Working with Tickets on page 177.

Tickets: create / modify / delete
(Job tickets only)

if you can manage Job tickets. See Working with Tickets
on page 177.

Tickets: Show All Tickets and their
Parameters (Public and other)

what tickets and parameters you can see in the Pilot (in
the Tickets View, when launching a task or workflow on
the file in the Files View, or when opening a processed file
from the Tasks list).

If this is deselected, you will only be able to use:

• public tickets (see  Tickets on page 26),

• public parameters in those public tickets (see Using
Public Parameters  on page 68),

• the Launch with option on files (not the New Task
option) (see Launching a Task on a File on page 76 and
Launching a Workflow on a File on page 1034),
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This access right: affects...

Note:

• Newly created users have this access right by default.
• You will not be able to create any ticket if you don't

have this access right.
• Users with this access right can use a Pilot preference

to simulate how the Pilot would look without this right
(see Tickets Preferences).

This is useful for administrators who want to check
how users without the full Pilot access right will see the
tickets and their parameters.

Access points: Create/Modify/
Delete

whether you can create/modify/delete Access points

Viewer : Deep Zoom the deep zoom rights in unprepared files as well as very
deep zoom viewing in prepared files.

Views

For Administrator Users

As an administrator, you can decide:

• which views you want to see and which not,
• which views other (non-administrator) users are allowed to see.

In the example below, the user called johndoe is not allowed to see the Milestones and Hot Folders
views.
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Note:

You can also setup the views assigned to users from the Pilot's Views pane:

1. Right click in the Views pane and select Select Views...
2. The Properties window opens, showing the Views available for the user currently logged on.

Select or deselect views as necessary.

Administrators can also copy the view settings of a user to one or several other users:

1. Select the user you want to copy the settings from, and go to  View > Copy Views  (or click right
that user and select Copy Views).

2. Select the user you want to give the settings to, and go to  View > Paste Views  (or click right
that user and select Paste Views).

For Non-Administrator Users

As a non-administrator user, you can only remove some of the available views for yourself. You cannot
add views that the administrator disabled, or change the views for another user.

In the example below, the Milestones and Hot Folders views are not available because the
administrator disabled them for this user.
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Note:  When a user has changed his own view preferences, Automation Engine will automatically
refresh after closing the Users window.

Red Alerts

When certain events are detected by the Automation Engine server, a Red Alert is broadcast to users.

Use the Red Alerts tab in the user Properties to configure which Red Alerts are shown to a specific
user (deselect the alerts you down want to show to that user).

Groups
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Creating Groups

1. In the Pilot, go to  Tools > Users .

2. In the Users window, go to Groups tab.

3. Do any of the following action in the Groups tab.

• Go to  File > New Group.. .
• Use the CTRL + N shortcut.
•

Cllick on the  icon.

The New Group dialog opens.

4. Enter the Name, Description and select a Color for the new Group.

5. Click OK. The new Group will be added to the database.
You can view the existing Groups under the Groups tab.

Defining Group Access Rights

You can assign relevant access rights to your Groups.

• In the Users window under the Group tab:

a) Double-click the group to which you will assign access rights.
The Properties window will pop up.
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b) Check the access rights relevant for the group in theAccess Rights tab of the Properties
window.

Note:  Automation Engine Administrators automatically have all access rights. You cannot change
this.

• You can give a particular access right to several groups/users in one go. Read more in Defining
User Access Rights on page 33

A Group member has access rights that are assigned to the Group. This overrules the User
Access Rights previously defined. If a user is a member in differerent groups, the relevant access
rights will be a sum of the access rights assigned to these groups.

Assigning a Group to a User

• To assign members to a specific Group:

a) Go to the Groups tab.
b) Click on one of the Groups. All the users will be listed underneath.
c) Select the users to be assigned to this group from the list.

• To assign a Group or Groups to a User:

a) Double-click the user from the Users wndow.
b) Go to the Groups  tab of the User properties window.
c) Add the member to one or more of the groups from the group overview.

2.9.13 Connection Doctor

As an Automation Engine administrator, you can run diagnostic tests from an operator's workstation
to verify that the Pilot's connection to the Automation Engine server works properly. With the provided
tools, you can attempt to fix the problems yourself without the need to call Esko Customer Support.
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The Connection Doctor is documented in Troubleshooting the Automation Engine Pilot on page
1369.

2.10 SmartNames

SmartNames are documented as a separate chapter in the "Complete Manual". Find it here:
SmartNames on page 916.

2.11 The ArtPro Action List Editor

2.11.1 Automating ArtPro Processing

Automation Engine can automate tasks in ArtPro and convert Nexus workflows into one or more
Automation Engine workflows. You can do this using the Apply ArtPro Action List task (see Apply
ArtPro Action List), which takes native ArtPro files as input, processes them and can output either
ArtPro files or a range of vector formats. The task uses an ArtPro Action List to define the chain of
actions to be executed. This Action List file can be created and edited by using the ArtPro Action
List Editor.

Note:  A considerable number of actions are identical or very similar to functionality that can be found
in ArtPro. In these cases, a basic explanation is given in this reference manual. For a fully detailed
description please refer to the ArtPro manual.

The ArtPro Action List Editor actions contain an elaborate number of vector outputs which converts
the ArtPro native file format to a range of vector output formats.

2.11.2 Working with ArtPro Action Lists

Download the ArtPro Action List Editor from the Server Administration web tool, as described in:
Downloading A Client App on page 208.

Install the ArtPro Action List Editor on your client machine as follows:

To open the ArtPro Action List Editor, select an Action List in the Apply ArtPro Action List task
panel and click the Edit button.
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The Action List you selected opens in the Action List dialog box. It is divided into three sections:

• Available Actions

• Selected Actions and

• Options for "selected action"

The Available Actions section has two columns. The left most is populated with all the available
actions. The next column is populated with the filtered actions. Drag and drop desired actions from
this column to the Selected Actions section. Enter an optional label to each action in this section
to help identify these unique actions when using public parameters.

In the Options for "selected action" section, the main parameters of the selected action are
displayed. These parameters can be edited. When you close the window, you are provided with an
option to save the changes. The default file extension for the ActionList is *.aal and the format
is always UTF8.

Action List Menu Options

The following is a list of menu options available in the ArtPro Action List Editor:

1. File menu:

• New Action List...: Click this option to open a new Action List.

• Open Action List...: Click this option to open an existing Action List.

• Save Action List...: Click this option to save an Action List.

• Save Action List As...: Click this option to provide a name to the Action List and save it in
a desired location.

• Exit: Click this option to exit the ArtPro Action List Editor.
2. Edit menu:

• Cut: Use this option to cut an action from the Selected Actions section.
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• Copy: Use this option to copy an action in the Selected Actions section.

• Paste: Use this option to paste a copied action into the Selected Actions section.

• Delete: Use this option to delete an action from the Selected Actions section.

• Select All:

• Edit Preferences...: Click this option to view the Preferences dialog box which contains
two tabs: GUI and Server. Configure the Distance Unit and Font Size Unit in the GUI tab.
Configure the Server details in Server tab.

3. View menu:

Hide/Show Library: Use this option to hide or show the Library (Available Actions section). Hide
Library option is initially displayed in this menu which toggles to Show Library after user has
hidden the Library.

4. Window menu:

Action List: name.aal: This menu displays names of all the Action Lists currently opened by a
user.

5. Help menu:

About ArtPro Action List Editor: Click this option to view a window which displays information
about the ArtPro Action List Editor.

Creating an Action List

To create an Action List:

1. Click the New Action List... in the File menu.
2. The Action List: Untitled.aal* dialog box appears. Using this dialog box, add actions to the Action

List and define attributes for actions.
3. In the first column of the Available Actions section, select All to view all the available actions in

the second column. Or filter the actions to view only some particular set (selection-related actions,
check-related actions...). Also, use the search field to display certain actions (for example, type
"OPI" in it to display all OPI-related actions).

4. Double click or drag actions from the second column of the Available Actions section to the
Selected Actions section.

5. Choose an action in the Selected Actions section and click Delete in the Edit menu to remove
it from the section.

6. Click an action in the Selected Actions section to view the associated parameters in the Options
for "selected action" section. These parameters can be edited.

7. Click Save Action List As in the File menu to save this action list in a desired location.
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Action lists have to be stored in the \\server\bg_data_custom_v010\dat\ArtPro Action
Lists folder for the task panel to pick them up. By default, the ArtPro Action List Editor also
saves them there, but you can choose a different location in the Save Action List As... dialog box.

2.11.3 Handling Fonts in ArtPro Files

Important:  All fonts used in ArtPro files handled by Automation Engine should either be:

• embedded,
• referenced and located in a folder accessible to the Automation Engine server.

If your file has non-accessible fonts, you will get an error when trying to add or edit text, update text
objects using ArtLink, export the file to PS or PDF...

ArtPro Files coming from a Nexus on Mac System

Type of ArtPro file in Nexus workflows Consequence on fonts in Automation Engine

ArtPro files created, edited or opened in ArtPro. These ArtPro files have all fonts and outlines
embedded (subset).

They can be opened, repeated, output… in any
ArtPro action list in Automation Engine, without
any font problems.

Exception: ArtPro files containing ArtLinked text
containing a character that was not embedded
(not yet used in the ArtPro file and the font is not
available).

ArtPro files created by a Nexus workflow (files
that have not been opened and saved by
ArtPro).

These files do not contain any font embedding.

Therefore, they cannot be used to generate PDF
export, unless: 

• You add a Text to Paths action before
outputting the file to PDF.

• You add all the necessary font folders (see
below) in your first action.

ArtPro files created by a Nexus workflow starting
with a PS/PDF import.

Referenced fonts are not available during this
workflow!

Any action that needs text outlines (Generate
Marks, Print to File, Export PDF…) will error.

To avoid this, you need to:

1. Insert a Save immediately followed by an
Open ArtPro file.

2. In the Open ArtPro file action, define the
necessary font folder.
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Handling the Fonts Correctly in an ArtPro Action List

In general, opening an ArtPro file does not need the glyphs from the characters in the job, since
ArtPro always stores the vectorized representation of the complete text block in the file.

When using ArtPro Action Lists and importing PDF files with non-embedded fonts, the fonts need to
be available on the Automation Engine server. Do the following to make them available:

1. Create a fonts folder in a container of the Automation Engine server.
2. Move the fonts from Mac to (that folder on) Windows using a third party font conversion tool (for

example CrossFont).
3. Adapt the actions that need font resources (for example the Importing action) in your ArtPro action

lists.

Note:  We recommend using TrueType fonts.

2.11.4 Available Actions

Adjust Stroke Width

This action allows to change the width of all (or all selected) strokes. For example: This can be used
to give hairlines a minimal width. First use the Selector to select all strokes smaller than the minimum
width, then use the Adjust Stroke Width action to change the width of the strokes.

Apply Pictures

This action applies an ArtPro file or picture to all objects in the file.

This function may be useful to replace the graphics in an existing step and repeat template with
another graphics file. The box popup determines which box of the picture (only for ArtPro files and
PDF files) is used to center the graphics when applying the pictures to the objects in the file.

Remove Unused Separations removes all empty separations after the Apply Pictures.

The Place Single Separation ArtPro File in Single Separation option defines how to insert ArtPro
files with only one separation. If the option is switched off, objects in this AP file with 100% of the
single separation are considered to be registration color and thus get 100% of every ink in the ArtPro
file after insertion. If this option is switched on, the file is inserted in one single separation instead.

ArtLink

This action gives full access to ArtPro’s ArtLink module from within the ArtPro Action List Editor and
allows automatic generation of multiple versions of a template file based on database information.
The different versions are in different files or different layers, depending on the setting of the radio
button at the bottom.

Since the template file needs to be made in the ArtPro application, please refer to the ArtPro manual
for a full description of the ArtLink module. For specific information on the use of Text parameters in
ArtLink, please refer the Technote on ArtLink Text Parameters.

The template file which is generated in ArtPro contains all “hot linked” objects which refer to
parameters in the database or automatic parameters based on job content. In what follows we
describe how an action list needs to be set up in order to automatically generate ArtLink versions
with the ArtPro Action List Editor.

http://www.acutesystems.com
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Using ArtLink in an Action List

Example:

A basic ArtPro action list could contain a Select File action and an ArtLink action.

The input folder contains an ArtPro template file "ice cream template.ap", a database file "ice
cream.txt" and an images folder which contains the various images which will be used for the
versioning: strawberry, lemon, lime, orange, peach and tomato.

The Select File action contains two entries whose name ends with ".txt", referring to the database
file and whose name ends with ".ap", referring to the ArtPro template file.

The Group Files option should be on, meaning these two files are grouped together for the ArtLink
action, which needs the database file and the ArtPro file. Note that the database file always needs
to be the FIRST entry in the list.

Setting the ArtLink Action

The ArtLink action has a number of parameters set.

ArtPro Template
The ArtPro file selection does not need to be selected here since it is actually determined by the
Select File mechanism. This can be used if the ArtPro File with the links is a fixed file.

Additional Resources
Additional Resources will allow to locate the Color Book and the Ink Book that needs to be used,
similar as one would load these in ArtPro when colors or inks need to be defined from a library
(example: PANTONE™ library).

File & Fonts Settings...
The File & Fonts Settings... button allows working with root folders, folder mapping and font folders
for the ArtPro template file, since this is actually an ArtPro file and may contain images (on the same
or a different server) and fonts. The fonts are obviously necessary if variable text needs to be applied
depending on the database parameters. For a full description of the File & Fonts Settings... we refer
to the Open ArtPro File action.

Save ArtPro
The Output File Naming Template button determines how the files, generated by the ArtLink action
are named and where they are saved.

As is clear from this resulting folder when the job has been executed, six jobs have been generated,
each with a variable extension:. Alnk_1 to .Alnk_6.

It is also possible to define if a Preview needs to be saved and at what resolution.

Save Records
It is possible to define if the results of the different records should be saved in multiple ArtPro files
("Files") or in one single ArtPro file containing different Layers ("Layers"). In that case, the name of
the different layers is defined using the File Naming Template.

The Database File

The database needs to be a text file as shown in this example:
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PANTONE;ice;barcode;pict

"300";"Blue Curacao Ice Cream";"54327719";":~images:strawberry"

"399";"Margharita Ice Cream";"54327627";":~images:lemon"

"370";"Caipirinha Ice Cream";"54327719";":~images:lime"

"orange";"Tequila Sunrise";"543277726";":~images:orange"

"1645";"Peche Mignon Ice Cream";"54327733";":~images:peach"

1797";"Bloody Mary Ice Cream";"54327740";":~images:tomato"

The first line describes what variables will be used, while the values for the variables are each
described on one line in the file.

• PANTONE™: the color entry in the color book to be used
• ice: a text string
• barcode: the value of a barcode to be used
• pict: an image to be used

Note:  The images are described as ~images:xxx where ~ describes the current position of the
template file and images is a subdirectory which is located relative to the current position of the
template file. Images will also be searched through the Files & Folders settings, so the full exact path
is not always necessary.

The Results

After processing, six ArtPro files have been generated, a zoomed view of the first ArtPro file clearly
shows the variables which have been used: the color, the text string, the barcode and the image.

The File Naming Template in the ArtLink action allows the use of parameter values from the database
records. The value of the n-th field can be used as a template key for the Save ArtPro file template.

Borders

The Borders action allows to modify the job size information of the current file.

Different job sizes can be defined in one file: media box, crop box, bleed box, trim box and art box.
Note that if multiple boxes need to be modified, multiple Borders actions need to be set in the action
list, as one Borders action changes only one of the Borders.

Each box sizes can be set to a fixed size depending on the size dialog or to a fixed size depending
on dimensions which are put in the Vertical and Horizontal fields.

The square buttons in the lower part of the window determines in what direction the new box size
is applied, depending on the current content of the file.

It is equally possible to calculate a difference to the current size of any page box (selected by the
"start from Box" option), using the DV field (difference vertical) and DH (difference horizontal) field. In
this case the Vertical and Horizontal fields needs to be set to 0, while the DV and DH values (positive
or negative) are used to make the current box size larger or smaller again with the direction depending
on the selected square button in the lower part of the window.

Suppose a file was imported from PostScript with the bleed contained in the job size, it could now
have a Trim box which is for example 3mm smaller in all directions when setting DV and DH both to
-3 mm. After being handled by the Borders action, it contains the page box information defined by
these settings. Hence Step and Repeat applications or imposition applications can now place the
files based on the Trim box (for example).



2
Automation Engine

715

Certified PDF

Certified PDF allows to integrate the Certified PDF Workflow functionality into Automation Engine.
The aim is to provide functionality to import Certified PDF, edit and then export as Certified PDF with
information about edits and changes to the document. Certified can be divided in three parts: Input,
Output and Certified ArtPro sessions.

Certified ArtPro Sessions
Automation Engine can work in Certified Mode, by switching it on in the Certified PDF action.

User name, Short user name, etc. - provides the information about the user who is editing the PDF
document. That information is stored in Certified PDF each time when a new session is started.

If Certified Mode is enabled, the filed "User name" is mandatory. So, before switching on Certified
Mode a User Name should be specified. Otherwise, switching to Certified Mode is not allowed and a
message box is displayed stating that User Name must be defined before turning Certified PDF on.

Working Certified Mode in Automation Engine affects the way it works for all following open/save
actions. Whatever the Certified options states are, Automation Engine is now recording the history of
changes made to the file and saves them with the ArtPro files. From version 8.0, all ArtPro files have
the possibility to be exported to Certified PDF and all the history of changes are recorded. Those
changes are recorded as sessions.

A session is a track of changes from beginning of the session to the end of the session.

A session starts when:

• A file that does not yet contain a session is created or opened. This can be: opening an ArtPro file
from version lower than 8.0, importing a PDF (Certified or not) or importing any other file format.

• An ArtPro 8.0 or higher is opened, changed and saved. The active session is closed and a new
session is opened.

• Certified PDF file is exported and Certified mode is on. In that case, the old sessions are recorded
to PDF file and a new session is opened.

The session is not begun when:

• Certified PDF file is exported and Certified mode is off. The active session is continued.

Clip

Clip uses the frontmost selected path as a cutting form to adjust the shape of the underlying paths.
Any part of the underlying paths that falls outside the frontmost one will be cropped. Thus it masks
out the selected paths underneath.

The original paths are modified. For a more detailed description, see the ArtPro manual.

Clip to Border

The Clip to Border action clips all the objects to the edge of the selected PageBox.

Objects which are completely out of the pagebox are removed, objects partially inside the selected
pagebox are clipped to the pagebox.

Choose All radio button to apply the Clip to Border action to all objects or choose Selections Only
radio button apply it to the selected objects only.
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Close ArtPro File

This action removes the currently open ArtPro file from memory. Note that every ArtPro action list
needs to be terminated by a Close ArtPro File action.

When building an ArtPro action list that does not contain a Close ArtPro File action, the system issues
a warning when closing the action list. Click the Cancel button and make the necessary adjustments.

Clicking the OK button merely closes the warning window, it is up to the operator to go back to the
action list and add the Close ArtPro File action at the appropriate location. Failing to do so results in
wrong output. Since data continues to remain in memory, Automation Engine continues to process
the different pages and documents on top of each other until it runs out of memory.

Create ArtPro File

This action generates a blank ArtPro file which can be used later for adding pictures, inserting other
files, etc.

Create Layer

The Create Layer action creates a new layer in the ArtPro file currently open in memory. Further
processing takes place in the newly created layer.

A typical example is a double burn workflow, where multiple files are imported (CMYK of first version,
K of second version, K or third version, etc.…). To make later editing easier, set a Create Layer action
before each of the imports, hence layering the final output file. The name of the layer is determined
by the template.

It is possible to move the selection to the newly created layer, by switching on the appropriate option.
Using the Position dropdown, create a layer on top or at the bottom of the file.

Delete

This action allows to delete objects, unused separations, unused layers and defined separations
from the current file.

Objects

Delete objects

Select Delete Objects checkbox, click All radio button to delete all objects or click Selection Only
radio button to delete only selected objects. Although not often used, deleting all objects could
be used to delete the contents from a file but retain all pagebox settings for another document (or
picture) to be imported into or placed. For more information on selections, see the Selector.

Separations

Separations mode

Select Leave as is in the dropdown menu toleave the separation “as is”. Select Remove in the
dropdown menu to define what separations to delete (Remove) or select Only Include in the
dropdown menu to define what separations to keep. The Delete Unused Separation option is not
influenced by this setting.

Die/ Transparent/ Varnish/ Opaque
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The checkboxes allow to set if separations should be removed or included based on the separation
type.

Separations list

If Separations mode is set to Remove, all separations defined in the list are deleted from the file.
If Separations mode is set to Only Include, only the separations defined in the list are kept and
all others are removed.

A separation name can be added by clicking the + button and typing the name in the text field. By
selecting a separation from the list and clicking -, a separation name can be removed from the list.
The separation names in the list can contain wildcards (*).

Delete Unused Separations

If this option is selected, unused separations are removed, regardless of the Separation mode
setting.

Layers

Delete Layers

If Delete Layers is selected, all layers defined in the list are deleted from the file. A layer name
can be added by clicking the + button and typing in the name in the text field. By selecting a layer
name from the list and clicking -, a layer name can be removed from the list. The layer names in
the list can contain wildcards (*).

Delete Unused Layers

If this option is selected, unused layers are removed.

Difference

The Difference action is used to calculate the differences between two ArtPro files.

This function is useful to verify that the graphics of two different language versions fit, to find out what
changes a customer made to the new label, to verify that corrections on files have been executed, etc.

The difference calculation is based on a pixel comparison. Based on the resolution set in the
Resolution field, the system compares the pixels of the two files at the same location.

When a difference is found between two pixels, one pixel is put in the resulting difference file at the
same location. When no difference is found, no pixel (or a gray pixel in separated mode) is put in the
resulting file. This means that when two files are compared that are identical, the resulting difference
file is either empty or completely gray.

The comparison and the type of resulting file is dependent on the setting of the radio buttons at the
bottom of the dialog box:

Separated

Each separation of the two files are compared on a separation basis. For each separation, a
grayscale TIFF is written to disk. In the resulting grayscale images, a 50% gray pixel means there
is no difference for that specific pixel, if the first file for the pixel is darker that in the other file, a
darker pixel is put in the difference files and vice versa.

CMYK

CMYK pixel data of the two files are compared in this case. If no difference is found, the resulting
difference pixel is white, when there is a difference, the pixel (CMYK) of the second file at that
location is put in the difference file. The resulting file in this case is a CMYK TIFF file.

Note that with this comparison method, ONLY the CMYK information is taken into account,
differences in PANTONE™ separations are disregarded.
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Binary

This results in one single 1-bit TIFF file where differences are shown as black pixels.

Align Horizontal / Vertical

When the ArtPro files to be compared have different job sizes, these popup menus allow to define
how the jobs have to be aligned before comparison.

Delete Matching Files

Removes the TIFF files of the separations in which no difference between the two jobs has been
found. The Separated mode is the only setting that results in multiple files, hence this setting is the
only one affected by this option.

Make Report Job

Generates a new ArtPro document, with the name of the compared files, date and time of
comparison, used resolution and all difference files placed underneath each other, preceded by the
separation name.

Output

Allows to specify the name and the location of the difference file.

File & Font Settings

Since the Difference action actually opens two ArtPro files, in some cases it may be necessary
to specify Root Folders, Folder Mapping and Fonts folders. Please refer to the Open ArtPro File
action for full details.

Export CIP3

The Export CIP3 action creates a CIP3 file of the active job.

CIP3 is a file format used to transfer data about a specific file through the production process. Besides
a preview which can be used to extract ink key settings, this CIP3 file contains information concerning
separations, ink coverage, job dimensions, etc.…

Two main settings are present: the oversampling of the preview as well as the resolution of the preview
that is included in the CIP3 file.

Export Illustrator

This action exports an Illustrator native file (up to Illustrator 7.0) from the current ArtPro document.

Include Traps
Determines if traps are included in the Illustrator file. Multistep gradations are not converted into
Illustrator multistep gradations but are exported as CT’s with the resolution as determined by this
input field.

Compatibility
Determines whether an Illustrator 7.0, 5.0, or 3.0 file is exported. Depending on this setting, a number
of restrictions apply:

1. Export to Illustrator 3.0 was developed for line art only:

a. text is not supported, use the Text to Paths action before this export
b. images are not supported
c. gradations are not converted, only the first color of the vignette is exported
d. multistep gradations are not exported

2. Export to Illustrator 5.0 does not support TIFF images:
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a. placed TIFFS, mapped TIFFS and internal images are not supported
b. non linear multistep gradations are not supported

3. Export to Illustrator 7.0:

a. mapped pictures are exported as CMYK TIFF images

Select the Output Fully Transparent Object checkbox to obtain transparencies as output using
Export Illustrator.

Downsample Images
To sample the images in the file 2 times, 4 times, 8 times or not at all.

Export Macroflex

The Cyrel Macroflex uses the same philosophy as the Mount-O-Matic, but is manufactured by
DuPont and has some differences.

The minimum distance between the two registration marks is 127 mm. The registration marks also
contain characters that refer to the used separations in the group. A refers to the first separation,
B to the second,... .

The Macroflex is not using a cylinder to put the polymer on, but is a flat table model. First of all,
an adhesive sheet of laminate the size of the cylinder is put on the table. The camera can move
horizontally and vertically to show the exact position on the sheet for each piece of polymer. An
operator glues the polymer onto the sheet. Once completed, the sheets of all separations are put
on the cylinders of the flexo printing press.

Export Mount-O-Matic

With Export Mount-O-Matic it is possible to export an ASCII text file that contains all information
specifically for the Mount-O-Matic machine.

Mount-O-Matic is a device allowing flexo printers to reduce the use of photopolymer in the plate
making process. This machine is useful when only small parts of the file contain information.

Shrink means the same as vertical distortion and serves as information for the Mount-O-Matic. As
the Mount-O-Matic file only contains coordinates and not the actual contents of the file, the same
vertical distortion has to be used when printing the job to film.

Export PDF

This action converts the ArtPro file in memory to a vector PDF file. By default this PDF file is written
to the job directory.

The Export PDF dialog box is based on different sets of settings or Flavours: “For Press”, “For
inPDF”, “For Viewing”, “Normalized PDF” and “JDF”. The settings for each of these flavours can be
changed. “inPDF” is used to create inPDF files.

Next to the flavour, an indication to the compliancy is given: this shows that, based on the settings,
the file will be PDF 1.3, 1.4, 1.5 or JDF compliant.

Placed Files (S&R)

When outputting a PDF of a file containing placed EPS, this EPS is placed in the PDF file as a PDF
XObject. This works on certain Rips. The Rip must accept PDF XObjects containing PostScript.

Placed DCS works only with Separated PS Output and not when outputting PDF.
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Load Settings from XML

Select an XML file using a Select File action. The settings from that XML file can be loaded in the
Export PDF action, overwriting the settings. The XML file can be saved (for example) in ArtPro, using
the Export PDF Flavor option.

Normalized PDF

With the Normalized PDF flavour, output PDF files that can be opened and edited in PackEdge,
Automation Engine etc.

1. Normalized PDF Options:

When using Normalized PDF as flavour, some specific functions are used and some general
options are changed.

a. Generate Normalized PDF:

With this option in the General tab, the PDF file structure is If no screening is defined on all or
some objects, a default screening will be applied to these objects. The defaults are: PDF and
XMP information is included in the PDF file.

b. Force Default Screening

This option (in the Optimize tab) is used in combination with the Include Screening option.
Since Normalized PDF does not allow objects without any screening definition, this option
applies a default screening on objects that do not have any screening defined yet. This default
screening is the default screening angles (15, 45, 75...) and a default ruling of 120 lpi.

c. Images:

Images are included as Esko links and also embedded at low resolution. This means image
downsampling is set at 96 dpi, the Link option is set to “Esko” and the Embed Images option
is on.

2. Normalized PDF Restrictions:

a. Screenings:

If no screening is defined on all or some objects, a default screening will be applied to these
objects. The defaults are:

• ruling: 120
• dotshape: simpledot (round)
• angles C: 15, M:75, Y:0,B:45 any other : 45

b. PANTONE inks not in Esko color books:

These inks are saved as unregistered inks. Inks found in Esko ink books get the correct ink
book reference. Ink type is kept (technical, opaque, varnish, normal).

c. Placed or repeated Files:

Placed or repeared files (ArtPro, Normalized PDF) are expanded in PackEdge.
d. No barcode information.
e. No font file information.
f. Text:

All text is saved and the font is subsetted and embedded. This results in real text in Esko
Software. However, 2-byte fonts are always vectorized when exported to any PDF flavour in
ArtPro.

g. Images:

Images keep their links if possible (most TIFF, JPEG and PSD files). This is also the case for
mapped images. Some image formats such as DCS images, PSD with multiple alpha channels,
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TIFFs with extra channels (often generated by ArtPro PS/PDF import) are not supported or
incompatible with the Esko Software. These images are embedded or generate a .ct fle on
Esko software - depending on the settings.

General Settings

Generate Normalized PDF

Please refer Normalized PDF above.

Generate Separated PDF

With this option on, the ArtPro document is exported as a separated PDF in which each page
represents a separation of the ArtPro document. It can be combined with the Add Composite on
Page 1 option.

Add Composite on Page 1

This option is available when Generate Separated PDF is on. If enabled, the first page of a
separated PDF will contain a composite proof of the ArtPro document. All subsequent pages
represent a separation used in the ArtPro document.

Add Notes

With this option on, all ArtPro notes are included in the PDF file and appear in Acrobat or the Reader
as normal, editable PDF notes.

Add Non Printing Layers

If switched on, layers set to non printing are exported into the PDF file. With this option off, these
layers are not output, so the PDF file contains only layers with the Print option on.

Include 1.5 Layers

PDF 1.5 allows the use of layers. If the option is switched on, the ArtPro layers are put in the PDF file
as 1.5 layers. The compliancy is set to PDF 1.5. This allows user to switch layers on/ off in Acrobat.

Output Fully Transparent Objects

Without this option, fully transparent objects are ignored. With this option on, transparent objects
are output.

Page Layout

The Page Layout section allows to set Orientation, Mirror and Distortion.

The Orientation can be set to portrait, turn right, turn left or upside down. It defines the direction in
which the file is put on film or on paper. Choosing portrait outputs the file in the upright position, turn
right rotates the file 90° and turn left rotates it -90°. By activating Mirror, the job is mirrored before
exporting, resulting in a wrong-reading output. Distortion is defined as a percentage of the jobs
original dimensions. This distortion is specifically important for flexo jobs. On mounting a flexo plate
on the press, it is stretched out in one direction. By making the output slightly smaller than needed,
we compensate for this distortion. The original dimensions of the ArtPro file remain unchanged.
Positive values make the job bigger and negative values make the job smaller. Example: Vert.
distortion = -2.35% makes the output 97.65%. In this way the output can also be scales: example,
entering -50% for both Vertical and Horizontal Distortion outputs the job at half of its original size.

Add Thumbnail

With this option on, a thumbnail is created of the file, a small preview, that can be shown in
thumbnails in Acrobat. With this option off, the thumbnail in Acrobat is gray.

Add Standard Preview

Preview can be defined by resolution (default 72 ppi) or by max size (in kb). This can be useful when
creating a PDF of a large size S&R, of which the preview at 72 ppi would be several Mb.

Add Separated Preview
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It is now possible to save a separated 72dpi preview in the PDF file. This non-standard preview can
only be used by other Artwork Systems software, such as ArtPro S&R...

Use Anti-Aliasing

Allows to define if Anti-Aliasing needs to be applied when calculating the preview.

Previews & Page Boxes

Thumbnails are created using the Media box. Separated previews are also created using the
Media box. The Standard Preview is based on the Art box, in order to be compatible with other
applications. This implies that the Standard Preview does not show any bleed. For JDF output,
these settings are used for all PDF files created.

Marks

This option allows to add marks into the PDF file. The Marks button and option work in exact the
same way as in the Generate Marks Action.

Optimize Settings

Use Picture Caching

Picture Caching makes the output faster by keeping all images that are put in the PDF file in the
RAM, until the complete file is written. This keeps application from having to read an image multiple
times from the hard disk, if it is used multiple times in the file. The condition is that enough RAM is
required on the machine. This is very useful if images are stored on a remote file server.

Output Gradients as Images

If this option is switched on, all gradients are converted to images instead of including them in the
PDF file as PDF Shadings.

Compress Page Description

When this settings is switched on, the PDF file is compressed. This option is switched on by default.

Include Screening

If the option Include Screening is on, Extended Screening and PostScript Screening information is
saved in the PDF file. screening is not included.

Generate JDF Output

JDF Output is an optimization system for outputting S&R of PDF files. When outputting a Step &
Repeat to JDF, multiple files are generated. First of all, the one up file(s) are exported to PDF file(s).
If the One up already was PDF, the file is just copied, unless the option Copy File is off. Second,
one or more PDF files are generated containing all elements that are on the Repetition: registration
marks, test strips, extra information, etc. Items that are grouped, are in the same file. Third, a JDF
file is created, containing the positioning of all these PDF files.

Copy PDF

If the Copy PDF option is on, the original PDF files in the S&R will be copied to the output folder
of the JDF Output. If the option is off, these single PDF files will not be copied, and the JDF will
contain a link to their original location.

Target Size

This option can be used to ensure that the size of the PDF file does not exceed a certain size
(example: 5000 kb) This can be used for files that need to be sent, example, by e-mail. In order
to keep the file size below the maximum size, images may have to be downsampled and/ or
compressed more than set in the dialog box. Do not use this for files that are sent to Press!

Split Long Paths

Just like PS output, paths with many anchor points can be split up as parts. The more parts that
need to be exported, the longer it takes. The default settings is 500.000 points.
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Text Settings

Vectorise text

Before exporting, ArtPro converts all text to paths to avoid font problems at a later stage. When
this option is switched off, the text is in the PDF file as real text. If text is not set to be vectorised,
it is always embedded. Japanese 2-byte characters are always vectorised.

Subset Embedded fonts...

Subset Fonts define whether fonts should be embedded as subset if only a part of the characters
are used. How much of the font characters should be used before the font is embedded completely,
can be set in the When percentage of characters used is less than field. If this value is set to 100%,
a subset is created for every font which is not used completely.

Color Settings

Force Opaque Inks to knockout

If the option Force Opaque Inks to Knockout is on, overprints is first flattened, so a visually correct
result is generated, but the resulting PDF is NOT OK for printing! In order to warn that the result is
correct visually, but not for print, a red exclamation mark is shown when switched on.

Fail on Nonseparable Blend modes

If the file to be exported contains Nonseparable Blend modes (Hue, Saturation, Color, Luminosity),
the file fails if this option is switched on. These Nonseparable Blend modes operate on a 3
component color space. This means that to calculate the resulting color, CMYK needs to be
converted to 3 components, the Blend needs to be calculated, and the result needs to be converted
to CMYK again. However, no instructions are given on how these conversion from one color space
to another should happen. This results in different behaviors and different color results in different
applications/ RIPs.

Exclude Separations

This option can be used to exclude separations from the output. By clicking the Options button,
the Output Separations dialog is opened. By Adding a separation (click the + button and define its
name. Wildcards can be used), you can exclude this separation for output. By selecting an entry in
the list and clicking the - button, you can remove it from the list. The Search Unused Separation
setting at the top, excludes separations that are not used. It only turns separations off, separations
excluded earlier can not be removed from the Exclude list, even if they are in use. The Search
Unused Separation option does not take registration color into account. The Exclude separations
can not be used in combination with the Include separations option.

Include Separations

This option can be used to include only the selected separations from the output. By clicking the
Options button, the Include Separations dialog box is opened. By Adding a separation (click the
+ button and define its name. Wildcards can be used), you can include this separation for output.
By selecting an entry in the list and clicking the - button, you can remove it from the list. The Include
separations can not be used in combination with the Exclude separations option.

Color Management

Color management is a technique used on color in documents to ensure that consistent color is
reproduced throughout the print production cycle. Managing color means making sure color is
reproduced in the same way for each device the system is outputting to.

If a profile has been defined at the time of importing or opening a file in the action list, it is possible
to override the settings for output (example: color profiles for proofers or separated output) in this
menu.

DotGain

This allows to apply a dotgain file on the output. For a full explanation on Dotgain, we refer to the
ArtPro manual, in the Screening section. The applied dot gain curve is applied to the PDF as a
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transfer function in the Graphic state. The dot gain curve for placed files works without problems
with placed ArtPro files and PDF files coming from ArtPro or the ArtPro Action List Editor. Placed
PDF files from other applications work fine, as long as they do not define their own dot gain curve
inside the PDF, as the embedded curve has priority. If a placed PDF file coming from ArtPro or the
ArtPro Action List Editor already contains a dot gain curve, a warning is generated on PDF Output.

Always Generate CMYK Separations

This option includes all CMYK separations to deviceN color spaces as soon as one of the CMYK
separations is used. This option is only useful for customers that use a GMG color manager on
their PDF files.

Flattener

The Flattener is used to translate transparencies and blends. This is necessary when outputting
PDF 1.3 compliant.

The Flattener section, contains all settings to flatten Blend modes and overprints. It can also be run
as a separate action: Flatten Transparencies. The Flattener replace all blend modes by “normal”
objects, maintaining the final result, that is, the blend is calculated to whatever is underneath at
that time, and is adapted in a lineart object (if possible) or an image.

Image Settings

Use Image Downsampling At

All images with a resolution higher that this value, is resampled. This allows you to create smaller
PDF files, example: for a quick soft proof.

For Images Having at Least

If this option is on, only images with a resolution higher than the entered resolution, is downsampled
to the down-sample resolution. In the example above, when switching on the option, images with
a resolution below 450 ppi remain unmodified, while images with a resolution above 450 ppi are
downsampled to 300 ppi.

Use Averaging When Downsampling

This option is the same as in the more print settings. When it is activated, image quality is better,
but the output is slower. The difference with PostScript output is that CCITT images are averaged
too when outputting to PDF.

Image Compression

No Compression, Lossless compression (Flate), Maximum Quality, High Quality, Medium Quality
or High Compression. None means that all compression is taken off. Compressed images are
decompressed in the PDF file. A lossless compression means that the file will still be complete after
decompression. There is no loss of quality. In the three other cases, the files are compressed with
a JPEG compression. A higher compression means smaller files, but worse quality and vice versa.

Include RGB preview of images

This adds a lowres 72ppi preview of the large images inside the PDF. These previews are used by
some Acrobat plug-ins, to speed up previewing files.

Image Clipping

The Image Clipping option allows to force clip images to the smallest size inside the clipping path.
Allows calculation to include the full picture if clipping does not give any benefit, that is, if the sum
of the image parts is close to or bigger than the size of the full image. A full image is only included
once in the PDF file, even if it is placed multiple times.

Links

This option allows to include OPI comments into the PDF file. Choose between None (no links), OPI
links or Esko links. The option Embed Images allows to define if images with OPI comments should
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be embedded as well. OPI comments can not be used in, for example, Illustrator, unless the InPDF
plug-in is used. For more information, see the InPDF documentation.

File & Fonts settings

This option allows to open the Root Folder, Folder Mapping, Fonts Folder and Color Management
settings. These are the same as when opening an ArtPro file.

Certified PDF

If the “Output profile” file is selected then PDF file is preflighted after being exported. The Output
profile can be cleared by shift-clicking the Browse button. If Certified PDF Enabled is unchecked,
then regular non-certified PDF file is saved and no new session is started. The Incremental save
option works only if the last Certified PDF (that is, the imported Certified PDF or the last Exported
PDF) is still available. The option means that the previous Certified PDF file’s contents are merged
with the exported PDF, so that “rollback” the PDF document to the previous session is possible.
Using this option can result in a large PDF file. To keep both the PDF as the ArtPro file in a certified
(“green”) state, it is necessary to save the ArtPro file after the Certified PDF Export.

Export Picture List

The Export Picture List action creates a Picture List file from the Step and Repeat file. An option
allows to define whether mapped pictures should be included or not. The File Name Template allows
to define name and location. A Picture List can be used in the Import Picture List action.

Fit Borders

The Fit Borders action adjusts the job size and the selected page boxes (All or a selection from the
Border popup menu) to all the elements which are on the current document. Note that when All is
selected, this means that the media box, crop box, bleed box, trim box and artbox are all set to the
same size. Users can define if they want to fit the borders only vertically, horizontally or both. They
can define whether it should be applied to selections only or on all.

Fit to Border

The Fit to Border action fits all the objects to the edge of the selected PageBox. If the option
Scale Proportionally is on, all objects are scaled proportionally, until the bounding box of the
selected object reaches the selected border, either in Vertical or in Horizontal direction. If the Scale
Proportionally option is off, the selection is scaled to fit the borders both vertically and horizontally.
This can sometimes be used when creating sleaves.

The Scale factor can be rounded off using the Scale round to value. If set to, for example, 5, the
scale is rounded down to the closest multiple of 5. If set to 0, no rounding is applied. The upscaling
can be limited using the Limit scale to field. The Fit To Border action can be applied to all objects
or only to the Selection. Apply on Notes transforms notes along with the rest of the file, so that the
positioning of the notes inside the file remains the same.

Fit to Paper

The Fit To Paper action selects the most appropriate paper size from a list of paper sizes. This allows
to select the most appropriate page size (for proofers) or plate size (for image setters) for a job, based
on the available proofers and/ or plate sizes. These paper sizes can be entered in the Action settings,
using the + button. The Media Box defines what box is to be used to determine the optimal paper
size. It can be set to Center on Page, Upper Left on Page or Fit To Page. Only this last option
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actually scales the job to fit on the optimal paper size. If the Rotate to fit option is on, it is allowed
to rotate the job when searching for the optimal paper size.

Flatten Transparencies

The Flattener section, as found in the Export PDF and Print dialog boxes, contains all settings to
flatten blend modes and overprints. It can also be run as a separate action: Flatten Transparencies.
The Flattener replaces all blend modes by "normal" objects, maintaining the final result, that is, the
blend is calculated to whatever is underneath at that time and is adapted in a lineart object (if possible)
or an image.

Please note that placed PDF or placed ArtPro files can not be flattened! In those cases a warning is
generated: Flattener was unable to process placed art... This happens only if in the
job, some objects with transparency have to be flattened with a placed image.

Resolution

The Resolution allows to set at which resolution an image should be made, when necessary.

Noise for Gradients

If it is necessary to translate a gradation into a ct, the Noise For Gradients field sets the amount
of noise that has to be applied.

No noise from/ to

This allows to define a range in which no noise should be applied to gradations. This is useful, for
example, in autoblend screening.

Vectorise Opacity Channel

This is an optimization tool for the flattener. It reduces the path containing an ArtColor internal
image, removing all areas being completely transparent (by vectorizing the opacity channel) before
flattening. This way, objects underneath a part of an image where it is 100% transparent, no longer
need to be flattened.

Flatten Overprints

If the Flatten Overprints is on, objects containing blend modes as well as, objects containing
overprint (that is, “trans” in the Paint Style) are flattened. This can be used to get a correct preview
in older Acrobat versions and Mac OS X Preview.

Ignore Overprints on Placed Art

This option allows to ignore Overprints on top of placed Art. If this option is not on, Overprints on
top of placed Art (example: a S&R) results in a failed job.

Full Step and Repeat

The Full Step and Repeat action is based on ArtPro Interactive Step And Repeat. This functionality
allows you to create a repetition of one single file at a time, based on either count or fill size.

General

Count/ Fill size

There are two ways to make a step and repeat in Full Step and Repeat: count, where the horizontal
and vertical number of labels is defined, or fill size, where the size of the paper is defined and as
many labels as possible is put in this area.

When using the fill size, the number of labels is calculated and equally divided in the remaining
space around the S&R. When count is used, the fill size is calculated. When a group of labels is
selected in ArtPro afterwards, all the used parameters are displayed.
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Step

The Step is the space used for every file. Unlike the Size shown above, the step size takes rotation
and bleed (margin) into account.

Margin

Margin is used to define the bleed between the labels. It is the difference between the Step and
the box size. The horizontal and vertical margin can be set separately. If the bleed of the single file
exceeds the bleed applied on the repeat, the jobs are cut off in the middle.

Gap/ After

The Gap is the distance in between labels. After defines after how many labels the gap should be
entered. A value of 2, for example, results in two labels without gap, then the gap and then again
two labels without, etc.

Distort

The Distort value allows to define a distortion for every repeat block separately.

Bleed

The Bleed defines how much bleed is used to the outside of the repetition. So there is a different
setting for bleed in between jobs and around the repetition. It is ignored if the Keep Bleeds
checkbox is selected. It is always check if there is enough bleed in the selected file. The trim box
size is subtracted from the bleed box and divided by two. This size has to be bigger than the bleed,
otherwise an error message is displayed.

Keep Bleeds

When the Step distance is smaller than the bounding box of the ArtPro file, the different labels do
not overlap, but they are cut off. Keep Bleeds forces bleeds in the original file to be used, even if
there is no place to put them. This function can be useful to generate repeats of round labels.

Angle

Using the Angles popup,define rotation for the labels. The options next to the angle, allow to set
labels to switch direction every other label, either vertical or horizontally.

Cut Marks

If the Cut Marks option is on, cut marks is automatically generated around the repeat block. The
cut marks are generated on the used box size. When bleed is applied in between labels, double cut
marks automatically appear. The cut marks are filled with registration color.

Pattern

This option is used to make nested S&R. This means that the second row or column is shifted each
time and the step distance can be decreased so the labels fit into one another.

Pattern

Using the Pattern buttons, define whether every second column or every second row should be
shifted. The first button creates a rectangular pattern, with no staggering. The second two create
most basic staggering: every second row or column is shifted, and contains one label less than the
first row or column. The next two buttons generate rows and columns with the same number of
labels. The buttons for round labels shift round labels into each other to save space.

Stagger offset

The offset can either be half of the step size or any user defined value. When using the Round Label
pattern, the offset is automatically derived from the size of the job and can no be changed.

Continuous Stagger
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Without the Continuous Stagger option, all even rows or columns are shifted, the odd rows or
columns remain unchanged. When using the Continuous Stagger option, every row or column is
shifted in regard to the previous.

Include Partial Labels/ Do not clip partial labels

When using the Include Partial Labels option, the gaps created by the shift of a row or a column is
filled up with the part of the label as if the repeat was continued outside the job size. When setting
the Do Not Clip Partial Labels option on, these labels are placed completely instead of just a part.

Advanced

Page Box

Before stepping the selected file, it is possible to decide which box size needs to be used. By
default, this value is set to Trim Box. When Page Box is modified, the values in step distance and
size are automatically adapted.

Place Single-Separation ArtPro File in Single Separation

This option defines how to handle repeating ArtPro files with only one separation. If the option
is switched off, objects in this AP file with 100% of the single separation are considered to be
registration color, and thus get 100% of every ink in the ArtPro file after repetition. If this option is
switched on, the file is placed in one single separation.

File & Font Settings

Provides access to the root folders, folder mapping and fonts folders when the file to be stepped
is an ArtPro file. For a description of this function, please refer to the Open ArtPro File action.

Color Management Settings

This setting determines if color management has to be applied for the Step and Repeat job. When
enabling color management, it is possible to select a color management settings file, previously
saved by ArtPro. This file contains all ICC profiles and settings to determine how color has to be
treated throughout the rest of the workflow (example: proofing of the Step and Repeat document),
including ICC profiles for proofing, printing, etc.

Generate Marks

This action physically adds marks to the file, based on the dimensions of the box set in the action
dialog box.

Marks

The Marks settings define what marks will be used:

User Text

This allows to add user defined text. The text can be defined using the File Naming Template, so
that file names, user names, user keywords etc. can be included in the marks text.

Job Name

Puts the name of the ArtPro file in the lower left corner in all separations.

Version Number

This is the number that is shown in the Job Size dialog box. Every time an ArtPro job is modified
after saving, the version number is increased.

Date & Time

Puts the current date and time in the lower left corner in all ink separations.
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Separation Names

Puts the names of the separations on the separate films.

Distortion

Puts the distortion from the Print dialog box in the file. The value is preceded by V or H, depending
on the direction of the distortion.

Dot Gain File name

If a Dot Gain file is selected in the print dialog box and the Dot Gain compensation option is tagged,
the Dot Gain file name can be added to the comments.

Color Setting Name

If a set of Color Management settings are loaded, the name of this set can be added too.

Crop Marks

The crop marks are put on the bounding box.

Registration Marks

Appears in the four corners outside the job or centered on the job when the option centered is on.
The width of the registration marks is 1/300 inch (about 0.08 mm) and the color is always registration.

Marks File

This option actually allows to select a physical marks file from disk, clicking on the button with the
three dots opens the browser for selecting the file. For a description on marks files please refer to
the ArtPro reference manual.

Options

The Options define how the marks will be handled.

Vectorize Text

Converts all the text to paths, to avoid font problems on the RIP.

Set Inside Border

Sets the text on the inside of the borders instead of outside the job borders.

Use Text Settings

Define the font to be used for the marks using this settings. This can be interesting for Japanese
users. If a default Japanese font (example: Osaka) is defined, all marks text will also contain
Japanese characters.

Box

The Box drop down allows to define to what borders the marks should be applied.

Adjust Crop Box/ Adjust Media Box

This modifies the crop box after creation of the marks, so that the job and the marks are completely
inside the crop box. In that case, it may be necessary to change the media box as well, to avoid a
crop box bigger than the media box. Therefore the option Adjust Media Box can be used.

Files & Fonts

This button allows to define root folders, folder mapping and fonts folders, similar as in the Open
ArtPro File action (please refer to this action for a full description). This functionality has been made
available in case ArtPro files have been placed in an open job during the action list, to allow for the
retrieval of the linked images or used fonts at the time of printing.

Unit

Allows to define what unit should be used in the Marks. This unit can also be used for the ArtLink
parameters added by the Marks action.
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For PS/ For PDF

As the Dot Gain curve and Distortion can be placed as Marks and these two settings can be made
in the Print menu and in the Export PDF dialog, a pop-up has been added next to the Generate
Marks button. The pop-up allows to set what Dot Gain and Distortion should be shown in the
marks: the settings for PS (from the Print dialog) or those from the Export PDF dialog. The pop-up
only has affect when the Generate Marks action is used. If Marks are added, for example in the
Print action, the appropriate settings (in this example, the settings as defined in the Print dialog
box) is shown in the marks.

Generate Strokes

The Generate Strokes action creates strokes around all objects or around all selected objects (see
Select Objects for more information).

Width/ Inside/ Outside

The Width defines the line width for the Stroke. Filling in the width results in a symmetrical Stroke.
Otherwise Outside/ Inside distances can be defined separately.

Corners/ Caps

The Corners and Caps settings allow to define the shape of the strokes in the (outside) corners
and at the end points. For elaborate information, we refer to the ArtPro manual.

Separation Name/ Ink book

Strokes generated by this action gets 100% of the separation entered here and overprint for all
other separations. If the separation does not exist yet, it is created. In that case, the specifications
for the ink is searched in the defined Ink book.

Apply on All/ Selections

Allows to define whether strokes should be applied on all objects or only on the selected objects.

Add Stroke to Crop Box/ Trim Box/ Bleed Box

Allows to add a stroke on the selected page box.

Dashed

The Dashed option allows to generate dashed strokes. The Dash distances and Gap distances
define the length of the individual dashes and gaps.

Gravure Job Ticket

Gravure job ticket offers export for Gravure systems from Hell Gravure.

You can define the Resolution and Oversampling rate defined in the action, if they can not be
retrieved from the job ticket. Each job ticket and thus every separation can have a different value.

For separations with a resolution above 600 dpi and without oversampling, you can select PackBits
Compression for HiRes. Otherwise, you can Compress the TIFF using LZW, or leave the separation
uncompressed (if you did not select Compress TIFF). PackBits compression results in lower
compression rate, but will be calculated much faster than LZW compression, so it is the best solution
for high resolution files.

Selecting Separation Count in ArtPro File and Ticket Folder must match will ensure the Gravure
job ticket will check if the separation count in the ArtPro file matches with the ticket count in the
folder.

It is possible let the task Gravure Jobticket generate a warning or an error if the ArtPro job and
jobticket size don't match:
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• Selecting Error when ArtPro job and jobticket size don't match will generate an error. Also,
no file will be generated.

• Deselecting Error when ArtPro job and jobticket size don't match will generate a warning
instead and Gravure JobTicket output file will be generated.

For other specific information, contact Hell Gravure.

Gravure Tiff

Gravure Tiff is used to output ArtPro files directly as TIFF data for gravure printing. It creates one
TIFF file per separation.

The parameters

1. Output

Choose TIFF in the Output menu.
2. Oversampling

Oversampling means that ArtPro makes the calculation of the TIFF on a resolution which is too
high, that is, higher than the one needed. Afterwards it is ‘averaged’, this means that it is converted
to low resolution by calculating the average of each group of lines. This gives a kind of “blurred”
effect. Oversampling requires a long calculation time and therefore needs optimization.

The oversampling filter can be chosen from none to 8 times:

• none: a lot of jaggies
• 4 times: default value, this is the oversampling value used the most in the packaging and label

market
• 6 times: very high, example: for stamps

Example:

If you have an oblique black line on 360 lpi (= 140 l/cm), the edges are very much pixelized.
Oversampling means that you calculate with a higher resolution than the one you need.
Oversampling 4, means that the image is calculated at 4x the resolution (360 lpi) = 1440 lpi. Every
line is divided by 4. So there are 16 pixels read (4x4) for one output pixel. The output pixel gets
the grayvalue of the 16.

3. Resolution

The resolution of the TIFF file can be defined in l/cm or l/inch. A normal engraving resolution is
140 l/cm or ±360 l/inch.

4. Noise for gradation

The default : 3 %
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1 byte = 256 gray values

Gradations normally do not have more than 250 bands (steps of 0.4 %). ArtPro creates 400 bands
instead of 250. The added noise makes the steps invisible. The desired amount of noise can be
entered in this field.

5. IBM PC Byte order

By default this option is selected, because most engraving machines are IBM-oriented. The
system IBM uses ‘Little-endian’ while Macintosh uses ‘Bigendian’.

6. 1 Bit

This option allows you to choose between 1 bit data (checked) and 8 bit 256 graylevel data
(default, unchecked). Most systems take 8 bit data.

7. Save Fast Forward Data

This option creates an extra text-file (.SVS) with a description of which parts of the TIFF-output
file are blank and hence can be skipped. Some engraving machines have the possibility to take
this information into account.

Grid Step and Repeat

Similar to the other step and repeat action, this action gives access to ArtPro’s grid step and repeat
module from within the ArtPro Action List Editor.

The grid step and repeat allows to create a repetition of different ArtPro (or other supported) files with
the same size that are all placed in the same folder. The one-up files can be defined using a Select
File action before the Grid Step and Repeat action.

This repetition can be executed with or without a layout file which is actually a simple spreadsheet
containing the positioning of the different files.

For more information we refer to the Grid Step and Repeat section of the ArtPro manual.

Gridwarp

The Gridwarp action allows to calculate complex warping of documents based on a source grid and
a destination grid.

This action can handle the warping of all element types like gradations, images, etc.…. and is typically
used for the warping of conic cups, metal containers, etc.…

Grid Warp can be done using two files, an ArtPro and a Grid file. In that case, the operation of the
Gridwarp action is similar to the operation of the ArtLink action where two files are selected by the
Select File mechanism. Using the Select Grid button, a fixed Grid File can be used. If no Grid File
is presented, the Grid defined in the ArtPro file itself (if provided) will be used. This allows to set up
grid warp in ArtPro, and let Automation Engine do the actual calculation.

Import Picture List

With Import Picture List it is possible to import an ASCII text file containing information on name,
position and size of the bounding box of placed pictures.

These Picture List files can be created in ArtPro, using the Export Picture List function (see the
ArtPro Manual) or from any other application, if the ASCII text file has a construction as shown in
the example below. If not defined in the file, the placing is done on the box defined next to Use
Box, centering the image on the bounding box. The other options are the same as for opening an
ArtPro file.
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ArtPro Picture File V1.0

units mm

size 1005.72826.63

Bambolina1 -1.99 -1.99 142.4 126.99 0 16 32 TrimBox

Bambolina1 -1.99 125 142.4 125 0 16 32 TrimBox Bambolina1 -1.99 250 142.4
125 0 16 32 TrimBox

Bambolina1 -1.99 375 142.4 125 0 100 60 TrimBox

Bambolina1 -1.99 500 142.4 125 0 16 32 TrimBox

Bambolina1 -1.99 625 142.4 126.99 0 16 32 TrimBox

Bambolina1 140.41 -1.99 140.41 126.99 0 16 32 TrimBox

Bambolina1 140.41 125 140.41 125 0 16 32 TrimBox

Bambolina1 140.41 250 140.41 125 0 100 60 TrimBox

Bambolina1 140.41 375 140.41 125 0 16 32 TrimBox

Bambolina1 140.41 500 140.41 125 0 16 32 TrimBox

Bambolina1 140.41 625 140.41 126.99 0 16 32 TrimBox

Bambolina1 280.83 -1.99 142.4 126.99 0 16 32 TrimBox

Bambolina1 280.83 125 142.4 125 0 100 60 TrimBox

Bambolina1 280.83 250 142.4 125 0 16 32 TrimBox

Bambolina1 280.83 375 142.4 125 0 16 32 TrimBox

Flatten 421.23 0 292.24 413.32 0 16 32 TrimBox

Flatten 421.23 413.32 292.24 413.32 0 16 32 TrimBox

Flatten 713.47 0 292.24 413.32 0 16 32 TrimBox

Construction of a Picture List File

1. ArtPro Picture File V1.0
2. Units
3. Size; the job size, in the unit set above.
4. Filename; when importing a picture list, Nexus will place the pictures described in the Picture List

file, if the files are in the same folder as the picture list. If not, ArtPro will prompt for the specific file.
If the file is found in the folder or a file has been selected by the user, the picture will be applied
on the path, placing its center on the center of the bounding box.

5. Position of the bounding box; the position of the top left corner of the bounding box is defined.
The first value is the vertical distance from the top left corner of the job size, the second is the
horizontal distance.

6. Size of the bounding box; the next two values define the vertical and horizontal size of the
bounding box.

7. Rotation; the rotation can be 0, 90, 180 or -90 degrees.
8. Picture center offset, defining where to center the image, based on the topleft corner of the

bounding box.
9. Page box to be used.
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Importing

This action is probably the most important action and allows to Import PostScript 3 and PDF files in
to the native ArtPro file format (with full preflight and correction capabilities).

When a file is imported, typically all elements are made editable and all paths in the PostScript or
PDF document are converted to internal ArtPro paths.

This allows for imported documents to be edited with the Edit or ArtPro application. However, text
in the PS or PDF documents, in some cases will be converted to outlines (depending on the settings
in the Font Settings dialog box and depending on Creator of the PS or PDF file). This means that
although text can be added in Edit or ArtPro, text from the original document cannot always be
modified using the text editing functionality.

Importing Screening

1. Detecting Esko screening

When importing a PS/ PDF file containing Esko screenings, these screenings are recognized and
automatically converted to a PostScript screening with the correct Esko dot shape.

2. Different rulings / dot shape per separation

In ArtPro files, it is not possible to have screenings with different rulings or dot shapes per
separation. However, in Esko software these screenings can be defined. When importing such a
file, these screenings are split up into different ArtPro screenings. The objects using this screening
are split up accordingly and put on top of each other in overprint.

Importing Normalized PDF
Normalized PDF files can be imported just like any other PDF. Keep in mind that in Normalized PDF,
image links are included as EskoLinks.

1. Normalized PDF Restrictions
2. No support for Esko .ct file links

If you want to import normalized PDF back in Artpro, make sure the .ct files are embedded before
generating the PDF file in the Esko Software.

Page Settings
When opening the Import PostScript/PDF dialog box, the Page button is selected.

1. Import Page

If a multiple page PS or PDF document has to be imported, this setting defines what pages should
be imported. If Import Page is inactive, all pages of the PS or PDF file will be imported. This
function would typically be inactive, while the page range to be imported would be determined by
the Select Page action. This would actually invoke the importing action multiple times (creating
a document for every page).

If the Select Page action was not used for multipage documents, all pages would be imported
in one document. The positioning of the individual pages depend on the setting of the Multiple
Page offset option (see below).

If Import Page is active, only one page out of the multipage document will be imported. The page
that has to be imported can be entered in the Import Page field. The Import Page field can take
a string input (a page label) as well as a numeric input (a page number).

For PS files, the PS import has to jump to the right page of the file before starting import. (Selected
Only). However, some application define crucial information at the beginning of the PS file, on
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page 1 (example: Quark defines all fonts on page 1). Therefore, we have to interpret page 1 as
well (without generating output) before importing the selected page (First and Selected). In some
poorly constructed PS files, it is possible that the information needed for the selected page is
scattered over the pages in front of it. In that case, the option Until Selected should be used.

2. Ruler at top left

By default a PostScript or PDF file will be imported placing the PostScript origin (= 0,0) on the
center of the ruler. If you switch the option Ruler at top left on, the top left of the page will be placed
in the center of the ruler, placing the file in the lower right section. The origin in the PS file is in most
cases the bottom-left corner of the page, although this is not a general rule. Example: In EPS files
from Adobe Illustrator, the PS origin is the same as the origin of the ruler in the Illustrator file.

3. Multiple Page Offset

When importing a multipage PostScript or PDF file without a Select Page action in front, ArtPro
puts all pages with the 0,0 point in the center of the ruler. This results in multipage documents
being placed on top of each other. If you use the Multiple Page Offset, all pages are put next
to each other.

4. Import Separated File as Multipage

This option should be switched off in an action list. It relates to importing a separated file,
for example files using the %PLATECOLOR command to identify the separation name or older
separated PostScript files.

With the Import Separation File as Multipage on, all the elements of a separated file will come
in as grayscale, and the different separations will be treated as individual pages, so they will be
placed on top of each other, unless the Multiple Page Offset is on.

When importing a separated file with the Import Separated File as Multipage option off, the
Separated PostScript file converted to one (composite) ArtPro file with all the separations.

The individual paths coming from the different separations, will be merged together into a path
with the combined color information, based on the Merge Equal Paths option (see later). Images
will be recombined into one mapped picture.

Font Settings

1. Use Replacement Font instead of included Fonts

If this option is disabled the system uses the fonts in the file (if embedded). If they are not
embedded the system uses the fonts in the Fonts Folder. If this option is enabled the system uses
the fonts in the Fonts Folder first and uses the embedded fonts when the fonts are not available
in the Fonts folder.

2. Fail if Missing Font

When this option is enabled and fonts are not available in the Fonts Folders or embedded in the
PS or PDF file, an error appears on the Importing action when executing the action list, regardless
of the Preflight Settings (Cruise Controls). Use this option when no Cruise Controls are in use.

3. Fail if Courier

Similar to Fail if Missing Font, an error appears if there is a Courier font being used in the
document, regardless if it is a missing font or no missing font.

4. Convert to real text

When this option is enabled, the system attempts to convert the text in the document to real
editable text which can be modified in Edit or ArtPro. To do so, the font must be present on the
Edit or ArtPro system. Note that this option works only for files coming from certain applications.
Also note that only roman characters can be converted to real text. All other characters (special,
accented...) can not be kept, and will be vectorized.

5. Font Folders...
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It is possible to select multiple Font folders, in which system looks for fonts that are not installed
nor embedded in the PS file.

This allows importing a file with the fonts in a separate folder, without activating the fonts. Keep
in mind that these fonts are treated the same way as fonts embedded in the PS file, so all text are
converted to outlines. The font folder can be used for Type 1 fonts and Truetype.

To add font folders, go to the Font Folder..., click the + button. A dialog box appears to select
a folder. Click on the correct folder and click Choose. The font folder is added immediately and
system searches the folder and all subfolders for printer fonts.

A font folder is shown with its complete path. To stop using a font folder, simply select it from the
list and click the - button. The Reset button deletes all the font folders from the list.

The PS default fonts toggle makes system use a set of default fonts, like Helvetica, Courier, Times,
Symbol... They are stored in a folder called PS Fonts. On Windows, this folder should be on your
hard disk alongside the application file. On Mac OS, this folder should be inside the bundle of
the ArtPro Action List Editor.

This set cannot be modified. The system tries to use the embedded fonts first and then the font
folders.

You can open a File Naming Template dialog box allowing to define the name for the font folder
based on the job name, user name...

Color Settings
The Color Settings contain all separation related settings and determine how the custom colors or
CMYK separations are handled in the file. All functionality is available to either keep separations as
they are defined in the PostScript or PDF file, to convert them to CMYK or to merge them with another
separation. This can be done either in an automated way (example: Convert All Custom Colors to
CMYK) or for specific separations only which are known to be in the files that are processed.

This is discussed in the Custom Colors section. The list of the custom colors can be seen by clicking
the Custom Colors... button.

1. Single Separation

This option allows to import a single separation from a PS file or a PDF file. The name of the
separation is to be filled in the text field, example: “Black” or the name of any of the other
separations in the file to be processed. A typical example of the use of this functionality is double
burn or versioning, example: language changes, packaging versions, etc.…

To summarize an action list like this would handle folders containing two or more files, preferably
with a naming convention which identifies each version. For example, the English version of a
document could have the extension “_eng”, the Spanish version of a document could have the
extension “_esp”.

To simulate a plate change of black only on the press and allow for the merging of the black
plate of the Spanish version with the color plates of the English version following actions would
be defined:

a. Select file: English version.
b. Importing: CMYK of English version.
c. Save ArtPro file: English version.
d. Export PDF: English version.
e. Select file: Spanish version.
f. Importing: Black Plate only of Spanish version, the Remove Separation option will ensure all

Black from the English version is made transparent.
g. Save ArtPro File: English CMY with Spanish K.
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h. Export PDF: English CMY with Spanish K. (for example for proofing)
i. Close File: remove the file from memory.

This allows to actually proof the merged files exactly the way they would be put on press.
Since this merging takes place at the single file level, it is possible to identify potential problems
(example: moved graphics or images, text running through images, etc.…) early in the process
and physically correct them in ArtPro, even if the original documents are not available.

Double burn action lists are supported for single page as well as multipage documents, while
more than two versions are equally supported.

2. Remove Separation

When Single Separation is active, Remove Separation makes the original separation
transparent while the new separation from the file is being imported.

3. Force Black Overprint

When Force Black Overprint is checked, 100% black in the PS or PDF file is converted to all
transparent + 100% black in the ArtPro file. If Force Black Overprint is not checked (default),
all 100% Black in the PostScript or PDF file is treated as any other color, meaning that the result
depends on the Ignore all Overprints flag.

4. Ignore All Overprints

When Ignore All Overprint is not checked (default), overprint in the PostScript or PDF file is
converted to transparent in the ArtPro file. If Ignore All Overprint is checked, overprint in the
PostScript or PDF file is translated to 0% in the ArtPro file. This option can be used to take out
the trapping. Note that this option is not removing the transparent strokes, but only taking off
overprints. If both Force Black Overprint and Ignore All Overprints are switched off, the file is
not changed and can still be modified later.

5. Keep Screenings

This option keeps the screening definitions, if they were available, in the PostScript file or PDF file.
6. Fail on Nonseparable Blendmodes

A file to be imported can be set to fail if it contains Nonseparable Blendmodes (Hue, Saturation,
Color, Luminosity). These Nonseparable Blendmodes operate on a 3 component color space.
This means that to calculate the resulting color, CMYK needs to be converted to 3 components,
the Blend needs to be calculated and the result needs to be converted to CMYK again. However,
instructions on how these conversion from one color space to another should happen cannot be
given. This results in different behaviors and different color results in different applications / RIPs.

7. Fail if Transparencies in Incompatible Colorspace

If the file to be imported contains Transparencies (Blendmodes) on objects in incompatible
Colorspaces (example: RGB), the file fails when this option is switched on.

8. Fail if Transparencies imported on Existing Job

If PDF 1.4 transparencies are imported on top of a job containing any objects, this option causes
the job to fail.

9. Remove unused separations

This option automatically removes all separations that are defined in the file but which are not
used.

10.Convert C/CV/CVC/CVU/CVP to...

All the separations in the custom color list, that have a different extension only are automatically
converted to the one extension defined in this menu. So if there is a PANTONE 300 CVU,
PANTONE 300 CVC and PANTONE 300 CV, they all can be converted to example: PANTONE 300
CVC, automatically.

11.Convert CMYK to Hexachrome CMYK
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This option allows to replace CMYK by Hexachrome CMYK and thus allowing a smoother
integration with Hexachrome compatibility.

12.Convert all custom colors / Others

With this option checked, all separations in the file are converted to process colors, example
CMYK, based on the CMYK values for the separations as they are defined in the PS or PDF
file. The Others option is used for separations that are available in the file but not described in
the header. This should typically not be the case in a well constructed PS or PDF file, but does
sometimes happen. This option equally makes sure that these colors, if they appear, are converted
to process colors as well.

13.Custom Colors

The Custom Colors button enlarges the Color Settings menu with additional fields and a color
list which allows to merge PANTONE™ colors or selectively convert PANTONE™ colors to CMYK
without having to convert them all.

The additional fields that become available show a color list, a From and To field and an Add,
Delete and Reset button. In the example, some entries has been made in the color list: Blue is
merged into Reflex Blue. This is used if there are, for example, two special blue colors in a file
which need to merge together in one color. It is obvious that the names of the separations have
to be known before this action list is executed. If the Convert To color does not exist in the file,
it is automatically created.

To make an entry, type the name of the “From” separation in the left field (for example Warm
Red), and the name of the “To” separation in right field (example: PANTONE™ Red) and click Add.
Note that this first will leave the color (indicated by the color swatch in front of the entry in the
list) by default black. To change this, click on the swatch and set the desired colors as CMYK
values, these values will be used for display (for example when using ArtPro) and for proofing to
a CMYK device.

If a separation needs to be converted to CMYK, simply check the Convert button. Set Exclude
to keep the specified separation, even if Convert All Custom Colors is used.

To delete an entry from the list, select the entry and click Delete button. A Color list can be saved
to an external file, and loaded.

14.Color Management

Define different profiles for importing CMYK, RGB or grayscale files through Import PS. Click the
Color Management button to open the Import tab in the Color Management dialog box.

15.Color Book

The Color Book for import is the same (and uses the same UI) as the ArtPro color book. Custom
colors can be defined in import to be converted into the color book inks. This means, for example,
convert them into hexachrome values, if a hexachrome color book was selected. The selected
Color book is shown next to the Color Book button and an option is provided to turn it on or off.

Blends, Shadings and Gradations
Use this to define how gradients, blends and shadings should be handled on PS or PDF import. It is
advised to switch Recognize Gradations and Convert Shadings into gradations on, to recognize
gradations from most popular applications.

1. Recognize gradations (PS Only)

In a PostScript file, gradations can be described by a large number of paths or by a TIFF. In
most cases, these can be recognized and replaced by ArtPro gradations, if the option is checked
(default).
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With this option, gradations from Freehand and Illustrator are automatically converted into ArtPro
gradations or multistep gradations. Freehand and Illustrator vignettes which are not linear are
converted into multistep vignettes with midpoints. Gradations from QuarkXPress are converted
into ArtPro linear or multistep gradations.

If the option is not checked, depending on how the gradation was defined in the PostScript file,
it is imported as a series of paths, or it is converted to a TIFF image.

2. Convert Shadings into Gradations

PostScript Level 3 and PDF 1.3 and above often use the shading command to define gradations.
With this option, most shadings are converted into AP gradations or Multistep gradations. If this
option is switched off, an image is generated.

3. Convert blends into CT at

When blends are used in a document, they normally come in as a series of paths, with changing
paint styles. These blends are very difficult to select, modify,... Especially trapping becomes very
difficult. Therefore, usually blends are flattened into images, with one single path and one single
paint style.

With this option on, blends are even converted to internal ArtPro CT’s automatically. This means
the pictures are embedded in the ArtPro document in a ‘.ct’ file. The resolution for these images
can be set and the unit can be changed from pixels per inch to pixels per cm.

4. Resolution for Shadings

This option is for shadings that cannot be converted to ArtPro gradations (example: mesh
gradations). All these gradations are automatically converted and extracted as a TIFF image on
disk. The resolution for those TIFFs can be set here. Shading conversion to images is a very time
consuming calculation. Therefore, the default resolution is set to 50ppi, but a higher resolution is
recommended in some cases, depending on the shape of the object. Check the objects carefully.

Images generated during PS/PDF import always generate a mapped image.
5. Interpolate Shadings to 300ppi minimum

When working on certified or using Cruise Controls, it is very likely that lowres images generate
a warning or error. This would also happen for images generated when converting a shading.

To avoid this, the Resolution for Shadings can be set to a higher resolution (300ppi), but the
sampling of shadings at a high resolution is very slow and time consuming.

The option Interpolate Shadings to 300ppi minimum samples at a low resolution and creates
a higher resolution image from it. The lowres images are interpolated to a resolution higher than
300ppi. The resolution is a multiple of the sample resolution, example: if the sample resolution is
70ppi, the image after interpolation is 70 x 5 = 350 ppi. This results in a high resolution image,
generated at higher speed.

Links
This determines how links are handled upon import. With links we refer to either OPI links (%
%ALDImage commands) in PS or PDF files or references to EPS images in PS documents or
EskoLinks.

• Placing or importing

The different pictures that could be used in the original document are TIFF (with or without clipping
path), DCS, JPEG, PDF, EPS lineart, regular EPS image (with or without clipping path), EPS duotone,
tritones..., LoRes or HiRes images from OPI systems...

Most of these images can be brought into the ArtPro file in different ways:
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Most of them can either be placed or imported, depending on the kind of image and the desired
result. Example: When EPS images are imported, EPS is converted into a TIFF on disk and the TIFF
is placed in the ArtPro file. The big advantage is that the TIFF image can be mapped, which gives us
benefit for trapping, previewing, ink swapping, ink coverage... Therefore in ArtPro it is recommended
to work with mapped images (TIFF, JPG, Photoshop PSD and DCS) all the time.

Because of functionality, it is always recommended to map images upon import except for specific
cases like copydot images, PDF images, etc. When images are placed and not mapped, they remain
as they are (example: compression, content, etc.) and appear identically in the output as they have
been placed. This method is typically recommended for copydot images. Note that only TIFF images,
JPG images, PhotoShop PSD and PhotoShop DCS (without vector data) files can be mapped,
hence EPS images (any type, also DCS) can ONLY be mapped if they have been imported and thus
converted to a TIFF image on disk. Copydot images can equally be imported, (example: DCS copydot
– 1 bit data) but this is not recommended since the image would be decompressed while writing to
a TIFF file hence produce extremely large files.

Note:

TIFF images are not imported but only placed (and possibly mapped). Importing is only relevant for
PostScript images (for example: EPS images) which are then processed through the Import action
separately if “importing” has been set.

Summarized:

TIFF: A TIFF image can only be placed, not imported. A placed TIFF file can be mapped and thus
trapped automatically.

EPS image: An EPS image can be placed or imported. A placed EPS can not be mapped. When it is
imported, the pixels are converted to TIFF data. If the image has a clipping path, it can be converted
to an internal path with the image inside.

EPS graphics: If an EPS graphics file, example: a logo or chart, is placed, it can be transformed
(rotated, scaled,...) but not edited (it is treated as one object). By importing that same logo, all the
vectors are converted into internal paths which can be edited and trapped.

EPS duotones (+ monotones, tritones and quadtones): Can be placed or imported. An imported
duotone is correctly converted to a mapped picture. The condition here is that they should be created
with Adobe Photoshop 5 or later. Duotones from older versions of Photoshop are extracted as CMYK
images when imported, so these should be placed instead.

DCS: A DCS image is in fact a preseparated EPS. So the same rules apply. Importing makes it a TIFF,
which allows us to map, preview, trap,...But a DCS cannot be imported directly (example: dropped
in a hot folder to be imported), it has to be used in a PS or PDF file. In other words, if the DCS image
is placed in a (Illustrator, XPress,...) document that is saved out as a PS or PDF it can be imported
and mapped correctly.

OPI images (Open Prepress Interface): When OPI low resolution EPS sample images are used in
a document that needs to be imported, the images always have to be placed, if they are not
automatically replaced by their high resolution version upon import (see the OPI section). If they are
imported, completely new (low resolution) TIFF images which is not recognized and replaced by the
OPI server are created, resulting in a low resolution output. If low resolution TIFF images are used,
they can typically (for most OPI servers) mapped and further worked with (example: for trapping).

• Omit/ Embed

There are three ways to put an image in a PS or PDF file.

• ‘OPI’: The image is omitted (TIFF, EPS, DCS,...). This means the original picture is not included
in the PS file, only the link is available. The link is a path, indicating the place where the image
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can be found on the hard disk or anywhere else in the network (example: on the file server).
These PS/PDF files are obviously very small. They are quick to write and copy.

In the Links tab of PS/PDF Import, they respond to the settings under Omit. In the picture list,
under display links, these images have OPI: in front of the name.

• ‘EPS’: The image is embedded. The complete original picture as well as the link is included in
the PS file. This means in ArtPro we can choose which to use. These are usually EPS. They
respond to the settings under Embed. These images can be recognized in the picture list, by
the ‘EPS:’ in front of the name. These PS/PDF files are larger.

• The image can be completely embedded without the link. This is usually with TIFF images.
(Freehand is an exception. All TIFFs are always embedded in the PS files, with the link).
Because no link or name is available, ArtPro can not display these images in the picture list.
No link settings can be defined. These images are extracted to TIFFs on disk during import.

• EskoLink: These are linked images in a Normalized PDF. These act in the same way as OPI
links but use a different syntax. EskoLinks allow to define different density per separation and
allows the definition of separation remapping.

How to handle links on Import:

1. Use Link and Place All

The original file referred to by the link is searched and this file is placed. The embedded information
(if present) is ignored. The file is searched at its original location, unless the link is re-routed in the
Display links... part of the dialog box or if rerouting is defined in the OPI settings. If the image is
not found, the embedded information is used. If it is not available, the result is an empty path.

This setting is mostly used for TIFFs and JPEGs, omitted from the file, lores OPI images, single
file DCS or duotones from Photoshop (version 5 or below).

2. Use Link and Import EPS

The file referred to by the link is searched and this file is used. The embedded information (if
present) is ignored. If the file referred to is an EPS/DCS, it is imported, converting lineart to ArtPro
native lineart and extracting images to disk according to the settings in the Images settings. If the
file referred to is not an EPS or DCS (example: TIFF), it is placed.

The file is searched at its original location, unless re-routing is defined in the OPI settings. If the
image is not found, the embedded information is used. If it is not available, the result is an empty
path.

This setting has to be used for DCS and duotones (if you want them converted to mapped TIFFs).
It is also used if there is an OPI swap. In general, most OPI images have the same format (example:
EPS). ArtPro is rerouted to the hires. If that hires is an EPS.duotone/ DCS it is imported and
converted to a TIFF. In all other cases it is placed. This option is used for EPS, when they are
either omitted from the PS file or embedded and the original has been modified since.

3. Ignore All Links

The link is ignored and only the embedded information (if present) is used. This embedded
information is imported, converting lineart to ArtPro native lineart and extracting images to disk
according to the settings in the Image settings.

This setting is used for embedded (hires) EPS and TIFFs. There is no difference in result whether
you apply use link and import or Ignore all links. However, if the links are ignored, we need not
worry about ArtPro finding the original on disk (is the link correct?, does it need re-routing?,...).

When importing a PS/PDF file, 1, 2 or 3 needs to be chosen for all ‘omitted’ images (the ones in
the list with OPI in front of the name) and also for all the embedded images (the ones with EPS).

4. Extensions
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It is possible to override the above option settings with the Extensions fields. Consider the
example where all EPS images are linked and imported. Depending on the types of EPS pictures,
it may be considered to make an exception to this setting, example: one would not want to equally
import copydot EPS pictures. To avoid this, but still allow for other EPS pictures to be imported
and hence trapped, it is possible to work with an extension for the copydot images. If the copydot
images would be defined as “.cpd” (as an example), then typing “.cpd” in the Extensions field next
to Use Link and Place All would place ONLY the images with a .cpd extension, while importing
the others.

It is equally possible to add multiple entries in the Extensions fields separated by a space,
example: “.cpd .main .duotone” etc.…

5. Into Opacity: B/W, Gray, 5th Channel, Invert

With the Into Opacity options, you can define that linked TIFFs in the PostScript file should be
put into the opacity channel, and thus be made transparent.

1. B/W

If the B/W option is checked, all black&white bitmaps referred to by link are put into opacity
with a solid black image channel. So, all black pixels remain black and all white pixels become
transparent.

2. Gray

If the Gray option is on, all grayscales, referred to by link, will be put into opacity, with a solid
black image channel. The resulting CT will be black for the percentage of the grayscale, and
transparent for the remaining percentage.

3. 5th Channel

If this option is checked, a 5 channel TIFF referred to by link, results in a four channel internal
CT and the 5th channel is used as opacity channel. The areas of the Photoshop alpha channel
that were 100% masked, result in 100% image in ArtPro. The areas that were 0% masked,
become completely transparent. Any value in between (example: soft edges on the mask)
result in a partial transparency (see pictures). If the option Invert is on, the opacity channel is
inverted, using the Invert button in the Mapped Picture paint style. This way, the alpha channel
can be made up in two ways, positive or negative. With Into Opacity it is also possible to
work with extensions (see above): Example: B/W is off, gray is on, extension = .gr This means
all B/W is not affected and all grayscales with an extension .gr is put into opacity. All other
grayscales are not affected.

OPI
This is used for rerouting linked images. The rerouting could happen based on the name of the image
or based on the path of the images. There are mainly two reasons why rerouting may need to take
place:

• Low resolution images need to be replaced by (rerouted to) high resolution images.
• Missing images need to be rerouted to their correct (current) location.

Note:  Re-routing can only be done when OPI links are available for the images and the Use Link
and Place All or Use Link and Import EPS options are set.

1. Perform OPI swap

This option enables the rerouting as defined in this menu. If the option has not been set, all settings
are ignored and no rerouting takes place when OPI links are used by the system.

2. Sample Extension / Hires Extension
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The Sample Extension and Hires Extension fields are used to swap the extension of the image
that is linked. This is typically used for OPI servers which are set to add an extension to or replace
an existing extension with another when low resolution images are generated from high resolution
images.

Every extension that is entered in the Sample Extension field is cut off from the linked file before
it is actually searched, while every extension that is entered in the Hires Extension field is added
to the linked file before it is actually searched.

If the Sample Extension field contains “.lay” and the Hires Extension field is empty and the image
that is linked is “image.lay”, then the system actually searches for “image”, the “.lay” extension
is cut off.

If the Sample Extension field contains “.lr” and the Hires Extension field contains “.hr”, and
the image that is linked is “image.lr”, then the system actually searches for “image.hr”, the “.lr”
extension is cut off and the “.hr” extension is added.

It is equally possible to enter multiple extensions in the fields, separated by spaces. If the
extensions of the file referred to in the link matches an extension entered in the Sample Extension
field, the extension is cut off and when present, it is replaced by the extension in the Hires
Extension field at the same position. Extensions that only need to be cut off and not replaced
should be at the end of the list.

Example:

• Sample Ext. field: “.lr .low .lay”
• Hires Ext. field: “.hr .high”

The result of this operation is:

• “.lr” is replaced by “.hr”
• “.low” is replace by “.high”
• “.lay” is cut off

3. Sample Folder / Hires Folder

Similar to the Sample Extension and Hires Extension fields, the Sample Folder and Hires
Folder fields are used to reroute the system to search for an image in a folder different from the
folder determined in the path of the OPI link. In OPI swapping environments, this is typically used
for OPI systems that are set to generate low resolution images of high resolution images with the
same name but in a different folder.

Suppose all low resolution images are stored in a folder “ForLayoutUse” and all high
resolution images are stored in the folder “Originals”, both under the same subdirectory, then
“ForLayoutUse” would be filled in the Sample Folder field, while “Originals” would be filled in
the Hires Folder field.

When the OPI link in the file is then: E:/CustomerX/Images/ForLayoutUse/Image, the system will
actually search for and use: E:/CustomerX/Images/Originals/Image

It is also possible that one path is changed twice, for example: by putting multiple entries in the
Sample Folder or Hires Folder fields separated by spaces. This implies that there should be no
spaces in folder names that need to be replaced.

For example, if the Sample Folder contains “LR Customer” and the Hires Folder contains “HR”,
then the OPI path E:/JOBNR/ImagesCustomer/LR/Image is replaced by E:/JOBNR/Images/HR/
Image.

In the above examples, it is clear that all OPI paths have been generated by a system on Windows.
The above would work for cases where the front-end station creating the PostScript or PDF file
with OPI links is based on Windows and has the same mount point and drive letter for the image



2
Automation Engine

744

server as the Automation Engine. As in the first example, for both Automation ENgine and the
front-end Windows machine, E:/ is the network drive for the image server entered at the mount
point where the CustomerX folder is the first available subfolder.

It is clear that in a day to day production environment, the above situation is mostly hypothetical.
Indeed, mostly Macs are being used as the front-end, while if even Windows machines would be
used, they would often have a different mount point to the image server than Automation Engine.

In these cases, the Folder Mapping mechanism can be used to remap the drives for the OPI paths.

An example clearly illustrates this. Suppose the Image Server has following structure for the
images that are made available to the network: E:/Server/Images/…

Suppose that the Images folder has been made available to the Mac environment as Image Server
and this volume gives access to the content of the Images folder.

Suppose that the Server folder has been made available to Automation Engine and this folder is
mounted as a network drive under G:/, hence this G:/ gives access to the contents of the Server
directory.

If now an OPI link on the Mac is defined as: ImageServer:image then Automation Engine actually
needs to find: G:/Images/image To achieve this, we would enter “Image Server:” in the Client
field, while entering “G:/Images/” in the Server field. Clicking Add appends this definition to the
list. It is possible to have multiple OPI folder mappings active at the same time. The system
equally automatically converts between Macintosh notation of subfolders and Windows notation
of subfolders (: and /).

4. Root Folder

If a linked file cannot be found at its original location or at the location it is supposed to be found
after re-routing, the file will be searched for in the folder or volume that is defined as Root folder.
Nexus will not only search in the Root Folder but equally in all subfolders. When a Root Folder
has been defined, it is displayed underneath the Root Folder button. To remove the Root Folder
setting, click on the Root Folder button while holding the SHIFT key.

Note that Nexus will use the first instance of the file that it finds, which may be potentially
dangerous in production environments. Suppose the image to be found is called “logo.TIFF” and
the logo is not found at its location, Nexus checks the Root Folder and its subfolders.

Suppose in the production environment, two customer directories have been set underneath
the root folder directory: RootFolder/CustomerA/Images/logo.TIFF and RootFolder/CustomerB/
Images/logo.TIFF.

Even if the CustomerB logo needs to be used, the system always picks the first instance of the
name that it finds, in this case the logo of CustomerA! It is also not advisable (for speed reasons)
to select a complete disk or a very big image tree as root folder.

5. Exclude Folders from Search

When searching through the Root Folder, folders names entered in this field are not searched. This
can be used when all images can be found on the same volume, with the possibility to exclude
all folders containing low resolution files, example: all low resolution files may always be put in
folders called ForLayoutUse.

Image Settings

1. Vectorise Bitmaps: Always/ Most/ Never

When importing a PostScript or PDF file containing 1-bit images or a 1-bit image is detected via
OPI, this setting defines how to handle those.

When set to Never, the 1-bit images are placed as images. When set to Always, 1-bit images
are always vectorised. When set to Most, the 1-bit images containing more than 5mio pixels are
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placed, images smaller than 5mio pixels are vectorised. For example: This option can be used to
vectorise small logos but leave large scans such as copydot files, unmodified.

When vectorizing a Bitmap, the Precision can be set to Exact (no reduction factor and straighten
margin is applied), Fine, Normal and Coarse. For more information, refer the ArtPro Manual.

If a bitmap is placed as an image, the bitmap is converted into a Mapped TIFF with image channels
and an opacity channel. The image pixels constitute the image and the white ones are transparent
to the background.

Both a vectorised TIFF and a bitmap mapped TIFF are colored exactly like in the original
document. When importing a PDF file, the result is always a grayscale TIFF. In most cases a
vectorised bitmap is smaller and quicker to handle than a mapped TIFF.

2. Make Images Internal

After importing, all TIFF and JPG pictures (placed in the PostScript or PDF file or extracted by
Automation Engine) can be automatically converted into Internal Images in ArtPro, by activating
the option Make Images Internal. It is only used in exceptional cases. For more information on
internal images, see Chapter 5: Contone of the ArtPro Manual.

3. Extract included images

If an image has to be extracted on disk during PS/PDF import (see also Links), a file is saved to
disk. During Import, identical images are detected and deleted. This means that, if Automation
Engine extracts images from the PS or PDF file and writes them to disk, these images are
compared and if the same image is used several times, only one of them is kept. The comparison
is done after writing the TIFFs and before making them internal (if necessary). This comparing can
take some time but results in faster editing and smaller file sizes.

The File Name field in this dialog box is set to define how the extracted images of the PS or
PDF file is named and to what location they are saved. The path name in this case determines
where they are saved. If empty they are saved to the current job folder. It is advisable to use
the document page number in the Template, as otherwise some files can be overwritten with
multipage PS import and Select Page Action.

4. Resolution / Detect Image Resolutions

When images are extracted during the import of a PDF or PS file and the Detect Image
Resolutions in PostScript / PDF Import option is on, Automation Engine checks the internal
resolution of the image.

If this resolution is an integer (example: 360 ppi), the image saved uses this resolution and is
placed in the ArtPro file at 100% scaling. If the resolution is not an integer (example: 243,6 ppi),
or if the Detect Image Resolutions in PostScript / PDF Import option is off, the resolution as
defined in the Import PS/PDF dialog is used and the scaling is adjusted (in this case, the 300 ppi
image is placed at a scaling of 123.56%).

5. Use Original Name

When the original name of an image is known, the extracted file is saved with the original name if
this option is checked. If this option is off or the original name is not known, the user is prompted
for a name but by default the name of the PostScript file followed by .⇒ and a number is used.

6. Use Photoshop clipping path

If a PS file is imported, in which Photoshop TIFF files are placed, containing a clipping path, this
clipping path can be converted to ArtPro line art, with the TIFF file placed inside it’s path. This
option only affects TIFF files coming in with OPI. Clipping paths on EPS images are always used.
Another difference is that during Import PS, all paths are imported as straight line vectors, while
when using the Use external clipping path option when placing a picture, the curves are kept
as curves.

7. Recognize TIFF Channels
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When OPI linked pictures have to be placed, Automation Engine tries to recognize any spot colors
when placing a TIFF file and if the Recognize TIFF Channels is switched on.

A TIFF file can contain channels indicating masked areas (type1), channels indicating selected
areas (type2) and channels indicating spot colors (type3).

Channels of type 1 and 2 are treated as alpha channels, thus put into the opacity channel. If the
TIFF contains more than one alpha channel, only the first is used and all others are ignored, though
the separation are generated based on the channel names present in the TIFF. These separations
have CMYK value 0, 0, 0, 100 and only reflect the number of channels in the TIFF.

If spot color channels are found, a separation is created with the same name as the TIFF file
channel.

The color definition (CMYK representation) for this spot color is first searched in the ink book. If
not found there, the color information from the TIFF file is used.

If ArtPro encounters an unknown color space, a new separation is created with the channel name
and with CMYK representation 0, 0, 0, 100.

General Settings

1. Clip Text

Text that was clipped in another application is clipped in ArtPro as well after Import PostScript/
PDF. In order to make this possible, though, clipped text is vectorised in ArtPro and thus no longer
available as real text. Normal text (not clipped) is not affected by this option, which is checked
by default.

2. Merge Equal Paths

If Merge Equal Paths is unchecked, all paths are converted to ArtPro in the normal way. If
checked, two or more identical paths on top of each other are merged into one single path with
the combined color information. This option is automatically enabled for separated files.

3. Recognize Illustrator Layers / Merge Equal Layers

When checked, all the original layers from imported Illustrator (<9) EPS files are recreated in
Automation Engine and all the elements are put back on the correct layers. All PDF files containing
PDF 1.5 layer information, also generate the correct layers in Automation Engine. Make sure to
generate PDF 1.5 output from certain applications (example: Illustrator CS) to include all layer
information.

If unchecked, all vectors are put on one single layer called PostScript Import. This option can be
used with or without Merge Equal Layers. If Automation Engine finds multiple layers with the
same name, those layers are merged into one (example: An EPS with a ‘Dielines’ layer is imported
on an ArtPro template with ‘Dielines’ in it). It is possible in Automation Engine to have several
layers with the same name.

4. Ignore Page Commands

In a normal PostScript file, the document size is defined at two places: the bounding box, in the
header of the file and page commands, later in the PostScript. In most cases, the Page Commands
are more exact than the bounding box. For files coming from certain versions of Barco systems,
the Page Commands are rounded off, while the bounding box is exact. In those cases, you can
choose to Ignore Page Commands and use the PS bounding box instead.

5. Keep Strokes

When checked, all strokes found in the PostScript or PDF file are imported as ArtPro Strokes. If
the option is unchecked, the strokes are converted to regular ArtPro paths.

6. Memory
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This parameter indicates how much Virtual Memory is allocated to the Import function, in order
to store its variables, key words, dictionaries, etc. Generally, 20000 kB (default) is sufficient to
perform the function. However, when the error message VMError appears, the value should be
increased.

Certified PDF

When importing any file type other than PDF, the Sessions log indicates that no input profile was
applied and the session begins AFTER the import.

• Importing non-Certified PDF

When importing a non-Certified PDF file and Certified Import is enabled, Automation Engine
Certifies the PDF file and import the Certified PDF instead of the original. Unless Overwrite input
file on re-preflight is checked, a new certified PDF is saved (according to the Template settings)
and this certified PDF is imported. This is saved as a separate session.

• Importing Certified PDF

1. Re-Preflight if profile does not match: Selected

The job is re-preflighted if the input profile and the embedded profile do not match. If they match,
the session log indicates that both profiles are identical. When comparing two profiles, their
content is checked and not just the name.

2. Re-Preflight if profile does not match: Unselected

The Certified PDF is imported without re-preflighting it. The Session window indicates the profile
it was originally certified by.

• Re-preflight

When Re-preflighting, Automation Engine creates a new session, preflight the file and close the
session. The file is saved according to the File Naming Template settings.

1. Overwrite input file on re-preflight

When checked, there is no new PDF file created by Automation Engine. Instead, it replaces the
original PDF file.

2. Get all bounding boxes for preflight report

When checked, this option forces Automation Engine to obtain bounding boxes for the last
preflight report. If activated, it gets full information for every report item along with bounding box
of the area where the error/ warning occurred. This causes an additional preflight of the input
document and consume additional time.

Cruise Controls (Preflight Settings)

This dialog box is used to set a preflight profile.

Several controls are available which are split up in four categories: Lineart Color Controls, Image
Controls, Object Controls and Text Controls. These controls are found in the left pane. Clicking the
triangle in front of each of the controls will show the available controls for that category.

In the right window the selected controls, for example preflight settings, are shown, each with an
either green, orange or red circle in front. The color determines the severity of the control: red refers
to error level, orange to warning level and green to note level.

To change the severity level for a preflight item, click on the preflight item and select the appropriate
severity level from the dropdown menu. To add a preflight item to the list, double-click on the control
in the left window.
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To remove a preflight item from the list, select “Delete Control” from the contextual menu, or select
it and press Cmd - Backspace.

The Save Controls, Clear Controls and Load Controls buttons allow to respectively save all the
selected controls with their severity level to a file, clear the list or load controls and their severity level
from a previously saved file.

Note that a job is not held based on preflight, in the case of a warning level or error level there is
only an exclamation mark in front of the job in the Job list indicating that the error button should be
clicked to verify the error log information for that specific job. However, even if there was a preflight
error, the job still continues to run until completed!

When preflight has been performed for a file and the file has been saved it contains a complete Cruise
Report (preflight report). Using ArtPro it is possible to view this report and actually use it to navigate
to the appropriate object in the file that triggered that specific entry in the Cruise Report.

By switching on the Save Report option, a preflight report can be saved in PDF format to the location
specified in the Template. Using an E-mail action, this report can be emailed as an attachment, using
a Select File action to select the PDF file only.

Following are the different Cruise Controls or preflight settings which are available:

1. Info

With these settings, information about the imported file can be found:

Filename: The original name of the imported file

Format: What file format the imported file has (as found in the header of the file)

Title: Title of the document of which the imported file was created

Creator: Application in which the imported file was created

Date: Date on which the imported file was created

Type: What type of file was imported (Comp. / Separated)
2. Lineart Color

* Overprint: Overprint defined in the imported file is detected. Overprints in a document could
indicate that the file may already contain some trapping.

* Custom Colors: Using this control, get notified when and where a custom color is used in the
imported file.

* Ink Coverage: Ink coverage can be checked not to exceed a given percentage, example: 300%.
This is used to find a common error, like the use of registration color, where simple black was
needed.

3. Image

This category contains all controls to avoid most common errors in images.

* Resolution: if the resolution of all images used in the imported file is bigger or smaller than 72,
300, 1000 ppi or a freely entered value, a warning is generated. This can point out low resolution
images or images with an excessive resolution. Very important to know here is that ArtPro takes
the scale factor of an image into account. The real resolution is the scan resolution divided by the
scale factor in % and multiplied by 100. The real resolution of a 300 ppi image scaled to 200% is
150ppi. The real resolution of a 72 ppi image scaled to 20% is 360ppi.

* Color: Images in the specified color space (RGB, CMYK, LAB, Separated or grayscales) can be
found. This could also be very useful because ArtPro does not support any RGB images.

* Links: With the Link settings, OPI or EPS comments can be checked:
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OPI Comments: indicates if OPI comments were encountered in the imported file.

OPI Recognized: indicates if the found OPI comments were used.

EPS Linked: indicates if linked EPS files were encountered in the imported file.

EPS Imported: indicates if these found EPS files were imported (instead of being placed).
4. Object Kind

Object controls offer the possibility to point out objects smaller or bigger than a given value. For
example, to avoid hair lines or small text printed in flexography.

* Text: text smaller or bigger than 12pt, 6pt or any entered value can be looked up and reported.

* Strokes: strokes can be checked for size to be bigger or smaller than 2 mm, 1 mm, 0.5 mm or
a user defined value.

5. Text

Text controls contains three criteria for font control:

* Font Missing: A criteria can be set to search for missing fonts during import. ArtPro reports if no
font information was found at all, meaning the printer as well as screen fonts were missing.

* Font Name: If a font, used in the imported PS or PDF file matches the name entered here, a
warning is displayed. This way, the system can notify the operator when for example, a courier
is used in a file, for this is often a replacement font.

In the definition of the font name, a wild card can be used. If you enter Cour*, all font names
starting with "cour" are found, including courier bold, courier italic, etc. The name is not case
sensitive.

To add controls to the list, double click on the control or select it and click on the button with
the arrow to the right. To remove controls from the list, select it and click on the button with the
arrow to the left.

* TrueType: checks if TrueType fonts were used in the imported file.
6. Transparency

Transparency controls contains three criteria:

* Blend Modes: A criteria can be set to search for used blend modes.

* Opacity: If an opacity higher, lower or equal to the entered value is encountered. If set to “Lower
than 100%” is set, all objects with an opacity other than 100% trigger the control.

* Opacity Masks: checks if Opacity Masks were used in the imported file.
7. Preflight Report

The Preflight Report allow to get information from the PDF Preflight Reports. This of course only
applies on importing PDF files that were preflighted. The Cruise Controls that can be used are the
three levels of Preflight report: fixes, warnings and errors.

Please note that Bounding Boxes for preflight entries are only available if the file was preflighted or
re-preflighted during import, with the Get all bounding boxes for preflight report option selected
(see above).

Ink Coverage

The Ink Coverage action calculates the surface ink coverage of the document and saves the
information as a text file on disk. The Template Editor button again determines the naming and
location of the file.
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Per separation in the job, a value is given as a percentage and as a surface coverage (example:
square mm). Equally a total surface value is given.

Note:

In the case of pictures, ink coverage only works when there are mapped pictures or when placed
ArtPro pictures contain a separated preview. In other cases an average value is used. When using
ArtPro, this average value can be adapted in the paint style. The only relevant setting in this action is
the samples per inch that is taken which determines the accuracy of the ink coverage. After running
the job, the results can be seen in the Job Editor.

Ink Coverage Check

Ink Coverage Check verifies if the amount of ink does not exceed the Ink Limit.

Special separations such as opaque separations, die or transparent separations can be excluded.
The page box to be used can be set, as well as the resolution at which the job needs to be rasterized
for checking.

Join

The Join Paths function joins the two nearest open points of the selected paths with a straight line.

This is repeated until no open points are left.

Insert ArtPro file

This action inserts an existing ArtPro file or picture into the file which is currently being processed.

The file that is inserted can either be a fixed file (name is selected in the Insert File window) or a
file which has been determined by a previous Select File action (in this case the file to be placed
would be selected from a folder which is dropped in the hot folder) or a file which has been generated
elsewhere in the action list. An example of the last case is the result of a Difference action that needs
to be inserted (place as picture) in a new ArtPro file.

The insertion is done on the bottom right quadrant of the current position of the ruler, determined by
the position of the ruler in the Importing action, the position of the ruler in an opened ArtPro file or
the position of the ruler after the Move Ruler action.

Browse

Allows to physically select a fixed file from the system. Click Browse to open the Browse menu.
After selection the name of the file with its full path is displayed underneath the Browse button.

When no file is selected, the file to be inserted needs to be determined by a previous Select File
action in the action list.

Overwrite separation angles and frequency

When inserting an existing ArtPro file, the system loads colors correctly. If separations were different,
Automation Engine adds the appropriate separations in the separation table. When there are identical
separations, this option overwrites the angles and frequency of the current separations with the
values of the file that is being inserted.
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Merge Layers with Same Name

The ArtPro file format supports layering. When this option is set, content of layers in the inserted
ArtPro file is merged with content of layers in the current file, if they have the same name.

Ignore Screening Errors

Since Extended Screenings are stored differently in newer version of the application, opening a file
from older version may result in a conversion of the screening. If this conversion fails, the job fails,
unless the Ignore Screening Errors option is selected. As a conversion error means the screening
settings are changed, it is advised to use the this option only for action lists that do not have any
screened output or if screening settings are defined in the action list itself.

Place as picture using

This option is used for placing image files or treating an ArtPro file as a picture (which would mean
the content of the ArtPro file is not available, for example, for trapping or internal modifications).

Supported picture types include EPS, DCS, TIFF, PSD, ArtPro, PS, PDF and TIFF/IT.

When the Place as picture using option selected, the drop-down menus present beside this are
enabled which can be used when inserting a file with it to place the selected file as a picture inside
the open file.

At the time of inserting, a rectangle is created of the same size as the border defined in this popup
menu, in which the file is placed as a picture. The Align picture on option can be used to define
on what border the placed file should be positioned. The top left corner of the selected border is
placed in the center of the ruler.

For example: combination of both options allow you to place the inserted file positioned on its trim
box (top left corner of the trim box in the center of the ruler), but place it inside it's bleed box.

Place Single-Separation ArtPro File in Single Separation

This option defines how to handle inserting ArtPro files with only one separation. If the option
is switched off, objects in this AP file with 100% of the single separation are considered to be
registration color. Thus they get 100% of every ink in the ArtPro file after insertion. If this option is
selected, the file is inserted in one single separation instead.

Recognize TIFF Channel

The Recognize TIFF Channel Option allows to recognize TIFF Channels when inserting a TIFF File.

A TIFF file can contain channels indicating masked areas (type1), channels indicating selected areas
(type2) and channels indicating spot colors (type3).

Channels of type 1 and 2 are treated as alpha channels and put into the opacity channel. If the TIFF
contains more than one alpha channel, only the first is used and all others are ignored, though the
separation are generated based on the channel names present in the TIFF. These separations have
CMYK value 0, 0, 0, 100, and only reflect the number of channels in the TIFF.

If spot color channels are found, a separation is created with the same name as the TIFF file channel.
The color definition (CMYK representation) for this spot color is first searched in the ink book. If not
found there, the color information from the TIFF file is used.

If Automation Engine encounters an unknown color space, a new separation is created with the
channel name and with CMYK representation 0, 0, 0, 100.
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Layer Versioning

The Layer versioning action allows to create multiple ArtPro files from a single file, based on its
layers. The Base Layers are used for every ArtPro file, while every Version Layers results in a
separate ArtPro file. This can be used, for example, to split up a file with layers “Base graphic”, “Base
Text” “English” “French” “German”, into 3 files: everyone having the Base layers and one with the
French, one with the German and one with the English layer.

Base Layers
The Base Layers are the layers that are used for every ArtPro file. These can defined by name or
by range. When defining a base layer by name, it can be added to the list by clicking the + button.
Layers can be removed from the Base Layers list by selecting it and clicking the - button. The name
of a layer can be defined by doubleclicking it in the list. When defining the name of the Base Layers,
wildcards (*) can be used.

When defining the range, you can, for example, define that layer 1 - 3 are base layers.

Version Layers
The Version Layers can be defined by the user or it can be set to use all non base layers as version
layers.

When defining the Version Layers, you can add and remove versions. The Template key for a version
can be used in the File Naming Template in order to define the names of the resulting ArtPro File. For
every version, you can define what layers need to be used. If the option is selected and the entered
Layer is not found in the original ArtPro File, the action fails.

The option Ignore Case In Layer Names defines whether the definition of layer names should be
case sensitive or not. If other layers than the ones defined in the versions and base layers are found,
the action fails if the option Fail if extra Layers found is selected. This option is disabled when the
All Non Base Layers option is selected for the Version Layers.

When saving the various ArtPro files, you can define if the file needs to be saved with preview (and
its resolution) and if the Certified PDF information should be included.

Make Compound

With Make Compound all the selected paths will become one single object.

Where paths are overlapping, a look-through window to the background is created.

For a more detailed description, please refer to the ArtPro manual.

Make Thumbnail

Make Thumbnail is an action to create a TIFF or JPEG preview of an ArtPro file.

Resolution can be set up to 120 dpi. Noise for gradation can be set. There is no oversampling.

Compression can be set to TIFF, High Quality JPEG, Medium Quality JPEG or High Compression
JPEG. The Template can be used to define name and location of the thumbnail.

Modify Layers

The Modify Layers action allows to change the settings of layers. In the Layer fields you can enter
any number of layers, using full name or a wildcard (*).
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If the Matching option is selected, all layers matching the entered string are affected. If it is not
selected, all layers NOT matching the string are affected. This allows, for example, to select all layers
except “varnish*”

With the checkboxes you can set the layer(s) to (in)visible, (un)locked or (non-)printing.

If a layer name is not found, this line is ignored. However, if the “Abandon” option at the end is on,
the rest of the action list is abandoned.

Layers with hidden, locked or non-printing checks, stay like that until other Modify Layers actions
remove check or until the action list closes the ArtPro file.

Modify Paint

The Modify Paint action allows to modify the paint (in percentage of a given separation) of objects
or selected objects, change the overprint, or modify the start and end color of gradations.

Modify Screen

This action will apply user defined screening parameters to all selected objects.

The screening parameters in this case are PostScript based. The Dot Code field allows you to enter
a PostScript string to execute your own personalized screening.

Use a Screening set allows to select a screening set as saved in ArtPro based on the name in the
Screen field. The file can be selected using the Browse button. See the ArtPro documentation for
a full description.

Modify Separations

The Modify Separations allows to change settings for separations.

Rename C/U/CV/ CVC/CVU/CVP to
This allows to convert different CVC flavours to the same extension.

Delete CMYK Flags
This allows to remove CMYK flags. These flags indicate what separations should be handled as
CMYK (for placing pictures, importing PS files, etc.) even if they are replaced by spot colors.

Separation list
The separations are selected by name. Wildcards can be used, example: “Die*” selects all
separations whose name starts with Die. Separations are added by clicking the + button.

Rename
A separation can be renamed by entering the original separation name and the new separation name
and check “Rename”. Note that renaming is NOT the same as remapping !

Create
A separation can be created by entering the separation name and check “Create”. In the example,
a separation PANTONE Red will be created.

Set to

1. Remap
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A separation can be remapped by entering the original separation name and the “target”
separation. If the Target separation does not exist, the job will fail.

2. Convert to CMYK

A separation can be converted to CMYK by entering the name of the separation and entering
“CMYK” as target.

3. 0 / Trans

A separation can be set to knockout by entering “0”. All objects containing “trans” for that
separation are changed to “0”. By entering “Trans”, the separation is set to overprint, changing
all “0” values to “trans”. The Apply on Selection can be used to set the desired separation to
0% or Trans only for the selected objects.

4. Opaque / Die / Trans

Allows to set the attribute of a separation to opaque, die or transparent (varnish).

The Opaque/ Die/ Trans information is used in the JDF export and in the Vector trapper action.

Move Ruler

Every document in Import has a ruler position, depending on how the ruler position was set when
importing a file or when opening a file.

The Move Ruler action moves the ruler within the current file to a new position based on an offset
from the current ruler position or an offset from the position of any of the corners or centers of the
pageboxes. This offset is set by the Vertical and Horizontal fields. This is very useful when pictures
or other files need to be added to the current file at an offset from the ruler position or any of the
corner or center points of one of the pageboxes.

Nested Step and Repeat

The Nested Step and Repeat action is based on the PowerStepper module in ArtPro.

It is used to make step and repeat based on the MFG (ArtiosCAD), CFF2 or DDES information. MFG,
CFF2 and DDES files are generated on CAD/CAM systems to create die cuts (example: Dimensional
Impressions’ “Score”). Through this action these files can be used to automate the step and repeat
process without having to calculate positions, rotation and nesting. For a full explanation of the
Nested S&R functionality, we refer to the ArtPro Manual.

The action typically needs two files as input:

• The CAD file
• The ArtPro file

The CAD file can also be specified in the action settings.

Nested Layout File Format

Instead of selecting an image, the user can also select a ‘layout’ file, that contains the names of
several images, together with information on where they should be placed.

Layout files are tab-separated text files with a small header. Here is an example:

ArtPro Nested S&R Layout V1.0

JokerBoxBerries.aw 1-35

JokerGreen3.aw 46-7
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The first line identifies the file as a ‘layout’ file that can be used for Nested S&R. It is followed by an
empty line. Each following line contains the name of an image and the station numbers at which these
images should be placed. In the example, the file ‘JokerBoxBerries.aw’ is placed at station numbers
1 through 3 and 5 and the file ‘JokerGreen3.aw’ is placed at station numbers 4 and 6 through 7.

When using a layout file, you can deselect the option Filenames in Layout File must match and
provide the files to be placed using a Select File before the action.

Open ArtPro File

This action opens an existing ArtPro file, either input through the Apply ArtPro Action List task,
generated earlier in the action list or defined earlier in the action list (example: through the Select
File action).

When an ArtPro file is dropped in the hot folder, the line art file AS WELL as the CT file (when available)
need to be dropped. The system automatically selects the line art file for opening while recognizing
the appropriate CT file. In order for this to work correctly, the corresponding action list has to be
created with the option Preserve Filenames active. This makes sure that the appropriate line art
and CT file names are not modified by the system which would result in the system not finding the
CT portion of the file.

The Open ArtPro File action contains functionality related to used images, used fonts and color
management. Although an ArtPro file can contain a line art portion and a CT portion (for internal
images), an ArtPro file can equally contain LINKED images, these are images which are used in the
ArtPro file but which are not embedded in the CT portion of the file.

The Open ArtPro File action contains four main portions: Root Folders, Folder Mapping, Fonts
Folders and Color Management.

Root Folders
When images were used residing on the front-end Macintosh or on a server which can not be
mounted on the Nexus system, the Root Folders functionality can be used to define where Nexus
has to locate linked images which are used in the ArtPro file for opening.

In this example one Root Folder has been defined: E:/AE/ AP_files. When an ArtPro file that contains
linked images which were previously stored on a local Mac needs to be opened, they need to be
copied to this folder or a subfolder of this folder first. A Root Folder can be added by typing in the
appropriate path and clicking the Add button or by selecting it through the Browse mechanism.
Equally, a Root Folder can be removed by clicking the Remove button.

Multiple Root Folders can be set, when opening an ArtPro file, Automation Engine goes through the
respective root folders (and subfolders) until the image has been located.

Note:  You can use a File Naming Template to locate the root of the images.

Folder Mapping
The Folder Mapping mechanism can be used when images which are residing on a server and which
can be mounted on the Automation Engine are used.

As an example, in the ArtPro file, the path of an externally linked image can be defined as:
Intel_Mac:images:image1.

Obviously, on the Automation Engine, the file server would be mounted at a different mount point
with a different name. Typically the image server would be mounted to a drive letter, for example, G:.

To allow Automation Engine to automatically locate images on the Image Server when opening an
ArtPro File, the Folder Mapping mechanism allows to substitute a portion of the path name used in
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the ArtPro file with another name. In above example, Intel_Mac would be substituted with G:/, which
would tell the Automation Engine to find above image as G:/images/image1.

To define a Folder Mapping substitution, enter the respective fields On Client (how the local
Macintosh sees the file server) and On Server (how the AUtomation Engine sees the file server) and
click Add. Similarly, Folder Mapping substitutions can be removed by clicking the Remove button.

Fonts Folders...
When live text has been used in the ArtPro document, Fonts Folders can be used to allow
Automation Engine to extract the outline information from the Mac fonts for trapping, printing,
exporting, ArtLink functionality, etc.… Please note this is only valid for Type 1 fonts and Truetype
fonts.

To define a fonts folder click the Add button and browse to the appropriate folder. Similarly, fonts
folders can be removed by selecting them and clicking the Delete button.

Although the ArtPro file format (version 6 and onwards) contains all the outline information for live
text in the document, the font is still important for special functionality like ArtLink, Regmarks, etc.
… By clicking the folder icon next to a font folder, you can select Edit, which opens a File Naming
Template dialog box allowing to define the name for the font folder based on the job name, user
name,...

Color Management
This setting determines if color management has to be applied during the action list. When enabling
color management, it is possible to select a color management settings file, previously saved by
ArtPro. This file contains all ICC profiles and settings to determine how color has to be treated
throughout the rest of the action list, including ICC profiles for proofing, printing, etc.

Tip:

You can use Make SMB Compatible to rename all the linked images with a crossedge sign (⇒). This
character will be replaced by an underscore. Use this option to make these images compatible with
Windows fileserver. In this case, the ArtPro file should be saved to disk so that the image links point
to the renamed images.

If the ArtPro file itself contains a working space different from the one defined in the Color settings
file, the action list stops if the option Stop when working space profiles are different is checked.

Map Pictures
If the Map Pictures option is selected, images are converted to mapped pictures if possible. For
more information on Mapped Pictures, we refer to the ArtPro documentation.

Ignore Screening Errors
Since Extended Screenings are stored differently in files from older version, opening a file from
them results in a conversion of the screening. If this conversion fails, the job also fails, unless the
Ignore Screening Errors option is selected. As a conversion error means the screening settings are
changed, it is advised to use the Ignore Screening Errors option only for action lists that do not
have any screened output or if screening settings are defined in the action list itself.

OPI Generation

The OPI Generation action allows to generate low resolution images from high resolution images,
example: for use in a page layout environment.
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In this action the resolution and format (TIFF or EPS) can be selected. When a document is printed
with Omit Images, the Importing action can then recognize the OPI comments in the PostScript or
PDF file and reroute back to the high resolution images.

Optimizing

The Optimizing action deletes (parts of) the contours that are not needed to produce correct print
output. The function makes it possible to “clean” or flatten a document, removing all the superfluous
and unnecessary paths. For each path the program checks all the contours on top of it and decides
which objects should be cut, united or left untouched to maintain the same structure in the job.

Optimize is especially useful to eliminate unnecessary contours from an imported PostScript file, to
perform faster trapping, faster printing,... Keep in mind though, that the objects are typically less
editable after optimization than before. We hence only recommend to use the Optimizing action for
complicated graphics documents.

The effect of optimizing are, the graphics look a lot cleaner and are faster to print and trap. However,
the editability is considerably reduced.

PowerTrapper

The PowerTrapper dialog box is used to make trapping settings.

1. Choose your trapping settings in the Distance & Direction, Color & Shape and Processing tabs.
2. If needed, define trapping rules using Add Rule.
3. Save your trapping settings as a Trap Preset to be able to reuse them on another document.

Distance & Direction

1. Trapping

You can choose between two trapping modes:

• Normal Trapping: This selects adjoining color pairs, which are likely to cause registration
problems like ugly light gaps, and unwanted halo effects. PowerTrapper Standalone
automatically chooses the most appropriate trap direction based on the relative luminance of
the adjoining colors. Lighter colors are generally trapped into darker colors to minimize the
visual effect of the trap.

• Reverse Trapping: This prevents overprint of adjoining color areas by trapping these color pairs
with a white knockout (erasing) trap. The white knockout trap is put on top of the lighter of
the two colors.

This is useful to prepare a job for Dry Offset printing (example: metal beverage cans) where
overprinting of inks is not allowed as the inks would contaminate each other on the blanket.

2. Trapping Distance

Enter the width you want to give your traps. The unit used is the General unit defined in Illustrator's
Unit & Display Performance Preferences. The default trap width is 0.2 mm (or equivalent in your
chosen unit).

3. Minimum Ink Difference

Trapping is applied to two adjoining colors when:

• the two colors each consist of at least one ink but they have no common inks.
• the two colors have common inks but there is a difference of at least the Minimum Ink

Difference percentage for two or more inks making up these colors.

These differences in ink percentages must be in opposite directions.
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For example, with the default minimum ink difference percentage of 10%, the following two colors
are trapped:

1st color: C 5% M 10% Y 50% K 15% (+10% K)

2nd color: C 5% M 10% Y 85% K 5% (+35% Y)

Increase the Minimum Ink Difference to trap colors that are more different, lower it to trap colors
that are more similar.

4. Image Trapping

• Automatic (default): this determines the most suitable trap direction automatically, by
comparing the average lightness of the CT image with the lightness of the adjoining area, then
traps the lighter color into the darker one.

• Always Towards Images: this always traps line art under adjoining CT images.

• Always Towards Line Art: this always traps CT images under adjoining line art.
5. Pull Back

An ink pull back keeps away all but the darkest ink of a color area composed of multiple inks that
borders to a very light background.

It prevents individual inks from the composed color to become visible on the background due to
registration errors during the printing process.

• Automatic (default): this creates pull backs on rich black or rich spot colors, when the color
left in the pull back area is not very different from the composed color.

• Only Pull Back Rick Black: this only creates pull backs on rich black.

• Do Not Pull Back: this never creates any pull back.
6. Advanced Settings

Expand the collapsible button to view the Advanced Settings.

1. If you want to use a different distance when trapping into black, spot colors, images or when
creating pull backs, enable the corresponding option and enter the trapping distance to use.

The unit used is the General unit defined in Illustrator's Unit & Display Performance
Preferences.

2. Image Trapping

If you want images to be trapped with each other, enable Trap images to images.
3. Pull Back

If you chose to use Automatic pull back (see Pull Back), the Also pull back light inks option is
available. Enable it if you want to create pull backs even when the pullback ink (ink remaining
in the pull back area) is visibly different from the composed color. Enable Do not pull back
images and gradients if you do not want to create pull backs on images and gradients.

4. Overshoot Mode

You can choose between the following three overshoot modes:

• Automatic (default): The centerline behavior is according the rules determined in the color
pair list.

• Never on Dark Areas: The centerline is forced not to get beyond the center of dark areas.
• Never: The centerline is forced not to get beyond the center of any area.
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Color & Shapes

1. Trap Color Intensity

By default, PowerTrapper uses the full color of the object to spread in the trap (100% trap color
intensity).

However, you can create a trap of a lighter color by reducing the trap color intensity percentage.
2. Image Trap Color

Choose how to trap your images:

• Use Original Image Data (default): When spreading an image, PowerTrapper uses the
underlying image data (when the image is clipped) to create the trap.

Note:  When there is no underlying image data (the image is not clipped), it creates an empty
trap.

• Extend Image Data: PowerTrapper automatically extrapolates the image along its top, right,
bottom and left edges to ensure that the trap looks as expected even if there is no clipped
image data outside the visible image.

• Use an Approximate Flat Color: Instead of using existing or extrapolated image data in the
trap, PowerTrapper uses a solid color. A suitable color is determined by averaging the image's
colors along its boundary with the object to trap.

3. Truncate Traps

PowerTrapper can truncate the trap so that it does not stick out on another color. There are two
truncation modes:

• On Center (default): when a portion of a trap comes too close to the contour of another object,
PowerTrapper limits it to half the distance between the trapped object and the other object.

• On Edge: when a portion of a trap comes too close to the contour of another object, it is
truncated on the other object's edge.

4. End Caps

This option specifies how to shape the ends of an open trap.

• Square (default): this option ends the trap at right angle to the adjoining object.

• Round: this rounds the ends of the trap. This option is typically only used in combination with
white knockout (reverse trapping).

Note:  We recommend you not to use Round End Caps together with Truncate Traps On
Center, as this can generate some artefacts (the round caps are truncated).

• Object Dependent: with this option, the trap is a logical continuation of the contour of the
spread object.

5. Trap Corners

This option allows you to change how the traps’ sharp corners are handled.

• Round (default): a round cap will be placed at all corners.

• Beveled: this cuts sharp corners off.

• Mitered: this option works with a miter ratio.
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The miter ratio serves to limit the length of the sharp corner (the distance from the base of
the trap to the corner point).

The default miter ratio value is 4. This means that if the length of the sharp corner is more than
4 times the Trapping Distance, then the corner are cut off (beveled). If it is less than 4 times
the Trapping Distance, the corner are left as it is.

6. Advanced Settings

Click the collapsible button to show the advanced settings.

Truncate Traps

If you want to truncate traps into black differently, select Into black and choose the truncation
mode (On Center or On Edge).

Processing

1. Color pairs

PowerTrapper can trap all hits (occurrences) of a color pair the same way or recalculate the trap
direction for different hits.

• Each hit can have its own decision (default): this recalculates the trap direction for each hit
of a color pair.

• Use the same decision for all hits: this traps all hits of the same color pair in the same direction.
• Use the same decision for objects smaller than: this uses the same trap direction for hits of

a color pair belonging to small objects, and recalculates the trap direction for hits belonging
to bigger objects.

Use the field next to the option to determine the maximum size of small objects. The unit used is
the General unit defined in Illustrator's Unit & Display Performance Preferences.

The default size is 1 mm (or equivalent in your chosen unit).

Restrictions

In some cases PowerTrapper can safely ignore certain object types to speed up the trapping.

• Ignore existing trap layer: if your document has already been trapped, select this option to
keep the existing trap layer out of the trapping process.

• Ignore bitmaps: this keeps bitmap pixel data from being trapped. Bitmap data is contourized
before trapping which may slow down trapping depending on the bitmap's contents. Bitmaps
with lots of small isolated islands typically take a longer time to trap.

Note:  When you indicate an object type to ignore, it is ignored completely as if it did not
exist in the job. Also, the ignored objects does not truncate trapping areas resulting from other
objects below them.

2. Small Gaps

Some input jobs contain very small unintentional gaps between neighboring objects, preventing
the correct trapping of these objects. Although it is better to clean up such jobs before trapping,
PowerTrapper can ignore these gaps automatically.

To use this option, select Close when smaller than and enter the maximum size small gaps can
have.

The unit used is the General unit defined in Illustrator's Unit & Display Performance
Preferences.

The default size is 0.01 mm (or equivalent in your chosen unit).
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Note:  If you set a big gap size, trapping may become slower and small parts of the job may be
ignored during trapping.

Add Rule
Add Rule allows to define custom trapping settings for specific trapping pairs.

1. When to use rules:

In most cases the general trapping settings entered in the Trap dialog box gives you excellent
results, but in some cases you may need to refine them using rules.

Add Rule allows to specify exceptions to the general trapping settings for certain color pairs.
They are an advanced feature and should be used only by experienced users.

For example, you can use them in the cases below:

• To set a different trap distance for a specific spot ink.

Sometimes you need a larger trap distance for spot inks if there is no other ink to help cover
leaks on the press.

• To prevent trapping or ink pull back in specific cases.

Depending on the type of the adjoining colors, trapping and / or pull back may be undesirable.

• To force a specific trap direction.

PowerTrapper Standalone determines the trap direction based on the relative lightness of the
adjoining colors. If the colors have a similar lightness level, it selects an arbitrary direction. You
can use a rule to make it always use a particular direction for a color pair.

• To specify a different shape and/ or truncation mode for certain color pairs.

For example, you can choose to use “On Center” truncation when trapping under a 100%
black line and “On Edge” truncation on all other color pairs.

2. Creating a rule

• Click the Add Rule button at the bottom of the Trap dialog.

• In the pop-up that opens, choose the trapping pair to apply the rule to using the From and To
lists. You can create a rule to trap from/to: any color, a particular ink (process, spot or opaque),
a particular object (image, gradient or empty background) or the registration color.

Note:  When trapping a particular ink, you can choose the ink name from which Minimum
Density the rule is applied and if the color must be pure (no other separation in the color
object) to apply the rule.

• Choose the contents of the rule.

Options Description
Trapping Direction

• Automatic lets PowerTrapper
Standalone calculate the trapping
direction.

• Force Trapping from ‘From’ to ‘To’
always spreads the “From” color/
object on the “To” color/object.
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Options Description
• Do Not Trap ‘From’ to ‘To’ never

traps the “From” and “To” colors/
objects together.

Trapping Distance Use this to define a special trapping
distance for the trapping pair.

Trap Color Intensity Use this to define a special trap color
intensity for the trapping pair.

Pull Back
• Automatic lets PowerTrapper

decide if there should be a pull back
on the trapping pair.

• Always Pull Back always creates
a pull back on the trapping pair.
The darkest ink of the pair is the
pullback ink (remaining ink in the
pull back area).

• Do Not Pull Back never creates a
pull back on the trapping pair.

Pull Back Distance Use this to define a special pull back
distance for the trapping pair.

Reverse
• Automatic lets PowerTrapper

Standalone decide if the trapping
pair should have a reversed trap.

• Always Trap Reversed always
generates a reversed trap for the
trapping pair.

• Do Not Trap Reversed never
generates a reversed trap for the
trapping pair.

Truncate Traps Choose if traps generated for the
trapping pair should be truncated on
center or on edge.

End Caps Choose how to shape the ends
of open traps for the trapping pair
(square, round or object dependent).

Trap Corners Choose how to shape the trapping
pair's trap corners (round, beveled or
mitered).

• If necessary, use the + button to add contents to your rule. You can use the - button to remove
contents.

• After defining the rules, click OK button. You can now see your rule at the bottom of the Trap
dialog box.

When trapping your document, PowerTrapper traps the trapping pairs that match rules according
to those rules and the rest of your document according to the main trapping settings. If necessary,
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you can add another rule or remove a rule previously created. You can also edit a rule by double-
clicking it in the Trap dialog box.

Print to File

The Print to File action converts the ArtPro native file format to a composite or separated EPS file,
depending on the Device Type that has been chosen.

Depending on the action list, the Print to File action can be simply followed by a Close File action,
an FTP action, a Copy File action or a Convert EPS to PS and a Send over PAP action. This
depends on what device the file needs to be printed to and how the device is physically connected
to Automation Engine. This is described later in this section.

Load Settings from XML

After using a Select File action to select an XML file, the settings from that XML file can be loaded
in the Print to File action, overwriting the existing settings.

General Concepts

1. Flattening

When creating a PS file, the ArtPro file is flattened if needed, as PS does not support blend modes,
opacity, etc. The settings of the Flattening Options are used.

2. Composite PostScript®

Composite PostScript means all information is calculated into a single page, unseparated
PostScript file.

In a Composite file, placed EPS files are copied unmodified. This means that if you work with
DCS for example, the placed low resolution is sent to the printer. Both TIFF files and ArtPro files
are converted into PostScript at full resolution (or any resolution defined by other print settings).

There are mainly 4 ways of generating PostScript for Printers/ Proofers.

1. Using DeviceN (Composite L3 Printer)

When outputting composite PostScript using the Level 3 DeviceN comments, a composite
PostScript is generated, containing all transparencies and spot colors. If this composite output
is handled by a RIP, capable of handling these level 3 commands, a correct output can be
achieved. This option is preferred if the Proofer/Printer can handle it.

Please note that composite output, even when using the DeviceN command does not include
dotgain or screening information.

2. DeviceN Off, Use Setcustomcolor OFF

The complete job, if necessary, is flattened to remove all overprints and transparencies, and
converts all PANTONE™ colors into CMYK.

The result is a flattened CMYK composite PostScript file which can be sent to any color proofer.
3. DeviceN Off, Use Setcustomcolor ON

This creates a flattened file, flattening all CMYK overprints and blend modes.

The resulting PostScript file contains CMYK objects in combination with separation color
objects. This PostScript file still contains overprinted objects. Not every color Proofer can
handle this.

4. Bitmap Proofer
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This option forces to Rip the complete job into a CMYK image at a given resolution and
generate a PS file containing only the Ripped CMYK image.

3. Separated PostScript®

If you make a file with All Separations, a multipage PostScript file is created. Each page contains
black and white information describing the separation of one ink. So the file contains as many
pages as there are inks in the ArtPro file.

If you make a file per separation, a single page PostScript file is created containing the black and
white information of the film (ink) you asked for.

Placed art in separated output:

• EPS files containing CMYK, grays and custom colors are separated by ArtPro using
separation code. Some EPS files however, are not suited for this separation code. Therefore
an alternative separation code is provided (by switching on the Simple separation code
option) for these situations. If you work with DCS files (or DCS-2), ArtPro replaces the low
resolution file by the high resolution separations.

• TIFF CMYK files are separated and converted into PS.

• ArtPro files are converted as normal, this means any picture in the file is expanded with high
resolution.

• OPI: PostScript output of TIFF files always contain OPI comments (as specified in Aldus Open
Prepress Interface Specification 1.2 and 1.3). This makes it possible to work with low resolution
images on the Mac and in proofs (= unseparated output) and high resolution images on film
(= separated output). Even if the TIFF file type is not supported (not CMYK), OPI comments
are generated.

Examples of TIFF files which are supported by OPI are RGB and palette TIFF files. These files
can be placed in ArtPro, can be seen on screen and make a color proofer output. However,
separation cannot be made for these TIFFs, unless you use OPI replacement.

4. Placed Files (S&R)

Placed PDF 1.3 files are converted to PS during output. Placed PDF 1.4 files cannot be converted
to PostScript Level 3 and generate an error Cannot convert PDF 1.4 into PostScript.
Note that the distinction between PDF 1.3 and 1.4 is not done on the header, but on the presence
of PDF 1.4 functionality.

Device Type

1. Color Proofer

Color Proofer is the standard Composite PostScript output to send to PostScript proofing devices.
2. Color L3 Proofer

Color L3 Proofer generates composite output, using Level 3 commands such as DeviceN and
shadings. This results in composite output, containing all spot colors, overprints, etc. Screening
and Dotgain Compensation is not included.

3. Separated Proofer

Separated Proofer is a device to print separations on a color proofer, for example: a LaserWriter.
Although it is sent to a Proofer, the output is separated.

4. Bitmap Proofer

This output, originally developed to be able to output overprints and transparencies, has become
obsolete because of the L3 commands. With the Bitmap Proofer output, the ArtPro file is RIP'ed
into image data which is sent to the proofer, preceded by a PostScript header and followed by
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a PostScript footer. The image data consists of CMYK information. This output can get quite
substantial, depending completely on the output resolution and the file size.

In the RIP tab of More Settings, the desired resolution can defined. The ideal resolution is equal
to the resolution of the proofer device being used.

5. Custom proofer

Custom proofer is the output device for proofers with all More Settings available. Any device type
actually has a number of preset More Settings, of which some can be modified and others are
grayed out. Custom Proofer has the preset More Settings from Color Proofer, but all settings
are available for modification.

6. Generic ImageSetter

This is the default device for the output of Separated PostScript, for a general type of imagesetter
or platesetter.

7. Agfa

To generate output for an Agfa imagesetter, choose Agfa in the Device Type list. The type of
PostScript generated for Agfa is separated PostScript.

8. Barco RipScript

This device type generates separated PostScript, to be exposed through Barco RipScript.
9. Barco TransScript

This output generates EPS files which can be sent to an old Barco system, through Barco
TransScript. Note that these files are not standard EPS files and are not to be used in applications
other than Barco TransScript. For more information on how to output through Barco TransScript
and the limitations of this method of output please refer to the ArtPro manual.

10.Creo (Layout / Single Job)

These two devices make it possible to use OPI server functionality for Step & Repeat on Creo
Servers. Whereby, high resolution image data is stored on the server and a preview version is
stored with the original file. At output the server automatically replaces the preview version with
the high resolution data, according to the OPI comments contained in the Step & Repeat Print
file. Printing will therefore be considerably faster, as network data transfer between Automation
Engine and the Creo server system is reduced to a minimum.

1. Procedure

a. Print the single job in the Print menu with the option Creo (Single Job) and send it through
to the Creo server.

b. Create the S&R file of the single original ArtPro job and save it.
c. Print the repetition file to Creo (Layout)

Besides the OPI possibilities, the Creo output contains DIG comments, allowing Print files
from Automation Engine to be used in the VPS, the Creo Virtual Proofing System. Therefore,
even if the OPI Step&Repeat is not used, Creo Layout should still be used to enable the
VPS.

11.Crosfield

Crosfield output is based on Generic Imagesetter but fine-tuned to make the Crosfield OPI work.
The setting Include Gradations comments allows Crosfield to put gradations (converted to CTs)
in the Lineart level (at high resolution) and CTs in the CT level.

12.DCS-2 Single File / DCS-2 Multifile

The DCS-2 output creates a DCS file, a separated file format including all separations and a
preview. With Multifile, the result is as many files as there are separations and an additional
preview file. For Single file, separations as well as preview are contained in one single file.
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The DCS files can be placed in other applications (example: page layout or imposition
applications,...) or can be used with OPI servers when printing Step & Repeat files or from
imposition applications. Hereby, the high resolution image data (DCS 2 file) is stored on an OPI
server and a preview version, generated by the OPI system is stored with the original file. At output
the OPI server automatically replaces the preview version with the high resolution data, according
to the OPI comments contained in the Step & Repeat file or the imposition file.

To print Step and Repeat files from one-up ArtPro files follow this procedure:

Save the single job in the Print menu with the option DCS-2 and send it through to the OPI server.

Create the Step and Repeat file of the single original ArtPro job, either in a step and repeat action
list or manually on an ArtPro front end station and save it.

Print the repetition file to Generic Imagesetter in the Print menu, with the option Replace Placed
ArtPro by OPI in the More Settings.

13.Delta Technology

This output device is only to be used for repetitions. For every group, a Delta list is created. In
the case of S&R, a delta list will be created for a single label. The next time the same Delta list
is used, the RIP only has to place it, resulting in a very high S&R optimization. To use this S&R
optimization, the clipping box has to be a rectangle. For S&R Tabular, this is no problem, but
nested CFF2 repetition can cause troubles.

14.LinoType-Hell

LinoType-Hell output is based on Generic Imagesetter. This output supports the Automatic Page
Positioning feature from Linotype-Hell.

15.Optronics

The Optronics is the same as Generic Imagesetter output.
16.Nexus

This Device Type should be used when printing to NexusRIP workflows as it results in separated
PostScript optimized for NexusRIP. This device is used to print single documents (to a low
resolution link file) as well as S&R or imposition data with links.

17.Purup

Purup is based on the Generic Imagesetter output, but fine-tuned for use with the Purup OPI
system, Imagelink, which is based on low resolution DCS files.

18.Quark Separable EPS

To generate an EPS file that can be separated by Quark XPress® you can choose Quark Separable
EPS as Device Type. As this is a composite output, it has some serious limitations concerning
transparencies. Therefore, DCS-2, L3 Proofer or PDF Export is more advisable. For more
information please refer to the ArtPro manual.

19.Scitex Separated / VIP / PCF

The best way to send to Scitex is using separated output, as composite output has too many
limitations. The only reason to use composite (VIP) output is for APR, Scitex OPI system on the
VIP rips or if the files are to be handled further on the Scitex systems.

To generate composite output for the Visionary™ Interpreter for PostScript® from Scitex, choose
Scitex VIP in the Device Type list.

Scitex VIP is a computer application which converts PostScript files into the Scitex formats. The
Scitex VIP output always makes PostScript output to a file, as it is not a real device but a computer
application.

In some cases the VIP can be selected in the chooser, in other cases VIP has to be opened and
the PostScript file loaded into the VIP. This depends on the customers’ configuration. The type
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of PostScript generated for Scitex VIP is composite PostScript. The composite output is then
to be separated by the Scitex RIP. Please bare in mind that composite PostScript is much more
limited when it comes down to supporting transparencies, or not standard ArtPro functionality
like mapped pictures, etc.

Output to Scitex PCF is specifically meant to output step and repeat data to Scitex’s native format.
For more information on these device types, please refer to the ArtPro manual.

20.Screen

The Screen is the same as Generic Imagesetter output.
21.Think Laboratories

A Generic Imagesetter output, fine-tuned for Think systems.
22.Custom ImageSetter

Custom ImageSetter is the output device for imagesetters with all More Settings available. Any
device type will actually have a number of preset More Settings, of which some can be modified
and others are grayed out. Custom ImageSetter has the preset More Settings from Generic
ImageSetter, but all settings are available for modification.

Other Settings

1. Paper Size

The Paper Size drop-down menu includes the different sizes. If a PPD needs to be assigned, it
should be done through the Convert EPS to PS action. from media box always uses the Media
Box. from page box uses the active (that is, the last selected) page box. If any objects are outside
the selected page box, a warning is generated. When choosing from Job (default), the active
page box is used, enlarged if necessary to fit all objects.

Following sizes are included in the Paper Size menu:

• A4: 210 x 297 mm
• A3: 297 x 420 mm
• US Letter: 8.5 x 11 inch
• US Legal: 8.5 x 14 inch
• Tabloid: 11 x 17 inch
• Tabloid extra: 12 x 18 inch

2. Layout

For proofer output, choose between Center, Fit always, Fit Large Paper or Tile output. Center
will position the job centered on the paper size, taking into account the indicated Distortion for
size. A distortion of 0% results in a true size job output. If the job is bigger than the indicated paper
size, it is clipped on the edges. Fit Always enlarges or reduces, so that the ArtPro file matches the
paper size. Fit Large Paper fits large format ArtPro jobs to smaller paper sizes, without enlarging
the job when the paper size is larger than the job size. Tile is used when a job is larger than the
paper size. It divides the job over several pages, with the indicated Tile Margin and Tile Overlap.
Define a Tile Margin if you do not want to use the complete paper size. The Tile Overlap indicates
how much of the tile edges are printed on the next page, as to create an overlap area.

3. Orientation

The Orientation can be set to Portrait, Turn right, Turn left or Upside down. It defines the
direction in which the file is put on film or on paper. Choosing portrait outputs the file in the upright
position, turn right rotates the file 90° and turn left rotates it -90°.

4. Mirror / Negative
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When Mirror check box is selected, the job is mirrored before exposing, resulting in a wrong-
reading output. Negative allows outputting separations as negatives. Note that these settings
are additional to the settings on the RIP actions.

Example: a negative setting on Print to File and a negative setting on the Assemble a Screen
Page Sub action results in a positive output. The same is true for Mirror. Equally note that the
imagesetter or platesetter device can also have a negative and mirror setting.

5. Output

This allows to define the name of the output file, using the File Naming Template.
6. Title

The Title allows to define the title comment in the PostScript file. This comment can be extracted,
example, in a NexusRip workflow, to extract the job name instead of the PostScript file name.

7. Distortion

A document can be output with a vertical and/ or horizontal distortion. It is defined as a percentage
of the jobs original dimensions and is applied to the PostScript file.

This distortion is specifically important for flexo jobs. On mounting a flexo plate on the press, it is
stretched out in one direction. By making the output slightly smaller than needed, we compensate
for this distortion. The original dimensions of the file remain unchanged.

Positive values make the job bigger and negative values make the job smaller. Example: When
vertical distortion is -2.35% it makes the output 97.65%. In this way you can also scale the proofer
output: example, entering - 50% for both vertical and horizontal distortion outputs the job at half
of its original size.

8. Clip

If the job is bigger than the paper or the film, you may output in parts. If Clip is not active, the
complete job is printed or exposed and is thus clipped on the output when it is bigger than
the paper size. When Clip is checked, you can define the tile dimensions by clicking on the
Rectangle... button. The tile indicated in the Rectangle dialog will output.

9. Rectangle...

Clip Rectangle allows to define what part of the job should be printed.

1. page box Clipping

When page box Clipping is selected, the job size chosen under Use Box is used to clip the
output. The different boxes can be defined in the Job Size dialog box.

2. Manual Clipping

If Manual Clipping is selected, the size and position of the part to be printed can be set
manually. In the Vertical and Horizontal field, the size of the rectangle to be printed can be
entered. If the Lock to Ruler option is selected, the rectangle to be printed moves along when
moving the ruler (see Move Ruler action).

3. Automatic Clipping

If Automatic Clipping is selected, the size and position of the part to be printed is defined by
the job size and the settings of the Divide and Print Part fields.

Divide: in the Divide field, enter how many parts the job should be split up, for both vertical
and horizontal.

Print Part: in the Print Part field, define which part of the job should be printed.
10.Marks

Besides the Cut marks, other objects like registration marks as well as job and separation
identification can be added to the file through Generate mark.
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11.Separations

The Separations menu has a dual function, to define which separations have to be output and to
define how separations need to be mapped to other separations. By default the window is blank
and the Search Unused Separations option is selected. This means that the system checks
which separations are in the document and output separations which are not empty. When there
are non-mapped pictures in the file though, all separations are output. The Separations window
contains two areas, the Separation Mappings area and the Exclude area.

1. Separation Mappings

To add an entry to the Separation Mappings list, click the + button and enter the separation
name in the From field. By entering the To separation, you can remap the separation to another
plate. Note that it is equally possible to enter “CMYK”, which allows to convert a separation
to CMYK on output without actually modifying the document itself.

The Print icon can be toggled on or off by clicking the Print button.

An example on the use of the Separations dialog box, is in a double burn action list, where
there are three different black separations in the file: English Black, Spanish Black, and
Graphics Black. In this case, the Graphics Black should be mapped to the English Black as well
as to the Spanish Black, hence they are merged. Seven separations are output into six plates.

2. Notes on separation mapping

Mapping of output separations is fully supported for all paint styles. Even placed ArtPro jobs
can be merged. Example: for a layout, containing two ArtPro jobs, each with a different spot
color, both separations can be merged during output. This is even possible if the jobs contain
TIFFs. This is because no merging is done within the placed ArtPro jobs. Note however that
remapping is only available for Separated outputs!

Separating placed EPS- and PDF-files takes into account overprints, PS3 and PDF1.3
vignettes (Illustrator 8 and 9) and Photoshop duotones.

3. Screening for mapped separation

When you have a step & repeat file containing multiple jobs and you want to map separation X
from job A into separation Y from job B, separation X will still be output with its own screening
settings as long as this job (A) does not contain separation Y. When job A contains separation
X as well as separation Y, the screening which will be used to output the mapped separation
X into Y will be separation Y.

4. Exclude Separations

This option can be used to exclude separations from the output. By clicking the Options
button, the Output Separations dialog box is opened. By Adding a separation (click the +
button and define its name. Wildcards can be used), you can exclude this separation for this.
By selecting an entry in the list and clicking the - button, you can remove it from the list.

5. Search Unused Separations

The Search Unused Separations setting excludes separations that are not used. It only turns
separations off, separations excluded earlier are not removed from the Exclude list, even if
they are in use. The Search Unused Separations option does not take registration color into
account.

12.Dot Gain Compensation

The Dot Gain Compensation button defines if the dot gain curve(s) selected in the Dot Gain
File... menu (see below), has to be calculated on the PostScript output. With this option off, all
curves are ignored for output. Dot Gain Compensation is only available on separated output.

13.Dot Gain File ...
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The Dot Gain File ... button allows you to select a Dot Gain File. The file name of the selected Dot
Gain file is shown on the right side of the button. If a Dot Gain File is selected in the Print menu,
this Dot Gain File overrides all Dot Gain settings in the Screening dialog (example: an opened
ArtPro file). The exception is a placed EPS that contains a dot gain compensation, in which case
both curves are used. A selected file can be removed by clicking the Dot Gain File button while
holding down the SHIFT key. Dotgain files are generated in and saved from the screening dialog.
(please refer to ArtPro manual for more details).

14.Color Management

If a color management profile has been defined at the time of importing or opening a file in the
action list, it is possible to override the settings for output (example: color profiles for proofers
or for separated output) in this menu.

15.Flattening Options

When creating a PS file, the ArtPro file is flattened, as PS does not support blend modes, opacity,
etc. The settings of the Flattening Options are used.

16.File & Fonts Settings

The File & Font Settings allows to define root folders, folder mapping and fonts folders, similar
to the Open ArtPro File action (please refer to this action for a full description). This functionality
has been made available in case ArtPro files have been placed in an open job during the action
list, to allow for the retrieval of the linked images or used fonts at the time of printing.

More Settings

In this dialog a whole list of Print Settings are available. Depending on the active Device Type
the settings are defined automatically, whereby some are checked by default. For some devices,
some settings are not accessible (gray) and others can be (de)activated. For Custom Proofer and
Custom Imagesetter all the options are available so as to allow specific customized output. The
More Settings are divided up in seven categories: Page, Separations, Paints, Text, Optimize, RIP
and Preview. For more information, please refer to the ArtPro reference manual.

1. Page

These settings are related to the type of file of the EPS (PS) file that is generated by the Print to File
action (composite versus separated,...), and the comments in the header. Changing these settings
may in some specific cases be necessary to have a receiving application or printer recognize the
file or to have the correct type of file generated.

2. Separations

These settings determine how separations and page commands are defined in the file. Depending
on the Device Type that has been selected in the main Print to File dialog box, these settings
are correctly defined by default. Only in specific cases should changes be made.

3. Paints

These settings are related to how colors and overprints are defined in the file and how gradations
and images are handled. The system supports applying image averaging at the time of down
sampling. This results in better image quality when downsampling has been applied, but slows
down the generation of the PS output.

4. Text

These settings determine how text is handled in the file. Settings can be made to vectorise text
or to embed fonts.

5. Optimize

These settings determine how the PostScript needs to be optimized and how OPI comments
need to be handled in the file, including the use of OPI comments for placed ArtPro files, allowing
for a productive Step and Repeat solution (example: with the Creo Layout device).
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The PS Optimize settings include the ability to split long paths (important for output to PS Level 1
RIPs or for RIPS with limits to the amount of points on a path due to insufficient memory) and the
use of picture caching which improves output speed when images need to be put into the output
multiple times (example: when image trapping has been applied).

6. RIP

These settings allow for specifying special comments needed to output PostScript to a RIP
system, including the NexusRIP. Note that the ArtPro Action List Editor has the ability to add an
XML job ticket (Write Job Ticket) to the PS file, that contains specific information about the job,
including the job size, separations, screening used, etc. This job ticket is then read by NexusRIP
and put into the link file when a link file is generated. This allow ArtPro to display all the information
about a specific job (the job ticket) when this link file is placed (example: a step and repeat file).
For more information and an example please refer to the ArtPro manual.

7. Preview

These settings determine the type of preview that is generated (if any) and if a mask needs to
be generated in the preview (example: to support transparent views for clipping paths). Some
receiving systems may not support this preview mask. In these cases the mask can then be
switched off, but the file is still output correctly.

PrintCheck

The Printcheck option allows to create an image of the complete job. Besides the resolution, the
noise for gradation can be set. The compression allows to choose between tiff and jpeg, with 3
possibilities on compression : High compression, Medium compression or High Quality. The file can
be exported as a Tiff/JPEG or an EPS. The Box drop-down menu allows to define what border has
to define the boundaries of the image to be created.

Regmarks

The Regmarks action allows to use personalized marks.

The idea is to create one ArtPro file with the marks you need based on a blank document. The job
size is not relevant for applying the registration marks.

When using this selected ArtPro file with this action, the marks will automatically adapt to the job
size of the current document while the inks will equally be adapted.

There are two ways of selecting a Regmarks file: either select a fixed file by using the Select File
button in the action, or select a variable Regmarks file by using the Select File action.

For a description of how to build a registration mark file in ArtPro we refer to "Import marks" in the
ArtPro manual.

With the Box menu, define on what page box the regmarks need to be applied or to use the bounding
box of the selection.

With the Merge Layers function, you can define that layers with the same name in the Regmark file
and in the open file, should be merged together.

Reorder Layers

The Reorder Layers action allows to change the order of layers.

Layers with a name that match one of the entries are placed in the specified order. Other layers are
placed underneath in their original order.
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Entries in the list can be added and removed using the Add and Remove buttons. An entry can
contain a wildcard (*).

If two different layers match the same entry, their relative order depends on the original order.

If a layer name matches different entries, the best matching is chosen. Example: a layer name Trap
layer matches more with “Trap*” than with “*”.

Reorder Separations

Reorder Separations allows to change the order of the separations in the Separations list.

Separations with a name that match one of the entries are placed in the specified order. Other
separations are placed underneath in their original order.

Entries in the list can be added and removed using the + and - buttons.

An entry can contain wildcards (*). If a separation matches two different entries, it is placed at the
topmost position. If two different separations match the same entry, their relative order depends on
the original order.

There is an option to reverse the separation order. This option can be used for some special printing
procoesses like dry offset. When reverse is enabled, separation reorder cannot be done.

Save ArtPro File

This action saves the currently processed file to an ArtPro file on disk.

Output
The Template allows to set the name of the file to be saved.

Compatibility
The Compatibility allows to choose to save the document as ArtPro 9.x/8.x or as ArtPro 7.5 / 7.0 / 6.5
file or as ArtPro 6.0 file. An ArtPro document saved in an earlier file format does not contain version
specific information. Example: an 8.0 document saved as ArtPro 7.5 document will not contain blend
modes. The file is flattened before saving.

Include Preview
When With Preview is checked, a (separated) preview is included in the ArtPro file. The Resolution
field allows to define the resolution (in ppi) for this preview. Default is 72 ppi.

When the preview is added to the file, it is shown in the Job Editor, if the Thumbnail option is
enabled. in the Preferences.

Save Hidden Layers
This option defines whether layers with a “Hidden” state should be included in the saved file or not.
See also the Layers related actions.

Profiles
Embed entire profile in ArtPro files allows to include the used Color Management profile in the
ArtPro file. This can be useful when moving files to another system. The option Don't embed profiles
for imported pictures with embedded profiles disables embedding profiles already embedded in
the pictures.
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Flattener Options
When saving as ArtPro 7.5 file, the ArtPro file is flattened. The settings of the Flattening Options
are used.

Certified PDF sessions information
The option Include Certified PDF information allows to define if Certified PDF information should
be included in the ArtPro file. If the option is checked, the information is included in the file, even
when saving as ArtPro 7.5 file. If that file is open in ArtPro 7.5, that information is ignored. If the option
Save Certified PDF Information is selected, the Certified PDF information is saved in a separate
XML document. The File Naming Template is used to define its name and location.

Flattener Template
If the Flattener needs to save images, the name of these images are defined by the File Naming
Template next to the Flattener Options.

Select File

Automation Engine is capable of working with hot folders that can accept files, as well as hot folders
which can accept folders. When a folder is submitted to a hot folder, this action determines which
file(s) from the folder is selected for processing. It can also be used to filter on a list of files which
should be used as input to the following action. The Select File contains several items for selecting
a file for further processing.

Select Options
The Select Options show the criteria used. A line can be added using the + button or removed using
the - button. When a criteria is selected, its settings are shown in the Select Item Options. The
available settings depend on the Select mode (By Name, By File Type,... see below).

Select By Name

1. Whose Name

The system selects a file based on the name of the file. The parameters are: is anything, starts
with, “ends with”, “contains”, “does not contain”, “does not start with” and “does not end with”.

The Edit Template button allows to use the File Naming Template. It is also possible to use
Regular Expressions.

2. Position From 0 To 500

The Position From... To... fields work in combination with the Whose name contains... option.
Using the position fields, you can point out what character positions of the file name is checked.
When setting Whose name contains as “APR” from position 2 to 4, files which have APR on
character position 2 to 4 are searched. As the first character is position 0, the 3rd, 4th and 5th
characters are searched.

Select By Documenttype

1. File Type

You can use this to select an ArtPro, PDF or PS file which matches the other criteria.
2. Number of Separations

The Number of Separations can be set to Equals, More than or Less than.
3. Number of Pages

The Number of Pages can be set to Equals, More than or Less than.
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4. Page Box

The selection can be set for the selected page box to be within the entered values.
5. Orientation

The orientation criteria can be set to All, Portrait or Landscape.

Select Objects

Select Objects allows to select/ deselect objects.

First
The radio buttons define what to do prior to the selection.

Do nothing means leaving the selection as is. This can be useful to combine multiple Select Objects
actions.

Invert Selections inverts the selection prior to applying the select action.

Select All or Deselect All allows to start from scratch with either everything selected or everything
deselected.

Paint Style

1. Flat Paints

Allows to Select/ Deselect Flat Paints. This can be used in combination with the Matching option
(see below).

2. Gradations

Allows to Select/ Deselect Gradations, either Linear, Circular or Multistep gradations. This can
be used in combination with the Matching option (see below).

3. Matching

Using the Matching option in the Paint Style tab, it is possible to select objects with a Flat Paints
or a Gradation within the defined percentage range. The separation names can contain wildcards.
The Overprint column allows to select objects that are transparent for that specific separation.

4. Pictures

Allows to Select/ Deselect Pictures, either placed, mapped or Patterns.
5. Images Type

Selects all placed files of the file type defined by the menu: TIFF, ArtPro files, EPS, TIFF, TIFF/
IT or PDF.

6. Images Color

Selects all images in the file based on the setting of the dropdown menu. Choices are: CMYK,
RGB, grayscale, B/W (Black and white one bit images) or All.

Transparency

1. Blend Mode

Selects all objects with a certain Blend Mode. By setting the dropdown menu to All, you can
select all objects containing any Blend Mode.

2. Opacity

Allows to select all objects with an opacity higher (At Least), lower (At Most) or Equal to the value
entered.

3. Opacity Masks
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Selects all objects containing a Soft Mask.
4. Objects/ Groups with Transparency

Selects all objects or groups containing any transparency.
5. Overprint

Selects all objects containing overprint.

Objects

1. Text

To select all text, or text smaller or bigger than the entered pointsize.
2. Vectorized Text

To select vectorized text. Text that was converted to outlines using the Text to paths action or
during import is remembered.

3. Font Name

Selects all text items or text blocks containing the font entered in the input field. A text item
containing more than one font, is selected completely if the entered font is used.

4. Screen Name

Selects all items using the screen settings entered in the input field.
5. Object Name

This helps to select objects with that name ( eg. a layer from an imported MFG file which imported
as a sub-layer in ArtPro.)

6. Strokes

To select all strokes or those smaller or bigger than the entered value.
7. Traps

Selects all traps created by Automatic Trapping. A trap that has been edited is longer be
recognized as a trap and thus not be selected.

8. Barcodes

Selects all Barcodes containing bar code information. With some transforms (example:
unproportional scaling), an invalid barcode is created. A warning is given when transforming and
the bar code is longer selected with this function.

9. Thin Part Fixes

Select the thin part fixes done in ArtPro.
10.Slices

Selects all slices (used for Grid Warping).
11.Open Paths

Selects all paths that are open.
12.Blends

Selects all blends.
13.Link

To select all objects containing a link for ArtLink.
14.Objects Inside / Outside bounding box

In the Objects tab you can define to select or deselect objects inside or outside a defined
pagebox.

15.Layers
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This allows to select or deselect objects that are in a Layer that matches (or does not match) the
entered name. The layer name can contain wildcards.

Selections

The radio buttons at the bottom define whether the defined objects should be selected or deselected.

Using Within Selections in combination with Select searches for objects that match the defined
criteria inside the current selection. Objects that do not match these criteria are deselected.

Using Within Selections in combination with Deselect, deselects the objects inside the selection
that match the defined criteria. Objects that do not match these criteria remain selected.

The Fail if Number of Selections... option allows to have the action fail if the number of selections
is higher than, lower than or equal to the entered value. This can be used to have the action fail if
any text is smaller than 7 pt, for example.

Separate

This action separates the file or repetitions into its separations. The separations are placed under
and next to each other in a single ArtPro file. You can define the Vertical Gap and Horizontal Gap
to be left in between the separations and the number of columns to be used (that is, the number of
separations to be placed next to each other). In order to print a “separated” file like this, the option All
Separated Pages on Same Film should be selected, in the More Settings of the Print to File action.

Set Station Numbers

The Set Station Numbers action is based on the Station Number part of the Step And Repeat
Nested action. It allows to set station numbers on an existing step and repeat file. For more
information on Station Numbers, we refer to the ArtPro manual.

It is possible to define the origin for the Offset, using the square buttons. By default, this is set to
place the Station Numbers centered on the bounding box of a station.

The File Naming Template can be used to define the text of the Station Numbers to be added.

Spread

This action allows to apply a spread on all objects or on the selection. The action is based on the
Interactive Trapping function in ArtPro. For a more elaborate description, we refer to the ArtPro
documentation.

When a Spread is applied on an object:

1. The paint style of the original object is changed to 0% for every separation.
2. A slightly larger Spread object is generated.
3. The Spread object gets the paint style of the original object, BUT changed to “trans” for every

separation that had a 0% value.
4. If the original object had a blend mode, the original and spread object are grouped and the blend

mode is applied on the group.

Tabular Step and Repeat

The Tabular Step and Repeat action gives access to ArtPro’s tabular step and repeat module from
within the ArtPro Action List Editor. For a full description we therefore refer to the ArtPro manual.
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This action can be used to Step and Repeat not only ArtPro files but also TIFF files, EPS files, DCS
files and PDF files. Hence any of these file formats could be handled by an action list that starts with
a Tabular Step and Repeat action.

Equally, the Tabular Step and Repeat action could be preceded by a Select File action which would
select a file from a folder.

This would typically be the case, when an ArtPro file and a Regmarks file are bundled in a folder for
Tabular Step and Repeat. The Select File action would then select the ArtPro file (or any other of
the supported formats) that needs to be stepped, and be followed by a Select File action to select
the Regmarks (ArtPro) file that needs to be used to generate the register marks.

The first drop-down menu, Use Box, allows to determine which page box (example: media box,
bleed box, trim box, etc.) needs to be used as reference for the Step distance. For example: if the
Trim box is selected, the step distance horizontally and vertically is based on the size of the Trim box
(unless Freeze Step is selected).

Step and Repeat Settings

1. Count

Amount of instances of the file, horizontally and vertically.
2. Begin Pos.

Horizontal and vertical offset to the ruler position for the first instance of the document to be
stepped.

3. Step

Only when in combination with the Freeze Step option, this fields determine the offset between
the steps. When left (0,0), the step distance is actually based on the selected pagebox (in the
example: the Trim box) of the file that is stepped.

4. Angle Setting

The Angle setting determines the rotation of the file to be stepped.
5. Cut Marks

The Cut Marks option adds cut marks for any of the stepped instances.
6. Keep Bleeds

Includes the bleed of the stepped file in the step and repeat document. Bleeds are always kept
outside of the step and repeat job size. Note that bleeds overlap when the step distance is set
to the Trim box.

7. Place Single-Separation ArtPro File in Single Sep

This option defines how to handle repeating ArtPro files with only one separation. If the option
is not selected, objects in this AP file with 100% of the single separation are considered to be
registration color and thus get 100% of every ink in the repetition. If this option is selected, the
file is inserted in one single separation instead.

8. File & Font Settings

This gives access to the root folders, folder mapping and fonts folders when the file to be stepped
is an ArtPro file. For a description of this function, please refer to the Open ArtPro File action.

a. Color Management Settings

This setting determines if color management has to be applied for the step and repeat job.
When enabling color management, it is possible to select a color management settings file,
previously saved by ArtPro. This file contains all ICC profiles and settings to determine how
color has to be treated throughout the rest of the action list (example: proofing of the step and
repeat document), including ICC profiles for proofing, printing, etc.
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Text to Paths

This action automatically converts all text or the selected text to outlines. Note that when importing
PS or PDF files, text could already have been converted to outlines if the Convert to Real Text option
has not been set during the Importing action. This is especially useful when ArtPro files are used
and files need to be exported to environments where the fonts are not available.

Transform

This action applies a transformation to objects in the document. The transformation is done either
to all objects or to the selected objects only (see Selector).

Following transformations can be executed:

• Move horizontally and vertically
• Scale horizontally and vertically
• Rotate
• Shear

Options

1. Repeat

The repetition field allows to execute the transformation multiple times.
2. Copy

The Copy option copies the contents of the file before executing the transformation. If at the same
time repetition is set there will equally be multiple copies.

3. Apply on

a. Path, Paint and Soft Mask

The Path, Paint and Soft Mask options determine if the objects and their contents are
transformed or only the contents without the objects or the objects without the contents.
Suppose a clipping path with an image would be transformed and Path is not checked, then
only the image itself is transformed and not the clip path.

b. Notes

Transforms the notes along with the rest of the file, so that the positioning of the notes inside
the file remains the same.

c. Center Paint

The Center Paint option is only available if the Apply on: Paint and Soft Mask is off. It
transforms the path only, but then reposition the paint based on the center point of the path:
the point in the paint that was on the center point of the original path is placed on the center
point of the transformed path. For example: this can be used when scaling or distorting Step
and Repeat files, without scaling the contents of the paths, but still retaining their position
inside the paths.

4. Scale Strokes

If the Scale Strokes option is unchecked, the stroke width does not change when scaling. If the
option is checked, the stroke remains a stroke and its width is changed for the same percentage
as the parent path was scaled. Thus, scaling an object with a 3 mm stroke to 150%, results in
an object with a 4.5 mm stroke. When scaling is unproportional, the stroke width is scaled by the
geometric mean of vertical and horizontal scaling. This means the stroke is scaled proportionally.
The geometric mean is the square root of the product of vertical and horizontal scaling.
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5. Use Ruler

For scaling and rotating, the Use Ruler option defines to use the center of the ruler as the center
for rotation and scaling. If the option is unchecked, the center of the selected objects is used.

Trim & Bleed

This function calculate trim and bleed for all objects in the file.

The action is typically when performing in Step and Repeat and has been described in the Nested
Step and Repeat section.

Unite

Unite creates the union of the selected paths.

Select the necessary paths with the Select Objects action and then apply the Unite action.

For a more detailed description, please refer to the ArtPro manual.

Update ArtLink

The Update ArtLink action is comparable to the ArtLink action. All of its settings can be found in
the ArtLink dialog box.

While the ArtLink action creates as many versions as there are records in the database, the
Update Artlink action does not create any files or versions. It modifies the open ArtLink file using
the information from one specific database record (defined in the Record Number field) or from
information included in the XML file.

Additional Key Values

The Additional Key Values allow to define keys to be used in the File Naming Template when
updating the file. These keys are defined from the action list rather than coming from the database.
For example: this can be useful to set the name of the operator.

Vector Trapping

This action gives access to ArtPro’s PowerTrapper module from within the ArtPro Action List Editor
and performs the trapping on all elements in the file.

For a full description of all the different settings we refer to the Automatic Trapping section in the
ArtPro manual.

Since this action actually generates additional objects containing the trapping information it is
possible to view and edit the traps in ArtPro or to export them to PDF or composite PS.

1. Remove traps first

If the Remove traps first checkbox is selected, all existing traps are removed before trapping
is calculated. The selection of the original objects is kept, allowing to immediately trap the same
selection again with different parameters.

2. Trapper Version

The Version defines what trapping routine has to be used. Version 1 (Packaging) starts to trap in
the background and works its way to the front, while version 2 (Commercial) starts in the front and
works towards the back. This second routine should be faster in general, though version 1 might
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give more consistent results, as it has a longer development history. Therefore we recommend to
use version 1 for packaging and labels and version 2 for commercial work.

4stage Trapper uses a totally different kind of procedure. Unlike Version 1 and 2, it does not work
object based and only calculates traps for where different colors actually meet.

The 4stage Trapper is the only good way to trap objects containing transparencies. The traps
made by the 4stage trapper are defined using transparencies as well.

Distance

1. Into Color

Defines the spread distance for trapping colors under colors. When you enter a value for Into
Color, it is automatically copied for Into Black as well.

2. Into Black

Defines the spread distance for trapping colors under black. If Into Black needs a different value
than Into Color, enter Into Color first and then Into Black because by default the value from the
first field is copied into the second. Sometimes you may want a bigger spread under the black
color, example, for a centerspread. To create a centerspread (center trapping in black, example,
for comic strip drawings), the spread value should be set to slightly more than half the width of the
thickest black line. When the spread value is higher than half of the black line width, in the middle,
where the spreads meet from both sides, the spreads is limited to the center and does not overlap.

3. Into CT

Defines the spread distance for trapping colors to pictures. For Version 1 and Version 2, the color
type can be flat color or linear gradation. Multistep gradations and other pictures are not trapped
automatically. The 4stage trapper can trap anything.

4. Center Error

These fields specify the accuracy for the centerspread (see example on the right). When Off option
is selected for Center Error means no centerspread is calculated. The percentages, together with
the distance, define the precision for center trapping. The lower the percentage, the more precise.
Example: with a trapping distance of 0.5 mm and 8% accuracy, the trap centerline is at a maximum
distance of 0.04 mm off the real centerline. Keep in mind that increasing the accuracy increases
the trapping time! Also note that a smaller trap distance results in more accurate centerspreads, so
do not set the distance higher than necessary. The accuracy cannot be different for normal colors
and for black for the 4Stage trapper or if the trapping distances are equal. This means that if the
black trap distance is changed to equal the normal trap distance, the accuracy is automatically set
to the one for the normal colors. General settings are 8% for normal colors and black. If you have
a job where centerspread under black is important, put the accuracy to 2%, 1% or even 0.5%.

5. Corners/ Miter

This field defines the trap corners, which can be mitered, rounded, bevel or square. The miter
limit can be set to a maximum of 4.

Direction

1. Separation Threshold

It indicates the minimum difference that must exist between touching colors before they are
trapped. There must be a difference more than the Separation Treshold in at least one separation
in each direction. The usage for the different versions is described below.

2. Black Margin

The Black Margin defines what colors are treated as black. From what percentage should an
object be trapped with the distance Into Black and from what percentage Into Color. The default
value is 85%, meaning a box of 100% yellow is spread into a box of 90% black with the distance
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of Into Black. If the black in this example was only 80%, it would trap at the distance for Into
Color. It actually does not just apply for black but in general for all dark colors. If the black value
in color on proofer multiplied with the percent value in paint style is higher than the black margin,
the distance into black is used.

3. Trap Intensity

The Intensity, by default 100%, defines the "intensity" of the trap and can be adjusted according
to the needs. When a job is trapped, the traps should be as inconspicuous as possible. With a
lower intensity, the traps become lighter and so less visible. But keep in mind that if the intensity
is too low, the trapping will not be correct.

4. Keep Away Rich Black

A rich black is a black element, to which another color was added, to make it look darker. Usually,
a tint of cyan is added to the black, but this could be done with any separation, cmy or spot. The
idea is to make 100% black look darker on print, as black, like other inks, is a transparent ink,
which sometimes looks more like a dark gray than black.

If the Keep Away Rich Black option is on, a rich black area is trapped so that the supporting color
is kept away from the edge of the black, on white as well as on color. This means that on a white
element, a trap line is created with only black and no supporting color.

5. Split Gradations

Vignettes are by default spread or choked as one object, that is either completely spread or
completely choked. In theory, though, this trapping is not always correct. A gradient could be
darker than the background at one end (choke) and lighter at the other (spread).

This option makes it possible to partially spread and choke one vignette. When it is active, the
calculation of the automatic traps divide the vignette path into several parts depending on the
colors. On the basis of the light-dark principle the different parts are then spread or choked.
Hence, some parts of the same vignette can spread to the outside whereas other parts can choke
to the inside.

6. Gradation Mode

When set to Step into Gradations, the program decides on the trap direction according to the
light-dark principle. When set to Always towards Flat, gradient is always forced to spread into
flat colored backgrounds, even if this background is lighter.

This option is not applied for multistep gradations. Forcing a multistep gradient into a flat color
has to be done manually. The 4state Trapper always uses Step into Gradations.

7. Trap Images / All Separations (Packaging and Commercial only)

In order to trap mapped pictures automatically, enter a distance for Into CT and activate the
Trap Images option. By default it is switched off so that selected pictures are ignored during
autotrapping.

Using Version 1 & 2, mapped pictures trap with flat colors or linear gradations, not with multistep
gradations or other pictures. The autotrap result is a mapped picture with a minimum value added
for the underlying colors or a gradient transparent on top of the picture.

When all separations are active (default), it traps all the separations of the color, whether they are
in the picture or not. When the option is not active, the image is only trapped into separations
that are not in it.

For example, a cmyk image is put on top of a cyan background and a pantone 032. With the
option unchecked, it only traps into the pantone 032. With the option checked, it traps in both.
By default, all colors are spread in the image and black is choked. This can be adjusted using the
Black Margin (see earlier). The 4stage Trapper always traps All Separations.

8. Image to Image (4stage Trapper only)
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Using the 4stage Trapper, images are always trapped towards lineart. If the Image to Image
option is checked, images are also trapped towards images.

9. Image Mode (4stage Trapper only)

When set to Step into Image, the program decides on the trap direction according to the light-
dark principle. When set to Always towards images, the background is always forced to spread
into the image, even if this image is lighter.

10.Trapping Pairs

The Trapping Pairs button opens the dialog that holds the actual trapping pairs. A trapping pair
is represented by a From color, a To color and a Mix color. The From and To are the original
colors, whereas the From is spread into the To color. The Mix is the color of the actual trap.

2.12 The PitStop Profile Editor

You can easily create and manage PitStop PDF  Profiles and Action Lists using PitStop Profile
Editor from Automation Engine.

Read more about PitStop in http://www.enfocus.com/en/support/knowledge-base

2.12.1 Setting Up the PitStop Profile Editor

You can download PitStop Profile Editor the Client Apps section of of Automation Engine server
web page. You can access it by browsing to http://<name of your server>  or  http://
<name of   your server>:9999 .Read more in Main on page 208

1. Download and install the PitStop Profile Editor on your client computer where the Pilot is
installed.

• On Windows:

1. Double-click on the Automation Engine PitStop Profile Editor.exe.
2. Click Next on Esko Installshield Wizard on your client machine.
3. Confirm on Installshield Wizard that you want to install PitStop Profile Editor by clicking Yes
4. Browse to the location where you want the Wizard to create subdirectories. The default

location will be C:\Esko.
5. Click Next.
6. Finish the installation.

• On Mac:

1. Double-click on the downloaded Automation Engine PitStop Profile
Editor.dmg.

2. Double-click on the Automation Engine PitStop Profile Editor.pkg. The
Assistant will guide you through the installation.

3. Click Continue.
4. Click on Change Install Location to specify the location where you want the

subdirectories.
5. Click Install. Fill in your credentials to confirm the installation.
6. A message The installation was successful will appear. Close the installation.

http://www.enfocus.com/en/support/knowledge-base
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2. Start the application from:

• All Programmes > Esko > Automation Engine PitStop Profile Editor > PitStop Profile
Editor .

• Applications > Automation Engine PitStop Profile Editor > PitStopProfile Editor .

3. Fill in the host name of the Automation Engine server in the  Edit > Preferences  window. This
will integrate the application with the PDF Profiles and Action Lists from this server.

You can now access the the PDF Profiles and Action Lists from the Automation Engine Server.
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2.12.2 Using SmartNames in PitStop Profile Editor

You can use SmartNames in PitStop Profiles and Action Lists in Automation Engine Profile Editor. You
can make use of PitStop's "Smart Preflight" and reduce the the number of Profiles and Action Lists.

The PitStop Profile Editor loads the global SmartNames from the Automation Engine server that has
been entered in the preferences.

1.
Create SmartNames in SmartNames View by clicking New SmartName icon  in the toolbar.

Read more in Creating a SmartName

2. Start the application from :

• All Programmes > Esko > Automation Engine PitStop Profile Editor > PitStop Profile
Editor .

• Applications > Automation Engine PitStop Profile Editor > PitStopProfile Editor .

You can access the PDF Profles and Action lists in the PitStop Profile Editor.

3. Select one of the PDF Profiles and click on the menu button  to expand menu options. From
the following drop-down, choose New.

4. Enable one of the CHECK ONs.



2
Automation Engine

785

a) You can now choose from Available Checks pertinent to your CHECK ON.
b)

Click on Actions  and Enable Variable Names.

5. Click on the blue SmartName (Variable)  icon. Created SmartNames (Global) and System
SmartNames will be available.

6. Choose the desired SmartName and Click OK. You can also give a brief Description.

You can use a SmartName in fields requiring:

• text
• niumber
• measurements (size in "mm", "cm" , "in", "p" (picas) or "pt" (points) ).

Attention:  Specify units in the measurement SmartNames (i.e. "mm", "cm", "in", "p"
etc). . If the unit is not specified, SmartName value assumes points as its units. For
example, SmartNames representing A4 dimensions, should resolve to "210 mm" and
"297 mm". If the SmartNames resolves to "210" and "297", the dimensions will be
taken as 74mm x 105mm while preflighting.

• toggling on or off.

Note:  The SmartName value "0", "FALSE" or empty, corresponds to check box which is off.
"1", "TRUE" or anything else corresponds to on.
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2.13 The RunList Editor

The RunList Editor enables you to create and modify RunLists.

A RunList is a file used to collect several files into one Job Folder, or to make one final PDF out of
several smaller PDFs (for example for imposition). It contains the names of the files to be collected
or joined, their collecting / joining order and their original location.

You can use this for example with the Wait for Files (via JDF) task. If you want to collect a number of
files with different file names, you can create a RunList referencing those files, and feed that RunList
to the Wait for Files (via JDF) task.

2.13.1 Setting Up the RunList Editor

1. Install the RunList Editor on your client machine (where the Pilot is installed):

• On Windows:

1. Open an Explorer window and type the following in the address bar: \\Automation
Engine Server Name\Automation Engine 10.1 Windows Client (where
Automation Engine Server Name is the name or IP address of your Automation Engine
server).

2. Copy Automation Engine RunList Editor 10.1.0.exe on your client machine.
3. Double-click the exe file to install the application.

• On Mac:

1. In Finder, go to  Go > Connect to Server...  (or use Command + K).
2. In the Server Address field of the Connect to Server dialog, type smb://Automation

Engine Server Name/Automation Engine 10.1 Mac Client (where Automation
Engine Server Name is the name or IP address of your Automation Engine server).

3. Copy Automation Engine RunList Editor 10.1.0.dmg on your client machine.
4. Double-click the dmg file to install the application.

2.

Double-click the RunList Editor shortcut  on your desktop to open the RunList Editor
application.

3. Go to  Edit > Preferences  (on Windows) or  RunList Editor > Preferences  (on Mac) to open
the Preferences window.

4. Connect the RunList Editor to your Automation Engine server:

a)
In the Servers tab, click the  button at the bottom of the Servers list.
In the pop-up that opens:
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b) enter the User Name and Password you use to login to the Pilot,
c) select Manual in the Browse Method list,
d) enter your server’s name or IP address in Server Address,
e) fill in the Server Port used by your server.

This is the port you defined in Configure for Shuttle communication (see Automation Engine
Setup for Shuttle on page 48).

f) Click the Add button.

This adds a connection to your server in the Servers list. You should see a green dot if the
connection was successful.

5. In the Units tab, choose the units to use when submitting to a workflow that has public
parameters:

a) Choose to define the Distance in Millimeter, Point or Inch.
b) Choose to define the Resolution in Pixels Per Millimeter or Pixels Per Inch.
c) Choose to define the Screen Ruling in Lines Per Millimeter or Lines Per Inch.

2.13.2 Creating a RunList

1. Go to  File > New  to create a RunList.

You can also use Ctrl + N (Windows) or Command + N (Mac).

This opens the following dialog:
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2. Add files to the RunList:

a) Click the Add Pages button in the toolbar.
b) In the pop-up that opens, use the Browse... button to browse to your file.
c) Define which of the file’s pages you want to add to the RunList (for example, if you want to

add the pages 1, 2, 3 and 7, enter 1-3, 7 in Page range).

Note:  By default, the From 1 to ... option is selected, selecting all pages.

d) Click OK.

This creates an entry for every file you add.
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You can see the RunList’s total number of pages at the bottom of the dialog.

Note:

You can also drag and drop one or several file(s) into the dialog to add them to the RunList.

By default, this adds all of the files’ pages, but you can double-click an entry to edit it.

3. If necessary, click the Add Blank Page button in the toolbar to add blank pages to the RunList.

4. You can also add a placeholder for a file that is not available yet:

a) Click the Add Pages button.
b) Type the file name in the pop-up’s File Name field.
c) Click OK.

The RunList dialog will show an orange “?” icon, to indicate that you still have to provide a link
to the file.
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Tip:

• You can also create placeholders for several files that are not yet available. See Adding a
Number of Placeholders on page 790.

• You can use Undo (Ctrl + Z (Windows) or Command + Z (Mac) or Redo (Ctrl + Shift + Z
(Windows) or Shift + Command + Z (Mac) when creating or editing a RunList.

• To delete a RunList entry, select it and press Delete (Windows) or Command + BackSpace
/ Delete (Mac).

You can use Ctrl + A / Command + A first to select all entries for deletion.

• To duplicate a RunList entry, select it and press Ctrl + D (Windows) or Command + D (Mac).

5. When you are done, go to  File > Save  (or use Ctrl + S (Windows) or Command + S (Mac) and
give your RunList a name.

RunLists are saved in the JDF format.

Adding a Number of Placeholders

To create placeholders for several files that are not yet available:

1. Go to  RunList > Auto Add...

This opens the Auto Add Name Format dialog.

2. In Number of Pages, enter the number of placeholder entries to create.

3. Use the Prefix Text, Number Format and Suffix Text fields to define the name to give to the
placeholders.

The Number Format specifies the number of digits to use in the file name.

For example, this format:

generates the entries below:
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While this format:

generates those entries:
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2.13.3 Viewing the RunList Files

Context for the current task

•

To view the pages grouped by file, click  and select RunList (Windows), or click  (Mac).

•

To view each page individually, click  and select Page List (Windows), or click  (Mac).

2.13.4 Changing the Files' Extension

• Go to  RunList > Change Extension...  to change the extension of all your individual files at once.
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For example, you can use this to create the RunList from original InDesign files, then change the
extension to PDF to use individual PDF files in your workflow.

Note:  If you don’t have the files with the new extension at the location defined in the RunList,
they will have an orange “?” icon.

2.13.5 Sorting the RunList's Files

• Select entries in the main dialog and go to  RunList > Sort Selection By Name  to sort them
alphabetically.

• You can also drag the entries to reorder them.

This updates the order of the RunList pages automatically.

2.13.6 Submitting the RunList to a Workflow

Once your RunList is ready, you can submit it to an Automation Engine workflow of your choice.

Attention:  Make sure that:

• The RunList Editor is connected to your Automation Engine server (see Setting Up the
RunList Editor on page 786).

• The workflow you want to submit your RunList to is public (see Making Your Ticket Public
on page 49 in the User Guide).

• The RunList and the individual files it references are accessible to the Automation Engine
server (saved on an Automation Engine container).

• You have replaced any placeholders in the RunList by the actual files.

1. Go to  File > Submit...

This opens the following dialog:
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2. Select the workflow you want to launch on your file in the Workflow list.

3. In Launch As, you can change the name of your RunList before launching it into the workflow
if desired.

4. If you also want to submit the individual files referenced in the RunList, select their check boxes.

For example, when submitting to a workflow starting with a Wait for Files (via JDF) workflow step:

• submit the referenced files along with the RunList from the RunList Editor,
• in the Wait for Files (via JDF) parameters, use [URL of Folder of Input] for Look in Folder.

The referenced files will be copied to a temporary folder alongside the RunList, and picked up
by the workflow step.

5. Click Launch.

2.14 The Script Runner

2.14.1 Scripting for Script Runner on Mac OS

A Script Runner on Mac OS supports AppleScript and Shell Script to automate operations.

Note:

Sample scripts are provided as-is with no warranty of fitness for a particular purpose. These scripts
are solely intended to demonstrate techniques for accomplishing common tasks. Additional script
logic and error-handling may need to be added to achieve the desired results in your specific
environment.

It is up to the user to verify that his intended use of the offered automation functionality is compliant
with any third party license agreement and/or other restrictions applicable to any non-Esko products.
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Using AppleScript on Script Runner

AppleScript is a scripting language that makes direct control of scriptable applications and of many
parts of the Mac OS possible. An AppleScriptable application is one that makes its operations and
data available in response to AppleScript messages, called Apple events.

We recommend using AppleScript because:

• it is highly integrated into the Mac OS
• it is supported by a lot of third party applications
• it has a high level of accessibility for scripting beginners

1. Open the AppleScript Editor and add following code.

Options Description

main This function will be called by the Script
Runner. Only the code in this main function
gets executed.

inputs The first argument of the main function: a list
of input file paths (type: list of strings).

outputFolder Second argument of the main function: the
folder where AE expects the script’s result files.
AE will continue the flow with the files you write
in this folder. If you leave this folder empty, AE
will continue the flow with the inputs of the Run
Script task (type: string).

params Third argument of the main function: additional
script parameters injected into the script via
the Run Script ticket (type: list of strings).

log Extra log information in the Run Script task
details

return “OK” This will communicate with the Run Script
task that everything went fine. Other
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Options Description

possibilities are return “Warning” and
return “Error”.

2. Save this code as an AppleScript text file in the Script Runner’s AppleScript folder (default: /
Library/Scripts/Esko/AppleScript) or in the Automation Engine AppleScript folder.

Note:  Script Runner supports ‘Text’ format. Therefore it is essential to change the file format to
‘Text’.

3. You can add following code to test this script locally in the AppleScript Editor. Save the file and
click Run to execute the script.
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Notice the ‘Hello, World!’ and ‘OK’ result in the event log. The Script Runner does not attend to
the test code in your script. It will execute the contents of the main function and ignore the rest.
Therefore, you can keep your test code for future local testing.

4. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New
Task. Choose the Run Script task, modify its settings and launch the task.

Read more in Run Script on page 469

Note that the ‘Hello, World!’ in the task details and ‘OK’ state are corresponding with log
“Hello, World!”’ and ‘return “OK”’ in the script.
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Using AppleScript On Script Runner: A Sample Case

We can use inputs, outputFolder and params in the AppleScript to achieve our objective. First,
we demonstrate how to duplicate files without the size restriction and then proceed with the actual
case.

1. Open the AppleScript Editor and add the code given below. This code is aimed to iterate through
the list of inputs. It enables you to handle the inputs one by one, via the ‘input’ variable.

2. You can modify the Script as given below to duplicate the files to a specified output folder
without size restrictions. Save this code as an AppleScript text file in the default AppleScript
folder of Script Runner(default: /Library/Scripts/Esko/AppleScript) or in the Automation Engine
AppleScript folder.
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3. Add the file size check in the code as given below. This will duplicate the file when the input file
size is smaller than the maximum size from the script parameters. If this condition is not met it
will add an entry in the log and there will be "Warning". Save the file.
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4. Open the Automation Engine Pilot. Go to Files view where you can select the files to be copied
and open a New Task. Choose the Run Script task, modify its settings and launch. This modified
ticket will duplicate every selected file which is smaller than 10MB to the current job’s Script
Output folder. In this example, we excuted this task for two files(Blairon.pdf: 22MB and Dansk
Droge.pdf: <1MB).
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‘Dansk Droge.pdf’ is duplicated into the job’s Script Output folder. ‘Blairon.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the task
details.

Using Shell Script on Script Runner

In this example, we use a Shell Script to copy every input file with a size smaller than the specified
size in the script parameters to the output folder.

1. Open a text editor and add following code. When the Script Runner executes this code, $1 (the
script’s first argument) will contain a string of input file paths separated by :. The code splits up
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the concatenated file paths into a real list. This helps to iterate through the list and handle the
Run Script task’s inputs one by one.

2. Write and save the code as below. This script copies the input to the output folder if the input’s file
size is smaller than the maximum size from the script parameters. If the size of the file is bigger, it
adds an entry in the log and makes sure the task ends in ‘Warning’ state (via exit value ‘1’). Save
this code as a text file to the Script Runner's Shell folder (default: /Library/Scripts/Esko/Shell)
or to the Automation Engine Shell folder.
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$1 First shell script argument: the Run Script
task’s inputs. A string of input file paths,
separated by ‘:’.

$2 Second shell script argument or output
folder: This is the folder where Automation
Engine expects the script’s result files. AE
will continue the flow with the files you write
in this folder. If you leave this folder empty,
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AE will continue the flow with the inputs of
the Run Script task.

$3, $4, $5, … Remaining shell script arguments:
additional script parameters which you
can inject into the script via the Run Script
ticket.

exitValue Ending Status of the task

0 OK

1 Warning

2 Error

3. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a
New Task. Choose the Run Script task, modify its settings and launch. This modified ticket will
duplicate every selected file which is smaller than 10MB to the current job’s Script Output folder. In
this example, we excuted this task for two files(Blairon.pdf: 22MB and Dansk Droge.pdf: <1MB).

‘Dansk Droge.pdf’ is duplicated into the job’s Script Output folder. ‘Blairon.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state (due to exitValue=1 in the
code) and added an entry in the task details.
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2.14.2 Scripting for Script Runner on Windows

A Script Runner on Windows supports Windows Script and Batch File. We recommend Windows
Script for its scripting abilities comparable to batch files, its wider range of supported features and
the simpler syntax. Windows Script is plain-text VBScript or JScript which is interpreted and run by
the Windows Script Host.

Using Windows Script on Script Runner

1. Open a text editor and add the following code:

Function Main The function that will be called by the Script
Runner. Script Runner executes only the
code in this main function.



2
Automation Engine

807

inputs First argument of main function: a list of
input file paths(type: list of strings).

outputFolder Second argument of the main function:
the folder where AE expects the script’s
result files. AE will continue the flow with
the files you write in this folder. If you leave
this folder empty, AE will continue the flow
with the inputs of the Run Script task (type:
string).

params Third argument of the main function:
additional script parameters injected into
the script via the Run Script ticket (type: list
of strings).

WScript.Echo This puts some extra log info in the Run
Script task details and log. This call prints
text to the Console and adds a newline
character without Script Runner context.

Main = “OK” This will communicate with the Run Script
task that everything went fine. Other
possibilities are Main = “Warning” and
Main = “Error”.

2. You can test this script locally by adding the following code: Save this file. Open command
prompt. Change the directory to the script’s parent directory. Run command ‘cscript
MyHelloWorld.vbs’.

This will produce the output ‘Hello, World!’ to the console. The Script Runner does not attend to
the test code in your script. It will execute the contents of the main function and ignore the rest.
Therefore, you can keep your test code for future local testing.
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3. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New
Task. Choose the Run Script task, modify its settings and launch the task.

Note that the ‘Hello, World!’ in the task details and ‘OK’ state are corresponding with
WScript.Echo “Hello, World!” and Main = “OK” in the script.
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Using Windows Script On Script Runner: A Sample Case

We can use inputs, outputFolder and params in the AppleScript to achieve our objective. First,
we demonstrate how to duplicate files without the size restriction and then proceed with the actual
use case.

1. Open a text editor and add the code given below. This code is aimed to iterate through the list of
inputs. It enables you to handle the inputs one by one, via the ‘input’ variable.
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2. You can modify the Script as given below to duplicate the files to a specified output folder without
size restrictions. Save this code as a text file with ‘.vbs’ extension (VBScript) in the Windows
Script folder of Script Runner (default: C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts
\WindowsScript) or in the Automation Engine WindowsScript folder.
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3. Add the file size check in the code as given below. This will duplicate the file when the input file
size is smaller than the maximum size from the script parameters. If this condition is not met it
will add an entry in the log and there will be "Warning". Save the file.
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4. Open the Automation Engine Pilot. Go to Files view where you can select the files to be copied
and open a New Task. Choose the Run Script task, modify its settings and launch. This modified
ticket will duplicate every selected file which is smaller than 10MB to the current job’s Script
Output folder. In this example, we excuted this task for two files(Blairon.pdf: 22MB and Dansk
Droge.pdf: <1MB).
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‘Dansk Droge.pdf’ is duplicated into the job’s Script Output folder. ‘Blairon.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the task
details.
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Using Batch File for Scripting on Windows

1. Open a text editor and add the code given below. This code is aimed to iterate through the list
of inputs. It enables you to handle the inputs one by one, via the command %1 (the script’s first
argument) will contain a string of input file paths, separated by ‘;’.

2. You can modify the Script as given below to duplicate the files to a specified output folder with a
size check. Save this code as a text file with ‘. bat ’ extension in the Script Runner Batch File Folder
(default: C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts\BatchFile) or in the Automation
Engine BatchFile folder.
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%1 First batch file argument: the Run Script
task’s inputs. A string of input file paths,
separated by ‘;’.

%2 Second batch file argument or output
folder: the folder where AE expects the
script’s result files. AE will continue the flow
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with the files you write in this folder. If you
leave this folder empty, AE will continue the
flow with the inputs of the Run Script task.

%3, %4,%5… Remaining batch file arguments: additional
script parameters, injected into the script
via the Run Script ticket.

Exit value Ending Status of the task

0 OK

1 Warning

2 Error

3. Open the Automation Engine Pilot. Go to Files view where you can select the files to be copied
and open a New Task. Choose the Run Script task, modify its settings and launch. This modified
ticket will duplicate every selected file which is smaller than 10MB to the current job’s Script
Output folder. In this example, we excuted this task for two files(Blairon.pdf: 22MB and Dansk
Droge.pdf: <1MB).

‘Dansk Droge.pdf’ is duplicated into the job’s Script Output folder. ‘Blairon.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the task
details.



2
Automation Engine

817

2.14.3 Using ExtendScript on Script Runner (On MacOS/Windows)

ExtendScript is JavaScript extended for Adobe CS applications. Adobe provides a complete
integrated development environment (IDE) for programming ExtendScript which is the ExtendScript
Toolkit (ESTK). Latest versions of the ESTK are available with the Creative Suite. For more info and
Adobe scripting resources visit the Adobe Scripting Center.

1. Open the ExtendScript Toolkit and add following code. Save this code in the Script Runner’s
ExtendScript folder. The default location is : /Library/Scripts/Esko/ExtendScript for a Script
Runner on Mac OS or C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts\ExtendScript on
Windows. Alternatively, you can save them in the ExtendScript folder of Automation Engine.
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Main This function will be called by the Script
Runner. Only the code in this main function
gets executed.

Inputs First argument of main function: a list of
input file paths (type: list of strings).

outputFolder Second argument of the main function:
the folder where AE expects the script’s
result files. AE will continue the flow with
the files you write in this folder. If you leave
this folder empty, AE will continue the flow
with the inputs of the Run Script task (type:
string).

params Third argument of main function: additional
script parameters, injected into the script
via the Run Script ticket. (type: list of
strings)

$.writeln This writes extra log information in the Run
Script task details and log. Without Script
Runner context this call prints text to the
Console, and adds a newline character.

alert This registers some extra log info in the Run
Script  task details and log. Without Script
Runner context this call displays an alert
box.
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return “OK”; This will communicate with the Run Script
task that everything went fine. Other
possibilities are Return = “Warning”
and Return = “Error”.

2. To test the script locally in the ExtendScript Toolkit, add following code, save and run.

Note that the alert box pops up and the ‘Hello, World!’ and ‘OK’ result in the Console.

 

The Script Runner does not attend to the test code in your script. It will execute only the contents
of the main function and ignore the rest. Therefore, you can keep your test code for future local
testing.

3. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New
Task. Choose the Run Script task, modify its settings and launch the task.
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Note that the ‘Hello, World!’ in the task details and ‘OK’ state are corresponding with
$.writeln("Hello World!")  and Return = “OK” in the script.
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Using ExtendScript on Script Runner: A Sample Case.

Note:  When you use ExtendScript on Windows, you can avoid troubles while accessing your user
specific settings such as Adobe applications' Presets , Actions etc by stopping the Script Runner
service and running it as an application for the logged in user (who also defined Adobe settings).

Open  Start > All Programs > Esko > Automation Engine Script Runner > Preferences .

Stop the Script Runner and uncheck Start at login (which actually means ‘Start as service’) and
Close Preferences.

Start as a console application by double clicking its executable:
Script Runner’s program folder>\bin_ix86\egscrrun.exe (for example C:\Esko
\bg_prog_fastserverscrrunnt_v120\bin_ix86\egscrrun.exe)

Note:  To prevent having to start up the Script Runner every time you log in, add its executable to
your user’s/system’s Startup Items.

1. Define a My Print Preset in your Adobe Illustrator application.

2. Open the ExtendScript Toolkit and add following code. This code is aimed to iterate through the
list of inputs. It enables you to handle the inputs one by one, via the input variable.

3. To print every input file using a Print Preset from the script parameters of the  Run Script task,
write the code as below. Save this code in the default ExtendScript folder(of Script Runner or
Automation Engine).
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4. Open the Automation Engine Pilot. Go to Files view where you can select a file and open a New
Task. Choose the Run Script task, modify its settings and launch the task.
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Launching this ticket will result in the selected Illustrator files being printed using the Print Preset
specified as script parameters (My Print Preset) in the task.

2.14.4 Appendix : Script Samples

Note:

Sample scripts are provided as-is with no warranty of fitness for a particular purpose. These scripts
are solely intended to demonstrate techniques for accomplishing common tasks. Additional script
logic and error-handling may need to be added to achieve the desired results in your specific
environment.

It is up to the user to verify that his intended use of the offered automation functionality is compliant
with any third party license agreement and/or other restrictions applicable to any non-Esko products.

AppleScript Code Samples

MyHelloWorld.applescript

on main(inputs, outputFolder, params)
 log "Hello, World!"
 return "OK"
end main
on run
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 -- Our main function is not using any of its arguments, so provide empty ones
 set inputs to {} -- empty list
 set outputFolder to "" -- empty string
 set params to {} -- empty list
 main(inputs, outputFolder, params)
end run

MyDuplicate.applescript

on main(inputs, outputFolder, params)
 set returnValue to "OK"
 
 -- Translate the output folder (UNIX path) into an AppleScript file
 reference
 set outputFolderReference to POSIX file outputFolder
 
 -- Get the maximum size from the script parameters and convert from megabyte
 to bytes
 set maxSize to (item 1 of params) * 1000000
 
 -- Iterate through the list of inputs
 repeat with input in inputs
  -- Translate the input (UNIX path) into an AppleScript file reference
  set inputReference to POSIX file input
  
  -- Get the size of the input
  set inputSize to size of (info for inputReference)
  
  -- Check wether the input is OK to duplicate
  if inputSize < maxSize then
   -- Duplicate input to output folder
   tell application "Finder" to duplicate inputReference to
 outputFolderReference with replacing
  else
   log input & " is too big to duplicate"
   set returnValue to "Warning"
  end if
 end repeat
 
 return returnValue
end main

Shell Script Code Sample

MyCopy.sh

#!/bin/bash

# Split up the input file paths into a list
# via the Internal Field Separator (IFS)
OLDIFS=$IFS # Always keep the original IFS
IFS=":" # Now set it to ':'
# Split up '$1' into the 'inputs' variable, with ':' as separator
inputs=( $1 )
IFS=$OLDIFS # Restore the original IFS

inputCount=${#inputs[@]}

# Get the output folder
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outputFolder=$2

# Get the maximum size from the script parameters
# and convert from megabyte to bytes
maxSize=`expr $3 \* 1000000`

exitValue=0

# Iterate through the list of inputs
for (( i=0; i<${inputCount}; i++ ));
do
 input=${inputs[$i]}
 # Get the size of the input
 inputSize=`ls -l "$input" | awk '{print $5}'`
 
 # Check wether the input is OK to copy
 if [ $inputSize -lt $maxSize ]; then
  # Copy input to output folder
  cp -f "$input" "$outputFolder"
 else 
  echo "$input is too big to duplicate"
  exitValue=1
 fi
done

exit $exitValue

Windows Script Code Samples

MyHelloWorld.vbs

Function Main(inputs, outputFolder, params)
 WScript.Echo "Hello, World!"
 ' Set the function's return value.
 Main = "OK"
End Function

' Our main function is not using any of its arguments,
' so provide empty ones.
Dim inputs()
Dim outputFolder
Dim params()
Main inputs, outputFolder, params

MyCopy.vbs

Function Main(inputs, outputFolder, params)
 Dim returnValue
 returnValue = "OK"
 
 ' Get the maximum size from the script parameters
 ' and convert from megabyte to bytes.
 Dim maxSize
 maxSize = params(0) * 1000000
 
 ' Create the file system object that is going to do the copying.
 Dim filesys
 Set filesys = CreateObject("Scripting.FileSystemObject")
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 WScript.Echo "File system object created"
 
 ' Iterate through the list of inputs.
 For Each input In inputs
  ' Turn the input path into a file object.
  Dim inputReference
  Set inputReference = filesys.GetFile(input)
  
  ' Check wether the input is OK to copy.
  If inputReference.Size < maxSize Then
   ' Copy input to output folder.
   Dim outputFile
   outputFile = outputFolder & "\" & filesys.GetFileName(input)
   filesys.CopyFile input, outputFile
  Else
   WScript.Echo input & " is too big to copy"
   returnValue = "Warning"
  End If
 Next
 
 ' Set the function's return value.
 Main = returnValue
End Function

Batch File Code Sample

MyCopy.bat

@echo off
rem First script argument contains the input file paths
set inputs=%1
rem Trim surrounding quotes
for /f "usebackq tokens=*" %%a in ('%inputs%') do set inputs=%%~a

rem Get the output folder
set outputFolder=%2

rem Get the maximum size from the script parameters
rem and convert from megabyte to bytes
set /a maxSize=%3*1000000

set exitValue=0

rem Iterate through the input file paths which are separated by ';'
:ITERATE_INPUTS
if "%inputs%"=="" goto EXIT
for /f "tokens=1 delims=;" %%a in ("%inputs%") do call :HANDLE_INPUT "%%a"
for /f "tokens=1* delims=;" %%a in ("%inputs%") do set inputs=%%b
goto ITERATE_INPUTS

:HANDLE_INPUT
rem Get the size of the input
for %%? in (%1) do set inputSize=%%~z?
rem Check wether the input is OK to copy
if %inputSize% lss %maxSize% (
 rem Copy input to output folder
 copy /y %1 %outputFolder%
) else (
 echo %1 is too big to copy
 set exitValue=1
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)
goto :eof

:EXIT
exit %exitValue%

ExtendScript Code Samples

MyHelloWorld.jsx

function main (inputs, outputFolder, params) {
    $.writeln ("Hello, World!");
    alert ("Another way to say: Hello, World!");
    return "OK";
}
// Our main function is not using any of its arguments, so you can test
 main without arguments
main ();

MyPrint.jsx

function main(inputs, outputFolder, params) {
    // First and only script parameter is the print preset.
    var printPreset = params[0];
    
    var returnValue = "OK";
    
    // Iterate through the list of inputs.
    for (i=0; i<inputs.length; i++)
    {
        var input = inputs[i];
        
        try
        {
            // Open the input file.
            var myDocument = app.open(File(input), DocumentColorSpace.CMYK);
            // Create print options and set the print preset.
            var options = new PrintOptions();
            options.printPreset = printPreset;
            // Print the document.
            myDocument.print(options);
            // Close the document without saving.
            myDocument.close(SaveOptions.DONOTSAVECHANGES);
        }
        catch (e)
        {
            // Log problem info and set the return value to "Warning".
            $.writeln("Problem while printing " + input);
            $.writeln("Name: " + e.name);
            $.writeln("Message: " + e.message);
            returnValue = "Warning";
        }
    }

    return returnValue;
}
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3. Jobs

3.1 Job Basics

3.1.1 The Job Concept

What is an Automation Engine Job?

An Automation Engine Job represents an amount of work to be done for a certain order in your
business system. This can be a classic order management system but it could also come from a web
application that needs Automation Engine to execute some prepress tasks.

A Job is an entry in the Automation Engine Jobs database and has a unique name. In the Pilot, Jobs

are represented by this blue folder icon .

In Automation Engine, a Job consists of 2 things:

• data: files and folders, stored under the Job's Job Folder, in a Container.
• metadata: the parameters of that job order, usually how the order management system describes

this job. They can be general parameters like the job's name, order ID, customer and due date
but can also be parameters describing what to do with the input files to get to the targeted result.

Jobs can be created manually by an Automation Engine user or automatically via some integration
with an external system.

A Job represents Work In Progress (WIP). This means that you should remove Jobs that are 'done'.
Removing a Job from the Automation Engine Jobs database does not mean that you have to delete
the related data files.

Most Automation is based on Jobs

A lot of the automation that Automation Engine brings comes from the fact that tasks can
automatically use parameters from their Job context. Job parameters automatically become
SmartNames and the (workflow) task tickets can use those SmartNames to pick up their values.

Note:  Customers that do not use Jobs at all find a similar level of automation by using Workflow
Parameters. Learn more in Using Workflow Parameters on page 1065.

Launching tasks on Jobs

Jobs can be managed manually in the Pilot, but several actions are also possible by launching tasks.

• The Create Job task on page 1280 task allows to create and modify Jobs.
• The The Check Job Parameters Task on page 874 task allows to check and correct barcode

and ink parameters used in designs.
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• The Archive Job task and the Restore Job task allow to remove Jobs, store their data on a different
network place and, if needed later, restore them back, including their metadata.

• The Relocate Job task allows to move a Job's Job Folder to a different place. For example to
another Container that has more disk space.

Learn more about these tasks in Tasks you can Launch on Jobs on page 869.

Like all tasks, these tasks can also be triggered by an external system. Learn more in Integrating
with External Systems on page 1228.

3.1.2 Types of Jobs

Conceptually, we can distinguish several types of Automation Engine Jobs. This categorisation
usually depends on these factors:

• What type of site are you? Does your company only do prepress or do you also produce? And if
you produce, do you also re-produce items that you produced before?

• Is your Automation Engine closely integrated with your order management system? If it is, then
Automation Engine best follows a similar process logic as in that system. Terms like jobs, orders,
products, items, milestones etc. will need to have the same meaning.

We distinguish 3 types of Jobs:

Attention:  The categorization of these job types does not appear in the user interface of
Automation Engine. Their names are only used here to illustrate different ways of working
with the tools Jobs and Products. Learn more about Products in Products on page 876.

Type 1: A Prepress Job

The goal of a Prepress Job is to make a single one-up design print-ready. Typical steps are preflight,
making print-ready and approval. The result is a file that is ready to be produced.

Some variations:

• The production can then be done in-house (in another Job, under another order number) or the
print-ready file can be sent out to a company that produces.

• The resulting file can be registered as an Automation Engine Product.
• A Prepress Job can result in multiple files, but only when they belong to the same product item,

for example front and back graphics. They probably also share the same approval cycle.
• At (flexo) prepress houses ('trade-shops'), the result could also be a set of plates.

The Job can be removed when the work is done.

Type 2: A Production Job

A Production Job is a job that uses one or multiple product items for a specific production run. The
product items were already approved and print-ready. The goal of this type of job is output.

A Production Job does not contain the one-up's data in its job folder, but links to one or multiple
Products. The job folder of a Production Job typically only stores the layout files or other data that
are unique to this specific production order. The product data stay in their Product Data Zone.

The Job can be removed when the work is done. The Products are not removed, they stay 'live' until
a next Job links them in for another production run.
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Type 3: An All-In-One Job

Some customers have Jobs in which they handle both the prepress work and the output production.
The one-up data is stored inside the job folder, not registered as a Product and the workflow
continues within this Job with the productions steps (layout, plates, send to press...). Production
related data is also kept inside this job folder.

In some cases, when the output is combined with other (already existing) items, this can mean that
the one-up data is copied from other (older) jobs into in this job folder.

The Job can be removed when the complete work is done.

Attention:  In this chapter, we will describe the use of Jobs without the use of the Products
tool.

3.1.3 The Job Views

General Job Views

The Pilot and its Views were introduced in The Pilot's Main Window on page 20. We here illustrate
some job-related specifics:
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1. Type of View.

• The  Containers view shows the folder structure of your Containers but will show a folder
in blue when it is an active Job Folder. Double click any blue folder to select and view that job.

• The  Job Overview shows all jobs (or a filtered list). You can combine this with Smart Views
on page 163.

• The  Last used Job view opens the last used job in the job specific view.
2. Info. This button opens the Job Setup of the selected job. Learn more in Job Setup Parameters

on page 837.
3. Search input field. Learn more in Job View Filters on page 832.
4. Job Overview. Define the columns and their order in  View >  Select Columns in 'Jobs'... .
5. Job Details. See some of the job's details. Learn more in Job Setup Parameters on page 837.
6. Amount of Jobs (selected).

Note:  When you open the dropdown list, you can select another job that you recently used. You can
set the amount of remembered jobs in  Edit >  Preferences >  Pilot .

Tip:  If you regularly switch between same views, consider using multiple view tabs ( File >  New
Tab ). For example:
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Job View Filters

Basic Searching

When you type in a filter in the Search input field, the filter will be looked for in All of the default
attributes Order ID, Name, Project ID, Customer Job Reference.

Tip:  You can use double quotes to restrict the search. For example

• FL 123 will list jobs that have both FL and 123 in at least one attribute.

• "FL 123" will only list jobs that have this exact string in at least one attribute.

Click Save to save this search. Decide if it is for all users or only yourself and if you want to add
it to your views bar.

Advanced Searching

If you want to search in other attributes, or if you want to create advanced search criteria, click on
the + button. A new search criterion appears.

See how the attributes dropdown list offers many more attributes:
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In the dropdown list, select Other... to add even more attributes to this list. For example Customer
name.

Use the + button to continue adding search criteria. For example:

You can even add 'logical operators' to your criterion. Hold Alt when clicking on the + to start your
criterion with All, Any or None. See this example where you are not sure which CSR handles this
job order:

Click Hide Criteria to hide the lines with the criteria but still have them active.
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As shown above, you can save the (set of) search criteria. You can re-use it later as a Smart View
or pick it from the dropdown list in the search field:

Job Specific View

When you select a job from the dropdown list of last used jobs, or when you double click a blue job
folder, the view adapts and focuses on that job.

• The Pilot top bar mentions the name of the selected job.
• The Last Used Job drop down list mentions the name of the job folder.
• The Folders pane shows the (blue) job folder, its subfolders and their files.
• The Tasks pane shows the tasks that were launched in this job context.
• The list of favorite tickets also shows (blue) job tickets (saved for this job only).

All tasks that are launched in this view will run "in this job". Job-based SmartNames will now get
their values from this job.

3.1.4 The Job Menu

Note:  When no job is selected, some of the menu options are unavailable.
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• New Job.... Learn more in Creating a Job on page 835.

• Go to Job. When a job is selected in a list, use this to go to that job ('open' the job).

• Job Setup.... This opens the Job Setup dialog of the selected job.

• Find Job.... This opens a separate dialog to search for jobs. Learn more in Job View Filters on
page 832.

• Relocate Job. This moves the job folder of a (live) job. Select the ticket of the Relocate Job task.
Learn more in Tasks you can Launch on Jobs on page 869.

• Remove Job.... This removes the open or selected job(s) from the jobs database. You will be
asked to confirm and you can choose to keep the files and folders. Learn more about removing
multiple jobs and re-creating them in About Removing Jobs on page 867.

• Delete View Data.... This deletes all View Data present in the job folder. View data are stored in
hidden subfolders of files that were prepared for viewing in the Automation Engine Viewer. You
will be asked to confirm. You can choose to Also unmark subfolders that are marked for Speed
for Viewing. Learn more about this feature and View Data in Prepare for Viewer on page 415.

• Manage Job Filters.... This opens a dedicated dialog to manage job filters. Learn more in Job
View Filters on page 832.

3.2 Creating a Job

You can create jobs manually or they can be created automatically.

Creating a Job Manually

To create a job, you can first select an existing folder that will become the job folder, or you can have
a new job folder created while you create the job. Follow these steps:

1. In the Pilot, choose one of these methods to create a new job:

• go to  Job > New Job...

• right-click (on an existing folder) and select New Job...

• click the Create Job icon 

• (select a folder and) use Ctrl + Alt + N  (Windows) or Cmd + Alt + N  (Mac).

2. In the New Job dialog, decide if you want to use an existing job as a template.

• If you don't use a template, click OK and fill in all the parameters in the next dialog.

• If you want to an existing job as a template, select it and decide which type of parameters you
want to include from that job in your new job. Then click OK.
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The job you use as a template could be a job that is similar to the new one (for example the
123-lemon job has many same attributes as the 234-banana job). It could also be a job that
you specifically created to be used as a template (the typical 'flexibles' job for example).

The milestones that you copy from the template job will be added in the state that they were:
confirmed or not, with related milestone actions or not etc. Their time stamp will be relative to
the creation date and time of your new job. For example: you want your new job to also get
the milestone 'proof ready' 2 days after it was created.

Tip:  Copying milestones from another job will be useful when they are not confirmed yet.

3. A dialog opens with the Job Setup. Now you can fill in all the parameters for the job.

If you started from an existing folder or used a template, several parameters will already be filled in.



3
Automation Engine

837

Learn more in Job Setup Parameters on page 837.

Creating Jobs Automatically

In most cases, the Automation Engine Job originates in another system. Recreating that job manually
in the Pilot is not an efficient way of working. It is strongly advised to integrate Automation Engine
with that other system and so have the jobs come in automatically. This will both win you time and
reduce errors.

This integration can be based on an incoming file that describes the job or could be a bi-directional
link with that external system. In both cases, the Create Job task on page 1280 task will create
the Job in background (probably as part of a workflow task). Such an automated workflow can also
update Jobs with new or changed parameters.

Learn more in Integrating with External Systems on page 1228.

3.3 Job Setup Parameters

You can fill in the job setup parameters while creating a job, or, when you are in a job context, by
going to  Job > Job Setup... .

In an existing job, you can add or modify parameters at any time, except the Order ID and SubOrder
ID. Learn more in Job tab on page 838.

The parameters are spread over multiple tab sheets. The tab sheets Automation, Page Assignment
and Imposition only appear when you are using the module for page workflows.

Most job parameters are automatically offered as Job SmartNames. Learn more in SmartNames on
page 916.

The button Apply Job Setup... allows to copy parameters from other jobs. Select the job and define
which type of parameters you want to include from that job.
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This is similar to how you can use a template job at the moment of job creation. Learn more in
Creating a Job on page 835.

3.3.1 Job tab

The Job tab contains the main job order information:

Order ID: order management systems typically define a job order by an identification number. This
is a mandatory field.

Caution:  You can not change it once the job is created.

SubOrder ID: often, a job order also has a sub number (or text). You can leave this field blank.

Caution:  You can not change it once the job is created.

Important:  An Automation Engine job needs to be unique. More specifically, the combination of
Order ID and Suborder ID needs to be unique.

Job Name: this is the name that you see in the job overview lists. This is a mandatory field. If you
do not enter a name here, the name will be "OrderID_SubOrderID".

Important:  Also the name of the job needs to be unique.
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Note:  You can change the name after the job was created.

Note:  The job name will also be proposed as name for the job folder. Learn more below.

Description: a short text describing the job order. By using its SmartName version, this text can for
example also be picked up in a report PDF.

Due Date: the due date and time for this job order. This date is used in job filtering and also in several
tasks that allow choosing the Job Due Date as one of the choices for the task due date. For example
the Submit to Gang Run on page 1109 task and the Publish on WebCenter task on page 1353 task.

Project ID: the identification number of the project that this job order belongs to. Project numbers
are typically defined by the order management system or any other external system. This parameter
can be useful to find jobs that belong to a same project. This parameter can match to a project on
WebCenter.

Category: choose a category from the list. Categories are often used to help you find jobs or to
define the route of a workflow. Click the button Categories... to add new categories manually or by
loading a list from an XML file.

You can add more custom categories. Two are offered in this tab sheet: Custom Field 1 and Custom
Field 2. You can set four more in the tab Categorization. You can configure their custom names in
Configure - Jobs - Job Setup. See an example in the above screen shot.

Tip:  In the page about the tab Categorization, you can find a table with matching names of categories,
custom fields and their SmartName versions.

Last Actor: the last Automation Engine user that worked with this Job (launched a task, opened a
file). This is filled in automatically but you can set it manually too.

Job Folder: define the path of the job folder for this job. You can choose one of these methods:

• browse to an existing folder (somewhere in one of your containers).
• browse to the root of where you want to create the new job folder and click . By default, the

Job Name will proposed as name for the job folder. You can change that if you want to.

• Use the Smart Job Location defined in the Configure Tool: when this toggle is selected, the
location and name of the job folder will be calculated based on a job parameter or on the default
location for that customer. A preview of the folder's location and name can be asked by clicking
the Show Job Location button. Learn more in Smart Job Location on page 663.

Tip:  The browse button can also be used to relocate an existing job folder. When you here change
the path of an existing job folder, you will be asked if you want to move or copy the data to the
new job folder.

3.3.2 Customer tab

Customer ID: click Select... to open the Select Customers dialog. Choose one or add a new
customer. Learn more about creating new customers in New Customer on page 697.

Customer Name and Customer Description: these fields will be filled out automatically after
selecting a customer.

Customer's Job Reference: this is how your customer refers to that job, how they named it (initially).
When communicating with your customer, he will appreciate if you mention this name (as well). You
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can for example add this name as a SmartName to a report PDF or add it to a name of a file that
you send him.

Customer Service Representative (CSR): select or type the name of the person in your sales or
service department who manages this customer account.

The E-mail address of the CSR that you selected is automatically displayed if it was used before.
You can also enter the E-mail address manually.

You can click the Contact... button to open an E-mail message with that E-mail address in the To
field (if an E-mail client is configured).

Tip:  All these parameters

• can be used to filter or search for a job.
• can be entered via XML/JDF/JMF. It is strongly advised not to re-enter these admin data manually.

Learn more on how this can be done in Integrating with External Systems on page 1228.

• exist as System SmartNames.

3.3.3 Inks tab

This tab sheet allows to store ink specifications for this job.

What you enter here serves as a minimal requirement for this job. This means that you can for example
only enter the angles for a specific set of ink names and leave all other fields or columns blank.

As with most tab sheets, you can enter this data manually, copy these parameters from another job
(see the button Apply Job Setup...) or get them from an XML when using the Create Job task on
page 1280.

Use cases



3
Automation Engine

841

Job ink parameters can be used in these cases:

• When you import design files, the task Normalize PostScript / PDF / Illustrator 8.0 File on page
379 offers to enforce these job ink parameters in the output file.

• In PackEdge or ArtPro, when you open a file that is located in a job folder, the editor will check if
the file's inks match the job ink parameters and show a warning when they don't. You can also use
the Load Job Parameters feature in the editor's Inks dialog to enforce the job ink parameters.

• When you use the Check Job Parameter task, you can check and or modify the file's inks.

• In page workflows, when you use the Variant Setup in the Imposition tab, the job's inks will be
used.

Note:  A job can only have one set of ink parameters.

Preferred Ink Book: when you then type an ink name in the table, Automation Engine searches for
the ink in your preferred ink book first. For example, if you type 154 as ink name, and your preferred
ink book is Pantone Colors Uncoated, Automation Engine will automatically suggest the ink
PANTONE 154 Uncoated .

Printing Method: you can set a printing method per ink. The list shows those defined in the
Configure tool.

These are typical examples of how to make use of a Printing Method:

• In your Imaging Engine (RIP) task for flexo, you select only the inks of printing method 'flexo'.

• You make a special ReportMaker PDF that focusses on the embossing 'ink'. In your workflow,
you use the Extract Inks on page 350 task to select the wanted ink type before you start the
ReportMaker task.

Learn more in Printing Methods on page 673.

Some tips on editing the ink list

• To start, click in the empty canvas under the column Ink Name and type in an ink name. For
example 'C'.

• You can define specify ruling, angle and dot shape per ink name or use the buttons at the bottom
of the tab sheet to specify them for all inks.

• Ruling uses the unit as defined in  Edit >  Preferences... >  Units .

• To change all fields in a column with a same value, double click the column header (valid for
Ruling, Angle or Dot Shape).

3.3.4 Parameters tab

This tab allows to store two types of job parameters:

• custom job parameters, with a name and value that you decide. They will also appear as a
SmartName.

• FlexRip/Proof job parameters. This is an older technology that allows enforcing job parameters
into the FlexRip or FlexProof task tickets. Learn more in FlexRip/Proof Job Parameters on page
843.
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Note:  With Imaging Engine, this concept is replaced by the use of SmartNames.

These job parameters can be created

• manually. Learn more in Creating and Modifying a Custom Job Parameter on page 842.
• by loading values from an XML file. Learn more in Loading Job Parameters from an XML File on

page 842.
• by using the Create Job task, where you use the (XML) input from an external system. Learn

more in Create Job task on page 1280.

Creating and Modifying a Custom Job Parameter

Use the buttons Add..., Modify... and Remove to manage your custom parameters manually.

Follow these steps to add a custom job parameter:

1. Click Add... to open the Add Job Parameter dialog.
2. Choose the Scope 'General'. Learn more about the other Scopes in FlexRip/Proof Job Parameters

on page 843.
3. Type in the Name and Value and click OK.

The SmartName version will be created automatically. To easily recognize which SmartNames are
job specific, their name starts with [jp. ] .

Loading Job Parameters from an XML File

If you have an XML file that contains the custom job parameters, you can create them automatically
by loading them into your job setup:

1. In the job setup tab Parameters, click Load....

2. In the Load Job Parameters from XML dialog, click Browse and browse to your XML file.

3. Click OK. You now have a custom parameter for all value pairs the XML contains from the root
node.
For example: the result after loading the XML file:

For this example, see the automatically created SmartNames of these custom job parameters
(for this job '1236'):



3
Automation Engine

843

Learn more about using SmartNames in SmartNames on page 916.

FlexRip/Proof Job Parameters

Creating Job Parameters for FlexRip or FlexProof

1. Click Add... to open the Add Job Parameter dialog.
2. Choose the Scope of a specific type of FlexRip or FlexProof.
3. Check the parameters that you want to enforce during RIP'ing and define their value. For example:
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Click OK. The job parameters for this type of FlexRip/Proof will be added as one line.

Using Job Parameters for FlexRip or FlexProof

When you now select a file in that job and open a task ticket for that particular FlexRip/Proof, you
will see fields that are marked by an orange icon . These are fields that are overruled by the job
parameters.

For example:

Note:  With Imaging Engine, this concept is replaced by the use of SmartNames.

3.3.5 Bar Codes tab

In the Bar Codes tab you can create parameters for multiple bar codes of different types.

Tip:  One file can have for example a retail bar code and also a general purpose bar code that will
be used for a filling station.

As with most tab sheets, you can enter this data manually or get them from an XML file when using
the Create Job task on page 1280.

Tip:  When selecting a bar code, the specified parameters are shown in the Details area.

Similar to the Inks tab on page 840, these parameters can be used to enforce their parameters
into the bar codes of the job files that you opened in PackEdge or ArtPro. Also here, the Check Job
Parameter task can be used to check or correct the bar codes in the files versus the parameters
you specify here.

See this example where the job parameters are enforced  into the bar code in PackEdge:
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We now briefly describe the available parameters. We refer to the documentation of your editor for
more details.

Type

Selecting a Type is a mandatory choice.

Note:  When you define more than one bar code, the checking mechanism with the editors and the
Check Job Parameter task will recognize the type of bar code and check accordingly.

Sub Type

Some bar code types offer sub types. For example a Datamatrix code.

Code

The validity of the code is not checked here. This is done in the editors.

Composite Code

A Composite Code is a 2D symbol placed on top of a GS1 barcode, that encodes extra information
(batch number, expiration date...).

Output Resolution

Enter the resolution (in ppi) that you will use to RIP your bar code. This parameter helps preventing
unwanted levels of rounding in the bar width. )

http://help.esko.com/products/overview
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Bar Width Reduction (BWR)

Use this parameter to adjust the width of the bar code bars, in order to compensate for ink bleeding
when printing on your substrate.

Your printer or customer will usually provide you with the value to use. For example if your printer
tells you that the line width will increase by 0.01 mm, you should use a Bar Width Reduction value
of 0.01 mm.

Important:  This field expects a value in millimeters (mm).

Important:  If you use a comma as a decimal symbol, it will be replaced by a dot.

Tip:  You can enter a negative value if you want to print thicker and not thinner bars.

Device Compensation

Use this if your printer gave you a separate device bleed value. This parameter adjusts the bar's
width to compensate for bleed caused by the plate or film making process.

Important:  This field expects a value in millimeters (mm).

Note:  If you use both a Bar Width Reduction and a Device Compensation value, the software will
add them together to adjust the bar's width.

Tip:  You can enter a negative value if you want to print thicker and not thinner bars.

Narrow Bar

This parameter determines the width of the narrowest bar of your bar code (and affects the width
of your bar code proportionally). For GS1 bar codes, this affects the size (height and width) of your
bar code proportionally.

Magnification

Use this parameter to increase or decrease the bar code size proportionally. For example: enter 1.25
for a magnification of 125%.

Important:  The value needs to be between 80% and 200%.

Ratio
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The Ratio is the factor between the width of the narrowest bar and the width of the widest bar in
your barcode. For example, enter 3 if you want your widest bar to be three times as wide as your
narrowest bar.

3.3.6 Step&Repeat tab

Specific JDF

This tab with Step and Repeat parameters is only useful in a workflow where you receive a JDF from
an external system that describes the Step and Repeat via “JDF for Stripping for Packaging”. Such a
JDF will not only create the job but also store those specific Step and Repeat parameters in this tab.

These parameters also become job parameter SmartNames and can so be picked up by Step and
Repeat tasks. They will appear as [jp.steprepeat. ].

Note:  The task Import JDF Step & Repeat on page 355 uses the JDF itself as input. In that case the
values shown here are just informational and the task does not use SmartNames.

Also via XML?

Step & Repeat specifications can also come from external systems via an XML file or database
queries or HTTP calls. In such cases, these parameters do not end up in this tab sheet and they
also become other types of SmartNames. Learn more about this in Integrating with External Systems
on page 1228.

Manual entry

You can also enter values manually here but that usage is not different than when you would add
them in the custom Parameters tab sheet.

3.3.7 Categorization tab

Attention:  This tab only appears if you created custom categories in the Configure tool (see
further).

The Categorization tab allows you to manage up to four extra custom Job Categories (you already
have three category fields in the Job tab).

You can use these custom categories as extra ways to search jobs. And you can also use their
SmartNames in task tickets.

Creating and modifying a Custom Category

Go to  Tools >  Configure >  Jobs >  Job Setup  and type the name of custom category.

Managing their Values

To manage the list of values you can choose for each category, click the corresponding Manage...
button, and add or remove items to the list. In this dialog, you can also load lists of items from an
XML file by clicking Load....
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Overview of Custom Categories and their SmartNames

Because there is already 1 standard Job Category, the number of your custom categories will be
1 higher. See this overview:

Table: Names of custom Categories

name of Job setup tab name of category in
Job setup

custom field number name of SmartName

Job "Category" / Job Category
Job name you gave custom field 1 Job Category 2
Job name you gave custom field 2 Job Category 3
Categorization name you gave custom field 3 Job Category 4
Categorization name you gave custom field 4 Job Category 5
Categorization name you gave custom field 5 Job Category 6
Categorization name you gave custom field 6 Job Category 7

3.3.8 Advanced tab

This tab sheet offers a feature to automatically start a task or workflow when you create or update
a job that uses this job as a template.

Caution:  This is an old feature. Please check below for the alternative ways to reach the
same goal.

If you wish to use this, check the toggle and select the Task Type and Ticket Name.

When is a job updated?

A job is updated in these cases:

• when the JDF that created the job is sent again to Automation Engine. Learn more about JDF in
Integrating with External Systems on page 1228.

• when a Create Job task is launched again on the same job.

When is this feature useful?

This feature can be useful when you have jobs that are created automatically via JDF without the
automatic launching of tasks at that moment. Your JDF can then specify that a job needs to be used
as a template. And that template job can have this parameter active to launch a task.

Alternative methods

There are other ways to launch a workflow in a job that was just created or updated.

The Create Job task on page 1280 can

• be part of a workflow, so right after this step where the job is created your workflow continues
with more steps.

• can be started automatically by an Access Point. Learn more in Access Points on page 1236.

• also has a tab sheet with this same feature. Learn more in Create Job task on page 1280.
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3.3.9 Automation tab

Note:  This tab is only offered in page workflows.

The Automation tab offers tools to automate your page workflow. When a certain job related event
happens, a specific task can be launched automatically, which then can lead to a next status in the
workflow.

You can do this for Normalization, Proofing and Exposing.

• Choose how you want to normalize the file when a page is delivered. Select a single task or
a workflow.

• Choose when you want to launch a proofing output task: when a sheet side, a variant or an
imposition is complete. Select a task.

• Choose when to expose your job: when a plate, a separation set or an imposition is ready
(complete and approved if required). Select a single task or a workflow.

3.3.10 Page Assignment tab

Note:  This tab is only offered in page workflows.

This tab offers settings to automate the assigning of incoming PDF files to Page slots.

Learn more in Page Assignment via Naming Convention.

Learn more about the Pages tool in Working with Pages on page 182.

3.3.11 Imposition tab

Note:  This tab is only offered in page workflows.

• Variant Setup
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When working with variants, this allows you to select the correct use case and variant separation
from the list. Learn more in Variant Setup, a section of Working with Plates on page 192.

• Output prerequisites

These settings allow you to decide when a separation can be considered as being ready.

• When no page is rejected: This is called "implicit approval". The plate status in the Plates
View will indicate 'ready for ripping' if all the pages of the plate are assigned and if no page
is rejected. When a page for that plate is unassigned or rejected, the output task on a plate
will fail.

• When all pages are approved: This is called "explicit approval", it is more strict than "implicit
approval". The plate status in the Plates View will only indicate 'ready for ripping' if all the
pages of the plate are approved. When not all the pages on that plate are approved, the output
task on a plate will fail.

Learn more in Task status information.

Learn more about the Plates tool in Working with Plates on page 192.

3.4 About Job Folder Location

3.4.1 General Note on Data Structure

Automation Engine allows you to choose your own data structure

As mentioned in Data Management in Automation Engine on page 23, Automation Engine will work
with the data structure you have.

This freedom also brings requests for advice on what data structure could serve your specific needs
the best. The more you learn about the available tools (Jobs, Products, SmartNames, Workflow
Parameters etc.) the more you will learn what is (no longer) important in that data structure.

Historical View on Data Structure

Before there were workflow automation servers like Automation Engine, prepress managers built
up their own logic in the prepress data structure. Prepress operators browsed many folders in the
network to open a file in their workstation editor and then saved it again, often with a changed name.

Very typical was the habit to write information about the files into both their name and their location.
For example: a final version was named "name_final.pdf" or written in a folder "Final". Or a
file was named "lemon_c_m_y_k_pms123.pdf". Or when the job was ready to be archived they
moved the whole job folder to a share "For Archive".

Then came workflow servers like Automation Engine where the information is (automatically) stored
in database fields. And the user can see information via a dedicated interface: the Pilot. You can for
example list all jobs of the category "NON-FOOD" or you can use the "i" button to see the PDF's
inks (XMP metadata).

Does this mean that the data structure and the file naming is less important than before? No, actually
the opposite is true.
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Why is it still Advised to have a Logical Data Structure?

There are two main reasons why a logical data structure is more important than ever:

• for the people that do not use the Pilot.

Are there non-prepress users looking directly at your prepress data structure? If those people are
not using the Pilot interface, they will still want to get information from the location or from the
name (like in the 'old days').

Note:  We advise to check if those colleagues will not prefer to install a local Pilot and benefit
from that information-rich view. Remember you can use User Access Rights to limit heir access.
And they could even benefit from using the Viewer.

• for external systems that look at, use or deliver the data.

What other systems are looking at your data structure or at files that come from there? What
systems send you data into that data structure?

The integration of Automation Engine with many other systems is the main reason that your data
more than ever needs to be well structured and named. Learn more in Integrating with External
Systems on page 1228.

For these reasons we advise to:

• investigate thoroughly what data structure will serve your needs and those of the system(s) you
(will) integrate with. This includes avoiding copied data.

• use all the tools that can automate the creation of those folders and file names (templates,
SmartNames, Smart Job Location etc.).

3.4.2 FAQs on Job Folder Location

Can I Move a Job Folder?

As explained in The Job Concept on page 24, a job is a temporary object. But even during its short
life time, it can happen that you want to move the physical data to another place in the network.

In this case, it is very important that you use one of the tools in Automation Engine to do this. If you
use the OS tools (Windows Explorer, Mac Finder etc.), Automation Engine will not be aware of this
move and its database field for the job folder will still refer to the old path.

You can relocate a job folder

• manually, one by one. By using the browse button in the Job tab on page 838 of the job setup.
You will have the choice to move or copy the folder.

• by using the Relocate Job task. You can launch this task on multiple jobs (for example on a smart
filtered selection).

Can I Rename a Job Folder?

To rename a job folder you can use the same manual relocation tool as mentioned above.

1. In the Job tab of the job setup, in the field with the job folder path, change the name of the folder.
2. Click OK. The resulting dialog offers a choice on what to do with the original folder and files.
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3. Make your choice and click OK.

What happens when I Remove a Job Folder from a live Job ?

When Automation Engine can not access the job folder of a job that you are trying to open or use, a
warning dialog will mention "Could not retrieve the list of files". The Pilot will show the job folder
in yellow.

This is the same warning that you will get when there is network problem and Automation Engine
can for example not access a complete Container.

When Automation Engine can again access that folder again, with the place and name it was
expecting, the job folder will again be shown in blue and ready for use.

Note:  In the Configure tool, there is a feature that allows to remove all "dangling jobs" (jobs that
have no more link to their job folder). Learn more here.

3.4.3 Good Practices regarding Job Folder Location

Creating all your job folders under 1 same root folder can result in a slow Automation Engine Pilot
and even slow tasks. We advise not to do this.

Here is an example setup that certainly causes too many subfolders in one same folder:

To keep your system healthy, it is good practice to use subfolders in your data structure.

Here is some advise on what logic you could use to decide that data structure:

About using Subfolders per Customer Name

We do not advise this, mainly because customers tend to change their names. It looks like a good
idea at first, but Esko has seen many customers migrating away from this structure.
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About using Subfolders per Customer ID

We do not advise this. It is true that using a customer ID is more stable, but it also has some
disadvantages:

• That customer ID number is often meaningless to the Esko users.
• Because legal regulations may require your company to keep track of order history, it is possible

that old customers may not be deleted in the business system. That is why, when your customer
changes his name, some business systems then change the ID anyway.

• Another reason to not base your folders on customer ID is that customer companies also merge.

These reasons show that we again face the same issues as when we use the customer's name.

About Using Subfolders per Type of Job Order

We do advise to base a data structure on types of jobs.

If you have prepress orders (creating and getting a one-up print ready) and production orders
(outputting existing approved data), then structure them in separate folders or even different
Containers.

Or you can use the product or production type: labels, carton, digital, flexo, offset etc. A typical way
to set this up is by using the SmartName of a Job (custom) Category.

About Using Subfolders per Order Range

We do advise to create a data structure where you split folders based on the job's Order ID.

For example: all jobs in the 1000 range in one folder, all jobs in the 2000 range in the next folder, etc.
This is a straight forward structure that will not allow more than 1000 subfolders in one folder. Use
String Extract SmartNames on page 948 to set this up.

This is considered to be the best practice.

For example:

Note:  All these principles also apply to folders where you store Products (Product Data Zone). Learn
more in the dedicated chapter on Products on page 876.

3.5 Uploading Files to Jobs

There are many ways to upload files onto a job folder.

• Manually:

• using the Pilot
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• drag and drop files or folders from outside the Pilot onto a job (sub)folder in the Pilot. Or
use copy/paste shortcuts.

• right-click a job (sub)folder and choose Upload Files.... Learn more here.

• right-click a job (sub)folder and choose Upload Files from FTP Site.... Learn more here.

• using Shuttle, as start of a workflow in this job. Learn more here.

• Automatically:

• from Access Points on page 1236. Any of the 5 types of Access Points can upload data to a
job (sub)folder (and launch a workflow). The Folder Access Point can also be a sub-folder of
the job folder. Learn more in Integrating with External Systems on page 1228.

• using the Download WebCenter Document task on page 1361. When your Automation Engine
is connected to a WebCenter, this task logs on to WebCenter and downloads documents from
a specified WebCenter project. Learn more in Integrating with WebCenter on page 1346.

• from WebCenter,

• by synchronizing the WebCenter project with an Automation Engine job. When a WebCenter
project has a workflow connection with an Automation Engine job, documents can be
copied to that job when synchronizing. Set this up in the Configure page of the WebCenter
project.

• by using WebCenter's Sync Workflow task in a WebCenter workflow. Learn more in the
WebCenter documentation.

3.6 Milestones: Tracking Job Status

3.6.1 Concept

Milestones represent important moments in the life of an Automation Engine job. Each job has at
least one Milestone: the moment it was created. You can add Milestones, predefined ones or custom
ones. Each Milestone has a due date and several other attributes (see below). The goal of a Milestone
is that is gets confirmed.

Note:  The Job Due Date that you set in the job setup is not automatically created as a Milestone.

A Milestone has these attributes:

• a Name. For example "Approved".

• a Due Date. This is the time that this Milestone is expected to be confirmed. It could represent
when deliverables are expected (plates, print production, shipping, invoicing). Or it could stand
for the time an action is expected to be finished, for example "Approved" in 3 days.

• a status. Users can decide on the status Confirmed or not (still "pending").

• a set of Actions. You can optionally attach Actions that need to be done to get that Milestone
confirmed.

http://help.esko.com/products/WebCenter
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• a Responsible user.

Milestones can be created and managed

• manually, by a user in the Pilot.
• by copying them from a template job (manually or via the Create Job task on page 1280).

• by the Manage Milestone task.

• by an external system, using JDF/JMF. Learn more in Integrating with External Systems on page
1228.

How can you Use Job Milestones?

Milestones can be used

• as the basis for status feedback to external systems. This is the main reason to invest in setting
up and using Milestones.

Automation Engine focuses on reporting what happens with a job but not on job organization
or job distribution: that is the task of the order management system. What is important is that
Automation Engine reports back to such systems and that this ideally happens without manual
intervention of prepress users (who have other things to focus on). Learn more in Informing Other
Systems of the Milestones Statuses on page 866.

• in the Pilot,

• when filtering jobs. For example you want to remove all jobs that have a milestone "Finished"
confirmed more than 2 weeks ago.

• as visual help when tracking the status of jobs.

3.6.2 The Milestones View

This view is different when you are using it in the Job Overview mode or in the Last Used Job mode.

Both these views use these icons for different milestone statuses:

•  indicates the time the job was created.

•  indicates the current time on the time line.

•  indicates a pending milestone (not confirmed).

•  indicates a selected milestone.

•
 indicates an overdue milestone: the current time is later than the due date of the (pending)

milestone.

•  indicates a milestone that contains one or more Actions that are not all completed. Learn
more in Working with Milestone Actions on page 861.

•  indicates a pending milestone of which all Actions are completed.

•
 indicates a confirmed milestone. A milestone must be completed before it can be confirmed.

In Job Overview Mode

When you are in Job Overview mode, you can see all milestones of a (filtered) list of jobs.
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The Milestones view offers two types of overview.

The Timeline View

The Timeline View  shows you the milestones for a defined period.

Use these buttons to define the time period you are viewing:

•
 to show 1 day, 7 days, 14 days or 31 days.

•  to show the previous week, previous day, the current day, the next day or the next
week.

From the menu Milestones, use Go to Date... to specify a specific date in the center of your view.

Select a milestone to see Milestone Details in the bottom pane.

Tip:  When hovering over a milestone icon, you will see its name and more details:

Tip:  Double click a milestone icon to open the milestone view for that specific job.

The Status View

The Status View  shows the milestones and their status in columns.
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Go to  View > Select Columns...  to choose which milestones will be shown here and to define the
order of these columns.

If no icon appears in a milestone column, this means that this milestone is not defined for that job.

In Job Mode

In Last Used Job mode, the Milestones view shows all the milestones for a specific job.
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Select a milestone to see it selected in the time line and to see details below about any actions for
this milestone.

Printing out the Job's Milestones

You can use  Milestones >  Print Milestones...  to print (or save to PDF) a view of a job's milestones.
You can define the printer's page format but the content of the page is fixed. The page shows some
major job info and the milestones' timeline and overview.

An example:

Note:  The thumbnail of the job shown in this printout is the one you can (manually) add in the Job
tab sheet of the job setup.

3.6.3 Adding Milestones to a Job

Adding a Milestone Manually

1. Select your job and open the Milestones view.
2. Click , or go to  File > New Milestone .
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3. From the Milestone Name list, select the milestone you want to add to this job. If the one you
want is not yet in the list, click Manage... and create it there. Learn more in Manage (Custom)
Milestones on page 860.

4. If you want, add a Description for your milestone.
5. Define a Due Date and time. This is a mandatory field.
6. If you want, add a Reminder. Choose an absolute time or a time relative to the due date. At that

time, a reminder will be E-mailed to the Responsible user.
7. Select the user that is Responsible for this milestone. This is a mandatory field when you set

a reminder.
8. Click OK.

Copying the Milestones from another Job

When you create a new job (manually or via the Create Job task on page 1280 or via JDF), you
can copy the properties of another job (template) to that new job. This can include the milestones
of that other job.

The copied milestones will be set relative to the creation date and time of the new job.

For example, a typical job for your customer FruitCo has a job due date of 9 days after job creation
and during that period it includes 3 custom milestones. The due date of the new job that copies
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those milestones will then be set to 9 days after its creation date. And its milestones will be created
relative to the new creation date.

3.6.4 Manage (Custom) Milestones

There are many predefined milestones, but you can also create custom milestones.

In the Milestones view (in Last Used Job mode):

1. Go to  Milestones > Manage Milestones . This dialog shows you all your milestones and their
attributes:

2. Click the Add button.

In this dialog:

• enter a Name for your custom milestone.
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• you can also enter a Nickname, this is the name that will be shown in the Pilot interface. This
is also useful when your milestones are managed by JDF/JMF. Learn more in Integrating with
External Systems on page 1228.

• if you want, choose a Color and / or browse to an Icon to help recognize this milestone. Icons
can be based on JPEG/PNG/GIF files and will be automatically scaled to a fitting resolution.

• you can also enter Comments. For example to explain all users how this milestone should be
used or if an external system is using this milestone information.

• if you use the Products on page 876 tool, define if this milestone can also be used as
Products status.

• click OK. Your custom milestone now appears in the list and is ready to be added to jobs..

Note:  You can safely remove milestones that you already used in jobs. Those jobs will not loose
their (local copy) of the milestone.

3.6.5 Working with Milestone Actions

Concept

A milestone represents a status that you want to reach. A milestone can also list what Actions need
to be done to reach that state. A milestone can only be confirmed when all its actions were set to
completed.

Some customers use these tools extensively and ask their users to base their daily work on the
milestone actions appearing in their To Do List. These users then use custom filters when over-
viewing (their) actions. They typically filter their actions based on user, state and urgency.

Creating Milestone Actions

To add an action to a milestone:

1. Select the milestone in the Milestones view.
2. Click  or go to  Milestones > New Action...  or right-click on the canvas in the bottom part

of the Pilot.
3. In the New Action dialog, enter what needs to be done, who needs to do it and by when.
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The user that needs to do the action can later change the State from Pending to In Progress,
Completed or Aborted.

Working with Milestone Actions

Milestone actions appear

• in the Milestone view, when in job mode. See a screen shot here.

• in the To Do List, as Milestone Actions. The To Do list offers some more functionality on these
actions:

• Right-click to open, delete or create a new action.
• Right-click or click  to Forward the action to another user.

• Check 'I am currently handling this item' to change the state to In progress.

Open (double-click) the action to use these extra tools:
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• change the State.

Note:  Because the names of these states are shared with CheckPoint Actions, choosing Accept
or Reject will for a milestone action result in Done.

• change the Due Date.

• add a Message.

For example: a user opens his to do list in the morning and uses a filter showing all the actions on
his name that have a due date before noon, in the state Pending or In Progress. He can also use
the column due date to sort by urgency.

3.6.6 Using Milestone Statuses to Filter Jobs

The filters that you make in Job Overview mode can also be based on milestones.

See this example of a filter that was saved as a Smart View named "Still Need Plates Today".
It only shows jobs with an unconfirmed milestone "Plates Ready" that has a due date today:
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Learn more on creating such filters in Job View Filters on page 832.

3.6.7 Using Milestones in Workflows: the Manage Milestone Task

Concept

Using milestones in workflows enables these principles:

• Milestones can help control a workflow. A workflow can check the status of a milestone before
continuing (in a specific direction). Use the workflow control Router to do this. See an example
here. Learn more in Router on page 1024.

Tip:  When you also work with the Products tool, then check if the dedicated Wait for Product
Status task is a better alternative.

• The Manage Milestone task helps to automate working with milestones. This task serves to
create and confirm milestones as a workflow step. This enables a lot of automation when working
with milestones. And you can also use it to hold workflows. Learn more below.

See an example of a workflow that automatically confirms four milestones:

The Manage Milestone Task

You can use this task to automatically decide one or multiple of these milestone attributes:

• Set all pending actions of the following milestone in state "Completed": select the milestone
you want to set as "Completed". Learn more about Milestone Actions in Working with Milestone
Actions. This setting is mandatory.

• Create the milestone if it does not exist: if the above selected milestone you selected was not
yet added to the job, check this option to add it (otherwise the task will fail). The milestone will
be created with the status "Completed".

• Automatically confirm the milestone:
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• Check this option to set the above selected milestone as "Confirmed" and have the workflow
continue with its next step(s) or with any task that was waiting for this milestone to be
confirmed.

• Do not check this option if you are still waiting for a confirmation. The task will then serve as
a hold-point: it will pause the workflow until that milestone is confirmed.

• In the Workflow Editor, this step then will jump up and down, as a signal that a user
intervention is needed:

Right-click the file-icon and choose to Open Milestone... or to Show in Tasks View.

• In the Tasks view, you will see the phase User intervention needed.

Click on the red text to open the milestone dialog where you can change any setting.

If you check Confirm Milestone (and click OK), the workflow will continue. If you can not
confirm this milestone yourself but for example need the help of someone else, then type
in a description and change the responsible user.

• In the Milestones view, right-click to open the milestone or directly click in the column
Confirmed to change it to Yes.



3
Automation Engine

866

Tip:  Some customers make the manual confirmation of a milestone easy by offering the users a
favorite ticket that only (creates and) confirms a milestone. This is useful when that user is aware of
a status that Automation Engine has no information on.

For example: A plate room operator checks plates that come out of the developer. He reads their
job number on the plate and types it in as a job filter in his simplified Pilot. He then launches the
appropriate favorite ticket: Plates OK or Plates NOT OK.

This information can now automatically change a workflow and/or be sent out to the system that
does the press planning. Learn more about such feedback in the next section.

3.6.8 Informing Other Systems of the Milestones Statuses

The milestone status of an Automation Engine job is often more important to external people than
to users of the Pilot. Many parties want to be kept up to date about the latest status in prepress,
both colleagues and customers.

External systems are not always interested in all prepress details. You can choose to only inform
them on some specific milestones.

These are tools that help inform other systems and their users:

• Add a notification to your Manage Milestone task. This can be an E-mail notification or the same
message can also be written in an XML file for an external system to read. Learn more about the
type and content of such messages in Notifications on page 175.

• Or you can use one of many tools dedicated to help integrate Automation Engine with external
systems. Typical methods are

• write out XML files
• write directly in the database of the external system
• when the external system is capable of subscribing to JMF signals, you can set up the

automatic sending of JMF signals when a milestone is confirmed.

For more information on these feedback tools, see the dedicated chapter Integrating with External
Systems on page 1228.
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3.7 About Removing Jobs

Concept

An Automation Engine job represents a Work In Progress. It is expected that you remove the job
when the work is done.

Removing a job means that it is removed from the Automation Engine jobs database. You have the
option to keep the job folder data.

When you remove a job,

• all finished tasks in that job will be deleted. If you wish to keep those tasks, use the Task Cleanup
Rules on page 682 to move them (earlier) to the Task History on page 621 tool.

• if that job still has unfinished tasks, you will be asked before removing the job to confirm that they
can be cancelled and deleted.

• all Actions for that job in the To Do List will be deleted.
• any setup of Hot Folders in that job folder will be removed.
• when you choose to not delete the job folder, all the job's setup parameters will be stored in a

subfolder 'config' (this is the information that was inside the database).
• the job will disappear from the Pilot's Job Overview.
• in the Containers view, the blue colored folder icon will turn back into a standard yellow folder

icon. You will be able to restore it later.

Note:  The Archive Job task allows to remove the job (from the database) and move the job folder
to a different place in the network. Learn more here.

You also have tools to reactivate the job, to recreate it back into the jobs database. See below.

Removing a Single Job

To remove a single job, select the job and press Delete. You can also right-click (or go to the menu
Job) and choose Remove Job....

You will be asked to confirm. You can choose to also remove the job folder and its contents.

Caution:  There is no way to Undo the removal of the files and folders.

Removing Multiple Jobs
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In the Job Overview mode, you can select multiple jobs and remove them in the same way as
described above. You will also get the option to keep or remove (all) their job folder data.

Note:  It is good practice to use a smart filter when you select multiple jobs to be deleted. For
example: all jobs that have their milestone 'finished' confirmed more than a month ago.

Note:  There is no "Remove Job" task, so you can not remove jobs as a workflow step.

In  Edit  >  Preferences , you can decide to avoid getting (many) questions when you remove multiple
jobs:

• questions about jobs being in use by other users. A job is 'in use' when a user has this job open
in his Pilot.

• questions about jobs containing unfinished tasks.

Learn more in Pilot Preferences on Multi Job Removal.

Recreating a Job that was Removed

When a job was removed but the job folder data is still available, you can recreate that job back
into the jobs database.

There are two ways to recreate a job:

• Recreating a job manually. Follow these steps:

1. In Containers view, select the yellow folder that used to be the job folder of a removed job.

2. Right-click (or go to the menu Job) and choose New Job.... When a previous job setup is
detected in that job folder (in the subfolder 'config'), you will be able to recreate that job.
Choose to Reuse the previous setup.
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3. Click Recreate. The renewed job will be opened and will contain the previous job setup
parameters, subfolders and local (blue) job tickets.

• Recreating one or multiple jobs with the Restore Job task.

Learn more in The Restore Job Task on page 873.

3.8 Tasks you can Launch on Jobs

These are the tasks that you can launch only on Automation Engine jobs:

• The Relocate Job task moves the job folder of a job to another place.

• The Archive Job task removes a job and exports all its data and metadata into a ZIP file.

• The Restore Job task re-creates a job from a ZIP file that was created by the Archive Job task.

Like all tasks, these tasks can also be triggered by an external system. Learn more in Integrating
with External Systems on page 1228.

The Create Job task is documented in the chapter Integrating with External Systems on page 1228.
Find a direct link here.

Note:  The Remove Job feature removes one or multiple jobs. This feature is not available as a task,
it is something that a user chooses in the Pilot. Learn more in About Removing Jobs on page 867.

3.8.1 The Relocate Job Task

Concept

This task allows to change the location of an Automation Engine job. The job itself does not change,
only the path of its job folder.

Restriction:  You can not launch this task as part of a workflow.

Task Options
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• Enter the New Job Location. Keep in mind to end the location with the name of the job folder.

• You can choose to:

• Copy the files to the new location.
• Move the files from the original job folder to the new one.
• Not copy or move the files. The relocated job will then have an empty job folder.

Warning:  If you move a job folder without using a tool from Automation Engine, the job
setup field for the job folder will not be updated and the Pilot will show warnings. Automation
Engine will keep trying to retrieve your missing files and this can slow down your server.

Relocating Multiple Jobs

In Job Overview mode, (filter and) select the jobs you want to relocate. Right-click and choose a
Relocate Job ticket:
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3.8.2 The Archive Job Task

Concept

The Archive Job task removes a job from the jobs database and exports the data in a form that
enables to restore the job later.

Typical for this task is that it exports the job metadata as well, these are the job setup parameters.
This metadata makes it possible to restore the job (back) later.

Note:  The job's metadata is exported in a subfolder named 'config'.

Note:  When you launch the Zip task on a job, the task only ZIP's the data inside the job folder,
not the job's metadata.

Note:  When archiving (removing) a job, the tasks that were launched in that job will be deleted. If
you want to keep these tasks, use the Task History on page 621 tool. This tool allows setting up rules
that automatically move those tasks to a separate database (before archiving the job).

Task Options

• Output in: define where you want to write this archive data. For example some customers use
a 3rd party backup/archive solution that scans specific network folders for new incoming data.
This system then archives that data online or writes it on a backup medium.

• File Name: define the name of the file in which all data will be stored. When you do not choose
to generate a ZIP file, this will be a folder with subfolders.

• Generate ZIP file: deselect this option if you want to move the job folder to the above location
without ZIP'ing all data.

• Generate XML: select this option to generate an XML file that describes this job. Such an XML
file can be useful for a 3rd party archive solution that for example uses it to build up its search
database.
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• Apply XSL: select this option if you want to format the XML file using an XSL style sheet from
a 3rd party archive solution.

• Keep Job and Job Folder (Export Job): deselect this option if you want to delete the job folder
once it is successfully archived.

Select this option if you still want to keep the job in the job database and also keep the job folder
in its original location. Here are some examples when to choose this:

• To use this task as a job backup tool.
• To exchange that job with another Automation Engine. For example to send to a job to

another plant of your company (that also has Automation Engine) or to share the job with Esko
Customer Service.

Archiving Multiple Jobs

In Job Overview mode, right-click the selected jobs and choose your Archive Job ticket.

Here is an example of a smart way to archive multiple jobs. The filter lists all jobs that have their
milestone "Job Finished" confirmed this week:

Using the Archive Job Task in a Workflow

You can end a workflow by archiving the job that the workflow was launched in.

Here is an example:

Notice these steps:



3
Automation Engine

873

• After the plate making stage, the workflow waits for 2 weeks.
• It then sets the milestone "Ready for Archive" but without the option to confirm it. This triggers a

request for a user intervention (learn more about this option the Manage Milestone task).

• When a user confirms this milestone, the workflow continues and archives the job.

3.8.3 The Restore Job Task

Concept

This task allows to restore jobs back to the Automation Engine job database that were previously
archived using the Archive Job task.

Restriction:  You can not launch this task as part of a workflow.

Possible Input Types

The input file for this task can be

• a ZIP file created by the Archive Job task.

• a job folder created by the Archive Job task.

• an XML file that refers to the location of a ZIP or folder created by the Archive Job task.

The root node of the XML needs to have an XML attribute named "Location". The value of this
attribute is the URL to the ZIP or archived job folder. Here is an example XML (it looks like the
XML generated by the Archive Task):

Task Options

• Output in: define where you want to place the restored job folder. Use [Job URL] when you
want to restore the job to its original location and with its original job folder name.

• Job Name: define the name of job once it is restored. Use [Job Name] when you want the
job's original name.
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• Order ID and SubOrder ID: similar to the job name, define a new ID or use SmartNames to use
the ID's of the original job.

• Due Date: set the job's new due date.

• Delete archived data: select this option if you want to delete the archive data after restoring
the job.

3.8.4 The Check Job Parameters Task

This task serves to check if your file matches specific parameters as defined in your job setup. You
can also use it to automatically correct the file according those parameters.

Note:  For the task to function properly, the file should be part of an Automation Engine Job.

For Barcode settings, you can select:

• Auto Correct when you want to correct the file with what is specified in the job's Bar Codes tab
on page 844 .

For example, your Normalized PDF includes an Esko barcode of type EAN-13 and code
123456789012, and your job parameters specify an EAN-13 with code 5449000050205, then
this task will automatically correct the barcode number in the PDF to 5449000050205.

• Stop with Error when you want the task to stop with an error if the barcode in the job's Bar Codes
tab on page 844 does not match the barcode in the file.

Note:  This task only checks barcodes created in Esko PackEdge or by using Esko's barcode plug-
in for Adobe Illustrator (DeskPack). If the task does not find such a barcode, the task will end in a
warning.

Note:  You cannot use this task to check and auto correct barcodes in normalized PDFs generated
by ArtPro.

For Inks, you can select:

• Auto Correct when you want the task to correct the file's ink settings according what is specified
in the job's Inks tab on page 840.
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• Auto Correct (Strict Checking): when you want to correct the file's ink settings and order
according the job's ink parameters.

In this strict setting, the task will finish with an error if it finds unexpected inks (inks that are in
the file, but not defined in the job parameters) or if it finds missing inks (inks that are not in the
file but are defined in the job parameters).

• Stop with Error when you want the task to stop with an error if the job's ink parameters are
different than those in the file.

3.9 Automated Creation of Jobs

Most of the job setup parameters originate in another system, often the order entry part of the
business system. It could also be a web-portal where job specifications were first entered.

When someone already entered this data manually, we advise to not re-enter that data. We therefore
strongly advise to get your jobs created automatically.

The chapter Integrating with External Systems on page 1228 explains how this can be done. It
describes the many available techniques and also offers exercises.

Here is a summary of how jobs can be created automatically:

• by the Create Job task on page 1280 that, as part of a workflow, picks up the job setup
parameters via SmartNames or from an external (XML) file(s).

• by an Access Point that interacts with the external system and launches a workflow that uses the
found information in the Create Job task.

• via JDF/JMF commands from an external system, sent directly to Automation Engine's JDF
channel.



4
Automation Engine

876

4. Products

4.1 Products Basics

4.1.1 The Products Concept

What is an Automation Engine Product?

An Automation Engine Product is a one-up graphics production item stored in the Automation
Engine Products database. A Product represents a Stock Keeping Unit (SKU). A Product is what you
Step&Repeat on a plate or press, possibly combined with other Products.

As explained in The Job Concept on page 24, a Job is a to-do for Automation Engine. A Job is not a
thing, it is an activity with a specific goal. A Job is temporary, you delete it when the Job is done. A
Product does represent a thing and is not temporary, you expect it to come back in other production
(output) orders. For example, you could have 200 Jobs, 20.000 Products and 20.000.000 files.

In Types of Jobs on page 829, we also describe that a Product is the result of a "Prepress Job-
Order", in which the goal is to get a design ready for production and customer approved. From that
moment on, the Product can be used in many "Production Job-Orders", where the only task is to
produce (output) it.

It is easier to integrate Automation Engine with a business system when both use the same concepts.
It will be easier to translate the incoming orders into a prepress (data) context. It will also be easier
to give feedback to that system about statuses in prepress.

The Main Principles when Working with Products

Working with Products typically means following this process:

• You first check your data structure. Working with Products requires that your Job data are split
from your Product data. Learn more about in Products Data Structure on page 881.

• Then you build up your Products database. Learn more about how to automate this in Creating
Products on page 897.

• Then you start linking Product(s) into your Jobs. This way, the Product data files are not inside
the Job Folder. Product data are independent: today they can be linked to Job 123 and next time
to Job 456. They can even be linked to several Jobs at the same time.

In Automation Engine, this temporary relation to a Job is a temporary link between items in the
Product database and items in the Jobs database:
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Here is an example how this looks in the Pilot: the Job 440123 links to 3 Products:

Note:  You can work with Products without working with Jobs. However, in all classic print production
environments Esko advises to use the Jobs concept.

Product File Formats

These file formats are supported as Automation Engine Products:
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• PDF

Note:  Non-Normalized PDFs cannot be checked for barcode parameters. Learn more in The
Check Product Parameters task on page 912.

• ArtPro
• Adobe Illustrator (Esko DeskPack workflow).

Note:  You will only see a product part thumbnail when the AI file was saved as PDF compatible.

It is possible to add other file types to the Products database, but it will become clear that Automation
Engine does not offer (m)any valuable features for such files (no thumbnail, few tasks possible,
provided parameters are irrelevant etc.).

Who typically uses the Products tool?

The Products tool benefits all customers that have product items coming back into production, all
environments that do some form of re-runs. These sites usually are printers/converters.

If your business is to produce an item only once, then you may conclude it is not worth to add
these files to the Products database. If you produce an item only once, you then probably end by
removing the Job and storing its data somewhere as a backup, just in case you need it again for
some unexpected reason.

Benefits of working with Products

• Data efficiency: no more needless copying or searching of data.
• A transparent data structure that supports the process logic of re-runs.
• A more user-friendly interface: thumbnails and colors indicating status.
• Automation Engine now speaks the same language as your business system, this enables a higher

form of integration, leading to even more automation.

What is the Products tool not?

The goal of the Products tool is not to make Automation Engine a Digital Asset Management system
(DAM).

These are some differences with a DAM:

• The Products database only stores one version. There is no automatic versioning tool.
• Searching for references is limited. You can see which Products are used in a Job and you can

see in which Jobs a Product is used.
• File support: the Products tool is designed for one-up graphics production files, not for images

or CAD or 3D or admin data.

Note:  You can use WebCenter as a DAM for your graphics production data. WebCenter offers
automatic versioning and supports all file formats. There are also standard available tasks to up- and
download data from WebCenter to Automation Engine in case you need it (back) for production. Learn
more in Synchronizing Products with WebCenter, a section of the dedicated chapter Integrating with
WebCenter on page 1346.

Do I have to Install an Extra Database?
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No. An installation of Automation Engine already provides the required database.

Note:  Product attributes are stored in the same database as the one that is configured for Jobs (see
Tools  >  Configure > Automation Engine Database >  Jobs ).

Automated management of Products (and Jobs) via Integration

The goal of using the Products tool is to work more efficient. It is therefore important that you
automate the management of your Products. Creating them manually or changing their status
manually would again reduce efficiency.

You can automate managing (Jobs and) Products by integrating Automation Engine with your order
management system.

These should be your goals for such automation:

• All new Jobs and Products appear automatically.
• Jobs automatically link in their Products.
• Products statuses change automatically.
• Ideally, the business system makes a difference between Prepress and Production Jobs.
• Production Jobs should be fully automatic, the Product(s) they link to are already approved so

the only limitation should lie in how far you can fully automate the Step&Repeat.

See Tasks on Products to learn about tasks you can use in a Products workflow. As usual, these
tasks can also be triggered from an external system. Learn more in Integrating with External Systems
on page 1228.

4.1.2 Global Products and Job Products

A Global Product is the one we described above: its data is not inside a job folder, it is independent.
Global Products can be linked into several jobs (even at the same time).

It is however possible to store the data of a product inside a job folder. We then call it a Job Product,
it can only be used in that job. Some Prepress Service Providers (trade shops) or commercial printers,
who don not normally produce re-runs, use this concept.

Like Tickets, the global version is visualized with a yellow icon  and the job (local) version with a
blue icon . See some examples in Products Views and Menu on page 886.

See this example of a Job Product, notice how the product file is located inside the job folder:
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4.1.3 Products can have Multiple Parts

A Product can be a combination of multiple Product Parts. These parts then come together on press
or later in finishing and so end up as 1 SKU in your warehouse.

Some examples:

• A bicycle helmet is sold in a plastic wrap that also contains a paper sheet with product information.
The sheet was printed in 2 print runs: first the front in 2 colors (front.pdf) and then the back in
1 color (back.pdf). This front-back printing made these 2 Product Parts become 1 Product (after
cutting). 1 Product is kept in the warehouse (1 SKU), 1 Product is ordered by your customer.

Note:  There could be other Products that use the same front Part but a different back Part as
their (language) variant.

• A booklet is glued to a label. These 2 Product Parts come together in finishing and so become
1 SKU, 1 Product to be ordered.
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These are Not Multiple Parts of one Product:

At first glance, these 3 labels look like Parts of a same Product. This may look that way to the brewery,
for whom the product is the beer bottle.

But, for the label printer, these are 3 different Products.

• They do not come together in printing or in finishing.
• In the warehouse, they are 3 separate SKUs.
• They can be ordered separately: your customer can for example order 6.000 front labels, 3.000

French back labels and 3.000 Spanish back labels.

4.2 Products Data Structure

Important:  This page illustrates data structures to work with Global Products (where the product
data is not inside a job folder).

Splitting Product data from Job data

When jobs link to product (data) it is important that they do not share any folders. This data separation
can be achieved in many ways.

Here are 2 examples:
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• On the left, an example where the data split between jobs and products happens quite high in
the container.

• On the right, an example where this data split is done per customer.

Note:  Using customer names for folder has its disadvantages too. Customer tend to changes
names for example. Learn more about your options in Good Practices regarding Job Folder
Location  on page 852.

Organization of Product data

Once your product data is split from the job data, you can freely decide how to structure that product
data.

See these 2 examples:
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• On the left all the product data is in 1 same folder FruitCo Products. This is usually not
advised because it quickly leads to having too many files in a same folder (slow browsing, general
system slowness etc.). And if you want to select a file related to a product file, you will again have
to browse, even when they are in subfolders like Originals or Proofs.

If you create further subfolders that avoid having too many files in one folder, then this is a valid
way to organize your data.

• On the right each product has its own folder. This is advised. When each product has its own
folder, you can

• use subfolders to store related files.
• choose whether you store the actual product file in its root folder (as in above example) or in

its own dedicated subfolder, for example named Production file.

Attention:  The more structure and consistency you have, the easier it will be for other
systems to also benefit from this data structure. They can then rely on finding files in specific
places and will also be able to provide you files in specific (sub)folders.

Note:  When creating Product (Parts) via JDF, see Products JDF setup to learn about extra
possibilities.

The Product Data Zone (PDZ)

A product has one or more Product Parts and each part refers to a specific product part file. So
when we talk about the product data we more precisely mean the product part data. Learn more in
Product (Part) Properties on page 893.

The place where the product part file and its related files are located is also referred to as the product
part Data Zone. In the Pilot, when working with products, you sometimes want to launch tasks on
files related to that product. For example: selecting its report file and launching the E-mail task. That
is why it is advised to see more data in the Pilot than just the product part file.

The Depth of a Data Zone

The Data Zone is not just the folder where the product part file is located, it can be a larger zone.
How large this zone is is decided by its Depth.

The reason to set this depth is to control how much data the Pilot users will see and have access
to when selecting a product in the Pilot.

The depth of a product part data zone is decided when the product is created. It then takes the value
as defined in  Tools > Configure >  Products > Product Part Data Zone . Learn more in Configuring
the Data Zone Depth.

Here are some examples:

4.2.1 Examples of Data Zone Depth

Example 1: a Product Part with a Data Zone Depth of 1

The product shown below was created with a data zone depth of 1. See how, when you select the
product thumbnail, the Data Zone pane not only shows the folder Esko where the product part file
is located in, but also 30001, which is 1 folder higher. If the depth was 0, you would only see the
folder Esko and so have no direct access to other product's related files.



4
Automation Engine

884

Another place where this depth is visible is in the properties of the product part. Notice how the
definition of File in this case starts with (1) folder name:

Note:  In this properties dialog, it is possible to manually change this depth. This might be useful
when a wrong depth was used at product creation time. In above case you could for example remove
Esko/ from the File definition and it to the Data Zone path.

Example 2: a Product Part with a Data Zone Depth of 0

As in the above example, the product has its own folder and subfolders. But here, the actual part
file is not stored in a subfolder, but it is located in the root of that product folder. See how the PDF
is in the folder 22004 :

This indicates a Data Zone depth of 0. There is no need to, when you select the product, to see a
folder higher than 22004.

Note:  In the Data Zone pane, folders below the selected part are always visible.
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In the product part setup, notice how in this case the definition of File only contains the name:

Example 3: another Product Part with a Data Zone Depth of 0

In this example many product part files share a same folder, they do not each have their own folder
and subfolders. Here's how it looks in Container mode:

See below how, when the product thumbnail is selected, the Data Zone pane only shows the file's
parent folder FruitCo Products. Also here, there is no need to see 'higher', the related files are
in the folders below:

In the product part setup, the definition of File does not contain a folder name:



4
Automation Engine

886

Example 4: a Product with 2 Parts with a Data Zone Depth of 1

Note:  Multi-part products were introduced here.

This example shows a product that has 2 parts. Each product part file is stored in its own folder but
they share a common root folder.

See below how, when you select a part, the Data Zone pane also shows 11106, which is 1 level
higher than the folder the part file is located in:

In the product part setup, the definition of File contains 1 folder name:

4.3 Products Views and Menu

Note:  In the Files view you can not see if a file is a Product Part. Use the here described view
modes to work with products:

4.3.1 The Products Gallery View
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In Container mode, select the Products view to see

• the Product Gallery: a view on all or a filtered list of your Products. Choose the thumbnail view
 or the list view .

• the Data Zone pane (switch it on or off in the menu Product). This shows the data zone of the
selected product. Learn more in Products Data Structure on page 881.

• the Tasks pane (switch it on or off in the menu View). This shows all tasks launched on any of
the viewed products.

• the Launch Favorites pane (switch it on or off in the menu View). This shows your favorite tasks
available for the file type of the selected product(s).

Note:  A thumbnail mentions N/A when the thumbnail is not available. The reason for this can be

• because the product is an "empty" product: in JDF workflows, it is possible to create a product
part that has no link to a file yet.

• because the product part file is not a supported graphics file type (as we listed here).

The Products List View

The list view  offers the same functionality but shows the Product Gallery in columns:
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Go to  View > Select Columns in >  Product Gallery...   to customize which columns you see.

Tip:  You can also right-click on a column title and deselect that column there.

Note:  You can choose different columns for product parts (when also viewing the Parts pane).

Working in the Gallery view

Tip:  You can select multiple products by using Command-click (Mac) or CTRL-click (Windows) or
by using SHIFT-click to select a series.

You can use the Products Gallery view to

• create a new product ( ). Learn more in Creating Products on page 897.
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• get information about products:

•  indicates a Global Product,  a Job Product. Learn more here.

• To see if a product is linked to one or more jobs, you need to open the product's Properties.
Learn more in Product (Part) Properties on page 893.

• In thumbnail view, the color of the top bar indicates the status. Learn more about statuses
and their colors in Product Properties. When a product has multiple parts that do not have the
same status, this bar will be shown in grey. Learn more about multi-part products below.

• In thumbnail view, a number in the top right corner indicates that the product has more than
one product part. Learn more below.

• In thumbnail view, the text fields describe the main product attributes. Use  View >  Select
Thumbnail info in >  Product Gallery...  to customize the information that is shown there.

• manually change product properties. Press  or right-click the product(s) and choose Product
Properties.... Learn more in Product (Part) Properties on page 893.

• launch tasks on one or multiple products. Select the product(s), choose a favorite ticket or right-
click and choose New Task or Launch with.

Note:  A task that you launch on a product part that is linked to a job will run in the context of that
job. This is important when you use job related SmartNames in the task's ticket(s).

Note:  If a product is linked to more than one job, the task will run in the context of the job that
this product was most recently linked to. Learn more in Product Setup on page 894.

Viewing Multiple Parts

When you select a product that has more than 1 part, an extra pane opens that shows those parts.
This happens automatically when you activated the function 'Show Parts' from the menu Products.

Tip:  You can re-size this Parts pane, the Pilot will remember its size.

Note:  In the Data Zone pane, the file(s) representing the selected product part(s) will be highlighted
in grey (and vice versa).

Note:  The name of the main product thumbnail is the name of the first product part (as defined in
its properties). Learn more here.
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Note:  The thumbnail info of a product part can be different than for the main product thumbnail. Set
this info in  View >  Select Thumbnail info in >  Parts... .

By seeing the separate parts, you have all the above mentioned functionality also available on product
parts.

If however you want the functionality (a task or managing properties) to happen on all parts, then
there is no need to view or select any parts. For example launching a task on the main product
thumbnail will automatically launch this task on all parts.

Filtering and Searching

The filter and search tools enable to quickly make smart product selections. You can also save these
filters as a Smart View.

You can search and filter products in the same way as you do with Jobs. Learn more in Job View
Filters on page 832.

More Functionality in this View

A lot of functionality is offered when you right-click one or multiple products:

• Use New Task and Launch with... to launch a task or workflow on your selected product(s).
Learn more in Launching a Workflow on a File on page 1034.

• Use Open..., Open With and View... to open the product part file in a chosen application or in
the Automation Engine Viewer.

• Use File Info... to see the metadata of the product part file.

• All other features are described in The Product Menu on page 892.

4.3.2 The Product(s) in a Job View

When in Last Used Job mode, the Products view shows which products are linked into that job.

When this job is a "prepress job", your goal will be to get that product approved and ready for output.
When this job is a "production job", you will probably work on step & repeat (in an editor or via tasks)
and/or output tasks. Learn more about these job types in Types of Jobs on page 829.

See this an example of a production job that needs to output 2 labels:
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Notice how

• the 2 products have a status 'approved', which is typical when you start outputting them.
• a Step & Repeat task was launched on the 2 products.
• the resulting pdfpla file was output in the job's subfolder "Step&Repeat".
• that pdfpla file was selected to launch the Prepare for Viewer task.

Using the Data Zone pane to see All Related Data

In job mode, the Data Zone pane always shows the job folder. When a product is selected, you will
also see the product's data zone.

In this example, selecting the 'mango' product made the Data Zone pane also show folder '200108'
and its subfolders:
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Note:  The data zone of a product is decided at its creation time. Learn more in Products Data
Structure on page 881.

In job mode, the Data Zone pane offers access to all the data relevant for that job:

• When you want to access a file in the job folder, browse to it in the (blue) job folder.
• When you want to access a product part file, click on the product part thumbnail and choose

your action from there.
• When you want to access another file in the product's data zone, select the product part thumbnail

to visualize it's data zone and then browse in those (yellow) product folder(s).

Hiding the Files View

The fact that you can access all data using the Data Zone pane, means that there is no more need
to see the Files view (when you work with products).

Also, when you use the Products view and then switch to another job, the Files view will again be
shown. To avoid that you need to click on the Products view again, you can choose to hide the
Files View.

To do this, right-click on the Files view and choose Remove from Views Bar.

Tip:  To see the Job Setup while staying in the Products view, select the blue job folder icon and
use the shortcut CTRL-ALT-J (Windows) or Command-Alt-J (Mac).

4.3.3 The Product Menu

Tip:  Many of the features offered in the Product menu are also offered when you right-click on a
selection that you made.
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• New Product... allows you to browse to a file, create it as a product and link it to the job you are
in. Learn more in Creating Products Manually on page 897.

• Upload as Product... does the same as above but also uploads the chosen file to its new product
data zone. You can use this for example when the file is still on your local computer, on a CD/DVD
drive or already in a Container but not yet in its proper product place. Learn more in Uploading
As a New Product on page 898.

Note:  These features are also available when you right-click on an empty piece of canvas in the
Product Gallery.

• Link Products.... Use this feature to manually link product(s) to the job you are in.
• Product Properties... opens the setup of the product and its parts. Learn more in Product (Part)

Properties on page 893.
• Go To File shows you the product part file in the Files view of the Container mode.
• Explore Folder... opens a disk explorer view of the folder of the selected product part file.
• Link to Job... enables a quick way you to link a product(s) to a job from a list of most recent

used jobs (or choose Select Job... to select any other). You will get a warning when the product
is already linked to that job.

• Unlink Product. In Job mode, use this to remove the selected product(s) from that job. This does
not delete any files.

• Hide / Show Parts. Learn more in the Products Gallery View about working with Products that
have Parts.

• Manage Product Filters.... If you saved filters in your Products view, manage them here and
decide if you want to add them in the Views bar (as a Smart View).

• Manage Statuses.... This is where you can add or modify custom product statuses. This list also
contains Milestone names that were allowed to be used as product status. The way to add or
modify them is the same as described in Manage (Custom) Milestones on page 860.

4.4 Product (Part) Properties

Product properties are the attributes that are stored in the Automation Engine Products database.
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The concept is very similar to the Job Setup fields for Jobs. Most of the properties also become
available as SmartNames, in a dedicated category Product Information. Learn more on how to use
SmartNames here.

Note:  The SmartNames view allows to specifically test product part SmartNames. Learn more in
Also Show Product (Part) Parameter SmartNames on page 932.

The properties are divided in general product properties (Product Setup) and properties specific to
each product part (Product Part Setup).

Note:  The concept of multi-part products was introduced here.

You can also use the Product Properties dialog to manually Add or Remove Parts. You can use
the arrow buttons to sort the parts. A product will get its name and thumbnail from the product part
that is highest in this list.

4.4.1 Product Setup

General tab

• Name: For global products, the product name has to be unique. For job products, the name has
to be unique within a job. For example there can be multiple job products with the same product
name as long as they exist in different jobs. Learn more about global and job products here.

• Product ID: This is the product identification code, often (only) a number. The same remark as
mentioned above about uniqueness is also valid here. The maximum length of a product ID is
32 characters.

• Customer Name: Select the customer that this product belongs to.

• Customer's Product Reference: This is the name your customer uses for this product. It can be
useful as a search filter or for example to mention on a report file for this customer.
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• Custom Fields: You can define up to three custom fields to help you search the products
database or to use them as SmartNames.

• Description: You can add a description (maximum 128 characters).
• Status: Choose the products status from the list. Learn about standard and custom statuses in

The Product Menu on page 892.

Tip:  You can use the Wait for Product Status on page 525 task to hold and continue a workflow
based on this status.

Jobs tab

This is where you see which job(s) that this product is currently linked to, and when that link was
made.

Attention:  If the product is linked to more than one job, a task that is launched on that product
will run in the context of the job that this product part was most recently linked to.

Ordered Copies is an attribute that can be set when you use the The Link Product to Job task on
page 909. This number is picked up in the SmartLayout function of Esko's Step & Repeat editor
Plato (learn more in Working with Products in Editors on page 905). This number also becomes a
SmartName that for example can add its value to a report file.

Parameters tab

You can here add custom parameters that also become available as SmartNames.

Attention:  Mind that these parameters need to reflect what is specific for this product (range).
Parameters that relate to how you output this product (Step&Repeat, press...) are probably
more job related parameters and so belong in the job setup.

4.4.2 Product Part Setup

You can specify more and different properties for a product part because

• a part refers to a file. Some part properties relate to the file's location and its graphics
characteristics.

• a product can have several parts with different properties (for example the front has the barcode
and the back only has one ink).
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Most properties also become available as SmartNames (in the category Product Information).

See this example of a product with 2 parts:

General tab

• Data Zone: This is the path to the folder containing the product part. This could also be a folder
one or more levels higher. Learn more about the important concept Data Zone in Products Data
Structure on page 881.

• File: This is the name of the file for that product part.

Note:  If the parts file is in a subfolder within the parts data zone, you can include a folder name
in this field: subfoldername/file. Learn more in Products Data Structure on page 881.

• Name: This is the name of the product part. This can be different than the file name.

• Custom Fields: You can add up to 3 custom fields.

Barcode tab

If the product part file has an (Esko) barcode, you can specify its properties here. The barcode can
be checked and corrected using the interaction with Esko editors or by using the Check Product
Parameters task. The details and usage is identical as with jobs: learn more in the Job Setup Barcodes
tab.

Status tab

Each product part can have its own status. This is relevant when a product has multiple parts.

Note:  A product will automatically get the status of its parts when there is only one part or when
the status of all its parts is the same.

The set a status, pick it from the list or use the The Manage Product Status task on page 910 task.
If the status you choose has a Nickname, than that is the name you will see. Learn more about
creating statuses in The Product Menu on page 892.
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You see when and by whom the status of this product part was last changed. An extra note can also
help clarify why the status was changed.

Tip:  When the change was done by the The Manage Product Status task on page 910 task, the
user name includes the name of the server.

Parameters tab

You can set custom parameters per product part. Their SmartName version shows up in the category
Product Part Parameters and their name starts with [ppp. ].

Inks tab

The inks in the product part file can be checked and corrected by the interaction with Esko editors
or by using the Check Product Parameters task. Details and usage is identical as with jobs, learn
more in the Job Setup Inks tab.

Note:  JDF workflows that create product (parts) can also specify such ink properties.

4.5 Creating Products

Products can be created

• manually, using the Pilot

• by making a file a product part file
• by uploading a file to a new place and then making that file a product part file.

• automatically

• by using the Add To Products  on page 254. The task then defines the product properties
based on the file's URL or metadata or out of some XML file(s) etc.

• by direct JDF/JMF commands. This technique communicates directly to the server software.
For more information on JDF contact Esko Solution Services or find some basic answers in
the chapter Integrating with External Systems on page 1228.

Note:  You can also use above tools to modify products (except the upload method).

Note:  Removing products is described in this separate page.

4.5.1 Creating Products Manually

Note:  Learn about the difference between global and job products here.

Creating a Global Product

Follow these steps to manually create a new product:
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1. In the Pilot, go to Container mode and Products view and click on . Alternatively, go to
Product > New Product...   or right-click on an empty part of the canvas in the Product Gallery
pane and choose New Product... .

2. The dialog first asks you to select the file that you want to add as product part file. Make your
selection and click OK to continue.

Important:  When you select multiple files, the next steps will create them as parts of a same
product.

Important:  If you select a file that is located in an (active) job folder, you will automatically create
a job product.

3. Now define the product's properties, both of the product and of the product part(s). Learn more
in Product (Part) Properties on page 893.

Tip:  At this point, you can use the Add button to add extra product parts.

4. Click OK to confirm and create the product. The new product appears in the product gallery.

Note:  You will get a warning when a product part with the same name or ID already exists.

Creating a Job Product

To create a job product, you can use the same steps as above but you start in Last Used Job mode
(you are in a job and you select a file located somewhere in that job folder).

4.5.2 Uploading As a New Product

Upload as Product... does the same as creating a new product but also uploads the selected file
to its new product data zone.

You can use this for example when the file is still on your local computer, on a CD/DVD drive or
already in a Container but not yet in its correct product place.

Much like Creating Products Manually, follow these steps to upload one or multiple file(s) as a new
product (parts):

1. In Container or Last used Job mode, go to the menu  Product >  Upload as Product...  or
right-click on an empty part of the canvas in the Product Gallery pane and choose Upload as
Product...  .

2. Select the file(s) and fill in their properties (same steps as when Creating Products Manually on
page 897).

3. In the product part setup, there is now one extra field where you have to define the Destination
of the file. Choose the Use the Smart Product Location as set in Configure or browse to where
you want to store the product part.

The Smart Product Location is a tool that can define the location and name of the product part
based on a product parameter or on the default location for that customer. Learn more in Smart
Product Location on page 678.
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Note:  The Smart Product Location can be checked by clicking on Show Product Location.

4. Confirm with OK.

4.5.3 Creating Products Automatically

You can create products automatically by using the The Add to Products task on page 908.

You can launch this task

• as a user in the Pilot, after selecting an input file. This is advised when you use a task ticket in
which SmartNames already fill in many properties automatically.

• or this task can be part of a workflow that selects the input file(s) and also provides the values
for the required product properties.

To automate the creation of products, you typically create workflows that combine the The Add to
Products task on page 908 with some of these tools:

• the Select File on page 470 and the Select Referenced File on page 471 workflow control (when
the file path is mentioned in an XML or CSV).

• Using Regular Expressions  on page 978.

• the Data Splitter on page 308 workflow control.

• System Value SmartNames. Learn more in Creating System Value SmartNames on page 944
and see an Example of Looking for the Product Part URL on page 945.

Some of these are used in these examples of the two main types of product creating workflows:

Example Workflow 1: Building your Products Database from your Existing Data

When you start to work with the products tool, you may already have a lot of data that you want to
add to your products database. With this existing data, your goal is to launch workflows that create
many dozens or hundreds of products in one go.

Attention:  Based on what you learned in Products Data Structure, you can decide to first
re-arrange your data structure or to keep the data in their existing folders before you start
creating your products.

Tip:  It is good practise to first test this import on a part of your data, for example limited to one of
your customers. We advise to also test your output workflows with some of that first set of products.
You might learn details that you want to change before importing all your other products.

See this example where all the 200* folders contain one product part file in their root folder:
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This is the workflow we will use to automate creating these products:

We first use a smart way to select only the part file we need. We then add it as a product. We then
set the status.

These are important steps and settings in this workflow:

1. First manually select all the 200* folders and then launch or open your workflow.
2. The Data splitter (default settings) will split that group of folders and will so launch the Select

File step on every separate folder.
3. In Select File, use these settings:

• File Type: in this example the type we want is a normalized PDF.
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• In Select other Files, we select all those that are in the URL of what this step received as
input: that (single) 200...- folder.

• Do not Look in subfolders to avoid selecting the other PDFs or any report files.
4. In the Add to Products task, make sure to indicate the customer. We know the customer because

we make a manual selection under the product folders of a specific customer.

Tip:  When you do not set the customer via a SmartName, this workflow ticket becomes customer
specific. In such cases we advise to add that customer name to the name of your workflow ticket.

5. We propose to already set a status. When these data were produced earlier, you can for example
set their status to 'Approved'.

Tip:  When you are testing these workflows, make sure to check the Updating options in the Add
to Products task.

Example Workflow 2: Adding New Incoming Designs as Products

When Should a New Design become a Product?

The concept of products allows to add them to the database very early. As soon as you have a
representation, a new design, you can add this file as a product part.

You can use the product status to indicate what stage this product is in, for example New or
Preflight OK or Waiting for Approval etc.

Changing the Product Part File During Prepress Stages

You can also change the product part file during a workflow. For example you first use the design file
as the product part file but once you import or normalize or start editing you then move that original
design file to a subfolder original and update the product part with the more recent (normalized)
PDF file.

Note:  To update a product you use the same Add to Products task but use specific settings in
its Updating tab.

Creating a Product in a Job Context or Not

It is your choice to add the product while you are in a job context (in Last Used Job mode) or not
(in Container mode).

As mentioned in Types of Jobs on page 829, when you do not work in a job context, it will be difficult
to give feedback to your business system. However, many such systems do not give you a job-
order number to do prepress work on new designs. Many of them only send you job numbers for
'production jobs' in which you output already approved products.

In that case, you still have a choice to create your own 'prepress jobs'. A reason to do that is
consistency, because then everything that your users do in prepress (with Automation Engine)
happens in a job context.
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Tip:  But how do you name those self-created prepress jobs? You could base their name on the
name of the product they are supposed to create. For example if you know you are preparing a new
product that should be named 7890, then you could do this work in a job named Preparing_7890 .

Avoid Changing a Product Name or ID: Get it Right from the Start

It is very important to get the product name and ID as soon as possible. You do not want to create
a product and later change its name or ID. If this name is not sync with what the business system
expects then there will be no or little integration possible. For example if you send the business
system an early JPEG of the new design, it will need to have the correct name: the name of the item
that this system expects.

In an ideal situation, your business system sends you a prepress job and in there mentions the name
and ID of the product that it expects you to create.

In all other cases, to get this correct product name or ID, you will probably need to get this information
from people working with the business system. It is in that admin department that this number was
created. In the business process, those colleagues made the decision that you should prepare and
output a new design or variant, so they will have a record of that item number (and name).

Example Workflow

Your new designs can come in via many different ways. An important tool to help automate creating
them as a product are Access Points on page 1236. An Access Point can detect a new incoming
design and immediately launch a workflow that moves the file to the right folder for the product part
and then adds it to the product database.

See this example:

• A Folder Access Point detects new designs coming in from the customer FruitCo.

• This access point launches this workflow:

1. The found data is moved away from the access point folder to an 'arrival hall' for new designs
for this customer:
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Important:  We use this intermediate place because we first want to check what the correct
name and ID for this product will be.

2. The CheckPoint task asks a user to check with the admin department what the correct name
and ID needs to be. When needed, the user manually changes the name of that design file.

3. The next Move task is now able to move the design to a new own product folder. The folder
is decided by using SmartNames, based on the customer name and on the first 6 characters
of the designs name.

4. Now that we have the file in the right place and with the right name, we create the product.
5. A preflight is executed on the file.
6. The status we set depends on the preflight result.

Note:  You can of course extend this workflow with steps like editing and proofing. The goal of
this 'prepress job' is to have an approved product item. An other job should then serve to output
this product, possibly together with others.

Note:  There are countless variations of how new designs can be processed. To create smart ways of
automating their import to the products database, we advise to study all the possible tools mentioned
in Creating Products Automatically on page 899.

4.6 Linking Products to a Job

A global product can be linked to one or multiple jobs. A job product can only be linked to one job.

You can link a product to a job

• manually, using the Pilot, in Products view,

• in Container mode, by right-clicking one or multiple products, choosing Link to Job and
selecting the job from the list of recently used jobs (or by using the dedicated menu item).

• in Last used Job mode, by right-clicking in the Products panel, choosing Link Products...
and selecting the one(s) you want (or by using the dedicated menu item).
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• in Last used Job mode, in the Data Zone panel, by selecting a file in the job (sub)folder
and choosing the menu item Product >  New Product... . This will create a job product and
automatically link it to this job.

• automatically,

• by using the The Link Product to Job task on page 909.

• by using JDF/JMF commands. This technique communicates directly to the server software.
For more information on JDF contact Esko Solution Services or find some basic answers in
the chapter Integrating with External Systems on page 1228.

Which Job(s) is this Product Linked To?

You can see the job(s) that a product is linked to

• in the product's properties. Learn more in Product Setup.

• in  the list view. Learn more in Products Views and Menu on page 886.

Which Product(s) does this Job Link to?

You can only see which products a job links to by opening the job in Last Used Job mode.

4.7 Launching Tasks on Products

Launching tasks on products is very similar to launching tasks on files.

Here is some information specific to launching tasks on products:

• As with files, you can right-click on products and launch tasks from there. You can also launch
Favorites.

• Launching a task on a product will launch it on all its product parts. If you want to launch a task
on a specific part, use Show Parts to see the Parts panel and make your specific selection there.

• In Last used Job mode, in Products view, when you select one or more products and launch a
task, it will run in the context of that job. The SmartNames will relate to that job.

• In Container mode,

• tasks launched on products check if those products are linked to a job and will run in the
context of that job. See an example where two products were selected and the ReportMaker
task was launched:
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• when a product is linked to multiple jobs, the task will run in the context of the job that the
product was last linked to. Learn more in the Product Setup on page 894.

• In a workflow, you can use the Select File on page 470 task to select all the product parts of the
job (context) that that workflow is running in. The next workflow step is then launched on those
product parts.

4.8 Working with Products in Editors

Editors that have been configured to be a client of your Automation Engine server, will show extra
tools that help you work with products.

Easy Access to Open Products in Editors

Esko editors like ArtPro, PackEdge and Plato that communicate with an Automation Engine server,
offer an easy way to open product part files.

In their Open dialog, extra Job and Product lists help avoid a lot of browsing:

• You can select a job first and then the products linked in that job appear in the list of products:

• You can press Search... to open a dedicated Select Job or Select Product dialog.

• You can click on the drop-down arrow to pick one from the memory of last used jobs or products.
• When you open a product that has multiple parts, an extra dialog will open to let you choose

which part you want to open.

Tip:  When you are editing a product and you want to update it with your changes, then you best
use Save and not Save as. Saving as another name and/or in another folder will not change the
product part's URL.
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Editors Checking a Product's Barcode and Ink Parameters

As mentioned in the chapter on Jobs on page 828, Esko editors check if the file's barcode and ink
settings match those that were defined in the file's job setup (in Job Ink parameters and Job Barcode
parameters).

The same principle and tools are valid when your editor opens a product part file that has properties
for barcode and/or inks.

Note:  When both the file's product part and the file's job have such parameters defined, then the
product part parameters are checked.

Note:  When an editor is checking product parameters, the dialogs use the same wording: they also
mention "Check Job Parameters" when they check product parameters.

And, as with job parameters, there is also a dedicated task to check or correct such product
parameters. Learn more in the Check Product Parameters task.

In Esko Plato: Fast Ways to Load Products onto a Layout

Esko's Step & Repeat editor Plato offers extra tools that also avoid searching and browsing when
you put stations on the layout.

For this to work, Plato first needs to be aware in which job you are working. This is done in the
Layout Setup dialog:

• When you create a Manual Layout, the dialog Place Station offers the same job and products
lists as in the Open dialog, as shown above.

• When you create a new grid based layout, your right-click to add a station now also offers to add
the product parts (that are linked in that job):

• When you create a SmartLayout, you can choose to Load All Products... that are linked into
that job. Customers who often make layouts with many different files will quickly see the benefit
of this function:
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In Esko Plato: Using the Product Parameter "Ordered Copies"

When you load a product part in SmartLayout, Plato also checks the Product Setup parameter
Ordered Copies and automatically fills it in in the SmartLayout dialog.

An example: This product is linked into 3 jobs but for job 440123 there are 7.500 Ordered Copies:

When Plato works in the context of job 440123, and when you use that product in your SmartLayout,
that number of ordered copies will be filled in automatically:

Learn more about Plato here.

http://help.esko.com/products/Plato
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4.9 Tasks specific for Products

4.9.1 The Add to Products task

Attention:  This task requires you to be familiar with the manual setup of Products on page
876.

You can use this task to create a product (part) or to add or modify parameters of a product (part). You
can not delete product (part) parameters using this task. Learn more below on how to update fields.

The setup fields can be filled with SmartNames, typed in values or values chosen from a list.

Select item to set up: There are different tab sheets for product and for product part setup. Every
product hast at least one product part, so both are important.

Setting Up the Product

• General: You here define the main product properties. This tab is similar to the General tab when
you manually define a Product Setup. Learn more about each field in Product Setup on page
894.

• Parameters: You can here define custom product parameters. This tab is identical to the
Parameters tab in the Product Setup. Learn more about each field in Product Setup on page
894.

• Updating: When a product with the same Product ID or Product Name already exists, this task
will update that product. Define the rules here.
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• Update: If you want the existing product to be updated with the info from the task.

• Do not update: If you do not want the existing parameters to be updated.

• Update and provide a warning.

• Do not update and provide an error.

Link Global Product to the current Job: If you enable this the product in the task will be linked
to the current job context.

• Create Customer automatically when it does not exist yet. Indicate if you want this.

Note:  Mind that a customer exists when the Customer ID already exists.

Setting Up the Product Part

The settings for the product part as very similar to the ones for the product, that we explained above.

For the part, there are extra settings for the part's File:

• Update: If you want to update the product part with your task input file.

• Do not update: When the product part should not be updated with your task input file.

• Update and provide a warning.

4.9.2 The Link Product to Job task

The Link Product to Job task allows to link one or multiple products to a job.

It also allows to specify the Ordered Copies: this is the amount of product items that need to be
produced in that job order.

Select Job
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The job to link to can be indicated via its Name or via the combination of OrderID and SubOrderID.
You can select a specific job from the list but typically you will enter a SmartName here.

Note:  When the job does not exist, the task generates an error.

Note:  When the input file belongs to a product that is already linked to the specified job, the task
does nothing. This also means that the Ordered Copies specified in the task is then not set in the
product properties.

Ordered Copies

Enter the amount manually or use a SmartName. Learn more in Product Setup and in using the
ordered copies parameter in Esko Plato.

About the Task Input File

• When the input file is a product part of an existing Global Product, the product is linked to the
specified job and the ordered copies is set for that job (if the product was not yet linked to the
specified job).

• When the input file is a product part of an existing Job Product, the task generates an error.

• When the input file is not yet a product part, the task generates an error.

4.9.3 The Manage Product Status task

The Manage Product Status task allows to set the status of a product.

You can add an extra comment.

Tip:  Adding a comment is most useful when the status change was a user's decision. For example
a comment that mentions that the customer couldn't approve via E-mail or web due to network
problems and so exceptionally called you to confirm that he approves the file.

This task is often used to automatically set the product status during a workflow. See some examples
in Creating Products Automatically on page 899.

4.9.4 The Wait for Product Status task

The Wait for Product Status task allows to hold a workflow until (all) the input product part(s) reach
the status specified in the ticket.
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This task will wait until all Product Parts reach that status.

Learn more about product (part) status in The Product Menu on page 892 and Product (Part)
Properties on page 893.

Note:  This task ends in error

• when none of the input files are product parts.
• when one of the input product parts is deleted from the products database while the task is

waiting.

This task is typically used to prevent output before the product part(s) are approved. See this example
workflow:

Notice how the input of the Wait for Product Status task is defined by the Select File on page 470
task that has a specific option to select all the product parts in the job:
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4.9.5 The Check Product Parameters task

Note:  The concept and tools explained here are very similar to those in the The Check Job
Parameters Task on page 874.

The Check Product Parameters task allows to make sure that the barcode and/or inks of the task's
input file match the properties specified in its Product Part Setup. You can use the task just to check
the file or you can use it to automatically correct the file.

Note:  The input file must be a Product Part file.

Important:  When no output file name or folder were specified in the ticket, the Auto Correct actions
will overwrite the input file.

For Barcode settings, you can select:

• Auto Correct when you want to correct the file according to what is specified in its Product Part
Setup.

For example, your normalized PDF includes an Esko barcode of type EAN-13 and code
123456789012, and your product part specifies EAN-13 and code 5449000050205, then this
task will automatically correct the barcode number in the PDF to 5449000050205.

• Stop with Error when you want the task to stop with an error if the barcode in the Product Part
Setup does not fully match the barcode in the file.

Note:  This task only checks barcodes created in Esko PackEdge or by using Esko's barcode plug-
in for Adobe Illustrator (DeskPack). If the task does not find such a barcode, the task will end in a
warning.

Note:  You cannot use this task to check and auto correct barcodes in normalized PDFs generated
by ArtPro.

For Inks, you can select:

• Auto Correct: For each ink in the input file, the task checks if the characteristics of the ink match
the settings in product part parameters. If they don't match the file is corrected.

• Auto Correct (Strict Checking): Same as above but also generates an error if the file's list of
inks and the order of inks is not exactly as defined in the product part parameters.
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• Stop with Error: This is a strict check on the list of inks, their order and their characteristics.

4.10 Publishing Products to WebCenter

You can use the Publish On WebCenter on page 449 task to publish files from within an Automation
Engine container to a WebCenter project.

When you launch that task on an Automation Engine product,

• the product part file will be stored as a project document
• the product part file will also be stored as a document in the Bill Of Material of that WebCenter

project. The product (part) properties can be stored as WebCenter document attributes.

Note:  The reverse is not possible: it is not possible to push WebCenter document attributes to
Automation Engine product parameters.

Learn more about this in Publishing Products to WebCenter, a page in the dedicated chapter on
Integrating with WebCenter on page 1346.

4.11 Backing Up and Archiving Products

Backing Up Product Data

As explained in The Products Concept on page 876, data belonging to products are important data
that you want to keep online for a long time. This is why we advise to schedule a regular backup of
your product data. This can be done with many specialized (non-Esko) backup applications.

Additionally, we advise to use the database backup tools of Automation Engine. The products
database contains the properties of all your products. Remember that you can not restore selections
of this database, restoring is done on the complete database. And remember that the products
database is not a separate database but a database table in the jobs database.

Note:  Some customers also use the Pilot to back up the product part files. You can select all or
groups of products in your products gallery and launch tasks that can copy that data to a near-line
disk or off-line to some device (CD/DVD). You can launch the Create PAF / JPG / XML (LinkEdge)
on page 285 task (on normalized PDFs) or the Copy task or you can create workflows that copy the
whole product part data zone. If you accidentally lost product data, it will then be easy to recuperate
a selection of that copied data.

Archiving Product Data

As explained in The Products Concept on page 876, a product should stay in your database as
long as a job-order can come in that needs (to output) it. Ideally, the business system informs you
when its users have decided that a product item is 'end-of-life'.

Some customers keep some outdated products in the database to use them as basis for new
designs. When you do this, mind that exceptionally large databases may cause your system to slow
down.
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Tip:  When you do keep outdated products in the database, make sure to give them a status that is
easy to recognize, for example end-of-life or do not output.

Another reason to remove old products is to avoid the risk of using them again in production.

Tip:  You can reduce that risk by using a workflow that checks the status before outputting. See an
example in The Wait for Product Status task on page 910.

Important:  The Archive Job on page 260 task archives and restores job folders and job products.
Global product files are not stored inside job folders and will not be archived by this task.

In summary, there is no specific task or procedure to archive products. We advise to stick to these
general rules:

• Make regular backups of all your product data and database.
• Remove products from the database when you can.
• Use the product status to help indicate if a product can still be used for output.

4.12 Removing Products

What Happens when you Remove a Product?

When you remove a product, the product and all its parts are removed from the product database.
The product part files on disk are not removed.

Removing a Global Product does not leave a memory of the product (part) parameters. When you
make the file a product (part) again, it will not propose you any previous settings.

This is different when the product was a Job Product that was removed together with the job. When
you remove a job it always stores a memory of all its settings in a subfolder and this is also done
for settings of any job products. When you then use that ex-jobfolder to (re-)create a job, the old
product(s) are re-created in this job as job products and will have all their product (part) settings again.

When do you Remove a Product?

As mentioned in The Products Concept and in Backing Up and Archiving Products, (global) products
are created to be used for a long term.

It makes sense to remove a product when you are sure it will never need to be produced (output)
again. In other words, when there are no more benefits of having it in a database: when you don't
link it into jobs anymore or you don't use its SmartNames any more.

Removing a Product when in Container mode

In the Product Gallery, select the product(s) and press Delete or use the right-click or menu function
Product >  Remove Product . A dialog will ask you to confirm.

By default, you can not remove products when they are still linked to a job. However, you can force
this removal by using the option to also remove those job-links at the moment you remove the
product(s). This is the option Also remove from linked jobs or Also remove linked products from
all linked jobs.
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Removing a Product when in Job mode

When you are in a job's Products view and you select a linked product, pressing Delete serves
to Unlink the product from that job. However, the resulting dialog offers an option to Also remove
the product from the products database:

When you are asking to remove a product that is still linked to other jobs, you will see this warning:

If you want to remove products that are linked to multiple jobs, you need to do this in Container
mode (in the Product Gallery).
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5. SmartNames

5.1 Concept

What is a SmartName?

A SmartName is a variable that refers to a value. You use them by inserting them in input fields all
across Automation Engine. For example the SmartName [File] refers to the name of the task's
input file, and the SmartName [Date] refers to the date the task is launched.

SmartNames are shown in green and between square brackets. For example  .

Where can SmartNames be used?

Note:  Not all SmartNames can be used everywhere. To learn about limiting the places where they
can be used see SmartName Scopes on page 926.

• In Task Tickets, Workflow Steps and Access Points

See an example of a ReportMaker ticket:

The output file will be written in the Job Folder, in a sub folder 'Reports'. The output file name
will start with the name of the input file name plus the suffix '_reportcard_' and ending with
the date when this task is launched.

Tip:  You here also see how you can make combinations of SmartNames and regular (static) text.

The report template that will be used starts with the customer's ID number and ends with
'_Report_Template'. This makes the ticket smart enough to select the template that this
customer prefers.

• In some fields of the Job Setup

In this example a SmartName defines the code of the bar code in the Job Setup (the code is a
variable that will be coming in from an XML file):
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• As Workflow Parameters in Workflow Steps

When your workflow contains Workflow Parameters, you can pick them up as Workflow
Parameters SmartNames in task tickets of tasks used in that workflow. Learn more about
Workflow Parameters in Workflow Parameters.

• Inside SmartMarks

See this example of how a SmartMark (here in PackEdge) uses a Smart Text that also picks
up 2 SmartNames:

• Inside the setup of other SmartNames
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Some examples:

• You can create a custom SmartName that extracts the first 5 characters from the [Job Name]

• In below example, a conditional SmartName 'EXA_Which_Site_Is_Closest' compares the
value of two other SmartNames

• Inside some fields in the Customer setup
• In Configure, in some setup fields of Jobs and Products

Advantages

SmartNames are a crucial part of Automation Engine's power. They bring speed and error reduction
to your workflow through these effects:

• Consistency. Folders and file names will be consistent, no typing errors.

• Automation. You will rarely need operator intervention to edit workflows.

• Integration. SmartNames can pick up their value from other systems without human intervention.

• Organisation. Making workflows smart means you need to prepare less workflows. Smart
workflows adapt to the input files and the variable job instructions.

When you first install or update Automation Engine, you already get many Default SmartNames.
You can also make your own.

In the next chapters, we first give an overview of the general principles. Then we describe the different
types of SmartNames in more detail. We both explain the default ones and then show you how to
create your own.

5.2 General Principles

5.2.1 Using a SmartName

There are 2 ways to use an existing SmartName:

• click on  to open the SmartName Browser. Choose a category, select the SmartName and
click Insert.
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• When you want to insert multiple SmartNames, press ALT while clicking Insert. Then, the
SmartName Browser will not close.

• You can filter the shown SmartNames by entering text in the search filter top-right. Use double
quotes (") when an exact match is required.

• You can even combine search filters. For example when you type '123 exa', you ask to see
SmartNames that contain both 123 and exa in their name or Tag (learn about tags here) . Add
a semicolon '123 ; exa' to see SmartNames that contain 123 or exa.

• Click Refresh to make sure that the most recent created SmartNames are also shown (or
press CRTL-R or CMD-R).

• Click New SmartName if you want to create a new one from here, while keeping this dialog
open.
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• right-click in the field, choose Insert SmartName... and choose a SmartName from the offered
categories.

Important:  In both ways, make sure you first position your cursor in the exact place where you want
to insert the SmartName.

Tip:  It is possible to select and cut, copy and paste SmartNames.

5.2.2 The SmartNames View

The SmartNames View in your Pilot is where you

• see all your SmartNames, both the default ones that came with Automation Engine and the ones
you created extra

• add filters to help find and organize them
• create, modify or delete SmartNames (if you have the User Access Right. Read more in Defining

User Access Rights on page 33)

• test your SmartNames ("resolve").
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As usual, you can control the columns in this view. To do this, go to the menu  View >  Select
Columns in 'SmartNames'...  (by default they are all shown).

You can add a Description to your custom SmartNames. This quickly reminds you what they are
for, without the need to open and analyse them.

Tip:  The SmartNames View is not available when your Pilot is in Jobs Overview mode.

Tip:  When you choose  Tools >  SmartNames , the SmartName View opens as a separate window.

Type - Category - Scope - Private - Tags (Overview)

We here briefly describe what these columns mean. Find more detailed descriptions on some of
them in the next pages.

• Type. The type is a very important distinction. It defines what kind of technique the SmartName
will use to get (resolve) its value. Will it get the value from a database inside Automation Engine? Or
by asking the database of an external system? Or from an XML file or from another SmartName?
All types are documented in SmartName Types (Overview) on page 923 and later in even more
detail.

• Category. Categories are an old way of helping you filter and group SmartNames. We recommend
using Tags instead (see further).

• Scope. By default the Scope of a SmartName is global. This means you can use it everywhere.
Defining a different (smaller) Scope for a SmartName means that you want to limit the zone where
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it can be used. For example: if you define the Scope 'Step and Repeat' then you indicate that
this SmartName makes no sense to be used outside that concept of Step and Repeat. More on
this in SmartName Scopes on page 926 .

• Private. You can save a SmartName as Private. Private SmartNames are not visible when
applying SmartNames in a ticket. They do not appear in the list or the SmartName Browser.
Two example use cases:

• the SmartName is only used as a sub-component of one or more other SmartNames (that
users will see and use)

• you are still testing a new SmartName in the SmartName View and you do not want other
users to already use it.

• Tags. Adding custom tags to a SmartName helps you filter and group them. Read more on this
in SmartName Tags on page 927.

The right panel

On the right side of the SmartNames View, you can add more SmartNames to the list and you can
test them extensively. Read more in Testing SmartNames on page 931.

Advanced Search Criteria for SmartNames

As in many other Views in the Pilot, you can use Advanced Search Criteria. To activate this, type
in the Find field or press CMD-F (Mac) or CTRL-F (Windows). You see the criteria of the current filter.
Click the + or - to add or remove extra lines of criteria.

This screen shot is an example of a filter that shows all SmartNames with exam in their Tag.

Click Save to save this filter. Define if this filter is for yourself or for all users. Decide if you want to
Add to my views bar.

See an example of custom Smart Views:
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5.2.3 SmartName Types (Overview)

Later in this document we describe each type in detail. Here is an introduction:

Database Query SmartNames

These retrieve a value from an external database. This is useful when there is no other way that the
external system can send the information to Automation Engine (via XML or CSV or E-mail ....)

Read more on this type of SmartNames in Database Query SmartNames  on page 968.

String Extract SmartNames

These SmartNames extract a part of a string of characters (text or numbers). For example: when the
input is '123-abc', then extracting all characters before the '-' will result in '123'.

Note:  The string from which the value of the SmartName is extracted can contain other SmartNames.
For example: extracting the first 5 characters of the [JOB ID].

Read more on this type of SmartNames in String Extract SmartNames on page 948.
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System Value SmartNames

These retrieve a value from one of Automation Engine's own databases. You get these when you
install or update your Automation Engine server software. For example [Access Point E-mail
Sender] (only valid in the context of an Access Point)

Read more on this type of SmartNames in System (Value) SmartNames on page 939.

Script SmartNames

These use JavaScript to define a value.

Read more on this type of SmartNames in Script SmartNames  on page 970.

XMP Path Query SmartNames

These retrieve a value from the XMP (metadata) section of a PDF. For example when it was last
modified or the PDF version number.

Read more on this type of SmartNames in XMP path Query SmartNames on page 958.

Xpath Query SmartNames

These use XPath Queries to retrieve a value from an XML. The Xpath Builder is a great help to
construct these Xpath expressions.

Read more on this type of SmartNames in Xpath Query SmartNames on page 953 .

Conditional SmartNames

These return a value based on a condition. For example a SmartName 'Trapping size' has these
conditions: if the workflow parameter 'Printprocess' is 'flexo', then return '0,2' and if the
workflow parameter is 'digital' then return '0'.

These SmartNames are also often used to route workflows in one or the other direction.

Read more on this type of SmartNames in Conditional SmartNames  on page 961.

CSV Text Extract SmartNames

These extract a value from a CSV file. For example take the value from field 5 on line 2.

Read more on this type of SmartNames in CSV Text Extract SmartNames on page 951.

5.2.4 SmartName Categories

SmartNames are sorted into categories, so you can find them more easily. The SmartName View
and the SmartName Browser show you these categories and their members:
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Date

Use SmartNames of this category to insert the [Date] or [Time] of their execution.

File Information

These SmartNames return file-related information from within the file itself (for example [Media Box
Width] ) or from within the Automation Engine database ([File Type], [Folder of File],
[Smart ID] ...). The most popular one is [File], representing the name of the ticket's input file.

Global

This is a full list of all the SmartNames that can be used anywhere throughout Automation Engine.
The ones with a limited Scope will not be listed here.

JDF

These SmartNames are only used in tasks where JDF constructs are used. Read more about JDF
in What about JDF? on page 1230.

Job Information

These SmartNames refer to most of the fields in a Job setup, including the details of Customer and
CSR for that Job. Information on the location of the Job is part of the category Path Information.
Any custom Job Parameters are also a separate category.

Job Parameters

When you are in a Job context of a Job that has custom Job Parameters, you will see them here.
Their name automatically starts with 'jp. '
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Miscellaneous

• Some SmartNames return the name of the Automation Engine server(s). They are useful when
you use Assistant servers.

• [Auto-Number1] will add a sort-number to a group of output files. This helps sorting files. Find
more information here.

Path Information

These SmartNames correspond to the Job's location. Find more details in System (Value)
SmartNames on page 939.

Tip:  If these SmartNames are greyed out (unavailable), it means that the field you want to insert
them into is not a path field.

Product Information

These SmartNames are only useful when you use the Products on page 876 tool in Automation
Engine. Much like the category Job Information, this category relates to the many fields in the
Products database of Automation Engine.

Read more about setting them up in Product (Part) Properties on page 893.

Task Information

This category of SmartNames allows to insert task related information (Task Name, Operator,
Application Version...). Find more details in System (Value) SmartNames on page 939.

Workflow Context

These SmartNames pick up specific names or paths of folder or files in a workflow context. They
help avoiding that you have to make complex workflows or create complex custom SmartNames
to achieve the same result.

Find more details in System (Value) SmartNames on page 939.

5.2.5 SmartName Scopes

Depending on where you are in Automation Engine, different SmartNames may be available for use.

Global SmartNames

These SmartNames are available everywhere where SmartNames are offered.

SmartMarks SmartNames

These SmartNames are only available when using SmartMarks. In Concept on page 916 , find an
example where a SmartName was used to decide the Smart Text in a SmartMark.

Step and Repeat SmartNames

These SmartNames are only available in Step and Repeat tasks.
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Mark Information

These default SmartNames are only available in the task Add Marks to Imposition (page workflows
only).

Page Information

These default SmartNames offer information on the (PDF) page attributes, typically height and width.
You can use these in the (page) imposition related tasks like the Export Imposition to PDF File.

Plate Information

These default SmartNames offer information on the plate attribute of a (page) imposition. You can
use these in the task Export Imposition to PDF File.

Stripping SmartNames

These default SmartNames are only available when retrieving values from JDF files (with the Import
JDF Stripping task).

Imposition SmartNames

These default SmartNames are only available when working with impositions (for example, in the
Export Imposition to PDF File ticket).

Unit Text Field SmartNames

SmartName enabled unit text fields are available in tasks where units have to be entered. You can
do unit conversions and simple arithmetic using the operators +, -,* and  / . You can also use
parenthesis ( ) if necessary while calculating. PowerTrapper, Change Imposition Layout and Create
CAD sheet and a few examples of tasks that offer such unit text fields.

Some examples:

5.2.6 SmartName Tags

Creating a Tag

The Scope of a SmartName defines where it can be used. The Category of a SmartName helps
filtering. Adding Tags to a SmartName is an extra tool that enables you to organize them via custom
filters.

Note:  Tags are also shown in a separate column in the SmartNames View.

You can add one or more Tags when you save a new SmartName. When the Tag already exists, it
will appear in light blue:
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Tip:  In the Tags field, press the space bar to get a drop down list of all the Tags that were already
created on your Automation Engine.

To add a Tag to an existing SmartName, select it, right-click and choose Info to edit and add one
or more Tags.

To remove a Tag from a SmartName, select it and press the Delete button.

Tagging multiple SmartNames

1. In the SmartNames View, (filter and) select the SmartNames you want to tag.
2. Right-click and choose Tags.... A dialog will show what Tags they already have in common: Tags

that are not assigned to all selected SmartNames are shown in grey.

3. To add a Tag to all selected SmartNames, add the Tag and click OK.
4. To remove a Tag from all selected SmartNames, delete the Tag and click OK.

Filtering SmartNames on Tags

To filter SmartNames on Tags,

• in the SmartNames View, select the search field and type the name of a Tag.

Tip:  It is also possible to add a search row by pressing the Add "+"  button in the Scope bar,
and choosing Tags from the attributes list (that pops up on the left).

• when selecting a SmartName from the SmartNames browser, enter the Tag in the search field.

To filter on multiple Tags, separate the names by a space. For example to filter on SmartNames that
have both examples and OLH as Tag, type "examples OLH" into the search field.
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To filter on SmartNames that have either examples or OLH as a Tag, then separate the Tags by a
semicolon ";" (see screen shot).

Renaming a Tag

To rename a Tag, follow these steps:

1. Go to the SmartNames View, filter on the Tag.
2. Select all SmartNames that contain that Tag.
3. Right-click and choose Tags....
4. Double click the Tag to edit it and type the new name.
5. Click OK.

5.2.7 Creating a SmartName (General)

These are the general steps to create a new SmartName. Find more detailed instructions per
SmartName type further in this document.

1. In your Pilot, select  Views > SmartNames .

2. Click on the Create a new SmartName icon  in the toolbar. Alternately, choose  File >  New
SmartName .

This opens the SmartName setup dialog:
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Note:  Click  to select the attribute from a drop down list.

3. Select the Type. We introduced the available types in SmartName Types (Overview) on page
923. See further in this document for a detailed setup instruction per type.
Depending on which Type you choose, the dialog adapts to offer different options.

4. Select the Scope. We introduced the available scopes in SmartName Scopes on page 926.

Note:  You can easily change the Scope later ; this does not affect the setup options.

5. Set all the required attributes. This is a general introduction ; see the specific settings per type
further in this document.

6. Check the Result value (bottom left in the dialog).

Depending on the example input data (file), you can already here see the example result with the
already chosen settings.

7. Formatting Options... . You can still change the formatting of that result (text, number, data and
time). This is explained in detail in Formatting SmartNames  on page 972.

For example your SmartName already extracts a date out of an XML, but you also want to change
the format of that date from 25-Aug-14 to 25-08-14.

8. Click Save and enter a logical Name and a suitable Description.

When you use Save As..., the dialog stays open. This is very useful when creating multiple
variations of a SmartName one after the other.

SmartName Tags on page 927 explains all about adding Tags.
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Decide if your SmartName should stay Private. Read more about Private SmartNames this in The
SmartNames View on page 920.

9. Click OK.

You can use Save As... in the Add SmartNames dialog to enter a new name for the SmartName.
This is useful when creating multiple variations of a SmartName one after the other from the same
dialog.

10.Check the result of your new SmartName in more situations or tasks. Read more about this in
SmartName Relations and Dependencies on page 935.

5.2.8 Testing SmartNames

While creating new SmartNames you will want to test them. Instead of having to test them in a often
complex workflow, you can use tools available in the SmartNames View.

This part of the View contains 2 main sections:

• Include SmartNames From: This part serves to show extra SmartNames that were not appearing
in your list yet. Choose if you also want to show Workflow Parameters and/or Product (Part)
Parameters. Read more in Also Show Workflow Parameter SmartNames on page 931 and Also
Show Product (Part) Parameter SmartNames on page 932. The reason that you also want to
see them here is to test them as well. The next feature enables that:

• Resolve all using: This part allows you to test your SmartNames. You can test them on a task or
on a file. Read more in Test your SmartNames with 'Resolve All Using' on page 933.

Also Show Workflow Parameter SmartNames

Follow these steps to show extra Workflow Parameters in your list of SmartNames:

1. In Include SmartNames From, check A workflow and browse to the workflow that has the
Workflow Parameters you want to see here.
They will immediately appear in your list of SmartNames (unless you have a filter setting that
prevents that).

2. Tip: When your list shows many SmartNames already, it is possible you do not easily see them
appear. Because they are here all shown starting with the prefix wfp, you can easily check their
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presence by typing a name filter 'wfp'. Alternatively, you could also use the Category filter
Workflow Parameters.

Also Show Product (Part) Parameter SmartNames

Note:  This feature is only useful when your are using Automation Engine's Products on page 876 tool.

Follow these steps to show extra Product (Part) Parameters in your list of SmartNames:

1. In Include SmartNames From, check A product part: and browse to the product file that has
the Product (Part) Parameters that you want to see here.
They will immediately appear in your list of SmartNames (unless you have a filter setting that
prevents that).

2. Tip: When your list shows many SmartNames already, it can be hard to find them back in the list.
Because they are here all shown starting with the prefix pp, you can easily see them appear by
typing a Name filter 'pp' or 'ppp'. Alternatively, you could also use the Category filter Product
(Part) Parameters.
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Test your SmartNames with 'Resolve All Using'

The Resolve All Using tool in the SmartNames View enables testing your SmartNames. The basic
principle is that you give an example input which is then tested on all SmartNames.

Tip:  If the SmartName you want to test is a Workflow or Product (Part) Parameter, then first make
it appear in the list by using the feature Include SmartNames from. Read more on how to this in Also
Show Workflow Parameter SmartNames on page 931 and Also Show Product (Part) Parameter
SmartNames on page 932.

"Resolve all using:" - An example:

1. Make sure the SmartName you want to test is visible in the list.
2. If you want to test the SmartName by using it in a task, then first make sure you have a finished

task given a certain input. Then check A task and browse to the task in your task monitor dialog.
If you want to test the SmartName by using it on a file, check A file and browse to that file.

3. Click Show to start resolving all your SmartNames with the selected file or task. This also adds an
extra column to your SmartNames View.The example in this screen shot shows how the selected
file 666-2712_ReportCard.pdf made the SmartName [Everything before the _ ]'
resolved (resulted) in the 666-2712 .
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Set example values

This is useful for SmartNames that have dependencies. For the selected SmartName, you can type
in a manual value instead of needing to select a file or a task as input example.

Tip:  Not all SmartNames allow you to enter an example value. This will for example work for most
System type SmartNames and for the CSV Text Extract type SmartNames. This is because the
value of these SmartNames is a "given" and can be overruled by your new example value. The value
of SmartNames that are "calculated" can not be overruled ; the resolving mechanism will simply
calculate them when needed.

See an example in the below screen shot.

• You made a custom SmartName [File - only part before _], which is a string extract
with the _ (underscore) as separating character.

• This SmartName of course a depends on the system SmartName [File]. If you then select the
main SmartName [File], you will be able to set an example value.

• In our example, we enter the value "coco_765869".

• See how this value is shown as a manually entered example value: the  icon indicates this.

• See how the SmartNames (that depend on the SmartName [File] ), also react and resolve
a value: the SmartName [File - only part before _] results in 'coco'.
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Remove all Examples Values

Click this to remove all the example values from your SmartNames View.

Show results as Plain text

In some exceptional cases it can be necessary to insert a SmartName although the user interface
does not offer to insert this SmartName in this place. Use this function to see the SmartName as
plain text so you can then select, copy and paste it anyway in the dialog or ticket where you really
want it. Test carefully, because these cases are really exceptional.

A 'plain text' version of a SmartName looks a bit like XML code. For example [File URL] is in
plain text written as <<fileurl/>> .

Reload Resolved Values

This 'refresh' function is useful when the input for you test has changed in the meantime.

For example you are setting up SmartNames that are reading parts of an XML file and you already did
a test here. You typically want to test again after you know that the content of the XML file changed
(your test will show new values).

5.2.9 SmartName Relations and Dependencies

In SmartNames View, when you right-click on one or on a selection of multiple SmartNames, you
get these extra functions:
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Tip:  Most of those are also available from the View menu.

Attention:  How SmartNames relate to each other is very important when you need to manage
many of them. Such checks are very important especially when you plan to rename or delete
a SmartName!

Highlight Related SmartNames

Choose this function to highlight all SmartNames that need one or more of the currently selected
SmartNames: 'Need' can mean that the one you selected is based on the other(s) or it can mean
that the other(s) are based on the one you selected. This highlighting is a feature that stays active
until you switch it off again.

For example: see this screen shot of the ones related to the SmartName [File]:
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Select Related SmartNames

Choose this function to select all SmartNames that need one or more of the currently selected
SmartName. In this example [Fuel Cost] also gets selected because it [Fuel Cost no km]
needs it (to extract the unit 'km').

Select Dependencies

Choose this function to select all SmartNames that are used in the currently selected SmartNames.
If you select the SmartName [Fuel Cost no km] in the example below and then activate Select
Dependencies, the SmartName [Distance] will also get selected. This is because [Distance]
is used in the definition of [Fuel Cost no km].

Display Selected SmartNames Only
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This function is no longer about selecting but about limiting the SmartNames that are displayed. This
function helps when the selected ones are spread far out over your long list of SmartNames. See
how the limited focus is also shown at the top.

When you want to see all your SmartNames again, then simply choose the function Display All
SmartNames.

Display Unused SmartNames

When it's time to cleanup your SmartNames you will want to know which ones are not being used (any
more). Choose this function to display only the unused SmartNames. You will first get this warning
dialog:

Press continue to start the search. When done, decide what to do with them (delete? tag as
'unused'?).

5.2.10 Exporting and Importing SmartNames

SmartNames can be exchanged by exporting and importing (workflow) tickets that use those
SmartNames.

Learn more about exporting and importing (workflow) tickets in Exchanging Workflows on page
1009.

Caution:  SmartNames of custom Job Parameters ( [jp. ] ) will not be imported. When you
import a workflow that uses them, they will not be added into the job setup tab 'Parameters'.

Why Exchange SmartNames?

Exchanging SmartNames is typically done
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• with other people (during an Esko training or to send to Esko Customer Service).
• with other servers (colleagues that use another Automation Engine server in another plant of your

company).

How to Recover a SmartName that was Deleted?

Your SmartNames are a standard part of the Automation Engine backup data. When you want to
restore SmartNames that were (accidentally) deleted, you can get them back by restoring a backup
of that configuration. The deleted SmartName of course has to be part of that backup.

Read more about backups and how to restore them in Server Administration on page 38.

5.3 System (Value) SmartNames

We will first list the default SmartNames of this type (System SmartNames), then show you how to
create your own (System Value SmartNames) and end with some examples.

5.3.1 Default System SmartNames

We here describe the System type SmartNames that come with an install or update of your
Automation Engine server.

Remember:  In SmartNames View, the column Description already describes the SmartName
briefly.

Note:  Default System type SmartNames can not be changed. You can not double click and open
them. You can not copy them.

• Access Point Customer, Access Point E-mail Sender, Access Point E-mail Subject, Access
Point Host, Access Point Name: these can be used within Access Points.

• Access Point Path: the path to the folder on the FTP server that will be scanned.

• Access Point Protocol: describes the used File Transfer protocol in an FTP Access Point.

• Application Name and Application Version: mentions the name and or the version of your
Automation Engine software.

• Assembly: Assembly method as defined in the JDF file (Assembly/@order), only used in page
imposition tasks.

• Auto-Number1: the main reason to use this SmartName is to add control over sorting the files
in the workflow. This SmartName is therefore only valid when the task has multiple input files.
If you choose as output file name [File]_[Auto-Number1] then each output file will get an
(increasing) number. For example: your task input files are banana, lemon and mango.pdf.
Then the output file names will be banana_1.pdf, lemon_2.pdf and mango_3.pdf.

Note:  Notice that this SmartName is not related to version numbering!

• Back: the distance between the center of the back of the section and the trim box of the page
(typically used to add collating marks to a page imposition).
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• Backing up: the "backing up" method of the press (turn or tumble) as defined in the JDF file.

• Book Name and Book Number: name and number of the book (ImposeProof only).

• CSR for the Job: name of the customer service representative of the Job.

• Customer's Product Reference: name that your customer gives to the Product item.

• Customer's Job Reference: name that your customer gives to "his" job order.

• Date: the current date, formatted YYYYMMDD .

• Device ID, Device Model Description, Device Model name, Device Model Number, Device
Type: as defined in the JDF file, used for page imposition "Stripping" tasks.

• E-mail Address of the CSR for the Job: the e-mail address of the customer service
representative for the Job.

• Extension of File: the extension of the input file.

• File: the name of the input file without extension.

• File Type: the file type of the input file, for example PDF or PDFSC (= Esko Normalized PDF).

• File URL: the URL of the folder of the input file, the full path.

• First Folder of File: the name of the first folder of the input file. For example: the File URL
is file://aeserver01/ShareThatYouMadeContainer/FirstFolder/SecondFolder/
banana.pdf here, the First Folder of File is 'FirstFolder'.

• Folder of File: the name of the folder of the input file. In above example this is 'SecondFolder'.

• Folder of First Input of Master Workflow: name of the folder of the input file of the most outer
workflow.

• Folder of Input: the name of the folder of the input file (same as Folder of File).

• Folio: the page name of the current page (relates to Mark Information).

• Folios: a range of page names (folios) containing prefixes and suffixes (for example ~A~,~C~-
~E~,~G~).

• Imposition Name: the name of the imposition (page workflows).

• Ink Name: the name of the ink(s) (relates to Plate Information).

• JDF Device ID and JDF Device Name: the ID and name of the machine or software (RIP or
workflow) that interprets JDF.

• JDF Sheet Name and JDF Signature name: the sheet and signature name in the JDF file.

• Job Category ...: the category of the Job as defined in the Job setup, maximum 7 categories.

• Job Colors: the numbers of colors in the job (file) as found in the JDF file.

• Job Colors Mode: the Job color mode ('Black&White' or 'Full') as found in the JDF file.

• Job Container Name: the name of the Container where the Job has its Job Folder.

• Job Container URL: the URL of the Container where the Job has its Job Folder.

• Job CT URL: the URL of the "ct" folder of the Job (= where image files can be created during
normalization).
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• Job Customer Contact 1, 2, 3 : the name of the 1st, 2nd and 3rd contact of the Customer of
the Job.

• Job Customer Description: the description of the Customer of the Job.

• Job Customer E-mail 1, 2, 3: the e-mail address of the 1st, 2nd and 3rd contact of the Customer
of the Job.

• Job Customer ID and Job Customer Name: the ID and name of the Customer of the Job.

• Job Customer Info 1, 2, 3, 4, 5: the 1st etc.. info of the Customer of the Job.

• Job Description: the description of the Job.

• Job Due Date: the due date of the Job (YYYYMMDD).

• Job Due Time: the due time of the Job (HHMMSS).

• Job File Format: the file format of the Job (standard format is Esko normalized PDF).

• Job ID and Job Name: the ID and name of the Job.

• Job Temp URL: the URL of the "temp" sub folder of the Job Folder.

• Job URL: the URL of the Job's Job Folder.

• Layer Name: the name(s) of the layer(s).

• Layer Names: the names of the layers used in this sheet (page imposition workflows).

• Layer Number: the number(s) of the layer(s).

• Local Server: the name of the server where the task runs.

• Mark Height and Mark Width: height and width of the current mark.

• Master Server: name of the Automation Engine master server. This is the one that runs the "task
manager".

• Media Box Height and Media Box Width: the height and width (mm) of the Media Box of the
first page of the input file.

• Name (without extension) of originating Input of (enclosing) Workflow: the name of the first
input of the (enclosing) workflow.

• Name of first Input of Master Workflow: the name of the first input of the (most outer) workflow.

• Name of Folder of Job: the name of the Job Folder.

• Name of Folder of originating Input of (enclosing) Workflow: the name of the folder of the first
input of the (enclosing) Workflow.

• Name of originating Input of (enclosing) Workflow: the name of the first input of the (enclosing)
Workflow.

• n-th Input File: the index number of the input file (the how many'th it is).

• Number of Pages: the number of pages of the input file.

• Number of Pages (RunList): the number of pages in the RunList.

• Operator: the Automation Engine user that launched the task.
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• Order ID: the Order ID of the Job.

• Padded Page Label: the page label padded with zeros (extra zeros in front).

• Padded Page Number: the page number padded with zeros (extra zeros in front). Only used in
the Split Pages task.

• Page Label: the label of the page. Only used in the Split Pages task.

• Page Height: and Page Width: the vertical and horizontal trim size of the page.

• Page Number: the page number (starting from 1) or page range if the 'One Ups' contain more
than one page.

• Page Numbers: a range of page numbers. For example: 1-5,7,9-11  .

• Page Range: the range of imposed pages available in the output file (ImposeProof only).

• Paper Height and Paper Width: the vertical and horizontal size of the paper (page workflows).

• Plate Height and Plate Width: the vertical and horizontal size of the plate (page workflows).

• Plate Template Name: the name of the plate template (page workflows).

• Press: the name of the press as defined in the JDF file (Device/@FriendlyName or Device/
@DeviceID).

• Print Group Name: the name of the print group (collection of sheets) or sheet. This is used in
(Black & White) page workflows.

• Product Customer Description, Product Customer ID and Product Customer Name: the
description, ID and name of the customer for that Product.

• Product Custom Field 1, 2, 3: the custom field 1, 2 and 3 of the Product.

• Product Description, Product ID and Product Name: the description, ID and name of the
Product.

• Product Ordered Copies: the amount of ordered copies that were ordered of this Product Part
in this Job.

• Product Part Custom Field 1, 2, 3: the custom field 1, 2 and 3 for the Product Part.

• Product Part Data Zone: the URL of the Data Zone of the Product Part.

• Product Part Name: the name of the Product Part.

• Product Part Status: the status of the Product Part (the Esko system name).

• Project ID: the Project ID of the Job.

• RunList Name and RunList Number: the name of the RunList and its number in the imposition.

• Section Number: the number of the section, starting from 1 (this is related to Marks).

• Server: the name of Automation Engine's (Master) Server.

• Sheet Colors and Sheet Colors Mode: the number of colors in the sheet and their color mode
('Black&White' or 'Full'), as found in the JDF file (page workflows).

• Sheet Descriptive Name: a short description of the sheet as defined in the JDF file
(StrippingParams/@DescriptiveName), used in page workflows.
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• Sheet Index: the index of the sheet (starting from 0), used in page workflows.

• Sheet Name (scope 'Stripping'): the name of the sheet as defined in the JDF file (StrippingParams/
@SheetName), used in page workflows.

• Sheet Name (scope 'Plate Information'): the name of the sheet, used in page workflows.

• Sheet Number: the number of the sheet (starting from 1), used in page workflows.

• Sheet Side: the side of the sheet: Front or Back (used in page workflows).

• Sheet Side Smart ID: the Smart ID of the sheet side (unique identification number).

• Short Task ID and Short Workflow Task ID: the short version of the task ID number and the
(most outer) workflow task ID number. For example: '5439'.

• Signature Name: the name of the signature as defined in the JDF file (StrippingParams/
@SignatureName), used in page workflows.

• Smart ID: the Smart ID of the file (unique identification number based on last modification dates
of the file and all its references).

• Stripping Part Number: Stripping part number as defined in the JDF file, used in page workflows.

• Sub Order ID: the sub order ID of the Job.

• System Defined: this is used when outputting .imp files (page impositions). It is a combination
of the imp name, sheet number, sheet side and layer name.

• Task ID: the ID of the task in Automation Engine, the long version. For example:
'afbdf6ac-8d82-4eee-af4d-b2408041640f'.

• Task Name: the Esko system name of the task (workflow) ticket. For example the Add
SmartMarks task is called "batchbrix.smartmarks".

• Task Owner E-mail: the e-mail address of the owner of the task.

• Ticket Name: the name of the ticket of the task (the name you gave the ticket).

• Time: the current time (when the SmartName is calculated), formatted HHMMSS.

• Trim Box Height and Trim Box Width: Height and width of the Trim Box (mm) of the first page
of the input file.

• URL of first Input of Master Workflow: the URL of the first input file of the (most outer) workflow.

• URL of Folder of Input: the URL of the folder of the input file.

• URL of Folder of originating Input of (enclosing) workflow: the URL of the folder of the first
input of the (enclosing) workflow.

• URL of Input: the URL of the input file.

• URL of originating input of (enclosing) workflow: the URL of the first input of the (enclosing)
workflow.

• Variant Name and Variant Number: the name(s) and number(s) of the variant(s) (used in page
imposition workflows).

• Web (scope 'Imposition'): this is the index of the web in the print group (used in page workflows).
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• Web (scope 'Plate Information'): this is the number of the web (for multi-web printing in page
workflows).

• Workflow Task ID: the ID of the (most outer) workflow task.

• Work Method: the working method for 'backing up' Back to Front (page workflows).

• Work Style: the name of the work style defined in the JDF file (StrippingParams/@WorkStyle).

5.3.2 Creating System Value SmartNames

As we introduced in SmartName Types (Overview) on page 923, a System SmartName is a query
to one of Automation Engine's own databases. Think of it as a question to Automation Engine.

As you can see in Default System SmartNames on page 939, there are already a lot Default System
SmartNames. Still, there are still some cases where it makes sense to create your own extra System
Value SmartNames.

Concept

When creating your own System Value SmartName, your question can be one of these 3:

• "Give me the Job URL, the full network path to the Job's Job Folder"
• "Give me the Product Part URL, the full network path to the Product Part file"
• "Give me the Product Part Data Zone URL, the full network path to the Product Part Data Zone"

These questions usually come up in these 2 cases:

• when you receive a file and you want to store it in a Job or Product related folder
• when you want to get a file from (under) those places.

In both cases, you need to add 1 or more parameters in your question that you do know. For example:
"Where is the Job Folder if I tell you that the Order ID is 12345 and the Customer ID is 67888 ?"

Note:  In a perfect world, you have a perfect data structure that is very logic and it never changes.
Then you would maybe not have these questions. However, it can for example happen that your data
Containers fill up and you may not be sure on which one the Job Folder was created. Or the files
that you receive need more analysis to interpret where they belong to.

Creating a System Value SmartName - Generic Steps

We here only show the basic generic steps to create such a SmartName. See further for 3 specific
examples.

1. In the SmartNames View, click on 

2. Choose the Type 'System Value'.

3. Choose a Scope. If you are not sure, choose Global. Learn more about SmartName Scopes on
page 926.

4. Which System Value: choose the type you are you are looking for.
A list of attributes will appear. These will help to find what you want.

5. Check the attribute(s) that you do know, one could be enough.

6. Enter the value of each checked attribute. This will probably also be a SmartName.
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You obviously need to prepare these SmartName(s) first.

7. Check the Result value already shown below left. This will only be possible when you are in
SmartNames View and are using the Resolve all using tool. Read more about these in Test your
SmartNames with 'Resolve All Using' on page 933.

8. Click Save as... to save your SmartName.

Example of Looking for the Job URL

Example: Finding the Job URL by using the name of an incoming design file

• You have created a Job '1237' and you are waiting for the customers design file.
• You receive a design file via E-mail or FTP. Your customer does not know what Job name you

already created. The name of the design file is '78999_Banana.pdf'. This name starts with how
the customer names this job/design: the Customer 's Job Reference, followed by a free name
reflecting the design variant (here the banana flavor).

• The setup of your Job '1237' also includes this Customer 's Job reference '78999' (this
information came in earlier via your business system).

• You created a SmartName 'EXA FILE_ALLBEFORE_', a String Extract SmartName that extracts
from a file name all characters before the '_' . Read more about such SmartNames in String Extract
SmartNames on page 948.

• Your System Value SmartName SmartName now needs the settings as in this screen shot:

• Save your SmartName with a logical name. For example 'Find Job via Cust Ref Nrs in
Design File'.

Example of Looking for the Product Part URL

Example: Finding the full Product Part URL by asking the Product ID

• Your business system sends you an XML with a list of product items on which you need to launch
a workflow.

• Business systems often do not know the details of your prepress data structure. The XML
mentions the Product ID but does not know the full file URL to that Product Part. So you need
to find out that URL.

• For example, we look for the full URL of the Product ID '12345'. What the business system does
not know is the folder and the name of the PDF. The PDF name is 'tomato_juice.pdf', it has
no reference to the Product ID.
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• You first need to create a SmartName that extracts the Product ID from the XML. See this
example:

Learn more about extracting values from an XML file in Xpath Query SmartNames on page 953.

• Your System Value SmartName then uses that Xpath Query SmartName:
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See (below left) how the Result shows the complete URL to the PDF. This is what we were looking
for.

• Save your SmartName with a logical name. For example 'Find ProdPart URL via Prod
ID in XML file'.

Example of Looking for the Product Part Data Zone URL

Example: Finding the Product Part Data Zone URL by using the name of an
incoming design file

• You have a workflow where you business system creates new Products on your Automation
Engine, even before the design file has arrived.

• One of those is the Product '6662712_Yolo_Juice' that is waiting for its design (and has no
thumbnail display yet). The number before the underscore is the product ID.

• You have a Folder Access Point (or E-mail or FTP or WebCenter) that you scan for incoming
designs.

• When a design comes in, you first want to copy it to the right destination: to its Product Part
Data Zone.

• You need a System Value SmartName as in this screen shot:

• Save your SmartName with a logical name. For example 'Find ProdPart DataZone URL via
ProdID in Design File'.

• Your Copy or Move File ticket now uses this SmartName:
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• You probably want to continue your workflow with the Manage Product Status task to change
the status of this Product Part to 'Design File Arrived'.

5.4 String Extract SmartNames

When automating your workflow, you will quickly feel the need to extract a part of a file name or a
network path. String Extract SmartNames offer to do just this.

Note:  A String is a series of characters. These can be numbers, text or even symbols.

5.4.1 Creating a String Extract SmartName

To create a String Extract SmartName, follow these steps:

1. In SmartNames View, click on .
2. Choose the Type 'String Extract'.
3. Choose a Scope. If you are not sure, choose Global. Learn more about SmartName Scopes on

page 926.
4. In Extract part of..., decide from what you will extract something. In the canvas, you can

• type. This is mostly done to test your SmartName while creating it (you see the result below left)
• insert SmartNames. This is the most typical use, for example to extract parts of a [File]

or a [File URL].

• right-click and choose an option: Cut, Copy, Paste, Clear Contents or Insert SmartName.
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5. Define what you want to extract. Choose from these 3 methods:

• Start from character. Learn more in Start From Character on page 949.

• Use separation character. Learn more in Use Separation Character on page 950.

• Use regular expression. A "Regular Expression" is a standard language in computer science.
It enables very specific ways to extract parts of a string. Learn more in Using Regular
Expressions  on page 978.

Caution:  Results can vary if your input string is considered as a text or as a number! This
is decided in the Formatting Options. The default is that your string is assumed to be
text. Learn more about this in Formatting SmartNames  on page 972.

Note:  The Result will update itself only after you changed a setting or clicked somewhere in a
different field. Tip: press the 'Tab' button to make sure that the Result is re-calculated.

6. Click Save to save your SmartName and close the dialog. Click Save As... to save your
SmartName but keep the dialog open (to create more SmartNames).

Start From Character

This method allows to decide the start and end character that you extract. Some examples:
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Example 1: "First 5"

Your input string is '874095620banana' and you want to extract the first 5 characters.

Choose Start from character. For Start from Character choose '1' and for Number of Characters
choose '5'. This will result in '87409'.

Note:  This method is mostly used to extract the first characters of a file name. To extract the last
part of a file name, you need to use Regular Expressions. Learn more in Using Regular Expressions
on page 978.

Example 2: "All except the first 3"

Your input string is '8740956202537435'. You want to extract all of the characters except the first 3.

Choose Start from character. For Start from Character choose '4' and for Number of Characters
leave the default setting to '999'. This will result in '0956202537435'.

Use Separation Character

This method allows to separate the string into parts every time a certain Separation Character
occurs, and extract one of the parts.

You can choose a Separation Character from the list but you can also type in a different one.

The String Part is where you choose which part of the string you want to extract.

Example 1: "Everything before the (first) underscore"

Your input string is '12345_678901' and you want to extract everything before the underscore '_'.

Choose Separation Character '_' and set the String Part to '1'.

This will result in '12345'.

Example 2: "The 3rd part"

Your input string is '87409_5620_27_923' and you want to extract the number '27' which is the
3rd part of the string (if you separate it with the '_').

Choose Separation Character '_' and set the String Part to '3'.

This will result in '27'.

Note:  If you want the part after the last '_', then this is not possible using the Use separation
character. To do that, you need to use the method 'Use regular expression'. Learn more in Using
Regular Expressions  on page 978 .
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Example 3: "Everything after the '@' "

Your input string is 'Franky.Fruit@FruitCo.com' and you want to extract everything after the '@'.

In Separation Character, type in '@' and set the String Part to '2'.

This will result in 'FruitCo.com'.

Use Regular Expression (link)

Regular expressions are not only available in String Extract SmartNames. There are documented
in Using Regular Expressions  on page 978.

5.5 CSV Text Extract SmartNames

A CSV Text Extract SmartName allows you to create a SmartName that finds a value in a specific
field of a CSV file. We will first illustrate the generic steps to create such a SmartName and then
show a concrete example.

Note:  Although the name of this SmartName type contains the word 'text', the value that is extracted
can also be a number or any other character type.

5.5.1 Creating a CSV Text Extract SmartName

To create a CSV Text Extract SmartName, follow these steps:

1. In SmartNames View, click on .
2. Choose the Type 'CSV Text Extract'.
3. Choose a Scope. If you are not sure, choose Global. Learn more about SmartName Scopes on

page 926.
4. Define where your CSV can be found and set some options:

• CSV Source: Define the path and name of the CSV file. You typically use SmartNames here.

• Text Encoding: Indicate the Text Encoding of the CSV file. The default encoding is Unicode
UTF-8.

• Field Separator: Indicate which character is used to separate the fields in the CSV. If you're
not sure, open your CSV in a simple text editor.

• Quote Character: Indicate if the value in the CSV contains quotes that you do not want to
keep. For example: in the CSV a value is written as "25000" but you want to extract only
the 25000.

• Ignore line breaks: Check this option if the CSV only contains one record (column).

• Ignore first line: Check this option if the first line of the CSV contains the names of the
columns. Use Select Field... to preview the effect of this.
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5. Define which specific field in the CSV you want to extract.

• Type the number of the field and line in Extract text from field ... on line ....

• or click on Select Field... to get a preview of your CSV file and there click the field you want
to extract. The field and line number will then be entered automatically.

Note:  A preview of your CSV file will only appear if the field CSV Source can already find
your CSV input file.

6. Check the result in Result.
7. If needed, set any Formatting Options. Learn more in Formatting SmartNames  on page 972.
8. Click Save to save your SmartName and close the dialog. Click Save As... to save your

SmartName but keep the dialog open (to create more SmartNames).

5.5.2 Example

• You are working with the Products tool and have set up some integration with your business
system. You have set up a workflow where your Jobs are created automatically.

• You also get (from another system) a CSV file with the ordered copies (amount) that a Product
is to be produced in that Job context. The CSV is written in the Job Folder, in a sub folder CSV
and with a specific name. The screen shot shows how the CSV Text Extract SmartName can
be set up:
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• This SmartName [Find Amount in local CSV] can now be used in your automated workflow
where you use the Link Product to Job task.

5.6 Xpath Query SmartNames

As mentioned in SmartName Types (Overview) on page 923, Xpath Query SmartNames use
"XPath queries" to extract a value from an XML file. XPath, the XML Path Language, is a standard
query language for selecting nodes from an XML.

In Automation Engine, there are many tasks that can read parts of an XML, often without the need
to create a SmartName first.

Tip:  Many of these tasks and tools are described in the chapter Integrating with External Systems
on page 1228.

To help you build such XPath queries, Esko offers the The XPath Builder  on page 954. This tool
is available throughout Automation Engine, wherever you can create XPath queries.

5.6.1 Creating an Xpath Query SmartName

To create an Xpath Query SmartName, follow these steps:

1. In SmartNames View, click on .
2. Choose the Type 'Xpath Query'.
3. Choose a Scope. If you are not sure, choose Global. Learn more about SmartName Scopes on

page 926.
4. The large canvas is where you define your Xpath Expression. Initially, there is an example

expression about 'vsize'. It will be removed automatically when you have used the Edit button
and created your own. In this canvas, you can

• type an Xpath Expression (if you know how to do this).
• click on Edit to open the XPath Builder and create your expression there. Learn more in The

XPath Builder  on page 954.
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• click on Insert SmartName to insert SmartName(s) into your Xpath Expression. This is in
most cases not needed.

• right-click and choose an option: Cut, Copy, Paste, Clear Contents or Insert SmartName.

5. Separator: If the XPath Expression returns multiple elements, decide what character you want
to use as separator.

6. XML Source: Define the path and name of the XML. Or keep the default SmartName [URL of
Input].

7. Result: See the result of your XPath Expression. This is possible when the XML Source can be
found. The Result is also visible when you are in SmartNames View and are using the Resolve
all using tool and have manually selected an example XML. Read more about this in Test your
SmartNames with 'Resolve All Using' on page 933.

8. Formatting Options: Learn more in Formatting SmartNames  on page 972.
9. Click Save to save your SmartName and close the dialog. Click Save As... to save your

SmartName but keep the dialog open (to create more SmartNames).

5.6.2 The XPath Builder

Introduction

XPath is a language that describes how to locate elements and attributes in XML (Extensible Markup
Language) files. You can find a full specification on  http://www.w3.org/TR/xpath/  and a tutorial
on http://www.w3schools.com/xpath/.

Think of an Xpath Query SmartName as a String Extract SmartName but then to get a string from
an XML file.

http://www.w3.org/TR/xpath/
http://www.w3schools.com/xpath/
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The XPath Builder is an XML editor available in the Automation Engine Pilot. Anywhere in the
Automation Engine where there is an XPath Expression, you can access the XPath Builder by
clicking Edit.

The XPath Builder panel

• On top of the panel, you see the resulting XPath Expression that is probably a result of what
you have clicked below.

• The large canvas shows the Example XML Content.

• When possible, the example XML is automatically taken from the context. For example when
you open the XPath builder from the XPath Query SmartName dialog, then the input file is
used as an example XML.

• When no example XML is available automatically, right-click in the canvas to see these extra
ways to get and manage XML content: Cut, Copy, Paste, Clear and Paste from File....

• Use CTRL-F (Windows) or CMD-F (Mac) to open a Find tool. This is very handy when your
XML is a large file and you quickly want to find the string you want to select.

Note:  This area has XML syntax highlighting: specific colors indicate a specific kind of node.

• On the right you have tools that help you create the Xpath Expression by offering smart selections
and even help you edit the XML content.
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Building XPath Expressions

Select XML node

To build an XPath Expression, make sure that the Select XML Node button is clicked.

Simply click on an XML node to automatically create an XPath to that node. The resulting XPath is
shown in the XPath Expression field at the top.

Note:

• The created XPath will be an "absolute XPath" from the root node to the selected node.
• The selected node will be highlighted in yellow.
• When the selected node is used in a list, an index number will be used in the XPath. For example:

/PurchaseOrders/PurchaseOrder[1]/Address[2]/Street/text().

• The generated XPath takes namespaces into account by using the local-
name function. For example:  /*[local-name()='PurchaseOrder'][@*[local-
name()='PurchaseOrderNumber']='99503']/*[local-name()='Address']
[@*[local-name()='Type']='Billing']/*[local-name()='Street']/text()

Note:  By selecting Enforce namespaces, the XPath Builder will verify any used namespace.

Add Condition

To add certain conditions to the XPath, click Add Condition. Then click on the desired XML node
to add it as a 'predicate' to the XPath Expression.

Note:

• You can also add a condition by clicking on the desired XML node while holding the Alt key.
• The predicate nodes are highlighted in green.
• When using predicate nodes, the indices in the XPath are replaced with predicates.

For example: /PurchaseOrders/PurchaseOrder[@PurchaseOrderNumber='99503']/
Address[@Type='Billing']/Street/text()).

• When using predicates, it is possible that the XPath Expression selects multiple XML nodes. The
number of matches is displayed beneath the XPath Expression.
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Options

• Select siblings. Select this option to select all occurrences of the selected element at this level.

Tip:  This option is especially relevant when working with 'repeating content' in the Map data task.
You there need to Select siblings to avoid that only the first element would be repeated (you
would so get a list of only 1).

• Enforce namespaces. Select this option to enforce XML namespaces ('xmlns').

Tip:  XML namespaces provide a method to avoid element name conflicts. In XML, element
names are defined by the developer. This often results in a conflict when trying to mix XML files
from different XML applications.

• Use prefixes. Check this option if you want to use XML namespaces in your Xpath Expression
in a shorter way.

Note:  This option overrules the option Enforce namespaces.

Tip:  This option is especially useful when querying XMP.
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Editing Example XML Content

Format XML

Under Example XML Content, click on Format XML to format the example XML. This can be used
to make the XML more readable. It will typically remove unnecessary spaces and lines.

Edit XML

To edit the example XML, follow these steps:

1. Under Example XML Content, click on Edit XML.

Note:  This will make the XML content editable. Also, the buttons Revert and Apply will become
visible.

2. Edit the XML in any way you want.
3. When finished making changes, click Apply.

Note:  The changes will be automatically validated. If the XML is not valid, an error message will
appear and the location where the parse error occurred will be visible and highlighted in a red
color.

4. Before you click Apply, you can click on Revert to undo all changes made to the XML content.

Note:  You can undo/redo the last edits using (on Windows) Ctrl-Z and Ctrl-shift-Z or (on Mac)
Command-Z and Command-Shift-Z.

Note:  If you clicked Apply but did this in error, you can still click Cancel.

Note:  It is also possible to edit the XPath Expression itself manually. When you do this, take the
following into account:

• After editing the XPath, press Enter to validate the updated XPath Expression.

• If the updated XPath Expression is not valid, an error message will be displayed beneath the
XPath Expression.

• The corresponding XML nodes will be highlighted in grey.

5.7 XMP path Query SmartNames

XMP stands for ‘eXtensible Metadata Platform’. It allows embedding data about a file, known as
metadata, into the file itself. It is a standard defined by Adobe.

Esko also uses XMP as format for metadata in its processed files (Normalized PDF, View data, LEN
and other RIP output)

Note:  A full specification of how Esko uses XMP is available as part of the Automation Engine Online
Help, Find the white paper in its section "Related Documentation".

http://help.esko.com/products/Automation%20Engine?language=en-US
http://help.esko.com/products/Automation%20Engine?language=en-US
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Because XMP is actually XML embedded in a file, you can also use SmartNames to query that
metadata. XMP path Query SmartNames are very similar to Xpath Query SmartNames. The main
difference is that the source file is not a XML but a file with embedded XMP. The way to that metadata
is also an Xpath Expression.

5.7.1 Creating an XMP path Query SmartName

When creating an XMP path Query SmartName, it is typical is that we first need to indicate our
example input file, the one that contains the example XMP.

To create an XMP path Query SmartName, follow these steps:

1. In SmartNames View, in Resolve all using, check A file and browse to your (example) file that
has the XMP metadata.

2. In SmartNames View, click on .
3. Choose the Type 'XMP path Query'.
4. Choose a Scope. If you are not sure, choose Global. Learn more about SmartName Scopes on

page 926.
5. The large canvas is where you define your Xpath Expression. Initially, there is an example

expression about 'vsize'. If 'vsize' is mentioned in the XMP of the input file you selected,
it will already return a Result value (below left). This example expression will be removed
automatically when you have used the Edit button and created your own. In this canvas, you can

• type an Xpath Expression (if you know how to do this).
• click on Edit to open the XPath Builder and create your expression there. Learn more in The

XPath Builder  on page 954.

• click on Insert SmartName to insert SmartName(s) into your Xpath Expression. This is in
most cases not needed.

• right-click and choose an option: Cut, Copy, Paste, Clear Contents or Insert SmartName.
6. Separator: If the XPath Expression returns multiple elements, decide what character you want

to use as separator.
7. Result: See the result of your XPath Expression.
8. Formatting Options: Learn more in Formatting SmartNames  on page 972.
9. Click Save to save your SmartName and close the dialog. Click Save As... to save your

SmartName but keep the dialog open (to create more SmartNames).

5.7.2 Examples

Remember the many System SmartNames on 'Size'

There are many SmartNames that you no longer need to create yourself via XMP queries. Remember
these default (system type) SmartNames with Scope Page Information that may already deliver
exactly what you were looking for:
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Learn more about them in Default System SmartNames on page 939.

What if my file does not have the XMP information I'm looking for?

For example: you want to get the 'vsize' of a native PDF. Your workflow does not create a normalized
PDF version of it (where you would automatically get that extra XMP). In that case, you can use the
LinkEdge task to create an XML containing the same XMP as you would find inside a normalized file.

The next step is then to use an Xpath Query SmartName to get that specific XMP information from
inside that XML file. Learn more on how to do this in Xpath Query SmartNames on page 953.

Which application created this file?

Most files with metadata will have a note about which application created the file. Follow these steps:

1. Follow the generic steps as explained in Creating an XMP path Query SmartName on page 959.
2. In the example XML, use CTRL-F or CMD-F to find for the string 'CreatorTool'.
3. Select the node. For example: see how the 'CreatorTool' is selected in the example below:

4. Click OK.
5. Check the Result and Save your SmartName.
6. Tip: to shorten this name, create another String Extract SmartName or a Regular Expression.

Which options were used when RIP'ing this file?
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It can be useful to see with what resolution or distortion your RIP file was made. There are tools to
quickly detect that in Automation Engine, but your remote print site may not have those tools. It can
therefore be useful to extract that value and use it in a file name or (FTP) folder name.

Follow the similar steps as in above example. See the screen shot to detect even more RIP options
in the XMP of a LEN file (made with FlexRip or Imaging Engine).

5.8 Conditional SmartNames

Conditional SmartNames base their value on one or more conditions. The condition can be very
basic or can be built up of several criteria and sub criteria. You can also define the order in which
the conditions need to be met.

After documenting how to create a Conditional SmartName, we illustrate their power with some
examples.

5.8.1 Creating a Conditional SmartName (generic)

To create a Conditional SmartName, follow these steps:

1. In SmartNames View, click on .
2. Choose the Type 'Conditional'.
3. Choose a Scope. If you are not sure, choose Global. Learn more about SmartName Scopes on

page 926.
4. The dialog initially contains 2 blocks.

• A "conditional block". Each conditional block has one or more criteria and ends with the
Return value for that block.
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• You can create extra conditional blocks using the buttons Add / Remove (Windows) or  +
-  (Mac).

• You can also right-click in the line If xxx of the following are true: and Duplicate that
block. Use the functions Move Up / Down or drag and drop the blocks to define their order.

• The order of the blocks is the order that they will be checked, from top to bottom.

• Read more detail in Setting up a Conditional Block on page 962.

• An "alternative block". When none of the above conditions match, this is what the
SmartName's return value will be. Type in the value (or use another SmartName).

5. Check the result in Result.
6. If needed, set any Formatting Options. Learn more in Formatting SmartNames  on page 972.
7. Click Save to save your SmartName and close the dialog. Click Save As... to save your

SmartName but keep the dialog open (to create more SmartNames).

5.8.2 Setting up a Conditional Block

To set up a conditional block, follow these steps:

• If All - Any - None of the following are true. Choose the relation between the condition and
your (one or more) criteria.

• Per criterion, you need to
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• select the attribute from the drop down. Choose between the SmartName File or any Other
SmartName.

• select the text or number expression from the drop down list. You can choose any of the
following expressions from the drop down, depending on whether it is a text or numeric
condition:

• For a text criterion, choose from the following expressions:

• Contains, begins with, ends with, is and is empty.

Use ' ' (space) for 'AND' and ';' for 'OR'. For example, a text criterion specifying:

• " 'Inkname' contains 'Pantone C' ": this will resolve all ink names that contain
'Pantone' and all that contain 'C'.

• " 'Inkname' is 'C; M; Y; K;' ": this will resolve the ink names that are specifically
any of these.

• Use double quotes to specify the exact text corresponding to the attribute. For
example: " Inkname contains "reflex blue" ": this will only resolve for "reflex
blue".

• For a number criterion, choose from the following expressions: equals, is greater than,
is less than, and is between. Some important notes:

• If the attribute does not correspond to a number, it will be ignored.
• You can use standard unit symbols and unit conversions are done in background. For

example: if you specify "equals 5 mm" then this is not a problem when the file's XMP
is defined in in (inches).
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Note:  Unit conversions only work with units of the same kind. For example if the
specification is "equals 5 mm" then this will fail to resolve when the XMP mentions "6
ppi" or just "6".

• Note:  Number expressions will not resolve to text strings. For example: "Job Name
equals  MyJobName " will be ignored because equals is used for numbers, not text.

•

Note:  Quotes ( " ) and semicolons ( ; ) are not accepted as values in the text and number
conditions.

• Adding criteria: You can add a criterion to a condition by clicking the +.

• Adding sub criteria. When you hold Alt while clicking the +, your new criterion will be a sub-
criteria of the one above. See Examples on page 964 where we use it to exclude some attributes
that were selected in the one above.

5.8.3 Examples

Plate distortion depending on cylinder size

A Job Category is used to define size of the cylinder on which the product will be printed. This
circumference has an effect on the distortion that is required for the plate. A Conditional SmartName
defines the distortion setting for the RIP.
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ReportMaker Template depends on the Customer

The ReportMaker ticket uses a SmartName to select its template. A conditional SmartName checks
who the customer is.

• First we check if it is our biggest customer 'FruitCo' (ID 777).
• Then we check if it is any customer of the group 'SuperToy' (any of those 3 IDs).
• If it is none of the above, we use a generic template for all other customers:
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Dot Gain Compensation depending on the Press and type of flexo plates

If the press chosen for the Job is the flexo press Nilpeter, then the DGC file depends on the
category where the type of plates is defined: conventional flexo plates or digital flexo plates (CDI):

Find the French only version (using a sub criterion to exclude some attributes)

Our SmartName is looking for Jobs that are in the French language, but not in combined language
versions. See how the extra sub criterion (ALT-'+') excludes the categories that contain the Canadian
and Belgian version Jobs that combine French with another language:
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Smart preflight checking a workflow parameter 'Print Process' to check allowed
line width

Our workflow includes PitStop preflight. It is Smart Preflight because it uses SmartNames. Our
example shows how the preflight profile will check line width but have it depend on the print process
that the file will be printed in. The print process is defined as a workflow parameter.

• This is our workflow parameter: [wfp.Print Process]

• This is how we set up our conditional SmartName (3 print processes each get a condition on
line width (mm)):
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• This is how our SmartName is used inside the PitStop Profile (there named 'variable'):

5.9 Database Query SmartNames

5.9.1 Concept

Database Query SmartNames ask a question to an external database. They pick up information
from other systems, typically business systems (planning, production...). They only ask information,
they do not write information into that external system.
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Note:  Database Query SmartNames may not be used to pick up information from a database from
Automation Engine itself. For such use cases, you use the System (Value) SmartNames. Learn more
in System (Value) SmartNames on page 939.

Some typical examples when you use Database Query SmartNames:

• In the Tabular Step & Repeat task. You can fill its many fields with Database Query SmartNames
and so pick up all the required values. Narrow-web label printers often use this and base their
queries on press type and die-shape.

• As a RIP option that you pick up from an external system. For example your business system
that created your Job may have informed you about main production decisions like the press, the
amount of plates and their size. But the distortion factor may need to be picked up from another
external system closer to the press room. In that case, you use a Database Query SmartName
in your RIP's setting for distortion.

How do Database Query SmartNames compare to the other tools that access
databases?

• A Database Access Point also does a database query but its other main feature is that it triggers
a workflow, and maybe you do not want that to happen at the moment you pick the information.

• The Interact with Database task can read and write into external databases and can be used
as any step of a workflow. But it does not return you the values immediately, you get them
in a separate XML file from where you need to pick them up again (then via Xpath Query
SmartNames).

Note:  In cases where that XML is already available, it is advised to use the information from the
XML. For example: the XML that was used to create the Job, is stored in the Job Folder and it
also contains all the Step & Repeat information. In that case it is advised to pick up that Step &
Repeat info locally instead of asking it again to an external system (which always means network
traffic and small delays).

Basically, Database Query SmartNames is the preferred tool when you only want to pick up a value
and when an extra return-XML has no added value.

5.9.2 Creating a Database Query SmartName

First set up the link to that external database

Setting up a link to an external database is done in  Tools > Configure > External Databases .
Learn more on this in Configuring links to External Databases.

Now create the Database Query SmartName

To create a Database Query SmartName, follow these steps:

1. In SmartNames View, click on .
2. Choose the Type 'Database Query'.
3. Choose a Scope. If you are not sure, choose Global. Learn more in SmartName Scopes on page

926.
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4. Choose the External Database from the drop down list. If you need to create, change or test the
link to an external database, click Configure.

5. Write your SQL Command in the canvas. You can Insert SmartNames into your command.

Note:  Esko does not provide training in SQL commands. Contact your own IT database specialist
to help set these up.

6. Check the Result. The result will be (re-)calculated when you click any option outside the canvas.
7. If needed, set any Formatting Options. Learn more in Formatting SmartNames  on page 972.
8. Click Save to save your SmartName and close the dialog. Click Save As... to save your

SmartName but keep the dialog open (to create more SmartNames).

Learn more about integrating with external databases

Learn more about using SQL commands in the chapter Integrating with External Systems on page
1228, in the sections

• Database Access Point on page 1245

• Interact with Database task on page 1274

• An elaborate example.

5.10 Script SmartNames

Script SmartNames use JavaScript to get a value. Typically, other SmartNames are inserted into
the script.

JavaScript is a standard scripting language. Learn more on http://en.wikipedia.org/wiki/
JavaScript_syntax or on http://www.w3schools.com/js/js_syntax.asp.

Attention:  Before you create a Script SmartName, check if it can be built using standard
tools as

• a Conditional SmartName

• a Regular Expression (in a String Extract SmartName).

http://en.wikipedia.org/wiki/JavaScript_syntax
http://en.wikipedia.org/wiki/JavaScript_syntax
http://www.w3schools.com/js/js_syntax.asp
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5.10.1 Creating a Script SmartName

To create a Script SmartName, follow these steps:

1. In SmartNames View, click on .
2. Choose the Type 'Script'.
3. Choose a Scope. If you are not sure, choose Global. Learn more in SmartName Scopes on page

926.
4. The canvas initially shows a JavaScript template that returns the value "hello".

Attention:  This template is important. The script needs to be a function returning a value
that is called from the body of the script. Learn more in this Esko KB article.

Replace it with your own JavaScript. You will probably Insert SmartNames into your script. See
some examples in Examples on page 971.

5. Check the result in Result. The result will be (re-)calculated when you click any option outside
the canvas.

6. If needed, set any Formatting Options. Learn more in Formatting SmartNames  on page 972.
7. Click Save to save your SmartName and close the dialog. Click Save As... to save your

SmartName but keep the dialog open (to create more SmartNames).

5.10.2 Examples

The following examples are just a few basic samples of what a JavaScript can do. If you need help,
Esko has specialists available through Esko Solution Services (Not Esko Customer Service).

Calculating: Multiply

This JavaScript multiplies the values of 3 Job Parameters (number SmartNames):

https://wiki.esko.com/display/KBA/KB87952322%3A+Automation+Engine+-+What+is+the+correct+way+to+format+SmartNames+of+the+type+Script+in+Automation+Engine
mailto:solutionservices@esko.com


5
Automation Engine

972

Extracting a few lines from a text:

This JavaScript returns the first 2 lines of a SmartName, in this case the Job Description:

5.11 Formatting SmartNames

A lot of data that end up in SmartNames can come from external systems. And a lot of information
that you send back out to external systems may also be decided by SmartNames. These systems
can store their information in a different language, in a different regional format or even a specific
custom format. That is why it may be needed to change the format of a SmartName.

The formatting options are different whether your data is a Text, a Number or a Date or Time.

Note:  A data string that contains both numbers and text characters is seen as Text. For example:
789_87_banana is Text.

The option Formatting Options... is available when you create any SmartName.

5.11.1 Text Formatting

When, in Formatting Options..., you select the Data Format 'Text', you get the following options:



5
Automation Engine

973

• Remove leading and trailing spaces: If your SmartName value includes space characters at the
beginning or end, use this option to remove those spaces.

• Text Case:

• Keep the original case of the SmartName value.
• change the text case using Make Upper Case or Make Lower Case.

• Specify any special Encoding of the SmartName value. Choose

• None to leave it like it is.
• XML Encoding. If your SmartName output will be used inside an XML file, your value can

contain a character that has a special meaning in XML (a 'reserved character'), then this
encoding will replace that character by a by an XML entity reference. For example '10<20' will
be formatted to '10&lt;20'.

• URL Encoding. Similar to the above, this will replace the reserved characters for URLs with the
typical 'percent encoding'. For example 'Digital Flexo' will be formatted to 'Digital%20Flexo'.

• Custom Encoding: Use it to define custom replacements of characters or strings. Click Edit
and add one or more lines of rules. The rules will be executed from top to bottom. For example:

• First all ' ' (spaces) will be replaced by a Dollar sign
• then all '@' will be replaced by 'at'
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• then all words 'Limited' will be replaced by 'Ltd.'

The Result will update after a new setting as soon as you click in a different field.

5.11.2 Number Formatting

When, in Formatting Options..., you select the Data Format 'Number', you get the following
options:

First check or define the Input Format Options.

Why first? Because this might already have an effect on the Result that you will be checking when
you start the actual (output) formatting options.

The Input Format Options allow you to inform Automation Engine how your input is constructed,
how it should be interpreted.

For example: Your input is '123456,789' and you want to indicate now that your Decimal Separator
is the ' , ' (comma) and that there is no Thousands Separator (None). You will already see a change
in the Result.

(Output) Formatting Options

Now define how you want this Result formatted.

Note:  If the Result is already what you want, this means that the default settings in the Formatting
Options panel may already be the ones you want.
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• Decimals: Indicate how many decimals you want. Select Auto to keep the number of decimals like
it was in the original value of the SmartName. See in above screen shot how the setting 'decimals:
2' takes one decimal away and rounds the number to '79'. Another example is to round values
with too detailed numbers like '67,5000000000 to shorter ones like '67,5' (one decimal left).

• Decimal Separator: Select the type you want. In above screen shot we confirm that the comma
is the one we want (to keep).

• Thousands Separator: Select the type you want. See in above screen shot how it adds the point
in between '3' and '4'.

Note:  The decimal and thousands separators cannot be identical.

• You can choose to Add leading zeros to the value of the SmartName to get a certain number of
Needed Digits. If the value of the SmartName has less digits in the integer part than the specified
number of needed digits, leading zeros will be added until the number of needed digits is reached.
For example, if the number of needed digits is 5, "123" becomes "00123".

• You can choose to Convert the value of the SmartName to another unit.

• Length. Choose, in both directions, from Millimeters, Centimeters, Decimeters, Meters,
Inches, Mils and Points

• Angle. Choose, in both directions, from Radians and Degrees.

• File Size. Choose, in both directions, from Bytes, Kilobytes, Megabytes, Gigabytes and
Terabytes.

• Resolution. Choose, in both directions, from Pixels per Inch, Pixels per Millimeter, Pixels
per Centimeter, Lines per Inch, Lines per Millimeter and Lines per Centimeter.

• Time. Choose, in both directions, from Milliseconds, Seconds, Minutes, Hours, Days and
Weeks.

5.11.3 Date and Time Formatting

When, in Formatting Options..., you select the Data Format 'Date and Time'.

It is very important that you first check or define the Input Format Options....

Input Format Options

Date and Time descriptions appear in many different formats. Before a SmartName value can be re-
formatted, it will be required to first explain Automation Engine how your input value is constructed.
This is what you do in Input Format Options.
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Format: ISO 8601

Select this when your input date and time is in this standard format. This will be the case
when the date was constructed by Automation Engine. For example: your input data is
'2014-09-27T16:30:00.00+02:00' (September 27 2014, 4:30 PM in the time zone UTC+2).

Format: Unix Time (in milliseconds)

Select this when your input date and time is in this standard format. Unix time is used widely between
computers, it is the amount of seconds that have passed since 1 January 1970. For example:
'1410532200000' (milliseconds).

Format: Custom

Select this when your input date and time is in any other format than the 2 above mentioned
standards.

• Language: the language that you select here affects the list of default custom date and time
formats in the Custom Format drop-down list.

• Custom Format: indicate here how your custom input is constructed. You can specify the custom
format using the following notation: E = name of day of week, d = day of month, M = month, y
= year, h/H = 12/24 hour, m = minute, s = second, a = AM/PM, z = time zone. Learn more in this
Example on page 977.

• Time Zone: If you want, you can select the Time Zone of the original value of the SmartName.

Output Formatting Options

Once your input format is well understood by Automation Engine, you define the output Formatting
Options.

You here have the same options as in Input Format Options on page 975.
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Note:  If your Date and Time serves a field in any Automation Engine database, it needs to be
formatted according ISO 8601.

Example

You have a workflow where your MIS sends you an XML every time a new Job has to be created on
Automation Engine (see an example of such workflows in  Examples of integrating with an external
system).

The XML from the MIS mentions the Job's Due Date but has its own particular way of mentioning
the date and time. We will need to reformat it to the standard ISO 8601 (that Automation Engine
requires in this example).

Follow these steps to get the result as shown in the screen shot:
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• In the setup of the SmartName, you see our input value 'Wednesday, October 1 2014, 3:35
AM'. Normally this date would in this canvas not be written out like this but it would show up as
another SmartName, one that picks up that date from the XML that we mentioned earlier.

• Click Formatting Options..., do not check or change any settings there yet.
• Click Input Format Options..., Choose Custom and English.
• In Custom Format, type the string that you see in the screen shot. This is what those codes mean:

• 'EEEE': 'E' means 'day of the week. 4 times 'E' means the day is written out in full text.
• then there is a comma and a space
• 'MMMM': 'M' means 'month'. 4 times 'M' means the month written out in full (text).
• then a space followed by 'd', meaning the day of the month (number)
• then a space followed by 'y', meaning the year, in (full) number
• then again a comma and a space
• then 'h:mm', meaning the hour (in 12 hour system), followed by a colon, followed by the minutes
• then a space and 'a', meaning 'AM'.

• Indicate that this time is one from the New York time zone.
• Click OK to confirm and close the Input Format Options dialog.
• Now set the (output) Formatting Options: Choose the ISO 8601 format  and choose the same

New York time zone
• Check the Result: you should see a ISO 8601 format of the custom description that we received.
• Save the SmartName with a logical name.
• This SmartName (date) is one that we can now use in the Create Job task, for the Job Due date.

5.12 Using Regular Expressions

Regular Expressions are text patterns that are used to match strings. They can contain a mix of plain
text and special characters to indicate what to match. Find more information about this standard
tool on Wikipedia.

In Automation Engine, they are used for special cases where SmartNames do not offer a solution.
You can use Regular Expressions in

• String Extract SmartNames
• Some tasks: the Select File, Wait for Files, ...
• Some Workflow Controls: Data Splitter, Sort and Router.

5.12.1 A Selection of Useful Characters in Regular Expressions

Character Description Example

^ Beginning of the string. ^abc will only
lead to a match if the string begins with
abc.

^C matches "Cyan" but doesn't match
"PANTONE 120 C".

http://en.wikipedia.org/wiki/Regular_expression
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Character Description Example

| OR cat|dog matches "cat" or "dog"
$ End of the string. xyz$ will only lead to

a match if the string ends with xyz.
120$ matches "PANTONE 120" but
doesn't match "PANTONE 120 C".

. The . matches any single character. ab.d matches "abcd" as well as
"ab9d" or "ab-d".

[abc] Brackets enclosing a set of characters
indicates that any of the enclosed
characters may match the target
character.

[abc] matches "a", "b" or "c" but
doesn't match "x" or "y".

[^abc] The ^ inside the brackets means that
none of the enclosed characters may
match the target character.

[^abc] matches "x" or "y" but doesn't
match "a", "b" or "c".

[a-zA-Z] The - inside the brackets is used to
show a range of characters.

[a-zA-Z] matches all upper and
lowercase characters, [0-9] matches
all digits.

\d matches a numeric character (digit)
(exactly the same as [0-9]).

\d\d matches "96" but doesn't match
"5a".

\D matches any non-numeric character
(exactly the same as [^0-9]).

\D\D matches "A+" but doesn't match
"A4".

\s matches a whitespace. \d\s matches "5 " but doesn't match
"5a".

\S matches any non-whitespace
character.

\s\S matches " 6" but doesn't match
" ".

\w matches an alphabetic (word)
character (exactly the same as [a-zA-
Z0-9]).

\w\w matches "9d" but doesn't match
"5+".

\W matches any non-alphabetic character
(exactly the same as [^a-zA-Z0-9] or [^
\w]).

\W\W matches "+ " but doesn't match
"5+".

? The ? matches the character to its left
0 or 1 times.

esk\w? matches "esk" as well as
"esko" but doesn't match "eskonv".

* The * matches the character to its left 0
or more times.

c* matches "", "c", "cccc" etcetera.
esk\w* matches "esk" as well as
"Esko".

+ The + matches the character to its left
1 or more times.

c+ matches "c", "cccc" but not "". esk
\w+ matches "esko" as well as "Esko"
but doesn't match "esk".

{n} The {n} matches the character to its left
exactly n times.

a{3} matches "aaa" but doesn't
match "aa" or "abc". ab{3}c matches
only "abbbc" .

{n,} The {n,} matches the character to its
left at least n times.

a{3,} matches "aaa" or "aaaaaa" but
doesn't match "aa" or "abc".

{n,m} The {n,m} matches the character to its
left at least n times, but no more than
m times.

a{3,5} matches "aaa", "aaaa" or
"aaaaa" but doesn't match "aa" or
"aaaaaa".

\ Escapes characters with a special
meaning. The \ can precede a special
character (like * or [ ) if you want to
search for it literally.

esko\\artwork\*nv matches "esko
\artwork*nv". \?$ matches "?" at the
end of a line.
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Some examples based on the above list

Regular Expression Matches Doesn’t Match

\d{6}-\w{5}-\d{1,3}\.pdf 312454-ESKO4-1.pdf

235682-USA12-23.pdf

31245A-ESKO4-1.pdf

312456-USA-23.pdf

PANTONE \d+ C$ PANTONE 120 C

PANTONE 15 C

PANTONE 120 U

PANTONE 15 CU

[Yy].* Yes

y

N

no

(Cyan)|(Magenta)|(Yellow) Cyan

Yellow

Black

Cyan SpotColor

5.12.2 Using Parentheses to Extract

Use ( ) in the regular expression to define what to extract

Parentheses are used to define what you want to extract (to "capture a group").

Example:

Example input string: lemon

Regular expression: le(mo)n

Output: mo

What if I want to extract multiple groups?

Automation Engine does not support this. Only the first group in the string between ( ) will be
extracted.

Example:

Example input string: lemonandmango

Regular expression: le(mo)na(nd)man(go)

Output: mo

What if the input string already contains ( ) ?

When the input string already contains a set of parentheses, you have to "escape" those characters,
by adding a \ in front of them.

Example:

Example input string: ab(cd)e We want to extract the group between the ( ) .

Regular expression: .*\((.*)\).*

In human language: something, then an open parentheses, then the group we want to extract, until
there's a closing parentheses, followed by something.
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Output: cd

5.12.3 Examples from Users

These examples came from actual users. You may find more on Esko's Knowledge Base.

Extracting the last character of a string

The SmartNames function Start From Character on page 949 makes it easy to extract the first
x characters of a string. With Regular Expressions, you can extract the last character(s). See this
example (you can change the number to extract more (last) characters):

Example input string: banana

Regular expression: .*(.{1})

Output: a

Extracting the server name from the SmartName 'Operator'

Example input string: Chantal@AESERVER01

Regular expression: (.+)@.+

Output: Chantal

Extracting the domain from an E-mail address

Example input string: michael.jackson@esko.com

Regular expression: .+@(.+)\.[a-z]+

Output: esko

Extracting the part of a file name after the last underscore

Example input string: Banana_v03_271265_p003.pdf

• with the file extension

• Regular expression: .*_(.*)

• Output: p003.pdf

• without the file extension

• Regular expression: .*_(.*)\..*

• Output: p003

Extracting the part of a file name between the 2nd and 3rd underscore

Example input string: Banana_v03_271265_p003.pdf

Regular expression: [^_]*_[^_]*_(.*?)_.*

Output: 271265

http://help.esko.com/knowledgebase
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Extracting a number from a file name

Example input string: Cosmo453_Advertisement_4.pdf

Convention in human language: something_something_number.pdf

Regular expression: .+_.+_([0-9]+).pdf

Output: 4

Defining a specific file selection - containing an 'exclude'

In the Select File task, you can use regular expressions in the input fields that end with Name
Matches: by ending your input with @regex. This creates possibilities to define very specific
selections. Some examples:

• To select all files except files where the name contains _report :

(?!.*_report).*@regex

• To select all files but exclude MAC files (starting with . ) :

!\.).*@regex

• To select all ArtPro files, but exclude the automatically generated backup file:

(?!.* BU).*\.ap@regex

Defining a specific file selection

• To select the file and the report of the file:

<file/>.pdf|<file/>_report.pdf@regex

• To select only files with specific extensions. For example only the ARD and MFG files:

.*\.ard|.*\.mfg@regex

5.13 SmartNames of Parameter Values

The chapter "SmartNames" describes the many ways how to create a SmartName that will resolve
in a string like "flexo" or "123". But how do you create a SmartName that resolves in Parameter
Values that are not a free text string? For example you want a SmartName to decide a button in the
interface that indicates to rotate 90 degrees. Or you want a SmartName to decide an internal value
that is shown in a dropdown list, for example "Any User"?

We illustrate both cases with an example:

Creating a SmartName of a User Interface Button

Some buttons in Automation Engine Tickets can be transformed into SmartNames. Follow these
steps to create such a SmartName:

1. Right-click the button and see if the option Copy Parameter Value appears. If so, click the option.



5
Automation Engine

983

For example this option is available for the Orientation buttons of the Marks that you can set in
the Add Marks to Imposition task. Notice how you can copy their Parameter Value and how the
list of buttons also offers to be decided by a SmartName.

2. Go to the dialog where you create the SmartName and right-click and Paste the Parameter Value.

In this example we create a Job Parameter (that will become available as a SmartName). We here
show the manual creation but it would normally be created automatically based on input from
an external system. In the Job Setup, we create the Job Parameter Text Mark Rotation and for
its Value we paste (Ctrl-V) the Parameter Value of the button. The screen shot shows that the
resulting value is "270".

3. Now use that SmartName in the Ticket instead of the button. Click on the SmartName icon and
select it.
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Creating a SmartName of an Automation Engine internal value

This example shows how to create a SmartName that will return the value of "Any user" (a choice
from a dropdown list):

1. Right-click the interface value and see if the option Copy Parameter Value appears. If so, click
the option.

2. Go to the dialog where you are creating the SmartName and Paste the value there. You will see
it appear as "Any User...@".

Here is an example workflow: your Jobs are created via XML files that you receive from your
business system. The XML contains the name of the Esko user that should handle this Job and
therefore should receive an item in his To-Do list (from the Wait for Action (Checkpoint) task
that is automatically started when the Job is created). The Create Job task maps that user to
the custom Job Category 5. The Wait for Action (Checkpoint) task then picks it up as the
SmartName Job Category 5.

For this to work, the business system needs to know exactly how to write the Automation Engine
User names. In our example, the business system also needs to learn how to tell Automation
Engine that the To-Do of a Job is for Any User. In that case, the business system needs to mention
in the XML that the Job is for "Any User...@", because only that value will match the dropdown
choice Any user.

This screen shot shows how the Create Job task created the correct string in the custom Job
Category named ForWhichOperator:
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And the SmartName of this Job Category is then used in the To: field of the Checkpoint task:
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6. Workflows

6.1 Workflow Basics

Automation Engine enables you to create very powerful and automated workflows. You can
customize them to do exactly what makes sense in your environment. You can make them extra
smart by using SmartNames, subworkflows, routing, integration points with external systems and
much more.

A step in a workflow is an Automation Engine Task performing an action on an input file to produce
an output file. It can be also be a Workflow Control . Workflow controls can be about deciding
which route the workflow will take or about file management (selecting, sorting etc.) or about other
administrative decisions in the workflow.

Here is an example introducing some main tools:

1. A Transition is the green line that connects each step in the workflow. It is a graphical
representation of an output file of a step being used as the input for the next step.

2. By default each step has an OK and Error Output Pin. When a step ends in the OK state, the
output file will be sent to the step connected to the OK output pin. When a step errors out the
workflow will continue with the step connected with the Error output pin. In the example workflow
above the Preflight with PitStop task has 2 extra pins, matching the possible Preflight statuses.

3. This subworkflow handles the approval process. This sub-workflow opens when you double
click it.

4. Here we used the workflow control Router.
5. See how this Router shows 3 output pins. When hovering over them with your mouse you see

their name, in this case the route to 'Off site printing'

Apart from creating your own workflows, you can also download sample workflows per market
segment. These are advanced workflows that can serve as a head-start when creating your own.
Learn more about these in Sample Workflows on page 1076.

Workflows can be started

• manually, by an Esko user,
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• using the Pilot
• using the Shuttle client tool or the Shuttle plug-in of Esko editors and Adobe Illustrator.

• automatically

• by an Access Point
• by an external system that was integrated with Automation Engine. This could be WebCenter

or any non-Esko system.

Note:  Learn more about Access Points and integrations in Integrating with External Systems on
page 1228.

6.2 Building Workflows using the Workflow Editor

You can open the workflow editor from the Pilot using  (from the Tickets view) or  (from
the Files view).

6.2.1 The Workflow Editor Window

The workflow editor window consists of these main areas:
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1. The workflow editor menus. Learn more in The Workflow Editor Menus on page 988.
2. The workflow editor tool bar. Learn more in The Workflow Editor Tool Bar on page 990.
3. The files pane shows the files that you selected before opening this workflow (only when opened

from the Files view) or it shows the files that you launched this workflow on.
4. The favorites bar shows your favorite workflow steps that you often use when building workflows.

Add new ones by drag and dropping new steps or custom tickets into the bar. To remove any,
right-click and click 'remove'.

5. The canvas shows your workflow. You can monitor your workflow while it is processing files and
you can diagnose a finished workflow.

6. The tasks pane shows all the tasks and workflow controls that you can use in a workflow. You
simply drag and drop them onto the canvas. You can easily find tasks by using the filter and the
search field.

6.2.2 The Workflow Editor Menus

Some menu options are only available while creating a workflow, others are only available for a saved
workflow ticket.

Use this
menu...

to ...

File • Launch a file into the workflow (when you selected a file before building the
workflow).

• Launch a file into the workflow and keep the workflow editor window open
(Launch And Monitor).

• Select one or multiple files to launch in the workflow (Select File...).

• Save your workflow and all its parameters in a Ticket (Save Ticket).

• Save your workflow under a different name (Save Ticket as...).

• Save your workflow on your client computer (Export Ticket...). Learn more about
exporting workflows in Exchanging Workflows on page 1009.

• Show information about the workflow ticket (Show Info): the Name of the ticket,
the Task Type, the Tags, whether or not the ticket is Public, a Description of the
ticket.

• Open the selected step.

• Show Parameter Inspector. Use this tool to easily manage the ticket parameters
of all the used tasks. Learn more in The Parameter Inspector on page 1033.

• Find: puts your cursor in the search field of the tasks pane and clears any
previously entered text string.

• Search: puts your cursor in the search field of the tasks pane or highlights any
previously entered text string.

• Close this workflow editor window.
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Use this
menu...

to ...

• Print your workflow canvas on a network printer (only available for a saved
workflow ticket)

Edit • Undo or Redo your latest changes. The menu option also mentions which type of
change it can undo. For example: 'Undo Change Parameters' or 'Undo move'
etc.

• Cut, Copy or Paste the selected step(s). You can also copy-paste between
multiple workflow editor windows.

• Select All workflow steps.

• Delete the selected step.

View • Change the zoom of the workflow to its Actual Size. Alternatively, you can
also Zoom In, Zoom Out, or Zoom to Fit in the window. Check the available
shortcuts.

• Show / Hide Favorites, Files, Tasks and Sticky Notes. Learn more about sticky
notes here.

• Expand or Collapse the Queue. When a workflow is running, a Queue is the
vertical list of icons of workflow items that are being processed by a same step.
These items represent (grouped) files or concepts like Job, Plate etc. If the amount
of these icons is disturbing, choose to collapse that queue.

Advanced • Add / Remove this workflow ticket to / from your Favorites bar.

• See a processing Log (when the workflow is running). You can also send the Log
contents as an E-mail.

• Set up Task Options: Priority, Hold / Release, Launching a separate task per
input file and Annotations.

• Set up Notification Rules. Learn more in Defining a Notification Rule on page
667. Tip: check if using the separate Send E-mail task is a better alternative.

• Manage Workflow Parameters... and Workflow Parameter Values.... Learn
more about these in Using Workflow Parameters on page 1065.

• Manage Public Parameters for the selected step or check and Modify Public
Parameter Values for the whole workflow. Learn more in Using Public Parameters
in Workflows on page 1051.
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Use this
menu...

to ...

• Validate the current workflow (including all subworkflows). Any problems will be
shown and explained in a separate dialog.

6.2.3 The Workflow Editor Tool Bar

The tool bar offers buttons to:

• perform specific actions on the workflow ticket: . All available actions are explained in
The Workflow Editor Menus on page 988.

•
launch the workflow on the selected files  (only when you opened the workflow editor

from the Files view). Press Alt to see the button change to  and Launch and Monitor the
workflow (without closing the workflow editor).

•
change the zoom in the workflow canvas (zoom in  , zoom out  , zoom to fit  ),

Tip:

You can also use these shortcuts:

• Ctrl + Space (on Windows) or Space + Cmd (on Mac) to activate the zoom in tool, then click
or drag in the window.

• Ctrl + Alt + Space (on Windows) or Cmd + Option + Space (on Mac) to activate the zoom
out tool, then click in the window.

• Scroll your mouse up or down to move the whole workflow up / down in the window. Add
Shift to move left-right.

•
delete the selected step(s) ( ).

•

show / hide certain areas of the window: Files  (when opened from the Files or Tasks view),

Favorites , Tasks , Tickets .

Tip:  Use Ctrl + click or click and drag to select multiple steps.

6.2.4 Building a Workflow from Scratch

1.
In the Tickets view, click  to open the workflow editor.

The canvas shows these two workflow controls by default:  and .

2. Drag and drop the desired steps from the tasks pane onto the canvas.
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Note:  If the tasks pane is not visible, click  View > Show Tasks .

Note:  To find a task quickly, use the filter and the search field.

3. If you want to give one or more steps a more descriptive name to make the workflow self
documenting, double-click the name underneath the icon and change it.

You can still see the original name of the step by hovering over the step.

4. Connect your steps with one another. To do this, click on a step's green output Pin and drag it
onto the next step.

This will link the two steps with a green arrow, called a Transition.

Note:  Remove the transition by selecting the end part and dragging it away from the step that
it was connected to.
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Note:  You can connect a step's output to multiple other steps. These steps will receive the same
input file and will execute in parallel. See an example below ;

Note:  When you move your mouse to a point where multiple transitions come together, they will
split up to make it easier for you to pick one of them (see below). When you want to move them
together, hold the Alt button to select and move them together.

Tip:  Learn more about keeping your workflow clean in Visual Optimizations of a Workflow on
page 995.

5. Double-click each step and fill in its parameters in its ticket. Click OK to close the ticket. There is
no need to save these tickets. Their settings will be saved inside the workflow ticket.

6. Save your workflow using either:

• File > Save  or Ctrl + S,
• File > Save As...  or Ctrl + Shift + S.

Note:  Until your workflow is saved, you can undo your changes. In  Edit >  Undo  you can
read which change can be undone.

Note:  Until you save your changes, the name of the workflow will show an * behind it's name.
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Tip:  Before saving your workflow, it is good practice to check its validity. Use  Advanced  >
Validate Workflow  or Ctrl + Alt + V.

6.2.5 Building a Workflow using Custom Tickets

Compared to building a workflow from zero, using already made custom tickets as workflow steps
adds these extra possibilities:

Using the Ticket Browser

In the tool bar of the workflow editor, click  to open the Ticket Browser pop-up.

 shows the complete list, sorted per task type.  shows only the tickets of the selected task type.

1. Use the Categories filter and /or the search field to quickly find your custom ticket.
2. Select and drag the ticket onto your workflow canvas.
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Note:  Alternatively, you can choose to not use this Ticket Browser, but use the Tasks pane and
activate Show Custom Tickets (right-click in the list).

Custom Tickets in your Workflow can be Copies or References

When you add a custom ticket onto your workflow canvas, it is by default a copy of that ticket. This
means that any changes you make to that ticket will not be reflected in the original ticket and vice
versa..

When you hold Ctrl + Shift or Cmd + Alt (Mac only) while you drag a custom ticket onto your workflow
canvas, a reference to that ticket is added to your workflow. This means that any changes you make
to the ticket will also be done in the original ticket and vice versa.

Note:  This is equally valid when your ticket is a workflow ticket.

Referenced tickets also show their original name, with a small arrow in front. In this example you
see 3 workflow steps: a copied ticket on the left, a referenced one in the middle and on the right a
referenced one that was renamed in this workflow:

Note:  If the ticket that you refer to in your workflow uses any SmartName containing [ ...
originating Input ... ], be aware that this will reflect to the input of the ticket that you refer
to, not of the workflow that refers to it.

Adding a Part of another Workflow to your Workflow

If you want to add parts of a workflow to another workflow, follow these steps:

1. Open both workflows in a workflow editor.
2. Select a part of one workflow and choose Copy.
3. Click on the canvas of the other workflow and choose Paste.
4. Add the desired transitions and save your new workflow.
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Note:  If you plan to reuse workflows or parts of a workflow several times, we advise to create
subworkflows. Learn more in Subworkflows on page 998.

6.2.6 Visual Optimizations of a Workflow

Workflows can become very complex. The following tools help to visually optimize them, which will
make it easier to understand them.

Aligning Workflow Steps on a Grid

You can align your workflow steps on a grid. To do this, hold the Shift key while dragging a step to
the desired position. It will snap to a place on the grid.

Hiding and Showing Transitions

To optimize the overall look and readability of a workflow, you can hide specific transitions. See this
example where the transitions to one Send E-mail step make the workflow look more complicated
than it is:

To hide the transitions to a (less important) step:

1. Right-click on the desired workflow step.
2. Click Hide Transitions. All transitions going to this workflow step will now be hidden. All other

new transitions made to this step will automatically be hidden as well.

See this example where all transitions to the Send E-mail step are hidden:
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If you want to see which transitions were hidden, click on the step (start or end). The hidden transitions
will be revealed in a grey color:

To reveal the transitions again, right-click the step and choose Show Transitions.

Distributing the Space between Workflow Steps

To distribute the space between all (or selected) steps evenly and also to align them on a grid, proceed
as follows:

1. Right-click anywhere in the workflow window.
2. To align the tasks horizontally, click Horizontal Distribute Space or use Ctrl + Shift + H.
3. To align the tasks vertically, click Vertical Distribute Space or use Ctrl + Shift + V..

For example, this workflow needs some realignment:
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This is the result after distributing the space:

Adding Sticky Notes

Right-click anywhere on your canvas to add a Sticky Note to your workflow. Use these notes to add
background information and so help users understand the workflow. They can serve as warnings or
to remind users why some parts are constructed that way.

Customizing the Canvas Background

You can choose a custom canvas background for all your workflows. Right-click on the canvas,
choose Change Canvas Background... and browse to an image on your local computer.
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You can remove it again with Clear Canvas Background.

6.2.7 Subworkflows

A subworkflow is a workflow that is part of its master workflow. It is included in the workflow ticket of
the master workflow. A subworkflow can also include another subworkflow. You can create workflows
several levels deep.

These are two main reasons to create a subworkflow:

• The master workflow will look less complex when a part of its flow is represented by only 1
workflow step.

• To stop creating the same (parts of) workflows again. If you notice that you keep creating the same
or similar (parts of) workflows, then consider building that recurring part once and then copying
it as a subworkflow into the other workflows.

In this example we see that the complete approval workflow is represented by a subworkflow named
"SUBWFL Approval":

Double clicking the subworkflow step opens it in the same workflow window. Notice the indication
of the path:
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The Difference between a Subworkflow and a Referenced Workflow

A referenced workflow is not included in the master workflow, it is not copied on board. It is a link
to a separate (workflow) ticket.

Note:  Learn about adding referenced tickets or workflows in Building a Workflow using Custom
Tickets on page 993.

The advantage of a referenced workflow is that by updating your referenced workflow you so
automatically update all the master workflows that refer to it. See some examples in Good Practices
for Building Workflows on page 1010.

See this example where the approval part of the workflow is added as a reference. Notice the small
arrow and extra name of the original workflow ticket:

When you double-click a referenced workflow step, it will open in a separate window.



6
Automation Engine

1000

Building a Subworkflow

To add a subworkflow into your workflow:

1. In the workflow editor, drag a Workflow  task into your workflow. Or use an existing workflow
ticket ; in that case skip step 3.

Tip:  To find it quickly, select the category Workflow in the tasks pane or type 'workflow' in
the search field.

2. Double-click the workflow step.

The workflow step opens in a new canvas, where you can build your subworkflow. The extra level
in the path indicates that this is a subworkflow:

Note: This is an example of a path indication of a workflow with 2 levels of

subworkflows:

3. Build your subworkflow: drag and drop steps into its canvas, add transitions, open each step to
change its parameters. There is no need to save at this point.

4. In the workflow path, click on your master workflow to go back to it (in above example: click on

).
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5. Save your master workflow. Your subworkflow(s) will be saved as a part of it.

6.2.8 Inserting Wait Points

Sometimes you want the workflow to wait a while before continuing with the next task. There are
several ways to do this:

The Wait Task

Use the Wait task in a workflow to postpone the next task to a relative or absolute time.

A few examples of workflows where this task is useful:

• Your workflow sends a proof to a proofing device. You want to wait 30 minutes and then send
the user a To Do to go and pick up the proof.

• A Folder Access Point launches a workflow on incoming design files. These design files have
been backed up already somewhere else. That is why you can delete them from the Automation
Engine Container when you are sure that the workflow no longer needs them (for example after
4 hours).

• Every night you want to clean up a specific type of files that you consider temporary. You have
built this into your workflows, where a Wait task is set to release between 3 and 5 AM, and is
followed by a Delete task.

The Wait for Files Task

Use this task when you want to process files that are not present yet.

The task will look for the files at a regular interval, and when it finds them, it will pass them on to
the next workflow step.
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You can also define how long the task should wait, and what to do if the files aren't found after that
time period.

1. Select the File Type of the file(s) you want to wait for.

You can either:

• choose to wait for Any file type,

• select a specific file type from the list,

• select several file types (see below).

To select several file types:

a) Choose Select File Types... in the File Type list.

This opens the Select File Types dialog.
b) In this dialog, select the files types you want from the Available File Types column.
c) Click  to send them to the Selected File Types column.
d) Click OK when you are done.

You will see your selected file types listed in parentheses:

2. Use the File Name Matches parameter to search on file names.

You can use wildcards and SmartNames. You can also browse to a file with a name close to what
you need, and add wildcards and/or SmartNames to that example name.

3. Define where to look for the files in the Look in Folder parameter.

Choose to Look in subfolders or not.

4. Define when to Stop waiting for the files:
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• when a certain number of Files or Pages are collected,
• after a certain time if the files haven't been found (when Time exceeds ...).

To set a custom time, select other... and select a date and time from the dropdown list.

Depending on what you choose, the task will finish either after it has found all the files/pages, or
after a certain time if it can not detect all the files/pages.

Note:  If you do not give the task a time limit, and it can not detect all the files, it will run indefinitely.

5. Select Task ends in error when not all files were found if you want the task to finish with an
Error state when:

• the time that you set in Stop waiting when time exceeds ... has passed,

• the task has not detected all files at that set time.

The Wait for Product Status task

This task allows to hold a workflow until one or more Products have reached a certain status.

This task is documented in the chapter on Products on page 876. Find a direct link here.

The Wait for Action (Checkpoint) Task

Use this task to hold your automated workflow for any form of user intervention. This task adds a
Checkpoint in the user's To Do List. When the user finished the required action, he releases the To
Do item. He can choose to let the workflow continue, to abort it or to have it take another route.
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Task Settings:

• To: From the dropdown list you can choose a specific user or Task Owner (the user who launched
the task) or Any user (all users will get the To Do).

If you use a SmartName to specify the user, make sure it resolves to the method
"name@domain" (for example "franky@aeserver01" or "franky@fruitco-domain").

Note:

The users Any user and Task owner can also be addressed through a SmartName. This
SmartName needs to resolve to their internal Parameter Value "Task Owner...@" and "Any
User...@". Learn more about this in SmartNames of Parameter Values on page 982.

• Subject: This subject line is shown in the To Do List overview.

• Message: Optionally, add extra information.

• Due date: Setting a due date becomes useful in the To Do List overview for sorting and creating
filters (learn more in To Do List on page 616). Choose from the dropdown list to set a relative or
an absolute time ('On').

• Output States: You can here define custom output states. In a workflow, they are shown as
output Pins.

• Click Add to add a new output state. Enter a Name and Description (optionally) for the output
state. Choose the Type from the dropdown symbols. An example:
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• Release automatically: Select this if you want the task to end after a specific time to a specific
state.

Example of a workflow combining a To Do for "Any user" with one for "Task
Owner"

It is possible to use the To Do List to distribute tasks. The first user who picks up a To Do Action can
become the owner of the rest of the workflow.

See this example of a workflow that is launched by a Folder Access Point: the first Checkpoint task
sends the To Do to Any User. The second Checkpoint task sends it to the Task Owner:

The Folder Access Point launches this workflow with a non-specified user:

Learn more about Access Points in Access Points on page 1236.

This is how the result looks like in the Tasks view:

• First, the user was "UPLC" (the system user when no user is specified in an Access Point).
• The first To Do became visible in the list of All users.
• This first To Do was handled by the user "wde", which made him/her the Task Owner from that

point on in the workflow.
• The second To Do goes to the Task Owner, which is still "wde".
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6.2.9 Routing in Workflows

Simple Processing Routing

As mentioned in Building a Workflow from Scratch, Transitions can route your files to different
workflow steps. Automation Engine will automatically check the format of the files going through this
step, and send them to the appropriate step(s) for that file format. See an example below where the
PDF will go to will go to the trapping step:

However, to keep an easier visual overview of your workflow, we advise to use a Router workflow
control instead (learn more in Automatic Routing on page 1008).

Routing in Subworkflows

When a subworkflow has multiple end steps, an extra type of routing becomes possible. The end
steps of your subworkflow correspond with the outputs of the their workflow step in your master
workflow.

For example, this subworkflow ends with two 'OK' end steps that were renamed to "Small Press"
and "Big Press".

In the master workflow, you can see that they correspond to the two green output pins of the
subworkflow step "Layout".
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This means that:

• files sent to the "Small Press" end of your subworkflow will go through the "Small Press"
output pin in your master workflow,

• files sent to the "Big Press" end of your subworkflow will go through the "Big Press" output
pin in your master workflow.

Routing via To Do List Action Items

Users can decide the route of the workflow (files) through Action items in their To Do List. They can
also choose to forward the To Do Action item to another Automation Engine user.

Learn more about Workflows creating Actions in a user's To Do List in The Wait for Action (Checkpoint)
Task on page 1003. Learn more about using the To Do List in To Do List on page 616.

In the Pilot Tasks View

In the Tasks view, the Wait for Action (Checkpoint) task shows the Phase "User intervention
needed". Below right, the icon  shows that one (extra) item is added to this user's To Do List.

You can click either of these elements to Release the item to one of the outputs that were defined
in the Wait for Action (Checkpoint) task. This will close the To Do item.

In the Workflow Editor

In the workflow editor, the user will see User intervention needed as the file status and the
Checkpoint task step will jump up and down:

The workflow editor will also show one To Do  (for this workflow).
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To route (and close) the To Do item, you can

• right-click the file icon and select one of the outputs defined in the Checkpoint task.

• right-click the file icon and select Open To Do... and there select one of the outputs offered in
the Release button

•
click the To Do icon  to open the item in the To Do List and there select one of the outputs.

Note:  In the To Do List, make sure the Actions Filter shows the Wait for Action items.

In Shuttle

In the Automation Engine Shuttle window, Checkpoint tasks and To Dos can be handled in the
same way as you do in the Pilot Tasks View.

Attention:  The user name you used in the Checkpoint task and the user name used in
Shuttle to connect to Automation Engine must match.

Note:  Learn more about Shuttle in Using Shuttle to Upload and Process Files on page 47 (User
Guide) and in  The Automation Engine Shuttle  on page 47 (Reference Guide).

Automatic Routing

The Router workflow control  enables a workflow to automatically decide the route that your
workflow (files) should follow.

The criteria that you define to route to a specific output Pin can be based on many different types:
the file type, the number of separations, the value of a Job Parameter, etc.

For example: routing files based on their File Type:
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... and so send each file type to an appropriate next task in the workflow:

In the above example, ArtPro files are routed to their own normalization task, while Native or
Normalized PDF files are sent directly to the Trap task.

Learn more about the Router in Router on page 1024.

6.2.10 Exchanging Workflows

The two main reasons to export and import workflows are

• to exchange them with other plants of your company that also use Automation Engine.
• to exchange them with Esko Customer Service.

Exchanging workflow tickets is done in the same way as for single tickets:

1. Export the workflow to a ZIP file (in Tickets view or in the Workflow Editor).
2. Send the ZIP file to the other Automation Engine (onto a client computer of that server).
3. At the receiving site, in Pilot Tickets View, select Import, browse to the ZIP file, and click OK.

Note:  The Automation Engine software version on the server that imports the ZIP may not be on an
older version than the Automation Engine server that created the ZIP.

What about references?

As mentioned in Working with Tickets on page 177, references will also be copied into the ZIP file.
These references are not just files like templates but also SmartNames, profiles, scripts, referenced
workflow tickets etc. See a full list of included references in Exporting Tickets on page 178.

Attention:  Workflows that include referenced (blue) Job Tickets can not be exported. An
error message will appear.
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Note:  Exchanging workflows is often done just to exchange the SmartNames used in those
workflows. Learn more in Exporting and Importing SmartNames on page 938.

6.2.11 Good Practices for Building Workflows

Below tips help you build a workflow that is sustainable and easy to maintain. They also avoid extra
work and cost when you upgrade or migrate server computers.

Note:  Some of these tips are also present as an Esko Knowledge Base article. Find these and more
on http://help.esko.com/knowledgebase.

Avoid Absolute Paths and Server Names

Do you know the name of your file server in five years from now? Probably not. That is why we
recommend to avoid using that computer name in your Tickets and Workflows.

For example when you define a template for the ReportMaker task. See below example of a Ticket
with an absolute path to one specific template. If you have many such tickets, and the location of
the templates changes, you then have to adjust all your ReportMaker tickets.

This can be avoided by using a SmartName in the path. When the path changes, you then only have
to update the SmartName.

The SmartName can be a String Extract SmartName that contains the path or even just the server
name:

http://help.esko.com/knowledgebase
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The same principle applies to other tasks with references to files or folders like Compare PDF,
Create CAD Sheet and Select File. If you copy a PDF file to an external system, a CIP3 file to a
press, a TIFF file to an imaging device, a JPEG preview to an MIS, a ZIP file to an archiving system
etc., always avoid using server names and fixed locations.

Note:  You can keep it even more generic. For example if your templates are saved on the Automation
Engine Server, you can use the system SmartName [Server] to make your path smart. No need to
create an extra SmartName in this case, but you will have to keep the templates on the Automation
Engine Server when you migrate to new hardware.

Some typical situations where you better use SmartNames in paths:

• ReportMaker templates
• CAD files repository
• Image Mark files in SmartMark sets
• Files loaded in ArtPro Action Lists
• PDF, XML, JPEG communication with MIS/ERP
• TIFF, LEN, PS data sent to output devices
• Defining the file location of a Product.

For some situations, there is a default solution:

• In the Create Job ticket, use the Smart Job Location instead.
• Save PitStop Profiles in the default "PitStop Root" container (only visible in the PitStop ticket).
• FastImpose templates have a default location on the Automation Engine Server.

Annotate

If you are implementing a temporary workaround or even misusing a task to achieve your goals,
make sure that you later remember why you did this. There might be a better solution or less strict
requirements in a next version of Automation Engine. An exotic part of the workflow for which you
don't remember why or how you did it, is a part that nobody later dares to change or remove. It will
cause problems sooner or later.

The best way to manage this is to document on the spot. Automation Engine provides plenty of
possibilities to do so:

• Description field for tickets and workflows
• Tags for tickets and workflows (also helps filtering)
• Renaming the workflow steps
• Description field for SmartNames
• Tags for SmartNames
• Sticky Notes in workflows
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Note:  Documenting your experiences while building a workflow is not only a great help for yourself
and your colleagues but also for anybody at Esko Customer Service.

Use Referenced Tickets and Workflows

Referenced Tickets

You probably use several Export to PDF tickets. We advise to not copy-paste such a ticket in your
workflows but to add a reference to this ticket. Then, when you decide to change a setting (for
example "outline fonts"), you only have to change this single ticket and all the workflows that use it
will so adapt and use these latest settings.
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Learn more about referenced tickets in Building a Workflow using Custom Tickets on page 993.

Reoccurring Workflows Parts

When part of a workflow is identical in other workflows, we advise to create it as a separate workflow
and then refer to it from the master workflow(s).

For example, a part of your workflow sends feedback about a file to the business system. You
probably use this part in several workflows. We advise to create it once and use it many times as a
workflow step in various master workflows. We again advise to not copy it but to add it to the master
workflow as a reference. This way, when settings change, you will only have to adapt it once.

Workflows can get gigantic. When launching such a workflow, the Pilot will read all the settings of all
the tasks in this workflow, even in the subworkflows. This is why launching bigger workflows seems
slow. See an example of such huge workflows that you should try to avoid creating:

However, at the moment of launching, the Pilot will not immediately read the settings of a referenced
workflow. This adds an extra reason to divide such huge workflows into several referenced workflows.
The master workflow will not only react quicker, but will be much more structured and easier to
understand.

Here is a good example of a master workflow that quickly visualises the logic workflow process steps:



6
Automation Engine

1014

Learn more about copied and referenced subworkflows in Subworkflows on page 998.

6.3 Workflow Controls

Workflow Controls are steps in a workflow. Instead of executing a task on an input file, they make
workflow decisions on routing, file selection, file order etc.

•

 Start: Every workflow needs to start with this step. By default it is present on every new
workflow canvas.

•
 Modify Workflow Parameter Values: Use this to modify workflow parameter values at some

point during the workflow. Learn more in Modify Workflow Parameter Values on page 1015.
•

 Select Referenced File: Use this to easily select files that are referred to in an XML file.
Learn more in Select Referenced File on page 1018.

•
 Set Priority: Use this to assign a different priority to parts of your workflow. Learn more in

Set Priority on page 1021.
•

 Sort: When the order of the input files is important in the next workflow step, use this one
to manage that order. Learn more in Sort on page 1021.

•

 Router: This step enables automatic routing of files based on many possible criteria. Learn
more in Router on page 1024.

•

 Mark File: Use this step to mark files that you will select later in the workflow using the
Select Marked File workflow control. Learn more in Mark File and Select Marked File on page
1029.

•

 Select Marked File: Use this step to select the files that you marked earlier in the workflow
using the Mark File workflow control. Learn more in Mark File and Select Marked File on page
1029.

•

 Data Splitter: Use this step when you want to send the files one by one to the next task
instead of all together. Learn more in Data Splitter on page 1030.

•

 Data Collector: Use this to collect all incoming files before sending them to the next task.
Learn more in Data Collector on page 1029.
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•

 Fork: Use this to tag incoming and related files with a group tag. Learn more in Fork and
Join on page 1032.

•

 Join: Use this to select the files tagged as a group by the Fork workflow control. Learn
more in Fork and Join on page 1032.

•

 Cancel Workflow: When a file is sent to it, this step cancels the processing of the entire
workflow. This is useful when you also want to stop not just the branch of the workflow where
this step is used, but all branches. For example: when the previous step Manage Product Status
results in 'not approved' then the next step is Stop.

•

 OK: By default, there is already one OK step in the canvas. You can add more and route
files processed successfully to the appropriate OK step. When a subworkflow ends with multiple
OK's, they will show up in the master workflow as multiple green output pins.

•

 Warning: Add this step at the end of your workflow to route files that generated a warning
during processing. For example preflight tasks or approval processes typically also offer a warning
as end type.

•

 Error: Add this step at the end of your workflow to route files that generated an error during
processing.

Note:  A task that has one or more files ending with an error automatically triggers an error status
for both that task and the whole workflow. That is why it is not necessary to add this Error workflow
control and connect to it from the error output pin of a task.

To see which files caused this error, you can also click on the error output pin and open the output
widget:

Learn more in Diagnosing a Workflow in the Workflow Editor on page 1047.

6.3.1 Modify Workflow Parameter Values

This workflow control allows to modify values of workflow parameters during the workflow. Learn
more about workflow parameters in Using Workflow Parameters on page 1065.

Concept

The typical reason to modify a workflow parameter during a workflow is that there is new or changed
information that was not there earlier or at the start of that workflow. Some example cases:
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• The new or changed information is based on a user's decision. For example the decision how to
release a To Do Action item. See an example below.

• The new or changed information is coming from an external system (and was not available earlier).

Note:  Mind these exceptions:

• New information coming from WebCenter does not need this separate workflow control. The
tasks that communicate with WebCenter offer their own built-in tool to map their output
parameters to workflow parameters. Learn more in Modifying Workflow Parameters During a
Workflow on page 1075.

• When, during a workflow, an external system sends an updated XML with new or modified
parameters, check if you can use the feature Using Workflow Parameter Values from XML  on
page 1072. This feature loads that XML at every step of the workflow, not just at the start. This
means that the incoming updated XML can trigger an updated workflow parameter without
the use of this separate workflow control.

Using the workflow control Modify Workflow Parameter Values

To use this workflow control, proceed as follows:

1. Select and drag the Modify Workflow Parameter Values workflow control onto your workflow
canvas. Double-click it to edit.

2. Click Add to add workflow parameters or double-click existing ones to modify.
3. Use  to select an existing parameter or type the desired workflow parameter name and provide

a new value. This can be a fixed value, a SmartName or an XPath that retrieves the new value
from the workflow control's XML input. Learn more on Xpath in The XPath Builder  on page 954.

4. Click Add to confirm.

Note:  When the parameters list contains a new one, you will be asked to Confirm.

5. Click OK to close. Save your workflow.

Example: Capturing the To Do decision as a Workflow Parameter

Our workflow asks a user to decide if the output will be done on the old or on the new printer. This
decision should also be mentioned on the Report PDF.

• See how the To Do output Pin 'New faster Printer' routes to the workflow control that
sets the value of the workflow parameter 'Printer Decision by User' to 'New Faster
Printer'.
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• The ReportMaker template needs to pick up that workflow parameter. Those templates are
created in PackEdge. Because PackEdge SmartMarks can not pick up workflow parameters, you
first need to create a SmartName of that workflow parameter and then use that SmartName in
the template. Follow these steps to do this:

1. In Pilot, in the SmartNames View, in Include SmartNames From, check the option A workflow
and select the workflow that contains the desired workflow parameter.

2. Click  to create a new SmartName.
3. Set the Scope to Global and the SmartName Type to String Extract.
4. Click  Insert SmartName and select the category Workflow Parameters.
5. Select the desired workflow parameter [wfp. ] and click Insert.
6. Save the SmartName.
7. Open the ReportMaker template in PackEdge and open the SmartMark palette.
8. Select Text Mark from the Add SmartName palette.
9. Click the Smart Text... button, select the category SmartNames (Global) and select the

SmartName you just created.
10.Save the ReportMaker template
11.Use this template in the ReportMaker task. The resulting PDF can now mention what the user

decided in his To Do. Here is an example of how this can look like:

Visualizing the Workflow Parameter Values of a Step Output

To visualize the Workflow Parameter Values of a selected file, you can:

• choose the menu item  Advanced > Workflow Parameter Values . This dialog stays opens while
you click on output files.

• right-click on the desired step output and select Workflow Parameter Values.

Using above mentioned example, see the workflow parameter values of the Report PDF. The small

icon  indicates that the value was modified during the workflow:
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Note:  The set of workflow parameters can be different for each step output. For more info, see Using
Workflow Parameters on page 1065.

6.3.2 Select Referenced File

Use the workflow control Select Referenced File to easily select files that are referred to in an XML
file.

Note:  The Edit button offers to use the Xpath Builder. Learn more about creating Xpath Expressions
here.

• Select by: You can indicate (via SmartNames or XPath) which XML content to take to build up
the corresponding file path(s) and name(s). You can choose between:

• Folder and File Name: Choose this option if the source XML contains entries that define the
file path and file name separately. If this option is chosen, specify both the Folder and the
File Name.

• File Path: Use this when each file in the source XML has a fully specified absolute file path.

• Also select input files: Select this option to also add the step's input file(s) to the group of output
files.

• Don't group output: When this option is selected, the selected files will be offered separately to
the next step in the workflow instead of as a group.

When Don't group output is not selected (so output is grouped) and Also Select Input Files is
selected, the task will generate a group for each output:
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• Provide a warning when no files were selected: Select this option to get a warning when no
files are selected.

• Ignore unexisting file or folder: Select this option to prevent workflow errors when one or more
file paths refer to non-existing files. When selected, the non-existing files will be ignored.

Example 1: Folder and File Name

Our example XML refers to one file in a first Job and then to 3 files in another Job:

We used the Edit button to get to these settings:

After the Select Referenced File step ran, you will notice these 4 files on the OK output pin of the
workflow control (assuming the files exist).

• file://loppem/ExampleJobContainer/Jobs/Order-2014-100024/PDF/
Design1.pdf

• file://loppem/ExampleJobContainer/Jobs/Order-2014-100025/PDF/
Design1.pdf

• file://loppem/ExampleJobContainer/Jobs/Order-2014-100025/PDF/
Design2.pdf

• file://loppem/ExampleJobContainer/Jobs/Order-2014-100025/PDF/
Design3.pdf
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Example 2: Absolute File Path

This example XML contains several absolute file paths:

<?xml version="1.0" encoding="UTF-8"?>
...
  <FileSpec>file://AEserver01/Food/Jobs/1234/PDF/design1.pdf</FileSpec>
  <FileSpec>file://AEserver01/Food/Jobs/1234/PDF/design2.pdf</FileSpec>
  <FileSpec>file://AEserver01/Food/Jobs/1234/PDF/design3.pdf</FileSpec>
...

We chose the option File Path and used the Edit button to get to this setting:

The output pin of the Select Referenced File step will show these 3 file paths:

• file://AEserver01/Food/Jobs/1234/PDF/design1.pdf

• file://AEserver01/Food/Jobs/1234/PDF/design2.pdf

• file://AEserver01/Food/Jobs/1234/PDF/design3.pdf

Example 3: Using SmartNames

This example XML has a different structure:

<?xml version="1.0" encoding="UTF-8"?>
<Order id="2014-102457">
  <Customer id="JuiceCo"/>
  <Design>
    <File>PDF/design1.pdf</File>
    <File>PDF/design2.pdf</File>
  </Design>
</Order>

In this case, we find the Folder via a SmartName, based on the Order ID, and the File Name via
an Xpath:

This is the resulting selection ; the part of the path including the Job number was found via the
SmartName, followed by what the XML defined in <File> :

• file://AEserver01/Food/Jobs/102457/PDF/design1.pdf

• file://AEserver01/Food/Jobs/102457/PDF/design2.pdf
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6.3.3 Set Priority

Use the Set Priority workflow control to assign a different priority to certain branches of your
workflow.

You can set the priority to:

• Workflow (to use the general priority assigned to the workflow)

Note:  By default, the general workflow priority is set to Normal. You can change it by going to
Advanced > Task Options...  in the workflow editor window.

• Low

• Normal

• High

• Immediate.

You can see the chosen priority in blue under the workflow control:

Example

In this example, the most urgent operation is RIP'ing the files and sending them to the device.
Creating a JPEG and a Report PDF is less urgent:

6.3.4 Sort

Use the Sort workflow control to define the order of the files in a file set. You do this because the
order is important in the next workflow step.
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You can sort the files by:

• file name.

• workflow inputs. Files that entered the workflow first will be at the top of the list.

• SmartName. The value of a SmartName is calculated per file and that value determines the order.

You can sort in ascending or descending order.

Keep ... file(s): Use this if you only want to send a specific number of sorted files to the next workflow
step.

Sort by file name

Use a Regular expression to define the part of the file name that you want to sort on. The dropdown
list shows two example regular expressions:

• (.*) matches the entire file name

• .*?([0-9]+) matches the number in the file name (for example to sort files named
cover1.pdf, page_2.pdf, etc.).

Learn more about regular expressions in Using Regular Expressions  on page 978.

• Sort numerically

Select this option if you are using a regular expression to extract a number from file names. The
results will then be sorted numerically and not as text. For example, a value of 10 will be sorted
after 9 when this option is selected. When you don't sort numerically, the values are considered
as text: then 10 will come before 9 (as text, the first character 1 comes before 9).

• Accept non-matching files

Select this option if you also want to sort files that don't match the criteria. For example your
regular expression is based on numbers but the name of one file name doesn't contain numbers.

Any non-matching file(s) will be put at the top of the sorted list.

If you don't use this option and a file does not match, all your files will go to the error output pin.

Sort by workflow inputs

Files that entered the workflow first will be at the top of the list. You can sort in ascending or
descending order and optionally define how many files you want to keep.



6
Automation Engine

1023

Sort by SmartName

Select the SmartName you want to sort on. This list only offers custom SmartNames.

Numerical versus text based sorting works as described above for Sort by file name. The same is
true for the handling of non matching files.

Example: Sorting by Page Number

In this workflow, the Data Collector collects the pages of a page list after Normalizing, and sends
them to the Sort workflow control. Learn more about Data Collector here.

The Sort workflow control then sorts them in the right order, before sending them to the Create
Imposition task. The files are sorted on file name, in ascending order, using a Regular expression
to extract the number in the file name (and with the Sort numerically option):

Example: Sorting by SmartName, Numerically and As Text

In this example, you want to sort your files by the number that they contain. The number is always
mentioned after an underscore. You created a SmartName that extracts, from a file name, everything
after the underscore.

This is the result when you Sort numerically:
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This is the result when you don't Sort numerically ; the part of the name after the underscore is
now considered as text:

6.3.5 Router

The Router workflow control  serves to automatically decide the route that your workflow (files)
should follow.

Let's take the example where a Router decides the workflow track based on the size of the incoming
file. When the file is smaller than 5 MB, the file will be sent out via E-mail, otherwise via FTP.

• These are the settings in the Router:

Two rules were defined and the Route to names were customized.

Note:  The rules are executed from top to bottom. Their order can be changed with Move Up /
Move Down.

• This is the workflow:

Notice how (when the mouse hovers over the Router step) the name of the middle output pin
appears and how it matches the name that was defined in the Route to column of the Router
settings.
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Routing can be based on many different criteria (see the list below). Several of them offer these
generic options:

• Treat as numeric value: When you select this, the options in the value column offer numeric
possibilities (is less than, is greater than, etc.). This option is not there when it is obvious that
the value is numeric.

• Case sensitive: Select this if you want to match the exact case of the value.

Note:  If a value has to match, wildcards and Regular Expressions can be used in the value field.

Routing Based on Job Parameter Value

Choose this to route your file based on a Job Parameter. The Parameter Name dropdown list offers
the parameters of the Job setup tab Parameters and also those of the tab Step&Repeat.

Note:  You can also type in the parameter. This is not advised to avoid typing errors. However this
can be useful when you build the workflow and router settings outside of a Job context in which you
will be using it. In that case the parameters will not show up in the dropdown list yet.

An example:

Notice how you do not always need an Error route and how same routes can be chosen for more
than 1 value.

Routing Based on Job Field Value

Choose this to route your file based on one of the Job setup fields listed in the Field Name dropdown
list. The list also includes the custom Job Categories you may have defined.

The field Job Operation Context can only have these 2 values: update or creation. This value
was useful in cases where we now advise to use the Create Job task as a workflow step. Learn
more in the Advanced on page 1286 tab of that task.
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Routing Based on Number of Files

Choose this to route collections of input files based on the number of files in that collection.

Some examples:

• When you get not 1 but 2 files, you want to route to the recto/verso (front/back) workflow.
• You created various Tabular Step & Repeat tickets, one for each amount of Grids that they offer.

You use the Router to route to the Step & Repeat ticket with the same number of grids as the
amount of input files.

Routing Based on Milestone

Choose this to route based on the fact if a certain Milestone is Set or Not Set.

For example: you have a workflow where someone from the administration department uses the Pilot
to select a Job and set the Milestone 'OK from Admin department to Print'. The Router
checks if this OK was already given before continuing the workflow to the press.

Routing Based on File Name

Choose this to route files based on their name. Choose to Include the file extension or not.

For example: You agreed with the person sending you design files that no trapping will be done if
he ends the file name with 'notrap'. You created an Access Point that launches a workflow that
starts with this Router:

Routing Based on File Type

Choose this to route files based on their type.

For example: this Router categorizes many file types into specific routes:
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Routing Based on File Size

Choose this to route files based on their size.

Select Consider the combined size of all files in the collection if you want to match the size of
the whole file collection and not of its individual files.

See an example in the above introduction.

Routing Based on Number of Pages

Choose this to route files based on their number of pages.

Select Consider the combined page count of all files in the collection if you want to match the
page count of the whole file collection and not of its individual files.

For example: if the file has 2 pages, then you know it is a recto/verso (front/back) file.

Routing Based on Page Orientation

Choose this to route files based on their orientation (Portrait, Landscape or Square).

Some examples:

• your RIP does not have an auto-rotate function. Your workflow will then need to make sure that
you send the data in the wanted orientation.

• you want to know if a file fits on an output sheet. Before you compare the sizes, you will want to
know which side is the longest. If your output sheet is 100 horizontal by 60 vertical, you best only
compare sizes when your input file is also in landscape mode.

Routing Based on Page Size

Choose this to route files based on their page size.

This is typically used to route files to the output device with the right size. For example you want to
send small files to the small proofer, and bigger ones to the big proofer.

In Pagebox to use, you can choose either Trimbox or Mediabox. For images both settings Trimbox
and Mediabox will have the same result. The image size will be used for the comparison.
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Note:  This does not take the page orientation into account. Both page orientations will always be
checked. For example 'Page size' 'is equal to' '210 x 297 mm' will match both portrait
and landscape A4 files.

Routing Based on Number of Separations

Choose this to route files based on their number of separations.

For example: when a flexo job has more than 6 inks, you use a different SmartMarks set. It then
uses one with smaller rectangles for the color strips. You use a Router that checks the number of
separations. If it detects more than 6 inks, the next step is the Step & Repeat ticket that uses the
set of SmartMarks with the smaller rectangles.

Select Consider the combined separation count of all files in the collection if you want to match
the number of separation of the whole file collection and not of its individual files.

Note:  This counts the number of unique separations. For example, if you have a CMYK+Red and a
CMYK+Green file, the collection’s combined separation count will be 6.

Routing Based on Separation Name

Choose this to route files based on the name of their separation(s).

You can check if any (one or more), all or none of the separation names match or contain parts of
a specified string.

For example:

• when 'any' separation names 'contain' the text string 'pantone', then route to the part of
the workflow where you process the files that are not CMYK-only.

• when 'all' separation names 'does not contain' the text string 'Die', then route to the
Checkpoint task that will add an Action to the To Do List. The Action will ask the user to add
that separation.

Routing Based on Layer Name

Choose this to route files based on the name of their layer(s).

For example: you sometimes receive PDFs with several layers of black text in different languages.
The Router checks if the file has any layers with these names: FR, SP, EN, DE, IT, or PT. If so, it
routes them to the workflow where you first use Version PDF to create PDFs with only 1 language
in black (k): name_cmy_FR_k.pdf, name_cmy_SP_k.pdf, etc.

You can check if any, all or none of the layer names match. When using any, only one layer name
needs to match for the file to be considered matching.

Routing Based on SmartName Value

Choose this to route files based on a SmartName value.

For example: the Router checks the workflow parameters 'Print Process' or 'Preflight Yes
or No'. The values of these parameters decide what route the file needs to follow.

Find a good example in Launching a workflow with parameters from an XML on page 1319. Step 5
of that example illustrates how the Routers use SmartNames.
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Note:

Routing on SmartNames requires more resources from Automation Engine. If you have an alternative,
we advise you to use another routing method instead.

If your SmartName only contains Job related parameters, and you have many input files, we advise
to add a Data Collector in front of your Router. This will group the files into a collection and allow
the Router to perform the SmartNames check only once.

6.3.6 Mark File and Select Marked File

These 2 workflow controls are used as a pair. First you use Mark File to tag files, then you use Select
Marked File to select those files later in your workflow.

You can have several pairs of Mark File and Select Marked File in your workflow, as long as each
pair has its own tag.

Mark File Settings

In Mark all incoming items with tag, enter the tag to set on all files passing through this workflow
control.

Select Marked File Settings

In Select all items with tag, use the dropdown list to select a tag that you entered earlier in the
corresponding Mark File workflow control.

You can filter the selection of tagged files. Select Only select when name matches and enter what
name the file should match. You can use SmartName(s) and the asterisk * as a wildcard.

If you are working with subworkflows, you can choose to Also search workflows containing this
workflow (to search 'up'). Learn more about subworkflows here.

Example

A typical example is launching tasks on the one-up PDF after your workflow was already working
on the Step & Repeat version. In this case, you can tag the one-up file with Mark File, later select
it with Select Marked File and then for example archive it:

Note:  You need to use the exact same tag in the Mark File and the Select Marked File step. It is
case-sensitive, so we advise to always use the dropdown list.

6.3.7 Data Collector

Use the Data Collector workflow control
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• to collect all files that travel separately in the workflow and then send them all together to the
next step.

• to wait for all files before continuing the workflow (without grouping them)

Example

In this example, the Data Collector waits for all of the files to arrive (one-ups and their reports), and
then sends them as one group to the Zip task.

The result is one ZIP file containing both the one-ups and their reports.

Settings

• Error Policy. Decide what needs to happen when errors appeared earlier in the workflow, before
this Data Collector: Fail when errors occur or Ignore errors.

• Grouping

Group all collected data is active by default. In the above screenshot, notice how a mouse-click
on the box1.pdf in the output widget of the Data Collector, also highlights all the other members
of the group in light-blue (and as usual also the related files in previous steps).

Note:  Such a relation also means that they will share the same Workflow Parameters. Learn more
here.

Switch this function off when you want to use Data Collector as a wait point in your workflow. It
then only serves to hold the workflow until all previous steps are finished and then continues the
workflow with the same input (collections) as they entered the Data Collector.

Note:  When the Data Collector does not group, the Workflow Parameters will not be grouped
either. They remain attached to their specific file set. Learn more here.

6.3.8 Data Splitter

Use the Data Splitter if you want the next step in the workflow to process each file individually.
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Example

In this example, the Data Splitter (with the default setting Don't group output) sends the unzipped
files to the Checkpoint task one by one. This way, 5 To-Do Actions are created. The user needs to
decide for each file if it needs manual or background trapping:

Without the Data Splitter in this workflow, there would only be one To-Do Action. The Action item
would provide a link to the 5 files, but they would need to share the same decision.

Split and Create a (new) Group

You can also use the Data Splitter to split the collected files and group them according to a criterion
you define.

You can group the output by using a Regular Expression or by using a SmartName.

Two default regular expressions are available from the dropdown list:

• (.*) matches the entire file name without the extension

• .*_pag([0-9]+).*? matches the number directly after _pag in the file name (use this for
example for files named page_1.pdf, pagina_2.pdf, etc.).

Only the file name will be matched, without the extension. Learn more about regular expressions in
Using Regular Expressions  on page 978.

Example: Group RIP output to Prepare for Viewing

The Automation Engine Viewer enables viewing of RIP'ed data when they were prepared for viewing
together, as a group. When you have a folder containing RIP output of several jobs, it is important
that you send the right groups of separations to the Prepare for Viewing task. You can use the Data
Splitter and group the separations by using a SmartName.
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Note:  you can use the same principle in a workflow where you use the Create Wrapper file task.

Example: Group based on the Name of the Substrate

To automate the nesting process in an i-cut workflow, you can produce a grouped output using
Xpath Query SmartNames mapping to the name of the Substrate. That way, all data under the same
Substrate will be produced as one output for the nesting.

6.3.9 Fork and Join

The Fork workflow control automatically tags

• every file running through it
• and all the files that those files generate in the next steps (for example Report files)

This creates a Group Tag.

The Join workflow control then groups all the files with the same tag.

Example of Group Tagging

Our example workflow creates a ZIP containing the one-up PDF and its report PDF. This is easy to
set up when the workflow starts with only one file. This is different when your workflow starts with
multiple files:
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In this example,

• we have 2 input files that will travel through this workflow together
• the Fork tags both the input files and the 2 report files created from those input files
• the Join creates 2 groups, each with the input file and its report file.
• these groups are the inputs for the ZIP task. You now have a ZIP per group.

Without the Fork and Join steps, you get 4 ZIP files: one for every file. If you use a Data Collector
to group all of them, you get 1 ZIP of all 4 files.

6.4 Launching and Diagnosing Workflows

6.4.1 The Parameter Inspector

The Parameter Inspector enables you to quickly view or change the ticket parameters of your
workflow steps, without having to open and close each workflow step separately.

Open it by choosing Show Parameter Inspector... from the workflow editor File menu or by
choosing the same option after a right-click on the canvas.

Note:  The parameter inspector is not available for workflows that were already launched (running
or finished).

The window stays open while you navigate through the steps. The steps are shown in alphabetical
order. You can navigate through the steps by selecting them in the parameter inspector or by clicking
on steps in the workflow editor canvas.
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The parameter inspector does not show

• steps that have no parameters (Start - Stop - Warning - Error - Cancel)
• subworkflow steps. Double click the subworkflow step on the canvas to see its own steps appear

in the same parameter inspector window.
• referenced steps.

When available, you can

• choose Save As... to save the selected ticket as a separate task ticket.

• choose  to set extra options that you can also set when you open the ticket separately:
Notification Rules, Manage Public parameters and Map Output Parameters.

6.4.2 Launching a Workflow on a File

There are several ways to launch a workflow on a file: from the Pilot, from the Workflow Editor, from
Shuttle, via Access Points or via JDF/JMF.

Note:  Learn more about launching workflows from external systems in Integrating with External
Systems on page 1228.

Launching a workflow from the Pilot's Files View is very similar to launching a single Ticket. Follow
these steps:

1. In the Files view, right-click the file(s) you want to process and select:

• New Task . You can then select the workflow and change its settings before launching it.
• Launch with. You can then select the workflow and launch it without changing its settings.
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Note:

If you don't have the access right Tickets: Show All Tickets and their Parameters (Public and
other), you will only see Launch with. You will also only be able to select public workflow tickets.
Learn more in Access Rights on page 702.

2. Select the workflow ticket to use.

• If you have launched workflows previously, the most recent workflow tickets you used are
listed under Workflow.

• If you don't need a recently used workflow, select Other...

In the Select Ticket dialog that opens, select the workflow ticket you want to use and click OK.

Tip:  Type Workflow in the search field to quickly filter to the task type Workflow.

Tip:  If you hold the Alt, the OK button changes into Launch.
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3. Some variations are possible:

• To keep the workflow editor window open and monitor the workflow while it is executing, hold

Alt while clicking Launch to Launch and Monitor (the Launch button changes to ).
• If you choose New Task, the workflow editor opens. Fill in the settings you want to use in each

workflow step and click the Launch  button.
• If you choose Launch with and you don't have the access right Tickets: Show All Tickets

and their Parameters (Public and other), then

• if the ticket does not contain public parameters, the workflow is launched on the file as
soon as you select the workflow ticket.

• if the ticket contains public parameters, it will open for you to fill them in. You will only see
the public parameters. Click the Launch button when you are done.

In this example the user is asked to decide 2 public parameters:

Note:  If a workflow is launched on files that are linked to several Jobs, a separate workflow will be
launched for each Job context. This can happen for example when you use the Files view or Shuttle
or a Folder Access Point.

6.4.3 Using Favorite Workflow Tickets

Note:  In Favorite Tickets on page 179, you can read how to build and launch Favorite tickets for
single task tickets. You can do the same for workflows tickets. We here repeat some information and
add specifics about working with favorite workflows.

Favorite tickets are links to tickets that you use a lot. They show up in the Favorites pane, both
in the Files and in the Tickets View. You can use  Pilot > View >  Favorites  to show or hide the
Favorites pane.
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Favorites tickets show up depending on

• the file type you selected first.
• the user that is logged in. They are your personal favorites.

Tip:  You can copy and paste favorite tickets from one user to another. In  Pilot >  Tools >  Users
, right-click a user name and choose Copy or Paste Favorites.

Adding Favorite Workflow Tickets

There are 3 ways to create a favorite (workflow) ticket:

• when you first save a workflow or use 'save as', then check Add to Favorites.

• in the Tickets View, right-click a ticket and select Add to Favorites. Use Shift to select multiple
tickets.

• both in the Files and in the Tickets View, in the Favorites pane, right-click and choose Add
Favorite....

The Add Favorite Dialog

When selecting a (workflow) ticket to add as a favorite, these 2 tools help you filter your list of tickets:

1. Instead of seeing All Tickets, use the dropdown list and select one of the tickets filters that you
created earlier and saved into your Smart Views. Learn more about Smart Views here.

2. Type in a filter in the search field. What you type will be used to filter in all the columns.
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There is No Need to add Many Favorites of Same Task Type

When you click on the right side of the favorite, a dropdown list will show you all tickets of the same
task type (with a maximum of 10). This easy access to similar tickets means that you do not have to
create a favorite of those other similar ones (when you also use them often).

When the ticket that you look for is not in that list (remember that maximum 10 are shown), you can
choose Other... and select it there.

Organizing Favorite Workflow Tickets

In the Favorites pane, right-click and choose Organize Favorites... to organize favorites and to
create favorites based on SmartNames.
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• Click Add... to add a favorite by selecting it from the list of tickets.

• Click + [ ] Add... to add a favorite based on a SmartName. Find instructions below.

• Click Modify... or Remove to modify or remove a favorite.

• Click Move Up or Move Down to change the order in which the favorite will appear in the favorites
pane.

Adding a Favorite based on a SmartName

Click + [ ] Add... to add a favorite based on a SmartName.

• Define the Task Type. Select it from the dropdown list or specify the type by using SmartNames.

• Define the Ticket Name. Choose the Scope and define the name by typing in the name and
optionally using SmartNames in that name.

See this example where your favorite ReportMaker ticket is partially defined by the Job Category:
In the screenshot above you can see the feedback when the Resolved Value does not match. It is
good practice to use the Check button to check that value before clicking OK.
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Launching Favorite Workflow Tickets

There are various ways to launch a favorite (workflow) ticket:

Launch Immediately

1. Select file(s).
2. Hold the Alt button.
3. Click on your favorite. The task is launched.

Choose a Ticket of the Same Task Type and Launch Immediately

1. Select file(s).
2. Hold the Alt button.
3. Click on the right-side of a favorite to open the dropdown list of tickets of the same task type.
4. Move your mouse down to the chosen ticket.
5. Click on the chosen ticket. The task is launched.
6. Release the Alt button.

Open the Favorite Ticket in the Workflow Editor

1. Select file(s).
2. Click on your favorite.
3. In the workflow editor, check or change the settings and then launch or 'launch and monitor'.

Choose a Ticket of the Same Task Type and Open it in the Workflow Editor

1. Select file(s).
2. Click on the right-side of a favorite to open the dropdown list of tickets of the same task type.
3. Move your mouse down to chosen ticket.
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4. Click on the chosen ticket.
5. In the workflow editor, check or change the settings and then launch or 'launch and monitor'.

6.4.4 Building and Launching a Workflow On The Fly

If you build a workflow from the Tickets view, you cannot launch it until you finished building it. Your
Workflow Editor will not have a Files pane to select files and then launch it. Working this way is
typically something done by Automation Engine administrators while building the workflows. Once
the workflow is ready for testing, users can then go to the Files view, make a file selection, select
the workflow ticket and launch it.

However, you do not always have to prepare a workflow ticket before you can launch it. It is possible
to build the workflow and launch it on a file without first saving the workflow ticket. Follow these
steps to do this:

1. In the Files view, select the file(s) you want to launch your workflow on.

Note:  If you need to select files from different (Job) folders, then first select those in one same
folder, then choose New Task or New Workflow to open a Workflow Editor and there use the
Select File tool to select the files from any other folders (see step 4).

2.
Click  to open the workflow editor.

You can see the file(s) you selected in the Files pane of the Workflow Editor.

3. Build your workflow and define the settings of every step.

4. If you want, select more files. Right-click in the Files pane and choose Select File....

In the dialog that appears, select files from folders in Jobs or Containers.

5.
Click the Launch  button. Hold Alt to Launch and Monitor and keep the workflow
editor open.
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6. If you kept the workflow editor open, continue by changing the workflow settings, relaunching or
launching on different files. When ready, save your workflow ticket.

6.4.5 General Workflow Task Options

Task Options are options that will be used when you push the Launch button in the workflow editor.
These settings are not saved into the workflow ticket.

Open Task Options from the menu Advanced in the workflow editor:

• Priority: Choose the general priority with which you want to launch this workflow. The default
is Normal.

Note:  To choose High or Immediate, you need a special User Access Right.

Note:  You can also choose to set the priority of only a part of the workflow. Learn more in Set
Priority on page 1021.

• Hold: Check this when you want to hold the workflow when you launch it. The workflow will start

but immediately go into 'pause' mode. You can then later decide when to use the  button to
start it for real.

• Release: When you decided to use Hold, you can set a time when the workflow should be
released automatically. Choose a relative or absolute time.

• Launch a separate task per input file: Choose this option when you selected multiple input files
but when you still want to launch a separate workflow task per input file.

• Annotation: When testing many workflow tasks or many versions of a workflow, it can be useful
afterwards to read some notes that you added before launching it. Once the task was launched,
you can read these annotations from this same menu or you can read them in the Tasks view
when you right-click the main workflow task line.

For example: "This task was only launched to create the temporary files that
I need to test the next one"
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6.4.6 Relaunching Your Workflow with Different Settings

You can relaunch a workflow from the Tasks view and from the Workflow Editor (skip step 1):

1. In the Tasks view, double-click the main Workflow line to open your workflow in the workflow
editor.

Tip:  The workflow can be opened and relaunched even when it is still running.

Tip:  If you double-click any sub-step of the workflow, only that ticket will open. You can also
relaunch just that separate single step (if the input files are still available).

2.
In the workflow editor window, click the Edit Workflow button  if you want to make any
changes.

When you are finished making changes, and if you want to keep the new settings before you try
them out, save your workflow now.

Note:  As soon as you make one change, the name of the workflow ticket in the top bar will show
an asterisk * behind the name to indicate that it has been changed.

3.
Click Launch  or press Alt while clicking Launch to Launch and Monitor .

6.4.7 Diagnosing a Workflow in the Tasks Pane

You can check the processing status of a workflow in the Pilot’s Tasks pane. The Tasks pane appears
in the Files, Products and Tasks View.

Attention:  The Tasks pane does not show the Workflow Controls that may be part of your
workflow. To diagnose them, use the Workflow Editor.

Workflow Status
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The workflow status can be

• : running, when one or more steps are waiting to be handled.

• : success, when all steps finished successfully.

• : warning, when one or more steps finished with a warning.

• : failed, when one or more steps finished with an error.

• : cancelled, when a user cancelled the processing.

Right-Click and Diagnose Further

Right-click any task line to see many functions available for that task or its related files.

The availability of the functions depends on

• if the task is already finished or not
• if the task is the initial 'workflow' task type or any sub-step of that workflow.

Many of these functions are documented in Task Menu on page 168.

Some specific notes:

• Open Output File. This opens the output file in the default application for that file type on your
computer. For example: all PDF files are opened in Adobe Acrobat Reader.

• Open Output File With. This allows to chose from applications that you registered. For example,
this is how you register a locally installed PackEdge 14.0 :
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• Delete. If you decide to manually delete tasks, then you best delete the main workflow task step
so that all related task steps are also cleaned up. In general we advise to use the automated
version based on the standard Task Cleanup Rules that you set up in the Configure tool.

• Move to History. Same comments as above for the Delete function. Learn more about storing
task details in Task History on page 621.

• Log Info. The Log file contains the most detailed information about the processed task. You will
not only find the standard task Details (see also below) but also progress status and complex
technical debugging information. This level of detail can be interesting when searching for the
cause of errors. It is mainly meant for Esko service people.

• Open.... This shows the log information of the selected step in the Log dialog. You can send
an E-mail containing this log file and attachments (see below) or, when the task is still running,
Refresh to see the latest content.

• Open with allows to open the log file in a text editor installed on your computer. Register that
application in the same way as we explained for the option Open Output File With (see above).

Note:  This requires the Automation Engine client to have access to the share
'AutomationEngineLogging' on the Automation Engine Server.

• E-mail. The Compose E-mail message dialog allows to send this log info in an E-mail,
using the E-mail configuration as set up in Tools -> Configure. Fill in the E-mail address(es)
and change the body message as you wish. By default all relevant files are already attached
(remove any if you want to). The files with extension .ticket, .tic and .sn are file types
that Esko customer service can read.
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• Details shows you a summary of the log file with information meant for the user. It is also
translated. It can also contain links to related files. Here is an example of the details of the preflight
task that offers a direct link to the preflight report file:

Note:  In the Tasks View, you default get the Details pane.

• Group Workflows. If you do not filter the view by the column 'Launched', then tasks of a same
workflow are not shown together. Use this function to show them in a group anyway.
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6.4.8 Diagnosing a Workflow in the Workflow Editor

General View

In the workflow editor, you can see your file(s)  going from step to step, with their processing Phase
displayed in blue text.

Note:  This icon  can represent a single file or a collection of related files.

•
Click  to see the Details of the main workflow task (names of output files, stranded files,
reading of workflow parameters...).

Tip:  If you want the details of a specific workflow step, then first select one of the output files of
that step and then right-click and choose Details.

•
Click  to see the To Do Action items associated with this workflow.

Output Pins and Widgets

A number in the output pin of a step indicates the number of files that ran through it.
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Click on the number to open a widget showing the file names.

Inside the widget, right-click the name of a file to see more options. Many of these options were
explained in Diagnosing a Workflow in the Tasks Pane on page 1043.

Note:  You can also right-click the icons  of files that are still being processed and get more
options there.

Note:  To check the Workflow Parameter Values of a (collection of) file(s): learn more in Using
Workflow Parameters on page 1065.

Seeing the Followed Path

In an output widget, click on a file name to see which path it followed. In this example we clicked
on lemon_report.pdf. The name is highlighted in blue and the path that this file followed so far
is shown in yellow.

Seeing the Related Files
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Clicking on a file name also helps diagnosing the relations between files. In below example we clicked
on lemon.pdf in the 'Error' widget. This highlights all related files in a light blue color. These relations
were created during their processing.

Note:  Files that are related to each other in a workflow will also share the same workflow parameters
at that specific step of the workflow. Learn more in Using Workflow Parameters on page 1065.

Diagnosing an Error

In below example, we right-clicked on a file in the 'Error' widget and asked the Open Details .... This
explains the error: the zip was not created because it already exists (and the ticket had the setting
to fail in that case). Sometimes, you will need to Open Log ...  to find what you are looking for.

Details is meant for the user and is translated. Log info is mainly for Esko service people, it is more
complex and not translated.

In this example, you could now continue with these steps:

1.
Click on  to edit the workflow.
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2. Double click the Zip task, change the setting that generated the error and click OK to confirm
and close the ticket.

3.
Launch this changed workflow: click  or press Alt and click .

4. If you prefer this new setting, save your workflow.

Error Files or Invalid Files

See the open widgets of this example workflow:

• In the widget of the Start step, broccoli.pdf and Presentation.pptx are shown in grey
because they are not valid for the next step in the workflow.

• broccoli.pdf is invalid because it has a size of 0 Kb.

• Presentation.pptx is a PowerPoint file and that is not a valid input file type for the next
step.

Note:  Both file names would be shown in black when the next step would for example be a Copy
or Move File task.

• banana.pdf and lemon.pdf are valid PDFs.

• Sprouts.pdf: based on its extension '.pdf', the file was valid for the next step but it still resulted
in an error (the task detected that the file was not really a PDF file).

6.4.9 Pausing or Cancelling Your Workflow

While monitoring your file’s progress in the workflow editor, you can:

•
click  to pause your workflow (at the end of the task that is currently running),

•
click  to make your paused workflow run again,

•
click  to cancel your workflow’s processing.
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6.5 Using Public Parameters in Workflows

Note:  Public Parameters are not only available for Workflows but also for single Task Tickets. This
is documented in Using Public Parameters  on page 68. We here only add the specifics about using
public parameters in workflows.

6.5.1 Concept

Most Task Tickets offer many settings ('parameters'). And Workflows can be quite complex
combinations of many such Tickets. That is why, when an administrator creates a workflow, it can
be useful to not show this whole complexity to every day users of those workflows.

This can be done by making only some parameters public. Thus, the daily user can only see and
modify a limited set of parameters that he understands and is allowed to change.

For example:

A user wants to launch a workflow and needs to check or change only a few settings. Instead of
having him open the workflow and open several steps to change only 5 parameters, you offer him
this simple dialog, where he is asked to define the 5 parameters that you made public to him:

When the user presses OK, the workflow starts and uses the chosen settings.

Available from many Client Applications

This functionality is available for users launching workflows from these applications that have a
connection with the Automation Engine server:

• Automation Engine Shuttle
• Automation Engine Pilot
• ArtPro, Neo
• PackEdge, Plato, FastImpose
• DeskPack (Adobe Illustrator)
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Important:

• Client applications only show Public tickets and workflows, no matter what user is logged in. In
other words, they only show the same list of tickets that a user sees who does not have the User
Access Right "Tickets: Show all Tickets and their Parameters (Public and other)".

• If those public tickets and workflows do not have any public parameters, the user will not be
able to open them to change any parameters. They will be launched right after he selected the
(workflow) ticket.

Preference to have the Pilot show Only Public Parameters

In the Pilot, in  Edit > Preferences  the option Show only Public Parameters in Tickets can help
you prevent users from opening workflows in the workflow editor and so having access to all settings.

• When this option is not checked, users will be able to open workflow tickets and see all steps and
settings. If they can make changes and save the ticket depends on their User Access Rights.

• When this option is checked, a users that opens a workflow ticket will only be shown a dialog
with the public parameters of that workflow. When that workflow has no public parameters, the
user will see this dialog:

About Public Parameters in a Workflow Ticket that is Not Public

It is possible to set public parameters in a workflow ticket that is not saved as public. This can be
useful when the non public workflow ticket is referenced inside a master workflow that is public.
The public parameters of the referenced subworkflow will show up in the list of public parameters
of the master workflow.

6.5.2 Creating Public Parameters in a Workflow
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Creating public parameters in a workflow is very similar to creating them for a single task ticket, as
explained in Making a Parameter Public on page 69.

A summary:

1. In the workflow editor, select a step and open the ticket.
2. Right-click the parameter you want to make public and choose Make Parameter Public.

We here right-clicked in the field for Trapping Distance:

Note:  Not all parameters of all tickets can be made public.

3. Right-click the same parameter again and choose Modify Public Parameter.... Decide here if
you want the parameter to be a free or predefined value.

Note:  You can also skip this step and later manage this and all other public parameters in the
Manage Public Parameters dialog. You can also use both dialogs.

4. Save your ticket to also save these changes to your public parameters.

Note:  Public parameters belonging to steps that you later deleted from the workflow are not
removed. You can remove them using the Manage Public Parameters dialog.

Next step is to manage the workflow parameters in a special dialog where you will define more
precisely how they will present themselves to the user.

6.5.3 Managing Public Parameters in a Workflow

Once you have made parameters public in your workflow steps, you can open the Manage Public
Parameters dialog to get an overview and make changes.

1. In the workflow editor, go to  Advanced > Manage Public Parameters...
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The dialog shows all public parameters of this workflow, sorted by workflow step:

• The left pane shows the workflow steps for which you have made parameters public.

• The middle pane shows the public parameters of the workflow step that was selected on the
left. They are greyed out when they are already used in the right pane. When parameters are
not used in the right pane, they will not be public parameters.

• The right pane shows all the public parameters in detail (name, type of value, etc.). They are
default organized in Groups matching the (custom) name of the step where they came from.
This is where you build the dialog that the users will see and use to decide the values before
launching the workflow.

To help you trace their origin, selecting items in the panels also shows selections of related items
in the other panels.

2. You can

• drag parameters from the middle to the right pane to make them public. For example dragging
the parameter Trapping Distance into the group "background trapping".

• click on  to remove the parameter or group from the right pane. It will then not be public
anymore.

• re-arrange the order of your public parameters or groups (drag them up or down).
• click on  to change the default name of the group.
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• change the settings of the public parameters. Define in Prompt as is what the user will see.
Instead of Allowing the user to set a value, you can offer the user a choice of predefined
values.

In below example the user will get a dropdown to choose between Flexo normal and Flexo
large. The user making this choice when launching the workflow will not see the actual values
of 0,2 and 0,3 mm.

Learn more about editing and re-designing this pane in Making Presets to Simplify the Users’ Choices
on page 72 and Example of Further Customizing the Public Parameters Dialog  on page 1058.

6.5.4 Making Presets to Simplify the Users’ Choices

Presets are custom combinations of parameters. They simplify the choice users have to make. They
limit the amount of decisions that users have to make.

Example

For example, you want users to use different trapping settings when printing offset versus dry offset.
You can define those trapping settings in a preset, so that users will only have to choose between
'offset' and 'dry offset'.

We start from a Manage Public Parameters dialog where the trapping step has 3 public parameters:
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1. Click on  to remove the (default) Group named "Trap with PowerTrapper"

2. Press the Add Group button.

A new "Untitled Group" is created. Click on  to change the name.

3. Press the Add Preset button.

A new "Preset" is created. Click on  to change the name.

By default, two example values will appear. the preset was renamed to 'Choosing Process
to Decide Traps'.

4. Define what the users will see:

a) in Prompt as, enter the text that users will see in the client application (replacing 'Type the
name of the preset here (e.g. “Paper Size”)').

b) enter the values that the users will choose from (replacing 'Type a value here (e.g.
A4)'). We here added 'Offset' and 'Dry Offset'.

Click Add if you want to add extra values (not the case in our example).

5. Drag the parameters from the dialog’s middle pane onto one preset item. This will make them
automatically appear under each preset item (here both under Offset and Dry Offset).
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6. Define the parameters values for each preset item.

See the above screenshot for a good example.

7. Click OK to confirm and close the dialog.

8. Save your ticket.
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Result: this is how the resulting dialog will look like to the users of the client applications:

6.5.5 Example of Further Customizing the Public Parameters Dialog

In this example, we further customize the public parameters dialog by reorganizing the Groups and
adding a Preset to combine parameters.

Step 1 - Example Workflow and its Initial Public Parameters Dialog

This is our example workflow:

We created public parameters in 4 steps. This is the initial Manage Public Parameters dialog, where
the groups match the workflow steps:

If you don't customize this, the resulting dialog, that will be shown to the users launching a task,
will look like this:



6
Automation Engine

1059

In this dialog, you can see

• that the items on the left pane of this dialog match the groups in the Manage Public Parameters
dialog.

• that when there are multiple groups, an extra one named 'All' is automatically created. This
group offers all parameters together.

• that the parameter 'Trap size' is offered as a choice of presets. This was illustrated earlier.

In the next steps we will further optimize this dialog for the end user.

Step 2 - Customizing the Groups and the Text that the User will See

• In the group "check file",

• rename the group to "Who to Check",

• change Prompt as to 'User to Check the File in Editor',

• set the Default Predefined Setting to 'Any User'.

• Press Add Group  to created a new group and name it "E-mail to Customer" .
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• In the right pane, drag the parameters from the groups "Export to PDF File" and "Send
E-mail" into this new group.

Tip:  You can press Shift to select and drag multiple parameters.

• Remove these two groups that are now empty: "Export to PDF File" and "Send E-
mail". This is the result:

Note:  An alternative way to do this, is to first delete the 2 groups, then create the new one
and then drag the 5 parameters from the middle pane into the new group.

Step 3 - Adding a Preset and Combining Parameters

In the new Group "E-mail to Customer", we now combine 2 parameters into a new Preset:

• Press Add Preset. A new preset appears at the bottom of the bottom group. Rename it to 'PDF
pixel version'.

• Set the Prompt As to 'Convert to Image'

• Press Add to add a third parameter and rename the 3 parameters to 'No', 'Yes (304 ppi)'
and 'Yes (120 ppi)'.

• Drag the parameters 'Output as Image' and 'Rasterization Resolution' onto the first
value of this new preset.

• Adapt the parameter values as shown in this screenshot:
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For the user launching the workflow, the resulting dialog already looks a bit simpler:
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In this example, the list of parameters is not that long. That is why you could also decide to only
offer the All view in this dialog. You can do this easily by moving all parameters into one group. The
result can look like this:

Note:  Many tasks have Tickets with a conditional user interface: where settings depend on another
setting. For example settings that only become available after you first make another choice.
Example: 'Apply color conversion?' If 'Yes', then there is the choice 'Convert to CMYK'
or 'Convert to RGB'.

These kind of conditions can not be created in the Manage Public Parameters dialog. If you wish to
recreate such a user decision, you have to create a preset that offers a choice for each combination.
In our example this would mean a dropdown list with these 3 choices: 'No color conversion',
'Convert to CMYK' and 'Convert to RGB'.

6.5.6 Launching a Workflow with Public Parameters

Launching a workflow with public parameters is very similar to how it is done with single task tickets.

Learn more about all variants of launching workflows from Shuttle client applications in Using Shuttle
to Upload and Process Files on page 47.

Here are some examples:

Example when launching from Shuttle:

Drop the input file on the workflow in the Launch panel.
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If you drop a file on the launch field of a workflow that has public parameters, a dialog will open
asking you to decide these public parameters:

Click Launch when ready.

Example when launching from PackEdge:

Choose  File >  Launch Workflow  from the menu, select the workflow, decide the public parameters
and press Launch.
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Example when launching from ArtPro

In the Launch Workflow dialog, ArtPro offers extra functionality to convert the ArtPro file before
it enters the workflow and to set a Job or Product context (which is important when using
SmartNames).



6
Automation Engine

1065

6.6 Using Workflow Parameters

6.6.1 Concept

Workflow Parameters are parameters that are specific for a workflow. Their values are picked up
by steps in the workflow.

For example: you print displays and you mostly use the same output workflow. Your workflow
ticket has 3 workflow parameters: substrate, sheet size and quantity. The values of these
parameters can be typed in by a user or can be picked up from an external source.

Workflow parameters show up as SmartNames starting with [wfp. ]. Much like Job and Product
parameters, you can use them by inserting them in the SmartName enabled field in your workflow
steps.

In many cases, you could accomplish the same by using Job or Product parameters, but some
Automation Engine customers choose to not use the Jobs or Products concept.

Workflow Parameters are Loaded at Workflow Start-Up, but can Change Later
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Workflow parameters and their values are loaded when the workflow starts up. However they can
change during the workflow. This can happen via a user intervention or more automated steps. Learn
more in reading their value from an XML file and in modifying workflow parameters during a workflow.

Managing Workflow Parameters

In the workflow editor, go to  Advanced / Tools > Manage Workflow Parameters... .

• The Manage Workflow Parameters dialog is where you Add, Remove and Edit workflow
parameters.

• This dialog lists all the workflow parameters defined in the current workflow and all of its
subworkflows.

Note:  If you are in a subworkflow, the workflow parameters defined in the master workflow will
not be shown in this dialog.

• You can keep this dialog open while making changes in the current or subworkflow(s) and while
navigating to and from subworkflows. The list of workflow parameters is instantly updated to
reflect changes.

Workflow Parameters can be Different per Group of Files

Workflow parameters do not have to be valid for all files in that workflow, they can be different per
file or per group of files.

For example: the banana and lemon displays share the same substrate and sheet size, but
have a different value for the parameter quantity.

Workflow parameters are valid for one file or for a group of files. You can see such grouping of files
when you open a Widget and select an item in its list. This will not only highlight the selected item
(in blue) but also the other items belonging to that group (in light blue). Such a group is sometimes
referred to as a "Token", it can represent 1 or more items.

For example: when you select lemon.pdf, lemon_report.pdf also gets highlighted. This means
that they belong together in a group. This means that they share the same workflow parameters (at
that point in the workflow).
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These groups are created automatically by the file management logic in the workflow steps. However,
sometimes a setting lets you decide how these groups need to be created. A typical example is the
Data Collector on page 1029.

When you right-click on an item in a widget and select Workflow Parameter Values, you will see
the values for that group of files at that point in the workflow. An example:

Workflow Parameters versus Public Parameters

Public Parameters serve to simplify the decisions users have to make when they launch workflows
from client applications. Workflow Parameters serve to make your workflow more automated.

Workflow parameters are also SmartNames, public parameters are not.

In the Manage Public parameters dialog that is shown to the user launching the workflow, workflow
parameters show up as a separate parameter group named Workflow Parameters:

You can easily remove workflow parameters from the list of public parameters using the Manage
Public Parameters dialog. Learn more about public parameters in Using Public Parameters in
Workflows on page 1051.

Note:  There is an exception: if you use workflow parameters values from an XML file, the workflow
parameters will not be public.

6.6.2 Most Typical Use Cases for Using Workflow Parameters

1. Automating workflows by Loading Workflow Parameters from an XML file

This is the case where the order management or production planning system sends Automation
Engine an XML with the details of the output workflow. These production specifics are automatically
picked up and serve as parameters for the workflow. Learn more in Using Workflow Parameter Values
from XML  on page 1072.
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2. Using Workflow Parameters as a Smart Public Parameter

When users enter the value of workflow parameters manually, it usually resembles the case of a using
public parameters, but then also taking advantage of the referencing power of a SmartName.

For example:

Your users need to decide if the workflow is flexo or digital. You want them to answer this one
question as a public parameter:

This is only 1 question but we will use the answer for 3 different decisions in our workflow, once in
each of below workflow steps:

Here is an example how this can be done. We also illustrate two different levels of complexity:

• You use the value of the workflow parameter as text. For example the Preflight task, depending
on the user's answer, uses the profile flexo.ppp or digital.ppp . In this case you pick up
the workflow parameter as a SmartName:

In the same way, the ReportMaker task uses flexo.pdf  or digital.pdf as template. One
decision from the user so already decided values in 2 tickets.

• You can also use value of the workflow parameter inside another SmartName. For example
this conditional SmartName to define the trapping distance:
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You then use that conditional SmartName in the trapping task:

In this example, when you do not use a workflow parameter, the user launching the task would have
to decide 3 different public parameters. Now, the user is only asked 1 decision.

6.6.3 Creating Workflow Parameters Manually

Follow these steps to create workflow parameters manually:

1. Open the (sub)workflow in the workflow editor.

2. Open  Advanced / Tools  > Manage Workflow Parameters... .

3. In the Manage Workflow Parameters, click on Add and fill in the Name and Value.

Note:  You can leave the value empty at this time. The value has to be defined at the latest by
the time the workflow is launched (for example when a user who launches the workflow fills in
the value in the dialog of public parameters).

In the dialog, the column Workflow shows if the workflow parameter is present in the current
workflow or was created in a subworkflow.
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Note:  If you need to add many workflow parameters and if their names are already present in an
XML file, you can load that list of names by using the button Load Workflow Parameters from
XML.... Learn more here.

4. Save your workflow to also save your workflow parameters.

6.6.4 Loading Workflow Parameters from XML

Instead of typing them in manually, you can load Workflow Parameters from a XML file. You can
select all parameters from the XML file or only those of a specific XML Element. After loading them,
you can keep the values that came from the XML file or change them.

This is an example of a valid XML file:

Follow these steps to load only the items of the XML Element 'production' :

1. Open the (sub)workflow in the workflow editor.

2. Open  Advanced / Tools  > Manage Workflow Parameters... .

3. Click Load Workflow Parameters from XML....
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4. Browse to the XML file, select it and click Open.
A dialog pops up asking you to specify an XML Element or to leave the field blank to select all
items in the Root Element of the XML file.

5. In that dialog, type in the element name production and click OK to confirm.
This will load these workflow parameters:

6. If you want you can make any modifications like changing a value or even removing a parameter.

In our example, we don't need the parameter 'finishing' so we can remove it.

7. Save your workflow to also save your workflow parameters.

6.6.5 Using Workflow Parameters

Once you have created them, you use the workflow parameters by picking up their SmartName
version in the workflow step ticket.

1. Open the (sub)workflow in the workflow editor.

2. Double-click the ticket in which you want to use a workflow parameter.

3. Click on  in the SmartName-enabled field where you want to add the workflow parameter.
In the SmartNames Browser, select the Category 'Workflow Parameters'
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4. Select the workflow parameter [wfp. ] that you want and click Insert (or double-click) to add
it to the ticket.

5. Click OK to confirm and close the ticket.

6. Save your workflow.

6.6.6 Using Workflow Parameter Values from XML

Workflow parameters and their values can be defined by an XML file.

This is an example of a valid XML file:

In this concept, there are 2 differences versus creating workflow parameters manually or loading
them once from an XML:

• the workflow will load and re-read this XML file at every step of the workflow. This also means

• that you will probably not use the step Modify Workflow Parameter Values in this workflow
because its modifications would be overruled.

• that, during the workflow, the XML file can be updated with new or changed values.

• the resulting workflow parameters will not be public parameters. The concept here is that it is not
a user who decides the values, but an XML file.

Example

Follow these steps to set up a workflow where workflow parameters values are used from an XML file:
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Attention:  Before we can ask a workflow to use the XML file, we first have to insert the
workflow parameters as [wfp. ] SmartNames into the workflow step tickets. To be able to
do that, we will first load a sample of that XML and so create these required SmartNames first.

1. Open the (sub)workflow in the workflow editor.

2. Open  Advanced / Tools  > Manage Workflow Parameters... .

3. Click Load Workflow Parameters from XML.... Browse to your sample XML file, select it and
click Open.
A dialog pops up asking you to specify an XML Element or to leave the field blank to select all
items in the Root Element of the XML file.

4. Using the example XML mentioned in Loading Workflow Parameters from XML, type in the
element production in that dialog and click OK to confirm.
This will load these workflow parameters and create a [wfp. ] SmartName of each of them:

5. From that list, remove any parameters that you will not be using.

Note:

• The Values in this list will not be used anyway, they will come from the XML file (see step 7).

• The Names in this list are the basis for the [wfp. ] SmartNames. So do not delete them if
you need the SmartName version.

6. Use the resulting SmartNames in your workflow step tickets (as shown in Using Workflow
Parameters on page 1071).
An example:
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7. In the Manage Workflow Parameters dialog, check Use values from XML file. You will be asked
to confirm this step. Click OK.

8. Select the XML file using Browse or use SmartNames. This is the place and name that the
workflow will look for at the start of every step of the workflow.

9. Save your workflow to also save this setup of your workflow parameters.

6.6.7 Changing the Value of a Workflow Parameter

You can easily change the value of a workflow parameter by using the Edit or  (Mac) button in
the Manage Workflow Parameters dialog.

When would you change the value of a workflow parameter?

When you are testing a workflow while staying in the workflow editor. You edit the parameter value,

relaunch the workflow (  ) and monitor the result.

Tip:  When using values from an XML file, some administrators use this "edit and test" method to
learn how the XML file should look like.

Changing the value of a workflow parameter from a referenced subworkflow

If you edit the value of a workflow parameter that is defined in a referenced workflow, its value will be
overruled with the new value without changing that value in the referenced workflow. In the Manage
Workflow Parameters dialog, a pencil icon  will appear next to the workflow parameter that was
overruled.

For example, our workflow named Check Trap Proof Flatbed has a referenced subworkflow
named SUBWFL Approval in which a workflow parameter ApprovalType has the value
WebCenter:
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When you now edit this value, for example into hard copy proof, this icon  will appear next to
the value to indicate that this parameter was overruled:

6.6.8 Modifying Workflow Parameters During a Workflow

The Value of a workflow parameter can be modified while the workflow is running. This can be done
because

• the value changed or was empty before and has now 'arrived'. This change can be decided by
a user or by an XML file from an external system.

• the new value did not exist yet because it is based on an result of a previous workflow step.

These workflow steps can modify workflow parameters:

• The workflow control Modify Workflow Parameter Values. Learn more in Modify Workflow
Parameter Values on page 1015.

• The Integrate with WebCenter task.

• The Create or Modify WebCenter Project task.

• The Publish on WebCenter task.

These WebCenter related tasks are then part of workflows that use the result of their interaction with
WebCenter as a workflow parameter value in one of the next steps of that workflow.

Using the Integrate with WebCenter task

Some Actions in the Integrate with WebCenter task allow you to use the output of the Action to
modify the value of a workflow parameter.

To do this, you need to Map one of the task's Output Parameters to a workflow parameter.

For example, a workflow asks WebCenter what the approval status is of a document and then uses
that status information in the next part of the workflow:

1. In the workflow editor, in the Integrate with WebCenter ticket, select an Action. For example
'Get Document History'.

2. Click on the Tools icon  and choose Map Output Parameters.... A dialog will open.
3. Double-click an Output Parameter. For example Document approval status.
4. Define to which workflow parameter this Output Parameter needs to be mapped to. Select it

from the dropdown list or from the SmartNames Browser or type in a (new) name. If the workflow
parameter does not exist yet, you will be asked to confirm its creation.
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Learn more about the Integrate with WebCenter task here.

Using the Create or Modify WebCenter Project Task

The Create or Modify WebCenter Project task allows you to modify the value of a workflow
parameter with the value of the Project ID of that WebCenter Project.

To map the Project ID to a workflow parameter, use the same Map Output Parameters dialog as
explained in the previous section.

For example, you did not create the WebCenter project but you want to know the ID of this project
because you will publish data to that project later in your workflow.

Learn more about the Create or Modify WebCenter Project task here.

Using the Publish on WebCenter Task

The Publish on WebCenter task allows you to modify the value of a specific workflow parameter
with the value of the Document Version ID of the published document in WebCenter.

To map the Document Version ID to a specific workflow parameter, use the Map Output
Parameters dialog, as explained above.

For example:

You use WebCenter in your approval workflow. You have already published your production PDF
twice to WebCenter and the customer still wants changes. You make more changes and as usual
overwrite the PDF before publishing again to WebCenter.

Now the customer checks this 3rd version and changes his mind: he says that he liked version 2
better. This is a problem because nobody has version 2 any more. Remember that the document
versions that WebCenter keeps are versions of only the View Data.

This can be solved when, after publishing your PDF, you ask WebCenter the document version ID
and then make a copy of your production file and add that version number in its name. In this way,
you also keep versions of your production PDFs.

Learn more about the Publish on WebCenter task here.

6.7 Sample Workflows

You can download sample workflows from your Automation Engine server. You can use these

• to learn good practices in building workflows
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• as starting points when building your own workflows, rather than starting from scratch.

The sample workflows are categorized per market segment.

The installation will also install the required resources like input files, SmartNames, templates etc.

Installing Sample Workflows

1. Browse to the Server Admin page via http://servername or http://servername:9999/ .
2. Click on Samples.
3. Click on the Install button next to the desired market segment.

The Install button will not be available when you haven't logged in and 'unlocked' this feature.

Click, at the bottom of the page, on  and confirm your credentials. This will unlock this feature
and make the Install button available.

Important:  These sample workflows are hosted on https://mysoftware.esko.com/. If no Internet
connection is available while trying to install the sample workflows, an error message appears.

Caution:  The installation of sample workflows will overwrite any workflows that were
previously installed (for that same market segment). Any changes you made to those
sample workflows will then be lost. Therefore, we advise to make a copy of the sample
workflow in case you really wish to use it.

Tip:  Click the link in the market segment description to read more about the workflow and to
watch a video tutorial (if available).

4. Your Tickets View will show the resulting sample workflows:

https://mysoftware.esko.com/
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Sample input files and Job folders will be created in /ExampleJobContainer/Sample
Workflows .

5. Rename the sample workflow, to avoid losing any changes.

6.8 Automated Launching of Workflows

These tools allow to launch workflows automatically:

• Access Points launch a workflow after they detected a signal from 'outside'. There are 5 types of
Access Points. The Folder Access Point is the most classic example and is also often referred to
as a 'hot folder'. Access Points have their own View in the Pilot.

Learn more in Access Points on page 1236.

• WebCenter can also launch workflows on Automation Engine (when they are in the same LAN).
WebCenter can do this as a specific step in its own workflow, there called 'Submit Workflow'.

Learn more in the WebCenter documentation. Here is a direct link to this specific topic (in v14.0).

• Some external systems can launch a workflow on Automation Engine via JDF or JMF commands.
Although most of this functionality is also available through use of XML, some MIS vendors prefer
to use JDF/JMF because of specific additional features.

Learn more in What about JDF? on page 1230.

6.9 Migrating Old Task Chains

Old Workflow Technology

The Esko product BackStage, a predecessor of Automation Engine, had a limited workflow
technology where workflows were only linear and were named Task Chains.

For example:

http://help.esko.com/products/WebCenter
http://help.esko.com/docs/en-us/webcenter/14/quickstartguide/en-us/common/wc/reference/re_wc_SubmitWFNode.html
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If you still have such task chains, they will still work but Esko strongly advises to migrate them to
Automation Engine Workflows. See below how to do this.

Note:  Depending on your version and configuration, it is still possible that your Automation Engine
offers some task chains by default. Page printing workflows still offer Export to PDF File Chain
(Mark as Proof) and Publish Imposition on WebCenter Chain as chains of multiple steps. Also,
a 'FlexRip plus InkPlanner Chain' ticket is still available (until you can add it to a workflow with an
Imaging Engine step).

Migrating old Task Chains to new Workflows

You can not automatically convert task chain tickets into workflow tickets, but the workflow editor
offers a tool that helps you migrating a task chain to a workflow that will keep all your settings.

Follow these steps to migrate a task chain to a workflow:

1. In the Pilot, click on  New Workflow.
2. In the workflow editor, in the Tasks pane, select your task chain ticket.
3. Drag and drop your task chain ticket into the top part of the workflow editor window. A grey area

will appear, showing you a message where to drop the ticket.

4. This starts a conversion tool that extracts all compatible steps:
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• Each extracted step keeps all of its ticket settings.
• The step is named after the name of the task chain.
• The steps are not connected. You are invited to optimize your workflow construction. There

may be better ways to build your workflow in the current version.

Note:  When the chain contains deprecated steps, a warning appears:

When you click OK, the chain is migrated but the deprecated step will disappear after a few
seconds. This means that you should replace that step with a corresponding step that is available

in your current version. For example you should replace the old Mark File  by Mark .

5. Based on these extracted steps, build your new workflow.

In below example we removed the old Export to PDF step because this functionality is now
available on board the ReportMaker ticket:

6. Save your new workflow.
7. Test it and, when ready, delete the old task chain from your list of Tickets.
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7. Working with Gang Run Printing

7.1 What is Gang Run Printing?

Gang Run Printing enables you to efficiently match graphic designs to be printed with the available
substrate (to have as little substrate waste as possible and faster turnaround), with:

• Nesting,

• Ganging,

• Tiling.

This is especially useful when printing Sign and Display material and for shorter production runs.

It takes into account the designs' sizes, shapes and ordered quantities to produce layouts on
substrate sheets.

7.1.1 Nesting

Nesting is laying out several graphic files in the most efficient way so that waste is minimized.

When working with non-rectangular graphics, their bounding boxes may overlap in the layout.
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For more information about nesting in Gang Run Printing, see Creating Nested Layouts on the Nesting
Server on page 1087.

7.1.2 Ganging

Ganging is combining several different graphic files, in one print job, even if those files belong to
several orders (for example if one order doesn't fill a whole substrate sheet).
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This helps drive production costs down and helps you offer a competitive price to your customers.

7.1.3 Tiling

Tiling is splitting oversize graphics, used for example for billboards, into rectangular pieces (tiles) for
printing. These tiles can then be glued together.



7
Automation Engine

1084

When printing the tiles, Gang Run Printing can nest them to get the most efficient layout.

7.1.4 Manual or Automated Gang Run Printing

• In i-cut Layout, you can perform manual Gang Run Printing: selecting and preparing each graphic
individually, then finding layouts (the most efficient layouts are calculated automatically).

When working manually in i-cut Layout, you can tweak the results if necessary. See the i-cut
Layout manual for more information.

• In Automation Engine, you can automate the graphics selection and preparation too.

You can also submit your graphics for nesting on your chosen substrate, and manage your
substrate queues.

When working automatically in Automation Engine, you can process more graphics in parallel, and
you don't need an operator to keep checking when to generate layouts (this is done automatically).

7.2 Working with Gang Run Printing

Here is an overview of how you can work with the Gang Run Printing module.

1. You first prepare your graphics and submit them to be nested on a particular substrate, in your
chosen quantity.
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You do this through an input workflow, that should contain the Prepare Graphics for Nesting
and the Submit to Gang Run tasks.

See Preparing and Submitting your Graphics (Input Workflow) on page 1085.

2. Once the graphics are submitted, they go in a substrate queue, and the nesting server
calculates the best possible nested layouts, based on the sheet sizes and nesting parameters
you defined.

See Creating Nested Layouts on the Nesting Server on page 1087.

3. Once the nesting server has found one or more optimal nested layouts, it delivers them to your
output workflow, that creates production files (layout files and cut files).

The output workflow must contain the Export Nested Layouts task. You can set this workflow
to copy the production files to a specific folder and/or send the files to a press.

See Getting Production Files out of your Nested Layouts (Output Workflow) on page 1090.

7.2.1 Preparing and Submitting your Graphics (Input Workflow)

Preparing your Graphics

Before sending your graphics to be nested on the substrate of your choice, you need to make sure
they have at least a cut path. You may also want to add bleed and SmartMarks.

You can use the Prepare Graphics for Nesting task to identify or extract a cut path from your
graphic, and if necessary to add bleed and SmartMarks to it.

For more information about specific task parameters, please see Prepare Graphics for Nesting on
page 1100.

Identifying or Extracting a Cut Path

Your graphics must have a cut path as they will be nested based on their cut path.

For example, cardboard cut-outs of a tree (as below left) will be nested and cut differently than
postcards of a tree (as below right).

Depending on the case, your tree graphic will need a different cut path (shown in red).



7
Automation Engine

1086

The cut path is typically provided in the file as a contour line in a spot color.

For graphics that don't already contain a cut path, you can generate one from the white background,
the trim box, or a separate file.

Adding Bleed

If your file doesn't already have bleed outside the cut path or trim box, you can generate some in
the Prepare Graphics for Nesting task.

Adding SmartMarks

SmartMarks are marks that automatically update based on changes to the sheet size, the number
of inks on the sheet, etc. You can use them as regular marks or as production controls.

There are many types of SmartMarks (registration marks, barcodes, text, placeholders for eyelets...).

You typically add SmartMarks to your nested layout in your output workflow (mostly for cutting the
sheet), but in some cases you need to add some SmartMarks to your graphic in your input workflow.

For example:

• You can add eyelet marks to a graphic that will be used for a large eyeleted banner. You need to
add the eyelet marks before tiling the graphic to fit the substrate.

• When defining the cut path in the input workflow, you can add text on this cut path for easy
processing after cutting (for example to indicate the job and customer reference, or the order the
tiles must be glued in...).

Tiling Oversize Graphics

In case the substrate size is smaller than the final printed object (for example when printing
billboards), you can split the graphic into rectangular tiles (fitting the substrate size) that can later
be glued together.
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You can do this with the Create Tiles task. This task allows adding overlaps to be able to glue the
tiles on top of each other.

Submitting your Graphics

Once your graphics are ready, you can send them for nesting using the Submit to Gang Run task.

The most important things to define in that task are:

• how many copies of that graphic you want,
• on which substrate (and optionally on which substrate size) you want it printed,
• if you have a specific due date to get that graphic printed.

Note:

Substrates are organized into substrate queues, which not only define the substrate to use but also
how the graphics will be nested.

See Working with Substrate Queues on page 1088 for more information.

7.2.2 Creating Nested Layouts on the Nesting Server

Automatic Calculation of Nested Layouts

Once your graphic(s) arrive in the substrate queue, the nesting server calculates possible layouts to
nest those graphics, together with any graphic(s) already in the queue.

The nesting server tries to find the most optimal layout (or layouts, depending on your graphics)
possible, taking into account these substrate queue settings:

• the nesting settings you set up,

• the different possible substrate sizes (if applicable),

• the minimum fill percentage for that substrate queue.

If the minimum fill is reached, the nesting server sends the layout(s) to the output workflow to generate
production files. All graphics that have been nested in these layouts are then removed from the
substrate queue.
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If it isn’t reached, the graphics stay in the substrate queue until new graphics are submitted to the
queue, at which point the nesting servers calculates possible layouts again.

Outputting a Partial Quantity of a Graphic’s Order

Sometimes the nesting server cannot fit all of the ordered copies of a graphic on layout(s) that satisfy
the substrate queue settings.

In this case, rather than generating an extra layout that does not satisfy the minimum fill, the nesting
server only outputs the quantity that does fit on the optimal layouts.

For example, if 10 copies of a graphic are ordered but only 8 fit on a layout satisfying the minimum
fill, the nesting server does not generate a layout with only the remaining 2 copies. They will stay
in the substrate queue.

Once new graphics are submitted to the queue, the nesting server will try to generate a nested layout
containing the remaining 2 copies and the new graphics.

Generating Nested Layouts in Time for the Due Date

As your customers expect their printed goods to be delivered on a certain date, sometimes you
cannot wait for the minimum fill to be reached. In this case, you can either:

• manually force a layout to be generated from the urgent graphics,
• enter a due date when submitting these graphics. The graphics will then be force-nested in time

for that due date.

In both cases the nesting server generates a layout ignoring the minimum fill. However, it may also
use other graphics from the queue in the layout to still raise the substrate’s fill percentage.

Working with Substrate Queues

A substrate queue acts like a printer queue to which you can send jobs you want to nest and print
on a particular substrate.

Substrate Queues Based on Material Types

For each type of substrate material you have in your stock, you should have a substrate queue.

For example:

In your stock you have 2 piles of PVC substrates:

• Thickness 3 mm
• Thickness 5 mm

For this stock you should set up 2 substrate queues:
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• PVC 3mm
• PVC 5mm

Substrate Queues Based on Nesting Settings

It can also be useful to define substrate queues based on how the graphics will be nested and printed.

• If you have an expensive substrate, you can set the nesting server to always nest the graphics
so that the substrate waste is minimal.

• If your graphics need to be nested on a material that will be printed in offset, you could aim for
less plates (so less layouts) at the cost of extra waste.

So if some graphics needs to be nested differently (even if it is on the same material), you might need
to create a different substrate queue for each type of printing/processing.

For example:

In your stock you have a pile of 250 g/m cardboard both for business cards and door hanger orders.

Business cards and door hangers will be cut differently:

• business card will be cut by a paper guillotine,
• door hangers will be cut on a cutting table.

The way graphics are cut influences the way they need to be nested. Since nesting settings are
attached to a substrate queue, you need different substrate queues.

In this case you should set up 2 substrate queues:

• Cardboard for Business Cards
• Cardboard for Door Hangers

Grouping Certain Graphics Together

In certain cases, you don’t want to group certain graphics on the same nested layout, even when
they are to be printed on the same substrate or using the same printer.

For example you do not want to mix graphics that need varnishing with normal graphics, or you do
not want to mix graphics from different customers.

In this case you do not necessarily need to set up separate substrate queues for graphics to be
nested separately, but you can use grouping keys when submitting the graphics.

Even when submitting them to the same substrate queue, the nesting server will only nest graphics
that have the same grouping key together.

For example:

In your stock you have 1 pile of 220 gsm photo paper. Depending on the order, some graphics printed
on this paper need to be laminated, some don’t.

In this case you only need to set up 1 substrate queue, for both regular and laminated graphics.

You can use a grouping key called “Lamination”, with the values “Yes” or “No”, to prevent laminated
graphics being mixed with normal graphics.

Substrate Sheet Sizes

If you have a substrate material in several sheet sizes, you can add these sizes to the substrate
queue for that material.

For example:
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In your stock you have 3 piles of substrates:

• 1 pile of cardboard 2000x1000m
• 1 pile of cardboard 750x1200mm
• 1 pile of polystyrene 750x1200mm

For this stock you should set up 2 substrate queues:

• Cardboard (with 2 substrate sizes)
• Polystyrene (with 1 substrate size)

Substrate Rolls

If you are working with substrate rolls, you can still use Gang Run Printing: you can define your sheets
sizes based on your roll's dimensions.

Keeping Track of your Stock

If desired, you can keep track of your stock of each different sheet size.

You indicate the quantity of sheets you have in that size, and every time the nesting server uses that
sheet size for a nested layout, it will be subtracted from the available quantity.

Substrate Offcuts

The nesting server always tries to produce sheets with as little waste as possible. However, an
approaching due date might force you to produce a sheet that has a significant portion of waste that
could actually be re-used.

You can bring those rectangular leftovers (also called offcuts) back into circulation, by adding them
to the substrate queue as a smaller sheet size, together with their quantity.

7.2.3 Getting Production Files out of your Nested Layouts (Output
Workflow)

Every substrate queue is linked to an output workflow. You can build this workflow to your own needs,
but it should at least contain the Export Nested Layouts task.

As soon as the nesting server has found one or more optimal nested layouts for your substrate queue,
it delivers them to its output workflow, which is started automatically.

The output workflow then generates production files:



7
Automation Engine

1091

• A PDF file for the press, containing the nested layout, and marks for printing and cutting, but no
technical inks.

• A CUT file for the cutting table, containing the combined cut path of the nested graphics.
• (Optionally) a nesting report, in PDF format (which can be used as guide by the cutting table

operator) and/or in XML format (which can be used by the MIS for invoicing).

7.3 The Gang Run Printing View

The Gang Run Printing view in the Pilot shows an overview of all graphics that have been submitted
for nesting on each of the available substrates.

1. Substrates available
2. Graphics submitted for nesting on the selected substrate
3. Details of the selected graphic

From this view, you can:

• define substrates and their characteristics,
• have an overview of all graphics submitted to each substrate queue, and their state,
• control the printing flow (for example you can put some graphics on hold, or force-print some

of them).

7.3.1 Working with Substrates

When submitting graphics to be nested on a substrate, the graphics arrive in the corresponding
substrate queue in the Gang Run Printing view.
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In the Substrates list, you can see at a glance how many graphics have been submitted for nesting

on a particular substrate. 

The nesting server then calculates the best possible nested layout(s) for these graphics, based on:

• the graphics quantity ordered,
• the sheet sizes and nesting parameters you defined for your substrate queue.

The substrate queue icon  becomes animated during this calculation.

We strongly recommend you define your substrates queues here before submitting graphics to them.

Note:

If you submit graphics to a substrate queue that is not defined in the Substrates list (by entering
an unknown substrate in the Submit to Gang Run task), this substrate queue will be created
automatically in the Substrates list, but will miss crucial parameters (such as sheet sizes and a link
to an output workflow), so the nesting server won't be able to calculate layouts for it.

You will see a warning sign on the substrate icon  to indicate that the substrate queue isn't
properly configured. In this case, make sure to add the missing parameters.

You can also manage your substrates (edit, duplicate or delete them) from the Gang Run Printing
view.

Adding a Substrate

1. Click the action button  at the bottom of the Substrates list and select New Substrate...

You can also go to  File > New Substrate...  or press Ctrl + N on Windows / Cmd + N on Mac.

2. In the New Substrate dialog, enter the substrate Name.

3. In the Sheet Sizes tab, specify the sheet size(s) your substrate comes in.

Attention:  You need to define at least one sheet size for the substrate, otherwise graphics
sent to this substrate's queue will not be nested and printed.

4. In the Nesting tab, set the nesting settings for your substrate.

Graphics submitted for Gang Run Printing on this substrate will be nested according to these
settings.

5. In the Workflow tab, select the output workflow to launch on the graphics submitted to that
substrate's queue.

Attention:  You must link an output workflow to your substrate, otherwise you won't get
production files for the graphics you submitted to that substrate queue!

6. Click OK to save your substrate.
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Note:

If you save your substrate without having defined all the necessary settings (for example if you haven't
linked a workflow to your substrate), you will get a warning message, and there will be a warning

sign on the substrate icon .

If this is the case, you need to edit your substrate to define the missing settings. When you are done,

you should have a regular substrate icon .

Defining Sheet Sizes

For every sheet size you want to add:

1. Click Add (on Windows) or + (on Mac).

2. In the Add Sheet Size dialog, enter a Name for the sheet size you are adding.

3. In the Size parameters, enter the sheet's width and height.

The units used are those you defined in the Pilot Preferences (in  Edit > Preferences > Units  on
Windows or  Automation Engine > Preferences > Units  on Mac).

4. Enter the Margins to use.

The margins won't contain nested graphics, but can contain marks.

5. If desired, you can keep track of the Stock you have of that sheet size.

To do this, select Use available quantity of and enter the number of sheets you have in that size.

Every time the nesting server uses that sheet size for a nested layout, it will be subtracted from
the available quantity.

Attention:

If you are keeping track of the stock here and the stock reaches 0, the nesting server will
not nest layouts on that sheet size anymore.

This can cause graphics to be stuck in the substrate queue (if this was the only sheet size
defined for that substrate, or you chose to nest the graphics on that sheet size specifically).

When you get more sheets in that size, you should edit the available quantity.

6. Click OK.

Defining Nesting Settings

1. Select the Nesting Type to use for the layout:

• Minimal Waste tries to reduce the waste in material to a minimum in the layouts generated.
• Minimum Layouts aims to generate as few layouts as possible, potentially at the cost of

having some more waste.

Having fewer layouts can reduce setup time, making this option interesting for offset printing.
• Guillotine Cut generates layouts that can be cut on a Guillotine cutting table (which can only

cut in straight edge-to-edge movements).
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This usually reduces the number of cuts per layout but may increase the number of layouts
and the waste.

In the example below, the layout at left cannot be cut on a Guillotine table. A Guillotine nesting
can generate for example the layout at right, which can be guillotine-cut. The graphics that
don't fit on that layout will be placed on another layout.

2. Select the Search Method to use for calculating the layout.

Depending on if you are running a test or processing graphics for production, you can set the
layout search from Very Fast to Slow (Very Accurate) (the faster the search, the less accurate
the result can be).

3. If you want to nest the graphics in the order in which they are coming in, select Respect the
graphics order.

4. Depending on the Nesting Type you selected, you can set extra options:

If you have selected... you can set:

Minimal Waste or Minimum Layouts • the Fill Starting Point on Sheet (where the
first graphic will be placed): at the Top Left,
Top Right, Bottom Left or Bottom Right,

• the Primary Fill Direction (in which
direction the sheet will be filled): Horizontal
or Vertical.

Guillotine Cut the direction of the First Cut: Horizontal,
Vertical or Don't care.

5. If desired, you can add a Gutter in between cut paths (specify the gutter width).

6. If the graphics in your files have a bleed outside the cut path, you can clip it away by entering
the bleed distance into Bleed Clipping Mask.

7. When working with Guillotine Cut, you can choose to allow the nesting server to print a few extra
copies of some of the graphics, so that you have more printed sheets with the same layout.

This reduces the amount of plates needed for offset printing, keeping the costs down.

• If you want to do this, set a Maximum Overrun.
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For example set a Maximum Overrun of 10.0% if you don't mind printing up to 10% more
of some of the graphics to have less layouts.

• If you want to only print the exact ordered quantity of each graphic, and don't mind the number
of layouts, keep the Maximum Overrun at 0.0%.

For example, you need to print 100 "BLUE" graphics and 10 "RED" graphics, on a sheet size
that can fit 10 graphics.

• If you don't allow overrun, you will have 2 layouts:

• A layout with 9 "BLUE" and 1 "RED" graphics, to be printed 10 times (giving 90 "BLUE"
and 10 "RED" graphics).

• A layout with 10 "BLUE" graphics, to be printed 1 time (for the remaining "BLUE" graphics).
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• If you allow a Maximum Overrun of 20.0%, you will have only 1 layout, with 9 "BLUE" and
1 "RED" graphics, to be printed 12 times.

This gives 108 "BLUE" graphics (8% more than ordered) and 12 "RED" graphics (20% more
than ordered).
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8. In Rotation, specify if the task can rotate the graphics in the layout to get a better fit. You can
choose:

• Allow any angle,
• Allow 90 degree,
• Allow 180 degree,
• No rotation.

9. Enter a Minimum Fill if you only want to output the sheet when it's filled to a certain level.

Attention:

Do not put 100% here as only the graphics inside the cut path count as fill. The margins,
gutters etc. all count as waste.

By default, the minimum fill is set to 75%.

Linking a Workflow to Your Substrate

1. Select the output Workflow to launch on the graphics submitted to that substrate's queue.

This output workflow will be launched either:

• when the minimum fill percentage for that substrate is reached,

• in time for the submitted graphics's due date (if they have one),

• when you force print one or more graphics from the substrate queue.

Attention:  You must link an output workflow to your substrate, otherwise you won't get
production files for the graphics you submitted to that substrate queue!

2. If you have set a due date for the graphics to be printed, you can choose to Launch the workflow
automatically a certain number of hours and/or minutes before the due date.

If the workflow hasn't been launched by then (because the minimum fill percentage for that
substrate hasn't been reached), it will be automatically launched at that time (even if the fill
percentage isn't reached).

Editing a Substrate

1. Select the substrate that you want to edit, click the action button  and select Open.

Tip:  You can also go to  File > Open  or press Ctrl + O on Windows / Cmd + O on Mac, or just
double-click the substrate to edit.

2. In the Edit Substrate dialog, you cannot change the substrate Name, but you can edit all the
other settings.

Note:  If you want to change the substrate name, we recommend you duplicate the substrate
under your chosen name, then delete the original substrate.

3. In the Sheet Sizes tab, you can add, modify or delete sheet sizes for the selected substrate.

• to add a sheet size, click Add (on Windows) or + (on Mac) and define the sheet size settings.
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•
to modify a sheet size, select it, click Edit (on Windows) or  (on Mac), and change the
settings as desired.

• to delete a sheet size, select it and click Remove (on Windows) or - (on Mac).

4. In the Nesting tab, you can edit the nesting settings for the substrate.

5. In the Workflow tab, you can link a different workflow to the substrate or change when to launch
it automatically.

6. Click OK to save your changes or Cancel to revert.

Note:  After changing the substrate settings, the nesting server will automatically re-calculate nesting
layouts for the graphics in that substrate queue, even if no new graphic was submitted.

Duplicating a Substrate

1. Select the substrate that you want to duplicate, click the action button  and select
Duplicate....

Tip:  You can also go to  File > Duplicate...  or press Ctrl + D on Windows / Cmd + D on Mac.

2. In the Duplicate Substrate dialog, enter a Name for the new substrate.

3. The substrate settings are the same as the old substrate's, but you can modify them if necessary.

See:

• Defining Sheet Sizes on page 1093

• Defining Nesting Settings on page 1093,

• Linking a Workflow to Your Substrate on page 1097.

4. Click OK to save your new substrate.

Deleting a Substrate

1. Select the substrate that you want to delete, click the action button  and select Delete.

Tip:  You can also go to  File > Delete  or press the delete key.

2. In the dialog that pops up, click Delete to confirm that you want to delete that substrate.

7.3.2 Working with Graphics Submitted for Printing

Graphics Overview

List of Graphics per Substrate

If there are graphics submitted for nesting on a substrate, you will see the number of graphics to be

nested next to that substrate queue. 
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Click the substrate to see the list of graphics and their printing information at right.

Printing Information

For each graphic, you will see:

• the File Name and the page to be printed in that file,

• the Sheet Size it should be printed on (if this was defined when submitting the graphic),

• the Quantity ordered,

• the Remaining Quantity to be printed (if some copies of the graphic have already been included
in a nested layout this is what remains in the queue),

• the State of the graphic in the substrate queue,

• the date it was submitted (Submit Date),

• the Due Date.

This information comes from the settings defined when submitting the graphic to the queue.

If you want to find a specific graphic in the list, you can filter the graphics' list using the search field

, or sort the graphics by any of the columns by clicking the column header.
The sorting order has no influence on the output.

Tip:

You can also show / hide or reorganise columns by going to  View > Select columns in 'Gang Run
Printing'...

For example, you can show columns with your labels and grouping keys and use that to sort graphics.

Your column settings are saved when you quit the Pilot and restored the next time you log in.

Graphics States

Graphics ready to be nested and output.

When the nesting server calculates possible layouts, it will try to include all of the
graphics with this state in the most efficient layout(s) possible.

Graphics on hold.

Graphics with this state will not be included in the layout calculations.

Graphics that couldn't be placed on a layout because they are too big. It could be that:

• The graphic is too big for any available sheet size of that substrate. In this case,
consider either defining a bigger sheet size (if you have some available), or choosing a
different substrate when submitting the graphic to the queue.

• The graphic is too big for the sheet size you chose to nest it on (when submitting it to
the queue). In this case, choose a bigger sheet size, or set the graphic to be nested
on Any sheet size of your substrate when submitting it to the queue.

• It's too big to fit within the rotation possibilities defined for that substrate queue. In
this case, change the rotation parameter to Allow any angle.
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If none of these solutions help, you need to tile your graphic before submitting it to the
substrate queue.

Controlling the Printing Flow

By default, graphics will be sent to the output workflow automatically either when the desired fill is
reached or at the time you set (a certain amount of time before the due date).

However, you can:

• Put graphics on hold: select the graphic(s) and click the Hold button . Graphics on hold have

a hold icon  next to them in the table.

Note:  You can put one or more graphics (or even all graphics in the queue) on hold, but you
cannot put the queue itself on hold: even if all of the queue's graphics are on hold, new graphics
submitted to the queue will still trigger a layout calculation.

• Release graphics that are on hold: select the graphic(s) and click the Release button . Graphics

that are not on hold have a ready icon .

• Force-print graphics: select the graphic(s) and click the Print Now button .

Note:

To get a better substrate usage, some other graphics may be printed along the graphic(s) you
force-print. In this case, you will see that either these graphics disappear from the list, or their
Remaining Quantity is reduced.

Graphics that are on hold will not be included. If you want to force-print a graphic on hold, you
need to release it first.

• Remove a graphic from the queue: select the graphic and click the Delete button .

Note:  This will not delete the graphic file itself, only remove it from the substrate queue.

7.4 The Gang Run Printing Tasks

7.4.1 Prepare Graphics for Nesting

Use this task to prepare individual graphics for Gang Run Printing (you can add a cut path, bleed,
and SmartMarks in the General tab, and optimize your cut path in the Optimize tab).

You can send the following graphic file formats to this task:

• TIFF (CMYK or grayscale),
• JPEG (CMYK or grayscale, progressive JPEG compression is not supported),
• PSD (CMYK or grayscale),
• PDF (single page or multipage),
• Normalized PDF (single page or multipage).
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Typically, you use this task before a Submit to Gang Run task in an input workflow. The input workflow
prepares the graphics and submits them to a substrate queue on the nesting server (see Working
with Gang Run Printing on page 1084 for an overview of the whole Gang Run Printing process).

General Tab

1. In Create Cut Path, define what to use as a cut path, or how to generate one.

If you want to... do the following...

use an ink as cut path 1. Select From Ink or Trim Box.
2. Enter the name of the ink to use in the field below.

Tip:

• If the ink used for the cut path has different names in
different input files (for example if you have customers
from different countries using names like cut, découpe,
taglio...), you can add several ink names, separated by
a comma ( , ).

The order you use is important as the task will use the first
ink it finds in the list as cut path!

• You can use wildcards and/or use SmartNames to define
ink names. For example use Pantone* if you want to use
any Pantone ink used in the file as a cut path.

Tip:

When building a workflow using an example file, click  to
select one or more of the inks from the example file.

If you always receive CMYK graphics with one spot color
used for the cut path, select Any SpotColor.

3. Define what to do if the ink(s) you defined are not present in
the file:

• If you want to use the trim box as cut path instead, select
Create cut path from trim box if no ink is found.

• If you don't want to use the trim box but want the task to
end in error, leave Create cut path from trim box if no
ink is found deselected.

use the trim box as cut
path

Select From Ink or Trim Box (without specifying an ink to
search for).

If you always want to use the trim box as cut path (usually for
rectangular graphics like business cards), you don't need to
select Create cut path from trim box if no ink is found (as this
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If you want to... do the following...

option is only applicable when you want an ink as cut path as
your first choice).

use the cut path
defined in an
external ARD, PDF or
Normalized PDF file

Select From File and Browse to that file (or use SmartNames to
define the path to the file).

create a cut path from
the contour of the
graphic on its white
background

Select From White Background.

Note:

When creating a cut path this way, we recommend you select
the Flatten Objects option.

This will include both the contour of the design on the white
background and the contours of any "white holes" in the design
in the cut path. You can then remove the "white holes" contours
using the Remove holes option.

2. In Cut Path's Ink Name, enter the ink name to use for the cut path you just defined.

• If you defined the cut path based on an ink in your file, this will rename that ink to the name
you enter here.

Tip:  Use this to standardize cut path ink names across files (especially when your files come
from different customers).

• If you defined the cut path from the file's trim box, white background, or an external file, this
will add the cut path in that ink in your graphic file.

The cut path ink name you enter here will be used to identify the cut path in the Submit to Gang
Run task later in the input workflow.

3. If the graphic contains no bleed, you can add some here.

Select Create Bleed and enter the bleed distance (the distance outside the cut path). You can
also use a SmartName.

You can choose between two Bleed Modes:

• Choose Clone to take the part of the graphic just inside the cut path and replicate it to the
outside of the cut path.
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This is typically the best option for non rectangular cut path shapes.

• Choose Mirror to take a part of the graphic just inside the cut path (as much as the bleed
distance) and mirror it to the outside of the cut path.

This is typically the best option for rectangular cut path shapes.

4. If desired, you can add SmartMarks (a SmartMarks set that you created in i-cut Layout or
PackEdge) to the resulting graphics.

For example, you can add marks around the cut path to indicate the customer and the job name.
These will be visible in the bleed on the cutting table and can help organize your printed graphics
after cutting.

You can use SmartNames to enter your SmartMarks set's name.

Note:

Before you can do this, you need to:

1. Make sure your icut Layout or PackEdge application is connected to your Automation Engine
server.

2. Create and save a SmartMarks set in icut Layout or PackEdge (this automatically
saves it to the correct location on your Automation Engine server: \\AEservername
\bg_data_marks_v010\dat).

See the icut Layout or PackEdge manual for more information about connecting to an Automation
Engine server and creating a SmartMarks set.

Optimize Tab

If you created the cut path with the From White Background method, you typically need to optimize
the cut path contours that were automatically generated, to facilitate and speed up the cutting
process.

You can:

• Remove holes in your cut path.

Select this if the cut path was extracted from a white background and your graphic contains
white. This option makes sure that the white parts in your graphic are not considered part of the
background (which would create holes in your graphic).

• Smooth small jagged edges in your cut path.
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Select Smooth cut path with minimum distance between path points and enter the desired
distance. Any point that deviates from the cut path by less than that distance will be smoothed.

• Remove small objects from your cut path.

Select Remove contours smaller than and enter the minimum size for your graphic's small
objects. Any objects smaller than this will be removed from the cut path.

• Move the cut path inwards or outwards.

Select Offset cut path and enter a positive offset value (to move it outwards) or a negative one
(to move it inwards).

You can use SmartNames to specify any of these values.

7.4.2 Create Tiles

Use this task to tile oversize graphics, used for example for billboards, into smaller graphics to be
printed. You can select the size/number of the tiles, and allow for an overlap if necessary.

You can send the following graphic file formats to this task:

• TIFF (CMYK or grayscale),
• JPEG (CMYK or grayscale, progressive JPEG compression is not supported),
• PSD (CMYK or grayscale),
• PDF (single page or multipage),
• Normalized PDF (single page or multipage).

Note:

• For each image file or single page PDF, the task outputs a multipage PDF in which each page
contains a tile.

• For multipage PDFs, the task outputs a multipage PDF (in which each page contains a tile) for
each page of the input multipage PDF.

1. In Method, choose how to determine the number and size of the tiles:

• If the tile size is the most important (if for example you can only print a certain size), choose

Use Fixed Tile Size and enter the horizontal  and vertical  Tile Size.

Note:  The last tiles might be smaller (depending on the tile size and the size of the original file).

Select Allow Rotation if you don't mind having the graphic rotated by 90 degrees in case this
fits better and generates less tiles.

• If the number of tiles is more important to you than their size, choose Use Grid and enter the

Number of Tiles you want horizontally  and vertically .
• If you don't know the exact number or size of the tiles you want, but you can only print up

to a certain size, choose Automatic Tiling and enter the Maximum Tile Size horizontally 

and vertically .

The number and size of the tiles are calculated to have the least waste and the least tiles
possible, within that maximum size.
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All tiles will have the same size, except when adding an overlap.

Select Allow Rotation if you don't mind having the graphic rotated by 90 degrees in case this
fits better and generates less tiles.

• If you have a tiling template that you have created in icut Layout and want to use here, choose
Use Template and select your template in the Template list.

Note:

To do this, you need to:

1. Make sure your icut Layout application is connected to your Automation Engine server.
2. Create and save the template in icut Layout (this automatically saves it

to the correct location on your Automation Engine server: \\AEservername
\bg_data_custom_v010\dat\tiling).

See the icut Layout manual for more information about connecting to an Automation Engine
server and creating a tiling template.

With a tiling template:

• you can see exactly how your graphic will be tiled when creating the template in icut Layout
(if you create the template from the same/a similar graphic that you will use in Automation
Engine),

• you make sure you have consistent tiling in icut Layout and Automation Engine (for example
if you use icut Layout for some graphics orders and Automation Engine for others).

Attention:  If you want to add overlaps to your tiles when using a template, you need
to already add them in the template in icut Layout. You cannot add overlaps to tiles
created from a template in the Create Tiles task.

If you enable Fit graphics to grid, your graphic will be scaled to match the grid size, both
vertically and horizontally. This can result in non-proportional scaling!

2. Define what to use as Cut Path.

Note:  Whereas the Prepare Graphics for Nesting task allows you to generate a cut path if the
graphic doesn't contain one, in the Create Tiles task the cut path needs to be already available,
either as an ink or by using the trim box as cut path.

If you want to... do the following...

use an ink as cut path 1. Enter it in the Cut Path field.



7
Automation Engine

1106

If you want to... do the following...

Tip:

• If the ink used for the cut path has different names in
different input files (for example if you have customers
from different countries using names like cut, découpe,
taglio...), you can add several ink names, separated by
a comma ( , ).

The order you use is important as the task will use the first
ink it finds in the list as cut path!

• You can use wildcards and/or use SmartNames to define
ink names. For example use Pantone* if you want to use
any Pantone ink used in the file as a cut path.

Tip:

When building a workflow using an example file, click  to
select one or more of the inks from the example file.

If you always receive CMYK graphics with one spot color
used for the cut path, select Any SpotColor.

2. Define what to do if the ink(s) you defined are not present in
the file:

• If you want to use the trim box as cut path instead, select
Create cut path from trim box if no ink is found.

• If you don't want to use the trim box but want the task to
end in error, leave Create cut path from trim box if no
ink is found deselected.

use the trim box as cut
path

Leave the Cut Path field empty.

If you always want to use the trim box as cut path (usually for
rectangular graphics like business cards), you don't need to
select Create cut path from trim box if no ink is found (as this
option is only applicable when you want an ink as cut path as
your first choice).

The task will tile the graphic that is inside the cut path. The tiles created will have a cut path in
the same ink as the input graphic's cut path (if the cut path is created from the trim box, this
will be the Cut ink.

3. Typically, graphics for large banners or billboards are not supplied in the size at which they will
be printed out. In this case, you can Scale them up here.

For example, enter 1000% if your graphic is only 10% of the size you will need it to be.

4. If the graphics in your files have a bleed outside the cut path, you can clip it away by entering
the bleed distance into Bleed Clipping Mask.
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5. If desired, you can add SmartMarks (a SmartMarks set that you created in i-cut Layout or
PackEdge) to the tiles.

For example, you can add SmartMarks containing glueing instructions in the overlap zones. You
can use SmartNames to enter your SmartMarks set's name.

Note:

Before you can do this, you need to:

1. Make sure your icut Layout or PackEdge application is connected to your Automation Engine
server.

2. Create and save a SmartMarks set in icut Layout or PackEdge (this automatically
saves it to the correct location on your Automation Engine server: \\AEservername
\bg_data_marks_v010\dat).

See the icut Layout or PackEdge manual for more information about connecting to an Automation
Engine server and creating a SmartMarks set.

Tip:  We recommend you define your SmartMarks set in i-cut Layout, as it contains tiling-specific
SmartMarks fields (for adding tile numbers).

6. If you want to include overlaps (for example if the tiles' edges are to be glued on top of each
other), select Add Overlap and click the Options... button to set how exactly where and how big
the overlaps should be.

In the Overlap Options dialog:

a) Enter the Overlap distance.
b) In Tile Start Position, select where you want the first overlap to be: on the top left , top

right , bottom left  or bottom right  tile.

Note:

You can use SmartNames for most options of this dialog. For button options like Tile Start

Position, Direction and Pattern, you can set a SmartName by clicking , and edit it by
clicking Edit...
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Tip:

To know what the SmartName should resolve to to get a certain value for a parameter, do
the following:

1. Right-click the parameter value and select Copy Parameter Value.

• For a parameter with a field to edit (like Overlap), enter the desired value in the field
then right-click in that field.

• For a parameter with buttons (like Tile Start Position), right-click the button of your
choice.

2. Paste this in a text editor.

For example, the SmartName to get a top left  Tile Start Position should resolve to
tl.

c) In Direction, select whether the overlaps should run horizontally  or vertically .

Depending on the Tile Start Position you chose, horizontal overlaps can run from left to right

 or from right to left , and vertical overlaps can run from top to bottom  or

from bottom to top .
d) In Pattern, choose whether you want the overlaps to run snake-wise  or in zig-zag .

The exact snake-wise or zig-zag pattern depends on what Tile Start Position and Direction
you selected.

For example, when starting on the top left tile  and running horizontally  with a

snake-wise pattern , you will get something like this:

We recommend you run a test to determine exactly what pattern works best for your graphic.
e) You can choose to add an Overlap on both sides of each tile (using the overlap distance you

set on both sides).
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In this case, you cannot add a glue area to your overlaps.
f) If desired, add a Glue Area to your overlaps.

This area will not be printed and you can add glue to it after cutting the tiles.
g) Click OK.

Attention:  Adding overlaps increases the tiles size (of all tiles except the last ones). If
you selected the Use Fixed Tile Size or Automatic Tiling Method, you should take the
overlap distance into account.

7. If you want a report detailing how the graphic was tiled, select Create tiling report and click the
Options... button to choose how the report will look like.

a) In Report Size, select if you want your report on an A4 or a Letter page.
b) In Units, choose if you want the report to use mm or inch.
c) Click OK.

7.4.3 Submit to Gang Run

Use this task to submit a graphic file to a substrate queue, where it will be nested with other graphics
to optimize substrate usage.

In this task, you can specify parameters (quantity, scale factor...) for nesting graphics based on their
cut path.

You can send the following graphic file formats to this task:

• TIFF (CMYK or grayscale),
• JPEG (CMYK or grayscale, progressive JPEG compression is not supported),
• PSD (CMYK or grayscale),
• PDF (single page or multipage),
• Normalized PDF (single page or multipage).

Read more in:

General Tab on page 1109

Back Tab on page 1112

Substrate Tab on page 1112

Extra Tab on page 1113

General Tab

1. Define how many of each input graphic you want to print.

You can either:

• Enter the Quantity to print.
• Select Maximum Fill if you want to print as many copies as will fit in one sheet.

2. Typically, graphics for large banners or billboards are not supplied in the size at which they will
be printed out. In this case, you can Scale them up here.

For example, enter 1000% if your graphic is only 10% of the size you will need it to be.
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3. Define what to use as Cut Path.

Note:  Whereas the Prepare Graphics for Nesting task allows you to generate a cut path if the
graphic doesn't contain one, in the Submit to Gang Run task the cut path needs to be already
available, either as an ink or by using the trim box as cut path.

If you want to... do the following...

use an ink as cut path 1. Enter it in the Cut Path field.

Tip:

• If the ink used for the cut path has different names in
different input files (for example if you have customers
from different countries using names like cut, découpe,
taglio...), you can add several ink names, separated by
a comma ( , ).

The order you use is important as the task will use the first
ink it finds in the list as cut path!

• You can use wildcards and/or use SmartNames to define
ink names. For example use Pantone* if you want to use
any Pantone ink used in the file as a cut path.

Tip:

When building a workflow using an example file, click  to
select one or more of the inks from the example file.

If you always receive CMYK graphics with one spot color
used for the cut path, select Any SpotColor.

2. Define what to do if the ink(s) you defined are not present in
the file:

• If you want to use the trim box as cut path instead, select
Create cut path from trim box if no ink is found.

• If you don't want to use the trim box but want the task to
end in error, leave Create cut path from trim box if no
ink is found deselected.

use the trim box as cut
path

Leave the Cut Path field empty.

If you always want to use the trim box as cut path (usually for
rectangular graphics like business cards), you don't need to
select Create cut path from trim box if no ink is found (as this
option is only applicable when you want an ink as cut path as
your first choice).

4. If you want to set a due date (when the sheet with the nested graphics needs to be printed), select
Due Date and choose when you want the due date (and the due time) to be.
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• If you set a due date, the nesting server will always generate a nested layout that includes this
graphic before your due date, even when the minimum fill has not been reached.

Tip:  In your substrate queue settings, you can choose to generate the nested layout and send
it to the output workflow a specific time before the due date. This allows time for printing,
production...

• If you don't set a due date, the nesting server will only generate a nested layout when the
minimum fill is reached.

Select... to...

Immediate generate a nested layout including your graphic immediately (this
is the same as when you use Print Now in the Gang Run Printing
view).

Today set the due time to a certain time today (this is the default option).

The nesting server will generate a nested layout including your
graphic the specified amount of time before the due time.

Tomorrow set the due date to a certain time tomorrow.

The nesting server will generate a nested layout including your
graphic the specified amount of time before the due time.

In ... hours set the due time a certain number of hours after the task is
launched (you can set this with a SmartName).

In ... days set the due date a certain number of days after the task is launched
(you can set this with a SmartName).

You also need to set the due time.

On set the due date to a specified date (and time) in the future.

Job due date set the due date to the due date specified in the job setup.

Select
SmartName...

set the due date using a SmartName.

This opens the SmartNames dialog where you can select your
SmartName.
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Select... to...

Note:

• See SmartNames in the general Automation Engine manual for
information about SmartNames and how to create custom ones.

• Your SmartNames must resolve to a value in
the ISO 8601 standard format (for example
2014-09-27T11:08:00+02:00).

• If your due dates are supplied in a different format (for example
27/09/14), use the formatting options for date and time
SmartNames to convert this format to the ISO standard.

Back Tab

• On the Back tab, you can specify what to print on the back of each graphic:

• No graphics: choose this if you don't want any back side for the graphic.
• Even pages of multipage file: choose this to print the odd pages of the file on the front, and

the even pages on the back (this only works with multipage PDFs).
• Graphics from front side: choose this to print the same graphic on the front and on the back.

If your graphic has an irregular shape, you can select Flip horizontally so both graphics face
the same direction and have the exact same contour for cutting.

Note:  If your graphic contains text, you shouldn't flip it as this will make the text unreadable.

• Other graphics: choose this to print different graphics on the back, and Browse to these
graphics.

Tip:  Give the graphics to print on the back a consistent name, and use SmartNames to retrieve
them (for example, [File]_back.[Extension of File]).

Substrate Tab

1. Choose the Substrate to print your graphics on.

Attention:

You should choose (one of) the substrate(s) you have defined as a substrate queue in the
Gang Run Printing view.

If you submit your graphics to a non existent substrate, a substrate queue will be created
automatically for this substrate, but it won't be ready to process your graphics (so your
graphics will be stuck in the queue until you configure it properly).

2. If this substrate has several sizes defined, you can choose which Substrate Size to use.

Or leave this on Any to let Automation Engine find the best fit.
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Extra Tab

In this tab you can enter:

1. A Customer ID identifying the customer who ordered the graphics.
2. Your desired values for the custom fields you defined in the Configure tool.

You can use both customer ID and custom fields either as:

• labels in the reports about the nested layouts or the graphics,

• grouping keys to define which graphics can be nested together.

Example 1: Using Custom Fields as Labels

You get graphics orders from national and international customers. You are using different shipping
companies for national and international orders.

When generating layouts, you want to indicate which graphics are for national and for international
shipping, so the cutting operator can store the finished graphics in the right places.

1. In the Configure tool, define a Custom Field as Shipping.

The corresponding Custom Field parameter in this task tab will now be called Shipping instead.
2. When launching the task on graphics from international orders, enter International in that

parameter, otherwise enter National.
3. In your output workflow, choose to generate a layout PDF report in the Export Nested Layouts

task.
4. In the layout report, you will see for each graphic name:

• the label National if the copies of this graphic need to be shipped nationally,

• the label International if the copies of this graphic need to be shipped internationally.
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5. If you open the report in an application that can show PDF layers (for example Adobe Reader),
you will see that the report has a layer called Shipping.

If you hide the layers above this layer (so it only shows the Base and Shipping layers), you will
see that:

• Graphics that need to be shipped nationally are shown in the color of the National label (purple
in the example below).

• Graphics that need to be shipped internationally are shown in the color of the International
label (green in the example below, cut paths are shown in red).
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Example 2: Using Custom Fields as Grouping Keys

You need to print different graphics on the same substrate, but some will need to be laminated and
some not.

1. In the Configure tool, define a Custom Field as Lamination, and select Use as grouping key.

The corresponding Custom Field parameter in this task tab will now be called Lamination
instead.

2. When launching the task on graphics to be laminated, enter Yes in that parameter, otherwise
enter No.

3. The nesting server will generate layouts with either:

• only graphics to be laminated,
• only graphics that shouldn't be laminated.
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Note:  If you generate a layout report, it will have the label Yes if the graphics on that layout need
to be laminated, No if they don't.

7.4.4 Export Nested Layouts

Use this task to create production files (a PDF print file and a cutting file) from your nested Gang
Run Printing layouts.

Typically, the Export Nested Layouts task is the main part of your Gang Run Printing output
workflow.

When working with Gang Run Printing:

1. You submit the graphics to be nested and printed through the input workflow.
2. The nesting server automatically nests the graphics on the substrate, and sends the resulting

nested layouts to the output workflow linked to the substrate queue.
3. The output workflow generates production files from the nested layouts.

Note:

In a workflow, this task has five output pins (Print Files, Cutting Files, Done Graphics, Input and
Error), so you can send each type of file to the right place more easily.

If you select Create report, the task will have an extra output pin for the report.

Read more in:

• Sheet Tab on page 1116

• Production Files Tab on page 1120

• Reports Tab on page 1122

Sheet Tab

1. If desired, you can add SmartMarks (a SmartMarks set that you created in i-cut Layout or
PackEdge) to your sheet.

For example, you can use a SmartMarks set containing registration and/or cut marks. You can
use SmartNames to enter your SmartMarks set's name.

Note:

Before you can do this, you need to:

1. Make sure your icut Layout or PackEdge application is connected to your Automation Engine
server.

2. Create and save a SmartMarks set in icut Layout or PackEdge (this automatically
saves it to the correct location on your Automation Engine server: \\AEservername
\bg_data_marks_v010\dat).

See the icut Layout or PackEdge manual for more information about connecting to an Automation
Engine server and creating a SmartMarks set.

2. When the nesting server generates your nested layout, it places the layout on the sheet based on
the settings of the substrate queue you chose (sheet size and margins and nesting settings).
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However, you may want to move the nested layout on the sheet for printing and finishing purposes.
In Center Layout on Sheet you can choose to center the layout either Vertically, Horizontally,
or Vertically and Horizontally.

In the example below, the nested layout has been centered both vertically and horizontally.

3. If you are working with substrate rolls or large sheets, you can choose to fit the final PDF that will be
printed (the "sheet" file containing your nested layout) to one or both of the layout's dimensions.

This way, you can cut closer to the layout and have less substrate waste (for rolls) or save the
remaining blank area as an offcut so you can reuse it (for large sheets).

For Fit Sheet, choose either:

• To Layout Height to fit the sheet height to the height of your nested layout.
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• To Layout Width to fit the sheet width to the width of your nested layout.

• To Layout Width & Height to fit the sheet height and width to the height and width of your
nested layout.
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4. If you are printing Front and Back, define how the sheet will be turned for back printing in Backing
Up: either Work-and-Turn or Work-and-Tumble.

This influences how the back graphics will be placed in your final PDF.

Front (at left) and back (at right) with Work-and-Turn:

Front and back with Work-and-Tumble:
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Production Files Tab

The task will output:

• PDF print files,
• cutting files (in your desired format).

Note:  You will always have a single page PDF print file per layout, unless you are printing front and
back (in this case, the back graphic(s) will be on a second page).

1. In Save Cutting Files, choose the cutting file format you want to generate (i-cut, HPGL, PDF,
MFG, ACM or JDF).

Tip:

• If you have several cutting tables and you don't know yet which one you will use to cut the
sheet, you can generate several file formats: choose Select File Types..., select all the file
types you want to generate and click OK.

• If you want to check your cutting files for quality control, you can also output a PDF file and
inspect it in Acrobat.

When generating an ACM file (for a Kongsberg table), you can select Print Side Up to cut with
the print side visible.

For all cutting file types except JDF, you can influence the knife or cutting head's cutting
sequence:

• Leave Sequence lines deselected if you want to use the original cut paths for the cutting
lines (this way, common lines between graphics are only cut once, but every graphic is still
cut individually).
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• Select Sequence lines if you want the vertical and horizontal cutting lines to be concatenated
so that the knife can cut longer lines at once (so the knife doesn't need to be lifted and brought
down, and accelerate and decelerate, as often, which speeds up the cutting process).

If you have selected Sequence lines, you can choose to Cut Across Gaps to can cut longer
lines at once even if there is a gutter between your graphics.

Attention:

If you are generating an i-cut file, make sure you have i-cut marks in your file as they are
needed to define where to start cutting.

Other SmartMarks in your file will not be used for that purpose when working with an i-
cut file.

For more information about i-cut marks, please see the i-cut Layout manual.

2. By default, all inks with the technical ink type (including the ink used for the cut path) are
considered structural inks, and are included in the cutting file but not in the print file.

If you want to include other inks from your graphic in the cutting file but not in the print file, enter
their names in Add Extra Structural Inks.

When adding several inks, you should separate the ink names with a comma (for example
Crease,Kiss-cut). You can also use wildcards (*) and SmartNames.

3. By default, the output files have an automatically generated name containing unique identifiers
(for example nestingXXXX_YYYYYYY.cut and nestingXXXX_YYYYYYY.pdf).
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Note:  If multiple copies of the same layout need to be printed, the number of copies will be part
of the PDF file name.

If you want to give your output files a specific name, enter it in Output Name.

Attention:

Make sure you include a unique identifier in the name so that your output files do not
overwrite each other! This can happen for example if several layouts are generated.

To prevent this, we recommend you include a SmartName such as Task ID.

4. Define where to save the production files and the report(s):

• If you want to save all output files in the same folder, select Save all files in the same folder,
and browse to that Output Folder.

• Otherwise, make sure Save all files in the same folder isn't selected, and browse to your
chosen folder for the Print Files, Cutting Files and Report Files.

Reports Tab

You can create one or more nesting reports if desired.

• If you want XML reports (typically used as feedback for an MIS system):

• Select Create report per graphic if you want a report for each graphic nested (detailing on
which layout and substrate it is nested).

• Select Create layout XML report  if you want a report detailing the different graphics used
in each layout.

• If you want a PDF report detailing the different graphics used in each layout, select Create layout
PDF report.

This is typically used as instructions for the cutting table operator.

You can select:

• the Report Size (A4 or Letter),

• the Resolution used for graphics in the report (in the unit defined in the Pilot Preferences),

• the Units used in the report (mm or inch).



8
Automation Engine

1123

8. RIP'ing with Imaging Engine

8.1 Copyright Notice

© Copyright 2015 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BVBA. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BVBA does not warrant, guarantee or make any representations
regarding the use, or the results of the use of the software or the information contained herein. Esko
Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising
out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published,
in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other
means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE
®
, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other

trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly
owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2014. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.
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Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by BestTM Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

8.2 What's New in Imaging Engine 14.1 Prerelease
Version X?

New Proof Task

A new Proof task was added, for proofing to a physical device. See Proof on page 1193 for more
information.

The Proof - Unscreened Proofing task was renamed to Proof to File - Unscreened.

8.3 What is Imaging Engine?

An Adobe PDF Print Engine Based RIP

Imaging Engine is Esko's Raster Image Processor (RIP), based on the industry standard Adobe
PDF Print Engine.

On top of Adobe PDF Print Engine, Imaging Engine includes Esko's renowned color management,
screening, dot gain compensation and output formats (PDF, TIFF and LEN).

A RIP Integrated Seamlessly into Automation Engine

Imaging Engine is completely integrated into Automation Engine. This means that the Automation
Engine Pilot is your single point of contact for using Imaging Engine (you do not need to launch or
use any separate software).

You can run the Imaging Engine tasks on any PDF or Normalized PDF.
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A Powerful Multi-Files Processing RIP

Taking advantage of Adobe PDF Print Engine's capabilities (64-bit, multi-threaded, multi-process
architecture), Imaging Engine is powerful and highly scalable.

You can add more RAM and cores to your server hardware to process more files in parallel, and faster.

Note:  The amount of parallel processing you can do also depends on your license.

8.4 Using Imaging Engine for Proofing and RIP'ing

Files coming from a graphic designer often need a lot of prepress work before being printed (for
example, they contain objects in the wrong color space, vector graphics, etc.). You can do this
prepress work in Automation Engine for example.

After that, you can use Imaging Engine to both proof and RIP your files.

• When using the same solution for both proofing and RIP'ing, your proof will look much more like
your final print than if you had used two different solutions. This makes Imaging Engine ideally
suited for contract proofing.

• After the proof is approved, the RIP is the last essential step to make sure your files are ready
to send to your output device. Imaging Engine can generate screened or unscreened files,
depending on the device you want to use.

8.5 What Does Imaging Engine Do?

When proofing with Imaging Engine, you can:

• perform general file transformations to make sure the output is as expected (select the right page
box, rotate/invert/mirror the file as needed, apply a distortion to pre-compensate for substrate
distortion...),

• color manage objects in your file, or the whole file, so they look good on press,

• rasterize the vector graphics to continuous tone bitmaps,

• output your file to the file format needed for your proofing workflow or proofing device (TIFF or
PDF).

When RIP'ing with Imaging Engine, you can:

• perform general file transformations to make sure the output is as expected,
• rasterize the vector graphics to continuous tone bitmaps,

• screen those bitmaps at the correct resolution for your output device and which the screening
settings most applicable to your printing method,

• add dot gain compensation to compensate for plate and/or press dot gain,

• output your file to the file format needed for your imaging device (TIFF, LEN, PDF).

8.5.1 Color Management

Color management is making sure that colors are reproduced accurately at different stages of the
printing process.
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A computer where graphics files are created in a pre-press editor, a proofer and a press all have a
different a color gamut, which means that the extent of the colors they can reproduce is somewhat
different.

With color management, your application performs a controlled conversion of the colors between
these different devices, so that the colors are as consistent as possible. This consistency is especially
important for specific "brand" colors, that have to look the same on different substrates (cardboard,
paper, plastic...).

Colors in graphic files such as photographs are generally defined in the RGB color space (Red,
Green, Blue).

Proofers and presses use CMYK (Cyan, Magenta, Yellow and Black -or "Key") for printing, and
sometimes additional inks (for example Orange, Green and Blue, to be able to reproduce more colors,
or one or two spot inks -generally Pantone colors- used in a particular file).

Files coming from a graphic designer may contain CMYK, spot colors and sometimes images in RGB.

You can use color management to convert your input file's colors into your proofer's color space in
Imagine Engine's proofing tasks (Proof and Proof to File - Unscreened).

Imagine Engine uses Color Strategies created in the Color Engine Pilot for this purpose (for more
information about Color Strategies, see the Color Engine Pilot documentation).

8.5.2 Rasterizing Vector Graphics to Bitmaps

Files coming from a graphic designer may contain vector graphics or "linework" (especially for fonts
or logos).

Vector graphics are highly scalable without any loss of quality (as they are not based on pixels but
on mathematical formulas), but they are not printable.

To be able to print those graphics, you need to rasterize them with a RIP (Raster Image Processor).
This means converting them to bitmap images, or "contones" (continuous tone images), which are
based on pixels.

Low-resolution bitmaps can look pixellated, but Imaging Engine generates high-resolution bitmaps.

In Imaging Engine, you can choose to:

http://help.esko.com/products/Color%20Engine%20Pilot
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• output your files as contones if you need unscreened output (you can do this with the Image to
Unscreened Separations and the Proof to File - Unscreened tasks).

• screen those contones to get "halftones" if you need screened output (you can do this with the
Image to Screened Separations task).

8.5.3 Screening

What is Screening?

When printing an image on press, each ink (Cyan, Magenta, Yellow, Black and any additional ink) is
laid out separately on the substrate, and the super-imposition gives the final colors.

At a high detail level, the press can either print ink or not print ink, so to create differences of color
intensity within one ink, you use a small scale pattern of dots of varying size, called a screen.

When viewed from a regular distance, this pattern looks like a lighter or darker shade of that color,
depending on how big the dots are (what percentage of the area they cover).
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The screen can also be coarser or finer, so that you have to be more or less far away to see it as
shades of a color. This depends on how many lines of dots can fit in a certain measurement. This
is expressed in lines per inch (lpi), lines per centimeter (lpcm) or lines per millimeter (lpmm), and is
called the screen ruling.

A low screen ruling as below left looks very coarse, and the quality improves as the screen ruling
gets higher.
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Screen Angles and Moiré

When placing the screens of different separations on top of each other, a visually disturbing effect
called moiré can occur.

To avoid this effect, the screen of each separation is rotated at a specific angle, with a difference of
30° for the most "visible" inks (Cyan, Magenta and Black), and 15° for Yellow.
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Note:

The exact screen angles used depend on the printing process:

• Basic offset angles are: Y at 0 degrees, C, M, and K at 15, 45 or 75 degrees depending on the
application.

• Basic flexo angles are: Y at 7.5 degrees, C, M and K at 22.5, 52.5 or 82.5 degrees depending
on the application (or Y at 82.5 degrees, C, M and K at 7.5, 37.5 or 67.5 degrees depending on
the application).

Flexo angles are different from offset angles due to the anilox roll used in flexo presses (a cylinder
which is engraved with millions of small cells that carry a thin film of ink which is deposited on
the plate).

Putting the flexo screens on angles based on a 7.5° offset is needed to prevent moiré between
the screen and the pattern of the inking cells of the anilox roll.

Rosettes

When overlaying the screens of the different separations at their respective screen angles, you get a
rosette pattern. At a normal viewing distance, this is much less visible and distracting than moiré.

A rosette pattern can be clear centered or dot centered.

• Clear centered rosettes (also called hole centered rosettes) (below left) are built up around a hole,
and generally considered to be more stable.

• Dot centered rosettes (below right) are built up around a dot, and can give a more saturated result.

Types of Screens Supported

Imaging Engine supports different types of screens:

• screens with standard dot shapes,

• screens with advanced dot shapes,

• stochastic (FM) screens,

• legacy screens (screens that you have from an old version of FlexRip or Nexus RIP),

• custom screens (screens you have created in Screen Manager or HD Flexo).

Depending on your particular license, some of these screens will be included in your Imaging Engine,
and others can be purchased as an option.

Please check the sales material of your product to know what is included.

Screens have a short name and a long name. For example R -> Round Fogra (R being the short
name and Round Fogra the long name). When selecting a screen, they are listed alphabetically by
short name.
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Note:

Imaging Engine's halftone phase origin (the point where it starts screening the input file) is the top
left corner.

This is the same origin point as FlexRip and Nexus RIP, so you should be able to re-run old jobs and
get the same alignment (you may notice 1 pixel difference with old Nexus jobs).

Screens with Standard Dot Shapes

Depending on your license, your Imaging Engine product may include the following screens:

Circular (Euclidean) (short name: C)

This screens uses circular dots, that grow continuously circular until 100%.

The circular dot is typically used for flexography and letterpress.

This dot gives good results in many situations. However in some printing conditions the holes in the
shadows can fill in, which can result in unstable or high dot gain, and cause a loss in tonal range.
In this case consider using the Round Fogra dot instead.

Double Circular (short name: F)

This screen has circular dots in the highlights and mid-tones, and circular holes in the shadows.

Note that this screen can cause irregular ink bridging ("bridges" between dots) around the mid-
tones, which can give unstable dot gain in that tonal range. In this case use the Round Fogra dot
instead.

Paragon Euclidean (short name: PAREUC)

Paragon screens are designed for offset and flexo environments, to eliminate rosette drift and
suppress red and green patterns.

This is a Paragon screen with a round dot in the highlights, a checkerboard pattern in the 50%
region, and a negative round dot in the shadows.
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Round Fogra (short name: R)

This screen uses the Round Fogra dot, that closely resembles the elliptical and circular dots, and
can be used the same way. It is also a better alternative for square dots.

It goes from a round dot to a round hole, with a square/diamond shape in the mid-tones.

As with elliptical dots, the touching of the dots at the four corners at 50% (leading to a 50% intensity
jump) is avoided by using a more elongated dot shape so that the dots first touch around 45%
forming a chain and touching for the second time around 55%. This causes less artefacts and less
dot gain when printing.

The Round Fogra dot can be used for virtually all printing processes. It is very popular for offset
printing, but it can also be used for flexography, letterpress, silk screen printing and for making
films for offset-helio conversion. Only chemical etching gravure cannot be done with this dot
shape.

Screens with Advanced Dot Shapes

Depending on your license, your Imaging Engine product may include screens with advanced dot
shapes.

Rugby (short name: D)

This screen has a special dot shape and is used for screen printing. Rugby dots are shaped like a
rugby ball, or a diamond with round edges, which dramatically reduces the interference of the dots
with the mesh structure of the silk screen.

The dots touch around 35% to form chains. At 65%, a negative dot with rugby shape appears. This
dot shape is fully symmetrical.

Elliptical (short name: E)

This screen uses a more elliptical version of the Round Fogra dots.
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For these dots, the first touching point is around 35%. Between 35% and 65%, a chain is formed
with the same orientations as for the Round Fogra dots.

Helio (short name: H)

Helio dots continuously grow square, even above 50%, forming "helio walls".

This dot is needed for the classic gravure etching processes only. The dot shape is highly
optimized for both contone reproduction and linework areas.

Convex helio dots are the standard helio dots. The dot is as square as possible.

However in some circumstances the etching process smoothes out the square shape of the dots,
which can cause the helio walls to break during printing (especially at the highest dot percentages),
resulting in bad print quality.

On film On plate

 

 

 

 

In this case, you should use concave helio dots instead.

Helio Concave (short name: G)
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Concave helio dots are designed to avoid the helio walls breaking that sometimes happen with
standard helio dots.

In the concave helio screens, the square-shaped screen dots are replaced by more pillow-shaped
dots.

When etching the cylinder, the sharp ends are rounded off and the final result is closer to a square
than the result of the standard helio dot.

On film On plate

 

 

 

 

This dot shape will be useable up to slightly higher screen levels than the standard helio dot.

Line (short name: L)

This screen use lines instead of dots.

The advantages of using line screens are:

• there is no tonal jump because the lines never touch,
• the rosette patterns disappear completely, which gives the illusion of a higher ruling.

Paragon Diamond35 (short name: PARDIA35)
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Paragon screens are designed for offset and flexo environments, to eliminate rosette drift and
suppress red and green patterns.

Paragon Diamond35 is a screen with diamond shaped dots.

Paragon Elliptical35 (short name: PARELL35)

This is a Paragon screen with elliptical dots.

Square (short name: S)

This screen uses square dots in the highlights, forms a checkerboard at 50% and has square holes
in the shadows.

At 50%, the tonal jump can be very noticeable, especially when the printing process causes the
holes to fill (for example in Flexo), which results in a large dot gain. If the tonal jump is too obvious,
use Round Fogra or elliptical dots instead.

Eccentric 0 (short name: X0)

Eccentric dots are a series of more or less elongated dots, X0 being the most elongated (the furthest
from a round shape). A screen with X0 dots is close to forming lines.

Because of the more or less elongated shape of the dots, different eccentric dots have different
touching points. The dots form a chain between the two touching points.

Eccentric 0 has a first touching point at 5% and a second touching point at 95%.
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Note:

Eccentric dots have specific advantages for the flexo printing process:

• The flexo process is characterized by a high dot gain. Eccentric dots tend to lower this dot gain,
as well as the tonal jumps caused by dot gain.

• The more eccentric the dot is (X0 and X1 dots), the less noticeable rosette patterns it generates.
The difference in rosette patterns between eccentric dots and conventional round or circular
dots is more striking in flexo than in offset or gravure, due to the lower rulings used in flexo.

Eccentric 1 (short name: X1)

Eccentric 1 dots are slightly less elongated than X0 dots.

Eccentric 1 has a first touching point at 10% and a second touching point at 90%.

Eccentric 2 (short name: X2)

Eccentric 2 dots are less elongated again.

Eccentric 2 has a first touching point at 20% and a second touching point at 80%.

Eccentric 3 (short name: X3)

Eccentric 3 dots are only slightly elongated.

Eccentric 3 has a first touching point at 30% and a second touching point at 70%.

Eccentric 4 (short name: X4)

Eccentric 4 dots are the least elongated of the eccentric dots. They are close to Round Fogra dots.
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Eccentric 4 has a first touching point at 40% and a second touching point at 60%. At 50% the
dots form a checkerboard.

Stochastic (FM) Screens

In "stochastic" (or Frequency Modulated) screens, dots are not placed on a regular grid pattern like
in conventional (Amplitude Modulated) screens.

In a conventional screen, the dot size grows with the intensity (you have bigger dots at 50% than
at 25%). In a stochastic screen, the dot size stays the same, but you get more dots per area as the
intensity increases.

The advantages of stochastic screens are:

• sharper images,
• the full elimination of disturbing rosette patterns,
• no color shift caused by small registration errors (those errors are less visible than the same errors

with conventional screens, which can reduce press preparation time),
• the possibility to combine more than 4 separations without moiré.

Monet (short name: M)

The Monet screen has dot sizes exactly equal all over the density range, and is optimized for offset
printing.

In many cases, it can also be used in combination with a Rugby dot for silk screen printing.

If you experience high dot gain when using a Monet screen, we recommend you switch to an
Organic screen.

Monet for Flexo (short name: MF)

This screen is based on the Monet screen.

The Monet for Flexo screen has holes in the shadows that are bigger than the dots in the highlights,
so they don't fill up as much with dot gain (not increasing the shadows' darkness too much).
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This is especially beneficial for printing processes with high dot gain such as flexo.

Organic (short name: O)

Unlike first generation stochastic screens like Monet or Monet for Flexo, where the single dots are
left on their own, the organic dots are combined in clusters, forming organic-like random structures.
This reduces the dot gain around the mid-tones.

However, Organic screens can generate noise in images, giving a grainy appearance. If you
experience this problem, we recommend you switch to a Monet screen.

The Organic screen is optimized for offset printing.

Legacy Screens

If you have some screens that you got with an old version of FlexRip or Nexus RIP, they will still be
available in Imaging Engine.

Note:

Those are pre-calculated screens that were created for specific printing environments or to solve
specific problems. They can only perfectly match certain sets of conditions.

Today, you can get the same effects, fine-tuned for your particular printing conditions, by creating
custom screens in HD Flexo and/or Screen Manager.

See the HD Flexo and/or Screen Manager documentation for more information.

Conventional (AM) Screens

TwinBeam (short name: CD0)

The TwinBeam screen was developed for the CDI. It uses round dots that are exposed by two laser
beams.

CDI MultiBeam Optimized (short name: CD1)

The CDI MultiBeam Optimized screen was also developed for the CDI, as an improvement to the
TwinBeam screen. It uses round dots that are exposed by several laser beams.
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Endless (short name: CO)

This screen was used in combination with cylindrical sleeves on the CDI, to make several copies
of a job print continuously on the substrate, without broken dots at the edges of each job.

For best results, we recommend you use Screen Manager to create a custom seamless screen
instead of using the Endless dot here.

This screen uses the circular dot.

Groovy (short names: GVY1 to GVY5)

Groovy screens put a line pattern in the dark areas of the screen only. The lighter areas have a
Double Circular dot pattern.

The transition between the normal screen pattern and the line pattern is smooth, leading to a smooth
gradation on print between the lower density (non-groovy) and higher density areas (groovy).

They improve solid rendering in flexo printing (the lines help even out the ink distribution) and have
their best performance on foils. Performance on other substrates (paper, metal) is heavily dependent
on the printing circumstances.

You can choose between different groovy screens:

Long name Short
name

Pattern
angle

Pattern
ruling

Transition
start

Maximum
pattern
percentage

Pattern

Groovy1 GVY1 Close to 45
degrees

3 times
the original
ruling

95% 45% Lines

Groovy2 GVY2 Close to 45
degrees

3 times
the original
ruling

90% 45% Lines
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Long name Short
name

Pattern
angle

Pattern
ruling

Transition
start

Maximum
pattern
percentage

Pattern

Groovy3 GVY3 Close to 45
degrees

4 times
the original
ruling

95% 45% Lines

Groovy4 GVY4 Close to 45
degrees

4 times
the original
ruling

90% 45% Lines

Groovy5 GVY5 Close to 45
degrees

3 times
the original
ruling

93% 45% Eccentric1

Transitional (AM/FM) Screens

Circular Samba (short name: CS)

Samba screens are transitional screens, that were designed to solve problems in the highlights in
flexo.

They have a stochastic part in highlights and shadows, a conventional part in the mid-tones and the
transition between both contains a pattern that is gradually going from stochastic to conventional
over a large number of intermediate patterns.

SambaFlex (short names: CS4 to CS45)

Like Samba screens (which they are based on), SambaFlex screens are transitional screens, going
from stochastic to conventional and back.

SambaFlex screens support seven different minimum dot sizes, for every imagesetter resolution.
These sizes cover a very broad range, from hardly visible dots until dots so big that they can only
be used for artistic effects.

• Screens with a small minimum dot size (like CS4) have almost unnoticeable stochastic effects.

• Screens with a bigger minimum dot size (like CS45) have a coarser stochastic pattern, and less
dots in the highlights. The transition point in the highlights shifts up to higher dot percentages.

SambaFlex Highlight (short names: CS4H to CS45H)
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These screens are based on the SambaFlex screens, and only have a stochastic part in the
highlights. In the shadows, they stop at the darkest point, whether it is 100% or not (for these
screens it is usually 95%).

Custom Screens

In Imaging Engine, you can also use any custom screen you created in the HD Flexo and Screen
Manager applications. You will recognize those custom screens because:

• Screens created in HD Flexo have a short name beginning with HD (HD01, HD02...).

• Screens created in Screen Manager have a short name beginning with SCR (SCR01, SCR02...).

Please see the HD Flexo and/or Screen Manager documentation for more information.

Screened or Unscreened Output?

When RIP'ing your files with Imaging Engine, you can produce either screened or unscreened output.

• You typically need screened output to send to a platesetter or filmsetter (for offset or flexo for
example).

Run the Image to Screened Separations task on your input file to produce screened output (a
screened file per separation).

• You typically need unscreened output to send to a device that will take care of the screening, or
a device that doesn't need screened input (for gravure for example).

Run the Image to Unscreened Separations task on your input file to produce unscreened output
(an unscreened file per separation).
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8.5.4 Dot Gain Compensation

What is Dot Gain?

When printing a job, the dots tend to print larger on the press than on the plate, which makes the
output darker than the original file.

Original job

 

 

Digital film

 

 

Print

 

 

This is due to different factors:

• the type of ink: the more fluid the ink is, the more it will spread under pressure of the press.
• the type of substrate: paper with a rougher and more porous surface (like uncoated paper) reflects

less light, making the printed area look darker.
• the type of press:
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• offset presses typically print at a 67% density for a 50% dot,
• flexo presses have an even higher dot gain as they put more pressure on the substrate,
• gravure presses have a dot gain similar to offset presses for small dot sizes (up to about 30%)

and a sharply increasing dot gain for higher percentages (70% prints as solid).

What is Dot Gain Compensation?

To compensate for dot gain and have the printed output look like the original file, you use dot gain
compensation (DGC). This consists in making the dots on the plate smaller, so that with dot gain
they print to the correct density.

Dot on plate Dot on press

Without DGC

 

 

 

 

With DGC

 

 

 

 

Dot Gain Compensation Curves

You apply dot gain compensation by using a dot gain compensation curve, which defines which
percentage to use on plate for each desired percentage on press.

In the example below, you see how a press prints without any dot gain compensation in the dot gain
curve at left: a 20% density on the plate prints to 57% on press. 57% on the plate would print to
almost 90% on press.

At right, you see the dot gain compensation curve used to make the press print to the densities
expected in the job: to print a 57% density on press, a 20% density will be used on the plate. To
print a 20% density on press, you would need a density of about 5% on the plate.
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press

plate

plate

press

Dot gain curve Dot gain compensation curve

Creating a Dot Gain Compensation Curve

You can create dot gain compensation curves in Curve Pilot (see the Curve Pilot documentation for
more information).

Dot gain compensation curve files have the .dgc extension.

Using a Dot Gain Compensation Curve

You can apply a dot gain compensation curve on all or some separations of your job in the Image to
Screened Separations and Image to Unscreened Separations tasks in Imaging Engine.

DGC Curve Strategies

Different Dot Gains within a Job

When using a single dot gain compensation curve, the same dot gain compensation is applied to the
complete job, without making any compensation difference in the screening parameters, the inks or
the type of content (continuous tone images or line work).

However, dot gain is influenced by those factors.

Screening parameters

The following parameters influence dot gain:

• The dot shape: for example square, round and elliptic dots have slightly different dot gain
characteristics.

Stochastic screens produce more dot gain in the mid-tones than conventional screens.

See Types of Screens Supported on page 1130 for more information about dot shapes and
screens.

• The screen ruling: dot gain only happens on the perimeter of the printing dots, which means
that higher rulings always result in higher dot gain.

For example, a double ruling means double dot gain.

Inks

Dot gain compensation on a Yellow separation is often less important and less needed than dot
gain compensation on a Cyan separation.
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The viscosity of the ink also has a big influence.

Continuous tone images or line work

Sometimes, images have been pre-compensated for dot gain in an image editing program, so they
need less dot gain compensation than linework.

Dot Gain Compensation Curve Strategies

A dot gain compensation curve strategy contains several dot gain compensation curves and
defines when to apply which curve.

Creating a Dot Gain Compensation Curve Strategy

You can create dot gain compensation curve strategies in Curve Pilot (see the Curve Pilot
documentation for more information).

Dot gain compensation curve files have the .icpro extension.

Using a Dot Gain Compensation Curve Strategy

You can apply a dot gain compensation curve strategy in the Image to Screened Separations and
Image to Unscreened Separations tasks in Imaging Engine.

Each job separation or object is automatically compensated with the appropriate dot gain
compensation curve.

Note:  You can also use legacy screen-based DGC files (.scrdgc) as dot gain compensation curve
strategies in Imaging Engine.

PressSync Curves

PressSync curves are predefined compensation curves that can cover the dot gain compensation
needs of most presses, while significantly reducing the complexity of dot gain compensation in
workflows.

Slope and Mid-tone Compensation

Curves are defined by a letter and a number.

• The letter (A to H) describes how the press behaves in the highlights and shadows (the slope):
an A curve makes the press print darker in the highlights and lighter in the shadows (for presses
who have the opposite problem), while an H curve, on the contrary, makes the press print lighter
in the highlights and darker in the shadows.

http://help.esko.com/products/Curve%20Pilot
http://help.esko.com/products/Curve%20Pilot
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An E curve is halfway in between and has a straight slope: it corrects the output the same way
throughout the range. Use it for presses whose output is consistent in the highlights, mid-tones
and shadows.

• The number indicates how much the 50% dot (mid-tone) prints to: an E20 curve compensates
the 50% dot to 20%, while an E70 curve compensates 50% to 70%.

Creating a PressSync Curve

You cannot create PressSync curves, they are predefined. There are 400 different PressSync curves,
to match most dot gain compensation needs.

If you wish, you can see each PressSync curve on a graph in PressSync Pilot (see the PressSync
Pilot documentation for more information).

Using a PressSync Curve

You can apply a PressSync curve as press curve on all or some separations of your job in the Image
to Screened Separations and Image to Unscreened Separations tasks in Imaging Engine (you just
need to enter the letter and number of the PressSync curve).

PressSync Curve Sets

A PressSync curve set contains several PressSync curves, each attached to an ink (a process ink or
any spot color defined in Esko's CMS database).
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Creating a PressSync Curve Set

You can create PressSync curve sets in PressSync Pilot (see the PressSync Pilot documentation for
more information).

PressSync curve sets files have the .prsync extension.

Using a PressSync Curve Set

You can apply a PressSync curve set as press curve in the Image to Screened Separations and Image
to Unscreened Separations tasks in Imaging Engine.

Each job separation is automatically compensated with the appropriate PressSync curve.

8.5.5 RIP'ed File Formats

Imaging Engine can output to the following formats:

• TIFF, a bitmap file format widely supported by image-processing, publishing, DTP and other
applications. You can output to screened or unscreened TIFF.

• PDF, a multifunctional file format, supported by most graphics-related applications. You can
output to screened or unscreened PDF.

• LEN, a bitmap file format developed for Esko's CDI (Cyrel Digital Imager). You can send LEN files
to the Grapholas software, which will use them to expose flexo plates on the CDI drum.

LEN files have high resolutions of 2100 ppi and more. They are always screened.

Composite and Separated Files

When proofing with Imagine Engine, you can generate either composite or separated files.

RIP'ing with Imagine Engine always generates separated files.

Composite Files

Composite files are files that contain several separations. Imaging Engine can generate composite
PDF and composite TIFF files.

When generating composite output for:

• a single page input file, you get a single page output file containing all of the separations you
choose to output (after excluding technical inks for example).

• a multi-page input file, you get one output file per page of the input file, containing all of the
separations you choose to output from that input file page.

http://www.esko.com/en/products/overview/cdi/overview/
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In the example below, the input file has 2 pages, containing respectively Magenta and Yellow, and
Yellow and Cyan. When outputting to composite files, you get 2 one-page files, each containing
the separations of the corresponding page in the input file.

Separated Files

Separated files are files that only contain one separation each. Imaging Engine can generate
separated PDF, TIFF and LEN files.

When generating separated output for:

• a single page input file, you get one output file per separation of the input file that you choose to
output (after excluding technical inks for example).

In the example below, the input file has one page with a Magenta and a Yellow vignette. After
RIP'ing, you get 2 files (one for each separation), each containing a single channel bitmap.

Unscreened separated output
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Screened separated output

• a multi-page input file, you get one output file per page of the input file and per separation that
you choose to output.

In the example below, the input file has 2 pages, each containing a Magenta and a Yellow vignette.
After RIP'ing, you get 4 files (one for the 1st separation of the 1st page, one for the 2nd separation
of the 1st page, etc.), each containing a single channel bitmap.

Unscreened separated output
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Screened separated output

8.6 Imaging Engine Installation and Configuration

8.6.1 Licensing

To use the Imaging Engine functionality in Automation Engine, you need an Imaging Engine license
(in the form of a product key file).

If you don't have this license, you will not be able to configure Imaging Engine in the Automation
Engine Pilot, or see the Imaging Engine tasks.

Depending on the license you have, you will be able to output to some or all of the supported output
formats (TIFF, PDF and LEN), and you may be limited to a certain output file size or not (for LEN files).

For more information about the available licenses and which would fit your production best, please
talk to your Esko sales representative.

8.6.2 Installation

Before Installing Imaging Engine 14

Before you install Imaging Engine 14 on your system, check the following:

• You have the Suite 14 Imaging Engine Software Installation DVD.

Note:  If you downloaded the software from MySoftware.esko.com, you will need to mount the
corresponding .iso files as virtual DVDs, or unpack the .iso files first.

• You need to have Administrator privileges.

https://mysoftware.esko.com
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• You need Internet access.

• Your computer must meet the minimum requirements for the installation, as described on
www.esko.com/en/SystemRequirements/.

• Data Execution Prevention (DEP) must not block the installation.

• The Password Policy must not block the installation.

• You must make sure your anti-virus software is not blocking the installation or configuration.

• You need a product key file for Imaging Engine 14. If you do not have a product key file yet,
contact Esko Customer Support.

How to Change the Data Execution Prevention (DEP) Settings

Data Execution Prevention (DEP) is a security feature that helps prevent damage from viruses and
other security threats by monitoring your programs to make sure they use the computer's memory
safely. Before installing Imaging Engine 14, make sure that DEP does not block the installation.

1. In Control Panel, click  System > Advanced System Settings .

2. Click the Advanced tab.

3. Under Performance, click Settings.

4. Click the Data Execution Prevention tab.

5. Select Turn on DEP for essential Windows programs and services only.

6. Click OK.

7. Restart the computer.

How to Change the Password Policy

A password policy is a set of rules designed to enhance computer security by encouraging users
to employ strong passwords and use them properly. Before installing Imaging Engine 14, make sure
that the password policy on your system does not block the installation.

1. In Control Panel, click Administrative Tools.

2. In the Administrative Tools window, double-click Local Security Policy.

3. In the Local Security Policy window, double-click  Account Policies > Password Policy .

4. In the right pane, double-click Password must meet complexity requirements.

5. Select Disabled.

6. Click OK.

Licensing and Activation Requirements

Imaging Engine 14 is protected with licenses. These licenses are distributed as a product key file
(in .html). To import the licenses into the License Server, the product keys in the product key file must
be activated using the Activate Server Licenses utility.

You need:

• A product key file for Imaging Engine 14. If you do not have a product key file yet, contact Esko
Customer Support.

• Internet access to activate the licenses.

• An Esko ID in order to activate the licenses. Get one at http://www.esko.com/licensing/
CreateAccount.

http://www.esko.com/en/SystemRequirements/Imaging%20Engine%20powered%20by%20Adobe/14_0
http://www.esko.com/en/services/support-overview/support
http://www.esko.com/en/services/support-overview/support
http://www.esko.com/en/services/support-overview/support
http://www.esko.com/licensing/CreateAccount
http://www.esko.com/licensing/CreateAccount
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Installing Imaging Engine 14

You need the Suite 14 Imaging Engine Software Installation DVD for the installation. Use the following
procedure to install Imaging Engine 14:

1. Open the Suite 14 Imaging Engine Software Installation window:

• If you insert the Suite 14 Imaging Engine Software Installation DVD into the DVD drive, or
mount the corresponding .iso file, the window appears automatically.

• If you unpacked a downloaded .iso file, or if the window doesn't open automatically, double-
click setup.exe in the root folder.

2. Select the installation language.

3. Click Proceed to the installation.

4. Under Imaging Engine 14.0 installation, including related tools (Color Engine Pilot, Curve
Pilot, HD Flexo Screens and ScreenManager), click Install.

5. On the Imaging Engine 14.0 Installer page:

a) Install the License Server Components and activate the licenses. Read more in How to Install
the License Server Components on page 1152.

b) Check and install the prerequisites. Read more in How to Install the Imaging Engine 14
Prerequisites on page 1153.

c) Proceed with the software installation. Read more in How to Install Imaging Engine 14 on page
1154.

d) Install the Bitmap Viewer. Read more in How to Install the Bitmap Viewer on page 1154.

How to Install the License Server Components

1. On the Imaging Engine 14.0 Installer page, click on Install the System Controller 1.0.

2. Follow the instructions of the installation wizard.

3. When the installation is finished, click  Activate the licenses  on the Imaging Engine 14.0
Installer page.

4. In the Esko Network License Manager, do one of the following:

• click in the Click to activate your Product Key File area,
• drag your product key file in the area marked or drag your Product Key File here,
• click the Activate button.

5. Follow the instructions of the Activate License Wizard.

6. When asked about the product keys, choose I have received an HTML file containing my
Product Keys.

7. Click Browse to select the product key file.

8. When asked, fill in your Esko ID and Password.

9. Click Finish.
The licensed products you can use are now visible in the License Manager.

10.Close the License Manager to go back to the Imaging Engine 14.0 Installer page.
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How to Install the Imaging Engine 14 Prerequisites

Before you install Imaging Engine 14, you need to install the Imaging Engine 14 prerequisites.

1. On the Imaging Engine 14.0 Installer page, click on Check and install the Imaging Engine
System prerequisites.

This checks whether the operating system is suited for installing and running Imaging Engine 14,
and starts the Imaging Engine 14 prerequisites installation.

2. If:

• you see an error message about the Windows version, your operating system is not suited for
running Imaging Engine 14. Read the System Requirements again and install Imaging Engine
14 on a suitable operating system.

• you see the message Ready to install the prerequisite components for the
Imaging Engine software. Do you want to start the installation?, click Yes.

3. The installation wizard for the prerequisite components will check the licenses, list the prerequisite
components to install on the system, request confirmation for installation and then install the
required components.

Follow the instructions of the installation wizard.

The installation wizard will install the following components:

• Microsoft Visual Studio Redistributables
• Message Passing Interface service

If you are prompted to reboot your computer, do so and restart this installation procedure.

4. If the installer doesn't find a running Automation Engine 14 server on the local machine, you will
see the Enter Server name window, prompting you to enter the name of the server running your
Automation Engine.

Note:

• You should be able to access this server from your Imaging Engine 14 machine.

• You can still use the local machine as Automation Engine server (if Automation Engine 14
is installed on it): start up Automation Engine, and leave the field in the Enter Server name
window blank.

The installer then checks if the server you entered has a running Automation Engine 14 server.

If you get the following error: then:

ERROR - Imaging Engine requires
 Automation Engine 14.0.0 
The provided master server does
 not have Automation Engine
 14.0.0 running 
Checked server: [yourservername]

Automation Engine 14 is not running on the
server you entered.

1. Check that you entered the server name
correctly.

2. Make sure Automation Engine 14 is
running on it.

http://www.esko.com/en/SystemRequirements/Imaging%20Engine%20powered%20by%20Adobe/14_0
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If you get the following error: then:

3. Restart the Imaging Engine 14
prerequisites installation.

ERROR - Imaging Engine requires
 Automation Engine 14.0.0 
The provided master server does
 not have Automation Engine
 14.0.0 installed 
Checked server: [yourservername]
 (version [yourserverversion])

Automation Engine 14 is not installed on the
server you entered.

1. Check that you entered the server name
correctly.

2. Install Automation Engine 14 on it.
3. Restart the Imaging Engine 14

prerequisites installation.

5. Click Exit.

How to Install Imaging Engine 14

1. On the Imaging Engine 14.0 Installer page, click Install the Imaging Engine 14.0 products.

2. Follow the instructions of the installation wizard.

3. Read the End user license agreement carefully and select Yes, I accept the license agreement.

4. When asked to select the products to install on this system, select Imaging Engine and the desired
related products (Screen Manager, Curve Pilot, Color Engine Pilot...).

The System Components group cannot be deselected and will be installed on all systems.

5. Select a Destination Folder for the chosen products or accept the defaults.

6. At the end of the installation, click Finish.

How to Install the Bitmap Viewer

1. On the installation page, click Install the Bitmap Viewer 14.0 software.

2. Follow the instructions of the installation wizard.

3. Select the Destination Directory or accept the default.

4. Select the file types which you want to associate with the Bitmap Viewer or accept the defaults.

5. Select the language to use or leave Automatic selected to use the computer's language.

6. Click Install.

7. When all components have been installed, close the installation window and eject the DVD.

8.6.3 Configuration in the Automation Engine Pilot

Note:

• You need to perform this configuration before you can use Imaging Engine.
• If you have already configured Imaging Engine, you can only edit the configuration while it is not

processing files (if it is processing files while you try to change the configuration, you will see a
warning, and will have to wait until the processing is done).
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To connect your Automation Engine server to your Imaging Device:

1. In the Automation Engine Pilot, go to  Tools > Configure .

2. Select Imaging Engine Devices in the left pane.

3. Go to  File > New  or press the Insert key (on PC).

This creates an Imaging1 entry under Imaging Engine Devices and shows settings in the right
pane.

4. In the right pane's General tab:

a) In Host Name, enter the name of the server running your Imaging Engine and press Enter or
Tab (or click the Connect button next to Imaging Engine).

b) Check that you see a green dot  with the message Imaging Engine is up and running.

If you see... it means that...

a grey dot  with the message
Imaging Engine is starting up on
host

you need to wait a few minutes before
you can use Imaging Engine.

a red dot  with the message No
license for Imaging Engine on host

your Imaging Engine license is missing.

Please check your licenses.

a red dot  with the message No
Imaging Engine available on host

the server you have entered doesn't
have Imaging Engine or even
Automation Engine installed.

Please check if you have entered the
server name wrong.

You may see other error messages in some cases, but you will always get some advice as to
what you need to do (for example with the  Missing resource for Imaging Engine on host
message, you will get advised to Please reinstall the Imaging Engine).

Note:  You can Stop and Start Imaging Engine from here for troubleshooting purposes, but this
is generally not necessary, as Imaging Engine starts automatically, and will restart automatically
in case of a crash or after being force quitted.

c) Set the Number of Workers. This is the number of parallel processes used to work on multiple
pages of a file, or multiple files at the same time.

By default, the number of workers is set to 1.

Note:

The maximum number of workers you can set depends on your license and on the number
of cores on your server.

If your license allows it, we recommend you set the number of workers to the number of cores
of your server minus 1, for optimal processing.

5. In the Settings tab, select some settings to use in the Imaging Engine tasks when working with
the device you are configuring here:
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a) Select the Rotation Direction to use for all angle values (for example for transformation and

screening angles): either Clockwise  or Counterclockwise .
b) Select what kind of Rosettes you want to use in the Image to Screened Separations task:

• Clear Centered rosettes are generally considered to be more stable. This is the default.

• Dot Centered rosettes can give a more saturated result.

You can see which imaging device and which kind of rosettes have been used for each file in
that file's log.

6. In the Queue tab, enter a name for your Imaging Engine Queue.

7. In the left pane, select the Imaging1 entry, go to  File > Rename  and give it a meaningful name.

You can also select it and press F2 (on PC).

8. Go to  File > Save  or use Ctrl+S (on PC) to save your configuration.

8.7 The Imaging Engine Tasks

Imagine Engine consists of:

• two proofing tasks: Proof and Proof to File - Unscreened,

• two RIP'ing tasks: Image to Screened Separations and Image to Unscreened Separations.

Use the Imaging Engine tasks as you would use other Automation Engine tasks. For most of the
settings, you can also use public parameters (so an operator can define them through Shuttle) and/
or SmartNames.

You can use SmartNames everywhere you see the SmartName icon , and you can use SmartNames
in public parameters even for settings without that icon (for example if the setting is a button).

Important:  SmartNames values must resolve to a value that is valid for that setting at the moment
the task runs. Any invalid SmartName value will make the task end in error.

Tip:

• SmartNames are case insensitive (for example it doesn't matter whether your SmartName
resolves to AngleAndRuling or angleandruling).

• To know what value a SmartName must resolve to for a specific setting:

1. select the setting value you want (for example Scale : Fit to page size),
2. right-click that value (Fit to page size) and select Copy Parameter Value,
3. paste the value in a text editor (in this example it is FitSize).

For more information about SmartNames and public parameters, see the SmartNames and Using
Public Parameters sections of the Automation Engine manual.

8.7.1 Image to Screened Separations

Use this task if you need screened output to send to a platesetter or filmsetter (for offset or flexo
for example).
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Task Output

The Image to Screened Separations task generates one file per separation, in either PDF, TIFF or
LEN format.

For example, you can send screened LEN separations to the CDI.

In the example below, processing a file containing the lime green Esko star generates screened files
for the Cyan, Yellow and Black separations.

Task Parameters

In the Device field, select the imaging device that you configured.

Then use the selector pane at left to show more settings to fill in. See:

• General on page 1157,

• Transformations on page 1159,

• PDF Objects on page 1160,

• Document Inks on page 1161,

• Output on page 1161,

• Separations on page 1168,

• Summary on page 1175.

General

1. Define what Page Box of the input PDF you want to RIP.

You can either select Media Box, Trim Box, or insert a SmartName  that must resolve to either
media or trim.

After selecting your file's page box you will see its dimensions under the Page Box option.

Note:  This is a public parameter, that you can fill in when submitting files through Shuttle.

2. If your input file is a multi-page PDF, select which Pages you want to RIP:

a) First select All pages, Odd pages only or Even pages only in the Pages option.

You can also insert a SmartName resolving to either All, Even or Odd.
b) Then you can refine your selection by entering page numbers or a Page Range.

You can separate page numbers by a comma, or use a dash to indicate a page range (for
example 3,6-9). You can also use a SmartName resolving to page numbers and/or page
ranges using this same format.
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Note:

• Page numbers are always physical pages. If your document starts with page 5, you should
not use 5 but 1 to get the first page.

• If you enter page numbers that are not part of your document, they will be excluded from
the output (all the other valid pages will be RIP'ed).

• If you enter the same page(s) more than once (for example 1,1-2), it/they will only be
output once.

• Pages are RIP'ed in the order of the document (entering 5-1 will be automatically changed
to 1-5).

3. If you want to invert your output so it is compatible with the output device or software system

that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to invert
the output), or to 0 or false (to leave the output as it is).

4. If you want to mirror your output so it is compatible with the output device or software system

that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to mirror
the output), or to 0 or false (to leave the output as it is).

5. If you want to add a Smart Mark to your output file(s), select it in the Smart Mark list, or use a
SmartName that will resolve to the Smart Mark name.

A Smart Mark is a mark whose content is variable, so you can make it display information about
that specific job. For example, you can include some of the parameters used during RIP'ing in
your output file(s) by using a Smart Mark.

You need to:

a) First create the Smart Mark you want to use in PackEdge (see the SmartMarks section in
the PackEdge manual for details).

You can create either:

• a Smart Mark with RIP-specific parameters,

Use this Smart Mark parameter
in PackEdge:

to display this value from the
Imaging Engine parameters:

Resolution the Resolution of your output
file(s)

Screen based DGC the Curve Strategy you applied to
your separation(s)

DGC the Single Curve you applied to
your separation(s)

Dot shape the screen or dot shape you used
on your separation(s)
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Use this Smart Mark parameter
in PackEdge:

to display this value from the
Imaging Engine parameters:

V Distortion the vertical distortion you applied
to your output file(s)

H Distortion the horizontal distortion you
applied to your output file(s)

Device the imaging device you used

Negative Printing whether you inverted your output

Mirror Printing whether you mirrored your output

• another type of Smart Mark (for example a corner mark).
b) Then select that Smart Mark in your Imaging Engine task.

Transformations

Use the Transformations settings to rotate or distort your output relative to your input file.

1. If you want to Rotate your file's contents, select the rotation you want to apply here. This can be
0, 90, 180 or 270 degrees. Any other value will give an error.

Note:

• The direction of the rotation is the one you selected when configuring your Imaging Engine

(in the Settings tab). You will see  if you selected a clockwise or  if you selected a
counterclockwise rotation.

• You can use a SmartName that resolves to 0, 90, 180 or 270 (if you use a SmartName, the
task's default rotation direction, counterclockwise, will be used, regardless of what you
have configured for your device).

• You need to use a numerical value (ninety will not work).

• This is a public parameter, that you can fill in when submitting files through Shuttle.

2. If you want to apply Distortion to your file's contents:

a) Select the type of distortion to apply: No distortion, Flexo distortion or Values from file.

You can also use a SmartName that resolves to Not, Flexo or File.

Note:  If you selected Values from file and the input file contains distortion values, you will
see these in the fields below (greyed out).

b)
If you want to apply Flexo distortion, enter the vertical  and horizontal  distortion
percentages to use.

You can enter numerical values, or insert SmartNames that resolve to numerical values (without
the % sign).
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Note:

• The values should be within the 90%-110% range. If you enter a percentage outside of
this range it will be automatically adjusted to the nearest value in the range (for example
85 will be adjusted to 90%).

However, if you use a SmartName that resolves to a percentage outside the range, the task
will end in error.

• You can enter a simple formula and it will be calculated automatically (for example you can
enter 100+2 and this will be changed to 102%). This only works with numerical values and
not with SmartNames.

PDF Objects

Use the PDF Objects settings to define:

• how to color manage RGB objects in your input file,
• what dot gain compensation to apply to your input file's images.

All parameters in this tab are public parameters, that you can fill in when submitting files through
Shuttle.

1. In Default RGB Profile, specify the profile to use if no profile is specified for a certain RGB object
in the input file. The default is srgb.icc.

You can use a SmartName that resolves to the full profile name.

2. Select what output profile you want to use when converting RGB objects to CMYK:

• If you want to use the output profile from the input file (if there is one available), leave Use
output intent from file selected (it is selected by default).

• If you don't want to use the output profile from the input file, deselect Use output intent from
file and specify the output profile to use in Output Color Profile.

This output profile will also be used if there is none available in the input file.

The default is ISOcoated_v2_300_eci.icc.

For the Use output intent from file option, you can use a SmartName that resolves to true (to
use the file's profile) or false (to not use it).

For Output Color Profile, you can use a SmartName that resolves to the full profile name.

3. Select Use PDF transfer curves if you want to use the dot gain compensation curves attached
to the images in your input PDF.

These curves compensate for the unwanted characteristics of the device that created the images
(scanner, digital camera...).

Aside from these curves applied on individual images, you can still apply:

• a plate curve (to compensate for the dot growth or reduction -for example in Digital Flexo-
happening when making the plate)

• and/or a press curve (to compensate for the dot gain on press)
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... to the full file(s) before output.

You can use a SmartName that resolves to true (to use the input file's curves) or false (to not
use them).

Document Inks

Use the Document Inks settings to select which separations of the input file(s) you want to RIP.

For example, you can use these settings to exclude technical and/or varnish inks from your output.

See Selecting the Separations to Keep in the Output on page 1219 for more information.

Note:

If your file contains PantoneLIVE inks and you don't have a PantoneLIVE license, the Ink Book
column will show unregistered, followed by an ID number (for example <unregistered
"b0c3126e-4f74-4402-8e47-e5e9fe50195a">) instead of the PantoneLIVE ink book name for
those inks.

Output

Use the Output settings to define what type of output you want and where to output it.

You can set these through public parameters or using SmartNames.

1. Enter your output File Name and output Folder.

Note:

• You can use Imaging-specific SmartNames for the File Name.

By default, it is set to:

• [File]_[ShortInk] for single page input files (which gives output file names like
Myfile_C.tif),

• [File]_p[Page]_[ShortInk] for multi-page input files (which gives output file names
like Myfile_p1_C.tif).

• The File Name and Folder can contain special characters (except \ / : * ? < > " |).

• The whole path to the output file (including the container, Folder and File Name) can be up
to 255 characters.

• You can set a local or remote URL for the output Folder, but it must be an absolute path.

• If your output folder doesn't exist yet, the task will create it if the location you request is
valid (you should place this folder on an Automation Engine container accessible by your
Automation Engine user).

If the output folder creation fails, please check the task log for the full list of conditions and
adapt your output folder path accordingly.

2. Define what to do if a file of the same name already exists in your output folder:
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a) Click Set Overwrite Policy...
b) Choose what to do If files exist already. You can either:

• Extend the file name if you want to keep the existing output file and give the new output
file a different name. In this case, your new output file name consists of:

• the Output File Name (the File Name you set earlier) - which is what the file would be
called if no file with the same name existed,

• a custom suffix that you can define using plain text and/or SmartNames (by default, this
is _c, for "copy"),

• an automatic suffix made of the three last digits of the task ID,

Tip:

To see the task ID of your tasks:

1. Go to the Pilot's Tasks pane (in the Files or Tasks view).
2. Go to  View > Select Columns in 'Tasks'...
3. In the Columns dialog, select Task ID in the Available columns list and click  to

move it to the Show these columns: list.
4. Click OK.
5. You now have a Task ID column in the Tasks pane, listing the task ID of all the tasks.

• the file extension.

For example, you are working with a CMYK input file called file.pdf and you have left
the tasks' output File Name to its default value (the SmartName [File]).

The first TIFF files you generate will be called:

• file_C.tif,

• file_M.tif,

• file_Y.tif,

• file_Y.tif,

If you generate output from this input file again, with the task 3669, and you have set the
overwrite policy to Extend the file name with the default Output File Name + _c + ID
name, the new output files will be called:

• file_C_c669.tif,

• file_M_c669.tif,

• file_Y_c669.tif,

• file_Y_c669.tif,
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Tip:

• If you are working with the Bitmap Viewer, we recommend you keep the default overwrite
policy (Output File Name + _c + ID), which is compatible with the Bitmap Viewer.

• If you are not, you can define the custom suffix as you wish. For example, you could
use date and time SmartNames.

• Overwrite the existing file(s).

• End the task in error.

Note:  If you use a SmartName to set this, it must resolve to extend or 0 (for Extend the file
name), overwrite or 1 (for Overwrite), or error or 2 (for End the task in error).

c) Click Set.

3. Select the output File Type you want. This can be a TIFF File, a PDF File or a LEN File (see
RIP'ed File Formats on page 1147 for more information).

The task generates Separated output for all file types. This means you get one output file per
page of the input file, and per output separation.

The File Assembly is automatically set to 1 File Per Separation, and the Output Type set to
Separate (for both file types).

Note:

• Every output file that Imaging Engine generates contains XMP information (metadata about
file creation, separations, calibration curves, etc.).

You can view this XMP information by selecting your output file in the Automation Engine

Pilot's Files view and clicking .

For more information about XMP metadata, see the XMP Metadata white paper on
help.esko.com.

• TIFF files produced by Imaging Engine are fully compatible with Esko's Bitmap Viewer and
DotSpy.

• LEN files produced by Imaging Engine are fully compatible with Esko's CDI (Cyrel Digital
Imager), just as LEN files produced by FlexRip.

4. Choose the Compression to use for your output files.

http://help.esko.com/docs/en-us/suite-general/14/otherdocs/AE_XMPMetadata_Suite14_WhitePaper.pdf
http://help.esko.com/docs/en-us/suite-general/14/otherdocs/AE_XMPMetadata_Suite14_WhitePaper.pdf
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Note:

For screened output, all available compression methods are lossless (so you don't lose any of
the high-resolution detail).

You should choose a compression method based on the compression speed and the compressed
file size. Typically, faster compression methods compress the file less, so the output file is bigger.

Note that TIFF files can be a maximum of 4GB, PDF files 12GB, and LEN files are unlimited. Files
using stochastic screening are generally larger.

• For TIFF output, choose either:

• PackBits, a fast lossless compression method for graphic files.

Tip:  Use this if you want fast output and file size is not too much of an issue (if you have
a fast network for example).

• LZW, a lossless compression method for graphic files and other files.

Tip:  This compression method works best for files with large images.

• CCITT Group 4, a lossless compression method only used for files containing black and
white.

Tip:

• This compression method works best for files with a lot of text.
• Use this if having a small output file is more important than processing speed (for

example, if you want to store your screened files on a server to rerun jobs later, or if you
are working with really large input files that may give screened TIFFs of over 4GB).

• For PDF output, choose either:

• PackBits (see above).

• Flate, a lossless compression method similar to zipping, based on the LZW compression.

Tip:  This compression method works best for images with large single color areas or
repeating patterns.

• CCITT Group 4 (see above).
• For LEN output, choose either:

• Flate (see above).

• no compression (None).

Tip:  The Compression method offered by default for the output File Type you select (LZW for
TIFF, PackBits for PDF and Flate for LEN) is generally the best for this file type.
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Attention:

• When using a SmartName to set the output file's Compression, it must resolve to one
of the following (case insensitive):

• PackBits, LZW or CCITT-G4 for TIFF output,

• PackBits, Flate or CCITT-G4 for PDF output,

• Flate or None for LEN output.

Setting any other value, or an unsupported compression for the file type you chose,
will make the task error (with the message Unsupported combination of output
type and compression in the log).

• If you have already set the Compression but decide to change the output File Type,
by default the task will either:

• keep the same Compression (if it is supported for the new output File Type),

• or (if it isn't), set it to the first Compression available for this File Type.

You can still change it as desired.

5. Set the Resolution of your output files.

Note:

• The Resolution unit is taken from the general Automation Engine Preferences.

• You can enter values from 1 to 25400 ppi (or equivalent in your unit). SmartNames must also
resolve to a value in that range.

• Values in another unit than the one from the general Preferences will be recalculated, and
values like 300ppi + 500ppm will be calculated correctly.

• Depending on the Resolution you set here, you will have different screen Rulings available
in the Separations tab.

6. If your input file contains images, the images' pixels may not map exactly to output pixels because:

• the images' resolution is different from the output resolution you chose,
• scaling and rotation effects change the size and placement of the images' pixels.

You then need to resample these images to be able to output them at the same resolution as
the rest of the file.

In the Resample Images option, choose the resampling method you want to use (you will have
to make a trade-off between processing time and image quality).

• Choose From File to use the resampling method defined in the input PDF (this is the default
option). This method can be either:

• the "nearest neighbor" algorithm, which keeps the image very sharp but can make it look
jagged (pixellated but sharp). This is mostly recommended if you have small images with
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sharp lines/sudden differences in intensity, and/or you do not want your images to be fuzzy
at all.

This resampling method is very fast but may cause broken dots if the original image has
sharp jumps in intensity, small and sharp detail, hairlines...

Broken dots can be more susceptible to dot gain than regular dots, they can be washed
away while making the plate or can become unstable during printing (for example on flexo
plates they can flap around and smear ink on the substrate).

They can have an especially noticeable effect when using advanced screening technologies
such as Concentric.

• the "PDF interpolation" algorithm, that smoothes the image while resampling (see below).

Note:  Most PDF files don't specify a preferred resampling method, so the default ("nearest
neighbor" algorithm) is used. If you want to make sure that the "PDF interpolation" algorithm
is used, choose PDF Interpolation instead of From File in the Resample Images option.

You can also use a SmartName resolving to FromPDF.
• Choose PDF Interpolation to smooth the image while resampling.

With this method, you get images that are pixellated and fuzzy, so it is only recommended if
you have small images with gradual differences in intensity, like photographs of nature.

This is slightly less fast but reduces the chance of having broken dots.
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You can also use a SmartName resolving to PDFInterpolate.
• Choose Auto Resampling to upsample the images to an automatically calculated resolution

(generally half or a third of the output resolution) before smoothing it.

When using this, images are a lot less pixellated and fuzzy.

This method is quite slow but gives images of a good quality and reduces the risk of broken
dots a lot, so it is recommended in most cases (unless you want an extra sharp image and
have no broken dots problem, in which case you should choose From File).

You can also use a SmartName resolving to ResampleAuto.
• Choose Full Resampling to upsample the images to the full output resolution.

This is the slowest method but gives the highest quality images (not pixellated and only very
slightly fuzzy), with no risk of broken dots.

Use this if Auto Resampling doesn't give you the results you want.

Attention:

Resampling to full resolution can require significant amounts of memory when the
output resolution is high (especially from 4000 dpi).

If you want to do this, we recommend that you have at least 8GB of RAM available
for each worker (see Installation).
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You can also use a SmartName resolving to ResampleFull.

Note:

If your image is not...

• an 8 bit image,
• an image with 1, 3 or 4 components (for example grey, RGB or CMYK),

then the From File option is always used.

Separations

Use the Separations settings to define the screening and dot gain compensation to apply to the
separations you selected in the Document Inks settings.

You can define default screening and dot gain compensation settings for most or all of these
separations, and exceptions to these settings if you want to RIP some of these separations differently.

Defining Default Settings

Define the default screening and dot gain compensation (DGC) settings you want to use on the
separations to RIP. You will still be able to define exceptions to these settings for certain inks.

Under Default Separation Settings:

1. If your input file contains screening settings, you can have the task use (some of) those if desired.

In Use from file, select which setting(s) to use:

• select None if you want to ignore any screening settings present in the input file and only use
settings you define here,

• select All if you want to use all the screening settings from the file,

• select Angle only if you want to use the screen angles defined in the file, but use the dot shape
and ruling defined here,

• select Ruling only if you want to use the ruling defined in the file, but use the dot shape defined
here (the task then calculates the appropriate angles automatically),

• select Angle and ruling if you want to use the angles and ruling defined in the file, but use
the dot shape defined here.

Note:

• If you choose to use a certain screening setting from the file but that setting is not present in
the file, the task will use the settings defined here as a back-up.

• You can use SmartNames resolving to none, all, angle, ruling or angleandruling.

2. In Dot, select the screen/dot shape to use (or to use as a back-up if you are using the screening
settings from the input file).

You can choose from a list of screens installed on your Automation Engine server (on the screens
server).
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Screens have a short name and a long name. For example R -> Round Fogra (R being the short
name and Round Fogra the long name).

• Screens with a short name beginning with HD are custom screens created in HD Flexo. Please
see the HD Flexo documentation for more information.

Note:  You can only use an HD Flexo screen when generating LEN files at a resolution of 4000
ppi.

• Screens with a short name beginning with SCR are custom screens created in Screen
Manager. Please see the Screen Manager documentation for more information.

• Screens with a short name beginning with another prefix are predefined screens:

• screens with standard dot shapes,

• screens with advanced dot shapes,

• stochastic (FM) screens,

• legacy screens you have from an old version of FlexRip or Nexus RIP (any legacy screen for
which you have a license will have been copied to your Automation Engine server during
installation).

Tip:

• When selecting a screen, they are listed alphabetically by short name.
• When using a SmartName to set the screen, it should resolve to either the screen's short name

or its long name (not both).

3. Select the Ruling to use (or to use as a back-up if you are using the ruling from the input file).

Note:

• The ruling values offered depend on the Dot you selected, and on the Resolution you entered
in the Output settings.

• If you have used SmartNames for the Dot and/or the Resolution, you will not see Ruling
values to choose from, and will need to enter a ruling manually (which must be a valid ruling
for the dot shape and output resolution your SmartNames resolve to).

• When using a SmartName for the Ruling, make sure it resolves to the ruling value in lpi but
without the unit (for example it should resolve to 150 for 150 lpi).

• This ruling is applied to all separations, but you can change the yellow ruling to minimize yellow
moiré (see below).

The task will automatically calculate the correct angles to use based on the Resolution, Dot
shape and Ruling you set.
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If you are using SmartNames, make sure they resolve to a correct Resolution, Dot shape and
Ruling combination. If your combination is incorrect and no valid set of angles can be found, the
task will end in error.

4. Click Advanced Screening Settings to set options to minimize yellow moiré.

a) In Change Y Ruling, select Yes (conventional) if you want to minimize yellow moiré by
changing the ruling (when working with AM Screening).

When using a SmartName to set this, it must resolve to no if you don't want to use yellow
moiré reduction, or conventional if you do.

b) If you are changing the ruling, choose by how much: -15, -7, +7 or +15.

When using a SmartName to set this, it must resolve to -15, -7, +7 or +15.
c) Click Set.

Note:

• If your file doesn't contain a yellow separation, yellow moiré reduction won't be applied. The
task will run as normal but you will get a warning in the log.

• You cannot set yellow moiré reduction options when using a Paragon dot, as Paragon dots
already have built-in yellow moiré reduction.

After the screening settings, you now need to define dot gain compensation settings.

5. Define the Plate Curve you want to use on the separations to RIP.

This curve is used to compensate for the dot growth or dot reduction (for example in Digital Flexo)
happening when making the plate. Choose either:

• None if you don't want to apply any plate curve.
• Single Curve if you want to apply one curve for all separations (you can still define exceptions

for some of the separations later).

In this case, select the .dgc curve to apply at right.

You can choose from a list of curves available in the resource server defined for your
Automation Engine server.

• Curve Strategy if you want to apply a curve strategy (a file created in Curve Pilot that contains
several curves to apply in different cases: it can have different curves per separation, per dot
shape, per ruling...).

In this case, select the .icpro curve strategy or legacy .scrdgc screen-based DGC file to
apply at right.

You can choose from a list of curve strategies available in the resource server defined for your
Automation Engine server.

Note:

• You can use SmartNames resolving to the exact name of the Single Curve or Curve Strategy
(including the extension).

• This will set the Plate Curve type to Unknown in the ticket, but will resolve to the correct curve
type if the SmartNames are correct.
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6. Define the Press Curve you want to use on the separations to RIP.

This curve is used to compensate for the dot gain on press. Choose either:

• None if you don't want to apply any press curve,
• Single Curve if you want to apply one curve for all separations (you can still define exceptions

for some of the separations later).

In this case, select the .dgc curve to apply at right.

You can choose from a list of curves available in the resource server defined for your
Automation Engine server.

• Curve Strategy if you want to apply a curve strategy (a file created in Curve Pilot that contains
several curves to apply in different cases: it can have different curves per separation, per dot
shape, per ruling...).

In this case, select the curve strategy to apply at right (you can select a .icpro curve strategy,
a .prsync PressSync curve set or a legacy .scrdgc screen-based DGC file).

You can choose from a list of curve strategies available in the resource server defined for your
Automation Engine server.

• PressSync Curve if you want to apply a PressSync curve (a predefined curve applicable to
your printing environment).

In this case, select the letter and number of the PressSync curve.

Note:

• You can use SmartNames resolving to the exact name of the Single Curve, Curve Strategy
(including the extension) or PressSync Curve.

• This will set the Press Curve type to Unknown in the ticket, but will resolve to the correct
curve type if the SmartNames are correct.

Defining Exception Settings

If you don't want to use the default settings you defined for certain inks, you can define specific
screening and dot gain compensation settings for those here.

1. Click Define Exceptions...

2. In the Define Exceptions dialog, select to Define Exceptions either:

• by using exception criteria (see Defining Exceptions Using Exception Criteria on page 1171),
• Manually (see Defining Exceptions Manually on page 1173).

Note:  You can only define exceptions manually when you are launching the task on a (single)
file, not when you are defining a generic ticket without an input file.

Defining Exceptions Using Exception Criteria

If you want to define exceptions to the default screening and/or dot gain compensation settings for
certain inks, you can do it using exception criteria.

This works as follows:
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• You create a rule per separation or set of separations that need specific screening and/or dot
gain compensation settings.

• Within each rule:

• You define criteria to select the separation(s) you want to apply specific settings to.

Each criterion will check something about the inks in your file.

This check can be about the Ink name, Ink book, Ink Index, Ink type or Printing method.
For example, you can check if the Ink book is designer.

Tip:

The Ink index is the order in which the ink will be printed (the ink with ink index 1 is at the
bottom of the document and will be printed first).

To find the index of a file's inks:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an index of 1, the second
of 2, etc.).

Note that if you reorder the inks by one of the columns (for example by Ink name), they won't
be ordered by ink index anymore. You will need to close that dialog and reopen it to see the
ink index order again.

• You select these settings.

• If you have several rules, you can reorder them in order of priority (the top one is applied first).

Note:  You can do this either when running the task on one or more files, or when creating a task
ticket to use later.

If you have chosen to Define Exceptions by using exception criteria, do the following:

1. Click Add.

2. In the Exception Properties dialog, enter a Rule Name.

3. Under If separation matches, define one or more criteria to select your desired separation(s).

a) Define your criteria the following way:

• Ink name: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink book: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink index: you can define if it equals/is less than/is greater than the number you enter,
or is is between the two numbers you enter (in this case the ink indexes you enter as
boundaries are also selected).

• Ink type: you can define if it is a piece of text (alphanumerical characters).

• Printing method: you can define if it is a piece of text (alphanumerical characters).
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See the Printing methods section of the Automation Engine documentation for more
information about printing methods.

Tip:

• You can enter several values to check for: just use a semicolon (;) between them.

For example, to check for both inks called Cyan and inks called Magenta, choose Ink
name is and enter Cyan;Magenta.

• When launching the task on a file, you can also click  to select one or more of the Ink
names/Ink books/Ink types/Printing methods used in your input file(s).

A criterion will automatically be created based on your selection.

b) Click + to define more criteria.

Note:  You can create as many criteria as you want, they will be applied from top to bottom
(the top one will be applied first).

4. Define the settings (Dot, Ruling, Angle and/or Press Curve) you want to use for the selected
separation(s).

5. Click Add.

You can see your rule and the settings you selected for the exception separation(s) in the Define
Exceptions dialog.

Tip:  You can double-click your rule if you still want to edit it.

6. Repeat steps 1 to 5 to define more exception rules if desired.

If you want to remove an exception, select it and click Remove.

Tip:  Leave the Preview option at the bottom of the dialog so you'll be able to see your exception
separation(s) with its/their settings in the main task panel.

7. Click OK to save your exceptions and close the Define Exceptions dialog.

Defining Exceptions Manually

Note:  You can only define exceptions manually when you are launching the task on a (single) file,
not when you are defining a generic ticket without an input file.

If you have chosen to define exceptions manually, do the following:

1. Click Add.

2. In the Exception Properties dialog, select the Separation you want to make an exception for.

3. Define the settings you want to use for this separation (Dot, Ruling, Angle and/or Press Curve).

4. Click Add.

You can see your exception separation with its settings in the Define Exceptions dialog.

Tip:  You can double-click your exception if you still want to edit it.

5. Repeat steps 1 to 4 to define more exceptions if desired.
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If you want to remove an exception, select it and click Remove.

Tip:  Leave the Preview option at the bottom of the dialog selected so you'll be able to see the
settings for that separation in the main task panel.

6. Click OK to save your exceptions and close the Define Exceptions dialog.

Switching How You Define Exceptions

You can switch between the two methods of defining exceptions, and this will give the same results.

Switching from Defining Exceptions Manually to Defining Exceptions Using
Exception Criteria

If you defined exceptions manually but then choose to Define Exceptions by using exception
criteria, the task will translate your manual exceptions into rules, so that the same inks are selected,
and they have the same exception settings.

For example, if you manually selected Cyan, Magenta and Black and assigned to each of these
separations the Press Curve CMK.dgc, you will get the following rules:

Rule Name: Cyan (process)
Ink name is Cyan
Press Curve: CMK.dgc

Rule Name: Magenta (process)
Ink name is Magenta
Press Curve: CMK.dgc

Rule Name: Black (process)
Ink name is Black
Press Curve: CMK.dgc

Tip:  The rule names are created automatically from the contents of the exceptions, but you can still
double-click each rule to edit them.

Note:

If you...

• first defined rules with exception criteria,
• then switched to defining manual exceptions but didn't make any changes,
• then switched back to exception criteria,

... then your rules will be kept.

If you did change the exceptions in manual mode, the task will automatically generate new rules.

Switching from Defining Exceptions Using Exception Criteria to Defining
Exceptions Manually

If you defined rules with exception criteria but then choose to Define Exceptions Manually, each
separation selected by a rule will be selected individually, and have the settings you defined in the
rule.

For example if you had as criteria:
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Ink name is Cyan;Magenta;Black
Ink book is process

and you selected as Press Curve CMK.dgc, you will get the following manual exceptions:

Ink Name Ink Book Press Curve

Cyan process CMK.dgc

Magenta process CMK.dgc

Black process CMK.dgc

Note:  You can only switch to selecting inks manually when you are launching the task on a (single) file.

Summary

This shows a summary of all the settings you defined in the ticket.

• To show the settings from a tab, click + beside the tab name in the right pane.

Click Expand All to show the settings from all tabs.
• To hide the settings from a tab, click - beside the tab name in the right pane.

Click Collapse All to hide the settings from all tabs.

8.7.2 Image to Unscreened Separations

Use this task if you need unscreened output to send to a device that will take care of the screening,
or a device that doesn't need screened input (for gravure for example).

Task Output

The Image to Unscreened Separations task generates one file per separation, in either PDF or
TIFF format.

In the example below, processing a file containing the lime green Esko star generates unscreened
files for the Cyan, Yellow and Black separations.

Task Parameters

In the Device field, select the imaging device that you configured.
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Then use the selector pane at left to show more settings to fill in. See:

• General on page 1176,

• Transformations on page 1177,

• PDF Objects on page 1178,

• Document Inks on page 1179,

• Output on page 1179,

• Separations on page 1187,

• Summary on page 1193.

General

1. Define what Page Box of the input PDF you want to RIP.

You can either select Media Box, Trim Box, or insert a SmartName  that must resolve to either
media or trim.

After selecting your file's page box you will see its dimensions under the Page Box option.

Note:  This is a public parameter, that you can fill in when submitting files through Shuttle.

2. If your input file is a multi-page PDF, select which Pages you want to RIP:

a) First select All pages, Odd pages only or Even pages only in the Pages option.

You can also insert a SmartName resolving to either All, Even or Odd.
b) Then you can refine your selection by entering page numbers or a Page Range.

You can separate page numbers by a comma, or use a dash to indicate a page range (for
example 3,6-9). You can also use a SmartName resolving to page numbers and/or page
ranges using this same format.

Note:

• Page numbers are always physical pages. If your document starts with page 5, you should
not use 5 but 1 to get the first page.

• If you enter page numbers that are not part of your document, they will be excluded from
the output (all the other valid pages will be RIP'ed).

• If you enter the same page(s) more than once (for example 1,1-2), it/they will only be
output once.

• Pages are RIP'ed in the order of the document (entering 5-1 will be automatically changed
to 1-5).

3. If you want to invert your output so it is compatible with the output device or software system

that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to invert
the output), or to 0 or false (to leave the output as it is).

4. If you want to mirror your output so it is compatible with the output device or software system

that will process it, click .
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You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to mirror
the output), or to 0 or false (to leave the output as it is).

5. If you want to add a Smart Mark to your output file(s), select it in the Smart Mark list, or use a
SmartName that will resolve to the Smart Mark name.

A Smart Mark is a mark whose content is variable, so you can make it display information about
that specific job. For example, you can include some of the parameters used during RIP'ing in
your output file(s) by using a Smart Mark.

You need to:

a) First create the Smart Mark you want to use in PackEdge (see the SmartMarks section in
the PackEdge manual for details).

You can create either:

• a Smart Mark with RIP-specific parameters,

Use this Smart Mark parameter
in PackEdge:

to display this value from the
Imaging Engine parameters:

Resolution the Resolution of your output
file(s)

Screen based DGC the Curve Strategy you applied to
your separation(s)

DGC the Single Curve you applied to
your separation(s)

V Distortion the vertical distortion you applied
to your output file(s)

H Distortion the horizontal distortion you
applied to your output file(s)

Device the imaging device you used

Negative Printing whether you inverted your output

Mirror Printing whether you mirrored your output

• another type of Smart Mark (for example a corner mark).
b) Then select that Smart Mark in your Imaging Engine task.

Transformations

Use the Transformations settings to rotate or distort your output relative to your input file.

1. If you want to Rotate your file's contents, select the rotation you want to apply here. This can be
0, 90, 180 or 270 degrees. Any other value will give an error.
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Note:

• The direction of the rotation is the one you selected when configuring your Imaging Engine

(in the Settings tab). You will see  if you selected a clockwise or  if you selected a
counterclockwise rotation.

• You can use a SmartName that resolves to 0, 90, 180 or 270 (if you use a SmartName, the
task's default rotation direction, counterclockwise, will be used, regardless of what you
have configured for your device).

• You need to use a numerical value (ninety will not work).

• This is a public parameter, that you can fill in when submitting files through Shuttle.

2. If you want to apply Distortion to your file's contents:

a) Select the type of distortion to apply: No distortion, Flexo distortion or Values from file.

You can also use a SmartName that resolves to Not, Flexo or File.

Note:  If you selected Values from file and the input file contains distortion values, you will
see these in the fields below (greyed out).

b)
If you want to apply Flexo distortion, enter the vertical  and horizontal  distortion
percentages to use.

You can enter numerical values, or insert SmartNames that resolve to numerical values (without
the % sign).

Note:

• The values should be within the 90%-110% range. If you enter a percentage outside of
this range it will be automatically adjusted to the nearest value in the range (for example
85 will be adjusted to 90%).

However, if you use a SmartName that resolves to a percentage outside the range, the task
will end in error.

• You can enter a simple formula and it will be calculated automatically (for example you can
enter 100+2 and this will be changed to 102%). This only works with numerical values and
not with SmartNames.

PDF Objects

Use the PDF Objects settings to define:

• how to color manage RGB objects in your input file,
• what dot gain compensation to apply to your input file's images.

All parameters in this tab are public parameters, that you can fill in when submitting files through
Shuttle.
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1. In Default RGB Profile, specify the profile to use if no profile is specified for a certain RGB object
in the input file. The default is srgb.icc.

You can use a SmartName that resolves to the full profile name.

2. Select what output profile you want to use when converting RGB objects to CMYK:

• If you want to use the output profile from the input file (if there is one available), leave Use
output intent from file selected (it is selected by default).

• If you don't want to use the output profile from the input file, deselect Use output intent from
file and specify the output profile to use in Output Color Profile.

This output profile will also be used if there is none available in the input file.

The default is ISOcoated_v2_300_eci.icc.

For the Use output intent from file option, you can use a SmartName that resolves to true (to
use the file's profile) or false (to not use it).

For Output Color Profile, you can use a SmartName that resolves to the full profile name.

3. Select Use PDF transfer curves if you want to use the dot gain compensation curves attached
to the images in your input PDF.

These curves compensate for the unwanted characteristics of the device that created the images
(scanner, digital camera...).

You can use a SmartName that resolves to true (to use the input file's curves) or false (to not
use them).

Document Inks

Use the Document Inks settings to select which separations of the input file(s) you want to RIP.

For example, you can use these settings to exclude technical and/or varnish inks from your output.

See Selecting the Separations to Keep in the Output on page 1219 for more information.

Note:

If your file contains PantoneLIVE inks and you don't have a PantoneLIVE license, the Ink Book
column will show unregistered, followed by an ID number (for example <unregistered
"b0c3126e-4f74-4402-8e47-e5e9fe50195a">) instead of the PantoneLIVE ink book name for
those inks.

Output

Use the Output settings to define what type of output you want and where to output it.

You can set these through public parameters or using SmartNames.

1. Enter your output File Name and output Folder.
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Note:

• You can use Imaging-specific SmartNames for the File Name.

By default, it is set to:

• [File]_[ShortInk] for single page input files (which gives output file names like
Myfile_C.tif),

• [File]_p[Page]_[ShortInk] for multi-page input files (which gives output file names
like Myfile_p1_C.tif).

• The File Name and Folder can contain special characters (except \ / : * ? < > " |).

• The whole path to the output file (including the container, Folder and File Name) can be up
to 255 characters.

• You can set a local or remote URL for the output Folder, but it must be an absolute path.

• If your output folder doesn't exist yet, the task will create it if the location you request is
valid (you should place this folder on an Automation Engine container accessible by your
Automation Engine user).

If the output folder creation fails, please check the task log for the full list of conditions and
adapt your output folder path accordingly.

2. Define what to do if a file of the same name already exists in your output folder:

a) Click Set Overwrite Policy...
b) Choose what to do If files exist already. You can either:

• Extend the file name if you want to keep the existing output file and give the new output
file a different name. In this case, your new output file name consists of:

• the Output File Name (the File Name you set earlier) - which is what the file would be
called if no file with the same name existed,

• a custom suffix that you can define using plain text and/or SmartNames (by default, this
is _c, for "copy"),

• an automatic suffix made of the three last digits of the task ID,

Tip:

To see the task ID of your tasks:

1. Go to the Pilot's Tasks pane (in the Files or Tasks view).
2. Go to  View > Select Columns in 'Tasks'...
3. In the Columns dialog, select Task ID in the Available columns list and click  to

move it to the Show these columns: list.
4. Click OK.
5. You now have a Task ID column in the Tasks pane, listing the task ID of all the tasks.
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• the file extension.

For example, you are working with a CMYK input file called file.pdf and you have left
the tasks' output File Name to its default value (the SmartName [File]).

The first TIFF files you generate will be called:

• file_C.tif,

• file_M.tif,

• file_Y.tif,

• file_Y.tif,

If you generate output from this input file again, with the task 3669, and you have set the
overwrite policy to Extend the file name with the default Output File Name + _c + ID
name, the new output files will be called:

• file_C_c669.tif,

• file_M_c669.tif,

• file_Y_c669.tif,

• file_Y_c669.tif,

Tip:

• If you are working with the Bitmap Viewer, we recommend you keep the default overwrite
policy (Output File Name + _c + ID), which is compatible with the Bitmap Viewer.

• If you are not, you can define the custom suffix as you wish. For example, you could
use date and time SmartNames.

• Overwrite the existing file(s).

• End the task in error.

Note:  If you use a SmartName to set this, it must resolve to extend or 0 (for Extend the file
name), overwrite or 1 (for Overwrite), or error or 2 (for End the task in error).

c) Click Set.

3. Select the output File Type you want. This can be a TIFF File or a PDF File (see RIP'ed File
Formats on page 1147 for more information).

The task generates Separated output for both file types. This means you get one output file per
page of the input file, and per output separation.

The File Assembly is automatically set to 1 File Per Separation, and the Output Type set to
Separate (for both file types).
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Note:

• Every output file that Imaging Engine generates contains XMP information (metadata about
file creation, separations, calibration curves, etc.).

You can view this XMP information by selecting your output file in the Automation Engine

Pilot's Files view and clicking .

For more information about XMP metadata, see the XMP Metadata white paper on
help.esko.com.

• TIFF files produced by Imaging Engine are fully compatible with Esko's Bitmap Viewer and
DotSpy.

4. Choose the Compression to use for your output files.

• For TIFF output, you can choose between lossless and lossy compression. Lossless
compression preserves all the detail in the file, while lossy compression removes some detail.

We recommend you use lossless compression for the final output (for files you will send to a
third party RIP for example), and lossy compression only for previews and thumbnails.

For both compression types (lossless and lossy), you should then choose a compression
method, based on the compression speed and the compressed file size. Typically, faster
compression methods compress the file less, so the output file is bigger (note that TIFF files
can be a maximum of 4GB).

If you want
lossless
compression...

choose either:

• PackBits, a fast lossless compression method for
graphic files.

Tip:  Use this if you want fast output and file size is not
too much of an issue.

• LZW, a lossless compression method for graphic files
and other files.

Tip:  This compression method works best for files with
large images.

If you want lossy
compression...

choose one of the JPEG compression methods (those
are more suitable for images like photographs and natural
artwork than sharp edged or flat color images like line art
or lettering, as JPEG compression tends to introduce noise
into solid color areas).

They are sorted from very low compression (JPEG
Limited), which doesn't lose much detail but doesn't
reduce the file size much, to very high compression (JPEG
Extreme), which reduces the file size a lot but loses a lot of
detail.

http://help.esko.com/docs/en-us/suite-general/14/otherdocs/AE_XMPMetadata_Suite14_WhitePaper.pdf
http://help.esko.com/docs/en-us/suite-general/14/otherdocs/AE_XMPMetadata_Suite14_WhitePaper.pdf
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• For PDF output, all available compression methods are lossless.

You should choose a compression method based on the compression speed and the
compressed file size. Typically, faster compression methods compress the file less, so the
output file is bigger (note that PDF files can be a maximum of 12GB).

Choose either:

• PackBits (see above).

• Flate, a lossless compression method similar to zipping, based on the LZW compression.

Tip:  This compression method works best for images with large single color areas or
repeating patterns.

• JPEG 2000, a compression method based on JPEG and suitable for large images (the
version of JPEG 2000 used by Imaging Engine is lossless).

Tip:  The Compression method offered by default for the output File Type you select (LZW for
TIFF and PackBits for PDF) is generally the best for this file type.

Attention:

• When using a SmartName to set the output file's Compression, it must resolve to one
of the following (case insensitive):

• PackBits, LZW, JPEGLimited, JPEGLow, JPEGStandardLow, JPEGStandard,
JPEGStandardHigh, JPEGHigh, or JPEGExtreme for TIFF output,

• PackBits, Flate or JPEG2000 for PDF output.

Setting any other value, or an unsupported compression for the file type you chose,
will make the task error (with the message Unsupported combination of output
type and compression in the log).

• If you have already set the Compression but decide to change the output File Type,
by default the task will either:

• keep the same Compression (if it is supported for the new output File Type),

• or (if it isn't), set it to the first Compression available for this File Type.

You can still change it as desired.

5. Set the Resolution of your output files.
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Note:

• The Resolution unit is taken from the general Automation Engine Preferences.

• You can enter values from 1 to 25400 ppi (or equivalent in your unit). SmartNames must also
resolve to a value in that range.

• Values in another unit than the one from the general Preferences will be recalculated, and
values like 300ppi + 500ppm will be calculated correctly.

6. If your input file contains images, the images' pixels may not map exactly to output pixels because:

• the images' resolution is different from the output resolution you chose,
• scaling and rotation effects change the size and placement of the images' pixels.

You then need to resample these images to be able to output them at the same resolution as
the rest of the file.

In the Resample Images option, choose the resampling method you want to use (you will have
to make a trade-off between processing time and image quality).

• Choose From File to use the resampling method defined in the input PDF (this is the default
option). This method can be either:

• the "nearest neighbor" algorithm, which keeps the image very sharp but can make it look
jagged (pixellated but sharp). This is mostly recommended if you have small images with
sharp lines/sudden differences in intensity, and/or you do not want your images to be fuzzy
at all.
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This resampling method is very fast.

• the "PDF interpolation" algorithm, that smoothes the image while resampling (see below).

Note:  Most PDF files don't specify a preferred resampling method, so the default ("nearest
neighbor" algorithm) is used. If you want to make sure that the "PDF interpolation" algorithm
is used, choose PDF Interpolation instead of From File in the Resample Images option.

You can also use a SmartName resolving to FromPDF.
• Choose PDF Interpolation to smooth the image while resampling.

With this method, you get images that are pixellated and fuzzy, so it is only recommended if
you have small images with gradual differences in intensity, like photographs of nature.

This is slightly less fast.

You can also use a SmartName resolving to PDFInterpolate.
• Choose Auto Resampling to upsample the images to an automatically calculated resolution

(generally half or a third of the output resolution) before smoothing it.

When using this, images are a lot less pixellated and fuzzy.
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This method is quite slow but gives images of a good quality, so it is recommended in most
cases (unless you want an extra sharp image, in which case you should choose From File).

You can also use a SmartName resolving to ResampleAuto.
• Choose Full Resampling to upsample the images to the full output resolution.

This is the slowest method but gives the highest quality images (not pixellated and only slightly
fuzzy).
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Use this if Auto Resampling doesn't give you the results you want.

Attention:

Resampling to full resolution can require significant amounts of memory when the
output resolution is high (especially from 4000 dpi).

If you want to do this, we recommend that you have at least 8GB of RAM available
for each worker (see Installation).

You can also use a SmartName resolving to ResampleFull.

Note:

If your image is not...

• an 8 bit image,
• an image with 1, 3 or 4 components (for example grey, RGB or CMYK),

then the From File option is always used.

Separations

Use the Separations settings to select the dot gain compensation to apply to the separations you
selected in the Document Inks settings.

You can define default dot gain compensation settings for most or all of these separations, and
exceptions to these settings if you want to RIP some of these separations differently.
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Defining Default Settings

Define the default dot gain compensation (DGC) settings you want to use on the separations to RIP.
You will still be able to define exceptions to these settings for certain inks.

Under Default Separation Settings:

1. Define the Plate Curve you want to use on the separations to RIP.

This curve is used to compensate for the dot growth or dot reduction (for example in Digital Flexo)
happening when making the plate. Choose either:

• None if you don't want to apply any plate curve.
• Single Curve if you want to apply one curve for all separations (you can still define exceptions

for some of the separations later).

In this case, select the .dgc curve to apply at right.

You can choose from a list of curves available in the resource server defined for your
Automation Engine server.

• Curve Strategy if you want to apply a curve strategy (a file created in Curve Pilot that contains
several curves to apply in different cases: it can have different curves per separation, per dot
shape, per ruling...).

In this case, select the .icpro curve strategy or legacy .scrdgc screen-based DGC file to
apply at right.

You can choose from a list of curve strategies available in the resource server defined for your
Automation Engine server.

Note:

• You can use SmartNames resolving to the exact name of the Single Curve or Curve Strategy
(including the extension).

• This will set the Plate Curve type to Unknown in the ticket, but will resolve to the correct curve
type if the SmartNames are correct.

2. Define the Press Curve you want to use on the separations to RIP.

This curve is used to compensate for the dot gain on press. Choose either:

• None if you don't want to apply any press curve,
• Single Curve if you want to apply one curve for all separations (you can still define exceptions

for some of the separations later).

In this case, select the .dgc curve to apply at right.

You can choose from a list of curves available in the resource server defined for your
Automation Engine server.

• Curve Strategy if you want to apply a curve strategy (a file created in Curve Pilot that contains
several curves to apply in different cases: it can have different curves per separation, per dot
shape, per ruling...).

In this case, select the curve strategy to apply at right (you can select a .icpro curve strategy,
a .prsync PressSync curve set or a legacy .scrdgc screen-based DGC file).
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You can choose from a list of curve strategies available in the resource server defined for your
Automation Engine server.

• PressSync Curve if you want to apply a PressSync curve (a predefined curve applicable to
your printing environment).

In this case, select the letter and number of the PressSync curve.

Note:

• You can use SmartNames resolving to the exact name of the Single Curve, Curve Strategy
(including the extension) or PressSync Curve.

• This will set the Press Curve type to Unknown in the ticket, but will resolve to the correct
curve type if the SmartNames are correct.

Defining Exception Settings

If you don't want to use the default settings you defined for certain inks, you can define specific dot
gain compensation settings for those here.

1. Click Define Exceptions...

2. In the Define Exceptions dialog, select to Define Exceptions either:

• by using exception criteria (see Defining Exceptions Using Exception Criteria on page 1189),
• Manually (see Defining Exceptions Manually on page 1191).

Note:  You can only define exceptions manually when you are launching the task on a (single)
file, not when you are defining a generic ticket without an input file.

Defining Exceptions Using Exception Criteria

If you want to define exceptions to the default dot gain compensation settings for certain inks, you
can do it using exception criteria.

This works as follows:

• You create a rule per separation or set of separations that need a specific dot gain curve.
• Within each rule:

• You define criteria to select the separation(s) you want to apply a specific curve to.

Each criterion will check something about the inks in your file.

This check can be about the Ink name, Ink book, Ink Index, Ink type or Printing method.
For example, you can check if the Ink book is designer.
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Tip:

The Ink index is the order in which the ink will be printed (the ink with ink index 1 is at the
bottom of the document and will be printed first).

To find the index of a file's inks:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an index of 1, the second
of 2, etc.).

Note that if you reorder the inks by one of the columns (for example by Ink name), they won't
be ordered by ink index anymore. You will need to close that dialog and reopen it to see the
ink index order again.

• You select that curve.

• If you have several rules, you can reorder them in order of priority (the top one is applied first).

Note:  You can do this either when running the task on one or more files, or when creating a task
ticket to use later.

If you have chosen to Define Exceptions by using exception criteria, do the following:

1. Click Add.

2. In the Exception Properties dialog, enter a Rule Name.

3. Under If separation matches, define one or more criteria to select your desired separation(s).

a) Define your criteria the following way:

• Ink name: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink book: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink index: you can define if it equals/is less than/is greater than the number you enter,
or is is between the two numbers you enter (in this case the ink indexes you enter as
boundaries are also selected).

• Ink type: you can define if it is a piece of text (alphanumerical characters).

• Printing method: you can define if it is a piece of text (alphanumerical characters).

See the Printing methods section of the Automation Engine documentation for more
information about printing methods.
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Tip:

• You can enter several values to check for: just use a semicolon (;) between them.

For example, to check for both inks called Cyan and inks called Magenta, choose Ink
name is and enter Cyan;Magenta.

• When launching the task on a file, you can also click  to select one or more of the Ink
names/Ink books/Ink types/Printing methods used in your input file(s).

A criterion will automatically be created based on your selection.

b) Click + to define more criteria.

Note:  You can create as many criteria as you want, they will be applied from top to bottom
(the top one will be applied first).

4. Select Press Curve and choose the press curve to use for the selected separation(s).

5. Click Add.

You can see your rule and the Press Curve you selected for the exception separation(s) in the
Define Exceptions dialog.

Tip:  You can double-click your rule if you still want to edit it.

6. Repeat steps 1 to 5 to define more exception rules if desired.

If you want to remove an exception, select it and click Remove.

Tip:  Leave the Preview option at the bottom of the dialog so you'll be able to see your exception
separation(s) with its/their Press Curve in the main task panel.

7. If desired, you can reorder your exception rules (they are applied from top to bottom). To do this,
select a rule and click Move Up or Move Down.

8. Click OK to save your exceptions and close the Define Exceptions dialog.

Defining Exceptions Manually

Note:  You can only define exceptions manually when you are launching the task on a (single) file,
not when you are defining a generic ticket without an input file.

If you have chosen to Define Exceptions Manually, do the following:

1. Click Add.

2. In the Exception Properties dialog, select the Separation you want to make an exception for.

3. Select Press Curve and choose the press curve you want to use for this separation.

4. Click Add.

You can see your exception separation with its Press Curve in the Define Exceptions dialog.

Tip:  You can double-click your exception if you still want to edit it.

5. Repeat steps 1 to 4 to define more exceptions if desired.
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If you want to remove an exception, select it and click Remove.

Tip:  Leave the Preview option at the bottom of the dialog selected so you'll be able to see the
settings for that separation in the main task panel.

6. Click OK to save your exceptions and close the Define Exceptions dialog.

Switching How You Define Exceptions

You can switch between the two methods of defining exceptions, and this will give the same results.

Switching from Defining Exceptions Manually to Defining Exceptions Using
Exception Criteria

If you defined exceptions manually but then choose to Define Exceptions by using exception
criteria, the task will translate your manual exceptions into rules, so that the same inks are selected,
and they have the same exception settings.

For example, if you manually selected Cyan, Magenta and Black and assigned to each of these
separations the Press Curve CMK.dgc, you will get the following rules:

Rule Name: Cyan (process)
Ink name is Cyan
Press Curve: CMK.dgc

Rule Name: Magenta (process)
Ink name is Magenta
Press Curve: CMK.dgc

Rule Name: Black (process)
Ink name is Black
Press Curve: CMK.dgc

Tip:  The rule names are created automatically from the contents of the exceptions, but you can still
double-click each rule to edit them.

Note:

If you...

• first defined rules with exception criteria,
• then switched to defining manual exceptions but didn't make any changes,
• then switched back to exception criteria,

... then your rules will be kept.

If you did change the exceptions in manual mode, the task will automatically generate new rules.

Switching from Defining Exceptions Using Exception Criteria to Defining
Exceptions Manually

If you defined rules with exception criteria but then choose to Define Exceptions Manually, each
separation selected by a rule will be selected individually, and have the settings you defined in the
rule.

For example if you had as criteria:
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Ink name is Cyan;Magenta;Black
Ink book is process

and you selected as Press Curve CMK.dgc, you will get the following manual exceptions:

Ink Name Ink Book Press Curve

Cyan process CMK.dgc

Magenta process CMK.dgc

Black process CMK.dgc

Note:  You can only switch to selecting inks manually when you are launching the task on a (single) file.

Summary

This shows a summary of all the settings you defined in the ticket.

• To show the settings from a tab, click + beside the tab name in the right pane.

Click Expand All to show the settings from all tabs.
• To hide the settings from a tab, click - beside the tab name in the right pane.

Click Collapse All to hide the settings from all tabs.

8.7.3 Proof

If you have an Esko Proof Server, you can use the Imagine Engine Proof task to send your RIP'ed
output to a physical proofer, through the Proof Server.

This works as follows:

1. The Proof task color manages and RIPs your input file, and generates a TIFF file for proofing.
2. It sends this file to a workflow of your choice on the Esko Proof Server.
3. The Proof Server proofs it on the proofing device connected to that workflow.
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Note:

To use this task, you need to have created a Proof Server workflow in the Esko Proof Client, and
that workflow must:

• be connected to a physical proofer,
• have no color management or verification options set (you can set color management options

in the task itself).

For details on how to create a Proof Server workflow, please see the Esko Proof Client documentation.

Task Parameters

In the Device field, select the imaging device that you configured.

Then use the selector pane at left to show more settings to fill in. See:

• General on page 1194,

• Proofer on page 1196,

• Transformations on page 1197,

• PDF Objects on page 1198,

• Document Inks on page 1199,

• Color Management on page 1199,

• Output on page 1199,

• Summary on page 1203.

General

1. Define what Page Box of the input PDF you want to RIP.

You can either select Media Box, Trim Box, or insert a SmartName  that must resolve to either
media or trim.

After selecting your file's page box you will see its dimensions under the Page Box option.

Note:  This is a public parameter, that you can fill in when submitting files through Shuttle.

2. If your input file is a multi-page PDF, select which Pages you want to RIP:

a) First select All pages, Odd pages only or Even pages only in the Pages option.

You can also insert a SmartName resolving to either All, Even or Odd.
b) Then you can refine your selection by entering page numbers or a Page Range.

You can separate page numbers by a comma, or use a dash to indicate a page range (for
example 3,6-9). You can also use a SmartName resolving to page numbers and/or page
ranges using this same format.

http://help.esko.com/products/FlexProof%20E
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Note:

• Page numbers are always physical pages. If your document starts with page 5, you should
not use 5 but 1 to get the first page.

• If you enter page numbers that are not part of your document, they will be excluded from
the output (all the other valid pages will be RIP'ed).

• If you enter the same page(s) more than once (for example 1,1-2), it/they will only be
output once.

• Pages are RIP'ed in the order of the document (entering 5-1 will be automatically changed
to 1-5).

3. If you want to invert your output so it is compatible with the output device or software system

that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to invert
the output), or to 0 or false (to leave the output as it is).

4. If you want to mirror your output so it is compatible with the output device or software system

that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to mirror
the output), or to 0 or false (to leave the output as it is).

5. If you want to add a Smart Mark to your output file(s), select it in the Smart Mark list, or use a
SmartName that will resolve to the Smart Mark name.

A Smart Mark is a mark whose content is variable, so you can make it display information about
that specific job. For example, you can include some of the parameters used during RIP'ing in
your output file(s) by using a Smart Mark.

You need to:

a) First create the Smart Mark you want to use in PackEdge (see the SmartMarks section in
the PackEdge manual for details).

You can create either:

• a Smart Mark with RIP-specific parameters,

Use this Smart Mark parameter
in PackEdge:

to display this value from the
Imaging Engine parameters:

Resolution the Resolution of your output
file(s)

V Scale the vertical scaling you applied to
your output file(s)

H Scale the horizontal scaling you applied
to your output file(s)

Color Strategy the Color Strategy you applied to
your output file(s)
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Use this Smart Mark parameter
in PackEdge:

to display this value from the
Imaging Engine parameters:

Source Profile the Source Profile contained in the
Color Strategy you applied to your
output file(s)

Destination Profile the Destination Profile contained
in the Color Strategy you applied
to your output file(s)

Rendering Intent the Rendering Intent contained in
the Color Strategy you applied to
your output file(s)

Device the imaging device you used

Negative Printing whether you inverted your output

Mirror Printing whether you mirrored your output

• another type of Smart Mark (for example a corner mark).
b) Then select that Smart Mark in your Imaging Engine task.

Proofer

This is where you select the Esko Proof Server workflow to which the task sends your RIP'ed output.

• The Proof Server Workflow list contains all of the valid workflows found on your Proof Server.

You can:

• select a workflow from the list,
• use SmartNames (that must resolve to the name of a valid Proof Server workflow),
• set the workflow using public parameters.

Note:

To be valid, your workflow must:

• be connected to a physical proofer,
• have no color management or verification options set (you can set color management options

in the task itself).

Imaging Engine checks whether the Proof Server and the selected workflow are available when
defining ticket settings and when (re-)launching the task.

The task will end in error if it can't access the Proof Server workflow or if the workflow is invalid.

Tip:

For details on how to create a Proof Server workflow, please see the Esko Proof Client
documentation.

http://help.esko.com/products/FlexProof%20E
http://help.esko.com/products/FlexProof%20E
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Transformations

Use the Transformations settings to scale or rotate your output relative to your input file.

1. If you want to Scale your input file's contents, select either:

• Scale by percent and enter the vertical  and horizontal  scaling percentages to use.

Note:

By default, you enter the vertical scaling percentage and the horizontal one is calculated
automatically to keep the proportions.

If you want to enter the horizontal scaling percentage manually, click  to unlink it from the
vertical one first.

However, if you do this then link the percentages again, the last percentage you entered will
be kept, and the other one will be recalculated automatically to keep the proportions.

• Fit to page size to fit your output to the substrate defined in your Proof Server workflow, while
keeping the proportions (this will fit it to either the width or the height of the substrate, while
making sure everything is on the substrate).

• Fit to page width to fit it to the width of the substrate defined in your Proof Server workflow,
while keeping the proportions.

If you don't want to scale your file's contents, leave Do not scale selected.

You can use SmartNames resolving to not (Do not scale), ByPercent (Scale by percent),
FitSize (Fit to page size) or FitWidth (Fit to page width).

When entering SmartNames for vertical and horizontal scaling percentages, they must resolve to
the numerical value (without the % sign).

2. If you want to Rotate your file, select the rotation you want to apply here.

You can choose to either:

• use a fixed rotation (this can be 0, 90, 180 or 270 degrees; any other value will give an error),

• rotate your file if necessary to fit, or fit better, on the substrate (select Minimal Media
Consumption).

If it did fit on the substrate already, this option makes sure that the largest dimension of the
file will be placed in the substrate width, to use less substrate material when cutting.
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Note:

• The direction of the rotation is the one you selected when configuring your Imaging Engine

(in the Settings tab). You will see  if you selected a clockwise or  if you selected a
counterclockwise rotation.

• You can use a SmartName that resolves to 0, 90, 180, 270 or minimal (if you use
a SmartName, the task's default rotation direction, counterclockwise, will be used,
regardless of what you have configured for your device).

• When using a fixed rotation, you need to use a numerical value (ninety will not work).

• This is a public parameter, that you can fill in when submitting files through Shuttle.

PDF Objects

Use the PDF Objects settings to define:

• how to color manage RGB objects in your input file,
• what dot gain compensation to apply to your input file's images.

All parameters in this tab are public parameters, that you can fill in when submitting files through
Shuttle.

1. In Default RGB Profile, specify the profile to use if no profile is specified for a certain RGB object
in the input file. The default is srgb.icc.

You can use a SmartName that resolves to the full profile name.

2. Select Use PDF transfer curves if you want to use the dot gain compensation curves attached
to the images in your input PDF.

These curves compensate for the unwanted characteristics of the device that created the images
(scanner, digital camera...).
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You can use a SmartName that resolves to true (to use the input file's curves) or false (to not
use them).

Document Inks

Use the Document Inks settings to select which separations of the input file(s) you want to proof.

For example, you can use these settings to exclude technical and/or varnish inks from your output.

See Selecting the Separations to Keep in the Output on page 1219 for more information.

Note:

If your file contains PantoneLIVE inks and you don't have a PantoneLIVE license, the Ink Book
column will show unregistered, followed by an ID number (for example <unregistered
"b0c3126e-4f74-4402-8e47-e5e9fe50195a">) instead of the PantoneLIVE ink book name for
those inks.

In this case, you must exclude these inks from the output, or the task will end in error (with the
following message in the log file: This job contains PantoneLIVE inks, and the
necessary license for proofing these is not available.).

Color Management

• Select a Color Strategy to apply color management to the output file(s).

You can choose from a list of color strategies available in the resource server defined for your
Automation Engine server.

Note:

• The default color strategy is linear.

• You can only select a CMYK color strategy.

• You can select it through a public parameter, or using a SmartName. The SmartName for the
color strategy must resolve to one of the available color strategies.

Once you have selected the desired color strategy, you can see the Source and Destination
profiles used in the strategy.

Output

Use the Output settings to define what type of output you want and where to output it.

You can set these through public parameters or using SmartNames.

1. If your input file contains images, the images' pixels may not map exactly to output pixels because:

• the images' resolution is different from the output resolution you chose,
• scaling and rotation effects change the size and placement of the images' pixels.

You then need to resample these images to be able to output them at the same resolution as
the rest of the file.
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In the Resample Images option, choose the resampling method you want to use (you will have
to make a trade-off between processing time and image quality).

• Choose From File to use the resampling method defined in the input PDF (this is the default
option). This method can be either:

• the "nearest neighbor" algorithm, which keeps the image very sharp but can make it look
jagged (pixellated but sharp). This is mostly recommended if you have small images with
sharp lines/sudden differences in intensity, and/or you do not want your images to be fuzzy
at all.

This resampling method is very fast.

• the "PDF interpolation" algorithm, that smoothes the image while resampling (see below).

Note:  Most PDF files don't specify a preferred resampling method, so the default ("nearest
neighbor" algorithm) is used. If you want to make sure that the "PDF interpolation" algorithm
is used, choose PDF Interpolation instead of From File in the Resample Images option.

You can also use a SmartName resolving to FromPDF.
• Choose PDF Interpolation to smooth the image while resampling.

With this method, you get images that are pixellated and fuzzy, so it is only recommended if
you have small images with gradual differences in intensity, like photographs of nature.
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This is slightly less fast.

You can also use a SmartName resolving to PDFInterpolate.
• Choose Auto Resampling to upsample the images to an automatically calculated resolution

(generally half or a third of the output resolution) before smoothing it.

When using this, images are a lot less pixellated and fuzzy.
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This method is quite slow but gives images of a good quality, so it is recommended in most
cases (unless you want an extra sharp image, in which case you should choose From File).

You can also use a SmartName resolving to ResampleAuto.
• Choose Full Resampling to upsample the images to the full output resolution.

This is the slowest method but gives the highest quality images (not pixellated and only slightly
fuzzy).
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Use this if Auto Resampling doesn't give you the results you want.

Attention:

Resampling to full resolution can require significant amounts of memory when the
output resolution is high (especially from 4000 dpi).

If you want to do this, we recommend that you have at least 8GB of RAM available
for each worker (see Installation).

You can also use a SmartName resolving to ResampleFull.

Note:

If your image is not...

• an 8 bit image,
• an image with 1, 3 or 4 components (for example grey, RGB or CMYK),

then the From File option is always used.

2. Enter the number of Copies you want to print (at least 1).

You can use SmartNames and/or public parameters.

Summary

This shows a summary of all the settings you defined in the ticket.

• To show the settings from a tab, click + beside the tab name in the right pane.

Click Expand All to show the settings from all tabs.
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• To hide the settings from a tab, click - beside the tab name in the right pane.

Click Collapse All to hide the settings from all tabs.

8.7.4 Proof to File - Unscreened

Use this task if you need unscreened but color managed output, in a file that you can send to a
proofer.

Task Output

The Proof to File - Unscreened task can generate composite PDF or TIFF files (one file with all the
separations).

In the example below, processing a file containing the lime green Esko star generates one multi-
channel unscreened file containing the Cyan, Yellow, Magenta and Black channels, where the
Magenta channel is empty.

Task Parameters

In the Device field, select the imaging device that you configured.

Then use the selector pane at left to show more settings to fill in. See:

• General on page 1204,

• Proofer on page 1206,

• Transformations on page 1207,

• PDF Objects on page 1208,

• Document Inks on page 1208,

• Color Management on page 1209,

• Output on page 1209,

• Summary on page 1218.

General

1. Define what Page Box of the input PDF you want to RIP.

You can either select Media Box, Trim Box, or insert a SmartName  that must resolve to either
media or trim.

After selecting your file's page box you will see its dimensions under the Page Box option.
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Note:  This is a public parameter, that you can fill in when submitting files through Shuttle.

2. If your input file is a multi-page PDF, select which Pages you want to RIP:

a) First select All pages, Odd pages only or Even pages only in the Pages option.

You can also insert a SmartName resolving to either All, Even or Odd.
b) Then you can refine your selection by entering page numbers or a Page Range.

You can separate page numbers by a comma, or use a dash to indicate a page range (for
example 3,6-9). You can also use a SmartName resolving to page numbers and/or page
ranges using this same format.

Note:

• Page numbers are always physical pages. If your document starts with page 5, you should
not use 5 but 1 to get the first page.

• If you enter page numbers that are not part of your document, they will be excluded from
the output (all the other valid pages will be RIP'ed).

• If you enter the same page(s) more than once (for example 1,1-2), it/they will only be
output once.

• Pages are RIP'ed in the order of the document (entering 5-1 will be automatically changed
to 1-5).

3. If you want to invert your output so it is compatible with the output device or software system

that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to invert
the output), or to 0 or false (to leave the output as it is).

4. If you want to mirror your output so it is compatible with the output device or software system

that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to mirror
the output), or to 0 or false (to leave the output as it is).

5. If you want to add a Smart Mark to your output file(s), select it in the Smart Mark list, or use a
SmartName that will resolve to the Smart Mark name.

A Smart Mark is a mark whose content is variable, so you can make it display information about
that specific job. For example, you can include some of the parameters used during RIP'ing in
your output file(s) by using a Smart Mark.

You need to:

a) First create the Smart Mark you want to use in PackEdge (see the SmartMarks section in
the PackEdge manual for details).

You can create either:

• a Smart Mark with RIP-specific parameters,



8
Automation Engine

1206

Use this Smart Mark parameter
in PackEdge:

to display this value from the
Imaging Engine parameters:

Resolution the Resolution of your output
file(s)

V Scale the vertical scaling you applied to
your output file(s)

H Scale the horizontal scaling you applied
to your output file(s)

Color Strategy the Color Strategy you applied to
your output file(s)

Source Profile the Source Profile contained in the
Color Strategy you applied to your
output file(s)

Destination Profile the Destination Profile contained
in the Color Strategy you applied
to your output file(s)

Rendering Intent the Rendering Intent contained in
the Color Strategy you applied to
your output file(s)

Device the imaging device you used

Negative Printing whether you inverted your output

Mirror Printing whether you mirrored your output

• another type of Smart Mark (for example a corner mark).
b) Then select that Smart Mark in your Imaging Engine task.

Proofer

When outputting your RIP'ed files to a proofer:

• Select the Substrate Size from a list of predefined sizes, or enter the substrate Width and Height
yourself to define a Custom substrate.

Note:

• By default, the Substrate Size is set to Custom, with the Width and Height values of an A3
page.

• The Width and Height unit is taken from the general Automation Engine Preferences.
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Note:

You can set those values using public parameters and/or SmartNames. If you use SmartNames,
make sure that:

• the SmartName for Substrate Size resolves to one of the substrate sizes offered in the list
(when using a SmartName here, the Width and Height options will show 0, but the task will
use the correct dimensions when it runs).

• the SmartNames for Width and Height resolve to a numerical value, without any unit (the
default task unit, mm, will then be used, regardless of the unit set in the general Automation
Engine Preferences). When using a SmartName in one or both of these options, the Substrate
Size will show Custom.

If one or more of the SmartNames resolves to an invalid value, the task will fail.

Tip:

The Substrate Size you select here can be used to scale the input file's contents to the substrate
automatically (to do this, select Fit to page size or Fit to page width in the Transformations tab).

Transformations

Use the Transformations settings to scale or rotate your output relative to your input file.

1. If you want to Scale your input file's contents, select either:

• Scale by percent and enter the vertical  and horizontal  scaling percentages to use.

Note:

By default, you enter the vertical scaling percentage and the horizontal one is calculated
automatically to keep the proportions.

If you want to enter the horizontal scaling percentage manually, click  to unlink it from the
vertical one first.

However, if you do this then link the percentages again, the last percentage you entered will
be kept, and the other one will be recalculated automatically to keep the proportions.

• Fit to page size to fit your output to the substrate you defined in the Proofer settings, while
keeping the proportions (this will fit it to either the width or the height of the substrate, while
making sure everything is on the substrate).

• Fit to page width to fit it to the width of the substrate you defined in the Proofer settings,
while keeping the proportions.

If you don't want to scale your file's contents, leave Do not scale selected.

You can use SmartNames resolving to not (Do not scale), ByPercent (Scale by percent),
FitSize (Fit to page size) or FitWidth (Fit to page width).

When entering SmartNames for vertical and horizontal scaling percentages, they must resolve to
the numerical value (without the % sign).



8
Automation Engine

1208

2. If you want to Rotate your file's contents, select the rotation you want to apply here. This can be
0, 90, 180 or 270 degrees. Any other value will give an error.

Note:

• The direction of the rotation is the one you selected when configuring your Imaging Engine

(in the Settings tab). You will see  if you selected a clockwise or  if you selected a
counterclockwise rotation.

• You can use a SmartName that resolves to 0, 90, 180 or 270 (if you use a SmartName, the
task's default rotation direction, counterclockwise, will be used, regardless of what you
have configured for your device).

• You need to use a numerical value (ninety will not work).

• This is a public parameter, that you can fill in when submitting files through Shuttle.

PDF Objects

Use the PDF Objects settings to define:

• how to color manage RGB objects in your input file,
• what dot gain compensation to apply to your input file's images.

All parameters in this tab are public parameters, that you can fill in when submitting files through
Shuttle.

1. In Default RGB Profile, specify the profile to use if no profile is specified for a certain RGB object
in the input file. The default is srgb.icc.

You can use a SmartName that resolves to the full profile name.

2. Select Use PDF transfer curves if you want to use the dot gain compensation curves attached
to the images in your input PDF.

These curves compensate for the unwanted characteristics of the device that created the images
(scanner, digital camera...).

You can use a SmartName that resolves to true (to use the input file's curves) or false (to not
use them).

Document Inks

Use the Document Inks settings to select which separations of the input file(s) you want to proof.

For example, you can use these settings to exclude technical and/or varnish inks from your output.

See Selecting the Separations to Keep in the Output on page 1219 for more information.
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Note:

If your file contains PantoneLIVE inks and you don't have a PantoneLIVE license, the Ink Book
column will show unregistered, followed by an ID number (for example <unregistered
"b0c3126e-4f74-4402-8e47-e5e9fe50195a">) instead of the PantoneLIVE ink book name for
those inks.

In this case, you must exclude these inks from the output, or the task will end in error (with the
following message in the log file: This job contains PantoneLIVE inks, and the
necessary license for proofing these is not available.).

Color Management

• Select a Color Strategy to apply color management to the output file(s).

You can choose from a list of color strategies available in the resource server defined for your
Automation Engine server.

Note:

• The default color strategy is linear.

• You can only select a CMYK color strategy.

• You can select it through a public parameter, or using a SmartName. The SmartName for the
color strategy must resolve to one of the available color strategies.

Once you have selected the desired color strategy, you can see the Source and Destination
profiles used in the strategy.

Output

Use the Output settings to define what type of output you want and where to output it.

You can set these through public parameters or using SmartNames.

1. Enter your output File Name and output Folder.



8
Automation Engine

1210

Note:

• You can use Imaging-specific SmartNames for the File Name.

By default, it is set to:

• [File] for single page input files (which gives output file names like Myfile.tif),

• [File]_p[Page] for multi-page input files (which gives output file names like
Myfile_p1.tif).

This is a good default for composite output.

For separated output, we recommend you use:

• [File]_[ShortInk] for single page input files (which gives output file names like
Myfile_C.tif),

• [File]_p[Page]_[ShortInk] for multi-page input files (which gives output file names
like Myfile_p1_C.tif).

• The File Name and Folder can contain special characters (except \ / : * ? < > " |).

• The whole path to the output file (including the container, Folder and File Name) can be up
to 255 characters.

• You can set a local or remote URL for the output Folder, but it must be an absolute path.

• If your output folder doesn't exist yet, the task will create it if the location you request is
valid (you should place this folder on an Automation Engine container accessible by your
Automation Engine user).

If the output folder creation fails, please check the task log for the full list of conditions and
adapt your output folder path accordingly.

2. Define what to do if a file of the same name already exists in your output folder:

a) Click Set Overwrite Policy...
b) Choose what to do If files exist already. You can either:

• Extend the file name if you want to keep the existing output file and give the new output
file a different name. In this case, your new output file name consists of:

• the Output File Name (the File Name you set earlier) - which is what the file would be
called if no file with the same name existed,

• a custom suffix that you can define using plain text and/or SmartNames (by default, this
is _c, for "copy"),

• an automatic suffix made of the three last digits of the task ID,
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Tip:

To see the task ID of your tasks:

1. Go to the Pilot's Tasks pane (in the Files or Tasks view).
2. Go to  View > Select Columns in 'Tasks'...
3. In the Columns dialog, select Task ID in the Available columns list and click  to

move it to the Show these columns: list.
4. Click OK.
5. You now have a Task ID column in the Tasks pane, listing the task ID of all the tasks.

• the file extension.

For example, your input file is called file.pdf and you have left the tasks' output File
Name to its default value (the SmartName [File]).

The first TIFF you generate will be called file.tif.

If you generate output from this input file again, with the task 3668, and you have set the
overwrite policy to Extend the file name with the default Output File Name + _c + ID
name, the new output file will be called file_c668.tif

Tip:

• If you are working with the Bitmap Viewer, we recommend you keep the default overwrite
policy (Output File Name + _c + ID), which is compatible with the Bitmap Viewer.

• If you are not, you can define the custom suffix as you wish. For example, you could
use date and time SmartNames.

• Overwrite the existing file(s).

• End the task in error.

Note:  If you use a SmartName to set this, it must resolve to extend or 0 (for Extend the file
name), overwrite or 1 (for Overwrite), or error or 2 (for End the task in error).

c) Click Set.

3. Select the output File Type you want. This can be a TIFF File or a PDF File (see RIP'ed File
Formats on page 1147 for more information).

• For TIFF files, you can choose to output either composite or separated files.

To output Composite files, select 1 File Per Page in File Assembly (or use a SmartName that
resolves to FilePerPage). The Output Type is then automatically set to Composite.

To output Separated files, select 1 File Per Separation in File Assembly (or use a SmartName
that resolves to FilePerSeparation). The Output Type is then automatically set to
Separate.
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Note:

Those separated files are shown in the correct separation in the Bitmap Viewer (as it can read
the separation information in the XMP data) and in grayscale in other viewers.

When proofing them, they are also in the correct separation (for example the proofer proofs
the Magenta file using the Magenta cartridge).

• For PDF files, the task always generates Composite files. The File Assembly is automatically
set to 1 File Per Page, and the Output Type set to Composite.

Note:

With separated output, you can easily see how color management affects your output separations
relative to the input separations.

• If you are using a linear Color Strategy (that doesn't color manage process colors), the
process separated output files will contain the same objects as the corresponding separations
in the input file.

In the CMYK example below, each solid object in an input separation is the same in the output
separation (for example the Cyan bar is still only 100% Cyan).

• If you selected something other than linear in the Color Strategy (you are color managing
all separations of your file), the process output separations will be different from the
corresponding input separations.

In the CMYK example below, each solid object in an input separation is now made up of
several output separations (for example the Cyan bar is now 60% Cyan, 36% Magenta and
22% Black, and appears in these three separated output files).
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Note:

• Every output file that Imaging Engine generates contains XMP information (metadata about
file creation, separations, calibration curves, etc.).

You can view this XMP information by selecting your output file in the Automation Engine

Pilot's Files view and clicking .

For more information about XMP metadata, see the XMP Metadata white paper on
help.esko.com.

• TIFF files produced by Imaging Engine are fully compatible with Esko's Bitmap Viewer and
DotSpy.

4. Choose the Compression to use for your output file(s).

• For TIFF output, you can choose between lossless and lossy compression. Lossless
compression preserves all the detail in the file, while lossy compression removes some detail.

We recommend you use lossless compression for the final output (for files you will send to a
third party RIP for example), and lossy compression only for previews and thumbnails.

For both compression types (lossless and lossy), you should then choose a compression
method, based on the compression speed and the compressed file size. Typically, faster
compression methods compress the file less, so the output file is bigger (note that TIFF files
can be a maximum of 4GB).

If you want
lossless
compression...

choose either:

• PackBits, a fast lossless compression method for
graphic files.

Tip:  Use this if you want fast output and file size is not
too much of an issue.

• LZW, a lossless compression method for graphic files
and other files.

Tip:  This compression method works best for files with
large images.

If you want lossy
compression...

choose one of the JPEG compression methods (those
are more suitable for images like photographs and natural
artwork than sharp edged or flat color images like line art
or lettering, as JPEG compression tends to introduce noise
into solid color areas).

They are sorted from very low compression (JPEG
Limited), which doesn't lose much detail but doesn't
reduce the file size much, to very high compression (JPEG
Extreme), which reduces the file size a lot but loses a lot of
detail.

http://help.esko.com/docs/en-us/suite-general/14/otherdocs/AE_XMPMetadata_Suite14_WhitePaper.pdf
http://help.esko.com/docs/en-us/suite-general/14/otherdocs/AE_XMPMetadata_Suite14_WhitePaper.pdf


8
Automation Engine

1214

• For PDF output, all available compression methods are lossless.

You should choose a compression method based on the compression speed and the
compressed file size. Typically, faster compression methods compress the file less, so the
output file is bigger (note that PDF files can be a maximum of 12GB).

Choose either:

• PackBits (see above).

• Flate, a lossless compression method similar to zipping, based on the LZW compression.

Tip:  This compression method works best for images with large single color areas or
repeating patterns.

• JPEG 2000, a compression method based on JPEG and suitable for large images (the
version of JPEG 2000 used by Imaging Engine is lossless).

Tip:  The Compression method offered by default for the output File Type you select (LZW for
TIFF and PackBits for PDF) is generally the best for this file type.

Attention:

• When using a SmartName to set the output file's Compression, it must resolve to one
of the following (case insensitive):

• PackBits, LZW, JPEGLimited, JPEGLow, JPEGStandardLow, JPEGStandard,
JPEGStandardHigh, JPEGHigh, or JPEGExtreme for TIFF output,

• PackBits, Flate or JPEG2000 for PDF output.

Setting any other value, or an unsupported compression for the file type you chose,
will make the task error (with the message Unsupported combination of output
type and compression in the log).

• If you have already set the Compression but decide to change the output File Type,
by default the task will either:

• keep the same Compression (if it is supported for the new output File Type),

• or (if it isn't), set it to the first Compression available for this File Type.

You can still change it as desired.

5. Set the Resolution of your output files.
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Note:

• The Resolution unit is taken from the general Automation Engine Preferences.

• You can enter values from 1 to 25400 ppi (or equivalent in your unit). SmartNames must also
resolve to a value in that range.

• Values in another unit than the one from the general Preferences will be recalculated, and
values like 300ppi + 500ppm will be calculated correctly.

6. If your input file contains images, the images' pixels may not map exactly to output pixels because:

• the images' resolution is different from the output resolution you chose,
• scaling and rotation effects change the size and placement of the images' pixels.

You then need to resample these images to be able to output them at the same resolution as
the rest of the file.

In the Resample Images option, choose the resampling method you want to use (you will have
to make a trade-off between processing time and image quality).

• Choose From File to use the resampling method defined in the input PDF (this is the default
option). This method can be either:

• the "nearest neighbor" algorithm, which keeps the image very sharp but can make it look
jagged (pixellated but sharp). This is mostly recommended if you have small images with
sharp lines/sudden differences in intensity, and/or you do not want your images to be fuzzy
at all.
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This resampling method is very fast.

• the "PDF interpolation" algorithm, that smoothes the image while resampling (see below).

Note:  Most PDF files don't specify a preferred resampling method, so the default ("nearest
neighbor" algorithm) is used. If you want to make sure that the "PDF interpolation" algorithm
is used, choose PDF Interpolation instead of From File in the Resample Images option.

You can also use a SmartName resolving to FromPDF.
• Choose PDF Interpolation to smooth the image while resampling.

With this method, you get images that are pixellated and fuzzy, so it is only recommended if
you have small images with gradual differences in intensity, like photographs of nature.

This is slightly less fast.

You can also use a SmartName resolving to PDFInterpolate.
• Choose Auto Resampling to upsample the images to an automatically calculated resolution

(generally half or a third of the output resolution) before smoothing it.

When using this, images are a lot less pixellated and fuzzy.
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This method is quite slow but gives images of a good quality, so it is recommended in most
cases (unless you want an extra sharp image, in which case you should choose From File).

You can also use a SmartName resolving to ResampleAuto.
• Choose Full Resampling to upsample the images to the full output resolution.

This is the slowest method but gives the highest quality images (not pixellated and only slightly
fuzzy).
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Use this if Auto Resampling doesn't give you the results you want.

Attention:

Resampling to full resolution can require significant amounts of memory when the
output resolution is high (especially from 4000 dpi).

If you want to do this, we recommend that you have at least 8GB of RAM available
for each worker (see Installation).

You can also use a SmartName resolving to ResampleFull.

Note:

If your image is not...

• an 8 bit image,
• an image with 1, 3 or 4 components (for example grey, RGB or CMYK),

then the From File option is always used.

Summary

This shows a summary of all the settings you defined in the ticket.

• To show the settings from a tab, click + beside the tab name in the right pane.

Click Expand All to show the settings from all tabs.
• To hide the settings from a tab, click - beside the tab name in the right pane.
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Click Collapse All to hide the settings from all tabs.

8.7.5 Working with Separations

When working with the Imaging Engine tasks, you will often need to:

• Select which separations you want to include or exclude when proofing or RIP'ing.

See Selecting the Separations to Keep in the Output on page 1219.

• Apply different (screening and) dot gain compensation settings to the separations you are
including in the output (when RIP'ing).

See Applying Different RIP'ing Settings to your Output Separations on page 1223.

Selecting the Separations to Keep in the Output

When proofing or RIP'ing with one of the Imaging Engine tasks, you can select which separations of
the input file(s) you want to actually proof or RIP in your task's Document Inks settings.

For example, you may want to exclude technical and/or varnish inks from your output.

You can choose to proof or RIP either:

• All separations.

• A number of separations you select Manually (see Selecting Inks Manually on page 1219).

Note:

You can only select separations manually when running the task on a single input file.

• A number of separations you select by using selection criteria (see Selecting Inks Using
Selection Criteria on page 1220).

Selection criteria are rules that you define to select separations automatically for you when the
task is launched on a file.

This is more advanced but also more powerful than selecting separations manually.

We recommend that you select separations manually when you first start working with Imaging
Engine, then switch to using selection criteria when you want to automate your workflow a bit
more.

Tip:

To get used to working with selection criteria, try the following on a few of your files:

1. select the separations you want to output manually,
2. then change Select Inks to by using selection criteria and see which rules have been created

based on your manual selection.

Selecting Inks Manually

Note:  You can only select inks manually when you are launching the task on a (single) file, not when
you are defining a generic ticket without an input file.
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When choosing to Select Inks Manually, you will see a table containing all of your document's inks,
showing each ink's:

• Ink Name,

• Ink Book,

• Ink Index (the order of that ink in the document),

• Ink Type,

• Printing Method.

Select the ink(s) you want to RIP, or select the toggle in the table header to select/deselect all inks.

You will see a table listing the Selected document inks, and another table with the Document inks
that are not selected.

Attention:  If no ink is selected, you cannot launch the task.

Switching from Selecting Inks Using Selection Criteria to Selecting Inks Manually

You can switch between the two methods of selecting inks, and this will keep the same inks selected.

When switching from selecting inks using selection criteria to selecting inks manually, all the inks
selected by the rules you defined (the inks in the Selected document inks table) become selected
manually.

Note:  You can only switch to selecting inks manually when you are launching the task on a (single) file.

Selecting Inks Using Selection Criteria

If you don't want to select inks manually every time, you can define some rules to automatically select
certain inks in your input file(s).

You can do this:

• either when running the task on one or more files, or when creating a task ticket to use later,
• by choosing to Select Inks by using selection criteria in the Document Inks settings.

This is how it works:

• Each rule you create will check something about the inks in your file.

This check can be about the Ink name, Ink book, Ink Index, Ink type or Printing method. For
example, you can check if the Ink book is designer.
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Tip:

The Ink index is the order in which the ink will be printed (the ink with ink index 1 is at the bottom
of the document and will be printed first).

To find the index of a file's inks:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an index of 1, the second of
2, etc.).

Note that if you reorder the inks by one of the columns (for example by Ink name), they won't
be ordered by ink index anymore. You will need to close that dialog and reopen it to see the ink
index order again.

• You can create as many rules as you want.

• You can decide if you want to select the inks that match All of your rules, Any of your rules (at
least one) or None of your rules (if you want to exclude the inks that match the rules).

Build your rules the following way:

1. Choose how to apply your rules:

• Select All of the following are true if you want to only select the inks that match all of the
rules you define.

• Select Any of the following are true if you want to select all the inks that match at least one
of the rules you define.

• Select None of the following are true if you want to only select the inks that match none
of the rules you define.

2. Define your first selection rule.

You can select an ink based on its:

• Ink name: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink book: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink index: you can define if it equals/is less than/is greater than the number you enter, or is
is between the two numbers you enter (in this case the ink indexes you enter as boundaries
are also selected).

• Ink type: you can define if it is a piece of text (alphanumerical characters).

• Printing method: you can define if it is a piece of text (alphanumerical characters).

See the Printing methods section of the Automation Engine documentation for more
information about printing methods.

For example, you could define the following rules to exclude a technical ink called "crease":

None of the following are true
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Ink name is crease
Ink book is Visualizer Standard Finishes
Ink type is Technical
Printing method is Unknown

Tip:

• You can enter several values to check for: just use a semicolon (;) between them.

For example, to check for both inks called Cyan and inks called Magenta, choose Ink name
is and enter Cyan;Magenta.

• When launching the task on a file, you can also click  to select one or more of the Ink
names/Ink books/Ink types/Printing methods used in your input file(s).

A rule will automatically be created based on your selection.

3. Click + to add more rules and define them.

To remove a rule, click - next to it.

Tip:  If you are launching the task on a single input file, you will see a table listing the Selected
document inks, and another table with the Document inks that are not selected under the rules
you defined.

Attention:  If no ink is selected, you cannot launch the task.

Switching from Selecting Inks Manually to Selecting Inks Using Selection Criteria

You can switch between the two methods of selecting inks, and this will keep the same inks selected.

When switching from selecting inks manually to selecting inks using selection criteria, the task will
translate your manual ink selection into rules, so that the same inks are selected (you can see them
in the Selected document inks table).

The rules you get are based on the characteristics of the inks you selected.

For example, if you selected all the process colors but no spot color in your file (for an offset job),
you will get the following rules:

All of the following are true

Ink name is Cyan;Magenta;Yellow;Black
Ink book is process
Ink type is Normal
Printing method is Offset



8
Automation Engine

1223

Note:

If you...

• first selected inks using selection criteria,
• then switched to manual selection without changing the selection,
• then switched back to selection criteria,

... then your rules will be kept.

If you did change the selection in manual mode, the task will automatically generate new rules.

Applying Different RIP'ing Settings to your Output Separations

Once you have selected which separations you want to include in your RIP'ed output, you can choose
to apply different RIP'ing settings to these separations.

• When generating unscreened output with the Image to Unscreened Separations task, you can
choose which dot gain compensation settings to apply.

• When generating screened output with the Image to Screened Separations task, you can choose
which screening and dot gain compensation settings to apply.

In both cases, you can define default settings for most or all of the selected separations, and
exceptions to these settings if you want to RIP some of these separations differently.

You can define those exceptions in two ways:

• Manually (see Defining Exceptions Manually on page 1173).

Note:  You can only define exceptions manually when you are launching the task on a (single) file,
not when you are defining a generic ticket without an input file.

• by using exception criteria (see Defining Exceptions Using Exception Criteria on page 1171).

Exception criteria are rules that you define to apply certain RIP'ing settings to certain separations
automatically when the task is launched on a file.

This is more advanced but also more powerful than applying RIP'ing settings to separations
manually.

We recommend that you apply RIP'ing settings manually when you first start working with Imaging
Engine, then switch to using exception criteria when you want to automate your workflow a bit
more.

Tip:

To get used to working with exception criteria, try the following on a few of your files:

1. to apply your desired RIP'ing settings to certain separations manually,
2. then change Define Exceptions to by using exception criteria and see which rules have

been created based on your manual settings.

Defining Exceptions Using Exception Criteria

If you want to define exceptions to the default screening and/or dot gain compensation settings for
certain inks, you can do it using exception criteria.
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This works as follows:

• You create a rule per separation or set of separations that need specific screening and/or dot
gain compensation settings.

• Within each rule:

• You define criteria to select the separation(s) you want to apply specific settings to.

Each criterion will check something about the inks in your file.

This check can be about the Ink name, Ink book, Ink Index, Ink type or Printing method.
For example, you can check if the Ink book is designer.

Tip:

The Ink index is the order in which the ink will be printed (the ink with ink index 1 is at the
bottom of the document and will be printed first).

To find the index of a file's inks:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an index of 1, the second
of 2, etc.).

Note that if you reorder the inks by one of the columns (for example by Ink name), they won't
be ordered by ink index anymore. You will need to close that dialog and reopen it to see the
ink index order again.

• You select these settings.

• If you have several rules, you can reorder them in order of priority (the top one is applied first).

Note:  You can do this either when running the task on one or more files, or when creating a task
ticket to use later.

If you have chosen to Define Exceptions by using exception criteria, do the following:

1. Click Add.

2. In the Exception Properties dialog, enter a Rule Name.

3. Under If separation matches, define one or more criteria to select your desired separation(s).

a) Define your criteria the following way:

• Ink name: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink book: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink index: you can define if it equals/is less than/is greater than the number you enter,
or is is between the two numbers you enter (in this case the ink indexes you enter as
boundaries are also selected).

• Ink type: you can define if it is a piece of text (alphanumerical characters).
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• Printing method: you can define if it is a piece of text (alphanumerical characters).

See the Printing methods section of the Automation Engine documentation for more
information about printing methods.

Tip:

• You can enter several values to check for: just use a semicolon (;) between them.

For example, to check for both inks called Cyan and inks called Magenta, choose Ink
name is and enter Cyan;Magenta.

• When launching the task on a file, you can also click  to select one or more of the Ink
names/Ink books/Ink types/Printing methods used in your input file(s).

A criterion will automatically be created based on your selection.

b) Click + to define more criteria.

Note:  You can create as many criteria as you want, they will be applied from top to bottom
(the top one will be applied first).

4. Define the settings (Dot, Ruling, Angle and/or Press Curve) you want to use for the selected
separation(s).

5. Click Add.

You can see your rule and the settings you selected for the exception separation(s) in the Define
Exceptions dialog.

Tip:  You can double-click your rule if you still want to edit it.

6. Repeat steps 1 to 5 to define more exception rules if desired.

If you want to remove an exception, select it and click Remove.

Tip:  Leave the Preview option at the bottom of the dialog so you'll be able to see your exception
separation(s) with its/their settings in the main task panel.

7. Click OK to save your exceptions and close the Define Exceptions dialog.

Defining Exceptions Manually

Note:  You can only define exceptions manually when you are launching the task on a (single) file,
not when you are defining a generic ticket without an input file.

If you have chosen to define exceptions manually, do the following:

1. Click Add.

2. In the Exception Properties dialog, select the Separation you want to make an exception for.

3. Define the settings you want to use for this separation (Dot, Ruling, Angle and/or Press Curve).

4. Click Add.

You can see your exception separation with its settings in the Define Exceptions dialog.
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Tip:  You can double-click your exception if you still want to edit it.

5. Repeat steps 1 to 4 to define more exceptions if desired.

If you want to remove an exception, select it and click Remove.

Tip:  Leave the Preview option at the bottom of the dialog selected so you'll be able to see the
settings for that separation in the main task panel.

6. Click OK to save your exceptions and close the Define Exceptions dialog.

Switching How You Define Exceptions

You can switch between the two methods of defining exceptions, and this will give the same results.

Switching from Defining Exceptions Manually to Defining Exceptions Using
Exception Criteria

If you defined exceptions manually but then choose to Define Exceptions by using exception
criteria, the task will translate your manual exceptions into rules, so that the same inks are selected,
and they have the same exception settings.

For example, if you manually selected Cyan, Magenta and Black and assigned to each of these
separations the Press Curve CMK.dgc, you will get the following rules:

Rule Name: Cyan (process)
Ink name is Cyan
Press Curve: CMK.dgc

Rule Name: Magenta (process)
Ink name is Magenta
Press Curve: CMK.dgc

Rule Name: Black (process)
Ink name is Black
Press Curve: CMK.dgc

Tip:  The rule names are created automatically from the contents of the exceptions, but you can still
double-click each rule to edit them.

Note:

If you...

• first defined rules with exception criteria,
• then switched to defining manual exceptions but didn't make any changes,
• then switched back to exception criteria,

... then your rules will be kept.

If you did change the exceptions in manual mode, the task will automatically generate new rules.
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Switching from Defining Exceptions Using Exception Criteria to Defining
Exceptions Manually

If you defined rules with exception criteria but then choose to Define Exceptions Manually, each
separation selected by a rule will be selected individually, and have the settings you defined in the
rule.

For example if you had as criteria:

Ink name is Cyan;Magenta;Black
Ink book is process

and you selected as Press Curve CMK.dgc, you will get the following manual exceptions:

Ink Name Ink Book Press Curve

Cyan process CMK.dgc

Magenta process CMK.dgc

Black process CMK.dgc

Note:  You can only switch to selecting inks manually when you are launching the task on a (single) file.
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9. Integrating with External Systems

9.1 Introduction

This documentation is a guide for those who want to connect their Automation Engine server with
other systems. Typically these systems are

• Business systems like MIS (Management Information System) or ERP (Enterprise Resource
Planning). These systems usually have components like order entry, price calculation, customer
database, production planning, stock etc.. These systems can be purchased by your company
from an MIS vendor and then adapted to your specific business process or your company could
have created her own unique system.

• Asset Management systems. They focus on managing and sharing your prepress data and are
usually web-enabled.

A connection between your Automation Engine server and (one of) these systems is of course digital
and can be one-directional, bi-directional or, in case more than 2 systems are connected, even
triangular.

Note:  Throughout this document, for the sake of simplification, we will name such systems 'the
external system'.

Note:  Many features that we describe in this chapter require the optional module named Automation
Engine Connect.

Note:  A separate document is available on integrating Automation Engine with Esko WebCenter.

9.1.1 Why Integrate?

Faster.
No time is wasted by waiting, usually for a person.

Better.
Error reduction: no errors re-typing or misinterpreting. A small error can have huge costs. A wrong
'status' interpretation can have major production (cost) consequences.

More consistent, more process control.
Having a consistent way of working will benefit all. It is easier to train new people. It will be required
when your company is trying to receive quality certifications (ISO etc..).

Operators in both departments can focus on more added value tasks.
The freed up time can now be used to increase the quality of what they do or to think their actions
over. Hiring new (young) people will be easier when they see you have modern ways of working.
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Now let's have a look at what information typically is exchanged in each direction.

9.1.2 External System sending commands To Automation Engine

Create an Automation Engine Job and set Job parameters.
An Automation Engine Job represents a job order that you get from the business system. So it
is logical not to create those Automation Engine Jobs manually but to get your instructions from
that system in an automated digital way. All the parameters should then be picked up in a highly
automated workflow.

Create an Automation Engine Product and set Product parameters.
New design data that arrive can be automatically added to the Automation Engine Products
database, including the detailed product specifications like barcode and inks. Often, these design
data arrive before there is a job order to produce them. The workflow can link this newly created
product to a Job.

Start an Automation Engine workflow with parameters defined by the external
system.

Not all parameters need to be stored first in a Job or Product: Automation Engine can also retrieve
parameters from an external system during a workflow and use these parameters in subsequent
steps of the workflow.

9.1.3 Automation Engine sending commands To an External System

Setting Job or Product status in that external system.
The business system is very interested in what is happening with the job in the prepress department.
Being automatically informed on the exact status can have major benefits: Your sales/service people
will have up to date info for your customer. Your production will be more efficient when its planning is
based on reality. Automation Engine can send such feedback automatically. And based on that new
status, the external system may also decide to start an own automatic workflow.

Initiating actions on that external system.
Automation Engine could even do more than that. It could really talk to that external application, ask
questions and come back with a set of information.

9.1.4 Some general advice

Have a project manager
Appoint someone who owns the mission to do this. This integration can affect many people so
someone needs to be in charge. It is actually possible that it is the first time that these 2 different
departments (sales-service and prepress) are part of a same project. Each department will defend
its way of working. Each department will not know all complexities of 'the other side'.

Change Management
When you start eliminating some human intervention, it is possible that new questions will come to
the surface. Any changes in the way you work in such a busy production environment will need to
be defended. The integration is indeed technical but it is actually not 'just an IT project': the reason



9
Automation Engine

1230

you do this will be of interest to higher management. Often higher management is where such ideas
to integrate start. Making some changes will be necessary to get that higher efficiency that they are
looking for.

Step by Step
Start with a step that is 'obvious' and build from there. Before 'going live', carefully test and dare
to consider all sides of the changes that this integration will cause. Using both the new and the old
workflow can be confusing, so be prepared to switch over fast.

9.1.5 Need any help?

If you want help with your integration project, Esko offers 2 levels of service.

• Standard training by an Esko Academy trainer.

Esko trainers will explain the Esko part of the tools.

Tip:  After learning about the concepts and features in this documentation, we advise to also
check the chapter Examples on page 1287.

• Help from an Esko Solution Architect.

Esko Solution Architects are experienced in such system integrations and have a broader
knowledge of 'workflow', beyond the world of Esko products. Contact your Esko sales rep if you
want to know more.

9.1.6 What about JDF?

Note:  Job Definition Format is a standard language based on XML. It was created by the CIP4 group
to help standardize system integration in the printing industry. Read more on http://www.cip4.org

Integrations that use JDF/JMF require assistance from an Esko Solution Architect. That is why this
documentation does not cover JDF/JMF.

Note:  With some specific MIS, Esko optionally offers a 'standard' integration package based on a
White Paper. Some of these can be seen on http://www.esko.com/movies. Contact your sales rep
if you want to know more.

9.2 Integration Concepts

Let's distinguish the main concepts in integrating with Automation Engine. In many integrations,
several of these concepts are combined. There is no pre-defined order in which these concepts
whould be used in your particular case.

http://www.cip4.org
http://www.esko.com/movies
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The tools that we here introduce are documented in detail in the next chapters.

9.2.1 Access Points Triggering a Workflow on Automation Engine

Access Points trigger a workflow after they detected a signal from 'outside'. They use a 'polling'
mechanism: they check at a regular time interval if they have to trigger that workflow. There are 5
types of Access Points. You can create as many as you need.

A typical example is a classic hot folder (a Folder Access Point), where the incoming data is then
processed and the result is output on another folder. For example: design PDFs arrive in a hot folder,
from there they will be automatically trapped and then written to another folder.

However, Access points are not only used to start work on that incoming data. They can also receive
parameters for the workflow that they will start. These parameters define what needs to be done in
the workflow with some other (set of) file(s). For example: a Folder Access Point receives an XML from
the order entry system. The XML describes a list of re-run print Jobs. And for each Job it describes
which Products need to be linked into that Job and what quantity needs to be printed.

Or, instead of receiving those parameters, Access Points can go and search for them. For example:
a Database Access Point looks up the desired trapping distance in an external system. This results
in a SmartName the trapping task then uses.

Other types of Access Points are FTP, Mail and Web Service. Find their detailed documentation
in the chapter Access Points on page 1236.

It's all about SmartNames!
In most cases, these parameters that come in from the external system are turned into SmartNames.
And then these SmartNames will be picked up in the workflow tasks. These SmartNames can be
stored in Job or Product parameters, when they describe job or product characteristics that are
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relevant for the lifetime of the job or product. When the parameters are relevant only for the workflow
started by the access point, they can be used as workflow parameters.

9.2.2 Automation Engine tasks Interacting directly with the External
System

Not only Access Points can contact an external system. There are also 2 Automation Engine tasks
that are dedicated to interact with external systems. Contrary to Access Points, their interaction can
be bi-directional. Besides retrieving data from external systems, these tasks can also be used to
provide feedback to external systems. This will be described in more detail later. However, these
2 tasks are typically used because the workflow needs this interaction before it continues. The
result of these tasks will be used in the next steps of the workflow. As usual, this can be creating
Jobs or Products, or get values for SmartNames to be used in that workflow.

•
The Interact with Database task 

Automation Engine can use this task to read a value from an external database. For example: an
operator starts a workflow to Step & Repeat and output. The workflow asks the database of the
production planning system on which press this job will be printed. This is needed to know the
layout size and also any dot gain curve. This press choice can be decided very late, so it might
not have been part of the Job parameters that were created earlier.

Note:  Reading from an external database is also possible by using a simple SmartName query
or by using a Database Access Point.

Automation Engine can also use this task to write directly into the database of the external system.
For example to inform it on the new status of a Job or Product. When that system can not read
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XML messages with such information, then you can consider to have Automation Engine write
this information directly into the database of that system.

Caution:  This is a very direct way to have applications connect. This must be well
designed and carefully tested.

Important:  Esko takes no liability for queries that write or change fields in that external database.

•
The Interact with Web Service task 

The concept is very similar to the one above, but here the task uses HTTP calls to a web
service. Also here, both read ('GET') and write ('POST') commands are possible. When the
external system is running a web service, you will be able to access it via HTTP (Hypertext
Transfer Protocol). However, you also need to learn how to communicate to that system. Some
applications will indeed publish their API (Application Programming Interface). For example
Automation Engine can use this task to ask a question to Google Maps. This is only possible
because Google Maps did publish its API (and runs a web service). This example is illustrated in
the chapter Examples on page 1287.

Typically, both these tasks execute such interactions as part of a larger workflow in Automation
Engine. Find their detailed documentation in the chapter Tasks Interacting with other Systems on
page 1274.

Note:  The Integrate with WebCenter task is described in Advanced WebCenter Integration on page
1362, a chapter of the document on integrating Automation Engine with WebCenter.

9.2.3 Automation Engine Mapper tasks Transforming Data

Automation Engine offers many ways to use XML to control the workflow. Automation Engine also
offers many features to create XML files. But sometimes you need to create an XML with a different
content or formatting.

This Create XML File task is typically used to create XML files that are to be read by external systems.
In such XML files, you sometimes want more or less information. And sometimes you need to re-
format data in a way that the external system prefers.

Then there are the specific data formatting tasks like Split XML, Join XML or Map Data task. These
are powerful tools that offer many more ways to control XML files. Sometimes the data (information)
that comes from an external system first needs to be transformed before it can be used in Automation
Engine. Sometimes, these transformations are classic file conversions like CSV to XML. The Map
Data task was created to do this. Sometimes the XML will first need to be split in several XMLs (Split
XML task). Sometimes it will be useful to join several data files into one XML (Join XML task).
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Data transforming tasks can be used at any step in a workflow. They are used

• at the start of a workflow, to help transform what an Access Point delivered.
• at any other point in a workflow, also often at the end, to translate information into a format that

the external system prefers.

Find a detailed description of these tasks in the chapter Data Transforming Tasks on page 1255).

Transforming data from an Access Point

Here are some examples where such data transforming tasks are used right at the beginning of a
workflow that is started by an Access Point.

For example:

• The external system provides a list of jobs to be processed under the form of a large XML that it
writes on the Folder Access Point. The Split XML file  task then creates 1 XML file per job entry.
These separate XML files are then used for the Create Job task.

• The external system sends an CSV file on a Folder Access Point. The Map Data task first
transforms it into an XML. Later in the workflow, SmartNames will get their values by reading from
that XML file (Xpath queries).

• Some Access Points do not even result in data files yet. In case of a Database Access Point or
a Web Service Access Point, the accessed data can arrive as a several XML files. This is where
you can use the Join XML task to create a single and maybe even simpler XML file. Again, that
XML file is then typically the base to provide SmartNames their workflow specific value.

Transforming data from a workflow

There are many moments where it can be necessary to transform Automation Engine information.
Typically when sending information to external systems. Some of these external systems have their
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own mapping tools to read these incoming XMLs anyway. But sometimes you will be asked to have
Automation Engine transform them first.

Some examples:

• The MIS can not read an XML file but can read CSV. This is a classic use case for the Map data
task.

• The XMP (metadata) of a PDF needs to be sent to the external system as an XML. The LinkEdge
task does that. But maybe the MIS wants to have the ink coverage information formatted in a
different way. And maybe it is also necessary to convert the millimeters into inches.

• When using the Interact with Web Service task to ask the web service of Google Maps the
distance to a customer, the answer needs to end up in an XML or a SmartName.

• A Step & Repeat task requires a specific XML as input file, with a different structure than the one
from the external system.

• The Create Job task requires information that is present in 3 XMLs, from 3 different sources.

• The XML with feedback that you want to send to the external system needs to contain both a
Job status and some meta data from the PDF.

9.2.4 Automation Engine sending data Back to the External System

We briefly described this topic in the introduction (Automation Engine sending commands To an
External System on page 1229). Here, we add some detail and mention some tools.

A workflow in Automation Engine always generates output data, and often even many kinds. A lot
of that data is not just for other prepress components, but for external systems. We distinguish 2
main types of data:

• Sending Prepress data (back)

• Data for output devices like proofers and RIPs (CTP, DFE, Press)
• Data for people, often customer service or sales people or end-customers (PDFs attached in

e-mail or sent via FTP)
• Data for external systems, some of which web-enabled, often to view, approve or exchange

'assets'. In many cases it is not the original production files that are sent but smaller versions
(less Mb) or more secure versions like password protected PDFs (JPEGs, RGB-PDFs, viewer
streaming data, 3D files...)

• Sending Communication data (back).  Here, the goal is to inform. Some communication will
be about a status, for example 'plates made'. Some will be about describing the (new) prepress
data themselves, for example the ink coverage of a production PDF. This communication data
can also be files or it could be 'live':

• Communication files: XML, XMP-XML, CSV, TXT

• written on a network share, typically on a hot folder of the external system
• sent via e-mail or FTP

• Communicating directly with the external system: (see also Automation Engine tasks
Interacting directly with the External System on page 1232.)

• directly to its database, writing or updating fields
• directly to the web service of the API of that external system
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Transforming data before sending
Sometimes the external system does not support one of the above file formats or interaction
protocols. In those cases, the Map Data task can help to convert. Find an introduction to this concept
in Automation Engine Mapper tasks Transforming Data on page 1233.

Tip:  You do not always need to send a lot of Mb to send a lot of information. For example: an XML
describing de bar code parameters can be more useful than a high-res PDF. You could zoom-in on
the PDF but the XML will tell you even the non-visible parameters of that bar code (type, bar width
reduction, distortion...)

9.3 Access Points

An Access Point launches a workflow after it detected a signal from 'outside'. Automation Engine
offers 5 types of Access Points. The Folder Access Point is the most classic example and is also
often referred to as a 'hot folder'.

Tip:  We advise you to first read the introduction about the concept of Access Points in Access Points
Triggering a Workflow on Automation Engine on page 1231.

The Access Points Tool and View

In your Pilot, the Access Points Tool is where you create, modify and have an overview of your
Access Points.
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The top part of this view shows a list of all your Access Points.

The bottom part is a task monitor that shows the tasks that were executed by the selected Access
Point.

Working with Access Points (the basics)
We here list the main functionality that is available in tool bar and also via the File menu. The next
chapters will add detail per type of Access Point.

•
 to create a new Access Point.

•  to duplicate an Access Point. The selected Access Point will open with empty fields for
Name and Description.

•  to delete a selected Access Point. You will be asked to confirm.
•  to 'scan now'. To decide manually when the selected Access Point should scan for new files.

This can be useful when you do not want to wait for the time interval (see further).

Note:  This function is disabled for the Web Service Access Point.

To modify an existing Access Point, select it from the list and double click it to open and modify.

To deactivate  an Access Point, right-click it and choose Deactivate Access Point.

Differences in how they work

This table illustrates how some Access Points work in a slightly different way:

Table: Access Points - technical differences

Access Point Type Checks for data
at regular time

interval ('Polling')

Uploads that data Starts a workflow

Folder V V typically
FTP V V typically
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Access Point Type Checks for data
at regular time

interval ('Polling')

Uploads that data Starts a workflow

Mail V V typically
Database V - (**) typically
Web Service - (*) - (***) always

(*) The external system decides when to contact the Access Point

(**) goes to and gets info from an external database.

(***) waits until it receives an HTTP command from the external system

Access Point SmartNames
There is a specific category of SmartNames for Access Points. They enable smart re-using of many
attributes of an Access Point. All Access Point SmartNames are also automatically stored as workflow
parameters.

For more information on SmartNames, see the dedicated chapter SmartNames on page 916.

9.3.1 Folder Access Point

Concept

What is a Folder Access Point?

A Folder Access Point monitors a folder located somewhere in an Automation Engine Container.
Every time one or more files are uploaded into that folder, the Folder Access Point will move the
files to another folder where they will be processed. Folder Access Points are typically created to
launch a workflow using those incoming files as input files for that workflow.

However, you can also choose not launch a workflow. In that case the Access Point only serves to
upload files onto a specific folder in an Automation Engine Container.

Tip:  The chapter Examples on page 1287 contains an example case of a Folder Access Point.

Note:  Folder Access Points can also be used to process incoming JDF files. For more info on using
JDF, read more in What about JDF? on page 1230.

What about Hot Folders?

Before version 14 of Automation Engine, the user could create 'Hot Folders'. When you upgrade
to version 14, they will not be automatically migrated to Folder Access Points. They will stay Hot
Folders and will still function as they did before.

If you did create such Hot Folders in a version older than version 14, you will also keep your Hot
Folders View in the Pilot of your version 14. If you haven't created Hot Folders in Automation Engine
before upgrading to version 14, you will not see the Hot Folders view in the Pilot.

The following options were previously available in Hot Folders but are not available in Folder Access
Points. This is because there are now other and better ways to do these actions:
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• the annotation for the workflow task (you now write a 'description')
• grouped launching (you now can still create the effect by using a ZIP, but the most typical use

cases are covered when you use the dedicated 'gang run' related features)
• delete input files when the workflow is finished (this can be done with the Delete File task at the

end of your workflow)

Creating or modifying a Folder Access Point

Follow these steps to create or modify Folder Access Points:

1. In the Pilot click on Access Points view. Alternatively, choose Tools > Access Points .

2.
In the dedicated Access Points view, click on . Alternatively, choose  File > New .

3. In the resulting window, select Folder and click OK.
The New Folder Access Point window will open. Here is one with some typical settings already
filled in:

4. Enter a Name for the Access Point.

5. If you want, enter a Description.

This will help identifying your Access Point without having to read all its settings.

6. In the tab Folder Settings, define which folder will be the actual Access Point that will be
monitored by Automation Engine. Use the browse button to indicate it.

This folder needs to be inside a Container. This folder may not be inside another Folder Access
Point.

7. In the tab Monitoring, define the time interval.

• Check Every. Enter the time interval with which Automation Engine should check if any new
files came in. Think of the time interval as the maximum time it takes for the new files to be
picked up.

• Schedule. If you want this Access Point to be inactive during a part of the day, then activate
this option and indicate the start and end time of that period.

Note:  Such a temporary inactive state will not be shown in the general Access Points View.
In that View, the column 'Active' shows its general status.

8. In the tab Automatic Actions, define what needs to happen.
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• Move Files to. This is the folder where the files will be processed. If you want, use
SmartNames. These files have to be moved to avoid that the Access Point  would process
the same files again and again.

• Rename Files to. If you want you can choose to rename these files too. To do this, enter the
new file name.

Tip:  Typically, SmartNames are used here to help indicate in their name when they were
processed or where they came from.

• Action. Choose:

• None. Choose this option when you only want to use this Access Point to move the files.

• Workflow. Choose this option when you want a workflow to start. Select the workflow ticket
from the offered list. The new accessed files will be used as input files for this workflow.

Attention:  Make sure your workflow can start with the type of files that will arrive.

Options:

• Operator: choose the operator that will be shown as operator for the workflow task.

Tip:  If you do not want to assign one specific person, you could create an operator
named "Access Points" or "Automatic" and assign that one here. Also remember that
the Access Points Task Monitor shows you the tasks launched by the selected Access
Point.

Note:  If you leave this option blank, a system user "UPLC" will be used.

• Priority: choose the priority for this workflow: Low, Normal or High. The default priority
is 'Normal'.

• Process JDF. Choose this option when this Access Point will be used to process incoming
JDF files. For more info on JDF, read this section: What about JDF? on page 1230.

9.3.2 FTP Access Point

Concept

An FTP Access Point monitors a folder on an FTP site. At a regular time interval, it will check if
new files have arrived in that folder and it will move them to a designated folder in a Container of
Automation Engine.

Note:  There is no FTP server embedded in Automation Engine, so this functionality relies on a FTP
server that has been setup separately from Automation Engine.

This also works for new files in any subfolders of the scanned FTP site. Those files will be moved to
an identical structure of subfolders that will be automatically created.
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The FTP Access Point can also start a workflow on those files.

After uploading them, the Access Point deletes these files from the FTP site. However, the folders
(and subfolders) are not deleted. This way, the folder structure of FTP site stays intact.

Note:  The Pilot also offers a manual way to upload files from an FTP site. When you right-click on
a folder or Job Folder, the function Upload from FTP site is offered. This FTP Access Point is an
automated version of that feature.

Creating or modifying an FTP Access Point

Follow these steps to create or modify FTP Access Points:

1. In the Automation Engine Pilot go to the Access Points View. Alternatively, choose  Tools >
Access Points .

2.
In the dedicated Access Points View, click on . Alternatively, choose  File > New .

3. In the resulting window, select FTP and click OK.
The New FTP Access Point window will open. Here is one with some typical settings already
filled in:

4. Enter a Name for the Access Point.

5. If you want, enter a Description.

This will help identifying your Access Point without having to read all its settings.

6. In the tab FTP Settings, define where and how you wish to connect.
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• Server: Enter the name of the FTP server.

• File Transfer: Choose either Binary or ASCII.

Tip:  Binary will always work, but if you have an ASCII file, the transfer speed will be higher
when you choose ASCII.

• Connection Mode:

• Select Passive if there is a firewall between the FTP server and Automation Engine that is
blocking the FTP server from setting up connections to Automation Engine.

Tip:  By default, the FTP transfer uses Active Connection Mode (where the FTP server opens
the data connection). When Passive is selected, the system will use Passive Connection
Mode instead (where the client initiates the connection).

• Select Secure FTP if you are connecting to a secure FTP server (over FTPS, not SSL or
SSH). If you are experiencing problems using secure FTP, try connecting over regular FTP
and ask your IT administrator to check the security settings of your FTP server.

• User Name  and Password: Enter a valid user name and password for this FTP server.

• Folder: This is the folder on the FTP server that will be monitored. As mentioned in Concept
on page 1240, also its sub folders will be monitored.

• Customer: If you want to link a specific customer to this Access Point, use Select to pick it
from the list. Then you can use it as a SmartName.

7. In the tab Monitoring, define the time interval.

• Check Every. Enter the time interval with which Automation Engine should check if any new
files came in. Think of the time interval as the maximum time it takes for the new files to be
picked up.

• Schedule. If you want this Access Point to be inactive during a part of the day, then activate
this option and indicate the start and end time of that period.

Note:  Such a temporary inactive state will not be shown in the general Access Points View.
In that View, the column 'Active' shows its general status.

8. In the tab Automatic Actions, define what needs to happen.

• Move Files to.

• Folder. Indicate where you want the files to be moved to. Browse to a folder in a Container.
If you want, use SmartNames.

• Customer's Upload Folder. Alternatively, you can choose to move these files to the
Customer's Upload Folder. This is a folder you can define in the definition of the
Customer.

• Rename Files to. If you want you can choose to rename these files too. To do this, enter the
new file name.
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Tip:  Typically, SmartNames are used here to help indicate in their name when they were
processed or where they came from.

• Action. Choose:

• None. Choose this option when you only want to use this Access Point to move the files.

• Workflow. Choose this option when you also want a workflow to start. Select the workflow
ticket from the offered list. The new accessed files will be used as input files for this
workflow.

Attention:  Make sure your workflow can start with the type of files that will arrive.

Options:

• Operator: choose the operator that will be shown as operator for the workflow task.

Tip:  if you do not want to assign one specific person, you could create an operator
named "Access Points" or "Automatic" and assign that one here. Also remember that
the Access Points Task Monitor shows you the tasks launched by the selected Access
Point.

• Priority: choose the priority for this workflow: Low, Normal or High. The default priority
is 'Normal'.

• Process JDF. Choose this option when this Access Point will be used to process incoming
JDF files. For more info on JDF, read this section: What about JDF? on page 1230.

9.3.3 Mail Access Point

Concept

A Mail Access Point scans an e-mail account and extracts the e-mail attachments of new incoming
e-mail. These files are uploaded to a folder in a Container. A Mail Access Point can also start a
workflow on those files.

Here are 2 typical examples of how Mail Access Point SmartNames can help you do even more:

• You can agree with the e-mail sender to start the subject line with the Job number. This helps
you direct these files to the right folder.

• The address of the e-mail sender can be used to later send him an e-mail back about the status
of the files he sent.

Create or modifying a Mail Access Point

Follow these steps to create or modify Mail Access Points:

1. In the Pilot click on Access Points view. Alternatively, choose  Tools > Access Points .
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2.
Click on  to create a new Access Point. Alternatively, choose  File > New .

3. In the resulting window, select Mail and click OK.
The New Mail Access Point window will open up. Here is one with some typical settings already
filled in:

4. Enter a Name for the Access Point.

5. If you want, enter a Description.

This will help identifying your Access Point without having to read all its settings.

6. Define the Mail Settings:

• Incoming Mail Server: Enter the name of the mail server.

• Account Type: Depending on the mailbox configuration, choose either POP or IMAP.

• Secure Mail: Select this if the mailbox is a secure type.

• User Name and Password: Enter the user name and password of the mail account that will
receive the e-mails that you want to access.

• Customer: If you want to link a specific customer to this Access Point, use Select to pick it
from the list. You can then use it as a SmartName.

7. In the tab Monitoring, define the time interval.

• Check Every. Enter the time interval with which Automation Engine should check if any new
files came in. Think of the time interval as the maximum time it takes for the new files to be
picked up.
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• Schedule. If you want this Access Point to be inactive during a part of the day, then activate
this option and indicate the start and end time of that period.

Note:  Such a temporary inactive state will not be shown in the general Access Points View.
In that View, the column 'Active' shows its general status.

8. In the tab Automatic Actions, define what needs to happen.

• Move Files to.

• Folder. Indicate where you want the files to be moved to. Browse to a folder in a Container.
If you want, use SmartNames.

• Customer's Upload Folder. Alternatively, you can choose to move these files to the
Customer's Upload Folder. This is a folder you can define in the definition of the
Customer.

• Rename Files to. If you want you can choose to rename these files too. To do this, enter the
new file name.

Tip:  Typically, SmartNames are used here to help indicate in their name when they were
processed or where they came from.

• Action. Choose:

• None. Choose this option when you only want to use this Access Point to move the files.

• Workflow. Choose this option when you want a workflow to start. Select the workflow ticket
from the offered list. The new accessed files will be used as input files for this workflow.

Attention:  Make sure your workflow can start with the type of files that will arrive.

Options:

• Operator: choose the operator that will be shown as operator for the workflow task.

Tip:  if you do not want to assign one specific person, you could create an operator
named "Access Points" or "Automatic" and assign that one here. Also remember that
the Access Points Task Monitor shows you the tasks launched by the selected Access
Point.

• Priority: choose the priority for this workflow: Low, Normal or High. The default priority
is 'Normal'.

• Process JDF. Choose this option when this Access Point will be used to process incoming
JDF files. For more info on JDF, read this section: What about JDF? on page 1230.

9.3.4 Database Access Point
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Concept

A Database Access Point  reads, at a regular time interval, information from an external database.
That information is written into one or more XML files. The Database Access Point  can also start
a workflow.

A typical use case is checking an external system for a new status. That new status will be a reason
for Automation Engine to start an action. For example: in that external database, when the status of
a Job or Product is found on "preflight required", Automation Engine starts a preflight workflow. Or
the output tasks will be started for all jobs that are found in a status "Jobs to expose".

Tip:  The chapter Examples on page 1287 contains an example case of a Database Access Point.

To prevent that these statuses keep triggering these actions over and over again, the Database
Access Point offers the choice to update or delete those (status) fields. For example: the status
"Proof required" would be updated to "Proof started on Esko".

These use cases are often identical to those where an external system sends an XML file to
Automation Engine. Here are some typical reasons to use a Database Access Point instead of such
an XML transfer:

• The external system can not export the wanted data to XML. Or it would require an expensive
intervention or an upgrade of the software version.

• Exporting an XML would be a manual action by a user of that external system. And all manual
actions can be forgotten.

Create or modifying a Database Access Point

Follow these steps to create or modify a Database Access Point:

1. In the Pilot click on Access Points view. Alternatively, choose  Tools > Access Points .

2.
Click on  to create a new Access Point. Alternatively, choose  File > New .

3. In the resulting window, select Database and click OK.
The New Database Access Point window will open up. Here is one with some typical settings
already filled in:
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4. Enter a Name for the Access Point.

5. If you want, enter a Description.

This will help identifying your Access Point without having to read all its settings.

6. Define the Database Settings:

• External Database: Select the database from the list. The list shows the External Databases
that you configured via  Tools > Configure .

• Enter the desired SQL Select Query: The query will search for records or it will search specific
values in one or more columns. An XML file will be generated for each record that matches
the query.

Here is an example of a such an XML file. The query was looking for more info on Jobs with
the status 'New'. This XML shows the resulting details of the Job 1213. See how the 'Select
*' returned all the columns of the row of this Job 1213: name, operation etc...

?xml version="1.0" encoding="UTF-8?>
<design select="SELECT * FROM design WHERE status = "NEW""
 producer="DBPoller-MIS-1" created="2013-04-24T11:26:14.210+02:00">
    <id>1213</id>
    <name>MyDesign</name>
    <operation>CreateJobCard</operation>
    <width>12</width>
    <height>500</height>
    <depth>50</depth>
    <status>NEW</status>
</design>
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Note:  As soon as you select a Database Access Point, the query will be checked if it is valid.
If it is not valid, an error message will be shown.

• After Processing: Now choose what should happen after the results  from the query were
processed.

• Delete the records: This will delete the records that the query selected in the external
database. It will make them empty.

• Update the records: This will update the records that the query selected in the external
database with a new value. Click on Add to update the desired parameters. Fill in
the Column Name and the New Value in that database column and click OK.

Note:  If you want to update a record that contains a date and/or time, use the
format yyyyMMddHHmmss for the new value of the column or use now to insert the date
and time of the moment that the record is updated.

7. In the tab Monitoring, define the time interval.

• Check Every. Enter the time interval with which Automation Engine should execute this
database query.

• Schedule. If you want this Access Point to be inactive during a part of the day, then activate
this option and indicate the start and end time of that period.

Note:  Such a temporary inactive state will not be shown in the general Access Points View.
In that View, the column 'Active' shows its general status.

8. In the tab Automatic Actions, define what needs to happen.

• Move Files to. Indicate where you want the resulting XML file(s) to be written. Browse to a
folder in a Container. If you want, use SmartNames.

• Rename Files to. If you want you can choose to rename these files too. To do this, enter the
new file name.

Tip:  Typically, SmartNames are used here to help indicate in their name when they were
processed or where they came from.

• Action. Choose:

• None. Choose this option when you want no further action.

• Workflow. Choose this option when you also want a workflow to start. Select the workflow
ticket from the list.

Attention:  Make sure your workflow finds its input files. These can be the XML files
from the query but that is not required.

Options:

• Operator: choose the operator that will be shown as operator for the workflow task.
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Tip:  if you do not want to assign one specific person, you could create an operator
named "Access Points" or "Automatic" and assign that one here. Also remember that
the Access Points Task Monitor shows you the tasks launched by the selected Access
Point.

• Priority: choose the priority for this workflow: Low, Normal or High. The default priority
is 'Normal'.

9.3.5 Web Service Access Point

Concept

When a system has a web service, other software applications can send commands or queries to
that system using HTTP requests to the URL of the web service.

Note:  Some users prefer this way of direct communication rather then exchanging (XML) files on
hot folders.

Automation Engine also has a web server. A Web Service Access Point is a way for external systems
within the intranet to start workflows on Automation Engine by sending a command to the web
service of Automation Engine.

Tip:  In this section on differences between Access Points, you can read how a Web Service Access
Point works somewhat different than the other types of Access Points. One important difference is
that the Web Service Access Point does not use the concept of time intervals. It is the external
system that fully decides when to send a command to Automation Engine.

The HTTP requests can be both HTTP POST requests and HTTP GET requests. If the HTTP POST
request also 'posts' data files, then they will be used as input files for the workflow that will be started.

Note:  When using a HTTP GET request, parameters of the web service call are encoded in the URL
using HTTP query strings. When using HTTP POST requests, the parameters are encoded in the
content part of the HTTP request.

Checking the Automation Engine Web Service

The web service of Automation Engine will be running automatically on the Automation Engine server.

Note:  You actually also use this web service when you access the Automation Engine Client Apps
in a browser.

You can check the status of the Automation Engine Web Service by entering this in a browser:
http://<name of your server>:<port>/ws/ .The port number is the one as defined in the
Configure tool > Automation Engine Web Service. By default this port number is 4415.
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For example: if your Automation Engine server is named AESERVER1, then the URL to enter in your
browser is http://aeserver1:4415/ws/

The web page that then appears offers more guidelines on formatting more detailed HTTP
commands.

Creating a Web Service Access Point

Note:  Setting up a Web Service Access Point is simple. The complexity lies in the content of the
HTTP requests that are sent to it (see next chapters).

Follow these steps to create or modify a Web Service Access Point:

1. In the Pilot click on Access Points view. Alternatively, choose  Tools > Access Points .

2.
Click on  to create a new Access Point. Alternatively, choose  File > New .

3. In the resulting window, select Web Service and click OK.
The New Web Service Access Point window will open up. Here is one with some typical settings
already filled in:

4. Enter a Name for the Access Point.

This name will automatically be used to complete the URL for this Access Point.

5. If you want, enter a Description.
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This will help identifying your Access Point without having to read all its settings.

6. See the resulting URL. This is where the external system needs to send its command to launch
the workflow defined below.

7. Select the Workflow that this Access Point will start.

Options:

• Operator: choose the operator that will be shown as operator for the workflow task.

Tip:  If you do not want to assign one specific person, you could create an operator named
"Access Points" or "Automatic" and assign that one here. Also remember that the Access
Points Task Monitor shows you the tasks launched by the selected Access Point.

• Priority: choose the priority for this workflow: Low, Normal or High. The default priority is
'Normal'.

HTTP POST Requests

Launching a workflow using an HTTP POST request

The HTTP POST requests must meet the following requirements:

• The value of the Content-Type header of the HTTP POST request should be, in most cases,
multipart/form-data.

• HTTP request parts can be added to the HTTP POST requests to attach data files and/or to add
parameters (also see further).

• For every HTTP request part that is added to an HTTP POST request, a Content-Disposition
header should be present.

• For each data file, the (UTF-8 encoded) file name of the data file should be specified in the
corresponding Content-Disposition header.

• For each parameter, the name of the parameter should be specified in the corresponding
Content-Disposition header.

• The encoding of the HTTP POST requests should be base64 or no encoding (for example binary,
8bit,…).

For example:

POST /ws/myFavoriteWorkflow HTTP/1.1
Host: aeserver01:4415
Content-Type: multipart/form-data;
 boundary=----------------------146677a63ef
Content-Length: <length of request body in octets (8-bit bytes)>
...  
----------------------146677a63ef
Content-Disposition: form-data; name="wfparam1"
 
2mm
----------------------146677a63ef
Content-Disposition: form-data; name="wfparam2"
 
4mm
----------------------146677a63ef
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Content-Disposition: form-data; name="inputfile1";
 filename="inputfile1.pdf"
Content-Transfer-Encoding: binary
 
<binary contents of inputfile1.pdf>
----------------------146677a63ef
Content-Disposition: form-data; name="inputfile2";
 filename="inputfile2.pdf"
Content-Transfer-Encoding: binary
 
<binary contents of inputfile2.pdf>

Attaching data files to be used as input files for the workflow that is launched

You can attach data files to be used as input files for the workflow that is launched by adding them
as HTTP request parts to the HTTP POST request. For each data file, the (UTF-8 encoded) file name
of the data file should be specified in the corresponding Content-Disposition header.

For example:

POST /ws/myFavoriteWorkflow HTTP/1.1
Host: aeserver01:4415
Content-Type: multipart/form-data;
 boundary=----------------------146677a63ef
Content-Length: <length of request body in octets (8-bit bytes)>
...
 
----------------------146677a63ef
Content-Disposition: form-data; name="inputfile1";
 filename="inputfile1.pdf"
Content-Transfer-Encoding: binary
 
<binary contents of inputfile1.pdf>
...

When the workflow is launched, the data files are handled in one of the following ways:

• When the workflow is launched in a specific Job, the data files will be moved to the Job Folder.
• When the workflow is not launched in a specific Job and the workflow is successfully finished,

the data files will be deleted.
• When the workflow is not launched in a specific Job and the workflow did not finish successfully,

the data files will be kept in this shared folder:

\\<name of your server>\AutomationEngineTmpFolder

When no data files are attached to the HTTP POST request, the Web Service Access Point will
generate an XML file containing some information about the HTTP GET request. This XML file will
then be used as input file for the workflow to be launched and will be handled in the same way as
attached data files would be handled.

Launching a workflow in a specific Job

You can specify the Job in which the workflow should be launched by adding parameters as HTTP
request parts to the HTTP POST request. The name of each parameter should be specified in the
corresponding Content-Disposition header.

The Job in which the workflow should be launched can be specified using the Job ID, the Job Name,
the Order ID or using both the Order ID and the Sub Order ID. The parameters you need to add as
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HTTP request parts to the HTTP POST request are, respectively, jobid, jobname, orderid or orderid
and suborderid . The values for these parameters should be UTF-8 encoded.

For example:

POST /ws/myFavoriteWorkflow HTTP/1.1
Host: aeserver01:4415
Content-Type: multipart/form-data;
 boundary=----------------------146677a63ef
Content-Length: <length of request body in octets (8-bit bytes)>
...
  
----------------------146677a63ef
Content-Disposition: form-data; name="orderid"
 
2014-100254
...

Specifying the values of the workflow parameters of the workflow that is launched

You can also set the values of the workflow parameters of the workflow by adding parameters as
HTTP request parts to the HTTP POST request. These parameters should have the same names as
the names of the workflow parameter(s) which value you want to set. The values for these parameters
should be UTF-8 encoded . For each parameter, the name of the parameter should also be specified
in the corresponding Content-Disposition header.

For example:

POST /ws/myFavoriteWorkflow HTTP/1.1
Host: aeserver01:4415
Content-Type: multipart/form-data;
 boundary=----------------------146677a63ef
Content-Length: <length of request body in octets (8-bit bytes)>
...
  
----------------------146677a63ef
Content-Disposition: form-data; name="wfparam1"
 
2mm
...

HTTP GET Requests

Launching a workflow using an HTTP GET request

When using HTTP GET requests to launch workflows on a Web Service Access Point, no data files
can be attached.

Every time an HTTP GET request is received on the URL of the Web Service Access Point, it will
generate an XML file containing some information about the HTTP GET request. This XML file can
then be used as input file for the workflow to be launched.

• When the workflow is launched in a specific Job, this XML file will be moved to the Job Folder.
• When the workflow is not launched in a specific Job and the workflow is successfully finished,

this XML file will be deleted.
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• When the workflow is not launched in a specific Job and the workflow did not finish successfully,
this XML file will be kept in this shared folder:

\\<name of your server>\AutomationEngineTmpFolder

Launching a workflow in a specific Job

You can specify the Job in which the workflow should be launched by adding parameters to the
query string of the HTTP URL. The Job in which the workflow should be launched can be specified
using the Job ID, the Job Name, the Order ID or using both the Order ID and the Sub Order ID. The
parameters you need to add to the query string of the HTTP URL are, respectively, jobid, jobname,
orderid or orderid and suborderid. The values for these parameters should be UTF-8 encoded.

For example:

http://aeserver01:4415/ws/myFavoriteWorkflow?jobid=ee6b08ca-eecf-4cb7-
b2e1-254c20d82546
http://aeserver01:4415/ws/myFavoriteWorkflow?jobname=Libelle-2014-week12
http://aeserver01:4415/ws/myFavoriteWorkflow?orderid=2014-100254
http://aeserver01:4415/ws/myFavoriteWorkflow?
orderid=2014-100255&suborderid=001

Specifying the values of the workflow parameters of the workflow that is launched

You can also set values for workflow parameters by adding parameters to the query string of the HTTP
URL. These parameters should have the same names as the names of the workflow parameter(s)
which value you want to set. The values for these parameters should be UTF-8 encoded .

For example:

http://aeserver01:4415/ws/myFavoriteWorkflow?wfparam1=2mm
http://aeserver01:4415/ws/myFavoriteWorkflow?wfparam1=2mm&wfparam2=4mm
http://aeserver01:4415/ws/myFavoriteWorkflow?jobname=Libelle-2014-
week12&wfparam1=2mm

Error Handling

When using this Web Service Access Point, the corresponding HTTP responses should always be
checked because they can contain error messages.

In case the workflow was successfully launched, the HTTP response will contain the task ID of the
workflow task that was launched.

For example:

<?xml version="1.0" encoding="UTF-8"?>
<message>
    <response>taskid=dd145a15-49bb-4625-a0da-6d3aee663ae3</response>
</message>

In case the workflow could not be launched successfully and/or an error occurred, the HTTP response
will contain one or more error messages.

For example:

<?xml version="1.0" encoding="UTF-8"?>
<message>
    <error>
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        <code>-110</code>
        <msg>Problem loading ticket: swft/Web Service Access Point Test
 WF</msg>
    </error>
</message>

9.4 Data Transforming Tasks

We introduced the concept of these tasks in the chapter Automation Engine Mapper tasks
Transforming Data on page 1233.

Attention:  These types of tasks require good knowledge of SmartNames.

Attention:  The XPath Builder makes it a lot easier to extract parts from XML files. This tool
is documented in a separate chapter on SmartNames.

9.4.1 Create XML File task

The Create XML File task is typically used to export value from SmartNames to an external system.

Important:  This task does not use its task input file to start building the XML from. The content of
the XML that you will create is completely defined inside the task window.

Defining the content of the XML

The Create XML File task offers a blank canvas where you need to define all the content of the XML
that you want to create. In below example you see a combination of self written XML code (blue)
and some SmartNames (green). Click on + [ ] insert SmartName to pick a SmartName from the list.
Alternatively, right-click and choose a SmartName from the offered categories.
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Note:  The XML file has to start with an XML declaration. This line indicates the file encoding to
the reading application. To add such a line, you can simply right-click and choose Insert XML
Declaration to insert this industry default one: <?xml version="1.0" encoding="UTF-8"?>

Note:  Any links to externally defined XML schema (for example a reference to a DTD or XSD) may
influence performance. Preferably remove such links from the XML file.

• Replace reserved characters in SmartName values with XML entities: It is possible that the
SmartName returns characters that are not allowed in XML. With this option, you choose to map
these special characters mapped into these 'XML entities'. Below list shows these mappings:

Reserved characters in result value XML Entities
" &amp;quot;
' &amp;apos;
& &amp;amp;
> &amp;gt;
< &amp;lt;

• Task fails when output XML is not a valid XML file : Enable this option to have Automation
Engine check the validity of the XML. If this option is on, the task will fail if the XML is not valid.
The validation checks the XML formatting and the XML tag endings.

Note:  This task does not check XML schemas such as XSD, DTD, etc.
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9.4.2 Split XML Task

Concept

Sometimes you want to split XML files to make them more easy to use Automation Engine workflows.
These XML files typically come from an external system. The Split XML task needs 1 XML file as
input and will write 1 or more XML files as output. Some typical examples:

• Every morning your MIS system sends you a list with new Jobs and their details. To use that XML
for the Create Job task, you need to split it into 1 XML per Job.

• Your MIS system sends an XML per customer order, but your workflows are set up per production
item of an order. In this case, the Split XML task helps you to generate an XML file per production
item. This makes it easier to automate your workflow. This example is elaborated below.

Tip:  You can also use this task to split an XML that was created by Automation Engine itself. For
example to make that XML more manageable for an external system.

Supported input files
The input of this task is XML. Files with a different extension than .xml will not be recognised or
processed.

Note:  Exception: JDF files are also allowed as input. The resulting output will be XML files. These
XML files will no longer be valid as JDF file.

How to do you decide what to split?
How you split the task's input file is defined by XPath expressions. The built-in XPath Builder will
help you to do write those expressions. See further.

Example and Options

Example: The following code is grouping 2 production items in 1 XML file:

<?xml version="1.0"?>
<job>
  <commoncomponent>Z</commoncomponent>
  <commoncomponent content="Y" />
  <productionitem>
    <subelement content="A" />
    <subelement>1</subelement>
  </productionitem>
  <productionitem>
    <subelement content="B" />
    <subelement>2</subelement>
  </productionitem>
</job>

To split each production item into a separate XML file, set this expression in the XPath canvas:

/job/productionitem.
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This will generate these 2 files:

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<job>
  <commoncomponent>Z</commoncomponent>
  <commoncomponent content="Y" />
  <productionitem>
    <subelement content="A" />
    <subelement>1</subelement>
  </productionitem>
</job>

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<job>
  <commoncomponent>Z</commoncomponent>
  <commoncomponent content="Y" />
  <productionitem>
    <subelement content="B" />
    <subelement>2</subelement>
  </productionitem>
</job>

Note:  The SmartName [ File Number ] is available for this task only. It automatically generates a
unique file name.

Include the parent XML structure
This option will preserve all XML content that the XPath expression does not select.

Note:  In case of a conditional expression this will also include siblings that do not match the
condition.

If you only want to keep the parts that you selected with the XPath expression, then deselect this
option. Using the previous example, this will result in following XML files:

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<productionitem>
  <subelement content="A" />
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  <subelement>1</subelement>
</productionitem>

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<productionitem>
  <subelement content="B" />
  <subelement>2</subelement>
</productionitem>

When an input file contains a 'namespace declaration' in the parent XML structure ('xmlns'), then
that namespace declaration will be added as an attribute of the top level element. For example:

<?xml version="1.0" encoding="UTF-8"?>
<job xmlns:esko="http://www.esko.com/myowns/">
  <commoncomponent>Z</commoncomponent>
  <commoncomponent content="Y" />
  <esko:productionitem>
    <esko:subelement content="A" />
    <esko:subelement>1</esko:subelement>
  </esko:productionitem>
  <esko:productionitem>
    <esko:subelement content="B" />
    <esko:subelement>2</esko:subelement>
  </esko:productionitem>
</job>

Then the split result with namespace declaration on the top level element will be:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<esko:productionitem xmlns:esko="http://www.esko.com/myowns/">
  <esko:subelement content="A" />
  <esko:subelement>1</esko:subelement>
</esko:productionitem>

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<esko:productionitem xmlns:esko="http://www.esko.com/myowns/">
  <esko:subelement content="B" />
  <esko:subelement>2</esko:subelement>
</esko:productionitem>

Encoding

If the input XML file contains a header that specifies an encoding (for example
encoding="ISO-8859-3"), the task will write the output files in that encoding.

If no header or encoding is specified, the resulting files will have UTF-8 encoding by default.

XML Validation

The task will generate well formed XML, but there is no support for schema or DTD validation.
References to DTD's for validation will be removed.

Creating XPath Expressions

Usually you will not define the XPath expression by typing it in the task window yourself. Use the Edit
button to open de XPath Builder. This tool will help you create your own correct XPath expression
by clicking the variable elements. By selecting parts in the window with Example XML Content, you
will see the resulting XPath expression automatically appear in the top part of this tool.
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Important:  When the Example XML content window is empty, this means that you forgot to select
an XML input file before opening the Split XML task.

Selecting the option Select siblings allows you to automatically select the right level.

In above example, the user selected the level 'productionitem'. The selection is shown in yellow. The
siblings are also automatically selected and are shown in grey. The correct XPath expression that
is needed to split that level of elements will automatically appear in the top part of this tool.

You can easily build complex expressions with this tool, such as:

• selecting elements conditionally.
• selecting an element from a specific 'namespace'.

Find more information on the XPath Builder in The XPath Builder  on page 954 (chapter
SmartNames).

9.4.3 Join XML Files Task

Concept

The Join XML task joins the content of its input XML files. In case you do not want the full content
of all these input files, there are options to determine what parts you want or from what root level
down that you want their content.
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Some typical examples:

• The information you need is spread over several source XML files, maybe even coming from
different systems. You need (parts of) them combined in 1 XML file.

• You want to change the content of an XML. After splitting it you can re-join specific parts.

Note:  The Map Data task can also be used to join XML files, but it offers much more features and
options than this Join XML task.

Example and Options

The Join XML task joins multiple input XML files into 1 output XML file. The default option of this
task is to take the full content of the input files and join everything together into 1 XML file.

Name of the output XML file

The default name of the output XML file is set to [File]-joined. [File] is here the name of the first
input file. You can of course change this setting.

Xpath expression that extracts content from the input XML files

Tip:  In the previous topic about the Split XML task, we introduced Xpath expressions and also
introduced the XPath Builder tool.

This canvas is where you can define the content of the output XML. If you do not want the full content
of all your input files, use XPath expressions to define what you want to extract from them. Per input
file, all nodes that comply with the given XPath expression are imported into the output XML file.

Click on  to insert SmartNames to help build your XPath expression.
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Click on  to open the XPath Builder. For more info on XPath Builder please see The XPath
Builder  on page 954 (chapter 'SmartNames').

If this canvas is left empty, and if you didn't specify a Root Element, then all the nodes under the
root node are considered (XPath == /*/*).

Root Element in your output file

Each input XML file has its own root element. You can define here what you want as root element
in the output XML file. See an example where this root element was set to 'ink':

If this field is left empty, then the tag name of the root of the first input file will be used.

Example

You have these 2 XML files:

• One XML file lists ink attributes of a (first) ink of a PDF:

• Another XML file contains information on the ink coverage of that file:

You now want to join these 2 files into 1 XML file with all the ink attributes together.

• This is the result if you use no options:
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• This is the result when you set the option Root Element to PrintItem:

• This is the result when you also used the Edit button to add the XPath Expression /Job/ink
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Because the Xpath extracted only the content of <ink>, the pdf file name and the customer name
are not kept in this joined file.

Note:  To further change the structure, order or content, you can use the Map Data task.

9.4.4 Map Data task

Concept

The Map Data task is a powerful tool that can be used to

• convert CSV files into XML and vice versa.
• transform the content of a CSV or XML file: extract, join, rename or re-format parts.

Note:  A CSV or comma separated file is a structured text file. In such files commas or some other
character are used as field separators. CSV can be generated by exporting an XLS file in Microsoft
Excel.

Some example use cases:

• After interacting with an external system, you need to simplify or re-write the XML files that you
received.

• You need to combine information from different sources into 1 file, but also reformat it (this is more
than what the Join XML task can do). For example getting job specification from an incoming
XML file and getting ink information from the metadata of an uploaded PDF (XMP). You want to
combine those into one XML that can be used for the Job Creation task. To do this, the XMP ink
information should also be transformed to the XML format that is needed for Job Creation task.

• You need to transform an XML that you received before it can be used by the Create CAD Sheet
task.

• You receive an XML file with all possible sheet layouts. Now you need to create a list of these
layouts using a custom text format (for example plain text with line breaks, CSV or XML).

Tip:  The chapter Examples on page 1287 contains many examples that use this task.
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Main Tools in the Task Panel

The Map Data task panel consists of three main parts:

1. Option to choose the Output Format.
2. Canvas to specify the content of the output file of this task.
3. List of Parameters that you want to read from the task's input files.

Choose the Output Format

• XML: Click on Options to define these output format options:

• Replace reserved characters in parameter values with XML entities: It is possible that
the parameters from the input files return characters that are not allowed in XML. With this
option, you choose to map these special characters to 'XML entities'. Below list shows these
mappings:

Reserved characters in result value XML Entities
" &amp;quot;
' &amp;apos;
& &amp;amp;
> &amp;gt;
< &amp;lt;

• Task fails when output XML is not a valid XML file: Enable this option to have Automation
Engine check the validity of the XML. If this option is on, the task will fail if the XML is not valid.
The validation checks the XML formatting and the XML tag endings.

Note:  This task does not check XML schemas such as XSD, DTD, etc.
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• CSV: Click on Options to define this Output Format option:

• Text Encoding: Choose what type of text encoding that the system that will read this CSV
file prefers. The default is UTF-8.

Canvas to Specify the Content of the Output file

The canvas on the left there is where you can

• insert XML or CSV data from another file. This is the typical way to insert your example output
file, after which you can start replacing its absolute values with SmartNames or Parameters.

• insert Parameters from your input files (from the list on the right side of the panel)
• insert SmartNames
• insert Xpath expressions (the standard language to extract specific parts of an XML)
• ...

See more in Specifying the Output File on page 1271.

Tip:  Right-click in the canvas to get a list of content to insert.

A List of Parameters from your Input Files

In this field, you build up a list of parameters from your input files. You can then insert these
parameters easily in the canvas on the left, similar to how you insert SmartNames. These parameters
can come from one or more input files.

At the moment you set up the Map Data task, it is good practice to use example input files that
contain the same parameters as the files that will be the real input files of the Map Data task once it
is started in a workflow. It is also a good idea to start from a sample output file (see further).

See more in Setting Up (Example) Input Files on page 1266 and Adding Parameters on page 1269.

Main Workflow in Using the Map Data Task

Before we go in more detail explaining all the possibilities of this powerful task, it is good practice
to stick to following main workflow:

• Step 1: Get an example of the output file you need to create. Analyse its structure.
• Step 2: Get (an) example input file(s). Analyse its structure.
• Step 3: Create the parameters from the input file(s).
• Step 4: Specify the output file. Use your example output file and the parameters that you made

from the input file(s).
• Step 5: Test the resulting ticket in a workflow, using real input files.

Setting Up (Example) Input Files

Attention:  An example input file is a file that you use while you set up the Map Data ticket.
Be aware that this example file is often not your real input file once the task is running!
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Important:  The Map Data task allows to create parameters without the help of example input files
but this will be much more complex. We advise to create the parameters based on example input
files because it will help you with correct spelling, see the larger context and give you immediate
feedback.

2 ways to select an Input File

• In the Pilot, select one or more input files before you open the Map Data ticket. These files will
show up as input files.

• Open the Map Data ticket and click on Set Up Input Files....

Setting up an Input File is explained in more detail in the next sections of this document.

Working with Multiple Task Input files

By default a Map Data task will start as soon as it gets one input file. The task will not wait for a list
of input files to be complete. But you can easily solve that.

To make the Map Data task work on multiple input files, you need to make a workflow where you
have a Data Collector task before your Map Data task.

The Data Collector task will wait for outputs of previous tasks and hand them over as one group
to the next task.

How to Control the Order of Multiple Input Files

If your Map Data task has more than one input file, it is very important to control the order of those
input files. What you want to avoid is

• parameters that do not find their value because they look in the wrong input file.
• parameters that find a value but one that comes from the wrong input file.

Some examples that illustrate the importance of parameters looking in the correct input file:

• Your Map Data ticket is part of a workflow that creates a new Job. Does the parameter [date]
or [time] come from the input file from the MIS or from the metadata-XML from the PDF that the
customer sent you? The difference can result in a conflict about your due date of that Job!

• Your parameter [print technique] selects the field in row 2, column 5 of a CSV file. If this parameter
searches this field in the wrong input file, then your search can return "Rio de Janeiro" instead
of "Digital Flexo"!

To control the order of your input files, we advise to first use the Data Collector task, followed by a
Sort task and only then followed by the Map Data task.

The Data Collector task will wait for outputs of previous tasks and hand them over as one group
to the next task.



9
Automation Engine

1268

The Sort task enables you to sort that group. You can base the order on file name, time or
SmartNames.

Setting up (Example) Input Files - Details

1. Click on the Set up Input Files....

A panel opens that shows your current list of Input Files, their name and order in the list, their
type (XML or CSV) and if they link to an example file or not.

2. To add or modify one, click on Add or double click an existing Input file definition.

The Set Up panel opens.

3. Choose the File Type of the desired Input File: XML File or CSV File.

4. In case you chose CSV File, you can change the following CSV options:

• Text Encoding: Indicate the Text Encoding of the CSV file. The default encoding is Unicode
UTF-8.

• Field Separator: Indicate which character is used to separate the fields in the CSV. Check
your CSV in a simple text editor to detect it.

• Quote Character: Indicate if the value in the CSV contains quotes that you do not want to
keep. For example: In the CSV the value is written as "25000" but you want to extract only
the 25000.

• Ignore line breaks: Check this option if the CSV only contains one record (column).

• Ignore first line: Check this option if the first line of the CSV contains the names of the
columns.
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Note:  These CSV options have a great impact on the way the CSV input files are handled. A
selected value field (using the field number and the line number of the field) can be the wrong
one if the CSV options are not set correctly.

5. If you want, select an example file to be able to easily select data to be used as the value for
parameters.

Removing an Input file

In the Set Up Input files panel, the Remove button will remove the selected input file.

When there are no parameters created yet that use that input file, the input file item will be removed.
You will not be asked to confirm.

But when the input file is in use, you will see a warning mentioning this use. You will be asked to
confirm before deleting the input file item together with all the parameters or 'repeating content' that
require that input file.

Note:  A similar warning and effect happens when you change the File Type of the Input file (from
XML to CSV or vice versa).

Adding Parameters

There are basically 3 ways to create new parameters:

• creating them one by one, using the Add button.

•
loading multiple parameters from a file, using the  button.

•
duplicating an existing parameter, using the  button.

Adding Parameters

Once you specified the output format and set up the (example) input files, you can start adding
parameters that represent the values that you wish to insert from the task's input files into the output
file.

To add parameters, proceed as follows:

1. Click Add underneath the Parameters list.
The Add Parameter dialog prompts.

2. Enter a Name for the new parameter.

3. Select the Input File that contains the value for the parameter.

4. Specify where the value for the parameter is located in the selected Input File:

• In case you selected an XML Input File, specify the XPath Expression of the value in the
input file to be used as the value for the parameter. If you selected an example XML file for
the XML input file, you can easily create the XPath Expression using the Edit button. This will
open the XPath Builder. For more information on XPath Builder, see The XPath Builder  on
page 954 (chapter 'SmartNames').
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• In case you selected a CSV Input File, specify the Field number and the Line number of the
field in the input CSV file to be used as the value for the parameter. If you selected an example
CSV file for the CSV input file, you can select the desired field using the Select Field button.

5. Separator. If the XPath expression returns multiple elements, decide what character you want
to be used as separator.

6. Formatting Options. If you suspect that the chosen value might have leading and/or trailing
spaces, select Remove leading and trailing spaces.

7. If you want to save the created parameter as a SmartName, then click Save as SmartName....
In the prompted dialog, enter a comprehensive Name and Description and choose whether or
not you want this SmartName to be Private.

8. Click OK to add the parameter to the Parameters list.

The created Parameter is now in the Parameters list. You can now insert the created parameter in
the output XML or CSV (see Specifying the Output File on page 1271).
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Note:

• To edit an existing parameter, select it in the Parameter list and double-click it.
• To delete an existing parameter, select the parameter and click Remove. You will get a warning

when you try to delete a parameter that is in use (in the canvas on the left).
•

To delete all unused parameters, click on the action button  underneath the Parameters list
and choose Delete Unused Parameters. You will be asked to confirm.

• To add Parameters from an example input file, see the next section.

Loading Multiple Parameters from a File

Instead of creating parameters one by one, you can choose to load multiple parameters from a file.
Those that you would not need are easy to remove from the list anyway. To do so, proceed as follows:

1.
Underneath the Parameters list, click on the Action  button.

2. Choose Load Parameters from File in the prompted menu.

The Load Parameters from File dialog will prompt.

3. Select the desired Input File from which you want to load the parameters.

4. If the selected Input File is an XML file, proceed as follows:

a) Specify the XPath Expression to load the XML parameters from the Input File. You can click
Edit to open the Xpath Builder to help you build the desired XPath Expression. .

b) Click OK.

All parameters from the selected XML Element will be loaded, including child elements and
all attributes

5. If the selected Input File is a CSV file, proceed as follows:

a) If the First line contains parameter names, select the similarly named option and the values
from the first line will also become parameters.

b) Click OK

CSV Parameters will now be added for every field of every record in the Input File.

Note:  About names of parameters:

• When one or more parameters that are loaded from the example input file have the same name
(because the XML element name, the XML attribute name or the CSV field name in the example
XML/CSV file is the same), their names will be made unique by auto-numbering them.

• When one or more parameters with the same name already exist, a warning dialog will pop up
asking you if you want to replace them or not. If you choose to replace them, this will overwrite
their current contents.

Specifying the Output File

The canvas on the left of a Map Data ticket is where you define what your resulting XML or CSV
output file will contain.

There are many types of smart content that you can add to this canvas. And you can even type in

some content yourself. Some of these types of content are listed via the  button. You will also
see a complete list of possibilities when you right-click inside the canvas.
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Note:  Most of these are sensitive to the position of your cursor at the moment you right-clicked.
They will not be offered when they are not valid at that specific insertion point.

Caution:  There is no 'Undo' function while editing in this canvas.

Tip:  Find a good example in the chapter Examples on page 1287 . It shows how 2 XMLs from the
application Google Maps are mapped into one smaller output XML. That output XML so contains
only specific content to be picked up as workflow parameters.

Here are all the methods and data types that you can enter:

Cut-Copy-Paste
These standard functions work on all types of data you have entered here.

Clear Contents
This will clear the whole canvas.

Insert SmartName
Your output XML can also contain SmartNames. This way you can add information to the XML that
was maybe not present in the input files but important extra data for the system that will read the
output file.

Note:  You can also use the dedicated  button.

Paste from File...
The complete content of the selected file will be added here. This will be possible with all content
that is in a format that can be output to XML or CSV.

Important:  Use this function to paste your example output file.

Insert XML Declaration
It is a good practice to have an 'XML declaration' at the start of your XML file. This line indicates the
file encoding to the reading application. This feature will here insert the industry default one:

<?xml version="1.0" encoding="UTF-8"?>

Insert XML Element
Type in the name of the element that you want to insert. An opening and closing statement of that
element will be inserted. For example:

<Distance></Distance>

Often, you will continue by inserting a Parameter in between those two.

Insert XML Attribute
Type in the name and value of the attribute that you want to insert. For example:

units="miles"
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For example: see how this attribute was inserted in the above element:

<Distance units="miles"></Distance>

Insert Parameter
Choose the parameter from the list. Alternatively, select the parameter in the parameter list on the
right side and

• Click the  to insert that parameter at the current cursor position in the canvas.

• Drag & drop the  to the right position in the canvas.

For example: the parameter [GoogleMapsDist] was is inserted in above example:

<Distance units="miles">[GoogleMapsDist]</Distance>

Insert New Parameter
This is a shortcut that combines the adding of a new parameter with its immediate placement in the
canvas. After you inserted this new one, it will also appear in the parameter list on the right.

Insert Repeating Content (XML statement 'For Each')
For example: for each job that is described in the input file, you want to pick up all its ink specifications
(name, type, angle, ruling). This content will be repeated in the output file for each found job.

After making sure your insertion pointer is at the correct place in the canvas, right-click or use the
dedicated  button. A dialog appears and in the canvas a visual "repeating block" appears in pink.

Now start typing or add XML elements in the repeating block.

Mind that you insert the parameter at a valid insertion point.

Note:  When you add a parameter while your insertion point is inside a pink block of repeating content,
the dialog will mention that that parameter will only serve to be inserted in repeating content.

Choose to insert a new parameter and click OK. The parameter is inserted and also listed in pink
in the parameter table.

Note:  When the insertion pointer is out of the repeating block, parameters that were used inside
the repeating block cannot be inserted outside the repeating block. Their insert buttons are then
disabled (shown in grey).

It is also possible to insert Repeating Content inside another Repeating Content block. This is called
Nested Repeating Content. See an example:
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9.5 Tasks Interacting with other Systems

9.5.1 Interact with Database task

Concept

Tip:  The tasks that interact directly with external systems were introduced in Automation Engine
tasks Interacting directly with the External System on page 1232. You there also read how this task
compares to the Database Access Point.

The Interact with Database task allows you to communicate directly with an external database. It
allows both getting information from that database (read) and sending information to that external
database (write).

As mentioned in the chapter Integration Concepts on page 1230, a typical use for this task is to feed
information back to external systems by using this task in a workflow. For example, you can set up
this task to update a record in a table of your MIS when your workflow has reached a certain stage.
For example setting the status record to 'Proof Ready'.

Warning:  This task may not be used to interact with Automation Engine databases. This is
not supported by Esko. This can damage your server configuration.

Warning:  See the important remark in the task panel. As mentioned earlier in this document,
using SQL statements to change records of an external database can potentially harm that
database. If you are using this technique then this means that you have a database specialist
who takes all liabilities for these SQL queries.

Tip:  The chapter Examples on page 1287 contains 2 examples that contact an external database.
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Set Up and Options

File Name
When the SQL query is a 'select' statement (see further), the task will dump the found records in an
XML file. The default ticket offers the SmartName [Table Name] as name for that output XML file. In
below screenshot, this name would then be 'ProductionDetails'.

Note:  The SmartName [Table Name] is only offered in a context where it makes sense.

Caution:  Not all SQL queries will resolve a name of a database table. Do not use the
SmartName [Table Name] when it is possible that no table name is found.

External Database
Select a database from the list of configured databases. Click Configure... to access the configure
tool directly. Read about configuring External Databases in the chapterExternal Databases on page
637 in the Reference Guide.

Important:  Before linking Automation Engine with an external database, please check your license
agreements with the database manufacturer.

Statement
Choose the type of SQL statement that you want to use: SELECT or OTHER.

• SELECT
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When using the Select statement, the output of the task will be an XML file.

See an example of such a resulting XML. Notice that the SQL statement is also mentioned inside.

Advanced Options...: You can avoid creating an XML file that is too big by limiting the number
of records with the option Maximum number of records per file. The task will then generate
as many files as needed.

• Other

In this mode, you can execute any other SQL statement such as INSERT, UPDATE etc. However,
the task will in this case not generate an output file.

Note:  When the Statement type is set to Other, you cannot execute a Select statement.

In this example the status of the Job is changed in the orders database:

Execute SQL Statement
Decide if you want the SQL statement to be executed Once or Once per input file.

For example: You have multiple input files for this task: banana.pdf, lemon.pdf and mango.pdf. When
your SQL statement uses the SmartName [File] (= the task's input file), then the option Once per
input file will make the task run for each input file. With the option Once, the task would only run
for the banana.pdf (the first input file).

Tip:  Starting a task once and having it run on multiple input files is much lighter for the software than
starting the task multiple times with each time only one input file.

9.5.2 Interact with Web Service task
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Concept

Tip:  The tasks that interact directly with external systems were introduced in the chapter Integration
Concepts on page 1230.

The Interact with Web Service task uses HTTP requests to communicate with a web service of an
external system. Both read ('GET') and write ('POST') commands are possible. The result of this
task is typically an XML file.

When an external system is running a web service, you will be able to access it via HTTP (HyperText
Transfer Protocol). However, to do this, you also need to learn what you can communicate to that
system, what language you need to speak to it. Some applications will indeed publish their API
(Application Programming Interface). And it is that API documentation that will tell you what you can
enter in the Interact with Web Service ticket.

Tip:  The chapter Examples on page 1287 contains an example where a web service is contacted.

Difference with the Web Service Access Point.

• A Web Service Access Point is a way for an external system to speak to the web service of
Automation Engine. This Interact with Web Service task is the reverse: it is Automation Engine
that interacts with the web service of an external system.

• An Access Point is used to start a workflow. This Interact with Web Service task can be inserted
at any step of the workflow.

Set Up and Options
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Output folder and File Name
Define here the path and name of your output file. The type of output file is defined by the API. We
advise to choose XML.

When the Method is GET, this file will contain what the external system returns you. When the
Method is any other type, the output file will only contain a status of the interaction (for example 'OK').

Service
Choose the web service from the list. Click Configure... to access the Configure tool where you
define such external Web Services. For more information see the chapter Configure on page 628 in
the Reference Guide.

Method
There are various types of HTTP methods that you can send to a web service. Choose the method
from the list:

• GET. This most frequently used method will retrieve data from that external system. Consider the
URL as the question and the output file as your answer.

For example: ask Google Maps the distance from your company to your customer.

• POST. This method creates a new object on the external system.
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• This method is commonly used to post actual data, to upload a file to the external system.
Therefore, click on Options... and choose to Attach input files. All input files are added to a
single HTTP request and SmartNames are resolved in the context of the first input file. In case
each input file must be sent separately, then add a Data Splitter task before the Interact with
Web Service task in the workflow. In that case SmartNames will be resolved for each file.

Note:  The parameters are sent as "application/x-www-form-urlencoded" data. When XML
files are attached, the data is sent as "multipart/form-data".

• The POST method also enables to send a SOAP request. The exact text of the SOAP request
needs to be put in an XML file and you need to add a single parameter "SOAPAction" with
the needed value.

Note:  the Create XML task can be used to embed SmartNames inside the SOAP request.

Note:  Find an example on Esko Knowledge Base.

• PUT. This method requests the external system to store data or information under the given
(existing) URL.

• DELETE. This method requests the external system to delete the information corresponding to
the given URL.

• Select SmartName.... You can even use a SmartName to define the method.

Note:  PUT and DELETE are only used for 'RESTful' web services. 'REST' is the main architecture
style of HTTP. An alternative is 'SOAP'.

Path
This path will be documented in the API of the external system. APIs often present several paths
that you can address.

In the above example of a ticket to access Google Maps, the information will be gotten from the
'directions' part of the API. The path ends with XML which here means that we choose to get an
XML file back (and not a JSON file for example).

Headers
The API documentation will instruct you if you need to use HTTP headers. To do this, add their key
and value in the Headers list.

Parameters
The API documentation will instruct you what parameters you can use. To do this, add their key and
value in the Parameters list. This is where the actual 'question' will become more clear.

In the above example, you can see how the ticket asks Google Maps a distance between the origin
and destination address. Other parameters could be more optional, like in this case the option to
only calculate distances for routes that avoid toll roads.

Tip:  Just Google "Google maps API" or click here to learn how Google Maps is a nice example of
how an external system publishes its API.

Tip:  The chapter Examples on page 1287 contains an example that uses the Google Maps API.

http://help.esko.com/knowledgebase
https://developers.google.com/maps/documentation/webservices/
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9.6 Tasks often used in Integration Workflows

9.6.1 Create Job task

Concept, Workflow and FAQs

The Create Job task creates an Automation Engine Job based on an XML input file containing the
job parameters. Typically this input XML file comes from your business system. It is inside this system
that the job-orders are decided and where many of its prepress production parameters are entered
first. Typically, a Folder Access Point receives this XML file and then starts a workflow containing
this Create Job task.

Tip:  Read more about the concept of integrating with external systems in Introduction on page 1228.

Tip:  The chapter Examples on page 1287 contains many examples where this task is used.

It is possible that the XML file that feeds this Create Job task does not come directly from the
business system. Maybe you first have to combine it with another input file that contains other job
parameters. Such other parameters could for example arrive as metadata inside a PDF. The data
formatting tasks Split XML, Join XML and Map Data offer all tools to combine these parameters
into 1 XML file.

Should the XML be in a specific format?
No, but it should be a valid XML of course. You will set up SmartNames or XPath expressions that
map the vocabulary of that business system to the terminology required in Automation Engine. For
example your business system uses the term 'Order Number' to describe the name of a job. You can
then make a SmartName that maps 'Order Number' to 'Job Name'.

Can one XML file create multiple Jobs?
If your XML contains the description of multiple jobs, then you first need to split that XML into multiple
XML files that each describe one job. To do that you will set up a workflow with the Split XML task
in front of this Create Job task. Also use the Data Splitter task to make sure that the Create Job
task is started for each incoming XML file.

Can the input file be a CSV file?
If you want to create a Job from a CSV file, then use the Map Data task to convert it to an XML file.
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What if my business system can not export an XML file?
When your business system is not capable to export a job description in XML format, you can
consider the alternative where Automation Engine asks your business system if there is a new job to
be created. Read about the various possible techniques in the chapter Access Points on page 1236.

Can the task find its parameters outside the task's input file?
Yes. The input file of this task does not have to be the XML file that delivers all the parameters. It
can even be a PDF. The parameters could also be looked for in other files than the task's input file.
Some examples of such special setups:

• A Create Job ticket with a PDF as input file and where the SmartNames do SQL queries to an
external database.

• A Create Job ticket with SmartNames that find their values in workflow parameters.

• A Create Job ticket with (SmartNames that are) Xpath expressions to some centrally stored XML
that the business system writes there every night at 3 AM.

The Create Job task can get the values for its parameters from different sources. It can for example

• find the main job order specifications from the business system's XML file (name, ID, customer,
due date)

• AND get the some ink information from the metadata of a PDF
• AND get a custom parameter 'Press' from a workflow parameter [wfp.PressName].

What if the Job already exists? Can I use this task to update Jobs?
Yes you can also use this task to update existing Jobs. If Automation Engine detects that the Job
already exists, it will update the Job with any new or changed values.

This task will function as an Update Job task

• when it sees that the [Job Name] already exists
• OR when it sees that the combination of [Job Order ID] and [Job Sub Order ID] already exists.

At the end of this chapter, you can find a sample XML that can be used to create jobs from. Remember
that the format of the XML is free. This sample is not a template, it is just one example.

We will now document the settings in the different tab sheets.

Important:  To set up a Create Job ticket, you need advanced knowledge of SmartNames.
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Job

For most of the fields in this task, you can choose to set a SmartName or a combination of
SmartNames.

You can also directly write XPath expressions that will extract values from an XML file. The syntax
for doing this is  "XPath:" followed by a valid XPath expression for the input file.

Caution:  If you are not an expert in building XPath expressions, we advise to not type them
here but to create them via XPath SmartNames.

• Order ID. This field must have a value. You can not leave it empty.

• Sub Order ID

• Name. In the screen shot example, we combined 2 SmartNames with some absolute text ( _ ).

• Description. In the screen shot example, we wrote an XPath expression.

• Due Date. The format needs to be compliant with ISO 8601 (YYYY-MM-DDThh:mm:ssTZD) . For
example: 2014-07-28T12:00:00+01:00

• Project ID.

Tip:  Some users use this field to define the name of the project on Esko WebCenter that
corresponds with this Job..

• Category. For this field, you can also choose a category from the list.
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Tip:  The categories in the list are all those that were already used in a Job.

• Custom Fields. The custom fields that appear here are the ones that you defined in  Configure
> Jobs > Job Setup  (maximum 6). Alternatively to using a SmartName or XPath, choose a value
from the list.

• Job Folder. The system needs to know where to create the actual folder for this Job.

Note:  Beware that you do need to define a complete network path here, not just a folder name.

You have these choices:

• Use the SmartName [Smart Job Location] to use this setting as defined in  Configure > Jobs
> Smart Job Location .

• Click Browse to browse to the desired job location

• Click Browse to browse to a folder in a container, and then use SmartNames to define a sub
folder.

Note:  If you want to make the path smarter by adding the name of the customer, then you
best set that up as a Smart Job Location.

Customer

Using the same techniques as described for the tab 'Job', you here define the customer details for
the Job you are creating.

• Customer ID. You can alternatively select the ID from the customer list panel.

• Customer Name.

• Customer Description.

• Customer's Job Reference. This is the name that your customer uses for this Job.

• Customer Service Representative. You can alternatively select the CSR from the list.

• E-mail.

Inks

Setting up the inks for the new Job can only be done if the input file is an XML file and if the ink
properties are stored in attributes of XML elements.

In the example below the XML input file contains an element "Farben" (German for "inks"). This is
an array of "Farbe" elements, each describing an ink.
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The Create Job task will create an ink in the new Job for each of these elements in the XML. The
table in the dialog defines how to map XML attributes of each element to an ink property.

• Load Ink Information from an XML element. Enable this and then choose how you will load
this specification: You have these 2 options:

• XML element Name: Indicate the XML element that contains the ink specification. In above
example the ink info is described in the element Farben.

• XPath expression : Alternatively, use an XPath Expression to the XML element containing the
ink information. For example: /CreateJob/Farben

Note:

• To open the XPath builder, select XPath expression and click on the Edit button in the text
field.

• The XML that the ticket sees as input file will be loaded in the XPath builder. Alternatively,
you can right-click in the canvas and choose Paste from File... to select the example XML
input file.

• When you edit the XPath expression again, that same XML (example) input file will be
automatically used.

For each job ink parameter, specify the corresponding XML element that is used in the XML file. To
do this, select the parameter and click Edit.

• Ink name
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• Ink type
• Ink book
• Angle
• Ruling
• Dot Shape
• Printing Method

Parameters

To add custom parameters to the job you are creating, click Add and enter its Name and Value.

Both fields are SmartName enabled. Typically, the Name will be an absolute value and the Value is
a SmartName that extracts the custom parameters from an XML file.

For example:

Bar Codes

The Create Job task also allows to add parameters for one or more bar codes.

Important:  The Create Job task does not check the consistency of these bar code parameters.
This means that the creator of the input file is responsible to create bar code parameters that are
compliant.

You can Add or Remove parameters for multiple bar codes.

For each bar code, you can set the following parameters by adding a SmartName or an XPath
expression. Some also offer to select a value from a list.
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Attention:  Some parameters will not be relevant for some bar code types.

• Type.
• Sub Type. A list will be offered if you selected a Type that offers Sub Types..
• Code. As mentioned above, the code is not checked for validation here.
• Composite Code. Only some types offer to add an extra composite code.
• Output Resolution
• Bar Width Reduction
• Device Compensation
• Narrow Bar. Only some types work with a specification of Narrow Bar and Ratio
• Magnification
• Ratio. Only some types work with a specification of Narrow Bar and Ratio

Template

You can use an existing job as a template job for the new job that you here create. If you decide so,
you can select which attributes and parameters that you want to get from that template job.

Note:  For more information about using template jobs and their options, see the dedicated chapter
Jobs on page 828.

Select Use an existing job as a template if you want to create your job based on another job.

In Choose Job, Select the job from the list or use a SmartName to have the job selected. An
example of a SmartName could be [customer name]_template

Then choose what to Include from the template job into the new job:

• Files
• Folders
• Hot Folders. This item will only appear if your server still has hot folders from before v14.
• Tickets. These are the (blue) Job tickets.
• Milestones. Times will be set relative to the creation date of the new job.
• Parameters. Custom parameters.
• Inks.
• Categories

Attention:  If there any parameters that you pick up both from the input file and from a
template job, then those from the input file will be kept.

Advanced

The Create Job task can automatically launch a workflow when the new job is created and even
when the task updates the job.

To do this, select when you want have a workflow launched and select the workflow from the list.
You can even choose both moments.

Note:  If the Create Job task itself is part of a workflow, the workflow that is chosen in this task will
start immediately, as a separate workflow. It will not wait for the workflow that contains the Create
Job task to finish.

The advantage of this function is that the chosen workflow will be launched in the context of that
created/updated job. This means that all the used SmartNames will get their value from that job.
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Attention:  In case you create a workflow that contains the Create Job task as a workflow
step and then continues with other steps, then the tasks following that Create Job step will
not run in the context of the new/updated job: they will run in the context where the (main)
workflow initially started!

Sample Input XML

Click this link to find a ZIP with the samples used in the chapter Examples on page 1287. There is a
sample XML in the folder "Create a Job using XML' that you can use to test setting up SmartNames,
Xpath expressions and so build and test an example Create Job task.

Download the ZIP file and unzip it to a local folder or directly into a Automation Engine Container.

9.6.2 Add To Products task

The Add To Products task allows to create Automation Engine Products. The task can get their
properties out of file names, paths, SmartNames or values out of XML data.

This task is often used after workflow steps first made a smart selection of input files.

This task is documented in the chapter Products on page 876. Find a direct link here.

9.6.3 Link Product To Job task

The Link Product To Job task allows to link or multiple Products to a Job.

This task is documented in the chapter Products on page 876. Find a direct link here.

9.7 Examples

These examples will help you build and understand the workflows of typical integration use cases.

At the beginning of each example, we also mention which tools and tasks are used. We also add a
link where you can find the sample (XML) files used in that example.

Note:  An example often requires you to understand the features explained in the previous examples.

9.7.1 Creating a Job using XML

Summary

We will create a Job based on the sample XML. Most of the work is creating the XPath Query
SmartNames.

Tools used in this example:

• A sample XML describing 1 job order

http://help.esko.com/docs/en-us/automationengine/14/userguide/pdf/AE-IntegrExtSyst-Example-samples.zip
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• SmartNames including Xpath Builder

• The Create Job task

Step 1 - Analyze your Input XML file

Click this link to find a ZIP with the sample XML file used in this example.

Save the file in a logical place in an Automation Engine Container.

Open it (double-click) and have a look at its structure:

See how a lot of job info is inside the parent element 'CreateJob' and how the ink information is
inside a different parent element 'InkSpecifications'.

Note:  In this sample, even the full path for the JobFolder is filled in. This is usually not the case.
A business system usually leaves it up to you to decide where to store your prepress data. Some
MIS do want to control this as well. Advantage of already knowing exactly where your prepress files
are is that they can then also show some of them to their MIS users (final PDF, JPEG..). However,
most MIS will not decide that path for you but will ask you to let them know where you decided to
create that JobFolder. In that workflow, the MIS usually wants you to a return them a XML containing
that JobFolder path.

http://help.esko.com/docs/en-us/automationengine/14/userguide/pdf/AE-IntegrExtSyst-Example-samples.zip
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Step 2 - Create your SmartNames

SmartNames will read specific pieces of that XML and so populate the various properties of the Job
you will create. To read parts of that XML, we will use SmartNames of the type XPath Query.

Note:  You can also create SmartNames directly from within the Create Job task. However, because
they are Xpath queries that involve a sample input file, we advise to create them using the main
SmartNames tool . It will be somewhat easier to do it there.

1. Go to the SmartNames tool and indicate your sample input XML file
Because you will probably make a dozen new XPath SmartNames, it will be easier when you only
have to indicate your sample input file once. Do this in the Resolve all using: section.

Note:  You do not have to click on 'Show' at this moment.

2. Make a first XPath Query SmartName

1.
In the SmartNames tool, in the top bar, click on  to create a new SmartName.. Choose Type
XPath Query.

An example query about 'vsize' appears. It will be removed automatically later. See the part /
text() at the end. This means that the query will not select the full element but only the value
of that element.

At the bottom,
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2. Click on 'Edit' to open the XPath Builder.

As a first SmartName, we will create the Xpath Query representing the Job's OrderID.

All you need to do here is click on the value that the SmartName will be looking for. It will be
highlighted in yellow and the resulting XPath Expression will automatically appear in the top field.

3. Click on 'OK' to close the 'Edit Xpath Expression' dialog. The expression will have replaced the
example one. The resulting value will also be shown bottom left in 'Result:' (in below screenshot:
"002").

4. Now save your new SmartName. Give it a logical name and maybe add some tags and a
description.
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3. Now make the other SmartNames (quickly)

The next SmartNames will be made very similarly. Double click the one you just made and while
keeping the SmartName dialog open, follow these steps:

• click Edit

• in the Xpath Builder,

• click on the value you want the SmartName to represent
• click OK to close the Xpath Builder

• click Save As... and enter an appropriate name, tag and descriptions

Repeat this for all the SmartNames you wish to use in the Create Job task.

Step 3 - Insert the SmartNames in the Create Job ticket

Open a Create Job ticket and insert the created SmartNames in their corresponding fields.
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Do the same for all fields in the other tabs.

Don't forget to save your ticket.

Picking up the Ink parameters from the XML

As explained in Inks on page 1283, the Inks tab is constructed differently.

In our sample XML, see how the ink information is described in a parent element InkSpecifications.
And in there, per ink in an element named 'Ink'. And there are 8 inks described.
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You also see that the names of the ink parameters are not all identical to those used in the Job setup
in Automation Engine. In many cases these words in the XML may not be in English. This terminology
in the XML (in the business system) needs to be mapped to the official one in Automation Engine.
This is explained in the documentation of the Create Job task.

See the correct settings for our example:

• The element name under which all the ink info is found is InkSpecifications.

• The parameter names in your XML (right) have been mapped to the standard names in Automation
Engine (left):
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Note:  These names are not case-sensitive.

Note:  If one XML Element name is wrongly mapped, the Create Job task will not fail but only this
wrong parameter will stay empty in the Job Inks setup.

• Alternatively, in our example, You can use this Xpath Expression to select that element describing
all the inks:

This is the result in the created Job:
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Step 4 - Test your Workflow

Test you workflow by launching it from within the Pilot.

In the Pilot, select the input XML file and launch the workflow. It should create the Job and the Job
should contain all the parameters you had set up.

When the Job was created but one or more parameters were not found, the status of that 'Create
Job' workflow step will be 'warning' (orange).

• The task's details info will already tell you that "There were problems resolving some job fields".

• The task's log file will tell you what specific SmartName(s) has a problem. For example "Could
not resolve(2) job.customer : <NameOfTheSmartNameThatFails>/"

Step 5 - Add automation by starting this workflow from an Access Point

When an external system sends you a XML files describing Jobs to create, we advise to automate
this workflow.

A typical way to do this is to create a Folder Access Point. The folder of that Folder Access
Point is then the place where the XMLs will arrive. The workflow that the Folder Access Point will
automatically start at a regular time interval is then the one you created in this example.

Note:  Read more on setting up such automation in Folder Access Point on page 1238.

Attention:  It is also common for external systems to send the prepress department you an
XML file containing the description of multiple job orders . And often those systems only
send such a list once or twice per day. This use case is explained in a next example Creating
Multiple Jobs from One XML on page 1295.

9.7.2 Creating Multiple Jobs from One XML

Summary

Note:  This example requires you to master the features explained in the previous example Creating
a Job using XML on page 1287.



9
Automation Engine

1296

You receive an XML from the business system. It is a list of job-orders and their production
parameters. Some are already started in prepress, some are new, some are on hold. Your goal is to
create Jobs of all those in the status 'ReadyForPrepress'. The XML needs to be split into multiple
XML files each describing one Job. These XML files are then input files for the Create Job task.
The job-order info in the XML files is too elaborate. You will only pick up some selected parameters
from those XML files.

Tools used in this example:

• SmartNames including Xpath Builder

• Split XML task

• Data Splitter workflow control

• Create Job task

Step 1 - Analyze the XML describing Multiple Jobs

Tip:  Click this link to find a ZIP with the sample XML file used in this example.

The XML in this example describes the 3 job orders. See how 2 of them have the status
'ReadyForPrepress'.

http://help.esko.com/docs/en-us/automationengine/14/userguide/pdf/AE-IntegrExtSyst-Example-samples.zip
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Note:  In this example XML, we removed typical extra parameters about the customer, bar code and
inks. The principle of those types was already explained in Creating a Job using XML on page 1287.

Attention:  If you send this XML to the Create Job task, it would only create the first Job
it finds in the XML.

Step 2 - Create the Workflow Ticket

This is the workflow we need:
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• The Split XML task splits the XML into multiple XML files. If you don't do this, the Create Job
task would only create the first Job is finds in the XML.

• The Data Splitter makes sure the next task sees the many input files. It prevents that the task
is only launched on the first input file.

• The Create Job task creates Jobs, as determined in the Data Splitter, for each incoming XML file.

Note:  The Create Job has no output files. If you want to continue the workflow with its input files
(the split XML files), then configure a specific output pin for that. Read more on these possibilities
in The Workflow Editor and also Building Workflows in the User Guide.

Step 3 - Splitting the XML but also using a Filter on Status

In the Split XML task, we need this XPath Expression:

• The expression /Jobs/Job will result in splitting the XML on that level of elements: one per Job.

• The extra filter [Status = 'ReadyForPrepress'] will limit that to jobs with that status.

This Xpath expression can easily be built by using the Xpath Builder. Open it via the Edit button.

Note:  When the filter does not find any matching 'node' (job), the task will error and mention this
as the reason.

• Output in: Define where you want the split XMLs to be written.

• File name:Define the name of the split XML(s). The default setting will add a number.

Step 4 - Importance of the Data Splitter

When you do not use the Data Splitter, the Create Job task will receive all the XMLs generated by
the Split task as 1 group on its input pin. In this case only the first incoming XML will be processed
and the rest will be ignored. The Data Splitter step in this workflow will make sure the Create Job
task receives the XMLs as separate files so each of them gets processed.

Because we (possibly) have multiple input XML files, we need these (default) settings:
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We do not want the split XML files to be grouped. The Create Job task needs to be launched on
each one of them.

Find more details on this task in Data Splitter on page 1030.

Step 5 - Create the Xpath SmartNames

Identical as explained in the previous example Creating a Job using XML on page 1287, you need to

• create SmartNames that you will use in the Create Job ticket. As explained in Step 2 - Create
your SmartNames on page 1289.

• insert those SmartNames in the Create Job ticket. As explained earlier in Step 3 - Insert the
SmartNames in the Create Job ticket on page 1291.

Step 6 - Workflow Result

Select the XML describing multiple Jobs and launch your workflow.

The Create Job task will be started per incoming XML. In this case 2 times, because only 2 had
the status 'ReadyForPrepress'.

Note:  Workflow controls like the Data Splitter do not appear in this task overview.

See the files the workflow created:
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The 2 Jobs that had the status 'ReadyForPrepress' will be created:

9.7.3 Create Multiple Jobs from a CSV file

Summary
Every morning, you receive a CSV file from the planning department with a list of job orders for the
prepress department. Each row in the CSV represents a job order. This data needs to be converted
into separate XML files to send to the Create Job task.

Note:  a CSV is a Comma Separated Value file. This is usually an exported file from a database or
an XLS file.

Tools used in this example:

• SmartNames including Xpath Builder

• Map Data task

• Split XML task

• Data splitter workflow control

• Create Job task

Step 1 - Analyse the CSV file

Tip:  Click this link to find a ZIP with the sample CSV file used in this example.

Our example CSV contains a description of 2 job orders.

Because the Create Job task does not work with CSV files, we first need to create an XML. And
as you saw in the previous example Creating Multiple Jobs from One XML on page 1295, we will
need 1 XML per Job to create.

Note:  At this point it is good to detect any data fields that will need reformatting. In this example
workflow, the format of the due date will need to be mapped to the format that is required for that
field in the Job Setup.

http://help.esko.com/docs/en-us/automationengine/14/userguide/pdf/AE-IntegrExtSyst-Example-samples.zip
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Step 2 - Create the Workflow Ticket

This is the workflow that we need to create Jobs from a CSV with descriptions of multiple job orders:

• The Map Data task defines what parts of the CSV will be mapped into the XML file.

• The Split XML task splits that XML into multiple XML files, like we did in the previous example.

• The Data Splitter makes sure that the next task sees the many input files. It prevents that the
task is only launched on the first input file.

• The Create Job task creates Jobs, one for each incoming XML file.

Step 3 - Mapping the CSV to XML

The Map Data ticket will

• convert the CSV to XML
• define which parts of the CSV are needed in the XML
• define how the parameters should be named in the XML. You can keep their names if you want to.
• define what part in the XML will be Repeating Content. This is needed because you are not sure

how many jobs there will be in that CSV / XML. The CSV that you receive tomorrow can have
a different amount of rows. This is the 'for each' principle as explained earlier in Specifying the
Output File on page 1271.

Note:  The order in which we define the settings in this ticket is important.

1. Define the CSV as input file

• Select your CSV file and open the workflow ticket that you made in the previous step.
• Double click the Map Data step. This automatically sets your CSV as input file:
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• Now set 2 specific options that define how our example CSV should be read. Double click the
line 'Input File 1' to open its setup. Set the Field Separator to Semicolon. Because the first line
of the CSV contains the field headers (not values we want to read), check the option Ignore first
line. Remember that your specific CSV might be different, so do check all options.

• Click OK to close that dialog.

• Maybe now is a good time to already define the folder and name of your output XML. As usual,
you can use SmartNames in Output in: and File Name:.

• Click Continue.

• Make sure the Output Format: is on 'XML'. In the Options... make sure to activate the Replace
reserved characters in parameter values with XML entities. In this example, there are no such
characters.
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2. Define the Repeating Content in the XML

Note:  Make sure you have already read the chapter documenting this advanced technology.

This ticket allows many ways to use it. Following steps are specific for this CSV to XML workflow:

In the Map Data ticket, in the canvas where you define the output XML,

• Right-click and choose Insert XML Declaration. This is just good practice when creating XML.
• Right-click and choose Insert Element . Give it a logical names, for example <Jobs>
• Put your cursor in between the open and closing element, right-click and choose Insert

Repeating Content (or click on ).

Remember:  You can not make any existing content 'Repeating' later ; you need to create the
'Repeating Content' block first and then add content inside.

Every line (row) in your CSV represents a job order. So you do want Every line in your CSV to
become the Repeating Content. Remember we already decided to ignore the first line of the CSV.

• Click OK. A pink field for Repeating Content is created. Also the field parameters were created
automatically. They are colored pink because they are linked to the selected Repeating Content
field.
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• Now, inside that Repeating Content field, continue specifying the content of the XML. Insert
Elements and click the pink parameters in between the opening and closing element.

Caution:  Make sure your XML elements do not contain spaces!

This is a basic and valid example:

You can see we only use 5 of the parameters in this example. You can of course pick up a lot more.

Note:  Remember that the XML file will just be an in-between format. You will later, in the Create
Job ticket, still map the XML elements to the real fields in the Job Setup.

• Click OK to close the set up of your Map Data ticket.

• Save your Workflow ticket. No need to close it.

Step 4 - Test your CSV to XML Mapping

We advise to already test what we set up in our Map Data ticket. Because if that output does not
look good, it is better to correct that now instead of using a wrong XML file as input for the next
workflow steps.

With the CSV as input file, launch the workflow. Because we haven't defined the settings for the next
workflow steps yet, the workflow will surely fail.

You now see that your CSV was mapped to an XML. Double click the output file to open it. It should
look like this:
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You see

• the main structure /Jobs/Job

• the description of the 2 Jobs,

• including the 5 parameters that we picked up from their definition in the CSV.

When your XML is not OK, then solve the problem first before defining the next workflow steps.

Step 5 - Set up the Split XML step

• Leave the workflow ticket and go back to your Pilot.
• Go to the folder where you wrote the output of the Map Data ticket and select the

Orders_for_Prepress_CSV2XML.XML

• Open the default Split XML ticket. Your XML will be seen as input file.

• Click Edit to open the Xpath Builder.

• Click on a Job node

The resulting Expression will be shown above: /Jobs/Job .

• Click OK to close the dialog.
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• Your ticket is ready. Save it with a logic name.

• Open your workflow and replace the default Split XML step with this specific one.

• Save your workflow.

Step 6 - Test your workflow again

• Select the CSV and launch your workflow. Because we haven't defined the settings for Create
Job ticket yet, the workflow will surely fail.

What you now need to see is the 2 XMLs as output of the Split XML ticket.

• Double-click one of the split off XML files to open it. It should look like this:

Step 7 - Check the Data Splitter

The Data Splitter control in your workflow should have the (default) settings to 'not group'. It's
purpose is identical as in previous example, where we explained the importance of the Data Splitter.

Step 8 - Defining the SmartNames for the Create Job ticket

Making the SmartNames and inserting them into your Create Job ticket is not different here than
explained in earlier examples, like in Step 2 - Create your SmartNames on page 1289 and Step 3 -
Insert the SmartNames in the Create Job ticket on page 1291. We will first briefly recapitulate that
part and then we will pay extra attention to setting up the SmartName for the Due date.
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Creating the necessary SmartNames

Follow these steps to create the SmartNames:

• In your Pilot, go to the SmartNames tool.
• On the right, in Resolve all using:, select A file: and browse to one of the split off XML files (for

example Orders_for_Prepress_CSV2XML_1.xml).
• Create Xpath Query SmartNames for

• OrderID
• CustomerName
• CustomerID
• CSRemail

Creating the SmartName for the Due Date

• In your Pilot, go to the SmartNames tool.
•

Click on  to create a New SmartName.
• Choose the type : Xpath Query.
• Click on Edit. In the XPath Builder, select the value for the element DueDate.

• In the setup of an Automation Engine Job, the due date needs to be specified according the
ISO 8601 standard. We therefore need to reformat that date from how it was defined in the CSV
('30-09-14'). Now set the formatting options as follows (see screen shot below):

• Click on Formatting Options....

• Set the Data Format to Date and Time.
• Set the Format to ISO 8601.
• Choose your Time Zone (the one of your Automation Engine server).

Below left in the dialog, you will see that the Result is still not OK.
• Click on Input Format Options....

• Set the Format to Custom.
• Set the Language.
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• Choose Custom Format. Now write how your data was formatted in the CSV: dd-MM-yy.

Caution:  The month is here defined by an 'M' in capitals! A lowercase 'm' will be
seen as minutes!

• Click OK. The correct result should now be visible in the Formatting Options dialog.

Now save your SmartName and give it a logic name. For example "From XML - CSV Due date
for ISO".

The resulting Create Job ticket

• Open the workflow and double-click the Create Job ticket.

• Add your SmartNames. It could look like this:
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• Now save your workflow ticket.

Step 9 - Workflow Result

In the Pilot, select your CSV file and launch your workflow. It will look like this:

It will have created these 2 Jobs:
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9.7.4 Creating Jobs using a Database Access Point

Summary

We will use a Database Access Point to query an external database (one from a business system
where the job orders originate). The query will, at a regular time interval, ask that database which
new Jobs need to be created on Automation Engine. The result of this query are XML files with the
description of those Jobs. Those XML files will be used to create the Jobs (as shown in previous
examples).

Tools used in this example:

• An external database
• A Database Access Point
• SmartNames including Xpath Builder
• The Data Splitter workflow control
• The Create Job task

Step 1 - Analyse the External Database

Tip:  Click this link to find a ZIP with the sample database used in this example.

This is the database we will query in this example:

• The database software type is a MS SQL server.
• It runs on a a server computer named EAW11DL306.
• The name of the database that we will access is MyExternalSystem (there could be more served

by this same software).
• The name of the (opened) table is MyOrders.

http://help.esko.com/docs/en-us/automationengine/14/userguide/pdf/AE-IntegrExtSyst-Example-samples.zip
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• The table contains the description of 6 job orders.

• The Status column shows that 3 job orders are 'Ready For Prepress' . Those are the ones
that we want to create on Automation Engine.

Step 2 - Configure the Link to the External Database

Set up the link with the external database. This is done in via  Tools > Configure > External
Databases . Read more on such configurations in External Databases on page 637.

For this example, this is the configuration we need:

Step 3 - Set up the Database Access Point

Note:  Setting up Database Access Points is documented in Create or modifying a Database Access
Point on page 1246.

This is an example of the Access Point we need:
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• In the Pilot, create a new Access Point and choose the type Database.

• Give it a logical Name and Description.

Database Settings

• Select the External Database you configured in the previous step.

• Enter the SQL Select Query:

• 'SELECT' indicates which columns you want to get a value from.

• 'FROM' indicates the database table where these columns are.

• 'WHERE' indicates an extra filter: you do not want all the jobs from that table, but only those
with the status 'Ready For Prepress'.

Note:  SQL queries are case-sensitive!

Note:  It is possible to select values from different tables, for example if you want to get more
details about the customer or about production tools. This examples does not do that.

Note:  Esko does not offer training or support in database queries. This is mentioned in more
detail in Concept of tasks interacting directly with external systems and Concept of the Interact
with Database task.

• After Processing: We here use Update the records to change the status field in the external
database to 'InPrepress'. This is necessary to avoid that, after the next time interval, these
jobs would be created/updated again (because they would still be in the status 'Ready For
Prepress'.)
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Tip:  You can choose to not do this status-update here but rather wait until the workflow really has
created the Job. In the following workflow, you can then use an extra Interact with Database
ticket to update that status in the external database with for example a status 'Job Created
and Started in Prepress'.

Monitoring

Define the time interval with which the query should be done.

Note:  There is no need to set it to '1 minute' to make testing easier. See further how we will use
the scan now button instead.

Automatic Actions

The query will write an XML file for each job order that it finds in the specified status.

• Move Files to: Define where you want those XML files to be written. The Job they represent does
not exist yet so we advise to write them in some central folder. See an example in the screen shot.

• Rename Files to: Their default name [File] actually consists of [table_name]_[date-and-
time]. You can overrule this or add more SmartNames. Also see later when we show the result.

• Action: We will add a workflow in later steps of this example. For the moment, leave this to None.

Click OK to confirm your settings

Your Database Access Point now exists.

Activate the Access Point

Right-click and choose Activate Access Point.
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Step 4 - Test your Database Access Point

Select your Database Access Point and click the  button to scan now.

This will execute the SQL query immediately.

An Alert window will appear with the result. In our example, we see

• 3 XML files were created because 3 job orders had the status that we were asking for: 'Ready
For Prepress'.

• Their name is the result of the SmartNames as explained in the previous step.

This is one of the resulting XML files:

See how the XML file contains the query that was used.

These XML files will now be used as input files to create Jobs.

Check the new status in the database

Remember the Update the records setting in previous step. See how, for the 3 job orders that first
had the status 'Ready For Prepress', the status has now changed to 'InPrepress':
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Attention:  When testing this Access Point, do remember that every time you run it that the
status of those job orders will change to 'InPrepress' ! This means that the next time the
Access Point will do nothing simply because there are no more job orders in that database
with the required status 'Ready For Prepress'! So, in between tests, you have to manually
reset those statuses to 'Ready For Prepress'. And remember that the queries are case-
sensitive!

Step 5 - Create your SmartNames

Identical to how we did this in step 2 of the first example, we will now create the SmartNames that
will map the fields in the XML to the Job setup fields in the Create Job task.

1. In the Pilot, go to the SmartNames View.

2. On the right, in Resolve all using:, check the button for A file and browse to one of the XML files
you created in the previous step.

3. Click on Create a New SmartName.

4. In the dialog, indicate the type Xpath Query.

5. Click on Edit to open the Xpath Builder.

6. In the XML content, highlight the first value you want to make a SmartName for. For example
OrderNr.

The resulting Xpath Expression will appear.

7. Click OK.
You will see the result value 1235 appear bottom left in Result: .

8. Click Save As... and give the new SmartName a logical name. For example
EXA_DB_Myorders_OrderNr.

9. Keep the dialog open and click again on Edit. Repeat steps 6 to 8 for the next SmartNames that
you want to make in this example, except the SmartName for the Due Date, that one needs
an extra formatting. See next step:

10.Creating the SmartName for due date is here identical to how we did it in the previous example.
You need to make sure the output format is according the ISO standard for this Job setup field.
And you need to indicate how the input is constructed. In our example this is dd-MM-yy.
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11.When finished saving all SmartNames, close the dialog (press Cancel or use Save for your last
SmartName)

12.Back in the SmartNames View, type a view filter that will only show your 5 new SmartNames
and then click on Show (right panel)
You should now see this:

Step 6 - Create the Workflow with the Create Job task

To have the Jobs created automatically, create this workflow:

1. In the Pilot, go back to the Files or Job mode and click on  to create a new workflow.

2. Build a workflow that starts with a Data Splitter (keep its default settings 'don't group output'),
followed by a Create Job ticket.

3. Already save your workflow with a logical name. Remember we will later attach it to the Database
Access Point.

4. Double click the Create Job ticket and add the SmartNames to their matching fields.
It should look like this:
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The Job Folder setting in the screen shot is just an example of many ways to define it.

5. Save your workflow.

Step 7 - Test your workflow

In your Pilot, go to that (central) folder where your 3 XML files were written. Select these 3 input files
and launch your workflow.
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See how the Data Splitter receives 3 XML files and hands them over one by one to the Create Job
ticket that creates these 3 Jobs:

Tip:  Also check again if the due dates are formatted correctly.

Step 8 - Add the workflow to the Access Point and test again

Open your Database Access Point. In Action, choose Launch Workflow and select your workflow.
Click OK to confirm.

According the set time interval, your Database Access Point will run and now also use its resulting
XML files as input files for your workflow.

When your Database Access Point is selected., you see the workflow task appear:
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9.7.5 Launching a workflow with parameters from an XML

Summary

A workflow is automatically launched when the business system writes an XML file on a Folder
Access Point. The XML file describes what to do with what file: it contains a full path to a
new design file and describes many parameters that will be used as Workflow Parameters  in the
workflow that will be launched.

Such a concept is used by business systems that trigger a workflow on Automation Engine based on
a new status. For example: when the business system notices that the status of a job order changes
to 'Design Arrived', it decides to already start a prepress workflow on Automation Engine (the one
that is typical for new designs from that customer). It is also common that such setups are not limited
to only one status leading to one workflow. Some customers elaborate on this process and have 2
or 3 such links between a status in the business system and an automatically launched workflow
on Automation Engine.

Tools used in this example:

• SmartNames including the Xpath Builder

• Workflow Parameters

• A Folder Access Point

• These tasks: Preflight with PitStop, Create Report (ReportMaker), Zip, Send E-mail, Upload
via FTP

• These workflow controls: Select Referenced File, Router, Data Collector.

Note:  In this example we do not use Automation Engine's Job concept.

Note:  This example assumes you are already comfortable making advanced workflows.

Step 1 - Analyse the incoming XML

Tip:  Click this link to find a ZIP with the sample XML file used in this example.

This is the type of XML file that we receive from the business system:

http://help.esko.com/docs/en-us/automationengine/14/userguide/pdf/AE-IntegrExtSyst-Example-samples.zip
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In the XML file, notice

• the job order number and some customer details
• a absolute full URL to the design file that just arrived. The design is named 'Shrek.pdf'.

• some decisions if the workflow needs preflighting or creation of a report card.

Step 2 - Create the Workflow

Now create the basic structure of our workflow. Add the steps as in the screen shot. We will add
more detail later. It is possible that some of the connections can not be made yet.

Notice these main process steps:

• the workflow needs to run on the PDF, not on the incoming XML file that will land on the Folder
Access Point (that we will create later in this example). That is why we will also use Select
referenced File to select that 'Shrek.pdf' (see further).

• the workflow parameters will indicate whether the route to Preflight with PitStop and/or route to
the Create Report (ReportMaker) needs to be taken.

• if the Router confirms that preflighting is needed, the step will do that and use a Profile defined
in the XML.

• if the Router confirms that a design report card is needed, the Create Report (ReportMaker)
will create that.

• the Data Collector collects the Preflight Report and/or the Design Report card, after which they
are ZIP'ed together.
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• the XML will indicate the next router if this ZIP needs to be sent to the customer via E-mail or
via FTP.

Save your workflow with a logical name, for example EXA_XML_Workflow.

Step 3 - Load Workflow Parameters from the XML

The XML files that the external system sends will always have the same elements, but with mostly
different values. This is a typical case to use Workflow Parameters.

Note:  Read more about Workflow Parameters in Workflow Parameters.

1. Open the workflow you created and in the menu go to  Advanced  > Manage Workflow
Parameters .

2. Check Use values from XML file and enter these SmartNames [URL of Folder of Input]/
[File].xml (see also in below screen shot).

3. Click on Load Workflow Parameters from XML... (below right). Browse to your XML example
file and click Open. Choose to Leave blank to select all elements below the root element.
All the XML element names will be listed, with their value from in this specific example XML:

4. Click on X to close this dialog.
These parameters are now Workflow Parameters. Every time this workflow is launched, they will
be "loaded" before even starting the first workflow step.

5. Save your workflow.

Step 4 - Select the Design file that is Referenced in the XML

The workflow needs to run on the design file, not on the XML file. The design file is referenced in
the XML file.

1. In the Pilot, select the example input XML file and then open the workflow you created.

2. In the workflow, open the step Select Referenced File.

3. In Select by:, choose File Path.
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4. In File Path, click on Edit to open the Xpath Builder.

5. In the Xpath Builder, the input XML file of your workflow will be shown as Example XML Content.

Select the path (the value of the Design element).
On top, the resulting Xpath Expression will be shown.

6. Click OK to close the Xpath Builder.
The Xpath Expression is now copied as File Path.

7. Check the option Provide a warning when no files were selected.

8. Click OK to confirm these settings.

9. Save your workflow.
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Step 5 - Pick up the Workflow Parameters in your Workflow

We refer to the standard documentation to learn more on making workflows or on the tasks and
workflow controls used in this example. We will here focus on what is specific in our example
workflow.

Our workflow does not use the Job concept and we (therefore) use Workflow Parameters:

• in the 3 Routers

• in the Preflight with PitStop step

• in the Create Report (ReportMaker) step

• in the Send E-mail step

• in the Upload via FTP step.

In the 3 Routers

A value in the XML decides where the workflow will route to. Follow these steps for each Router
(they are very similar in all 3 routers):

1. In the workflow, open the Router.

2. In Route based on, choose SmartName value from the list.

3. In SmartName, pick the appropriate one from the list, category 'Workflow Parameters' ([WFP.)
and click Insert.

As can be seen in below screen shot, the 1st Router in the workflow needs the SmartName
[wfp.PreFlightYesNo] . The 2nd Router needs [wfp.ReportCardYesNo]. The 3rd Router
needs [wfp.SendViaFTPorEMAIL].

4. Close the list of SmartNames by clicking on the X.

5. Now set the relation between the SmartName value and the route to follow.
See this example for the 1st Router deciding if preflight should be done:
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See this example for the 2nd Router deciding if a report card should be created:

See this example for the 3rd Router deciding whether FTP or E-mail should be used:

6. Click OK to confirm the Router settings and close the workflow step.

7. Save your workflow.

In the Preflight step

In our example, the XML file also decides which preflight profile needs to be used.
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Note:  See the full documentation of this workflow step in Preflight with PitStop on page 407.

1. In the workflow, open the step Preflight with PitStop.

2. Define the Output folder and name. Mind that this is not for the preflight report file.

3. In the Preflight tab, in Profile, insert the Workflow Parameter SmartName  for the profile as
part of the path.

4. In the Report tab, define the output folder and name for the preflight report that you will send
to the customer.

5. Set any other options as wished.

6. Click OK to confirm the settings and close this workflow step.

7. Now drag the logical connections between the steps. The pin that represents the output of the
preflight report should link to the Data Collector. That file will be sent to the customer, the input
design file will not be sent.
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8. Save your workflow.

In the Send E-mail step

In our example, the XML file decides if the resulting files will be e-mailed or FTP'd to the customer.

Note:  See the full documentation of this ticket in Send E-mail on page 471.

1. In the workflow, open the step Send via E-mail.

2. In To, add the Workflow Parameter SmartName for the E-mail of the customer contact for this
job order.

3. In the Subject line, add the Workflow Parameter SmartName for the job order.

4. In Message, add the Workflow Parameter SmartName for the name of the customer contact.

5. Fill in extra fields as wished

6. Click OK to confirm the settings and close this workflow step.

7. Save your workflow.

In the Upload via FTP step

In our example, the XML file decides if the resulting files will be e-mailed or FTP'd to the customer.
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Note:  See the full documentation of this ticket in Upload via FTP on page 519.

1. In the workflow, open the step Upload via FTP .

2. Enter the name of the Host.

3. In Folder, use the Workflow Parameter SmartNames to send the ZIP into a folder with a logical
name. For example:

4. Set other settings as wished.

5. Click OK to confirm and close this dialog.

6. TIP: Optionally, you can send the customer contact an E-mail that his files are on the FTP
server. Use the Notification tool of this workflow step to do this. Insert the Workflow Parameter
SmartName for the E-mail and name, similar to how we did it in the settings of the 'Send E-
mail' step.

7. Click OK to confirm the settings and close this workflow step.

8. Save your workflow.

Step 6 - Data structure of this Workflow

This is a workflow that does not use the Job concept, so you can not store all your data in sub
folders of a Job Folder.

The data structure that this example workflow creates looks like this:

• The folder MIS-XML-WFL DATA contains all the data that this workflow creates. See the logical
names of the (automatically) created sub folders. These folder names were set in the 'Output in'
fields of the relevant workflow steps.

• The folder MIS-XML-WFL HOT will be the folder used for the Folder Access Point.

Step 7 - Test the Workflow

1. In the Pilot, select your input XML file.
2. Then select the workflow you created and open it (double click).
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3.
Launch and Monitor: Press CTRL-ALT-Enter or Press ALT while clicking .

4. Drag the output file numbers so you can see these output files:

Step 8 - Create the Folder Access Point and Test Again

Note:  If you are not familiar yet with Access Points, then first read Access Points on page 1236.

1. In the Pilot, go to the Access Points view.

2. Create a new Access Point and choose the type Folder.

3. Give it a logical Name and Description.

4. In Folder Settings, indicate the folder where the external system will write the XML files.

5. In Monitoring, set your preferred time interval.

6. In Automatic Actions, indicate the folder where the XML files should be moved to once they
are processed.
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7. Set the Action to Launch Workflow and select the workflow of this example.

8. Click OK to confirm and close.

9. With the new Access Point selected, wait until the time interval passes or press 'Scan now' to
see the resulting tasks appear:

The screen shot shows 2 extra tests where the Preflight ended with a warning.

10.Check the workflow in more detail (output files and folders, XMLs with different options).

Step 9 - Possible Workflow Extensions

Here are some ideas to make this workflow even more powerful:

Feedback new status to MIS

It would be logic to inform the (business) system that sent you the XML on the fact that the workflow
has finished. Here are some tips on how to do that:

• Adding a Create XML step to the workflow and send an XML with the status on a folder that
that system will scan.

• Adding a Interact with Database  step to the workflow and have a database query write that
status right back into that system's database.

Note:  We can not use Milestones here because we are not working in a Job context.
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Read more on such possibilities in Automation Engine sending data Back to the External System
on page 1235

Adding the Preflight Status already in the Email or Report File name

The customer might want to first check the designs where the Preflight showed an error or warning.
To make this possible, you could extend the workflow to capture the Preflight status and use it as
a SmartName. You could then insert that SmartName

• in the Email subject and or message
• in the FTP folder or name of the ZIP.

9.7.6 Getting info from a Web Service into a Workflow

Summary

Your company has printing plants in site A and site B. Automation Engine is in headquarters ('site HQ')
where also the business system is. To enable a cheaper and faster delivery, your planning system
asks Automation Engine which printing plant is closest to the customer, where the printed product
should be shipped to ('site C').

Automation Engine asks the web service of GoogleMaps the distances and reports the result back
to the planning system. The planning system sends its request to Automation Engine via an XML file.
Automation Engine will also send a result back as an XML file.

Tools used in this example:

• SmartNames using Xpath Builder

• Workflow Parameters

• Interact with Web Service task

• Map Data task

• The Data Collector  and Sort  workflow control

Step 1 - Analyse the Input XML

Tip:  Click this link to find a ZIP with the sample XML file used in this example.

In our example, this is the XML file that we get from the planning system (RouteCalcRequest.xml):

http://help.esko.com/docs/en-us/automationengine/14/userguide/pdf/AE-IntegrExtSyst-Example-samples.zip
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For job-order 234567, the planning system asks which printing site is closest to the delivery site in
Memphis: A (Nashville) or B (New Orleans).

Note:  This example contains address as they are written in the USA.

Step 2 - Configure the Web Service

As documented in Interact with Web Service task on page 1276, the GoogleMaps API needs to be
added in  Configure >  External Web Services .

Step 3 - Create the workflow

Create a workflow with these steps. We will define some details later.

1. In Pilot, select the input XML file and create a workflow with these steps (the 2 'GoogleMaps'
steps are Interact with Web Service steps.)
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See how the workflow will use a Map Data step to join and partially redefine the outputs from the 2
interactions with GoogleMaps. Alternatively, you could make this workflow by using a Map Data
step after each interaction with GoogleMaps step, and then later end it with a Join XML step.

2. Edit the names of the 2 Interact with Web Service steps to those as in the screen shot.

3. Save your workflow with a logical name. For example "EXA - WEB - RouteCalc ".

Step 4 - Load Workflow Parameters from the XML

This example does not use the Job concept so we will create Workflow Parameters and pick those
up throughout the workflow.

1. Open the workflow you created and in the menu go to  Advanced  > Manage Workflow
Parameters .

2. Check Use values from XML file and enter theis combination of SmartNames: [URL of
Folder of Input]/[File].xml (see also in below screen shot).

3. Click on Load Workflow Parameters from XML... (below right). Browse to your XML example
file and click Open. Choose to Leave blank to select all elements below the root element.
All the XML element names will be listed, with their value from in this specific example XML:

4. Click on X to close this dialog.
These parameters are now Workflow Parameters. Every time this workflow is launched, they will
be "loaded" before even starting the first workflow step.

5. Save your workflow.
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Step 5 - Define the 2 Interact with Web Service steps

The settings for these 2 steps are almost identical. We will explain the ones for step 'A' and at the
end show the differences with those for 'B'.

1. Double-click the step 'GoogleMaps A' to open it.

2. Set logical values for the Output in and File Name fields.

3. Choose the web Service you configured for Google Maps and choose the Method GET.

4. Enter the Path as defined in the API documentation of Google Maps.
Because we are only interested in the distances, we here use Google Map's API
'distancematrix' and not the API 'directions'.

5. In Parameters, use Workflow parameters to define the API's key origins and destinations.
Unlike in Google Map's API 'directions', the keys 'origin' and 'destination' are both in plural
here! The comma or space between the parts of the address needs to lead to a valid address
specification for Google Maps.

6. The key units is optional. The default already is 'imperial' (miles, feet, inches ..)

7. Press OK to confirm and close this dialog.

8. Now double-click the other step 'GoogleMaps B' to open it.

9. Make sure the File name of the output XML file is different! And for the key origins, use the
Workflow parameters that match the printing site 'B':
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10.Press OK to confirm and close this dialog.

11.Save your workflow.

Step 6 - Settings to Collect and Sort the 2 Responses

It is important in this workflow to keep control over the order of the 2 XML files that Google Maps
will return us. You do not want to risk mixing up the distances for site A or B.

Settings for the Data Collector step:

Keep the default settings: Group all collected data

Settings for the Sort step:

Keep the default settings: Sort by file name in ascending order

Save your workflow.

Step 7 - First test to get the Google Maps result files

To define the settings for the Map Data step, we need the result XML files from the interactions with
Google Maps.

1. In Pilot, select the input XML file RouteCalcRequest.xml and launch your workflow EXA -
WEB - RouteCalc. It will probably fail, because we haven't defined the Map Data step yet.

2. You should get these 2 files:
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Right-click and choose 'Open to inspect them.

This is what Google Maps returns us when we ask the distance between site A and the delivery
site:

And this is what Google Maps returns us when asking the distance between site B and the delivery
site:
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Note:  In Google Maps API, the default value unit for time is seconds and the default value unit
for distance is meters.

Step 8 - Settings in the Map Data step

Next thing to do in this workflow is merge this information into one XML file.

1. In your workflow (edit mode!), open the Map Data step.
You will see that it proposes the workflow's input file (RouteCalcRequest.xml) as example
input file . This is not what we want here!

2. Select the line with that default example Input File and double-click to open it. Browse to the
first input file we really want as example: GoogleMaps_result_A.xml, which we wrote in a sub
folder GoogleMapsFeedback. Click OK to confirm.

3. Click Add and browse to the 2nd file we got back from Google Maps and add it as 2nd example
Input File. Click OK to confirm.

4. This also a good time to set a logical folder and file name for this output XML file that we will feed
back to the planning system. Let's assume that our output folder is a hot folder of that planning
system. Use the Workflow Parameter [wfp.OrderNr] in the file name.

5. Click Continue to start defining the XML content that we want to send back.

6. We will first pick up some parameters from the example input files. On the right, in Parameters,
click Add.

7. Click Edit to open the Xpath Builder and highlight the value of the <text> version of the element
<distance> (222 mi).
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8. Click OK to close. In the Add Parameter dialog, enter the name 'Distance_From_A' and click
OK to close.

9. Do the same for the value of the <text> version of the element <duration> (3 hours 18
mins).

10.Then create the same 2 parameters but using the other example input file
'GoogleMaps_result_B.xml' ('394 mi' and '5 hours 38 mins').
You end up with these 4:

11.Now specify the output XML as shown in below screen shot. See how we use a mix of Workflow
Parameters and Parameters  from the example Input Files.
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12.Click OK to close this workflow step.

13.Save your workflow.

Step 9 - Test the complete workflow

Our workflow is now complete (we assume that the place where the Map Data step writes the output
XML is monitored by the planning system).

1. In Pilot, select the input XML file RouteCalcRequest.xml and launch your workflow 'EXA -
WEB - RouteCalc'.

2. Check the flow and names of the output files. It should look like this:

3. Right-click and open the final output file '2345657_RouteCalc_Result.xml'. It should look
like this:
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The planning system will conclude that, for this job order, the printing site in Nashville is closest.

9.7.7 Updating a Product Status in an External System via Interact with
Database

Summary

Our workflow includes changing the status of a Product Part to Waiting for Approval. Because this
information is important for the service and sales staff, we will also inform the business system of
this new status.

Note:  In this example, we assume you are familiar with the Products tool. Read more on this tool
in Working with Products (old).

Tools used in this example:

• Products tool
• Manage Product Status task
• Interact with Database task, to an external MS SQL Server
• Mark File and Select Marked File  task
• ReportMaker task
• Send E-mail  task

Step 1 - Analysis and Setup of the External Database

Tip:  Click this link to find a ZIP with the sample database file used in this example.

Structure of the External Database Table

This is the database we will interact with:

• The database software type is a MS SQL server.
• It runs on a a server computer named EAW11DL306.

http://help.esko.com/docs/en-us/automationengine/14/userguide/pdf/AE-IntegrExtSyst-Example-samples.zip
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• The name of the database that we will access is MyExternalSystem.

• The name of the (opened) table is ProductionItems.

• The table contains the description of 4 production items.

• The item 'yolo juice' shows its 'ItemStatus' on 'Design arrived'. That is the database
record that we will change in this example.

Configuring the Link to this External Database

Setting up the link to this External Database is identical to how we did it for a previous example in
Step 2 - Configure the Link to the External Database on page 1311.

Step 2 - Initial Product Status and Job Setup

This is the starting configuration we need on Automation Engine:

• In  Pilot  > Products > Manage Product Statuses , create a Status 'Design arrived' with a blue
color and create a status 'Waiting For Approval' with a yellow color.

• Create a Product 666-2712. Give it the status 'Design arrived' and link it to the Job 1237.

• The Job 1237 is for customer FruitCo.
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Step 3 - Create the Workflow

In our example, we assume that the design was already preflighted and made ready for print. Our
workflow starts by creating a proof report and e-mailing it to the customer. It then changes the
Product status to Waiting For Approval and also updates the external database of this new status.

1. Create this workflow and save it as 'EXA - PRODSTAT' :

2. In the Mark File step, set the tag 'Product file' .
3. In the Create Report step, we advise these logical settings:

• choose any Report Template

• choose to Export to an extra PDF (we will e-mail the report PDF so you do not want the PDF
to refer to external files!)

• choose a to Output the file somewhere in the Job Folder  (because the report will probably
contain Job specific info)

• choose a logical File Name which will make sense to the customer when he receives it via
e-mail.
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4. In the Send E-mail step, we advise these logical settings:

5. In the Select Mark File step, use 'Product file' as the tag to be selected.
6. In the Manage Product Status step, select the Status 'Waiting For Approval'.

7. Save your workflow.

The Interact with Database  step is described in the next step of this example.

Step 4 - Setup of the Interact with Database Step

These are settings we need:
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• Output in and File Name: because we are changing an existing database record, the type of SQL
statement in this example is 'UPDATE'. As mentioned in the documentation of this task, this task
only outputs an XML file for 'SELECT ' statements.

• External Database: select the one you set up for the database in this example.

• Statement: use Other.

• SQL: use the query as shown in the screen shot. The 2 SmartNames make this query work for
all Product (Parts).

• Click OK to close.

• Save your workflow.

Step 5 - Test the Workflow

1. In Pilot, open the Job '1237'.
2. In Products View, select the linked in Product '666-2712'.
3. Launch the workflow 'EXA - PRODSTAT' that you created (using a Favorite or right-click Launch

with or...).
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4. This is the result in the Pilot ; notice the Product's change in status and color:

5. This is the resulting finished workflow:



9
Automation Engine

1345

6. This is how the external database should have changed ; notice the new status 'Waiting For
Approval' for item '666-2712':
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10. Integrating with WebCenter

10.1 Introduction

Automation Engine is not available outside its intranet (LAN). You should see it as an in-house system.
Automation Engine can of course be connected with many other systems. And those systems can
be web-enabled. Those systems will also have a different kind of users.

WebCenter is such a system. It is typically used by

• your colleagues working in places outside the intranet (in other plants, other countries, sales
people on the road etc.)

• your customers or other business partners.

If you look at what is communicated between Automation Engine and WebCenter, we distinguish
these types:

• exchanging files: exchanging files from Automation Engine to WebCenter and vice versa.
• exchanging information: exchanging the meta data from a Job to a Project and vice versa.
• sending direct commands to the WebCenter application (advanced setups).

Let's have a look at the main integration concepts between these 2 Esko products:

• WebCenter users want to send instructions or data to the Automation Engine users
• WebCenter workflows contain steps that are prepress actions. These are 'sub-contracted' to

Automation Engine. For example: WebCenter can not pre-flight designs, so it will ask Automation
Engine to do that.

• Automation Engine sending commands to WebCenter.

Publish and Approval
New or changed designs that were made print-ready need approval from the customer. Because the
customer cannot directly access Automation Engine's Jobs or Containers, the prepress department
will have Automation Engine publish the document to WebCenter. WebCenter then manages this
approval process with the customer and delivers the (final) answer back to Automation Engine.

Using WebCenter as a centralized product management system
WebCenter can be used to store all the prepress data centrally. Local prepress sites then download
to their Automation Engine the data that they need for prepress or production tasks. This means that
the files in Automation Engine Containers are actually temporary data whereas the long term data
storage is then on WebCenter.

Important:  Automation Engine does not keep track of versions of files. WebCenter does and that is
important when you use WebCenter as your central storage of prepress data.

Note:  Mind that you can choose to do this for only a part of your prepress data. For example only for
the files of some of your largest customers where prepress production is done in different countries.
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Note:  When Automation Engine users from different sites need data from the central WebCenter
storage, then several types of access rights will define what data they can see and what they can
do with it.

Note:  The parameters of a Automation Engine Product (Part) can be pushed as document attributes
on WebCenter (when the document is part of a BOM).

Apart from storing the prepress data centrally on the web, WebCenter can also use Automation
Engine as background server of some prepress functionality. A WebCenter workflow where your
customer is working with your sales rep could include a workflow step where Automation Engine is
asked to preflight the PDFs.

Automation Engine sending commands to WebCenter
All the above is possible through a handful of tasks and features that handle such communication.
Automation Engine can go a lot further than this and instruct WebCenter in much more detail. Some
examples:

• Automation Engine managing WebCenter users, groups, customers (create, delete...).
• Automation Engine managing WebCenter documents (download, download metadata, delete, set

attributes...).
• Automation Engine managing WebCenter projects (create, manage members, get lists, get

document lists...).
• and much more.

This advanced technique is enabled by the Integrate with WebCenter task on page 1363 in
Automation Engine. It offers over 50 different commands to send to WebCenter.

Note:  Automation Engine can also be told by an external system to send these commands to
WebCenter. For more on this topic, see the chapter on Integrating with External Systems.

10.2 WebCenter Sites

To configure links from Automation Engine to WebCenter sites, go to the item WebCenter sites in
the Configure  tool ( Pilot > Tools > Configure ).
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Website:

Specify the web address of the WebCenter site. After you entered the WebCenter address, click
Open... to check if the WebCenter site is up and running. If you are redirected to the login page, it
means that the address is correct and that the site is up and running.

Tip:  Be aware that this address is also the address that will be included in the notification e-mails
when adding links to documents (approval cycle start e-mail). You should therefore make sure that
the address can be accessed from the outside. Make sure to not use an internal address, but one
that you want your users to use when they use WebCenter.

WebCenter and Automation Engine are in the same LAN

Check this toggle if this is true. This will most likely be the case. Un-check this toggle if WebCenter
and Automation Engine are remote.

Note:  How can you verify that WebCenter and Automation Engine are in the same LAN? WebCenter
and Automation Engine are in the same LAN when you can connect from WebCenter’s application
server, this is the system where JBOSS is installed, to an Automation Engine Job Folder with the
credentials of the user ‘BGSystem’.

WebCenter's Approval Client:

If WebCenter and Automation Engine are not in the same LAN, you first need to create an Automation
Engine Approval Client in WebCenter. This is necessary to give Automation Engine permissions to
listen to the approval messages that are stored in WebCenter.
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Tip:  If the Approval Client does not exist yet, follow these steps:

1. In WebCenter, log in as Administrator.
2. Go to the Admin section. In Configurations, select Workflow Approval Clients.
3. Click the link “New Workflow Approval Client".
4. Enter a User name and a Password for the Automation Engine client. Mind that this is also

the user name and password that have to be entered when configuring the WebCenter site in
Automation Engine.

Fill out the client Name and Password and click the 'Check Connection' button. This will check
if that user can log on successfully.

The Info button displays the following information: ”In case Automation Engine and WebCenter are
not in the same local area network (LAN), the retrieval of the approval results is secured by a name
and password. The name and password specified in Automation Engine must match the name and
password specified in WebCenter by the WebCenter administrator. When clicking the 'Check' button,
the WebCenter version will be checked and the name and password will be validated by WebCenter.”

Check Connection

When you click this button, you should, after a few seconds, get a window saying “Check OK". The
software version of that WebCenter will also be mentioned.

Note:  The button will check the validity of the user name or password to connect to that WebCenter
but not of your WebCenter’s Approval Client.

Note:  When you connect to a secured WebCenter site (for example one that uses HTTPS://), then
you have to export its security certificate and import it on the Automation Engine server. If this is
not done, publishing from Automation Engine to WebCenter will result in an error. Read more on
how to do this in the chapter Install SSL Certificates on the Workflow Production Server of the
WebCenter documentation.

Tip:  After configuring a new WebCenter site, it is recommended to close your Pilot and start it again
in order to see the updated list of WebCenter sites in your tickets.

10.3 The WebCenter View in Automation Engine Pilot

The Automation Engine Pilot offers a specific WebCenter View that will show you all documents
in a WebCenter project without having to open a browser to look at the Project in WebCenter itself.
The Pilot user can also see the documents' approval status in WebCenter and can also download
those documents from this View.
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How to set up
In the Pilot, in the list of Views, click on the WebCenter icon. If the WebCenter View is not configured
yet, you will get a configuration page where you can fill out your WebCenter address and the
user name/password that will be used to connect to WebCenter. If the WebCenter View is already
configured, but you want to change the configuration, you can right-click in the window and you will
get the configuration window again.

Tip:  In the configuration, you need to specify the Project name. It is common practice to map Jobs
to WebCenter Projects using the SmartNames [Job Name] / [ Project Name]. On the configuration
page, use the SmartName [Job Name] for the Project name.

Troubleshooting
If you do not see anything appear in your WebCenter View, right-click on the View canvas and select
Configure. Copy the value of the URL, open a browser window and go to this URL. You should get
the WebCenter login window. To log in, use the same credentials as in the configure page. If you can
log in with the user name of the configure page, retype the password in the configure page that you
just used for logging in to WebCenter. This ensures that the password is still up-to-date. Try again to
connect to WebCenter. If it still does not work, verify that the Project name you try to access really
exists in WebCenter. Ensure that the SmartNames resolve correctly to the project in WebCenter.

10.4 WebCenter Integration Tasks

10.4.1 Create or Modify WebCenter Project task

Concept

This task allows to create a WebCenter Project from Automation Engine. If the project already exists,
it will be updated with new or changed parameters.
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Tip:  Some users want a WebCenter Project for every new Job in Automation Engine.

• When you manually create a Job, you can (in the advanced tab) select this task to be launched
when you create the Job.

• In a workflow, you can insert this task as a step after the Create Job task.

The WebCenter Project that you create is not limited to having the attributes that you defined here in
this task. The Project can also get extra attributes from the selected Project Template or the Customer
Company.

Requirements

To use this task successfully, you need

• in Automation Engine:

• to be in a Job context, a Job with minimally an Order ID.

• the user name and password of a WebCenter Project Manager.

• in WebCenter:

• a Project template with attributes matching the Automation Engine Job parameters
(Order ID, SubOrder ID, and - if used - any custom parameter defined in the Parameters
tab of the Job setup).

Note:  Make sure the WebCenter attributes have the correct type for your Job parameter
data. For example, when passing on a date parameter, the corresponding WebCenter attribute
should have the type 'Date and Time'. When passing on a numeric value, the WebCenter
attribute should have the type 'Numeric' ('Float' or 'Integer'). For more information about
attributes, see the WebCenter documentation.

Attention:  If the WebCenter attributes do not have the exact same name as the
Automation Engine Job parameters, the Job parameters will not be passed on.

• Optionally, check the WebCenter naming of Customer Company and Customer Location.

Task Options

Most fields allow both direct input and/or using SmartNames.
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• WebCenter Site: Select it from the list of Configured WebCenter sites. Optionally, Click
Configure... to access the Configure panel

• Project:The name of the WebCenter Project

• Project Template: Define if you want the new Project to be based on a Project template.

Note:  Make sure you select a Project template with attributes that match the Automation Engine
Job parameters

• Project Status, Customer Company, Customer Location: Click the refresh button to get an
updated list.

• Project Description: If you want, define a description for this Project.

• Project Manager User Name: Define which WebCenter user will be the manager of this Project.

Note:

• This user must already exist in WebCenter.
• This can be the same user as the one you use to contact WebCenter with (the user and

password fields further below). Also, that user that contacts WebCenter in this ticket must have
at least as much visibility in WebCenter as the Project Manager user that you enter here.

• User Name: This the user that you contact WebCenter with and who will create or modify the
Project.
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Note:  The user you enter here must be a Project Manager in WebCenter to be able to create
Projects.

• Password:

• Encrypted. Type it in. It will not be shown visible.
• Use SmartNames. Some customers prefer a SmartName because they do not want

Automation Engine users to know this password or because they want the latest changes in
that password to be automatically picked up here.

Modifying workflow parameters using this task
As mentioned in Modifying Workflow Parameters During a Workflow on page 1075, this task can also
be used to modify Workflow Parameters.

This task allows you to modify the value of a specific Workflow Parameter with the value of the
Project ID of the created or modified WebCenter Project. The mapping of the Project ID to a specific
Workflow Parameter can be done using the Map Output Parameters dialog.

10.4.2 Publish on WebCenter task

The Publish on WebCenter task allows to upload files from Automation Engine to a WebCenter
Project.

Optionally, you can request WebCenter to start an approval cycle on those files. In that case, this
Publish on WebCenter task will remain in a waiting status until the WebCenter sends back the final
answer of that cycle ('approved' or 'rejected').

Note:  An approval cycle in WebCenter ends when all approval members have answered or when
someone used a 'forced approve' or 'forced reject' answer.

This ticket has three tabs:

• Destination: Define in which WebCenter Project you want to publish the file.
• Publish: Define what version of the file you want to make public on WebCenter
• Approval: Define if and how you want to start an approval cycle.

Modifying workflow parameters using this task
As mentioned in Modifying Workflow Parameters During a Workflow on page 1075, this task can also
be used to modify Workflow Parameters.

This task allows you to modify the value of a specific Workflow Parameter with the value of the
Document Version ID of the document you publish in WebCenter. The mapping of the Document
Version ID to a specific Workflow Parameter can be done using the Map Output Parameters Dialog.
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Destination

Note:  You can use SmartNames in most of the fields.

• WebCenter Site: Select the WebCenter site you want to publish the document to. Click the
Configure... button if you want to add or change WebCenter sites.

• Project: Define in which WebCenter Project you want to publish the document.

Tip:  Use [JobName] as Project name to map your Jobs in Automation Engine to the Projects
in WebCenter.

Important:  If the WebCenter Project does not yet exist at publish time, it will be created. Mind
that the user that does the publish needs to be Project Manager in WebCenter to be able to
create a Project in WebCenter.
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Remember:  The recommended method to create a WebCenter Project is by using the Create
or Modify WebCenter Project task.

Note:  When this task creates the Project, the Project manager will be :

• the Project Manager of the Template group if the WebCenter user executing the task is part
of that group.

• or the WebCenter user executing this task.

• Folder: Define in which folder of that Project that the documents should be stored.

Note:  If the folder does not exist yet, it will be created if the user is a Project Manager in
WebCenter. With user we here mean the WebCenter user that you define further below in this
ticket.

• Project Template: If the task needs to create the WebCenter Project, define here which existing
Project template should be used.

Note:  Some WebCenter users do not see all Project templates. Templates are filtered according
the user’s visibility. When you define a user’s visibility, you can list a set of companies and/or a
set of groups. The effect on this is the following:

1. If a template has a customer defined, this customer (= company), needs to be in the list of
companies that the user can see. If the company is not in the list of visible companies of this
user, the template is not visible for this user. This means that this user can not use this template
to create a new Project.

2. When the template has group members, WebCenter checks whether the user can see all the
group members. As soon as there is one group in the template that is not visible to this the
user, the template is considered as ‘not visible’ for this user. Again, the user will not be able
to create a new project based on this template.

• Document Name: This field allows you to set a specific name of the published document. If left
blank, it takes the original name of the document.

Note:  If the document already exists, the task will create a new version of the document.

Note:  If the document already exists in a different folder of that Project, the task will fail.

• Document Description: This description will be available in WebCenter as  Version Comment.

• Document Attributes: This allows to set specific attributes for the document in WebCenter. These
may have different names than what you call them in Automation Engine. For example you can
map some metadata from the PDF to a Document Attribute.

• User Name and Password: Enter the name and password of the WebCenter user that will connect
to WebCenter and upload the document.

Note:  The task will fail in error if this WebCenter user lacks upload rights, even if the Project exists.

Publish

In the Publish tab you decide what version of the input file you want to publish and/or if you want
to prepare special raster data for the WebCenter Viewer.
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Allow Viewing and Annotating in WebCenter

If the Prepare for viewing and annotating toggle is checked, Automation Engine will rasterize the
graphic into files readable for the (WebCenter) Viewer. These rasterized data will then be published
to WebCenter.

Note:  This toggle can not be turned on when WebCenter and Automation Engine are not in the
same LAN.

Note:  If this option is not on, WebCenter will create the raster data for viewing.

The Resolution for non-images (linework, text ...) will be the maximum resolution you will have in
the WebCenter Viewer. You can choose between::

• Optimal: Automation Engine calculates the best resolution, mainly based on the size of the file.
It is recommended to select this option. For small files, it will rasterize with a high resolution. For
large files, it will be a lower resolution. This balance is to ensure you always have a fast viewing
experience in the Viewer, both when you first open the file and when you start zooming in.

• Custom: Allows you to specify a resolution yourself. If you set a high resolution, it will create
large rasterized files. Set a low resolution to have a lower quality view of the document in the
WebCenter Viewer.

Important:  For images, the maximum available resolution is used.

Anti-aliasing: This is relevant for the linework objects in your design that need pre-processing and
for which extra images are generated (CTs). Anti-Aliasing smoothes the staircase effect you get in
these CTs. Text will be more readable, also when zooming in.

Automatic grouping of input file into digital film sets: In a workflow, the publish task can be used
right after a RIP task that creates digital films (for example LEN or TIFF files). In such cases, you
may want to publish these files as one document. Enable this option to bundle that set of digital film
files and publish them as one document to WebCenter. Each digital film will make up one separation
of the document.

Note:  When digital film files were rasterized as one group, the Viewer tool will also recognize them
as 1 set of separations.

Allow Downloading in WebCenter

Make available for download:

• When this option is off, the Publish on WebCenter task will not publish the task's input file to
WebCenter but only the 'prepared' rasterized files. Choose this option when you do not want any
form of your production files to be downloaded by WebCenter users.

• When this option is on, you can choose which files you will make available for download on
WebCenter (if the user has such permissions):

• Input files. For example: your task input file is a production PDF, and that is the PDF you want
the WebCenter users to have access to. Or you already had made low resolution PDFs, and you
choose to publish those instead.

• PDF files for proofing. In this case, you choose not to publish the input file but a PDF file for
proofing that does not exist yet. Select from the list of PDF export tickets which kind of PDF you
wish to create and then publish to the WebCenter user. This way, you offer the outside world a
'PDF proxy' file instead of your real input production file.
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Attention:  Always choose this option when the task input files are not self-contained. For
example when your PDF refers to artwork, fonts or other PDFs.

Note:  If you select PDF files for proofing the viewing quality will be limited to the resolution of
the PDF files for viewing.

When disabling both Prepare for viewing and annotating and Make available for download, a
warning box is displayed indicating that no data will be published. You need to select at least one
type of data to publish.

Approval

The Approval tab allows you to select if and when an approval cycle should be started on WebCenter.

Important:  Make sure you already have an approval cycle set up in WebCenter! This approval cycle
setup will indicate who to invite, what their role is and more. Mind that the approval cycle can be
part of a Project template that you here selected.

Start the Approval Cycle and wait for approval. Select this if you want the approval cycle to start
automatically as soon as the file is uploaded to WebCenter. For this, you need to have an approval rule
specified in the Project or Project folder where you upload the document to. By default, WebCenter
will apply the folder approval setup if it exists. If not, the Project approval setup will be applied.

Due Date: If the WebCenter user that you use to log in with ('Destination' tab) has the Change
Approval Setup permission in WebCenter, you can also set the approval due date.

Note:  The due date specified here will take priority over the due date specified in WebCenter.

You can choose one of the following:

Choice Explanation
Immediate This will set the due date to the time that the

task was launched.
Today This will set the due date to today, at a user

specified time.
Tomorrow This will set the due date to tomorrow at a user

specified time.
In ... hours This will set the due date to a specified number

hours from the time the task was launched.
In ... days This will set the due date to a specified number

of days from the time the task was launched and
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Choice Explanation
at a specified time. A SmartName can be used
to set the number of days.

For example "in 2 days at 5:43 PM" is the same
as "the day after tomorrow at 5:43 PM".

On Use the calendar to set the due date and time.
Job due date This will set the due date to the one specified in

the Job setup.
Select SmartName... If you use a SmartName, it will also be added to

the above menu items.

Note:  The SmartName should be conform to
the ISO 8601 date string format. For example
2014-12-27T11:30:00+02:00

Annotations:

If any annotations were made during the WebCenter approval cycle, the Publish on WebCenter task
generates a annotations summary. At the end of the approval cycle, an HTML file will be generated.
This HTML file redirects the Automation Engine user directly to the WebCenter annotations page in
a browser. He will be asked to login to WebCenter.

You can here decide the folder and name where this 'shortcut' HTML will be written.

What if you get conditional approvals?
Documents that are approved conditionally in WebCenter will go through the Approved with a
Condition output of the Publish on Web task (standard of the type 'warning').
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It is good practice to use a Wait for Action (Checkpoint) task for those documents, so the
Automation Engine operator can fix them manually. For more details about conditional approval, see
the WebCenter documentation.

What if you have multiple input files?
When your Publish on WebCenter task has multiple input files, and your ticket requests an approval
cycle, then an approval cycle will be started for each of those input files. When the Publish on
WebCenter task has received an answer for all files, it will then show their specific status in the
task's output pins: which one was approved or rejected etc...

When you use the Split task in front of the Publish on WebCenter task, then Automation Engine
will start up a Publish task per input file.

Troubleshooting tip
If you get errors in this publish task and the log file does not give you an indication what might go
wrong, then try to do the same steps interactively inside WebCenter, using the user account that you
had used in your Publish ticket. If the error is due to permissions, you will quickly figure out what
goes wrong.

Publishing Automation Engine Products to WebCenter

Attention:  This page addresses customers who use the Automation Engine Products tool.
Learn more about this tool in the chapter Products on page 876.

When you publish an Automation Engine Product to WebCenter, the Product Properties and Product
(Part) Parameters will be taken as WebCenter Attributes. If there are existing WebCenter attributes
with corresponding names, their values will be updated during publishing.

Attention:  For this to work, WebCenter needs to be enabled to work with BOM - Bill Of
Materials. This is a setting in WebCenter -> Admin -> General Preferences.

The following Product (Part) properties and Product (Part) Parameters are synchronized with
WebCenter Attributes (see further how to rename these internal names to more readable ones):

Automation Engine Properties/Parameter WebCenter Attribute (Internal name)
Product Customer Reference ae.p.cusref
Product Custom Field 1 ae.p.category1
Product Custom Field 2 ae.p.category2
Product Custom Field 3 ae.p.category3
Product Internal ID ae.p.id
Product ID ae.p.prodid
Product Name ae.p.name
Product Description ae.p.desc
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Automation Engine Properties/Parameter WebCenter Attribute (Internal name)
Product Part Internal ID ae.ppid
Part Default Angle ae.pp.defaultangle
Part Default Dotshape ae.pp.defaultdotshape
Part URL ae.pp.url
Part Default Ruling ae.pp.defaultruling
Part Preferred InkBook ae.pp.preferredinkbook
Part Preferred InkBook UI ae.pp.preferredinkbookui
Part Internal ID ae.pp.id
Part Custom Field 3 ae.pp.category3
Part Custom Field 2 ae.pp.category2
Part File ae.pp.file
Part Status ae.pp.status
Part Status Nickname ae.pp.status_nickname
Part Status User ae.pp.status_user
Part Status Notes ae.pp.status_notes
Part Status Date ae.pp.status_date
Part Folder ae.pp.folder
Part Custom Field 1 ae.pp.category1
Part Name ae.pp.name
Part Inks ae.pp.inks
Part Barcodes ae.pp.barcodes
Product Customer Name ae.c.name
Product Customer Description ae.c.desc
Product Customer ID ae.c.id
MyProductParameter1 ae.p.par.MyProductParameter1
MyProductPartParameter2 ae.pp.par.MyProductPartParameter1

When a Product or Product Part  is published, the corresponding WebCenter Documents are
automatically added to the Bill Of Materials  of the WebCenter Project. The Product Amount for
the Job (if given) is updated as the Count property of the Bill of Materials.
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Tip:  You can rename the internal name of WebCenter Attributes to a more readable name by first
adding it to a Category:

Learn more about this in the PDF named Connection between Automation Engine and WebCenter
14  that you can download from http://help.esko.com/products/WebCenter.

10.4.3 Download WebCenter Document task

This task allows to download documents from WebCenter into an Automation Engine Container
(or Job Folder). Optionally, downloaded documents including their document attributes can be
immediately added to the Products database.

The following SmartNames are useful in a Download WebCenter Document task:

• WebCenter Document Folder: The folder in the WebCenter project that holds the document that
you are downloading.

• WebCenter Document Name: The name of the WebCenter document that you are downloading.

• WebCenter Document Original File name: The original name of the file that was uploaded to
WebCenter and there made a document.

http://help.esko.com/products/WebCenter
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• Output in and File name The above screen-shot shows how the default ticket proposes you a
logic place and name for the file you are downloading.

• Site: The WebCenter site to download the document from. Click Configure... to add or change
WebCenter site configurations (enabled only for administrator users).

• Project Name: The name of the WebCenter Project that you want to download a document from.

• Document Name: The name of the WebCenter document that you want to download.

• Lock document: Check this option if you want to lock the document in WebCenter. When the
document is locked, other WebCenter users will not be allowed to upload new versions. Only the
WebCenter user that locked the document can publish a new version and/or unlock the document.

• User Name and Password: of the WebCenter user that downloads and/or locks the document.

• Create or update Job Product: Check this option if you want to add the downloaded document
as an Automation Engine Product for the Job you are working in. If the file is already a Product,
the WebCenter document attributes are merged with the existing Product (Part) parameters. If
the attribute already exists as Product (Part) parameter, that Product (Part) parameter's value is
updated. If the attribute was not a Product (Part) parameter yet, it is added as a Product parameter.

Important:  In order to use the option Create or update Job Product, the task must run in a
Job context!

10.5 Advanced WebCenter Integration
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10.5.1 Integrate with WebCenter task

Concept

WebCenter can be used

• interactively, in a browser, by a WebCenter user
• by an external system, through a special connection setup
• by Automation Engine, by using the Integrate with WebCenter task.

This Automation Engine task goes a lot further than the ones we documented earlier: those other
tasks focus on exchanging files and creating projects in WebCenter. This Integrate with WebCenter
task enables Automation Engine to perform more than 50 different actions on WebCenter. Some
of these actions are very elaborate commands or requests for information and some even change
configurations.

Note:  The technology behind this task has historically often been referred to as the "WebCenter SDK"

Attention:  This task requires advanced knowledge of both WebCenter and Automation
Engine.

Task Options

• Output in and File name: Depending on the Action chosen below, these fields might be relevant
or not. If the action triggers this task to have an output file, then you can here define their folder
and name.

• Site: Select the WebCenter site from the list. Click Configure... to add or change WebCenter site
configurations (enabled only for administrator users).
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Note:  A connection will be made with the WebCenter that you select. It will not just test the
connection but will also get the list of possible commands from that specific WebCenter server.
That list then becomes the list of Actions (for this WebCenter).

• Action: Select the action. When the selected action offers options, the Options... button will
become active. The options dialog is specific per action. Here is an example:

See how selecting the action "Get List of Documents" automatically offers a sub-type of action
to choose, here "Specify folder(s) by ID" (or "by Name"). The button Options... offers another
specific dialog with more options for this Action.

Attention:  Most option fields offer Tool Tips which extra information, conditions and
general tips. Tool tips appear when you hold your mouse-cursor over the field.

• User Name and Password. Define which WebCenter user will execute the selected action on
WebCenter. Make sure this user has the required privileges.

More info
More detailed technical info is available in the "WebCenter SDK documentation". Read more about
this document in this Esko Knowledge Base article: KB 92180925.

Modifying workflow parameters using this task
As mentioned in Modifying Workflow Parameters During a Workflow on page 1075, this task can also
be used to modify Workflow Parameters.

The Integrate with WebCenter task allows you to modify the value of a specific Workflow Parameter
with the result of the action executed by the task.

For example (as shown in the screen shot): when you select the action "Get Document History", you
can update the value of a specific Workflow Parameter with the value of the approval status of the
document. First you need to define to which Workflow Parameter a specific Output Parameter needs
to be mapped to. You can do this using the Map Output Parameters Dialog.

https://wiki.esko.com/display/KBAS/KB92180925%3A+WebCenter+-+Where+to+find+the+WebCenter+SDK+documentation
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11. Troubleshooting

11.1 Troubleshooting the Automation Engine Server

As an Automation Engine administrator, you can run diagnostic tests on the Automation Engine server
when something seems wrong. With the provided tools, you can attempt to fix the problems yourself
without the need to call Esko Customer Support.

11.1.1 How to check the status of the AE databases

Proceed as follows:

1. Open the Server Admin Tool by entering http://<name of your server> or http://
<name of your server>:9999 in your browser.

2. Click on Diagnostics.

3. Log in using an administrator account or using an account that is a member of the BGADMIN user
group on the Automation Engine server.

4. Click on Databases.
When the Databases page is loaded for the first time, the database diagnostics tests will be
executed automatically for every Automation Engine database (see the following image).

5. If you want to execute the diagnostics tests for the Automation Engine databases again, click
the Check Again button.

For every Automation Engine database, you can see the following information:

• The Status of the database.

• The Database name.

• The Database System.
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• The status Details of the database.

• A link with detailed information on the database.

The Status of the database can be one of the following:

Status Definition
The database is online and accessible.

The database is online and accessible, but there are one or more warnings (for
example the database is near its size limit).
The database is not online or is not accessible (for example no connection could be
made to the database system, or the login failed).
The status of the database is unknown. This is the case if the DBMS type of your
Application Server database is an Oracle database or any of the other databases is
an Embedded database. There are no diagnostic tests available for these two types.

Note:  In the Configure tool, you can change the DBMS type of the database. For
more info, see: Automation Engine Databases.

Note:  If the Automation Engine server is not running, you can still check the status of the Automation
Engine databases. In this case however, the Database System field will be empty.

11.1.2 How to run network diagnostics tests on the AE server

To check if your network is set up properly, proceed as follows:

1. Open the Server Admin Tool by entering http://<name of your server> or http://
<name of your server>:9999 in your browser.

2. Click on Diagnostics.

3. Log in using an administrator account or using an account that is a member of the BGADMIN user
group on the Automation Engine server.

4. Click on Network.
When the Network page is loaded for the first time, the  network  diagnostics tests will be
executed automatically for every Automation Engine database (see the following image).
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5. If you want to execute the network diagnostics tests again, click the Check Again button.

For every Automation Engine network diagnostics test, you can see the following information:

• The status of the network test.
• The name of the network test.
• The status details of the network test.

The Status of the database can be one of the following:

Status Definition
The network test succeeded.

The network test succeeded, but there are one or more warnings.

The network test failed.

The network test was not applicable or was skipped.

What do the network diagnostics tests on the AE server do?

Test name Explanation
Online help A test to verify if the server can access http://

help.esko.com. the online source of help, with
a reference guide and a plethora of knowledge
base articles.

DNS A basic networking test to verify if the server
name for this computer corresponds uniquely
to what the Domain Name Server will return to
other systems trying to connect to this system.

License Server A connection test from the server to the License
Server. In case of failure, basic network tests are
done to verify DNS configuration and TCP/IP
connectivity.

http://help.esko.com/
http://help.esko.com/
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Test name Explanation
Assistant Server A connection test from the server to each

configured assistant server. In case of failure,
basic network tests are done to verify DNS
configuration and TCP/IP connectivity. In case
no assistant servers as configured, this test will
not show up.

Container Server A test to see if the server can connect to all
configured Container servers.

Webcenter Server A test to see if the server can connect to the
configured WebCenter Sites.

Device Server A test to see if the server can connect to
each configured subsystem. In case of failure,
basic network tests are done to verify DNS
configuration and TCP/IP connectivity. The
tested subsystems are RIP stations (FlexRIP),
Imaging Engine, Digital Front End for digital
presses (DFEs), Nexus and Odystar servers.

11.2 Troubleshooting the Automation Engine Pilot

As an Automation Engine administrator, you can run diagnostic tests from an operator's workstation
to verify that the Pilot's connection to the Automation Engine server works properly. With the provided
tools, you can attempt to fix the problems yourself without the need to call Esko Customer Support.

11.2.1 Connection Doctor

Opening the Connection Doctor

You can run diagnostic tests from an operator's workstation to verify if the Pilot's connection to the
Automation Engine server works properly. This can be done via the Connection Doctor tool in the
Automation Engine Pilot.

To view the Connection Doctor in the Pilot, choose  Tools > Connection Doctor .
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Alternatively, if you have trouble logging into the Pilot, an extra Connection Doctor... button will be
available to go directly to the Connection Doctor.

The Connection Doctor runs a series of tests that check the connection from Pilot to the Automation
Engine server. These tests are the following:

• Server access test
• Connection Speed test
• Automation Engine Viewer access test
• Software Update access test
• Online Help access test

Status Messages

The tests in the Connection Manager can have the following statuses:

Table: Server

Message Clarification

The Automation Engine server is down
for maintenance. Please try again later or
contact your administrator.

The maintenance status includes: server
updates, server upgrades or the installation
of hot fixes. Try again on a later moment, or
contact your administrator if necessary.
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Message Clarification

The Automation Engine server is restarting.
Please try again in a moment.

This can take a few second to a few minutes.

The server you're connecting to is an
assistant server. Please connect to the
master server <host_name of the master>.

In setups where Automation Engine runs on
multiple servers, one server is designated the
role of master. The other servers take up the role
of assistants. The master server is the server you
need to log in to.

The server is currently set to idle. Please try
again later or contact your administrator.

If a server's current role is set to idle, it will
accept no connections. Please try again later or
contact your administrator if necessary.

There was a problem connecting to
<host_name>. Please check that the host
name is correct and <host_name> is on.

This computer is unable to connect to the host.
Please check that the host name is filled in
correctly and that the computer is switched on.
Please contact your IT department should you
need assistance.

There was a problem connecting to
<host_name>. Please check that the server is
running.

This computer is unable to connect to the
Automation Engine server. The most common
reason for this is that the server is not running.

If the server is running, verify if your computer is
correctly connected to the network.

If you require assistance with this problem,
contact your IT department.

There was a problem connecting to
<host_name>. Please check that the server is
running, and verify with your IT administrator
if the "<host_name>'s" file is correct.

This computer is unable to connect to the
Automation Engine server. The most common
reason for this is that the server is not running.

If the server is running, verify if the hosts file
of your operating system is correct. The hosts
configuration of this computer contains explicit
references to the Automation Engine server's
host name and its IP addresses. A configuration
error could be the cause of this connection
problem.

If you require assistance with this problem,
contact your IT department.

There was a problem connecting to
<host_name>. Please check that your
computer is connected to the network.

This computer is unable to access the network.
You can try and diagnose the problem by using
one of the following methods:

• On Mac, go to:  Applications > System
Preferences > Network > Assist me...  to
test your connection .

• On Windows, go to:  Start > Control Panel
> Network and Internet > Network and
Sharing Center > Troubleshoot Problems >
Network Adapter  to test your connection.
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Table: Viewer

Message Clarification

There was a problem connecting to the
Application Server. Please check that the
server is running. Contact your administrator
if the problem persists.

The Application Server could not be reached.
Check if the server is running. Contact your
administrator if the problem persists.

The Application Server <host_name> is not
running on port <port_number>. Please
contact your administrator.

The Application Server is not running on the
designated port. Contact your Automation
Engine administrator to fix this issue.

Table: Connection Speed

Message Clarification

The connection speed to the server is good. The response time between this computer and
the server is less than 20 milliseconds, which is
considered good.

The connection speed to the server is
acceptable.

The response time between this computer and
the server is between 20 milliseconds and 100
milliseconds. This is OK for normal operations.

The connection speed to the server is bad. The response time between this computer and
the server is more than 100 milliseconds. This
is considered too slow for normal operation.
Consult with your IT department what can be
done to improve the speed.

Table: Software Updates

Message Clarification

Software updates will be downloaded and
installed when they become available.

The Automation Engine Web Server is
accessible from this computer. Software updates
will be downloaded and installed when they
become available.

The Automation Engine Web Server could
not be reached. Software updates will not be
installed on this machine.

The Automation Engine Web Server could not
be reached. This is most likely due to firewall
restrictions. Contact your administrator to
resolve this issue.

Note:  The Automation Engine server hosts software updates for Automation Engine Pilot. The
Software Updates test checks if software updates can be downloaded to the client computer. The
test will fail if the Automation Engine Web Server is not correctly hosted on port 9999. For example,
if another web service has claimed this port on the server. Please contact your Automation Engine
administrator to resolve this issue.

Table: Online Help

Message Clarification

Esko online help is available at http://
help.esko.com/.

Esko online help is available.

Pilot was unable to connect to the Internet.
Please check the Internet proxy preferences
of your operating system if you have

Automation Engine Pilot was unable to connect
to the Internet. Check the Internet proxy
preferences of your operating system. Contact

http://help.esko.com/
http://help.esko.com/
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Message Clarification
experience problems accessing Esko online
help.

your IT department if you require assistance with
fixing this issue.

Note:  This test verifies if the computer can access  http://help.esko.com, your online source of help,
with a reference guide and a plethora of knowledge base articles. A warning is issued when the online
help is unreachable. This does not necessarily mean online help is unavailable. Your Internet browser,
which is used to display the help pages, may be configured with an Internet proxy that enables you
to access the online help even if the Pilot is unable to connect to it. If unsure, please contact your
IT administrator for more information.

http://help.esko.com/
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12. IT requirements and FAQs

12.1 Introduction

This document describes the information needed to facilitate the installation of an Automation
Engine. It also answers typical IT related questions.

General system requirements for the involved computers can be found on http://www.esko.com/en/
SystemRequirements/Automation%20Engine/

Note:  This document mentions components and features that are (commercially) optional.

Note:  CP is used as abbreviation for 'Commercial Print'.

There are two sections in this document :

1. Technical details of an Automation Engine setup.
2. Guidelines and good practices in setting up an Automation Engine Environment.

12.2 Technical Details

12.2.1 Automation Engine in its environment

Overview

Overview

Component Description
Automation Engine Master server Main server where all clients are connecting

to. This server manages the Jobs and tasks
database. This server also executes the actual
server tasks.

Automation Engine Assistant server Assistant server that can execute tasks to take
away load from the master server.

Application server Component serving the Automation Engine
Viewer and CP (page) workflow tools. Typically
this component is found on the Automation
Engine Master server.

http://www.esko.com/en/SystemRequirements/Automation%20Engine/12_0
http://www.esko.com/en/SystemRequirements/Automation%20Engine/12_0
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Database server Server where the databases are located.
Typically this component is found on the
Automation Engine Master server.

Client A client workstation is connecting to the
Automation Engine Master server via Pilot or
Shuttle. Editors can also connect to the server
(ArtPro, PackEdge, Adobe Illustrator).

FlexRip Esko RIP that generates digital files for proofs
and/or plates. The Automation Engine Master
typically connects to one or more RIP devices.

WebCenter Esko's online collaboration tool.
File server Where the actual data is. Files are stored in

'Containers'.
Mail server A mail server can be used by Automation Engine

to send out e-mails.

12.2.2 Automation Engine installation

Automation Engine System User

Automation Engine needs a system user to run its service and connect to other network components.
The Automation Engine System User account must meet following requirements on the Automation
Engine server:

• should be a member of the Administrators group

• should have the Logon as Batch right

• should have the Logon as Service right

An installation of Automation Engine creates a local user BGSYSTEM on the Automation Engine
Master according to these requirements. This user then serves as the Automation Engine System
User.

Services

An installation of Automation Engine will install these services:
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Service name Service running under Purpose

BGMD Automation Engine System User Automation Engine's main
service

EG APPLICATION SERVER ('*) Automation Engine System User Application server service for
Viewer and CP Layout tools

EG STATION INFORMATION
SERVICE

Local System User System info collection service

EGWEBSRV Automation Engine System User Webserver for server admin and
client updates

FLEXlm License Manager Local System User License manager

FLEXnet licensing service Local System User License manager

MSSQLSERVER Network Service Default database server

MSSQL$EG_APPSRV_JBOSS
('*)

Network Service Default database server for the
application server

MSSQLServerADHelper Network Service SQL Server Active Directory
Helper

SQLWriter Network Service SQL Server VSS Writer

SQLBrowser Network Service SQL Server Browser

('*) Installed optionally on systems having Viewer and/or CP Layout Tools.

Attention:  All the services and processes of Automation Engine run as 32 bit.

Shares

These shares are created during the installation of Automation Engine:

Sharename Purpose Access

AutomationEngineImgFolder Temporary folder for image data server only

AutomationEngineLogging Automation Engine log files server only

AutomationEngineTmpFolder Temporary folder for Automation
Engine tasks

server only

bg_data_cms_v010 Central resources - Color
management data

server and clients

bg_data_custom_v010 Central resources - Automation
Engine presets

server and clients

bg_data_dgc_v010 Central resources - Dot gain
curves

server and clients

bg_data_fonts_v040 Central resources - Fonts data server and clients

bg_data_ipldata_v010 Central resources - CIP3/
Inkplanner presets

server and clients

bg_data_marks_v010 Central resources - SmartMarks
sets

server and clients

bg_data_system_v010 Central resources - License
configuration

server and clients
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DeskPackContainer Container for temporary
DeskPack iles

server and clients

EG_APPSRV_BINDEPLOY Application server configuration
folder

server only

EG_APPSRV_CONFIGURATION Application server configuration
folder

server only

EG_APPSRV_DEPLOY Application server configuration
folder

server only

ExampleJobContainer Default data container created
at first install

server and clients

FastRipTask FlexRip temporary folder server and clients

Impose FastImpose templates, marks
and defaults

server and clients

PitStop Enfocus PitStop templates and
configuration data

server and clients

Note:  Access right is set to: Read/Write for 'Everyone'

Installation Folder

Automation Engine is by default installed in a folder Esko on the root drive. Automation Engine can
not be installed in the Program Files or Program Files (x86) folder.

Every Automation Engine installation will create and use a temporary folder in the Esko folder
(BG_TMP).

Tip:  It is good practice to defer that folder to a drive other than the system drive. How to do that
is described in the Installation Guide".

12.2.3 Network Details

Network Configuration

Automation Engine requires TCP and IPv4 to work.

Note:  IPv6 is unsupported.

You need to configure DNS correctly. Links to other network should be configured using host names,
not IP addresses.

If a DNS and/or proxy server is used, make sure all components in the equation (Automation Engine
Server, Automation Engine Client, Proxy Server) are able to do an nslookup on hostname of all
other components.

Danger:  After installation of the Automation Engine software, the host name of that server cannot
be changed.
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Ports

These are the ports used by Automation Engine and the client software:

TCP :

• 8000-9000 for BGMD and the Automation Engine servers
• 5182 for ShuttleServer, unless configured otherwise
• 4401 for the Automation Engine JDF Server (service port)
• 1433 for the SQL server (default installation)
• 27100 and a dynamic port for Station Information Service
• 1098 RMI port for the EG Application server
• 1099 JNDI Naming Service for the EG Application server
• 4444 RMI Object for the EG Application server
• 4445 Transaction Manager for the EG Application server
• 27000 for the License Manager service

HTTP:

• 80 + 9999 for Tomcat/ServerAdmin (egwebsrv.exe)
• 8080 for EG Application Server
• 4411 for the Automation Engine JDFServer (JMF)
• 4412 for the Automation Engine Frip2JDF Server : process incoming feedback (JMF) from DFS
• 4415 for the Automation Engine ElemServer (experimental)

Connection with clients:

• The server sometimes relies on ephemeral ports, for example for uploading files in Pilot. These
ports are picked randomly between  49152 and 65535.

LAN/WAN Network Performance

Automation Engine client-server connection requires decent network performance.

Latency simulations in a lab environment show that:

• With delays below 20ms client (Automation Engine Pilot) performance is optimal
• With delays till 50ms client performance is relatively acceptable
• With delays around 100ms (and higher) client performance is poor to unacceptable

Therefore Automation Engine is not suited to run in a WAN environment.

Attention:  Using tools such as remote desktop services is in violation with the EULA (End
User License Agreement).

12.2.4 Database server

By default, Automation Engine is installed with an SQL Express database engine. However, for scaling
and performance reasons, one can choose to use a Full SQL server. Read more about this in Using
a Full SQLServer on page 1383.
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Installation Details

Mandatory components:

• SQL Server Database Engine
• Replication and Fulltext components

Mandatory installation parameters:

• Collation settings: SQL_Latin1_General_CP1_C1_AS
• Security Mode: SQL
• TCP protocol for the SQL Server service: enabled

Note:  These are the installation parameters used to install the default MSSQL Express server:

/ACTION=INSTALL
/FEATURES=SQL
/BROWSERSVCSTARTUPTYPE=Automatic
/SQLSVCSTARTUPTYPE=Automatic
/SQLSVCACCOUNT=”NT AUTHORITY\SYSTEM”
/SQLSYSADMINACCOUNTS=”BUILTIN\ADMINISTRATORS”
/SQLCOLLATION=SQL_Latin1_General_CP1_C1_AS
/IACCEPTSQLSERVERLICENSETERMS=1
/INSTANCENAME=<instancename> of MSSQLSERVER for unnamed instance
/SECURITYMODE=SQL
/SAPWD=<default password>
/TCPENABLED=1

Configuration details

Automation Engine requires 4 databases to run:

• BSJobs
• FastLane_TM
• FastLane
• EG_Appserver_JBOSS

Note:  The terms BS and FastLane refer to names of product that Automation Engine's architecture
originates from.

To access and modify these databases, Automation Engine needs a user who can:

• Login to the Database server:
• Database roles:

• db_owner: Members have full access.
• db_accessadmin: Members can manage Windows groups and SQL Server logins.
• db_datareader: Members can read all data.
• db_datawriter: Members can add, delete, or modify data in the tables.
• db_ddladmin: Members can run dynamic-link library (DLL) statements.
• db_securityadmin: Members can modify role membership and manage permissions.
• db_backupoperator: Members can back up the database.
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Oracle as Database Server for the Application Server component

An Oracle database server can be used to run the EG_Appserver_JBOSS database of the Application
Server component.

This will increase performance of the Pilot modes Pages, Proofs and Plates module. This so means
that the use of Oracle is only relevant in a production workflow for books and magazines. It has no
effect on the performance of the Viewer (which also uses the application server component).

Following database server versions are supported:

• Oracle 10g Standard Edition, Enterprise Edition
• Oracle 11g Standard Edition, Enterprise Edition

Important:  using Oracle as a database server for BSJobs, FastLane_TM and FastLane is not
supported.

12.2.5 File Server

Server Types

Automation Engine can use data that is available on network shares. These shares need to be on
Windows or Unix/Linux (using SMB) file servers.

:  We recommend to use Windows Server 2003 or Windows Server 2008 as file server.

Restriction:  Due to increasing connectivity issues between Mac OS and Windows Server, Mac OS
X (version 10.5.x, 10.6.x, 10.7.x, 10.8.x, 10.9.x) data servers are no longer supported.

Supported Access Protocols

Esko does not support fileserver access over protocols other than SMB/SMB2.

File server access

The Automation Engine system user must have read and write access on the shares. read more on
this in Automation Engine System User on page 1375.

12.2.6 Mail Server

Automation Engine can send e-mail to communication with your colleagues or customers, but also
with Esko Customer Service, to report problems.

Supported protocols are :

• smtp
• smtps (secure)
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You can set up the Corporate Mail server or the Google servers to be used by the Automation Engine
to send e-mails. For setting up a Google Server, you need a Google mail account. You can configure
Automation Engine to use a secure connection to smtp.gmail.com on port 465 using that account.

12.2.7 Users and Groups

Automation Engine Users

Users in Automation Engine map directly to Windows users.  The Windows users are organized in
two local Windows groups on the Automation Engine master. Regular users are in the BGUSERS
group, administrators are in the BGADMIN group.

These Windows users can be local users on the Automation Engine master server or Windows
domain users. If you create a new user via the Automation Engine Pilot, a local Windows user is
created for you.

If you want to use domain users, then assign these domain users to either the BGUSERS or the
BGADMIN local Windows group.

 Automation Engine Groups

User groups in Automation Engine have no correlation with Windows groups.

 Domain Users

Domain users can be used in Automation Engine. This requires that the Automation Engine system
user can retrieve user info from the Active Directory. Read more in Automation Engine System User
on page 1375

Restriction:  Automation Engine does not offer support for Domain Groups.

Single Sign-On

The Automation Engine client software does not offer any implementation for "single sign-on" .

12.2.8 The Automation Engine Pilot

Java

On Windows, a Java Runtime Environment (JRE version 1.7) is distributed with the Pilot. The user
does not need to install Java on the client machine.

On MAC, a Java Runtime Environment 1.6 is required. However, Apple does not allow Esko to
distribute this version, so the installation of Java has to happen separately from the Automation
Engine client. The installation of Java should start automatically when the Java Runtime Environment
is needed by the Automation Engine client installer. This automatic installation is currently provided
by Apple and could change in the future.
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12.3 General Guidelines

12.3.1 Scalability and Performance

Adding an Automation Engine Assistant

Adding an Assistant to Increase Throughput

Automation Engine comes with a built-in limit on the amount of concurrent tasks (tasks that are
processed simultaneously). The number of concurrent tasks that can be processed depends on the
licenses purchased . Evaluating and defining the amount of concurrent tasks needed should take into
account the number of files processed and the number of task run on these files over a certain period.

The amount of concurrent tasks needs to be in line with the capacity (RAM/CPU) of the Automation
Engine server. More concurrent tasks will increase the load on the system. If the capacity of the
Automation Engine server has reached it's limits, it can be increased by adding one or more Assistant
servers. One Automation Engine server will take the role of Master, the other(s) will take the role of
Assistant. The Master will monitor its own load and the load of the assistants to decide on which
server a task should be executed.

Adding an Assistant for Redundancy

An Automation Engine Assistant is not an out of the box fail safe solution.

However, it could be used in a fail safe scenario. In case the Master breaks down, an Automation
Engine server in an Assistant role, can be promoted to a Master server. A full backup package of the
Master (Configuration, Resources, Databases) can then be restored on the Assistant to rebuild the
initial configuration. Note: the backup package of the Master generated by the scheduled backup
procedure of Automation Engine can be automatically copied to the Assistant.

Fail safe solutions based on proper backup tools or on snapshots of virtual images are a valid
alternative, and might be seen as a more effective solution.

Adding an Assistant versus Adding an extra Master

When throughput needs to be increased, adding an assistant is not necessarily the best option. If
the production/organization can be split into logical components, then it could make sense to add
an extra master.

One master-assistant(s) combination has one main processing queue.

Redirecting Central Resources

Following shares are considered as central resources:

• bg_data_cms_v010
• bg_data_custom_v010
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• bg_data_dgc_v010
• bg_data_fonts_v040
• bg_data_ipldata_v010
• bg_data_marks_v010

It is allowed to redirect these resources to a central file server. Valid reasons for doing this are:

• Access: these shares need to accessed from other applications/servers than Automation Engine
(PackEdge, ArtPro, FlexRip,...)

• Backup strategy: these shares contain critical files such as color profiles, marks, curves,...
Remember that these shares are also included in Automation Engine's scheduled backup.

Note:  Esko recommends keeping the resources on the Automation Engine server to avoid extra
network traffic.

Using a Full SQLServer

Express edition versus Full SQLServer

Automation Engine requires a working DBMS (Database Management System) for its proper
operation and persistent storage.

Microsoft's SQL Server Express Edition is delivered and installed together with Automation Engine.
Automation Engine is configured to work with this SQL Server as default DBMS in this out-of-the-
box setup. New and empty databases and users are created during installation.

The SQL Server Express Edition software has the following limitations :

• Database sizes are limited to 10 GB (as of Express Edition 2008 R2).
• The SQLServer service will only use 1 CPU and will restrict its memory usage to 1 GB.

In many cases, the SQL Server Express Edition will be sufficient. However, from a certain load or
performance expectation onwards, it is highly recommended to upgrade your Express edition to a
full SQL Server. This section gives recommendations as to when the DBMS for an Automation Engine
installation should be upgraded from an Express Edition to a full SQL server.

Database Size Limitations

SQL Server Express Edition 2008 R2, delivered along with Automation Engine (since 12.1.1 onwards),
has a size limitation of 10 GB per database. However, you can scale up to a full version of SQL Server
to increase the size limit to the disk size. Given that Automation Engine has three main databases,
consider the following points:

• Jobs database: Automation Engine does not function as an archiving system. To keep the Jobs
database size under the limits, we recommend:

• keeping a Job online only for it's lifetime. The concept of a Job is temporary by nature: Jobs,
after a while, are done. If you have many re-prints of products, then consider using the Products
tool (Database) as well.

• archiving unused Jobs and Products.

Note:  Theoretical limits regarding the number of Jobs and Products exceed the practical Express
Edition server demands (<50.000 jobs / <250.000 products) considerably.
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• Task Monitor database: To keep the size of the Task Monitor database under limits, we
recommend:

• setting up adequate Task Clean Up rules.

Note:  The theoretical limit on the number of tasks in the Task Monitor in terms of size (>100.000
tasks) is overruled by what the Express Edition server can handle in terms of performance
(<100.000 tasks).

• Task History database: We recommend archiving the tasks in the Task History database
regularly to keep the database size under limits.

Note:  For the 2005 and 2008 Express Edition databases, you can estimate the limits by reducing
the limits by a factor 2.5.

Read more in:

• Performance Considerations on page 1384

• Recommendations on page 1385

Performance Considerations

The Automation Engine server performance depends on the performance of the used DBMS. This
may be noticeable when searching a Job in the Pilot (for example while filtering ), when monitoring
tasks (while filtering or scrolling), when executing tasks (while persisting their state, progress,
ticket, ...), and so on.

The number of tasks ran per day and the average number of connected operators (using a Pilot or
Shuttle) determines the load put on the Automation Engine server and its DBMS. In addition, the
setup of the DBMS and the environment in which it is running will also have an important effect on
performance :

• The SQL Server software can be installed on the same computer as the Automation Engine
software or on another computer.

• If the SQL Server is installed on another computer, then the network is involved. Under-performing
network components may seriously influence DBMS performance. Other software running on that
computer may influence performance as well.

• If the SQL Server is installed on the same computer as the Automation Engine (master or
assistant), that may have an impact on the amount of memory and CPU resources available to
the Automation Engine.

• An SQL Server can be set up to run 1 instance (unnamed or the default), or even multiple (named)
instances. In case of an Express Edition, each instance then has its own limitations (as described
above), independent of the others.

• Each Automation Engine database may be configured independently of the others (to potentially
point to different SQL Server instances on potentially different computers).

Issues with database performance can be noticed in the following situations (but are not limited to):

• a decline in average response time as experienced by operators of the Pilot.
• a decline in average time between the moment of submitting a task and the moment the submitted

task starts processing.
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Recommendations

We recommend upgrading the SQL Server Express Edition to a full SQL Server if one or more of the
following conditions apply when:

• more than 30.000 tasks are processed per day- this typically corresponds to 1.000 Jobs or files
per day.

• more than 100.000 processed tasks are constantly present in the Task Monitor (assuming that
cleanup rules are set up adequately).

• more than 20 active Pilots are connected simultaneously.
• Automation Engine is licensed and configured to run more then 7 concurrent tasks.
• the database size limitation risks to be exceeded.
• you use the functionality of the Pages, Proofs and Plates views (in commercial print imposition

workflows).
• there is a continuous load on the Automation Engine server (when production runs 24 hours per

day).

When upgrading to a full SQL Server, special attention must go to provide sufficiently powerful
hardware. When the SQL Server is installed on a dedicated computer, we recommend:

• SQL Server 2012 Standard Edition
• a powerful machine (4-8 CPU)
• 64-bit OS (Windows 2008 R2 / Windows 2012)
• with at least 16 GB RAM (preferably 32 GB)
• with a high performance network card

Note:  While SQL Server Express Edition is expected to be adequate, problems due to database
hiccups can happen (for example when peak load happens frequently, which might cause some of
the numbers mentioned above to be surpassed temporarily, but not on average). In such cases, we
recommend consulting Esko Customer Support and switching to a full SQL server.

Local versus Remote SQLServer

Esko recommends having the database server(s) locally on the Automation Engine Master (to avoid
extra network traffic). However, when a full SQL Server is required, the licensing model of SQLServer
needs to be taken into account:

• Per CPU: high cost if high number of CPU
• Per Client: high cost if high number of end users (end users = amount of users connecting via

Pilot, Shuttle, Access Points, so not just the BGMD service)

A full SQL server is needed in cases where both CPU usage and number of Automation Engine users
will be high.  In such cases, a dedicated server with 2 CPU's can be a cost efficient alternative.

Example Configurations

An Automation Engine setup is scalable and modular. How to set up depends on the load that your
server needs to carry and on the fail safe requirements.
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Small Size Configuration

This includes:

• One Master Server : setup as Automation Engine Master. The role of this server is managing Jobs
and tasks as well as processing tasks.

• One File Server: storing the data processed by the Automation Engine.

Note:  Esko recommends to have a dedicated file server in every case, even for small size
configurations.

Medium Size Configuration

This includes:

• One Master Server: setup as Automation Engine Master. The role of this server is managing Jobs
and tasks as well as processing tasks.

• One Assistant Server: configured as an Automation Engine Assistant. This server will only process
tasks.

• One File Server: this stores the data processed by the Automation Engine.

Large Configuration

This includes:

• One Master Server: setup as Automation Engine Master. The role of this server is managing Jobs
and tasks as well as processing tasks.

• One Assistant Server: configured as an Automation Engine Assistant. This server will only process
tasks.

• One File Server: stores the data processed by the Automation Engine
• One Viewing Assistant: configured to handle the Viewing sessions of all the clients.
• One Database Server: The Master server connects to a dedicated database server.

Very Large configuration

This includes two separate server groups consisting of one Master server and two Assistant servers.
Both server groups are completely independent units.

• Two Master Servers: setup as Automation Engine Master. The role of this server is managing Jobs
and tasks as well as processing tasks.

• Four Assistant Servers: configured as an Automation Engine Assistant. These servers will only
process tasks.

• One File Server: stores the data processed by the Automation Engine

One server per group is setup as Automation Engine Master. The role of this server is reduced to
only managing Jobs and tasks. The server has a relatively low amount of CPU and RAM. This server
runs a full SQLServer database engine.

Two servers are configured as Assistant. Their role is to process tasks. These servers have a high
amount of CPU and RAM.
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The data processed by both server groups is stored on the file server.

12.3.2 Snapshots/Cloning

Taking a snapshot or cloning for fail safe purposes can be done under the condition that no licenses
are activated on the server itself. When failing to do so, after restoring a snapshot of a virtual server
or restoring a backup clone, the licenses will be broken.

This can be overcome by:

• Temporarily deactivating the licenses before creating a snapshot or a clone.
• Installing the licenses on a computer other than the Automation Engine server

12.3.3 Remote Desktop Services

Attention:  Running the Automation Engine client software via Remote Desktop Services is
in violation with the EULA (End User License Agreement).

12.3.4 Sharing the Automation Engine server with Other Applications

Automation Engine requires a dedicated server to run on. Installing other software might influence
the functioning of Automation Engine and therefore is strongly discouraged.

Sharing the Automation Engine Server with other Esko Applications

1. WebCenter: Automation Engine and WebCenter can not be installed on the same server. Both
applications will malfunction if installed on the same server.

2. FlexRip: FlexRip can be installed on the same server as Automation Engine. However, Esko
advises to have these components on different servers.

3. PackEdge / Plato / i-cut Layout: Editors such as PackEdge / Plato / i-cut Layout are typically
installed on a client station but can be installed on the same server as Automation Engine (for
example to build templates). However, Esko does not recommend to use the server as a client
workstation.

4. Nexus: Automation Engine and Nexus cannot be installed on the same server. Both applications
will malfunction if installed on the same server.

Virus Scanners and Firewalls

Make sure that virus scanners and firewalls (including OS firewalls) do not interfere with the
Automation Engine software (blocking temp files, processes).
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